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Preface
Welcome to MicroMD EMR—the definitive Electronic Medical Records (EMR) solution. Based on emerging
healthcare industry standards, MicroMD EMR features flexible interfacing with clinical, administrative,
practice management, and research systems—both in-house and external. MicroMD EMR extends beyond
Electronic Patient Records into scheduling, workflow, and other functions. This enables MicroMD EMR to
integrate the entire operation of a practice or clinic. MicroMD EMR meets the needs of all types of medical
practices—ranging from small private practices to large multifaceted medical environments.

How This Manual is Organized
This manual explains the features of MicroMD EMR in detail. The manual begins with setting up the system,
which your support team has completed for you or has helped you accomplish. Then the manual reviews
the different areas and features of the software program. This is a reference manual and designed to
explain the purpose of the features of the software. It should teach you how the program works so you can
use the program to fit the needs of your individual practice.

Conventions Used in This Manual
Before using this manual, it is important to understand the typographical conventions used to identify and
describe information.

Cross-References
Cross-references to chapters, sections, page numbers, headings, etc. are shown in an italic typeface.
e.g., Refer to Conventions Used in This Manual page i.

Text You Type Using the Keyboard
Text that you type using the keyboard is shown in a Courier typeface.
e.g., Type Anthony Smith in the Name field.

Keys You Press and Buttons You Click
Keys that you press on the keyboard and buttons/icons that you click with the mouse are shown in a bold
sans-serif typeface.
e.g., Press Enter.
e.g., Click OK to continue.

Dialog Box, Application Window Titles, and Field Names
The titles of dialog boxes and application windows are shown in italics. Field names and selections made
from drop-down menus, etc. are also shown in italics.
e.g., The Print Preview dialog box appears.
e.g., Select Commercial Insurance from the drop-down list.
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Warnings, Notes and Tips
Warnings, notes and tips appear throughout the manual. They provide additional information important
for you to know about a topic.

 Warning Table



A warning alerts you to a severe situation, a potential for
data loss, or other critical information about the actions
discussed in the instructions.

 Note Table

○

A note highlights some important information you need
to know to use the features of the system correctly or to
get the results you expect.

 Tip Table

ii



This type of tip highlights helpful information you may not
know about the system or feature.



This type of tip contains a reference to some related
information or a related feature on another page or in
another section of the manual.
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Setup and Preferences
Before you can begin to use your MicroMD EMR, there is some setup that occurs beforehand. Aside from
your personal user preferences, your MicroMD support team has taken care of the majority of this setup
with you.
Much of the information in this chapter deals with the technical side of your system. Only system
administrators and support personnel generally work with the EMR Manager. Please contact your local
authorized MicroMD EMR reseller for additional assistance if needed.

○

Your MicroMD support team has already edited the
majority of your MicroMD EMR Manager or has walked
you through the process.

In This Chapter
In this chapter, we cover how to:

 Establish the structure of your practice (page 1.3)
 Add new users to the system (page 1.11)
 Edit the details of user accounts, including roles and functions (page 1.16)
 Add transcriptionists and receptionists (page 1.22)
 Assign co-signers to a user account (page 1.23)
 Create user groups (page 1.30)
 Create accounts for facilities such as X-ray machines (page 1.32)
 Manage system settings, such as defaults for new charts, practice holidays, security settings and
prescriptions (page 1.34)

 Configure communication with external systems, such as labs and practice management
(page 1.53)

 Establish practice-wide reference lists and manage user-defined additions (page 1.61)
 Define in-house settings for procedures, lab panels and custom labs (page 1.70)
 Set up the system to work with certain devices (page 1.74)
 Monitor the communication of your system with external systems (page 1.75)
 Establish your individual user preferences to enhance your workflow (page 1.84)
 Add to the built-in list of medical Internet sites (page 1.99)
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Overview of the MicroMD EMR Manager

Overview of the MicroMD EMR Manager
The MicroMD EMR Manager allows you to manage and monitor the entire MicroMD EMR installation for
your healthcare system. You typically access the MicroMD EMR Manager from the server. Just double-click
the MicroMD EMR Manager shortcut on the server’s desktop and log in with the appropriate credentials.
Only the SQL Server system administrator or a MicroMD EMR user with the Administrator or Practice
Manager role can access the MicroMD EMR Manager.

Figure 1.1 MicroMD EMR Manager

○

When MicroMD EMR was installed, a single user name and
password were created. Use the user name “sa” (without
the quotes) and the same password as the SQL Server
system administrator to log in to the MicroMD EMR
Manager for the first time. Please contact your local
authorized MicroMD EMR reseller for more information.

The MicroMD EMR Manager is composed of several individual sections. You access these sections using the
buttons on the left side of the window. This changes the right side of the window accordingly. Each of
these sections helps you manage a different aspect of your MicroMD EMR installation.

Locking the MicroMD EMR Manager
You can lock the MicroMD EMR Manager when you leave it unattended just like you can the main MicroMD
EMR application. When you lock the MicroMD EMR Manager, no one can access any part of the MicroMD
EMR Manager until you re-enter your password. After you re-enter your password, the MicroMD EMR
Manager displays the information that you were viewing when you locked your terminal.
Select File > Lock Manager from the main menu, or click the Lock Manager icon ( ) on the top toolbar.
The system clears the screen and displays a password entry dialog box. Enter your password to unlock the
MicroMD EMR Manager again.
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Practice Setup Manager
The MicroMD EMR Manager allows you to manage the information that relates to the installation of
MicroMD EMR in your healthcare system. It also allows you to develop a model of your entire healthcare
system. The model that you develop can include up to three levels that you establish in the Practice Setup
Manager:

 Practice
Each MicroMD EMR site installation is defined by the practice. For example, if your healthcare
system has the name Lakeview Community Medical Center, use this name to define the entire
MicroMD EMR installation for your practice.

○

Each MicroMD EMR installation has a single practice.

 Clinics within the practice
Each practice may consist of a number of practice locations. For example, Lakeview Community
Medical Center may consist of four locations: Lakeview North, Lakeview South, Lakeview East
and Lakeview West.



When interfacing with MicroMD PM, a “clinic” in the EMR is
the same as a “location” in the PM. For example,
Advanced Family Practice has a location in the PM called
CANFIELD. This translates into the EMR as the clinic
CANFIELD.

 Departments within the clinics
Each clinic may consist of a number of departments. Typically, out-patient establishments
contain only departments. For example, the Pediatrics Department, Geriatrics Department,
Cardiology Department and the Maternity Department may all be part of the Lakeview East
Clinic.



When interfacing with MicroMD PM, a “department” in the
EMR is the same as the “practice” in the PM.
For example, Advanced Family Practice has two practices
in their database: Advanced Family Practice and United
Physicians Group. In the EMR, there would be an
Advanced Family Practice department and a United
Physicians Group department.
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Practice Details
One of the first tasks to perform when configuring a new MicroMD EMR installation is to set the practice
details. The practice details include the practice name, address and registration number, as well as other
details of the practice.

Figure 1.2 Practice Details Window

○

Since the system uses your practice details throughout
the MicroMD EMR system, ensure that the details are
always accurate and up-to-date.

To edit the main practice details, simply click the Practice Information button to display the Practice
Setup Manager and click the Edit button (Figure 1.1 on page 1.2). Table 1.1 explains the available fields in
more detail.
Table 1.1

Fields on the Practice Details Window

Field

Description

Practice Name

Enter the name of the practice. The practice name appears on many reports
that are printed by MicroMD EMR and on all prescriptions. The practice name
may be included on letters printed by MicroMD EMR. (For more details on
printing letters, please see Chapter 26.)

Registration No

Enter the registration number of the practice. The company responsible for the
MicroMD EMR installation will supply the registration number. The registration
number uniquely identifies the practice. The registration number should be
entered when MicroMD EMR is first installed. Thereafter, the registration
number should not be changed.

1.4
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Fields on the Practice Details Window (continued)

Field

Description

License No

Enter the license number of the practice. The license number defines the
number of MicroMD EMR licenses, as well as the type of licenses that your
practice can operate. Change the license number only when the licensing
details of your practice are changed. Your local authorized MicroMD EMR
reseller will supply license numbers when required.

Client ID

Enter the Henry Schein Medical Systems security ID for this practice. Please
contact your local authorized MicroMD EMR reseller for more information.

Street Address, City,
State, Zip and
Country

Enter the address of the practice. The practice address appears on most reports
that are printed by MicroMD EMR. The practice address may be included in
letters printed by MicroMD EMR.

Phone

Enter the phone number of the practice. The practice phone number appears
on many reports that are printed by MicroMD EMR.

Additional Phone,
Fax and E-mail

Enter any additional contact methods for the practice. These fields are included
in MicroMD EMR for reference purposes only.

Direct Address

The Direct Address field is the practice’s direct e-mail address through the
Surescripts Clinical Interoperability Network (CIN).

Clinics in the Practice
Your MicroMD EMR site installation is defined by a single practice. This practice in turn is composed of a
number of clinics. You can add a clinic to the practice, delete a clinic from the practice or edit the details of
an existing clinic.

○

Since the system uses your clinic details throughout the
MicroMD EMR system, ensure that the details are always
accurate and up-to-date.
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Figure 1.3 Clinics in MicroMD EMR

Managing Clinics in the Practice
After you have defined a practice for the MicroMD EMR site installation, you can add practice locations
(or “clinics”).

Figure 1.4 Clinic Details

 To add a clinic to MicroMD EMR, simply click the Add button and complete the fields on the
Clinic Details window (Figure 1.4). Table 1.2 explains each field in detail.
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You must create at least one entry on this tab in order to
use MicroMD EMR.

 If you need to edit the details of a clinic, highlight the appropriate clinic and click the Edit
button at the bottom right of the window.

 If you want to delete the clinic, highlight the appropriate clinic and click the Delete button at
the bottom right of the window. When you delete a clinic, the MicroMD EMR Manager also
deletes all departments associated with the deleted clinic.
Table 1.2

Fields on the Clinic Details Window

Field

Description

Name

Enter the name of the clinic. MicroMD EMR uses the clinic name when
a user prints a prescription or an appointment reminder for a patient.

External Id

If you are configuring a system with both MicroMD PM and MicroMD
EMR, you need to enter the system ID of this location from the PM in
the External Id field. This maps the item between the PM and the EMR,
creating a link between the two systems. Please contact your local
authorized MicroMD EMR reseller for more information.

Street Address, City, State,
Zip, Country, Phone and
Fax

Enter the address of the clinic. The system uses the clinic address,
phone numbers and fax number when a user prints a prescription.

Additional Phone

Enter an additional phone number for the clinic. This is for reference
purposes only.

E-Mail

Enter the e-mail address of the clinic. This is for reference
purposes only.

Viewing a List of Clinic-Specific Resources
The MicroMD EMR Manager allows you to view a list of resources that are associated with each clinic.
The resources may be either MicroMD EMR users or facilities.
On the Clinics tab, highlight the clinic for which you want to see a list of users or facilities, then click
the Show Users button or the Show Facilities button as appropriate. The MicroMD EMR Manager
displays the list for you (Figure 1.5).
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Figure 1.5 Example of Clinic-Specific Resources
If you want to see more details about the user or facility, highlight the appropriate item to view the
details below the list.

Departments in the Practice
Your MicroMD EMR site installation is defined by the practice. The practice in turn is composed of a number
of clinics. Each clinic is composed of a number of departments and units.

Figure 1.6 Departments Within a Clinic
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You can add a department to a clinic; delete an existing department from a clinic; or edit the details of an
existing department. MicroMD EMR accesses the list of departments when you:

 Make a new appointment
 Create a new encounter
 Enter on-call details for a physician



Since the system uses your department details
throughout the MicroMD EMR system, ensure that the
details are always accurate and up-to-date.

Managing Departments Within a Clinic
You must associate at least one department with each clinic in order to create users within the system,
even if there is only one clinic. MicroMD EMR populates the Clinic drop-down from the Clinics tab.
Select the clinic you want to manage.

 To add a department to a clinic, click the Add button, enter the appropriate details and click
OK. Table 1.3 explains the fields on this window in more detail.



If configuring a system with both MicroMD PM and
MicroMD EMR, you need to enter the number you
recorded for this practice in the External Id field. Please
contact your local authorized MicroMD EMR reseller for
more information.



Click the Insert Clinic Address button to insert the clinic
address details for this department.

 To edit the details of a department, highlight the department, click the Edit button at the
bottom right of the window and edit the fields on the Department Details window that appears.

Figure 1.7 Department Details Window
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 If you want to delete the department, highlight the appropriate department and click the Delete
button at the bottom right of the window.

○
Table 1.3

When you delete a clinic, the MicroMD EMR Manager also
deletes all departments created for the deleted clinic.

Fields on the Department Details Window

Field

Description

Department Name

Enter the name of the department.

Department Type

Select the department type from the list of department types.

External Id

Typically, this is the unique ID assigned to the practice in the MicroMD PM.
It identifies the practice in the background of the system and helps you
map the data. Since you create departments in the EMR that reflect the
use of multiple practices in MicroMD PM, this ID links the two pieces of
data.

Tax No

This is the department’s tax identification number. The system uses this
number when you choose to filter the Objective Measure Calculations
report by the Department Tax No option. See page 29.3 for details on
retrieving performance data.

Consolidated

This option is for use with MicroMD CHC practices only who have their
EMR and PM databases in separate locations. When there is a check mark
in the Consolidated option, this tells the system that both the MicroMD
PM + EMR databases are in the same location. This is set by default for all
practices, not just CHCs.
For CHCs with databases in separate locations, removing the check mark
from this option enables several connection fields where your support
team can tell MicroMD EMR where your PM database resides. This helps
link up the appropriate reporting tables to share data. Please contact your
MicroMD support team for more information.

○

1.10

In general, you do not have to make changes to this
option. Very few CHC practices need to enter this
connection information.

CPC+PracID

For a practice that signs up for the CPC+ program, enter the CPC+PracID.

MIPS Virtual Grp ID and
MIPS Virtual Grp Nm

For practices or providers reporting as a virtual group, enter the group’s ID
and name in the appropriate field. The export file requires this
information to compile your data.

Insert Clinic Address
button

Click this button to copy and insert the clinic address, phone and e-mail
details into the Add Department window. Using the feature overwrites any
existing information in the Add Department window.
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Fields on the Department Details Window (continued)

Field

Description

Street Address, City,
State, Zip, Country,
Phone, Additional
Phone, Fax and E-Mail

Enter the address of the department. These fields are included in MicroMD
EMR for reference purposes only.

Viewing Department Resources
Just like with a clinic, the MicroMD EMR Manager allows you to view a list of resources that are
associated with a department. The resources may be either MicroMD EMR users or facilities.
On the Departments tab, select the appropriate clinic from the Clinic drop-down and highlight the
department for which you want to see a list of users or facilities. Click the Show Department Users
button or the Show Department Facilities button as appropriate. The MicroMD EMR Manager
displays the list for you.
If you want to see more details about the user or facility, highlight the appropriate item to view the
details in the bottom of the window.

Users and Facilities
The Users and Facilities Manager allows you to manage the resources that are defined in your practice.
These resources include users and facilities. Users are those people who need to log into the EMR and
perform a variety of tasks. The Users and Facilities Manager is where you create those user accounts. You
can also create User Groups in the MicroMD EMR Manager. A User Group is a group of MicroMD EMR users
that all perform the same functions. (See page 1.30 for more about user groups.)
Facilities are those equipment or resources that will have patients routed to them or that require an
appointment book, such as X-ray machines at the various clinics. Staff members book patients for
“appointments” with a specific X-ray machine. Each X-ray machine therefore requires its own appointment
book. To model this scenario in MicroMD EMR, you would create a facility for each X-ray machine. (See
page 1.30 for more about user groups.)

Adding New Users
The Users and Facilities Manager allows you to add new users to the MicroMD EMR practice installation,
and to edit the details of existing users in the system. The Users and Facilities Manager divides each user’s
account into the following six areas: Personal, Professional, Address, Workplace, Roles and Access.
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Figure 1.8 Users and Facilities

 To add a new user, simply click the Add button, follow the instructions on each screen and click
Finish when complete.

 To edit an existing user, click the user’s entry, select the appropriate tab, click the Edit button on
that tab, and make the necessary changes. Click OK when complete.
The MicroMD EMR New User Wizard guides you through the process of adding a new user to the system.
The following sections explain the fields on these screens in detail.



After you add a new user to the system, you cannot
delete the user from the system. If a user account is no
longer required, you make the user account inactive.
See page 1.28 for more details.

Personal
When you need to edit an existing user account, you can highlight the appropriate user, select the
appropriate tab and click the Edit button. Edit the information in the fields as necessary and click OK.
The Users and Facilities Manager allows you to maintain three addresses for each MicroMD EMR user: work,
home and other. Table 1.4 explains the fields on this tab in more detail.
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Fields on the Personal Details Window

Field

Description

Title

Select the user’s title (e.g., Mr., Mrs. or Miss). If the title you need does not
appear in the list, you can type the title directly in the text field. This
custom title is only available with this user.

First Name, Middle Name,
Last Name

Enter the user’s name in these fields. The user’s name appears
throughout MicroMD EMR, including in the top left of the window when
they log in to the system.

Suffix

Enter the user’s suffix (e.g., I, II, Jr., Sr.). Do not enter a professional suffix
here (e.g., MD, DDS). Enter the professional suffix under the Professional
Details tab (page 1.13).

Date of Birth

Specify the user’s date of birth. This is for reference purposes only.

Gender

Enter the sex of the user. This is for reference purposes only.

SSN

To record the user’s social security number, enter it in this field. This is for
reference purposes only.

Tax Number

Enter the user’s tax ID number. This is for reference purposes only.

Staff Number

If you have staff numbers, you can enter the user’s staff number in this
field. This is for reference purposes only.

Professional Details
The Professional Details window allows you to enter the physician’s license numbers, identifier numbers
and more. Table 1.5 explains the fields on this tab in more detail.
Table 1.5

Fields on the Professional Details Window

Field

Details

Degree

Enter the user’s degree. This is for reference purposes only.

Primary Function

Enter the user’s primary function. This is for reference purposes only and
only applies to physicians.

Professional Suffix

Enter the user’s professional suffix (e.g., for a medical doctor, type MD).
MicroMD EMR frequently includes this suffix whenever it displays or prints
the user’s name.

DEA Number

Enter the user’s Drug Enforcement Administration (DEA) number. It is
required if this physician prescribes controlled substances. The user’s
DEA number prints on all prescriptions created by the user.

NADEAN

If the provider has a special license to administer drug regimens for
treating people who have a narcotic addiction, you can enter the
provider’s Narcotic Addiction DEA Number in this field.
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Fields on the Professional Details Window (continued)

Field

Details

Rx State License No/s

Some states require a medical license number for nurse practitioners on
electronic prescriptions. If there is text in the Rx State License No/s field,
MicroMD EMR includes the number with electronic prescriptions, and
you can insert them to be printed on hard copy prescriptions. Separate
multiple license numbers with a single space.

UPIN Number

Enter the user’s Unique Physician Identification Number (UPIN). The
system uses this number for billing purposes when communicating with
external systems such as billing systems and laboratory systems.

NPI Number

Enter this provider’s National Provider Identifier (NPI) number provided
by CMS. The system uses this number for billing purposes when
communicating with external systems such as billing systems and
laboratory systems.

Medical License Number

Enter the user’s medical license number. This number prints on all
prescriptions created by the physician.

Specialty Type

Select the user’s specialty type (e.g., Family Medicine, Geriatrics or
Internal Medicine). This is for reference purposes only.

Specialty License Number

Enter the user’s specialty license number. This is for reference
purposes only.

Address Details
The Address tab allows you to maintain up to three addresses for this user: their Home address, their
Work address, and one Other address you need to record for the user. Table 1.6 explains the fields on this
tab in more detail.
Table 1.6

Fields on the Address Details Windows

Field

Description

Street Address, City, State,
Zip, Country

Enter the user’s address details for each of the tabs.



On the Work tab, click the Lookup icon (
) to use
the address of one of their associated departments
as their work address. This overwrites any existing
address details on the Work tab.

Phone, Additional Phone,
Fax, Beeper and Mobile

Enter the user’s contact numbers in these fields as needed. The Beeper
and Mobile fields apply to the Work tab only.

E-mail

Enter the user’s e-mail address if available.

Sms Address

On the Work tab, enter the user’s SMS Messenger details in this field. This
is for reference purposes only.
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Workplace Details
Use the MicroMD EMR Manager to maintain the workplace details of existing MicroMD EMR users. The
workplace details define the locations where the user works within the practice. Accurate workplace
details are particularly important in those practices that use the MicroMD EMR routing facilities.

Figure 1.9 Workplace Details
A user can work in numerous workplaces within a practice. Each workplace is defined by a department in
the practice. When MicroMD EMR displays the name of a workplace, the name of the clinic always appears
first and in square brackets (e.g., [Boardman] Advance Family Practice). The department appears after the
brackets.
To edit the workplace details of an existing MicroMD EMR user:

Procedure

Details

1. Highlight the appropriate user in the left side
of the window and click the Workplace tab.

The MicroMD EMR Manager lists all the locations in
which the user works, including departments AND
units (Figure 1.9).

2. Click the Add button in the Departments
section.

The Department List window opens and lists all
the departments within the practice.
To remove a department from this user, highlight
the appropriate department in the Departments
section and click Delete.

3. Highlight the appropriate department and
click Insert.

MicroMD EMR adds the new department to the
user’s workplace list.

4. Repeat step 2 and step 3 for each of the user’s
workplaces.
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Establishing Roles and Functions for the User
Your System Administrator uses the MicroMD EMR Manager to define user roles and functions. That person
must assign each MicroMD EMR user at least one role, but MicroMD EMR allows each user to have multiple
roles. In addition, the administrator can assign one or more functions to the user.

 Roles: Roles define the basic set of privileges that a given user has within the MicroMD EMR
system (i.e., what data and functionality the user has permission to access).

 Functions: Functions extend the basic set of privileges that a user has within the MicroMD EMR
system, providing additional flexibility to accommodate the user’s work flow.

○

You cannot assign only a function to a user—every user
must have at least one role assigned to them.

For example, a user assigned the role of Physician can perform the following tasks:

 Record medical information and encounters for any patient
 Sign any encounter that he or she creates
 View the medical information of MicroMD EMR patients
 Create, edit and delete Encounter Guides and Encounter Templates
 Access his or her own appointment book but no one else’s
In contrast, a user assigned the role Receptionist can perform the following tasks:

 Create new charts
 View and edit patient demographic information
 Access the appointment book of any physician for whom he/she is a receptionist
To edit a user’s roles and/or functions, simply click the Edit button (Figure 1.10) and place a check mark
next to each role and function you want to assign to the user (Figure 1.12). Be sure to click OK to commit
your changes.
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Figure 1.10 User Roles and Functions

User Roles
MicroMD EMR allows you to define one or more roles to each MicroMD EMR user. Each role that you
add to a user increases the functionality that the user can perform within the MicroMD EMR system.
Click the View Rights button on the Users tab in the MicroMD EMR Manager to view the rights of the
different roles (Figure 1.11).

Figure 1.11 List of Rights for the Various User Roles
Once you decide which role(s) a user should have, exit the window and click the Edit button to assign
them to the user (Figure 1.10).
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User Functions
In addition to user roles, you can assign specific functions to MicroMD EMR users to broaden their
access within the system. Place a check mark next to each function you want to add to the user’s
account. Table 1.7 explains these functions in more detail.

Figure 1.12 User Roles and Functions
Table 1.7

1.18

Additional Functions Available for User Accounts

User Function

Description

Merge Charts

This function allows the MicroMD EMR user to merge duplicate patient
charts (page 10.22).

Reports (All)

The Reports (All) option allows the user to generate any report in list,
regardless if it has patient medical information, as long as they have a
role that allows access to patient information.

Reports (Admin)

This function allows the MicroMD EMR user to use the report writing
facilities to produce administrative reports that do not contain patient
information (e.g., Encounter Duration per Physician). See Chapter 25
for more details on MicroMD EMR Reports.

Manage Groups

Providing this function to a user allows them to add patients to and
delete patients from a patient group (page 1.30). This function also
allows the user to create patient groups.

Manage Transcriptionists

A user with this function assigned to their user account can view the
External Transcriptions option on their Desktop under the
Administration button (page 6.18).
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Additional Functions Available for User Accounts (continued)

User Function

Description

Add Reference Data

This function allows the user to add entries to the system’s Reference
Lists (i.e., adding a new medication to the database). See page 7.2 for
more details on Reference Lists.

Add Templates to Shared

A user with this function can add templates to a Shared folder. A user
without this function can add templates only to their Personal folder.
See page 2.8 for more details on templates and sharing.

Write Prescriptions

The Write Prescriptions function allows you to provide any staff
member with appropriate licenses the ability to write prescriptions
under their own name. The system assigns this option by default for
the following four roles: Physician, Physician Assistant, Nurse
Practitioner, and Non-Physician Care Giver. See Chapter 21 for details
on writing prescriptions.

Write Prescriptions on
Behalf

The Write Prescriptions on Behalf user function allows you to provide
staff members with the ability to write prescriptions on behalf of a
prescribing provider but doesn’t allow them to write prescriptions on
their own. See Chapter 21 for details on writing prescriptions.

Authorize Refill Requests

The Authorize Refill Requests user function allows a user to process the
list of refill requests for any physician. See page 21.29 for more details
on this function.

Referral Tracking

A user with this function assigned to their user account can view the
Referral Tracking and Referral Tracking – in options on their Desktop
under the My Workflow button (page 4.30).

Goal Monitoring (Desktop) This function provides a way for a user to have access to patient Goal
Monitoring without opening the patient’s chart, further protecting
patient medical information. When you add this function to the user’s
account, the Goal Monitoring option is available on their Desktop
under the Patient Care button (page 5.3).
View OR

This field is no longer in use unless you had the hospitalization module
installed in previous versions of MicroMD EMR. This option allows the
user to access the operating room features in the system.

View Delivery Rooms

This field is no longer in use.

Patient Transport

This function enables the Patient Transport feature for users with
either the Practice Manager or Administrator role assigned to their
user account. When you add this function, the Patient Transport
option is available on the Desktop under the Administration button
(page 6.19).
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Additional Functions Available for User Accounts (continued)

User Function

Description

Unidentified Items

Practices can identify which categories of unidentified items a user will
have available to them. To specify which items a user can see on his or
her Desktop, click the Unidentified Items checkbox and place a check
mark next to each category you want the user to access. When you add
this function, the Unidentified Items option is available on the Desktop
under the My Workflow button (page 4.46). Only those categories you
selected appear in the Item Type filter for this user.

Manage Stock

This function allows the user to use the Stock Management feature.
When you associate this option to a user’s account, the Stock
management option is available on the Desktop under the
Administration button (page 6.20).

Manage Cardiology

This function is no longer in use.

Edit Master Descriptor List

This function allows the user to edit the practice’s descriptor list and
enables the Descriptor Manager menu option under Tools >
Encounter Tools (page 22.19).

Manage Item
Descriptor Sets

This function allows the user to customize descriptor lists for specific
symptoms, signs and/or diagnoses. It also enables the Descriptor
Manager menu option under Tools > Encounter Tools (page 22.19).

Copy All Common Lists To

This function activates the Copy All To button on the Common List
Builder (under Tools > Common List Builder). See page 7.5 for more
details on the Common List Builder.

Emergency Access

Place a check mark in this field to allow the user to open patient charts
in an emergency situation when an authorized user is not available.
The user must enter their password to document their opening of the
patient’s chart. See page 9.24 for more details on emergency access.

Set Prescription Warning
level

This option enables the Drug-Drug Warning Level and Drug-Allergy
Warning Level fields in the user’s preferences (page 1.84) and allows
the user to change the warning levels that display for prescriptions
they write. The user’s preference overrides the practice setting
(page 1.86).

Delete Provider Orders

This option allows the user to delete orders created by any provider. If
you do not want this user to delete any orders in the system, leave the
checkbox empty.

Drug-drug Interaction
Severity

Users with the Practice Manager role and/or the Administrator role
have access to the MicroMD EMR Manager. If you want to prevent a user
from editing the Drug Severities reference list (under Reference Lists >
User-Defined Additions), remove the check mark from the Drug-drug
Interaction Severity function.

Manage Mail to Practice

Place a check mark in this option to grant the user access to the
general practice mail inbox, both receiving and sending. They can
access this mailbox from the Mail section of their Desktop. See
page 4.11 for more details.
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Additional Functions Available for User Accounts (continued)

User Function

Description

Restricted or
Confidential Data

Place a check mark in this option to enable the Restricted/Confidential
Data options for this user. They will have a user preference to set their
personal encounter default; a Restricted/Confidential Data option on
the Encounter Header; and they will be able to open encounters
marked as Restricted/Confidential.

Administrator for EPCS

If this user has the authority to manage your practice’s participation in
Electronic Prescriptions for Controlled Substances (EPCS), place a
check mark next to this option. This activates the dashboard for the
MicroMD EPCS module. Please refer to the documentation provided by
your support team.

Chronic Care
Management

This function provides a way for a user to have access to a Chronic Care
Management patient without opening the patient’s chart. When you
add this function to the user’s account, the Chronic Care Management
option is available on their Desktop under the Patient Care button
(page 5.3). See page 17.31 for more details on Chronic Care
Management.

Include EPCS as
permissible

For providers participating in the incentive programs, the e-Prescribing
measure in the Promoting Interoperability category of MIPS allows
EPCS-certified providers the option to include prescriptions for
controlled substances in their reporting or to ignore them when
calculating their performance. Place a check mark in this user function
to allow the system to count EPCS prescriptions as permissible
prescriptions.

Disable Personal Enc
Templates

Place a check mark in this option to prevent users from loading or
saving encounter templates to the Personal folder. See page 2.8 for
more details on template folders.


Disable Standard Enc
Templates

When you use this function in conjunction with the
Disable Standard Enc Templates function, you can
limit staff members to use only templates in the
Shared folders.

Place a check mark in this option to prevent users from loading
encounter templates from the Standard folder. See page 2.8 for more
details on template folders.



When you use this function in conjunction with the
Disable Personal Enc Templates function, you can
limit staff members to use only templates in the
Shared folders.
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Transcriptionists
A user’s transcription list contains the names of the physicians for whom the user (transcriptionist) can
work and create transcribed encounters. A user must be assigned the Transcriptionist role before you
can edit this list. See page 27.44 for details on transcribing for physicians.

Figure 1.13 Transcriptionist’s List
To add physicians to the user’s list:

Procedure

Details

1. Highlight the appropriate transcriptionist
user in the left side of the window and click
the Roles tab.

The system displays the user’s current roles and
functions in the right side of the window (Figure
1.14 on page 1.23).

2. Click the Transcribe for tab at the bottom
of the window.

The system displays the current list of the user’s
physicians.

3. Click the Add button to assign a new
physician.

The system displays the Reference List View
window. This window only displays those users
with the Physician role.
To remove a physician, highlight their name and
click the Delete button.

4. Select the physician you want to add to this
user’s transcription list and click Insert.

The system adds the selected physician to
the list.

5. Repeat step 3 and step 4 for each physician
you want to add the transcriptionist’s list.

Receptionists
A user’s receptionist list contains the names of the physicians, locations and other resources whose
appointment books the user can access. A user must be assigned the Receptionist role before they can
edit this list.
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Figure 1.14 Receptionist List
To add physicians or resources to the user’s list:

Procedure

Details

1. Highlight the appropriate receptionist user
in the left side of the window and click the
Roles tab.

The system displays the user’s current roles and
functions in the right side of the window (Figure
1.14).

2. Click the Receptionist for tab at the bottom
of the window.

The system displays the current list of the user’s
physicians and other resources.

3. Click the Add button to assign a new
resource.

The system displays the Reference List View
window.
To remove a resource, highlight the name and
click the Delete button.

4. Select the resource you want to add to this
user’s receptionist list and click Insert.

The system adds the selected physician to the
list.

Co-Signers for Encounters
The MicroMD EMR Manager allows specified physicians to co-sign encounters for specified users. On
the Desktop for each physician in the list, the encounters that need to be co-signed appear in the
Encounters list (page 4.5). When you create a Co-signer List for a user, you specify:

 Physicians that can co-sign
 Encounter frequency before a co-sign is required
 In whose name the system should bill co-signed encounters
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Figure 1.15 Co-Signer List for a User
To add a co-sign encounters list for a MicroMD EMR user:

Procedure

Details

1. Highlight the appropriate user in the left
side of the window and click the Roles tab.

The system displays the user’s current roles and
functions in the right side of the window (Figure
1.14 on page 1.23). Make sure that the user has
been assigned the role of Physician or Nurse
Practitioner.

2. Click the Co-sign Encounters tab at the
bottom of the window.

The system displays the co-signing requirements
for the user, as well as the current list of those
physicians responsible for co-signing this user’s
encounters.

3. Click the Add button to assign a new
physician to the list.

To edit the existing list, click the Edit button.
To remove all co-signer details, click the Delete
button.
When you click Add, the system displays the Cosign Encounter window.

4. Click the Lookup icon (

).

The Reference List Viewer window opens.

5. Select the physician you want to add to the
list and click the Insert button.
6. Repeat step 4 and step 5 for each physician
you want to add to the list.
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Procedure (continued)

Details (continued)

7. In the Co-sign Criteria section, select the
frequency that a co-sign is required and in
whose name the practice should bill the
encounter.
8. Click OK.

MicroMD EMR displays the criteria and the list of
physicians on the Co-Sign Encounters tab
(Figure 1.15 on page 1.24).

Mail Access
For those users who need to have access to the external messages in another user’s mailbox, or the
external messages in the mailbox at another location, you can grant them access to these messages.
For instance, a staff member might have to cover another staff member who is on vacation, or a nurse
must have access to a doctor’s mailbox to manage any messages coming in.

Figure 1.16 Mail Access

Procedure

Details

1. Highlight the appropriate user in the left
side of the window and click the Roles tab.
2. Click the Mail Access tab at the bottom of
the window.

The system displays the current list of those
resources to which this user has mailbox access
(Figure 1.16).

3. Click the Add button to choose the mailbox
this user needs access.

To remove a resource, highlight the name and
click the Delete button.
The system displays the Reference List View
window.

4. Select the resource whose external mail
list you want to provide to this user and
click Insert.

The system adds the selected resource to the
user’s list.
When the user opens the Mail section of their
My Workflow, a drop-down appears called
Mailbox that allows the user to switch between
mailboxes.

5. Repeat step 3 and step 4 for each mailbox
the user needs to access.
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Editing a User’s Access
The MicroMD EMR Manager also allows you to edit the user’s password, suspend their user account, view
the number of times their recent login attempts failed, and map their credentials to an external system.

Figure 1.17 User Access to the System

Map the User to an External System
For those interfaces where you need the third-party system to recognize the user’s credentials for any
number of reasons, you can do so easily.

1.26

Procedure

Details

1. Highlight the appropriate user in the left
side of the window and click the Access tab.

The system displays the user’s current details in
the right side of the window.

2. Click the Map to External System button.

The External System Mapping window opens.

MicroMD EMR User’s Reference Manual Version 16.0

Users and Facilities

Chapter 1. Setup and Preferences

Procedure (continued)
3. Click the Lookup icon (

Details (continued)
).

The Edit Mapping window opens.

4. From the System drop-down list, select the
external system you need to map for this
user.
5. In the External Id field, enter the external
system’s identification for this user.

Typically, this is the unique ID assigned to this
piece of data in the other system. It identifies the
user in the background of the system.

6. Click OK.

Changing a User’s Password
Users can change their own passwords as needed (page 2.4); however, administrators can also change
user passwords using the MicroMD EMR Manager. There are three ways to do this:

 change the password directly from the MicroMD EMR Manager
 change the password while editing access details (page 1.28)
 force the user to change their password the next time they log in to the system (page 1.28).

Figure 1.18 Changing a User’s Password
To change the user’s password directly, highlight the user and click the Password button (Figure 1.17
on page 1.26). This displays the Change Password window (Figure 1.18). Change the password and
click OK. The following section discusses the other methods while also discussing other details you
can edit.
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Editing a User’s Access Details
The system allows you to edit each user’s access details. highlight the appropriate user and click the
Edit button (Figure 1.17 on page 1.26) to change their details. The system displays the Access Details
window. Make your changes and click OK. Table 1.8 explains the fields on this window in more detail.

Figure 1.19 User Access Details Window
Table 1.8

Fields on the User Access Details Window

Field

Description

Login Details Section

1.28

Login name

This field displays the text that the selected user types in the Login
name field when launching MicroMD EMR. You cannot change the
login name of an existing user.

Active

From this drop-down, you can specify whether or not the selected
user account is active. After you add a new user to the system, you
cannot delete the user from the system. To deactivate the account,
select No from this drop-down.

Failed logins

This displays the number of times since their last successful login that
the selected user attempted to log in and, for whatever reason, was
unable to successfully do so. To set this number back to zero, click the
Reset failed logins button.

Login suspended

This field indicates whether the user has been locked out of the
system. This could happen if the practice has chosen to limit the
number of failed attempts for users. This could also happen if
someone clicked the Suspend button to prevent this user account
from accessing the system. You can click the Reset failed logins
button to remove the suspension.

Reset failed logins button

Click the Reset failed logins button to clear the user’s counter of
failed attempts to enter their user name and password. You can also
reset a suspended account with this button.
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Fields on the User Access Details Window (continued)

Field

Description

Suspend button

Click the Suspend button to prevent the user account from
successfully logging in and accessing the system. To remove the
suspension, click the Reset failed logins button.

Password Section
New password and
Confirm password

Users can change their own passwords as needed (page 2.4);
however, there are times when an administrator needs to change the
password. To change the user’s password, type the new password
and confirm it in these fields.

User to change password
on next successful login

Place a check mark in the checkbox to force the user to change their
own password the next time they log in.

Change History for User Accounts in the MicroMD EMR Manager
MicroMD EMR tracks changes made to every user account in the system, including when the user tries
to log in and fails or if they reset their password. MicroMD EMR records the event and displays it in the
Change History. Simply click the Change History button anywhere in the user’s account (Figure 1.17
on page 1.26). Table 1.9 explains the columns in the Change History window.

Figure 1.20 Change History on a User Account
Table 1.9

Columns on the User’s Change History Window

Column

Description

Action By

This column displays the MicroMD EMR user name of the person who
initiated the change on the selected user’s account.

Date

The Date column is system date and time that the user in the Action By
column performed the action against the selected user’s account.

Area

This column displays the tab in the user’s account where the change was
made. If the change affected data on multiple tabs, the system lists them
all.
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Columns on the User’s Change History Window (continued)

Column

Description (continued)

Action

The Action column reflects the type of activity that occurred. It could be
changing existing data, adding new information, or removing outdated
information. The system also records failed login attempts and when the
user resets their password.

Action Details

This column displays the activity that actually occurred.

Managing User Groups
A User Group is a group of MicroMD EMR users that all perform the same function(s). For example,
Advanced Family Practice created a User Group called “DNA Lab” that contains all staff in the DNA
laboratory. When Dr. Davidson prescribes a plan for a patient, the provider can specify that the plan be
performed by any member of the “DNA Lab” group.

○

A user group cannot contain a facility.

Figure 1.21 User Groups
You can edit or delete an existing user group. Highlight the user group and click the Edit Group or Delete
Group button as appropriate.
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To add a user group:

Procedure

Details

1. Click the Users & Facilities button and verify
that you have the User Groups tab displayed.

See Figure 1.21.

2. Click the Add Group button.

The Add User Group window opens.

3. In the Name field, enter the title of this user
group.
4. From the Group Type drop-down, select the
kind of users this group involves.



If you want to include additional
comments about this user group,
you can enter text in the Description
field. The field is for reference
purposes only.

5. Click the Lookup icon ( ) in the Group
Members section to add users to the group.

The Reference List Viewer window opens.

6. Find the user you want to add to the group
and click the Insert button.

You can also double-click the entry to insert.

7. Repeat step 6 to add all the users you need for
this group.
8. Click Close when finished.
9. Click OK on the User Group window.
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Managing Facilities
The Utilities and Facilities Manager allows you to manage those equipment or resources that will have
patients routed to them or that require an appointment book. For example, Advanced Family Practice has
a single ultrasound machine and staff members need to know when this machine is available and where to
find. In this instance, you would create a facility for the ultrasound machine.

Figure 1.22 Facilities
The Utilities and Facilities Manager divides the details of each facility into categories: function, location
and operators (represented by the tabs in this section). You can edit or delete an existing facilities.
Highlight the facility and click the Edit or Delete button as appropriate.
To add a new facility:

Procedure

Details

1. Click the Users & Facilities button and verify
that you have the Facilities tab displayed.
2. Click the Add button.

The Add Facility window opens.

3. In the Name field, enter the title of this facility.

For example, Ultrasound or X-ray Machine.
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4. From the Facility Type drop-down, select the
kind of resource this facility entry involves.
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Details (continued)



If you want to include additional
comments about this resource, you
can enter text in the Description and
Function fields. These fields are for
reference purposes only.

5. Click OK.

The system adds the facility to the list.

6. Highlight that facility and click the Location
tab.

The MicroMD EMR Manager lists all the
departments in which the selected facility is
located. The resource is only available in these
areas.

7. On the Location tab, click the Add button.

The Department List window opens and displays
all departments created in the system.

8. Highlight the department you want to
associate with the resource and click Insert.
9. If there are only certain users certified for the
facility, highlight the facility and click the
Operators tab.

This is useful if only certain members of the staff
are qualified to use a machine (e.g., the ultrasound
or X-ray machines).

10. Click the Add button on the Operators tab.

The Reference List Viewer window for System
Users opens.

11. Locate and insert the appropriate user for the
facility.
12. Repeat step 10 and step 11 if there are more
users able to work the machine.
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Maintaining the System Settings
The Systems Settings Manager allows you to maintain settings that apply to the entire system, not just a
single user. This manager allows you to set demographic defaults for new patients, practice preferences
for certain areas of the program, practice holidays and more.

Figure 1.23 System Settings Manager

Demographic Defaults
Use the MicroMD EMR Manager to set some default values for a brand-new chart (only for EMR-only
clients). When the user creates a new chart, the system pre-populates the patient’s demographics with the
choices made on the Demographics tab. This tab also allows you establish the default units for taking vital
signs and for sales tax.

Figure 1.24 Demographic Defaults
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To set the demographic defaults, simply click the Edit button, make your changes and click OK. Table 1.10
explains the fields on this window in detail.
Table 1.10 Fields Available on the Demographic Defaults Window

Field

Description

Country

This field sets the default value for the Country field in the patient’s address when
a staff member creates a new patient chart.

State

This field sets the default value for the State field in the patient’s address when a
staff member creates a new patient chart.

Language

This field sets the default value for the Language field when a staff member
creates a new patient chart.

Nationality

This field sets the default value for the Nationality field when a staff member
creates a new patient chart.

Sales Tax

This field sets the sales tax for this practice and affects any stock items sold
through the system.

Vital Sign Units

The Vital Signs Units setting indicates whether your practice records vitals in
imperial or metric units.

Verify Height

When you select Yes from the Verify Height drop-down, any time a user enters a
patient’s height in the Vital Signs section of the patient’s chart and clicks OK, the
system checks the last entered height and compares it to the current height. If
the two are different, the system alerts the user.

Women’s Health
Vital Units

This drop-down determines the units used to measure vital units in the Women’s
Health module: Imperial or metric.

Fetal Ultrasound
Units

This drop-down determines the units used to measure fetal ultrasound units in
the Women’s Health module: centimeters or millimeters.

Gestational Age
Calculation

This determines the method of gestational age calculation: Nägele’s Rule or
Mittendorf Rule.

Practice Settings
Use the MicroMD EMR Manager to set some default values for all users throughout the system. The settings
on the Practice tab under System Settings allow you to standardize the way the system works for
everyone. This includes items like the maximum number of unsigned encounters you want to allow the
providers to have open at any time.
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Figure 1.25 Practice Settings for All Users
To set the practice settings, simply click the Edit button, edit the defaults as necessary and click OK when
finished. Table 1.11 explains all of the fields in detail.
Table 1.11 Fields on the Practice Settings Window

Field

Description

General
Reference database
expires after

In this drop-down, specify the number of months after which you would
like the database to expire.
If the database is expired, a red warning appears on the bottom of both the
Medications section of an encounter and on the Prescription Pad window.

Signature device

This tells MicroMD what device you want to use for acquiring electronic
signatures in the practice:

 Use Native Control: Select this option to use the each workstation’s
built-in signature control (e.g., laptop with a touch pad or a tablet with
a touch screen).

 Use Attached Device: Select this option to use an external device
connected to the workstation (e.g., a signature-capture pad with a
pen).
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Table 1.11 Fields on the Practice Settings Window (continued)

Field

Description

Remove related phone
messages when marked
as done

Phone messages can become cumbersome if there are a lot in your
system. To simplify things, a check in this checkbox will delete all related
phone messages but keep your latest one.

Default text formatting

The Default text formatting option allows you to specify the font face and
font size that appears in report templates, encounter templates, letters,
etc. when you first create them.

○
Assessment Description

If you make a change, the new setting is in effect for
new items only. Existing templates do not display the
default font and size.

You can choose whether MicroMD EMR displays the SNOMED descriptions
or the ICD descriptions for assessments throughout the system. The codes
displayed are the appropriate ICD-10 codes; however, you can choose
which descriptions best meet the needs of your practice.
ICD-10 codes generally map to an associated SNOMED code in a one-toone relationship. There are many ICD codes for which there are no related
SNOMED codes. However, there are also many ICD-10 codes that can map
to any one of multiple SNOMED codes. When your practice has ICD
selected from this Assessment Description drop-down, any ICD-10 codes
with multiple possible SNOMED codes appear in colored text with the text
“(SCTmulti)” next to the code description.

 Blue text: The ICD-10 code has not been mapped to a SNOMED code.
 Green text: The ICD-10 code was mapped to a SNOMED code.
Show HCC Code

The Centers for Medicare and Medicaid provide Hierarchical Condition
Category Codes (HCC Codes) and indicators. Practices have the ability to
choose whether or not to display these codes and indicators throughout
MicroMD. Simply select the code set version you want to use. Once you
select to show the HCC codes, MicroMD EMR displays them next to the ICD
codes in the system. By default, the practice’s preference is set to No.

Hide “Printed By” name
on footer

Place a check mark in this option to remove the user’s name from the
“Printed by” text in the footer of the Demographics Report (page 9.23), the
Medical Information Summary (page 12.20), the Chart Report (page 10.13),
Encounter Reports (page 22.57), Referral Letters and Patient Letters
(page 26.5).

Hide “Performed By”
name on plan

Place a check mark in this option to remove the user’s name from the
“Performed by” text in the Plan section of the encounter reports
(page 22.57).
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Table 1.11 Fields on the Practice Settings Window (continued)

Field

Description

Hide “Electronically
viewed by” on lab results

When a user marks a lab result as viewed, the system displays and prints
their name and date at the bottom of the result printout. If the user has
permission to mark lab results as viewed on behalf of the Results To
provider on the order, the system displays “on behalf of” in the footer.
Place a check mark in this option to remove this text from the printout.



This does not include CC results, only the original.

Patient Education Source

Select the default web site from which your practice would like to pull
patient education documents in an encounter. The recommended site is
Medline for quality and speed of retrieval.

Include Referral Orders in
MU CPOE

In the incentive programs with CPOE objectives, many practices refer
procedures and labs out of their practice. These actions still qualify for the
measure. If your practice has this workflow, you can place a check mark in
this option to count referral orders in the CPOE objectives when the
procedure(s) within the order qualify for the measure.

Chart
Max no of charts open
concurrently

From this drop-down, select the number of charts a physician can have
open at one time.

Workflow information
delete

The choice made from this drop-down defines how MicroMD EMR handles
workflow items when a user deletes an entry. “Workflow items” are those
entries represented in the patient’s Workflow Communicator (page 10.19).

 Remove From Database: This hides the deleted record from the
display in the program; however, it does not remove it completely
from the system. The items appear when you generate the audit
report.

 Strike-out Data: This choice does not delete the record from the
MicroMD EMR database. Instead, the system displays the deleted
entries with a horizontal line through them (i.e., strike through).
Default immunization
consent form

Click the Lookup icon (
) and select the proper consent form from the
Immunization Consent Forms reference list viewer. This is the default
immunization consent form for the practice.

Default chart access
authorization form

Click the Lookup icon (
) and select the proper consent form from the
Access Consent Forms reference list viewer. This is the default chart access
consent form for the practice.

Export Chart

Place a check mark next to the type of file you want to create when users
export or publish patient health records. You can choose just one type or
you can choose to export multiple formats.
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Table 1.11 Fields on the Practice Settings Window (continued)

Field

Description

Encounters
Maximum unsigned
encounters

The number in this drop-down allows practices to specify the maximum
number of unsigned encounters that each provider can have in the
system. When a provider reaches the maximum, they are unable to create
a new encounter until they sign some of the existing unsigned encounters.

Automatically bill when
signing

Choose this option to send encounters to billing automatically when
physicians sign them.

Max no of held encounters

This number sets the maximum number of encounters a provider can have
open at the same time and minimized to the Holding Area (page 22.38).
The maximum is nine encounters.

Max revisions per signed
encounter

This number restricts the number of times users can create revised
encounters of a completed encounter in the system (page 22.34).

CCM Auto Billing

Place a check mark next to this option to enable automated billing for the
Chronic Care Management module. After midnight on the last day of the
month (so it can include the full last day), the system automatically
determines whether there is enough Complex time recorded for each of
your CCM patients to bill the higher-value codes. If there is not enough
complex time recorded, but there is enough Non-Complex time recorded
for billing, the system sends the non-complex CCM codes over to the PM
for billing. See page 17.31 for more in-depth details on the CCM module.

Medical Information
Medical information
delete

The choice made from this drop-down defines how MicroMD EMR handles
medical information when a user deletes an entry from the Medical
Information tab of a patient’s chart.

 Remove From Database: This hides the deleted record from the
display in the program; however, it does not remove it completely
from the system. The items appear when you generate the audit
report.

 Strike-out Data: This choice does not delete the record from the
MicroMD EMR database. Instead, the system displays the deleted
entries with a horizontal line through them (i.e., strike through).
Mark category as
reviewed after

This option is only available when you select Yes from Apply auto-review
of medical information. You can control the number of seconds users
must stay on a category on the Medical Information tab of the patient’s
chart before the EMR automatically updates the date and user for the Last
reviewed by notation. Enter the number of seconds in this field.

○

Each user can override this setting under Tools >
User Preferences.
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Table 1.11 Fields on the Practice Settings Window (continued)

Field

Description

Apply auto-review of
medical information

Select Yes from drop-down to have the EMR automatically update the date
and user for the Last reviewed by notation on the Medical Information
tab of the patient’s chart.

○
Vitals Measurement

Each user can override this setting under Tools >
User Preferences.

If you do not typically record certain vital signs for your patients, you can
still receive credit toward Meaningful Use. From the drop-down, select the
vital signs you do record for your patients.

 All Within Scope: You record all basic vital signs.
 BP Out of Scope: You record all basic vital signs except the patient’s
blood pressure.

 Height/Weight Out of Scope: You record all basic vital signs except the
patient’s height and weight.

Orders
Default Bill-type for Labs

The selection in this drop-down sets the default for the Bill Type dropdown on all new lab orders.

Require diagnosis on
orders

Place a check mark in the appropriate checkbox to require users in the
practice to enter a diagnosis before saving a lab order, procedure order
and/or referral order. When the user attempts to save the order, the
system prevents them from saving until they enter a diagnosis.

Default ABN(s) for
procedure orders

Click the Lookup icon (
) and select the proper form from the ABN
Forms reference list viewer. This is the default ABN form used for
procedure orders in the practice.

Directory Settings
The locations on the Directories tab under the System Settings button in the EMR Manager define several
file paths used internally by the system. The installation program for MicroMD EMR sets these
automatically, and there is seldom a need to change them.
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Figure 1.26 Directory Settings
To edit these settings, click the directory you want to edit and click the Edit button.



If you DO need to edit these settings, we recommend
that you keep the directories somewhere on the server
that all workstations can access.

Table 1.12 Fields on the Directory Settings Tab

Directory

Description

Attachments

This is the location where you can find the individual files attached to
entries throughout the system.

Audio

This is the directory on the server where you want MicroMD EMR to store
the file audio.wav that results from recording information in an
encounter, encounter note, e-mail, etc.

Cardiology

This is the directory on the server where MicroMD EMR stores all files
generated by your attached cardiopulmonary devices.

CliniGration

This is the directory where Clinigration was installed. You typically do not
need to change this direction.


Database Backup

Use extreme caution with this directory. Many services
and feature rely on this directory.

This is the directory on the server where MicroMD EMR stores any
automatic backup files created.
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Table 1.12 Fields on the Directory Settings Tab (continued)

Directory

Description

Database Data

This is the directory on the server where your MicroMD EMR database
resides. When MicroMD EMR updates to a new version, this is the
database that changes.

Dictionary

This is the directory on the server where MicroMD EMR stores the
dictionaries used for the Spell Checker (page 23.25) in the Text Editor
throughout the system (e.g., Text Encounters and Letters).

Letters

This is the directory on the server where MicroMD EMR installs the
Standard letter templates you can find when writing letters (Chapter 26).

Patient Education

This is the directory on the server where MicroMD EMR stores all the files
used for Patient Education material. This could be both the materials
made available by MicroMD EMR or added to the system by users. You
can access Patient Education material under Tools > Patient Education
Library in the main menu (page 27.8).

Server Root

This is the main directory where the MicroMD server was installed.

Shared Data

This is the location of the data shared with all workstations.

Notification Settings
The Notification Settings tab under the System Settings button in the EMR Manager allows you to
indicate whether or not to process reminders for different items in the system and how many days in
advance the patient or physician should receive that reminder.
To change any of the reminder settings, click the Edit button, make your changes and click Close. Table
1.13 explains the fields in detail.



See page 1.59 for details on establishing external
messaging.

Figure 1.27 Notification Settings Window
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Table 1.13 Fields on the Notification Settings Window

Field

Description

E-mail patient

This drop-down controls whether MicroMD EMR sends an e-mail
message to patients to remind them about future prevention
programs or immunizations that are due.
If you want to send a reminder e-mail, select the number of days in
advance of the program or immunization that you want the message
to go out. If you do not want to send a reminder, select the No
Reminder option. (See Chapter 17 for more details on the Health
Maintenance category in a patient’s chart.)

Create unscheduled appt

This drop-down controls whether you want MicroMD EMR to create an
unscheduled appointment (page 11.31) automatically for patients
with programs or immunizations that are due.
Select the number of days in advance of the program or immunization
that you want the system to create the appointment so you can notify
the patient in an appropriate amount of time.
If you do not want to create an appointment automatically, select the
No Appointment option.

Send provider reminder

This drop-down controls whether MicroMD EMR sends a reminder to
the provider to remind them about the patient’s prevention programs
or immunizations that are due.
If you want to send a reminder to the physician, select the number of
days in advance of the program or immunization that you want the
message to go out.
If you do not want to send a reminder, select the No Reminder option.

Practice Holidays
The Practice Holidays tab under the System Settings button in the EMR Manager allows you to set and
manage the list of your practice’s holidays—days on which the practice is closed. Practice holidays can be
either Public holidays (e.g., legal holidays like New Year’s Day and Memorial Day) or Events for which the
office closes its doors for the day (e.g., building maintenance or the annual tennis day).
Both public holidays and events appear in red in the appointment book of each MicroMD EMR user and
resource.
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Figure 1.28 Practice Holidays Tab



You can filter the displayed list by selecting either Public
holidays, Events or All from the View section of the tab.

The system comes with a default set of legal holidays. If required, you can add, edit, or delete from the list
provided. To edit or delete a holiday, highlight the day and click the Edit or Delete button as appropriate.
Table 1.14 explains the fields in detail.

○

When you edit or delete a holiday or event, the system
performs the same action on that item throughout the
lists of subsequent years.

To add a practice holiday to the list, simply click the Add button, enter the appropriate data for the new
holiday and click OK. Table 1.14 explains the fields of this window in more detail.
Table 1.14 Fields on the Practice Holidays Window

Field

Description

Start date

Enter the first date of the holiday or event.

Number of days

Enter the duration of the holiday or event in days.

Type

From this drop-down, select whether this day or range of days is an Event or a
Public Holiday.
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Table 1.14 Fields on the Practice Holidays Window (continued)

Field

Description

Show time as

Select how you want to the system to display this holiday or event in
Appointment Books:

 Out of Office
 Usual Office Hours
 Available for Emergencies
Annual

Indicate whether the holiday or event occurs every year on that same date or
date range. If you select Yes, the system adds the holiday or event to the list of
practice holidays in all subsequent years when you click OK.

Description

Enter the name of this holiday (e.g., New Year’s Eve, Memorial Day).

Security Settings
The Security Settings tab under the System Settings button in the EMR Manager allows you to establish
various settings that apply to users when they log in to the system. This includes how often you want users
to reset their passwords, the minimum length you want their passwords to be, and if you want any special
characters within their passwords.

Figure 1.29 Security Settings Window

○

The security settings specified on this tab apply to all
users within the system.

To edit these settings, click the Edit button, make your changes and click OK. Table 1.15 explains the fields
on this window in more detail.
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Table 1.15 Fields on the Security Settings Window

Field

Description

Security Settings
Require password
changes every

Specify the frequency with which users are required to change their
passwords. If a user’s password remains unchanged for the specified
maximum period, MicroMD EMR asks the user to enter and confirm a new
password.

Do not allow reuse of
passwords within

Place a check mark in this checkbox to prevent users from using the same
password when resetting their password. You can specify the amount of
time that should pass before the system lets them use a previous password.

Lock MicroMD EMR after

If you want the system to automatically lock terminals for users after a
certain period of idle time, place a check mark in this checkbox and set the
number of idle minutes or hours that must pass before the system locks the
workstation. The limit is two hours.

Allow X failed logins
before suspending use

From the drop-down, select the maximum number of total unsuccessful
login attempts you want to permit users before MicroMD EMR locks their
account completely. Once the system locks the user account, that user
cannot access MicroMD EMR until an administrator resets their account.

Password Strength
Minimum size of
password

From the drop-down, select the minimum number of characters you want
to accept as a password from the users in the system.

Password must contain
numbers

Place a check mark in this box if you want to force users to include at least
one numerical digit (i.e., 0–9) in their password.

Password must contain
upper and lower case
letters

Place a check mark in this box if you want to force users to include at least
one uppercase alpha character (i.e., A–Z) and at least one lowercase alpha
character (i.e., a–z) in their password.

Password must contain
special characters

Place a check mark in this box if you want to force users to include at least
one non-alphanumeric character (e.g., %, $, #, @, !) in their password.

Encryption Passphrase

The Encryption Passphrase is a system-specific encryption key code that
allows your practice to run an algorithm on a patient record file and render
it unreadable without your key code. You use this with the Encrypt File and
Decrypt File features in the patient’s chart (page 10.17).
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Prescriptions
The Prescriptions tab under the System Settings button in the EMR Manager allows you to control
prescriptions in your practice. There are various requirements made for sending prescriptions, as well as
certain preferences practices have for the forms they want to use when printing and faxing. This section of
the EMR Manager allows you to manage these.

○

These are system-wide preferences, and the requirements
apply to all users within the system.

Figure 1.30 Prescription Defaults Window
To edit these settings, click the Edit button, make your changes and click OK. Table 1.16 explains the fields
in detail.
Table 1.16 Fields on the Prescription Defaults Window

Field

Description

Allow provider to select
prescription type

This drop-down controls whether or not providers can select the format of
the prescriptions they print. If you select Yes, providers can select the
following standard prescription formats from the Prescription Pad
(page 21.8).
If you do not permit providers to select the format of their prescriptions,
MicroMD EMR prints all prescription in the Standard MicroMD EMR format.
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Table 1.16 Fields on the Prescription Defaults Window (continued)

Field

Description

Default prescription form
for print

If you must send different information when you fax a prescription than
when you print a prescription, you can set the form defaults at the practice

and

level here in the EMR Manager. Click the Lookup icon (
) next to the
appropriate drop-down and insert the form. (See page 21.2 for details on
creating prescription form templates.)

Default prescription form
for fax

 5 on a page: Prints up to five prescription entries on a single-page
prescription. The prescriptions may not be valid for presentation at all
pharmacies.

 Customized – California (5 on pg), Customized – NY, Customized – Ohio
Fax, and Customized – Ohio Print: Prints a prescription form
customized to meet California, New York or Ohio requirements.

 Customized (supervisor): The same as Customized Type 1 but includes
the name of the supervising provider.

 Customized Type 1: Prints a customized prescription. Not
recommended for general use.

 Customized Type 2: Prints a customized prescription. Not
recommended for general use.

 Sample: Prints a prescription that indicates that a sample was
dispensed. The prescription is not valid for presentation at a pharmacy.

 Standard: Prints the standard MicroMD EMR prescription.
 Standard w. Associated Diag: Prints the standard MicroMD EMR
prescriptions, but it also prints the diagnosis(es) added to the
medication in the Associated Diagnosis field.



To limit the users in your practice to print or fax using
only the forms you specify here, select No from the
Allow provider to select prescription type dropdown.

Default Drug-Drug
Warning level

In this drop-down, select a default drug-to-drug warning level for the
practice. When there is a warning between the medication being entered
and a medication already listed on the patient’s chart, only the type of
warning you select from this drop-down appears to the user (page 1.86).

Default Drug-Allergy
Warning level

In this drop-down, select a default drug-to-allergy warning level for the
practice. When there is a warning between the drug being entered and an
allergy listed on the patient’s chart, only the type of warning you select from
this drop-down appears to the user (page 1.86).
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Table 1.16 Fields on the Prescription Defaults Window (continued)

Field

Description

Sending Schedule Drugs

Controlled substances are heavily regulated, and many states have
regulations regarding the electronic transmission of prescriptions.
Depending upon your state, you may be required to prohibit the electronic
transmission of Schedule II and/or Schedule III – V controlled substances.
Select Yes or No from the Faxing and Electronic drop-downs in the
appropriate column to allow or prevent users from sending those
prescriptions electronically.

Remind provider to print
prescription history
report every

Some states require that providers generate a report of all prescriptions
they have prescribed, sign it and keep it for their records or send it to the
pharmacy board. To remind providers to do this, select the time frame from
this drop-down.

Prescription copies
should be marked ‘Copy’

You can have MicroMD EMR print the word “Copy” on duplicate
prescriptions, even if the first method was faxed or sent through
Surescripts. Your state may require the word “Copy” on any duplicate
prescription. See page 21.38 for details on this feature.

e-Prescribing incentive
G codes on bill

To qualify for the e-prescribing incentive payments, physician must submit
the G code G8553 when the encounter meets certain criteria. This option
allows MicroMD EMR to detect that criteria for you and automatically add
that G code to the bill.

Third-Party Document Management Settings
The 3rd Party DMS tab under the System Settings button in the EMR Manager allows you to configure
MicroMD EMR to meet your Document Management System (DMS) needs. Once you complete some initial
setup, you can launch the third-party application instead of the standard EMR document management
interface.



Please contact your local authorized MicroMD EMR
reseller for more information about working with a
third-party DMS. In addition, MicroMD PM + EMR users
configuring TouchChart software may need additional
assistance to synchronize with proper chart IDs.

To edit this information, click the Edit button on the tab to display the Document Management Settings
window (Figure 1.31). Enter all appropriate settings and click OK. Table 1.17 explains the fields in detail.



When you select an application from the drop-down,
MicroMD EMR enters any defaults available to make your
job easier. Be sure to work with your DMS vendor to verify
any parameters needed.
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Figure 1.31 Configure Third-Party DMS



Click the Restore Defaults button to reset the
parameters back to the defaults for the selected
application. The system enables this button once you
make changes in either the Dynamic Parameters or
Static Parameters section.

Table 1.17 Fields on the Documentation Management Settings Window

Field

Description

Document Management Settings
Document Management
System

From this drop-down, select the third-party document management system
you purchased. Once you make a selection, the system enters any default
parameters available.

Application Path

Enter the path to the *.exe file of the third-party DMS. You can also click the
Browse icon (
) to locate the file.

Attachment Path

Enter the path where you want MicroMD EMR to store attachments added in
the system so the third-party application can retrieve them. You can also
click the Browse icon (
) to locate the file.
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Table 1.17 Fields on the Documentation Management Settings Window (continued)

Field

Description

Dynamic Parameters
User Name

Place a check mark in this checkbox if you want to send a user name to the
third-party DMS. By default, the system sends the user currently logged in to
the EMR.
If you want to use the same user name each time, remove the check mark
from the User Name checkbox and place a check mark in one of the Static
Parameter checkboxes. Enter the parameter name (e.g., /USER:) in the
Parameter Name field and enter the static user name in the Value field (e.g.,
george).

Password

Place a check mark in this checkbox if you want to send a password to the
third-party DMS. By default, the system sends the password of the user
currently logged in to the EMR.
If you want to use the same user password each time, remove the check
mark from the Password checkbox and place a check mark in one of the
Static Parameter checkboxes. Enter the parameter name (e.g., /PASS:) in the
Parameter Name field and enter the static user password in the Value field
(e.g., Adm1n123#).

External Patient ID

Place a check mark in this checkbox if you want to send the ID for the patient
(in the External MRN field of the patient’s demographics) to the third-party
DMS.
Some software system require a dash ( - )in the patient’s ID number, rather
than an underscore ( _ ). Place a checkmark in the Replace the dash with an
underscore in the External Patient ID checkbox to have the system send
underscores instead of dashes to the third-party DMS.

Chart No

Place a check mark in this checkbox if you want to send patient chart
numbers (automatically assigned by MicroMD EMR) to the third-party DMS.

Clinic

Place a check mark in this checkbox if you want to send the code for the
current user’s clinic to the third-party DMS. You can find this ID in the
External Id field (page 1.5) of the clinic in effect when the user accesses the
third-party DMS.

Patient Name

Place a check mark in this checkbox if you want to send the patient’s name
to the third-party DMS.

Patient SSN

Place a check mark in this checkbox if you want to send the patient’s social
security number to the third-party DMS.

Static Parameters
Static Parameter 1
through
Static Parameter 6

Place a check mark in any of these checkboxes if you want to send a set
parameter and value to the third-party DMS. Type the parameter name in the
Parameter Name field and the specific value in the Value field.
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Orders Tab
The Orders tab in the System Settings Manager allows you to create new order types that appear
anywhere you create orders in the system (e.g., on the Plan tab of an encounter or the Orders section of
your Desktop). The system comes with standard order types, but if, for example, your practice wants to
break out “Nursing Orders” into different categories, you can do that here in the EMR Manager.

Figure 1.32 Orders Tab
To add a new Order Type, click the Add button, enter the name and descriptions, and click OK. Your new
type appears in the list and will be available in all encounters from now on. Table 1.18 explains the fields
on this window in detail.



To hide certain order types that your practice does not
use, each user can hide those order types under Tools >
User Preferences > Order Types. See page 1.94 for
details.

Table 1.18 Fields on the Order Type Details Window

Field

Description

Order Type

Select the type of orders that you want to create with this new order type. These
are standard and cannot be changed.

Description

Enter some identifying information regarding the purpose of this new order type.
This text only appears in the list here in the EMR Manager.

Short Description
for Plan Tab

Enter the text you want to appear in the application.
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Configuring External Communication
MicroMD EMR is able to communicate with a variety of external systems, including practice management,
laboratory software, telephony, vaccine registries, and more. You use the MicroMD EMR System Integration
Wizard to configure most of the communication with external systems. Using the wizard, you specify the
method of communication (e.g., FTP or web service), the schedule for sending and receiving data, along
with various other communication details. The information that can be communicated between the
systems includes patient demographic information, insurance information and billing information.



You must have the MicroMD EMR Integration Module
installed to establish successful communication
between the EMR and most of the listed external
systems. Please contact your local authorized MicroMD
EMR reseller for more information.

Figure 1.33 Configuring External Communications



You can add a practice management system for
communication only if no practice management
systems are currently specified for communication with
MicroMD EMR.



If you want to establish fax settings, you must have the
MicroMD EMR Fax Manager installed on the machine you
want to use for faxing.
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Configuring Communication with External Systems
When you add or edit a communication setting, the System Integration Wizard opens (Figure 1.34). The
System Integration Wizard has several steps, and each step allows you to configure various aspects of the
communication. The details that appear in each step of the wizard vary, depending on the external system
you want to configure and the exchange method you choose.

Figure 1.34 System Integration Wizard
Communication between MicroMD EMR and external systems can be either uni-directional or bidirectional.

 Uni-directional (sending or receiving, not both): MicroMD EMR sends information to the external
system but does not receive information from the external system; or MicroMD EMR receives
information from the external system but does not send information to the external system.
For example, Betty at Advanced Family Practice uses a telephony application to export the
appointments on her schedule. That third-party application then uses the information it
receives to call her patients and remind them of their appointments. There is no information
that comes back from the telephony application.

 Bi-directional (both sending and receiving): MicroMD EMR sends information to the external
system and receives information from the external system.
For example, Betty at Advanced Family Practice has a lab system interfaced with her EMR. Her
EMR sends requests for laboratory tests to the external system. The tests are performed based
on those specifications. The EMR can then receive the results back from the laboratory and
enter the data into the EMR.
You can edit or delete existing configurations. Highlight the appropriate system and click Edit or Delete as
appropriate.
To add a new communication setting:

Procedure

Details

1. Click the Communication button in the EMR
Manager.
2. In the System column on the left, highlight the
type of system you want to add.
3. Click the Add button.
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Procedure (continued)

Details (continued)

4. From the Product Name drop-down, select
the system to which you want to establish
communication.

Depending the on the type of system you chose in
step 2, this drop-down displays only the products
available for that type of system.
For example, if you chose Laboratory in the System
column, the system only displays the available
laboratory products in this drop-down.

5. Complete the remaining steps of the wizard as
appropriate for the external system and click
Finish when complete.

The fields you have available to edit depend solely
on the system you want to configure. Table 1.19
explains the fields that may be available.

Table 1.19 Fields Available in the System Integration Wizard

Field

Description

System Details Screen (Step 1)
Product Name

Select the external system for which you want to establish communication
settings. The list of available products depends on the type of system you
select from the System column.

Vendor

When you select the product from the Product Name drop-down, the system
populates this field automatically for your information.

Exchange Mechanism

Specify the method that MicroMD EMR uses to communicate with the selected
external system. The choices available on the Communication Parameters step
vary depending on the choice you make here.

 Shared Directory: Select this option when the EMR and the external system
communicate across the network using a set folder.

 TCP – Socket Connection: TCP/IP is a computer address pointing to the
external system (e.g., 198.168.1.1). Select this option if communicating
directly to a specific computer.

 FTP: Select this option when the EMR and the external system
communicate using File Transfer Protocol (FTP). You can set your login and
password later.

 SSH FTP: Select this option if the file created is encrypted for a secure FTP
site. SSH is a type of “hashing” of the data.

 HTTP: Select this option when the EMR and the external system
communicate using Hypertext Transfer Protocol (HTTP).

 Web Service: Web services run in the background and allow the system to
communicate over the Internet without opening a web browser.
Exchange Mode

Specify the exchange mode that MicroMD EMR uses to communicate with the
selected external system:

 Batch: Select Batch to set the system to send outgoing data and to poll for
incoming messages based on a schedule that you specify.

 Continuous: Select Continuous to set the system to send outgoing data
immediately to the external system and to poll for incoming messages
from the external system continually.
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Table 1.19 Fields Available in the System Integration Wizard (continued)

Field

Description

Tasks and System Schedule Screen (Step 2)
Active and Task

Based on the type of external system, this section displays the task(s) you need
to configure. Task is a read-only field. Place a check mark in the Active box to
enable the task.
For example, if you choose a lab interface, but you only receive results for the
labs you submit to the company, you would activate the Lab Results task and
leave the Lab Requests task deactivated.

Computer Name

Type the name of the computer on which the EMR and the external system
store/retrieve the data exchange files.
For example, the name of Advanced Family Practice’s server machine is
“micromd_srv”. Betty typed micromd_srv in the Computer Name field as
she was setting up the communication to her third-party lab system.

Path

For the computer you entered in the Computer Name field, enter the location
on that computer where both the EMR and the external system store/retrieve
the data exchange files based on the type of task indicated.
For example, Betty has established the folder for receiving her lab results, so in
the Path field for her Lab Results task, she typed c:\labs\in. She’s already
told the systems that the c:\ directory is on the server using the Computer
Name field.

○

If you choose Shared Directory from the Exchange
Mechanism drop-down on the first step of the
wizard, the Path field indicates the location of the
shared directory.

Create Paths button

Click this button to create the folders defined in the Computer Name and Path
fields. It also creates the sub-folders required for communication (e.g., in and/
or out).

Schedule for sending

When you select Batch from the Exchange Mode drop-down in the first step of
the System Integration Wizard, the system enables this section. This section
allows you to create the schedule for MicroMD EMR to send and retrieve data to
the selected external system.

and
Schedule for
receiving

Simply click the Edit button to edit the schedule. (The Edit button is only
available for active tasks.)

Communication Parameters (Step 3 when using TCP Socket Connection)
These options are only available if you select TCP – Socket Connection from the Exchange Mechanism
drop-down in the first step of the wizard.
Send – host

1.56

Enter the TCP/IP address of the external system receiving the data sent from
your server.

MicroMD EMR User’s Reference Manual Version 16.0

Configuring External Communication

Chapter 1. Setup and Preferences

Table 1.19 Fields Available in the System Integration Wizard (continued)

Field

Description

Send – port

Enter the port through which the EMR server sends the information to the
external system.

Receive – host

Enter the TCP/IP address of your EMR server.

Receive – port

Enter the port through which the external system will send data to your server.

Timeout

For those times when the system fails to connect, enter how many seconds you
want to pass before the system stops trying.

Communication Parameters (Step 3 when using FTP)
These options are only available if you select FTP or SSH FTP from the Exchange Mechanism drop-down
in the first step of the wizard.
Upload FTP Path and
Download FTP Path

Enter the web address and location on the FTP site to which your FTP client can
upload files from the EMR (Upload FTP Path) or that contains the files the EMR
can download into the system (Download FTP Path). Entering the correct
path(s) allows the system to establish connection and transfer files.



For a UNIX-based FTP, the Upload FTP Path and
the Download FTP Path fields are case-sensitive.
Make sure you enter the paths EXACTLY, including
the same case for all letters.



FTP addresses typically take the form of ftp://
ftp.company.com, although they can vary.

Login Name

Enter the FTP login name to use when the MicroMD EMR Integration Module
attempts to access the FTP site.

Password

Enter the password to use when the MicroMD EMR Integration Module attempts
to access the FTP site.

Enable SSL or
Enable PKI

Place a check mark in this box to use secured socket layer (SSL) or public key
infrastructure (PKI) for the exchange of files, depending if you selected FTP or
SSH from the Exchange Mechanism drop-down.

Communication Parameters (Step 3 when using HTTP)
These options are only available if you select HTTP from the Exchange Mechanism drop-down in the first
step of the wizard.
Login Name and
Password

Enter the login name and password the MicroMD EMR Integration Module
should use when it attempts to access the web site entered in the IP Address/
URL field.

Timeout

For those times when the MicroMD EMR Integration Module cannot connect to
the web site listed in the IP Address/URL field, indicate the number of seconds
that should pass before the system cancels its attempts.
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Table 1.19 Fields Available in the System Integration Wizard (continued)

Field

Description

IP Address/URL

Enter the internet protocol (IP) address (e.g., 192.168.1.100) or universal
resource locator (URL) address (e.g., http://www.company_name.com) of the
web site with which you want to exchange files.

Client Certificate File

Enter the path and name of the file that contains the client certificate for the
site. This certificate file is what authorizes your system’s connection to the site.

System-Specific Data (Step 4 for Practice Management System – MD Serve only)
Multiple Accounts

Select Yes or No. Select Yes to allow multiple medical charts for a patient to be
created based on accounts in the Practice Management System.

System-Specific Data (Step 4 for Laboratory Systems)
Sending Facility

Enter the name of the sending facility.

Receiving Facility

Enter the code of the branch to which the practice sends its laboratory
specimens. The branch code is also known as the receiving facility.

Request Form

From the Type drop-down list, select the format of the request form required by
LabCorp. You can choose Standard Form or Standard Form (with stickers). In
the Title field, type the text that should print on all LabCorp lab-request forms
to identify your practice. This option is available only if you select LabCorp from
the Product Name drop-down in the first step of the wizard.

Margin Sizes

The Margin Sizes fields help you accurately position label text on your
laboratory labels. These values compensate for slight differences that occur in
page size and label positioning when you purchase a new batch of labels.
Specify a value for the adjustment where 1000 units equals 1 inch.

 Left: The value in the Left field moves the text of the labels away from the
left margin of the label page in toward the center.

 Bottom: The value in the Bottom field moves the text of the labels away
from the bottom margin of the label page in toward the center.
For example, Advanced Family Practice needs to adjust the printing by a
sixteenth of an inch from the left so the text isn’t cut off the label. In the Left
field, Betty types a 62. She divided 1000 by 16 (i.e., a sixteenth of an inch) to
reach 62.5 and found that 62 was close enough for her needs.
Label Print and
Default Qty

Place a check mark in this checkbox when you would like to print labels for lab
orders. In the Default Qty drop-down, select the number of labels to print each
time.

Label Template

Select the template you would like to use from the drop-down menu.

Account

Laboratories provide practices with account numbers that they use for billing
purposes. Click the Add button to enter the account number(s) provided by
your laboratory system. MicroMD EMR lets users select from this account list
when creating a laboratory request. Refer to your laboratory system guide for
information on account numbers and account codes. To delete account
information, simply highlight the account entry and click Delete.
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Table 1.19 Fields Available in the System Integration Wizard (continued)

Field

Description

Advanced Beneficiary
Notice (ABN) of NonCoverage

Select the English and Spanish versions of your Advance Beneficiary Notice
(ABN) of Non-coverage.

System-Specific Data (Step 4 for Diagnostic Tests)
Providers and
Facilities

Click the lookup icon next to the Providers and Facilities field and select the
providers and facilities that send and receive tests from the interface.

Sending Facility

Enter the name of the sending facility.

Receiving Facility

Enter the code of the branch to which the practice sends its diagnostic tests.
The branch code is also known as the receiving facility.

Receiving Application

Enter the application used to receive diagnostic tests.

System-Specific Data (Step 4 for Health Exchange)
Sending Facility

Enter the name of the sending facility.

Receiving Facility

Enter the code of the branch to which the practice sends its health exchange
data. The branch code is also known as the receiving facility.

Receiving Application

Enter the application used to receive diagnostic tests.

System-Specific Data (Step 4 for Direct Mail)
Clinic

Select the clinic or clinics that will be authorized for Direct Mail. Place a check in
the box of each clinic you select.

Department

Select the department or departments that will be authorized for Direct Mail.
Place a check in the box of each clinic you select.

User

Select the user or users that will be authorized for Direct Mail. Place a check in
the box of each user you select.

Configure Practice E-Mail Settings
MicroMD EMR is able to send a variety of e-mail messages to patients. The e-mail messages that can be
sent by MicroMD EMR include:

 Prevention reminders
 Immunization reminders
 Appointment reminders
The E-Mail option in the System list (Figure 1.33 on page 1.53) allows you to define the technical aspects of
how MicroMD EMR sends those messages to your patients. The settings include the sending e-mail
address, the SMTP host number and a few other settings.
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Figure 1.35 E-mail Settings Window
To edit the e-mail communication settings, simply click the Edit button, make your changes and click OK.
Table 1.20 explains these fields in detail.
Table 1.20 Fields on the Edit E-mail Settings Window

Field

Description

User name

Enter the name you want MicroMD EMR to insert as the sender’s name in all
outgoing e-mail messages.
For example, Advanced Family Practice has an e-mail account established called
“MicroMD EMR Reminder” with the e-mail address reminder@advancedfam.com.
In the User name field, Betty typed MicroMD EMR Reminder.

E-mail

Enter the e-mail address you want MicroMD EMR to insert as the sender’s e-mail
address in all outgoing messages.
For example, Advanced Family Practice has an e-mail account established called
“MicroMD EMR Reminder” with the e-mail address reminder@advancedfam.com.
In the E-mail field, Betty typed reminder@advancedfam.com. When a patient
clicks Reply after receiving a MicroMD EMR notification e-mail, the reply goes to the
address specified in the field.

E-mail service

From the drop-down, select the type of service that your practice uses to send email messages. If you select SMTP, the system enables the SMTP host field.

SMTP host

Enter the SMTP host address for the practice. This is typically an IP address for your
e-mail program. This option is available only if you select SMTP from the E-mail
service drop-down. Please contact your system administrator for more assistance.
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Establishing Practice Reference Lists
The Reference Lists Manager allows you to customize the MicroMD EMR Reference Lists to meet the
specific requirements of your site. These lists range from new items created in the system by all users,
including (but not limited to) new allergies, new habits, new appointment types and new patient signs.
Generally, if a user cannot find an item that meets their needs, they can create a new entry in the database
for that item.

○

Only users with the Add reference data function assigned
to their user account can create new entries in the
database for these items.

User-Defined Additions
MicroMD EMR allows users with the Add reference data function to add new items to any of the standard
Reference Lists in the system. Users with access to the MicroMD EMR Manager can add entries through the
Manager. To access this section, click the Reference Lists button in the MicroMD EMR Manager and verify
that you have the User-Defined Additions tab displayed (Figure 1.36).

Figure 1.36 User-Defined Additions

○

You can use either the MicroMD EMR Manager or MicroMD
EMR itself to add user-defined entries. However, you can
edit and delete existing entries only with the MicroMD
EMR Manager.

To edit or delete a user-defined entry, simply highlight the entry and click Edit or Delete as appropriate.
There are some reference lists from which you cannot delete user-defined entries (e.g., Habits and
Occupations).
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If you cannot delete an entry, but it is no longer required, you can highlight the entry and click the Make
Obsolete button. This prevents the item from appearing in the associated Reference List. This is also
useful if you do not want to delete an entry, but you want to keep it in the system for record-keeping
purposes. If you need this entry again in the future, you can simply highlight it and click the Make
Available button.
To add a new user-defined entry to a Reference List:

Procedure

Details

1. Click the Reference Lists button in the
MicroMD EMR Manager and verify that you
have the User-Defined Additions tab
selected.
2. In the Reference Lists section on the left,
highlight the list to which you want to add an
entry.

On the right side of the window, the system
displays the current user-defined entries for the
selected Reference List.

3. Click the Add button.

Depending on the list you selected, the window
that opens varies.

4. Enter the details of the new entry and click OK. The MicroMD EMR Manager inserts the new userdefined entry into the appropriate list.

Practice-Wide Common Lists
For use with the patient demographics window only, MicroMD EMR provides a way for you to customize
the Common List for relationships, languages, nationalities, etc. specific to the needs of your practice.
These are your practice-wide Common Lists, available to all MicroMD EMR users that can edit patient
demographics.

Figure 1.37 Practice-Wide Common Lists
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MicroMD EMR comes with a default set of practice-wide Common Lists that you can modify to meet the
specific requirements of your practice.

○

You can use either the MicroMD EMR Manager or MicroMD
EMR itself to maintain practice-wide Common Lists.

To remove an entry from the list, highlight the entry on the right and click the Delete icon (

).

To add an entry to a practice-wide Common List:

Procedure

Details

1. Click the Reference Lists button in the
MicroMD EMR Manager and verify that you
have the Practice-Wide Common Lists tab
selected.
2. From the Reference Lists drop-down, select
the list to which you want to add an entry.

The system displays the current Common List for
the practice on the right.

3. Search for the entry you want to add using the
Search field.
4. Highlight the entry and click the Add button.

The system copies the entry to the practice’s
Common List.

5. Repeat step 2 through step 4 for each entry
you want to add to the practice-wide
Common List.

Practice-Preferred Lists
MicroMD EMR allows your practice to maintain lists of those procedures, medications, labs and nursing
instructions that they prefer everyone in the practice to use. This helps all providers and staff to
standardize their care across the practice. These lists are available from the Smart button in certain
Reference List Viewers, and the MicroMD EMR Manager allows you to manage the entries in these preferred
lists.
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Figure 1.38 Practice-Preferred Lists
To remove an entry from the preferred list, simply highlight the entry and click the Delete icon (

).

To add an entry to a Practice-Preferred list:

Procedure

Details

1. Click the Reference Lists button in the
MicroMD EMR Manager and verify that you
have the Practice-Preferred Lists tab
selected.
2. From the index tabs on the right side of the
window, click the list to which you want to add
an entry (e.g., Medications).

The system displays the current Practice-Preferred
List on the right and the entries of the selected
Reference List on the left.

3. Search for the entry you want to add using the
Search field and filter buttons on the left side
of the window.
4. Highlight the entry and click Add.

The system copies the entry to the practice’s
Preferred List.

5. Repeat step 2 through step 4 for each entry
you want to add to the list.
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Customizable Lists
With the Customizable Lists tab, MicroMD EMR allows you to customize the refund eligibility options for
your practice when using immunization registries. You also use this tab to create stations and flag colors to
use with Scheduled Visits.

Flag Colors
We designed the flags in the EMR to mimic the flags you may have outside the rooms of your practice.
To customize the list of flag colors, click the Reference Lists button and click the Customizable Lists
tab. Under Flag Colors, simply click the Add, Edit or Delete button as appropriate. You can include any
description you like for the flags. For example, you can add the description of “Blood Work” to show
the staff that a patient has particular lab work that must be done.



To see the description associated with a flag color, hover
your cursor over the flag in the Scheduled Visits area of
the Desktop (page 4.32).

Figure 1.39 Flag Colors Window
Flag colors are fully customizable by selecting Custom from the Color drop-down on the Flag Colors
window. This opens the standard Microsoft® Windows® Color window, which allows you to select from
basic colors, as well as select colors from a spectrum.

○

You are not required to label a flag. The system
automatically labels the flag with the color you select
from the standard list of colors provided. If you customize
a new color, you must include a description.
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Station List
The stations in the system should relate to actual locations in your practice, such as exam rooms or
vitals areas. You customize the Station List using the MicroMD EMR Manager. To access and edit the list
of stations, click the Reference Lists button and the Customizable Lists tab (Figure 1.40). Under
Station List, simply click the Add, Edit or Delete button as appropriate.

Figure 1.40 Station List Options

○

The Checked In and Seen Today options are systemgenerated and cannot be deleted.

Setting Up Risk Scores
For use with the Health Concerns feature (and to help satisfy a Comprehensive Primary Care Plus
(CPC+) requirement, you can create a Risk Score to identify and flag patients with complex needs. You
can create custom risk scores/labels based on a risk stratification methodology and associate those
risk scores to patient Health Concern entries (page 17.25). You can then generate patient lists and
reports based on these risk scores/labels. (You can find the Health Concern reports under Risks and
Goals and Patient Groups.)
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Figure 1.41 EMR Manager
To set up a risk scores:

Procedure

Details

1. Click the Reference Lists button.
2. Click the Customizable Lists tab on the
window.
3. To add a risk score, highlight Risk Score in
the Customizable Lists section and click the
Add button.
4. Enter a Description, Score and Code for the
risk score in the window that displays.

Description: Enter a brief description of the risk
score’s meaning (e.g., High, Low).
Score: This is the numerical value for the score
represented by this entry.
Code: This field is currently not in use.

5. Click OK and the risk scores that you added
are now available in the EMR software.
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Compound Vaccines
The system allows you to specify the vaccines included in a compound vaccine and establish a link
between the individual vaccine and the compound in which it appears. When administering the
vaccine, the system alerts the user that the vaccine is now part of a compound vaccine and gives them
the option to document whether they used the compound vaccine or an individual vaccine.

Figure 1.42 Adding a Compound Vaccine
When a user administers a compound vaccine, the system replaces the individual vaccine entries in
the patients record with the word “Replaced” to reflect the fact that a compound was given on a
particular date in place of individual vaccines.
To add a new compound vaccine in the EMR Manager, click the Add button and complete the fields on
the Specify the Compound Vaccine window. Enter the appropriate code and click the Lookup icon ( )
next to the Compound for field to associate the multiple individual vaccines represented by the
compound vaccine.

Refund Eligibility
The Refund Eligibility options are for use with immunization registries. You can add new codes to the
list, and edit or delete existing codes. When adding codes, you can choose to add codes individually or
to do a batch import by copying from pre-defined code lists. All changes that you make are available to
all MicroMD EMR users in your practice.

Figure 1.43 Setting Refund Eligibility
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To add a new entry to the list, simply click the Add button and enter the Description and Code for the
new entry. Click OK when finished.
To edit or delete a code, highlight the code and click the Edit or Delete button as appropriate. You can
only edit the description of an existing code. You cannot edit the code itself.

Replacement Vaccines
There are times when your practice receives a new vaccine to replace an existing one in the system.
Or perhaps you receive a compound vaccine to replace a series of individual vaccines in the system
(page 1.68). The system allows you to designate replacement vaccines and link a new code to the
obsolete one.

Figure 1.44 Adding a Replacement Vaccine
To add a new replacement vaccine in the EMR Manager, click the Add button, enter the old code, enter
the new code and click OK.
When a user enters the obsolete code in the system, the EMR displays a message to let them know that
a replacement exists and allow them to determine whether they want to use it.

Medical Information Category Titles
In MicroMD EMR, when you open a patient’s chart and click the Medical Information tab, you have a
chart navigator that appears on the left side of the chart (page 12.2). Depending on your practice type,
you may not need to display every section, you may prefer them to display in a different order, or you
may prefer to call a section by a different name that is more commonly used in your practice. You may
want to create an additional category to match your users’ needs.
To learn more about the Chart Navigator, how to customize the categories and to create Navigator
Templates, please see Chart Navigator on page 10.5.

MicroMD EMR User’s Reference Manual Version 16.0

1.69

Chapter 1. Setup and Preferences

Establishing In-House Settings

Establishing In-House Settings
The MicroMD EMR Manager allows you to specify which procedures and laboratory panels and tests are
performed within the practice. These are called in-house procedures and in-house laboratory panels. You
can also identify those custom orders you have established with outside laboratories.

Figure 1.45 In-House Settings

Defining In-House Procedures
The MicroMD EMR Manager allows you to specify which procedures your practice performs in-house and
which resource(s)—whether specific users, facilities or practice locations—perform those procedures. Each
procedure that you define as an in-house procedure must be associated with a resource within the
practice. This is the resource that performs the procedure.
For example, John Abbott performs the colonoscopies for Advanced Family Practice. Betty associated
John Abbott with the colonoscopy procedure. By the same token, they have a facility created for each Xray machine at their practice. Betty has associated the X-ray procedures with both machines.

○

You can associate each procedure with multiple
resources if needed.

When a MicroMD EMR user records an encounter, the user can display a list of all in-house procedures. By
selecting from this Smart List, the user knows that the practice performs the selected procedure in-house.
To delete a procedure from a resource, simply highlight the resource, highlight the procedure and click the
Delete button.
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To add an in-house procedure to a resource:

Procedure

Details

1. Click the In-House Settings button and verify
that you have the Procedures tab displayed.
2. In the Resources section, highlight the
resource to which you want to assign a
procedure.

The system displays the in-house procedures on
the right currently assigned to the selected
resource. A detailed description of the selected
procedure appears in the yellow are below the
Procedures performed in-house section.

3. Click the Add button.

The Reference List Viewer window opens and
displays the Procedures Common List.

4. Select the procedures you want to add to the
list and click the Insert button.
5. Repeat step 3 and step 4 for each procedure
you want to assign to the selected resource.

Defining In-House Laboratory Panels
The MicroMD EMR Manager allows you to define the list of laboratory panels performed within the practice
(or “in-house”). Each laboratory panel is composed of a number of tests. You can add tests to an in-house
laboratory panel, and edit or delete existing tests.

Figure 1.46 In-House Labs
When a MicroMD EMR user records an encounter, the user can display a list of all labs performed with the
practice’s own resources. By selecting from this Smart List, the user knows that the practice performs the
selected labs in-house.
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To edit or delete a panel from a lab, simply highlight the panel and click the Edit or Delete button as
appropriate.
To add a panel to the list of in-house labs:

Procedure

Details

1. Click the In-House Settings button and
verify that you have the Inhouse Labs tab
displayed.

The system displays the in-house lab panels currently
created in the system. A list of the tests within the
selected panel appears in the yellow area at the
bottom of the window.

2. Click the Add button.

The Add In-house Panel window opens.

3. In the Panel Num field, type the appropriate
number for this group of tests.
4. From the Type drop-down, select the
specimen type required to complete this
panel of tests.

○

The system automatically splits lab
orders based on the Type dropdown.

5. In the Description field, enter useful text
that helps users quickly identify this panel
when they prescribe it.
6. Enter the procedure code for this panel in
the Procedure Code field.
7. In the LOINC field, enter the LOINC code you
need to associate with this panel.
8. Click the Add button to add an individual
test to this panel.

This opens the Add Lab Test Details dialog box.
You can also copy from tests already created in the
system. Simply click the Copy Tests button and
choose the test you want to copy.

9. Complete the fields on the test’s window
and click OK.
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Details (continued)

10. Repeat step 8 and step 9 for each test in
the panel.
11. When finished creating the panel, click OK
to save and exit.

Defining Custom Labs
If you have an agreement with your lab vendor for custom lab panels, you can add those custom labs to
MicroMD EMR so your physicians can choose them when ordering for their patients.
For example, Brooks Beverage hired Advanced Family Practice to perform their new-employee drug tests,
and these tests have special requirements. Advanced Family Practice worked it out with their lab company
and need to be able to create that special lab order.

Figure 1.47 Custom Labs with Your Lab Vendor
Follow the same procedures to add a custom lab as you do when adding an in-house lab, except you
select the appropriate vendor from the Lab System drop-down instead of selecting In-house Lab.



Use the Laboratory drop-down to filter the list to a
specific lab company.
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Defining Cardiopulmonary Devices
You can integrate your cardiopulmonary devices with MicroMD EMR. Before you can use your cardio device
with MicroMD EMR, you must be sure the device is installed and then establish the connection between the
two. Typically, your device vendor and your MicroMD EMR team take care of this for you.

○

For a list of the devices supported by MicroMD EMR,
please contact your local authorized MicroMD EMR
reseller.

Figure 1.48 Cardio Vendor Tab
Once you select the appropriate vendor for your device from the Cardio Vendor drop-down, the system
displays the configuration options necessary for that device. The system also displays the cardio
procedures accepted by that vendor in the Procedure Codes to Submit for Selected Vendor Device area
and enables the Restore Default Codes and Delete buttons.

 To delete a code from the list, highlight it and click Delete.
 If you need to restore the system to the device’s default codes, simply click the Restore Default
Codes button. This resets the procedure codes back to the default procedure codes accepted
by vendor.
Physicians generally prescribe cardiopulmonary procedures through an encounter, like any other
procedure order. Personnel responsible for performing the procedure generally perform it through their
Desktop like any other procedure order, recording the results in the process. Please see page 4.19 for more
details on working with orders on the Desktop.
If the user has a role associated with their user account that allows them access to the patient’s chart, they
have the ability to perform the cardiopulmonary procedure from the Orders section of the patient’s
Medical Information tab (page 15.6). The same is true for integration with a vitals device. See page 13.11
for details on recording the patient’s vital signs.
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System Monitoring
The MicroMD EMR Manager allows you to monitor the status and functioning of communication between
MicroMD EMR and various external systems. For each external system, MicroMD EMR is able to monitor
incoming communication and outgoing communication, like sending and receiving faxes and lab tests
and results.

Figure 1.49 System Monitoring Manager
The association of a system together with the direction of the communication to be monitored is known as
a “task”. For example, the sending of practice management information is a single task. Some examples of
tasks that you can monitor are:

 Practice Management: 1) sending practice management information, 2) receiving practice
management information

 Laboratory: 1) sending laboratory requests, 2) receiving laboratory results
 Transcription: 1) sending transcription information, 2) receiving transcription information
 Vaccination: 1) sending immunization details
You can also set the system to monitor specific tasks and to notify you (or other users) when an error
occurs during communication for that task. For example, if the fax system fails to send a fax, the system
can generate a message to notify the IT department about the failure. (For more information on
subscriptions, see page 1.78)
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Viewing the Status of Each Task
On the System Status Summary tab (Figure 1.49), the Systems Monitoring Manager displays the overall
status of each task that you have chosen to monitor. This allows you to determine quickly whether or not
specified tasks are functioning correctly. A colored icon next to the task indicates the status of the task.

○
 Green (

The Systems Monitoring Manager refreshes automatically
every five minutes. If required, click Refresh to manually
update the display.

): This icon indicates that the task is active and functioning properly.

 Red (

): This icon indicates that the task is not responding. For example, the fax module has
lost its connection and is no longer sending faxes.

 Yellow (

): This icon indicates that the task has encountered an error. For example, an
incoming file was not in the correct format, or the directory structure was not correct for saving
the incoming file.

 Gray (

): This icon indicates that you have not set the task for monitoring.

Changing the Status of a Task
MicroMD EMR changes the status of a task automatically when a specified event occurs. There are two
possible events that can cause the status of a task to change: an error message and the “I am alive”
messages.

 Error messages: If a task generates an error message, MicroMD EMR changes the status of the
task to Error, and the task’s associated status indicator changes to yellow ( ). After a task has
been assigned the Error status, you must manually reset the task. Until you do, the task remains
in error.

 I-am-alive messages: The MicroMD EMR Integration Module (Clinigration) automatically
generates I-am-alive system messages every two minutes. These messages indicate that the
module is functioning. The Systems Monitoring Manager constantly monitors the transmission
of these I-am-alive system messages. If the Systems Monitoring Manager does not detect an Iam-alive message for a period of one hour, MicroMD EMR changes the status of the MicroMD
EMR Integration Module (Clinigration) to Not Responding, and the associated status indicators
for all monitored tasks change to red ( ).
If MicroMD EMR later detects a new I-am-alive message—indicating that the MicroMD EMR
Integration Module (Clinigration) in now responding—MicroMD EMR changes the status of all
monitored tasks to Active. The associated status indicators for the tasks change to green ( ).
If a task has the Not Responding status, you can manually reset the status to Active.

○
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If you manually reset the status of a task to Active but the
problem that caused the error still exists, the Systems
Monitoring Manager will reset the status to Error or Not
Responding as soon as the error recurs.
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To reset the status of a task manually:

Procedure

Details

1. Click the Monitoring button and verify that
you have the System Status Summary tab
displayed.
2. Locate the task whose status you want to
reset.
3. Click the status button for the task (

or

The task must have the status Not Responding
( ) or Error ( ).
).

4. Review the report and click either Reset
Status or No Monitoring.

The Module Error window opens and shows the
most recent report for the selected task.

Reset Status sets the status of the selected task
to Active ( ).
No Monitoring removes the system’s monitoring
activities from the task and changes the status of
the task to Not Monitored ( ).

5. Click Close to exit the error box.

Specifying Tasks to Monitor
All available tasks for your practice appear on the System Status Summary tab (Figure 1.49 on page 1.75)
of the Systems Monitoring Manager. Tasks that you have selected not to monitor appear with a gray icon
( ). To specify which tasks you want the system to monitor or to edit your existing configuration:

Procedure

Details

1. Click the Monitoring button and verify that
you have the System Status Summary tab
displayed.
2. Click the Monitoring Settings button.

The Monitoring Settings window opens.
This window lists all available tasks that you can
set the system to monitor.

3. Place a check mark in the box next to each task
you want the system to monitor and remove
the check mark from those you do not.
4. Click OK.
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Setting up Subscriptions
On the Subscriptions tab, the MicroMD EMR Manager allows you to set up subscriptions to notify you (or
other users) when there are issues with the system’s communication. Each subscription monitors a
specific task in the system. For each subscription that you define, you specify the:

 Task to monitor
 User to whom the system should send the notification
 Mechanism for distributing the notification
For example, Advanced Family Practice defined a subscription to monitor the sending of laboratory
requests from MicroMD EMR to their external laboratory system. When an error occurs or the
communication fails, the system sends an e-mail message to Betty that something is wrong with the
interface.

Figure 1.50 Subscriptions Tab
To edit an existing subscription, simply highlight the subscription and click the Edit button.
To add a new subscription, click the Add button, complete the required information and click OK to save
the subscription. Table 1.21 explains the fields in more detail.
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To filter the list to only those notifications assigned to a
certain subscriber, make the appropriate selection from
the Subscriber drop-down.
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Table 1.21 Fields on the Add Subscription Window

Field

Description

Task

Select the task to monitor. The list of available tasks includes all external
systems with which the system communicates (page 1.53). For each
system, an Incoming and Outgoing task may exist. For details on specifying
tasks to monitor, see page 1.77.

Person or group to notify

Enter the person or group to which you want the system to send a
notification for the task if the task fails or encounters an error. If you want
the system to send a message to an individual, enter that person’s full email address.
To send a message to a group of people, click the Lookup icon to choose
the group. (See page 1.79 for more details on maintaining notification
groups.) The Person or group to notify field is available only if you select Email from the Mechanism for notification drop-down.

Mechanism for
notification

From this drop-down, select the method you want the MicroMD EMR
Manager to use when sending notification messages. You can find these in
the Notification Groups Manager under Tools > Notification Groups
Manager.

Is active

Check this box to activate this subscription. Remove the check mark if you
do not want the system to send notifications regarding this task. The
system only generates notification messages when the subscription is
active.

Maintaining Notification Groups
The Subscriptions tab allows you to select Notification Groups for messages generated by subscriptions.
Each Notification Group contains a list of e-mail addresses to which the system can send notification
messages for issues that arise with a certain task. In the MicroMD EMR Manager, you can manage your
Notifications Group from the Tools menu. Select Tools > Notification Groups Manager.

Figure 1.51 Notification Group Manager
For example, Advanced Family Practice created a Notification Group called System Administration and
define two members in this group (richard@advancedfam.com and jennifer@advancedfam.com). They
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assigned the System Administration group to the outgoing and incoming lab communication tasks. If an
error occurs with these tasks, the system generates an e-mail and sends it off to both Tom and Jennifer.
To edit a Notification Group, simply highlight the group and click Edit.

Procedure

Details

1. Select Tools > Notification Groups Manager
from the main menu.

The Notification Group Manager window opens
and lists all existing Notification Groups.

2. Click the New Group button.

The Notification Group window opens.

3. In the Group Name field, enter a useful
description of this group of people.
4. Click the Add button.

The Notification Member Details window opens.

5. If the person is a MicroMD EMR user, select
their user account from the EMR User Name
drop-down.

This populates the Name field for you.

6. Enter the person’s name in the Name field.
7. Enter the person’s full e-mail address in the EMail field.
8. Click OK.

The system adds the person’s name and e-mail to
the Notification Group.

9. Repeat step 4 through step 8 for each member
you want to add to the Notification Group.
10. Click OK when finished creating the group.
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Notification Log
The Notification Log tab of the MicroMD EMR Manager allows you to view the history of notifications
generated by subscriptions and sent out. This log displays the most recent messages (up to a maximum of
3000 messages). When you highlight an entry, the system displays the details of the entry in the bottom
portion of the window.

○

The log refreshes every 60 seconds.

While viewing the notification log, you can:

 Re-send specific messages in the log (highlight the entry and click the Resend button)
 Clear the notification log (simply click the Clear log button)
Communication Log
The MicroMD EMR Manager allows you to view the list of all messages generated by the MicroMD EMR
Integration Module. The Systems Monitoring Manager displays the most recent messages. Click the
Refresh button to update the display with the newest messages since you came into the tab.

Figure 1.52 Communication Log
While you view the log, you can filter the display to show:

 Messages for all tasks or just for a specified task (select the appropriate task from the Task dropdown)

 Messages that were triggered by any event or just by a specified event (select the appropriate
event from the Event drop-down)
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There are four types of events in the Systems Monitoring Manager:

 Alive: The MicroMD EMR Integration Module automatically generates “I am alive” system
messages every two minutes. These messages indicate that the module is functioning. When
the system does not receive an Alive message over the course of an hour, the system errors.

 System Error: Some MicroMD EMR communication routines include a variety of built-in errorchecking functionality. These routines can detect and report errors in data that is received or
supply information about a function that was executed successfully.
For example, the MicroMD EMR routine that enables communication between MicroMD EMR
and MicroMD PM checks that two patients do not have the same SSN. If the module detects that
two patients do have the same SSN, the routine generates an error message.
Alternatively, the EMR receives a message from an external system that indicates that a system
error has occurred. For example, “Disk Full - unable to perform download.”

 Data Error: Not implemented in this version of the MicroMD EMR Manager.
 Success: There has been successful communication with the specified task.
Communication Error Log
On the Communication Error Log tab, the system displays all of the errors produced by each system
interfaced with your EMR. From the System Type drop-down, select the system for which you want to view
the communication errors. (You can also filter the list by date.) Highlight an error to view the details in the
bottom portion of the window.

Figure 1.53 Communication Error Log
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Viewing the Client Error Log
Along with the various system messages you can access, the MicroMD EMR Manager also provides you with
a list of all error messages generated by MicroMD EMR workstations. When a user encounters an error while
using MicroMD EMR, MicroMD EMR automatically sends details of the error to the client error log. While you
view the log, you can filter the display to show:

 Errors for all users or just for a specified user
 Errors that were generated by any date or just by a specified date

Figure 1.54 Client Error Log
To view the client error log, click the Client Error Log button on the Communication Error Log window.
This opens the Client Errors window and displays the most recent client errors. To view the details of the
error, simply highlight the error. The system displays the details in the bottom portion of the window.



To e-mail an error message, simply highlight the
error message and click the E-Mail button. The
system launches your default e-mail program and
creates a new message automatically addressed to
MicroMD EMR support and with the error in the body
of the e-mail.
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Establishing User Preferences
MicroMD EMR provides each user with the ability to customize several aspects of their experience using the
system, from what they see when they first log in to the system to what data they prefer to use when
searching for patients.
To customize your user experience, select Tools > User Preferences from the main menu of the main EMR
application. You can find information about several of the items in this window in the appropriate section
of the manual; however, there are some items unique to your overall experience.

Figure 1.55 User Preferences Manager

General Preferences
The General section (Figure 1.55) allows each user to customize some overall behaviors of MicroMD EMR to
better suit their needs or just customize to their liking. Table 1.22 explains these fields in more detail.
Table 1.22 Fields in the General Section of User Preferences

Field

Description

Display Welcome screen
at startup

If you want the welcome window to appear every time you log in to
MicroMD EMR, place a check mark in this box.

Display new Workflow
Order alerts

Whenever you receive a new order to perform (e.g., a lab order that the
physician orders while in the visit with the patient), you can have the
system pop up a message in the lower right-hand corner of your screen.
Place a check mark in this field in your user preferences.

Automatically mark mail
messages as read when
opening

Place a check mark in this field if you want the system to change the status
of your mail message to Read automatically when you open the message.
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Table 1.22 Fields in the General Section of User Preferences (continued)

Field

Description

Reference list search
preference

Throughout MicroMD EMR, you can search through reference lists for the
data stored in your database. From this user preference drop-down, select
how you want to search for this data. Based on the text you type in the
search field, the system can find all entries that begin with the first letter
you type or it can find all entries that contain the first letter in any part of
the description.
For example, if you type oma and you have Match only first letters of the
word chosen from this drop-down, the system finds all entries that begin
with “oma”. If you chose Match any letters in the word, the system would
find all entries with “oma” anywhere in the description, including
Congenital anomaly of ear and Mesothelioma.



You can change this default on a case-by-case basis
by right-clicking the search area in the reference list
and making your selection.

Open to folder

This user preference allows you to define what set of templates opens in
the Template Manager windows for you by default. See page 2.8 for details
on working with template managers.

Default patient search

When you search for patients throughout the system, you have a choice
about the data you use when searching. You can set the default for that
choice here. From the Default patient search drop-down, select the type of
information you prefer to enter when trying to find a patient in the system.

Temperature taken

This field allows you to set the default location for taking a patient’s
temperature when recording vitals.

Default BP Settings

Depending on how your practice typically takes blood pressure (i.e.,
patient sitting, standing, lying, etc.), you can set the default here. The next
time a user opens the Add Vital Signs window (Figure 13.7 on page 13.11),
the system automatically chooses the method you chose here.

Remember choices made
in Performance Status for
plans in the encounter

In the Plan and Visit Tests sections of an encounter, the system can
populate the Performance Status settings to reflect the choices you made
in these fields the last time you ordered that procedure, laboratory test,
patient instruction, immunization, referral or nursing care order. Place a
check mark in this checkbox to have the system do this for you.

Electronic Signature
button

Click this button to enter the electronic signature that will be used
throughout the system.
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Prescriptions
The Prescriptions section allows users to customize preferences when creating prescriptions or adding
medications to the patient’s medications list. Table 1.23 explains these fields in more detail.

Figure 1.56 Prescription Preferences
Table 1.23 Fields in the Prescriptions Section of User Preferences

Field

Description

Default Medication List

From this drop-down, set the medication list you want to view when you
first open the Prescription Pad or any other place where the medication
reference list opens.

Refill Days Prior

In this field, enter the number of days prior to the end date of a
prescription that the medication appears in the Upcoming Refills list.

Printed prescription form
(default)

From this drop-down, select the prescription form you want to use by
default every time you print a prescription. See page 21.2 for more details
on creating custom prescription forms.

Fax prescription form

From this drop-down, select the prescription form you want to use by
default every time you fax a prescription. See page 21.2 for more details on
creating custom prescription forms.

Supervising provider

When you select a provider from this list, that provider’s name appears
when you use the Supervising provider field on a prescription. This is also
sent electronically when you send a prescription using Surescripts.
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Table 1.23 Fields in the Prescriptions Section of User Preferences (continued)

Field

Description

Drug-Drug Warning Level
and Drug-Allergy Warning
Level

From this drop-down you can limit the type of warnings that pop up when
you prescribe a medication. The system has a variety of warning types,
including the “severe” and “potentially severe.” If you only want to see the
severe warnings, make the appropriate selection from this drop-down.
(The system uses the warning data provided by First Databank®.)

Printer for prescriptions

From this drop-down, you can select the printer you want to use only for
prescriptions. This is especially useful for those practices with a dedicated
printer loaded with prescription paper. If you change the printer at the
time of printing the prescription, MicroMD EMR remembers this printer
until your session ends and resets to your user preference when you
sessions ends.

○

If the printer chosen in your user preferences does
not exist when you print a prescription, the system
automatically chooses the computer’s default
printer and retains it for that session.

RxFill Indicator

You can set your default preference for the Fill Indicator drop-down that
appears on the Prescription Processor window. For example, you only
want to receive dispensing notifications when you prescribe certain
controlled substances. You could set your RxFill Indicator preference to
Cancel All Fill Statuses and then only choose to receive notification at the
time you prescribe. For all other prescriptions, you would not receive
dispensing notification. See page 21.17 for more details on dispensing
notifications.

Rx Prior Authorization
staff

For use with the electronic prescription module, you can set who in the
practice you would like to access and handle your electronic prescription
prior authorization requests. You can select more than one person in the
practice. See page 21.61 for more details on electronic prior authorizations
for prescriptions.

Session Profile
This section of your user preferences allows you to set a couple of default values for logging in to MicroMD
EMR. You can also view the user roles and functions assigned to your user account. Table 1.24 explains
these in more detail.
Table 1.24 Fields in the Session Profile Section of User Preferences

Field

Description

Current Location

When you first log in to MicroMD EMR, the system displays a welcome
window. On this window, you can choose your current practice location. If
you choose to open MicroMD EMR straight to your Desktop, you still need a
way to change your location. You can do so with this field in your user
preferences.
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Table 1.24 Fields in the Session Profile Section of User Preferences (continued)

Field

Description

Transcribe for

If you are a transcriptionist for several people, you can set your default
provider and transcription duration here. Click the Transcribe for button
to set your default. See page 27.44 for more details on transcribing.

Roles and Functions

These sections display those user roles and functions assigned to your user
account. For more details about user roles and functions, see page 1.11.

Desktop Navigator
Customize your Desktop Navigator under Tools > User Preferences. Select the appropriate section from
the Category drop-down and use the arrow icons to move the items from the Available Items pane to the
Selected Items pane (or double-click the item you want to move). You can also change the order using the
up and down arrows in the Provider Toolbox pane.
For more details about defining your Desktop Navigator, see page 3.3.

Encounter Preferences
In this section of your user preferences, you can establish the default values for encounters you create,
including the recording tool you prefer (i.e., Encounter Builder, Text Encounter, Encounter Wizard or Form
Encounter). MicroMD EMR uses these default settings for the New Encounter window when you click the
New Encounter task in your Chart Tools (page 10.3). When you click the My New Encounter task, the system
uses your preferred recording tool automatically and sets the values on the encounter header by default.
You access these preferences in the Encounter category on the User Preferences window (Figure 1.57).
(Select Tools > User Preferences from the main menu.) Table 1.25 explains the available defaults in more
detail.

Figure 1.57 Encounter Preferences
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Table 1.25 Fields in the Encounter Section of User Preferences

Field

Description

Level category

From this drop-down, select the category of encounters you most frequently
record for your patients. This sets the value for the Encounter level category
field on the New Encounter window and automatically sets the header when
you use the My New Encounter task. Setting this default can help streamline
your billing process and eliminate much of the manual work at the end of an
encounter.

Level of encounter

From this drop-down, select the encounter level you most frequently record
for your patients. This sets the value for the Encounter level field on the New
Encounter window and automatically sets the header when you use the My
New Encounter task. Setting this default can help streamline your billing
process and eliminate much of the manual work at the end of an encounter.



When you change this drop-down, the system
automatically changes the Level category dropdown accordingly.

Examination type

From this drop-down, select the most common type of visit you have with the
majority of your patients. This sets the value for the Examination type field
on the New Encounter window and automatically sets the header when you
use the My New Encounter task.

Recording method

Select the recording tool you prefer to use for the majority of your
encounters. This sets the value for the Record encounter using field on the
New Encounter window and automatically launches this default tool when
you use the My New Encounter task.

○
Encounter Location

If you select either the Encounter Wizard or Form
Encounter recording method, be sure to specify the
name of the wizard or form the system should load
when you record a new encounter.

Select the method for automatically selecting the practice location when you
create a new encounter. This sets the value for the Performed in department
field on the New Encounter window and automatically sets the encounter
header when you use the My New Encounter task. You have two options:

 Use Appointment Location: This option takes the location entered on the
patient’s appointment in the Appointment Book.

 Use Current Session Location: This option takes the location you have set
in your user preferences or that you chose when you logged in.
Encounter duration

Select the amount of time it takes for you to complete a typical visit. This sets
the value for the Duration field on the New Encounter window and
automatically sets the encounter header when you use the My New
Encounter task.

MicroMD EMR User’s Reference Manual Version 16.0

1.89

Chapter 1. Setup and Preferences

Establishing User Preferences

Table 1.25 Fields in the Encounter Section of User Preferences (continued)

Field

Description

When opened from
Desktop

Anytime you create an encounter from the Desktop and then close it, the
system uses the When opened from Desktop preference to know what you
want to see after you’ve closed the encounter.

 When you select Go to Chart, the system opens the Encounter tab for the
patient you just created the encounter for.

 When you select Go to Desktop, the system returns to where you were on
the Desktop when you created the encounter.
Nature of encounter

From this drop-down, select the most common general category of visit you
have with the majority of your patients. This sets the value for the Nature of
encounter field on the New Encounter window and automatically sets the
encounter header when you use the My New Encounter task.

Patient Care Plan

From this drop-down, select a default Patient Care Plan to use while working
in encounters.

 Internal Use Format: This option is no longer supported.
 Patient Visit Summary Format: Selecting this option automatically
displays the patient’s version of the care plan so you can print the
document easily for the patient. See page 22.54 for more details on the
Patient Care Plan.
Encounter display

In a patient’s chart, you can display the data on the Encounter tab in text
form or as discrete data. This drop-down allows you set your preference. You
can also choose to let the system decide if you use a variety of encounter
recording tools. See page 22.57 for more in-depth details on encounter
reports.

Rename Encounter
Report Sections
button

Click this button to change certain section titles on the encounter report
when generated using templates (e.g, change “Assessment” to “Diagnosis”).
See page 22.57 for more details on the encounter report.

○

For Text Encounters, renaming report sections only
applies to individual sections added to the report
template. It does not apply to the Encounter (All
Entries) field on the encounter report.

Subjective

When you add a symptom to an encounter in the Subjective portion, the
system can either automatically assign that symptom to a category for you,
you can elect to manually assign each symptom or you can have the system
always assign the symptom to the Chief Complaint category for you. The
Subjective drop-down allows you to set that preference.

ROS

When you add a symptom to an encounter in the Review of Systems portion,
the system can either automatically assign that symptom to a category for
you or you can elect to manually assign each symptom. The ROS drop-down
allows you to set that preference.
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Table 1.25 Fields in the Encounter Section of User Preferences (continued)

Field

Description

Objective

When you add a sign to an encounter in the Objective portion, the system
can either automatically assign it to the General category for you or you can
choose to assign the category yourself for each sign you add. The Objective
drop-down allows you to set that preference.

Expand List View and
Expand List Details

When navigating the Subjective, Review, Objective, and Assessment tabs
in an encounter, you can expand the list and/or expand the details of each
item in each list. These two preferences allow you to set the default view for
the list items and details.

 Choose the Yes option button to default the lists to an expanded view.
 Choose the No option for a collapsed view.
See page 22.23 for details on working with these tabs.
Add “Reason for
Encounter” to Patient
Symptoms

When creating a new encounter, you can add symptoms to the Reason for
Encounter field on the New Encounter window (Figure 22.1 on page 22.3).
If you would like the system to add the symptoms from this field to the
encounter automatically for you, place a check mark in the Add “Reason
for Encounter” to Patient Symptoms checkbox.

Add “Problem
Reviewed” to Bill

Place a check mark in this box to indicate that when you review a problem in
the patient’s chart, you want that review to gain credit towards E/M coding;
however, the problem may not be related to today’s visit.
Remove the check mark from this option to prevent any assessments on the
Review of Problems tab in the encounter from appearing on the bill.

Default resources to
perform plan items

If you have a specific user in your practice who always performs labs or one
that always administers immunizations, you can set that user as the default
resource when you prescribe that type of plan for a patient in an encounter.
You can change this on a case-by-case basis if needed.

○

When you choose a resource in the Immunizations
field, the system also uses this person as the default
resource to administer any medications added to
the Plan tab of the encounter.

Nurse to use provider’s
Common List

This option applies to those users creating pre-encounters. Place a check
mark in this checkbox to view the Common Lists of the selected provider on a
pre-encounter, rather than your own Common Lists while you work in an
encounter.

Use Education View
Button

When you add patient education material in an encounter, the system
automatically displays the material for you to review with the patient. If you
would like to turn this automated display off, you can place a check mark
next to the Use Education View Button option. If you would like to view the
document, simply click the View Doc button.

MicroMD EMR User’s Reference Manual Version 16.0

1.91

Chapter 1. Setup and Preferences

Establishing User Preferences

Chart Preferences
Each user has a different way of working. MicroMD EMR provides each user with the ability to customize
certain areas of the chart to make it more efficient for them to use. Table 1.26 explains the preferences
available for setting defaults on your chart view.

Figure 1.58 Chart Preferences
Table 1.26 Fields in the Chart Preferences Section of User Preferences

Field

Description

Open Chart to

When you make a selection from this drop-down, the system always opens
patient charts to that specific tab.

Patient Overview
Dashboard

Dashboard templates allow you to standardize how you display information
under Patient Overview on the Summary tab (page 22.24) for every patient.
Click the Lookup icon (
) and select the template you want to use by
default. See page 27.4 for more information about Dashboard Templates.

Default Template

On the Demographics tab of a patient’s chart, there is a Patient Monitor view
that displays several categories at the bottom of the window. You can
customize the information that appears here.
To set a default Patient Monitor template, click the Lookup icon (
) and
select the template you want to use. See page 27.21 for more information on
creating Patient Monitor templates.

Chart Board links
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In the bottom section of the window, the Chart Board panes allow you to
display up to 10 “quick links” on the Chart Summary view of the
Demographics tab in the patient’s chart (page 9.4). Simply use the arrows to
move the choices back and forth to display the appropriate items (or doubleclick the item you want to move).
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Chart Summary Options
When you view the Summary tab of a patient’s chart, two of the views you have available are Summary
and Summary Expanded. On each of these views you can click the Filter button to narrow the list of
encounters to show only those encounters or activities you want to see. Your Chart Summary Options
allow you to default this filter so the system automatically filters the list for you.
See page 22.24 for more details about the options on this window and about filtering your list of
encounters in a patient’s chart.

Medical Information
When you review a patient’s chart, there may be certain areas you always review when you first open
Medical Information tab of the patient’s chart. Perhaps you familiarize yourself with the patient’s history,
their allergies and medications, and then move on to their current test results. Each physician has a
different workflow.
You can set a Common List and other preferences for the Medical Information tab here in your user
preferences (under Tools > User Preferences). The options here set the defaults in your patient charts.
See page 12.5 for more in-depth details on the Common List for your Medical Information tab.

Reroute Items
MicroMD EMR provides you with the ability to reroute any reminders to other MicroMD EMR users in the
event that you are not available for an extended period of time. You can also set the system to
automatically copy all lab results, diagnostic results and/or hospital reports to other users you specify, at
any time.

Figure 1.59 Rerouting Items
To re-route reminders, simply place a check mark next to the appropriate type of reminder and insert the
user to whom the system should re-route that reminder. Remove the check mark when you no longer need
the system to re-route your reminders. For example, Dr. Webb will be at a conference and then on vacation
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for two weeks. She can set her system to send any reminders to the physician covering for her (as long as
that person is a MicroMD EMR user on her system).
To copy all of your lab results, diagnostic results and/or hospital reports to another MicroMD EMR user.
Simply click the Lookup icon (
) and insert the user. To remove the user, highlight their entry in the text
box and click the Delete icon ( ). This is useful for those physicians who prefer a nurse or other personnel
to review their documents and only flag those that are abnormal.

Customizing Toolboxes
The system allows you to customize your Desktop Tools section (page 3.2) and the Chart Tools section
(page 10.3). Under Tools > User Preferences > Toolbars you can set up both lists of tools. Select the
appropriate section from the Toolbar drop-down and use the arrows to move the items from the Available
Toolbox Items pane to the Provider Toolbox pane (or double-click the item you want to move). You can
also change the order using the up and down arrows in the Provider Toolbox pane.

Order Types
Depending on the way you need to use orders in MicroMD EMR and what orders you need to create or view,
you can display or hide those types of orders within your encounters (i.e., the Visit Tests tab and the Plan
tab). Simply select Tools > User Preferences > Order Types in MicroMD EMR.

Figure 1.60 Order Types View Preferences
To show an order type, choose the View option. Choose the Hide option to remove the order type from
your display. There are two columns of options:

 Display - Visit Tests: Choose the order types that you want to see as sub-tabs on the Visit Tests
tab (page 23.8) in your encounter recording tools, if that tab appears in the tool.

 Display - Plan Tab: Choose the order types that you want to see as sub-tabs on the Plan tab
(page 23.9) of your encounter recording tools, if that tab appears in the tool.

○

The Instr tab always appears on the Plan tab.

For more details on creating different order types, see page 1.52.
1.94

MicroMD EMR User’s Reference Manual Version 16.0

Establishing User Preferences

Chapter 1. Setup and Preferences

Quality Measures
For those providers participating in incentive programs, MicroMD EMR needs to know on which quality
measures and objectives you want to report. Telling MicroMD EMR the measures you want to report on
allows the system to provide you with only what you need when recording your encounters.

Figure 1.61 Provider Quality Measures
First, choose your current incentive program at the top of the window. The list of Available Quality
Measures changes depending on the program. Use the arrow icons to move your chosen quality measures
to the Provider Quality Measures side (or double-click the measure you want to move).



Please refer to Chapter 29 for more details on
incentive programs in MicroMD EMR.
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CDA Readable Display
You can choose the sections that appear when you display a patient's electronic file in the system (e.g.,
when you open a CDA attachment in the Mail section of your Desktop).

Figure 1.62 CDA Display Preference
Simply drag and drop, double-click, or use the arrow icons to move the sections from the Available Items
pane to the Selected Items pane. The Selected Items pane are the sections that will display for you when
you open a CDA. You can also use the up and down arrow icons to order the sections to best suit your
needs.

○

1.96

Your selections here do not change the information
contained within the file or the way the system imports
the information.
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Miscellaneous
The Miscellaneous category in your user preferences provides an area where you can specify additional
preferences for a variety of features throughout the EMR. Table 1.27 explains these preferences in detail.

Figure 1.63 Miscellaneous Defaults
Table 1.27 Fields in the Miscellaneous Section of User Preferences

Field

Description

Internet
Latest News

From the Research section of the Encounter Ribbon (page 22.7), you can
access the Internet for the latest information on an item within the patient’s
encounter. The Latest News drop-down allows you to select the web site
you want to use for this search.
For example, you want to search the Internet for information on
mesothelioma because you remember hearing a story recently on the news,
and you prefer to search the MedScape web site.

General Search

Select a default search engine for general Internet searches while in an
encounter.

Orders
Ask to print form when
saving an order

If you would like the option to print a hard copy of each lab order, procedure
order, or referral order when you save it, select Yes from this drop-down.
Once you click Save on any order request, the system prompts you if you
want to print the item. If you do not want this prompt, select No from this
user preference.
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Table 1.27 Fields in the Miscellaneous Section of User Preferences (continued)

Field

Description

Lab Label Default
Printer

If you have a designated printer that prints only lab labels, select that device
from the Lab Label Default Printer drop-down. This saves you an extra step
when you work through your lab orders.

Text Editor
Default the text editor
zoom to

There is a zoom tool available in text editors throughout the system. This
user preference sets the default value for that zoom tool (page 23.25).

Results
Users permitted to mark
a result as viewed on my
behalf

If you have staff that review your test results and only send you the results
that need further attention, you can provide specific EMR users with
permission to mark the results as viewed for you. The system tracks their
user name and the date/time they marked the item as viewed (page 4.38).

Refresh Rates Section
Appointment Book,
Desktop, Pop-up
Notification

Refresh rates tell the system how often to update a particular section of the
EMR. You can set the Appointment Book (Chapter 11), the Desktop (Chapter
3) and the Pop-up Notifications (page 2.8) to update every so many seconds,
depending on your practice’s workflow.



You should change this rate carefully. Refresh rates
of only a few seconds could impair the speed of
your system and make it unusable.

Health Maintenance
Refresh

You can have the system refresh Health Maintenance manually or have it
refresh automatically (page 17.8).

Immunization Sort Order From the Immunization Sort Order drop-down, you can select the default
order in which your immunization templates appear in the list when you
load a template to a patient’s chart (page 17.15).

DMS
The system allows you to customize several options in the Document Manager. Under Tools > User
Preferences > DMS, you can set up view options, default sort orders, and customize the encounter report
naming convention. See page 28.26 for more in-depth details on the preferences for MicroMD DMS.

Specialty Setup Wizard
MicroMD EMR users who specialize in different areas of medicine use different aspects of MicroMD EMR.
The Specialty Setup Wizard provides some intuitive setup in a central location to help you quickly set up
your EMR preferences with respect to your specialty.
This wizard pre-selects the preferences for your charts, the typical medical information categories you
need, and the most common tools for your toolbox, based on your specialty. You can access the wizard
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from the main menu under File > Specialty Setup Wizard. Select your specialty and click Next. The
remaining steps are explained in more detail throughout this manual.

 Step 2 of the wizard reviews your user preferences (starting with General Preferences on
page 1.84)

 Step 3 of the wizard covers your Common Lists (page 7.4)
 Step 4 of the wizard covers the various kinds of template available throughout the system
Complete these sections and click Finish when complete.

Medical Internet Sites
You have the ability in MicroMD EMR to access various Internet sites from within encounters. The system
comes built with several web sites already. You can, however, add new ones if needed. You can view the list
of sites included in MicroMD EMR and associate sites with assessments from the main menu in the system.
Select Tools > Medical Internet Sites from the main menu.

Figure 1.64 Medical Internet Sites
To edit or delete a site from MicroMD EMR, highlight the site, click the down arrow next to the New
Internet Site button and choose Edit or Delete as appropriate.

○

Only a user with the Add reference data function
assigned to their user account can edit or delete an
Internet site in the system.

To add a new medical Internet site to your system:

Procedure

Details

1. Select Tools > Medical Internet Sites from
the main menu.

The Reference List Viewer window for Internet Sites
opens (Figure 1.64).
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Procedure (continued)

Details (continued)

2. Click the New Internet Site button.

The New Internet Site window opens.

3. In the Display Name field, enter a brief title
for this site’s entry.

This is the text that appears in any lists that show
Internet sites. Enter a useful title that is easy to
understand in a quick glance.

4. In the Web Site field, type the address of the
web site/page you want to open when you
choose this entry.
5. From the Category drop-down, select the
type of information to which the site is
related.

For example, if you find an insightful article on HIV/
AIDS that contains information you think you might
want to reference the next time you visit with an HIV/
AIDS patient, you can add the link to that article and
categorize it appropriately.

6. To associate this web site with a diagnosis,

The Reference List Viewer window for Diagnoses
opens.

click the Lookup icon (
) next to the Link
Internet entry to the following condition
section.
7. Locate and insert the appropriate condition
to which you want to associate this web site.

To remove an association, simply highlight the
diagnosis and click the Delete icon ( ).

8. Repeat step 6 and step 7 for each diagnosis.
9. Click OK when finished.
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General Features
This chapter serves as a general reference section to the program. It introduces you to common features of
MicroMD, which you use consistently throughout the program. Until you are comfortable with the
program, keep this section within reach for quick reference.
Not only is startup and shutdown a breeze, but there are also several other features built into the program
that help you expedite your patient visits. Icons and shortcut keys allow you to use the mouse and
keyboard to navigate through the program quickly and efficiently. Searching is made simple by using
wildcards and click-and-sort columns. Instructional video snippets provide instant information and
demonstration of the features right in front of you.

In This Chapter
In this chapter, we cover:

 Core modules of MicroMD EMR (page 2.1)
 MicroMD EMR Manager (page 2.2)
 Starting the application (page 2.3)
 Changing your password (page 2.4)
 Locking the application (page 2.5)
 Navigating MicroMD EMR (page 2.5)
 Shortcut keys to help you work with the software (page 2.7)
 Instructional video snippets to help you with certain features (page 2.7)
 Pop-up notifications you could receive (page 2.8)
 MicroMD EMR Templates (page 2.8)

MicroMD EMR Core Modules
At the heart of the MicroMD EMR are three inter-connected core modules. The comprehensive functionality
of MicroMD EMR enables users to fulfill most of their daily patient workflow requirements.

 Appointment Book: Enables you to efficiently schedule and manage appointment schedules.
For more details about the Appointment Book, please see Chapter 11.

 Desktop: Enables you to communicate internally—with other users of MicroMD EMR in your
practice—and externally—with the outside world. Also lets you see an overview of certain
significant details in the MicroMD EMR system, and perform various role-specific tasks. For more
details about the Desktop, please see Chapter 3 through Chapter 6.

 Charts Module: Gives you access to the charts (or electronic medical records) of all patients in
the MicroMD EMR system. For more details about using Charts, please see Chapter 10.
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Figure 2.1 MicroMD Core Modules
You use the three module icons on the MicroMD EMR toolbar to display the three MicroMD EMR core
modules: Appointment Book ( ), Desktop ( ), and Charts ( ). MicroMD EMR displays only one module
at a time. The toolbar icon for the module currently active always appears disabled.



The items on this toolbar change according to the
module displayed. In addition, the toolbar changes
according to the details displayed within the
module.

You can also use the three tabs at the top of the application work space to access these core modules
(Figure 2.1). For more on navigating the work space, please see page 2.5.

MicroMD EMR Manager
When your MicroMD Support Team installs the system, one of the components installed on the server is
the Practice Manager. This enables you to set up and manage the entire MicroMD EMR system in your
practice. For example, you use the Practice Manager to enter the address details of your practice and to set
the individual roles of each MicroMD EMR user. This, in turn, defines the levels of access that the users have
within the system. You can also use the Practice Manager to set the default state, country, nationality, and
language of all new patients created from within the system.

○

Only the MicroMD EMR System Administrator and
users with the Administrator role can access the
Practice Manager.

For more in-depth details about the Practice Manager, please see Chapter 1.
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Starting MicroMD EMR
In order to use MicroMD EMR, you must first log in. To log in, you must have a unique log-in name and
password to prevent unauthorized users from accessing confidential information. Your log-in name
identifies you to the system. Your log-in name is set and maintained in the MicroMD EMR Practice Manager.

○

Your MicroMD EMR log-in name is not case sensitive,
but your password is. This means if your username is
BillD and your password is Kangaroo, you can type
billd, billD or BillD whenever your user
name is required, but you must type Kangaroo for
your password (rather than KANGAROO or
kangaroo).

Only one person can be logged in to MicroMD EMR on a single computer at any given time. Before a new
user can log in to a given computer, the current user must first log out.

Procedure

Details

1. Double-click the MicroMD EMR shortcut on
your desktop.

You can also select Start > Programs > MicroMD EMR
> MicroMD EMR from the Windows® menu.
The MicroMD EMR Agreement dialog box opens.


2. Click the I Agree button to accept the legal
conditions.
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Place a check mark in the Do not
display when MicroMD EMR opens
checkbox so it doesn’t display every
time you log in. Select Help >
Disclaimer from the main menu to
edit the checkbox in the future.

The log-in window opens.
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Procedure (continued)

Details (continued)

3. Enter your log-in name and password and
click OK.

The Welcome to MicroMD EMR window opens.



Turn off the welcome window under
Tools > User Preferences (page 1.84).

4. From the available three options, click the
module that you want to open.

Changing Your Password
You can change your MicroMD EMR password as frequently as you like. Your password can be as long or as
short as you want it to be.



Your password is case sensitive. This means that if
your password is Kangaroo, you cannot type
KangarOO, KANGAROO, or kangaroo. You must
type Kangaroo whenever your password is
required.

To change your password:

Procedure

Details

1. Select File > Change User Password from the
main menu.

The Change Password window opens.

2. Type your current password in the Old
password field.
3. Type your new password in the New password
field and type it again in the Confirm new
password field.
4. Click OK.

2.4

For details on password requirements, see
page 1.45.
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Locking Your Terminal
To enhance the security of your patients’ medical information, you can lock MicroMD EMR when you leave
your computer unattended. After you lock MicroMD EMR, no one can access any part of application on
your computer until you either re-enter your password or have your fingerprint successfully scanned.
When you re-access MicroMD EMR after locking it, MicroMD EMR displays the information that you were
viewing before you locked MicroMD EMR.
There are two ways to lock MicroMD EMR:

 Manually
Select File > Lock Terminal from the main menu, click the Lock Terminal icon ( ) on the
MicroMD EMR toolbar, or press the F2 function key on your keyboard. MicroMD EMR clears the
screen and displays a password entry dialog box.

 Automatically
If you want the system to automatically lock terminals for users after a certain period of idle
time, you can do so in the MicroMD EMR Manager. Click the System Settings button and click
the Security tab. When you edit these settings, there is a Lock MicroMD EMR after checkbox and
drop-down. Place a check mark in this checkbox and set the number of idle minutes or hours
that must pass before the system locks the workstation. The limit is two hours. Please see
page 1.45 for more details on security settings in the system.

Navigating MicroMD EMR
The MicroMD EMR user interface is divided into three sections: the application work space, the toolbox,
and the navigation panel. The controls that appear in the toolbox and the navigator are context-sensitive,
(i.e., they vary depending on the module that is displayed in the application work space).

Figure 2.2 MicroMD EMR
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Title Bar
The title bar of the application contains the user currently logged into the workstation, as well as that
user’s current location. This is the location that the system uses throughout the system when
documenting your current location (e.g., when creating a new encounter). The system pulls the location
from your Session Profile preferences (under Tools > User Preferences).

Application Work Space
This is the area in which MicroMD EMR displays each of its three core modules. When you click one of the
tabs (i.e., Appt Book, Desktop or Charts), MicroMD EMR displays the appropriate information in the
application work space and changes the controls available in the Toolbox and in the Navigator section.

Toolbar
The icons on the MicroMD EMR toolbar vary depending on the MicroMD EMR module you display (e.g., the
toolbar displayed when you have a patient’s chart open differs from the toolbar you see when you have the
Appointment Book displayed). In addition, the toolbar changes according to the specific detail currently
displayed within the module. You can find details about the various icons when reading about the
appropriate section.



If you hover the mouse over the icon, the system
displays a pop-up that explains the function of the
icon.

Toolbox
The toolbox contains the tools that you use most frequently, depending on which of the three modules
appears in the Application Work Space (i.e., appointments, desktop or charts). When you are in the
Desktop or the Charts module, you can customize the list of tools available to you in each module
(page 3.2 and page 10.3, respectively). The tools available in the Appointment Book are standard
(page 11.15).

Navigator Section
The Navigator section contains a variety of controls that provide access to the different areas of the
module displayed in the Application Work Space. These controls also vary depending on the user roles and
functions assigned to the current user. When you are in the Desktop or the Charts module, you can
customize the navigator to better suit your personal workflow (page 3.3 and page 10.5, respectively). For
more details on user roles and functions, please see page 1.16.
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Shortcut Keys
There are variety of shortcut keys and key combinations available to help you use MicroMD EMR quickly.
Table 2.1

Shortcut Keys and Key Combinations in MicroMD EMR

Shortcut

Description

F1

This shortcut opens the PDF of the MicroMD EMR User’s Reference Manual. Use the find
feature of Adobe® Reader® to search for your topic.

F2

Use this function key to lock the application on the current computer.

F3

This shortcut opens the Patient Monitor when used in a window that requires you to
enter a patient's name.

Ctrl + F4

Use this key combination to close the current chart and open the Desktop.

Alt + F4

This key combination exits the EMR application.

F6

You can use F6 to open the Chart tab in the application.

F7

You can use F7 to open the Appt Book tab in the application.

F8

You can use F8 to open the Desktop tab in the application.

F9

While you are in a patient's chart, you can press the F9 key on the keyboard to switch
the Demographics tab.

F10

While you are in a patient's chart, you can press the F10 key on the keyboard to switch
the Medical Information tab.

F11

While you are in a patient's chart, you can press the F11 key on the keyboard to switch
the Summary tab.

F12

While you are in a patient's chart, you can press the F12 key on the keyboard to switch
the Encounter tab.
If your cursor is in a Patient field, F12 inserts the last patient whose information you
viewed.

Instructional Video Snippets
MicroMD EMR comes with instructional video clips throughout the system to show you and demonstrate
how to use some of the features. Whenever you see the video icon ( ), you can click it to watch a short
instructional video that will present more information about the area of the EMR you are in.
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Notification Pop-Ups
MicroMD EMR pops up a message in the lower right-hand corner of your screen that indicates you have a
new order, a new mail message or a new prescription request that needs your attention. This notification
displays for about five seconds. If you miss it, you can still access the item on your Desktop.

Figure 2.3 Notification Message

○

There may be a slight delay before the system
displays the notification message.

Working with MicroMD EMR Templates
MicroMD EMR provides you with a variety of templates in the system, from letter templates to report
templates to encounter templates. These templates allow you to customize these documents specifically
for your type of practice and the needs of your patients.

Figure 2.4 Managing Templates
The left side of the window is where you select the folder in which you want to store your template. The
middle is the list of templates within that folder. The controls on the right side of the window are the
actions you can perform against the templates in the list.
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Understanding the Types of MicroMD EMR Templates
When you use templates and when you save templates, the system allows you to choose from three types
of templates:

 Personal: Templates that you save to your Personal folder are those that you create new or copy
from other folders and tailor to your individual needs. You can edit, rename and delete any of
your personal templates. No other MicroMD EMR user can access your personal templates.

 Shared: Templates in the Shared folder are those that MicroMD EMR users make available to all
users of the practice or to users within a specific department of the practice. These templates
are typically those that providers make for themselves and want to make available for other
providers to use. The Shared folder is also an excellent way to keep your documentation
consistent throughout the practice.

○

Only MicroMD EMR users with the Add templates to
shared function assigned to their user account can
change the contents of the Shared folder. Any user can
copy from the Shared folder.

Each shared template is associated with either a specific department within the practice or with
all departments in the practice. Only providers in a specific department can access shared
templates associated with that department. For details on assigning functions to users and
defining a user’s work location(s), please see page 1.16.

 Standard: Templates in the Standard folder are the built-in templates supplied with MicroMD
EMR. You cannot create, edit, rename or delete a standard template. You can copy a standard
template and save the copy as either a Personal or Shared template.

Editing a Template
You can edit any template in your Personal folder and any template that belongs to you in the Shared
folder. (For details on how to see who owns a specific template, see page 2.17.)
If you want to edit a template in the Standard folder, you need to copy the template into your Personal
folder first. Once the template is in your Personal folder, you are free to edit it as needed. Simply highlight
the template and click the Edit button.



Depending on the kind of template, refer to the
appropriate section of this manual for more detailed
information.



If you have the Administrator role, you can edit any
template in the Shared folder, regardless of its owner.
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Deleting a Template
You can delete any of the templates in your Personal folder. If you have the Add templates to shared user
function assigned to your user account, you can delete any template in the Shared folder that belongs to
you. If you have the Administrator role, you can delete any template in the Shared folder, no matter the
owner listed on it; however, it would be a good idea to check with the owner of a template before you
delete it. (For details on user roles and functions, see page 1.16. For details on how to see who owns a
specific template, see page 2.17.)

○

You cannot delete any of the templates in the
Standard folder.

To delete a MicroMD EMR template:

Procedure

Details

1. From the Template Manager window,
highlight the template you want to remove.

For example, select Tools > Letter Templates from
the main menu. This displays the Letter Template
Manager window (Figure 2.4 on page 2.8).

2. Click the Delete button.
3. Confirm that you want to delete the template. The system removes the template from the
current folder.

Renaming a Template
You can rename any of the templates in your Personal folder and any template in the Shared folder that
belongs to you. (For details on how to see who owns a specific template, see page 2.17.)

○

You cannot rename any of the templates in the
Standard folder.

To rename a MicroMD EMR template:

Procedure

Details

1. From the Template Manager window,
highlight the template you want to rename.

For example, select Tools > Letter Templates
from the main menu. This displays the Letter
Template Manager window (Figure 2.4 on page
2.8).
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Procedure (continued)

Details (continued)

2. Click the Rename button.

The system displays the Rename Template dialog
box.

3. In the New Template Name field, type the new
title for the template.
4. Click OK.

The system changes the template’s name in the list
to the new one.

Copying a Template
You can create a copy of any existing MicroMD EMR template and then modify the copy to better suit your
needs or the needs of your practice. You can also copy a template from the Standard folder or the Shared
folder (even if you are not the owner). When you create a copy, you can save that copy in either the
Personal folder or the Shared folder, but you can only save to the Shared folder if you have the Add
templates to shared user function. (For details on user roles and functions, see page 1.16. For details on
how to see who owns a specific template, see page 2.17.)
To copy a MicroMD EMR template:

Procedure

Details

1. From the Template Manager window,
highlight the template you want to copy.

For example, select Tools > Letter Templates
from the main menu. This displays the Letter
Template Manager window (Figure 2.4 on page
2.8).

2. Click the Copy button.

The system displays the appropriate Save
Template window.
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Procedure (continued)

Details (continued)

3. Click either the Personal or Shared button on
the left.

To specify a specific department within the Shared
folder, select the appropriate department from the
Dept drop-down at the top of the window.

4. In the Template name field, enter a useful title
for the new template.
5. Click OK.

MicroMD EMR adds the new template to the
appropriate folder. You can now edit the template
as needed.

Moving a Template
You can only move a template if you have the Add templates to shared function assigned to your user
account. With this user function, you can move templates from your Personal folder into the Shared folder
or from the Shared folder into your Personal folder, as long as you are the owner of the template.
You can also move your template to make it available for a different department in the Shared folder, if you
have this function and if you have that department associated with your user account. Otherwise, you can
only copy from the Shared or Standard folders into your Personal folder.

○

You cannot move any of the templates in the
Standard folder.

If you have the Administrator role assigned to you, you can move any template out of the Shared folder,
even if it does not belong to you. You cannot, however, move it back to the Shared folder unless you have
the Add templates to shared function on your user account. (For details on user roles and functions, see
page 1.16. For details on how to see who owns a specific template, see page 2.17.)
To move a MicroMD EMR template:

Procedure

Details

1. From the Template Manager window,
highlight the template you want to move.

For example, select Tools > Letter Templates
from the main menu. This displays the Letter
Template Manager window (Figure 2.4 on page
2.8).

2. Click the Move button.

The Move Template dialog box opens.

3. Select the location where you want to move
the template.

Remember: The Shared folder is only available if
you have the Add templates to shared function
assigned to your user account.

4. Click OK.

MicroMD EMR moves the selected template to the
specified location.

Printing a Template
You can print several of the templates in the system, even if you are not the owner of the template. This
includes the CliniGuide, Text Encounter and a few other types of templates. This is an excellent way to
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make sure that your design prints correctly, without the need to populate data just to test the look of the
template. When you print a template, you do not print data, you only print the template as it appears in the
Template Manager.
To print a MicroMD EMR template:

Procedure

Details

1. From the Template Manager window,
highlight the template you want to print.

For example, select Tools > Letter Templates
from the main menu. This displays the Letter
Template Manager window (Figure 2.4 on page
2.8).

2. Click the Print button.

The Print Options dialog box opens.

3. Make any necessary changes and click OK.

MicroMD EMR prints the template to the selected
printer. Keep in mind that this template does not
contain any actual data, only static text and field
names.

Importing/Exporting Templates
Henry Schein Medical Systems (HSMS) maintains an FTP site of sorts called CliniBank. The CliniBank site
offers numerous templates created by HSMS and by other users, like you, that are available for import. You
can also share your templates with other users by exporting to CliniBank or to a folder on your own
network.

Figure 2.5 Import/Export Templates Manager
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The left side of the Import/Export Templates Manager window displays a list of all the templates that are
currently contained in the selected template folder. The right side of the window has two tabs—one for
your local network and one for CliniBank.

○

As long as the template is in XML format and
exported by another MicroMD EMR user, you can
import it into your database.

Importing Templates from CliniBank
You can download templates from the CliniBank FTP site and modify them to suit your needs. You can
only import into your Personal folder. Once you import the template, you can move it to a Shared
folder if needed.
To import a template from CliniBank:

Procedure

Details

1. Open the appropriate Template Manager
window.

For example, select Tools > Letter Templates
from the main menu. This displays the Letter
Template Manager window (Figure 2.4 on page
2.8).

2. Click the Import button.

The Import/Export Templates Manager dialog
box opens (Figure 2.5 on page 2.13).

3. On the right side of the window, click the
CliniBank tab.

The system connects via your Internet
connection to display the available folders on
the CliniBank site.

4. Locate and select the template you want to
import.

All templates that you can import are in XML
format.

5. Click the Import button.

MicroMD EMR converts the selected XML file into
a usable MicroMD EMR template and copies the
new template into your Personal folder.

Importing Templates from a Folder on Your Network
You can also import templates from a folder on your network. For example, you received a template
via e-mail and saved it to your hard drive. You can now load that template into the system through
your Personal folder.
To import from a folder on your network:

2.14

Procedure

Details

1. Open the appropriate Template Manager
window.

For example, select Tools > Letter Templates
from the main menu. This displays the Letter
Template Manager window (Figure 2.4 on page
2.8).

2. Click the Import button.

The Import/Export Templates Manager dialog
box opens (Figure 2.5 on page 2.13).
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3. On the right side of the window, click the
Local/Network tab.
4. Click the Browse icon ( ) at the bottom of
the Import/Export Templates Manager
window.

The Browse for Folder dialog box opens.

5. Locate and select the folder that contains
the template you want to import.
6. Click OK.

The system displays the list of all XML template
files that exist in the specified folder.

7. Highlight the XML template file that you
want to import.
8. Click the Import button.

MicroMD EMR converts the selected XML file into
a usable MicroMD EMR template and copies the
new template into your Personal folder.

Exporting Templates to CliniBank
MicroMD EMR allows you to export any MicroMD EMR template, whether it is in the Personal, Shared or
Standard folder. When you export a template, MicroMD EMR converts the template into an XML file.
When a MicroMD EMR user imports the XML file, MicroMD EMR re-converts the XML file into a usable
MicroMD EMR template.
When you export to the CliniBank site, you can export only to the Temp folder on the FTP site. Once
accepted, they move the template to the appropriate folder in CliniBank—where all MicroMD EMR
users can access and import the template. (For details on how to import a MicroMD EMR template,
see page 2.14)
To export a template to CliniBank:

Procedure

Details

1. Open the appropriate Template Manager
window.

For example, select Tools > Letter Templates
from the main menu. This displays the Letter
Template Manager window (Figure 2.4 on page
2.8).

2. Find the template you want to export.

You can export a template in any folder, including
those specific to a department within the Shared
folder.

3. Click the Export button.

The Import/Export Templates Manager dialog
box opens and displays all of the templates in the
folder you selected.

4. On the right side of the window, click the
CliniBank tab.

The system connects via your Internet connection
to display the available folders on the CliniBank
site.
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5. One the left side of the window, highlight
the template you want to export.
6. On the CliniBank tab, highlight the Temp
folder.

7. Click the Export button.

○

You can export only to the Temp
folder of the CliniBank site.

MicroMD EMR converts the selected template to
an XML file and copies the new XML file to the
CliniBank site. The new file appears in the list of
files in the Temp folder.

Exporting Templates to a Folder on Your Network
If you want to share templates with other users that have access to your network without going
through CliniBank, you can export the template to a folder on your network.
To export a template to a folder on your network:

Procedure

Details

1. Open the appropriate Template Manager
window.

For example, select Tools > Letter Templates
from the main menu. This displays the Letter
Template Manager window (Figure 2.4 on page
2.8).

2. Find the template you want to export.

You can export a template from any folder,
including those specific to a department within
the Shared folder.

3. Click the Export button.

The Import/Export Templates Manager dialog
box opens (Figure 2.5 on page 2.13) and displays
all of the templates in the folder you selected.

4. Highlight the template you want to export.
5. On the right side of the window, click the
Local/Network tab.
6. Click the Browse icon ( ) at the bottom of
the Import/Export Templates Manager
window.

The Browse for Folder dialog box opens.

7. Locate and select the folder where you want
to save the exported file.
8. Click OK.
9. Click the Export button.

2.16

MicroMD EMR converts the selected template to
an XML file and saves the XML file to the folder
you selected on your network.
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Viewing and Setting Template Properties
MicroMD EMR allows you to view and set the properties of each MicroMD EMR template. The template
properties include the owner of the template and a description of the template. Only the owner of a
template or a user with the Administrator role can edit the properties of a template.

Figure 2.6 Template Properties
Simply highlight the template for which you want to view or change properties and click the Properties
button. The Template Properties window (Figure 2.6) opens. Table 2.2 explains the fields on this window in
more detail.
Table 2.2

Fields on the Template Properties Window

Field

Description

Template Identifier

This is a system-generated ID used internally by MicroMD EMR. You
cannot edit this field.

Owner

This field displays the MicroMD EMR user who created the template.
When editing a template, only the owner or a user with the Administrator
role have permissions to edit the template.

Name

If you are the owner of the template, you can modify the name of the
template.

Description

Enter a description of the template. The description is limited to 60
characters.

Template Date

This field displays the date on which the owner created the template.
You cannot change this date.

Save letter to patient’s
chart

This option is available only on Letter Templates. See page 26.7 for
details on using this default for a template.
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Desktop Overview
What you see on the Desktop tab in MicroMD EMR depends solely on the roles and functions assigned to
your user account. The Desktop of a user with the Physician role has different options than the Desktop of
a user with the Receptionist or Lab Technician role. (For more details on user roles and functions, please
see page 1.16.)

In This Chapter
In this chapter, we cover:

 Overall functionality in the Desktop (page 3.1)
 Desktop Toolbox (page 3.2)
 Desktop Navigator (page 3.3)

Overview
The MicroMD EMR Desktop offers customized functionality for users with specific user roles. The Desktop
also allows you to communicate with other users of MicroMD EMR in your practice—and external
applications. Not every user will have access to every feature described in this chapter.

Figure 3.1 Example Desktop
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Depending on your user roles and functions, the items available under the My Workflow button vary
(Chapter 4). Also depending on your user roles and functions is the availability of the Patient Care
(Chapter 5) and Administration (Chapter 6) buttons and the various options under them.
Within each of the options of the Desktop, you can filter the right side of the window with the choices in the
Filters section at the top. In order for an entry to appear in the list, it must meet all criteria you set in the
Filters section. You can also click each of the column headers to sort the entries by that column. For
example, if you want to see only those internal mail messages that you have not read in order from the
oldest to the newest, select Unread from the Status drop-down and click the Date column header.

Desktop Toolbox
When you display the Desktop in the MicroMD EMR Application Work Space, MicroMD EMR displays a set of
tools in the Desktop Tools section based on the tools chosen under the Modify Toolbox icon ( ). These
tools are available no matter where you are in the Desktop. Please refer to the appropriate sections of the
manual to learn about each of the tools.

Figure 3.2 Desktop Tools
You can customize the tools displayed in your toolbox. If you only use a few tools, you might choose to
display only those tools. You might also choose to put those tools at the top of the toolbox and move those
you use less frequently near the bottom.



You don’t have to keep a tool in the Desktop Tools
display in order to use it. You can run the tool from
within the Toolbox manager. Click the Modify
Toolbar icon ( ), highlight the tool and click Run.

To edit the displayed list of tools in your Desktop toolbox:

Procedure

Details

1. Verify that you have your Desktop displayed.

3.2
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Procedure (continued)

Details (continued)

2. Click the Modify Toolbar icon (
Desktop Tools section header.

) in the

3. In the Available Toolbox Items section,
highlight the tool you want to display and click
the Add to toolbox icon ( ).

This opens the Toolbox Manager. You can also edit
this display from your User Preferences (page 1.84).
The system adds your choice to the Provider
Toolbox side of the window. To remove an item
from the display, highlight the tool on the right side
and click the Remove from toolbox icon ( ).



You can also drag and drop from the
Available Toolbox Items side of the
window to the Provider Tools side.

4. Click OK when finished customizing your
toolbox.

Desktop Navigator
The Desktop Navigator provides you with a way to access different utilities and areas of your Desktop. This
access is solely dependent on your user role and any functions assigned to you. Click the My Workflow
button to access the options available to you, based on your role. A Nurse or Nurse Practitioner role causes
the Patient Care button to display. If you have the Administrator role or any administrative functions, the
system also displays the Administration button.



The numbers next to the options in the Desktop
Navigator indicate the number of unaddressed
items in that section (e.g., 10 mail messages you
need to read).

Figure 3.3 Desktop Navigator
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Customize your Desktop Navigator to fit how you use the system. If you only use the Prescriptions and
Internal Mail sections, for example, you can choose to show only those two items.
To edit the displayed list of sections in your Desktop Navigator:

Procedure

Details

1. Verify that you have your Desktop displayed.
2. Click the Modify Toolbar icon ( ) in the
Desktop Navigator section header.

This opens the Desktop Navigator Manager. You
can also edit this display under Tools > User
Preferences (page 1.84).

3. In the Available Items section, highlight the
section you want to display and click the right
arrow icon.

The system adds your choice to the Selected Items
side of the window. To remove an item from the
display, highlight the section on the right side and
click the left arrow icon.



You can also drag and drop from the
Available Items side of the window
to the Selected Items side.

4. Click OK when finished customizing your
navigator.

3.4
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Desktop: My Workflow
The options under the My Workflow button allow you to see at a glance what essential tasks need your
attention. Based on the roles and/or functions assigned to you in the system, MicroMD EMR displays the
appropriate tasks in the My Workflow area of the Desktop Navigator.
The numbers next to the options in the Desktop Navigator indicate the number of unaddressed items in
that section (e.g., 2 internal mail messages you need to read, 27 encounters you need to sign, and 15
orders you need to perform).
These numbers make it easy to access each task that requires your attention and to take the appropriate
action. For example, if a provider has unsigned encounters waiting for him in the system, he can simply
choose the Encounters task and work them from there.

In This Chapter
In this chapter, we cover the following sections of the Desktop:

 Attachments (page 4.2)

 Portal Updates (page 4.24)

 Demographics (page 4.4)

 Prenatal Care (page 4.26)

 Encounters (page 4.5)

 Prescriptions, including prescription

 Encounter Monitoring (page 4.7)
 Faxes - Incoming (page 4.7)
 Faxes Sent (page 4.8)
 Imported Labs (page 4.8)
 In-house Labs (page 4.10)
 Mail, including secure messaging
(page 4.11)

requests (page 4.26)

 Reception (page 4.27)
 Records Request (page 4.28)
 Referral Tracking (page 4.30)
 Scheduled Visits (page 4.32)
 Test Results (page 4.38)
 Transcription (page 4.40)

 Open Reminders (page 4.17)

 Transition of Care (page 4.41)

 Orders (page 4.19)

 Unidentified Items (page 4.46)

 Phone Messages (page 4.22)
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Attachments
MicroMD EMR allows users to add attachments to a patient’s chart. If someone has added an attachment
to a patient’s charts (e.g., a nurse or front desk personnel) and have indicated that the attachment is for
you, the system lists the attachment in this task list, as long as it is not marked as viewed. (For details on
working with attachments in the patient’s chart, see page 20.1.)

Figure 4.1 List of Attachments Not Viewed

Viewing an Attachment
To view the attachment, simply highlight the entry and click the Open button (or double-click the entry to
open). The system keeps this attachment in your “not viewed” list until you specifically mark it as viewed.
You can do this one of two ways:

 Highlight the entry and click the Mark as Viewed button. The system then removes the entry
from the list.

 Or you place a check mark in the Viewed checkbox when the item is first attached to the
patient’s chart.

4.2
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Create a Reminder About the Attachment
In this area of your Desktop, you can also create a reminder related to the selected attachment or print the
list displayed in the window. When highlight an entry and click the Create Reminder button, the system
completes most of the information for you. (For more details on patient reminders, see page 10.26.)

Print the List of Attachments
When you click the Print List button, the system prints only the entries displayed in the list. For example,
Kim at Summervale Medical Center filtered her Attachments list based on date. The system displayed four
entries. When she clicked the Print List button, the system printed those four entries. Then she selected
Not Viewed from the Status drop-down and the system displayed 10 entries. When she clicked the Print
List button in this case, the system printed the 10 entries now displayed.

Forward an Attachment
To forward the attachment to another user, highlight the entry and click the Forward button. The system
displays the Forward Attachment window (Figure 4.2). You can choose the user to whom you would like to
send the file, as well as the patient to whom it belongs. Add any comments in the Note field and click OK.

Figure 4.2 Forward Attachment Window



If you place a check mark in the URGENT checkbox,
the system displays a red exclamation point in the
Attachments section of the Desktop (Figure 4.1 on
page 4.2).
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Demographics
Those users with the Receptionist role associated with their user account do not have access to clinical
information in the patient charts. However, receptionists still need to open and edit patient demographic
information (e.g., change of address or insurance). The Demographics section of their desktop allows them
to do this.

Figure 4.3 Demographics on the Receptionist Desktop
Using the filters at the top of the list, you can find patients based on today’s appointments for a certain
provider. You can also use the Search for field to find a patient based on their name as well as other criteria
(change the selection in the Based on drop-down to see other criteria).

Add or Edit a Patient Entry
If you have a new patient and you need to create a new chart for them or you need to edit information,
simply click the New or Edit button as appropriate and complete the window that opens. See Chapter 9
for more details on working with patient demographics.

○
4.4

You can only delete a patient if there is no medical
information entered in their chart.
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Printing the Patient Demographic Report
Click the Print button to print the patient’s Demographic Report. See page 9.23 for more details on the
report.

Change History
Whenever someone makes a change to the patient’s demographic information, the system records that
change, who made it and when. Click the Change History button to view any changes. If you want to print
the list of changes, simply click the Print button. See page 9.8 for more details on the change history.

Other Activities Available
The Utilities button on this section of the Desktop provides the receptionist user with a multitude of other
useful functions, from creating a prescription request to writing a letter for a patient. Please see the
appropriate sections of this manual for information on each task.

○

The Utilities button is not available to users who also
have the Physician role associated with their user
account.

Encounters
The MicroMD EMR Desktop allows you to review the encounter records for which you are responsible,
including those for which you must co-sign. The Encounters section displays all of your unsigned
encounters by default. You can quickly open, complete and sign all of your unsigned encounters from one
central location.



To sign multiple encounters at the same time, place a
check mark in the Sign column for each of the
encounters you want to sign. Then click the Sign
Multiple button. The system prompts you for your
password. Enter your password and click the Sign
button.
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Figure 4.4 Physician’s List of Encounters



To view all encounters from visits you completed today,
select <Today> from the Status drop-down list.
To view your list of pre-encounters, select Preencounters from the Status drop-down list.

Simply highlight the encounter you want to sign and click the Sign Encounter button or the Co-Sign
Encounter button as appropriate. If you want to sign multiple encounters at once, simply place a check
mark in the checkbox next to each encounter and click the Sign Multiple button.
When you click the Print List button, the system prints the list of currently displayed encounters. If you
change the filter and click Print List again, the system prints the list now displayed in the window.
If you need to view the patient’s chart for more in-depth medical information, simply highlight the
patient’s entry and click the Open Chart button.

4.6
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Encounter Monitoring
The Encounter Monitoring option on the Desktop allows you to track when a report was sent to a referring
physician. You are able to filter the list of encounters and see which encounters are signed, how the report
was sent (electronically, faxed or printed) and which provider was associated with the report.

Figure 4.5 Encounter Monitor from the Desktop
If you want to see the report history of an encounter, highlight the encounter and click the Sent History
button. This opens the Encounter Reports window. For more details on this window, see page 22.57.
Sending a report for the selected encounter is simple. With the encounter highlighted in the top portion of
the window, click the Encounter Report button. For more details on generating an encounter report,
please refer to page 22.57.
For more details on writing patient letters (the Letter button) and writing a letter to the referring physician
(the Referral Letter button), see Chapter 26.

Faxes – Incoming
When you receive incoming faxes from Interfax, the system files these into the Faxes – Incoming section of
your Desktop, based on the fax line(s) associated with your user account. To view the fax, simply highlight
the appropriate row and click the Open button. This launches MicroMD Document Management to display
the fax and allows you to attach the document to a patient’s chart if necessary. See page 27.36 for details
on Interfax.
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Faxes Sent
This section of your Desktop provides a simple list of all faxes you have sent using in the system. This
section only displays those faxes you have sent. Use the filters at the top to narrow the list to display only
those faxes you want to see.
From this section, you can open the fax, delete it or re-send it. If you need to print a list of the faxes, click
the Print List button. This prints only the currently displayed list.

Imported Labs
MicroMD EMR can receive laboratory results electronically—directly from the laboratories. The timing and
frequency of downloads vary from laboratory to laboratory and between MicroMD EMR systems. (See
page 1.53 for details on external communication.) To view the list of results imported from that system,
choose the Imported Labs section of your Desktop.
You can quickly view the results of the selected test in the yellow area below the list. Some of lab
companies only provide the results from the tests in text format (i.e., no discrete data for an individual
test). When the EMR encounters this type of result, the system displays the text “see note” where the result
would be. This indicates that you can click the yellow note icon ( ) next to the test to view the result.

Figure 4.6 Imported Labs on Desktop

4.8

MicroMD EMR User’s Reference Manual Version 16.0

Imported Labs

Chapter 4. Desktop: My Workflow

Filtering Lab Results
To narrow the list of results, you can filter the window to just those orders you want to review. You can do
so by lab system used to download the data, the provider, the patient and/or the date (or date range) of
the download. The orders included in the list must satisfy all criteria you specify to appear on the list.

○

The Provider drop-down lists only those providers in the
user’s common list of providers for imported labs. This list
may include providers who are not MicroMD EMR users.

Adding Lab Results
While the main purpose of this section is to view the results imported from a lab company, you still have
the ability to add lab results while in this window. Simply click the New button. Please refer to page 13.17
for more details on laboratory results.

Deleting Lab Results
There may be times when you simply need to discard the results in the list. Maybe the entry was a
duplicate in the download or some other valid reason for deleting the results. Simply highlight the entry
and click the Delete button.

Printing Lab Results
As you work with your list of lab results, you can print individual results. Highlight the result’s entry and
click the Print Result button. The system sends the print job to your system’s default printer.

Viewing Orders for a Lab Result
If you need to view all orders currently in the system for an individual patient (whatever their status), rightclick the patient in the list and select View Patient Lab Orders from the pop-up menu. The Medical
Information Viewer window opens (Figure 4.7) and displays all lab orders for that patient. From this
window, you can add, edit, delete and print the orders in the list. You can also work through the patient’s
list of labs and record that a lab was performed.

Figure 4.7 Medical Information Viewer – Lab Orders
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In-house Labs
If you only want to add results only for those lab orders your practice performs in-house, the In-House Labs
section of the Desktop provides an easy console to use. With this section of your Desktop, you can search
for all the labs per patient so you can quickly enter their results. By default, this section displays only those
results from today that you have not viewed. Use the filters to find the results you want to see.

Figure 4.8 In-house Lab Results
To add a new lab result for the selected patient, click the New button and complete the window that
opens. To view a set of in-house results, highlight the result and click the View Result button. For more
details on lab results, see page 13.17.



4.10

A yellow note icon ( ) appears in the yellow area below
the list (Figure 4.8) when notes exist for the test. Simply
click the note icon to display the contents of the note.
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Internal Mail/Secure Messaging
MicroMD EMR allows you to use internal mail messages to communicate with other MicroMD EMR users in
your practice. Mail messages can contain information in text, graphic, or audio formats. When you send
MicroMD EMR mail messages, you can also insert a link to a patient’s chart (not applicable to external
messages).
For example, Dr. Davidson sends an internal mail message to Dr. Webb, a cardiologist. In the message, Dr.
Davidson describes Mr. Paxton’s condition and refers Dr. Webb to the encounter on April 8. This link makes
it easy for Dr. Webb to access the patient’s chart.

○

All MicroMD EMR users—regardless of their assigned
roles—have their own messaging center and can
send and receive mail messages.

Figure 4.9 Internal Mail

○

For information on external Secure Messaging, please see
page 4.14.
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Internal Mail/Secure Messaging

Filtering the Displayed List of Messages
The system defaults your view to all of your unread messages; however, you can use the filters at the top to
display the messages in a variety of ways. Table 4.1 explains these filters in more detail.
Table 4.1

Filters Available for Internal Mail

Field

Description

Date Range

To display a list of messages for a specific time period, you can make a
selection from the Date Range drop-down or set the range using the From and
To fields. The From field in the date range defaults to the date of the earliest
item in the list.

Route

The Route filter allows you to display only those messages you have Received
or those messages you have Sent to others in the system.

Status

You can filter the list to display only messages of a certain type. For example, if
you just marked a messages as Read, you can filter the list to display only
messages with the Read status to find your message quickly.

Patient

You can filter the list to display only those messages pertaining to a specific
patient. Type the patient’s name in the field. If the system finds a match, it
enters the patient. If not, the Search window opens so you can find and insert
the appropriate patient’s name.

Received From

To filter the list to include only those messages you have received from a
specific user in the system, select that user from this drop-down.

Mailbox

For those users who have access to the external messages in the practice’s
mailbox; the external messages in the mailbox at a specific practice location;
or the external messages in another user’s mailbox, choose the Mailbox you
want to view.



Patient messages from the Patient Portal also
appear in your practice’s mailbox or in the mailbox
of a specific user account if this is how your practice
has the portal configured.

Sending Mail Messages
You can send a mail message to any other MicroMD EMR user or user group. Users who send mail
messages to user groups that they are members of also receive the mail messages when added to the mail
messages.
When you send a new mail message, you can include a link to a patient’s chart. This makes it easy for the
recipient of the mail message to refer the patient’s chart in relation to your discussion. You can also view
and send messages from several other places in the system.


4.12

You can send the same mail message to multiple
MicroMD EMR users or user groups.
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To send a mail message:

Procedure

Details

1. Click your Desktop tab.
2. Choose the Mail option.
3. Click the New button.

The system displays the Mail – New window.


4. Next to the To field, click the Lookup
icon (

You can also right-click in the right
pane and select New Message from
the context menu.

This opens the Add Mail Recipients window.

).

5. Search for and highlight the user or user
group to whom you would like to send this
message.
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Procedure (continued)

Details (continued)

6. Click the Add button.

You can also double-click or drag and drop the entry
to the right side of the window.



When you highlight a user group on
the right side of the window, the
system displays the members of that
group in the bottom pane.

7. Repeat step 5 and step 6 for each user
and/or user group.
8. When finished adding recipients, click OK.
9. If you want to associate a patient’s chart to
the message, type the patient’s name in
the Re: Patient field.

If the system finds a match, it enters the patient. If not,
the Search window opens so you can find and insert
the appropriate patient’s name.

10. In the Subject field, enter a brief
description of what the message regards.
11. Click the tab for the type of message you
want to create and enter your message.



You can include all three types of
information (i.e., text, audio and
graphic data) in a single mail
message.

12. If this is a top-priority message, place a
check mark in the Urgent box.
13. Click Send to post the message to the
inbox of the recipient(s).

Sending Secure Messages Externally (Direct Mail)
When sending patient health information to the outside world, you need to be sure the information is
protected and the patient’s privacy maintained. MicroMD EMR allows you to use the Surescripts Clinical
Interoperability Network (CIN) to send messages securely to other users registered with the network.

Setting up Secure Messaging
Your MicroMD support team typically establishes your Direct Mail settings and helps you with
registration. For details on setting up this feature, please contact your local authorized MicroMD
EMR reseller.

Sending a Message Securely
Once set up for Direct Messaging, to send a message to an external user through the CIN, click the
Lookup icon (

4.14

) next to the To field of a new Mail message and click the Direct Users tab to search
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for and select the person you want to message (Figure 4.11 on page 4.16).



Anywhere you see the Mail button throughout the
system, you can choose to send the item to a Direct User.

Figure 4.10 Direct Users Tab



If there are physicians or organizations to whom you
frequently send secure messages, you can add them to
your Common List to avoid searching the whole list.

Reading Mail Messages
Each mail message has a status associated with it: Read or Unread. All new mail messages have the status
Unread. After you open a message, the system automatically assigns the message the status Read. You can
also click the Mark as Read button to indicate you have read the message. Viewing your messages is easy.
Simply highlight the message and click the Open button. The system displays the message for you in a
new window. You cannot edit any information in the mail message.



If you do not want the system to mark your messages as
Read when you open them, remove the check mark from
the Automatically mark mail messages as read when
opening checkbox in your User Preferences (under Tools
> User Preferences > General).
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Figure 4.11 Reading a Mail Message



You can also double-click the message entry to open
it, or you can right-click the message entry and select
Open Mail.

Click the Open Chart button to open the patient’s chart if the sender specified a patient in the Re: Patient
field when they created the message.

Replying to or Forwarding a Message
Once you open a mail message, you can send a reply back to the same user (or patient), all users currently
on the message, or forward the message to another user in the system. Simply click the Reply or Forward
button on the message as appropriate and add your comments, audio or graphic.
When you click the Reply, Reply All, or Forward button for a message that is not the most recent message
you have received in the same conversation, the system displays a yellow bar at the top of the message to
alert you that you are not responding to the most recent message in the conversation.

Figure 4.12 Alert When Not Opening the Latest Message in a Conversation
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If you respond to such a message and want to read and respond to the most recent one, simply click the
yellow alert bar to switch to the newest message. The system discards your current reply and opens the
Mail window for the newest message in the conversation so you can continue.
If your practice has the Patient Portal and allows patients to send messages to your practice, those
messages appear in the practice’s Mailbox or in the Mailbox of the user associated with the message. You
can reply to the patient in the same way as responding to other mail messages. Your response message
goes back out to the patient’s account on the Patient Portal.

Associating a Patient to a Message
There are times when you receive a message, either internally or externally, that has no patient attached to
it. Typically, this happens when a practice receives a message from an external source. Staff members do
however, on occasion, forget to associate the message with a patient.
To associate a patient with a mail message, simply click the Lookup icon (
find your patient.

○

) next to the Patient field and

Once you save or close the message, you can no longer
change the patient associated with the message.

Changing Read or Unread Status
When you open a mail message, the system automatically marks the message as Read. If you want to mark
the message as Unread (e.g., you want to return to the message later because you were just called into a
meeting). Or you may already know the contents of a message and simply want to mark it as Read without
actually opening the mail.
You can do both of these actions easily. Simply highlight the message and click the Mark as Read button
to change the status of the unopened message to Read. You can also right-click the message and select
Mark as Read from the context menu. This right-click menu also allows you to select Mark as Unread to
change the status of the message as Unread.

Deleting Mail Messages
When you no longer need a mail message, you can delete the message from your Desktop. Simply
highlight the message and click Delete Message. You can also right-click the message and select Delete
Message from the context menu.

Open Reminders
MicroMD EMR provides a way to set reminders for patient follow-up care, from upcoming appointments to
procedures due for the patient. You can also create non-patient reminders for tasks not specific to a
certain patient. The Reminders section of the Desktop displays a list of your current reminders—tasks you
need to perform and items you have yet to address.
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The filters at the top of the list allow you to narrow the list displayed in the window. Table 4.2 explains
these fields in more detail.



If you have someone covering for you while you’re
out of the office, you can have these reminders
rerouted to that user account. See page 1.93 for
more details.

Figure 4.13 Reminders List
To open a reminder, simply highlight the entry and click Open Reminder. (You can also double-click the
entry to open it.) To mark the reminder as complete, simply choose the Done option in the Status section
of the reminder’s window when you open it. Click OK when finished. The system removes the reminder
from the list.

4.18



You can also click the Mark as Done button to
remove a reminder from the list.



For in-depth details on creating and using reminders
in MicroMD EMR, please see page 10.26.
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Filters Available for Reminders

Field

Description

Reminder Date

To display a list of reminders for created during a specific time period, you can
make a selection from the Reminder Date drop-down or set the range using the
From and To fields. The From field in the date range defaults to the date of the
earliest item in the list.

Status

Once you mark a reminder as done, the system removes the reminder from your
active list. If you would like to see the reminder again, simply select Done from the
Status drop-down list.

Patient

You can filter the list to display only those reminders pertaining to a specific
patient. Type the patient’s name in the field. If the system finds a match, it enters
the patient. If not, the Search window opens so you can find and insert the
appropriate patient’s name.

Route

The Route filter allows you to display only those reminders you have received or
those reminders you have sent to others in the system.

Received From

To filter the list to include only those reminders you have received from a specific
user in the system, select that user from this drop-down.

Orders
The Orders section of the Desktop provides a central location for you to manage the order requests
assigned to you for completion. These orders can be for procedures, laboratory tests, nursing care
requests, immunizations, and more. Providers can request orders when recording an encounter, but the
order can also be placed outside of an encounter.

Figure 4.14 List of Orders in the System
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Managing Orders
To narrow the list of orders, you can filter the window to just those orders you want to review. You can do
so by the date the order was made, by patient, by type of request and/or by status. You can also filter the
list by the person who requested the order and/or who it was assigned to. The orders included in the list
must satisfy all criteria you specify in order to appear on the list.
While the majority of the orders in your list come from physician encounters, you can still create a new
order from this window. Click the New Order button and choose the type of order you want to create. (See
page 1.52 for more information on customizing order types.)



If you filter the list to display only a specific type of order,
MicroMD EMR immediately opens the appropriate dialog
box when you click the New Order button.

To edit an order on your list, simply highlight the order and click the Edit button. This allows you to add
more accurate details to the request or send a reminder to the patient for the procedure.

Performing an Order
To record that you have completed the order on your list, highlight the entry and click the Perform button.
Depending on the type of order, the appropriate window opens for you to record the details of performing
the order. For example, when you record that you have performed a lab test, the window that opens allows
you to record the results of the test.
From the list of orders you have to perform, you can also change the status of an entry without opening it.
Highlight the entry and click the Set Status button. Choose the appropriate status from the drop-down
menu. This is especially helpful if the patient does not show up for their procedure or if they were too
anxious to let you draw their blood.

Future Orders
If you want to view a list of orders created ahead of time (e.g., maybe the patient was asked to have lab
work done before their next visit), you can select Future from the Date Ordered filter. The system changes
the From date to today’s date and the To date to two months from today, and it changes the Status filter to
Requested and the Requested By filters to <All> automatically for you. Use the remaining filters to narrow
the list if necessary.

Figure 4.15 Future Orders
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If the order was not created and billed through an
encounter, the system may prompt you to create a bill for
the order. This opens a window similar to the Bill Builder.
See page 24.2 for details on using this window.

Other Activities
You can also open the patient’s chart from your list of orders to perform. Simply highlight the patient’s
order and click Open Chart. To print the displayed list of orders, click Print List. The system prints the list
to your computer’s default printer.
For those orders that are complete, you can view the results of the item. Highlight the entry and click the
Results button. Depending on the type of order, the system displays the appropriate window with the
details entered by the user who performed the order.

Laboratory Test Labels
For those laboratory interfaces that require a specific label be printed with the order, you can create the
label using the Lab Label Template Manager on the Administrative Panel (page 4.21). MicroMD EMR comes
with two standard templates already: one for use with LabCorp and one for use with Quest Diagnostics.




When selecting a template to use with the DYMO
LabelWriter, make sure the orientation of any new
templates are set to Landscape.

Refer to page 2.8 for details on working with Personal,
Shared, and Standard folders.

To create a new template, open the Lab Label Template Manager (on the Administrative Panel) and click
the New button. The system displays the Lab Label Template Builder window. From here, you can add
fields, adjust the page size and more.
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Phone Messages
Gone are the days of stacks of paper phone-message slips piling up on your desk. MicroMD EMR
streamlines your practice and allows anyone who takes a phone call to enter the message in the system
and send you an electronic notification. You can access the Phone Messages list to quickly review and
return phone calls and manage your list.
You can filter the list of phone messages using the Filters area at the top of the list. Table 4.3 on page 4.23
explains the filters in more detail.

Figure 4.16 List of Phone Messages
If you receive a call for another user in the EMR, you can create a phone message to them. To create a new
message (either for yourself or to send to another user), click the New button and complete the needed
fields. Once you have addressed a message that you have received, you can highlight the message and
click the Mark as Done button. This places a check mark in the Completed column and removes the
message from your active list.

4.22

○

When a user sends a phone message to multiple
recipients and one of those recipients marks the phone
message as Done, the system marks the message as
Done for everyone and removes the message from
everyone’s Desktop.



To retrieve messages marked as done, simply select
Completed from the Completed drop-down.
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To keep the clutter down, place a check mark in the
Remove related phone messages when marked as
done setting in the MicroMD EMR Manager under
Practice Settings (page 1.37).

Other actions you can perform with messages and the message list:

 To delete a message, you can right-click the message and select Delete from the pop-up menu.
This removes the message from everyone’s list, except the person who wrote it.

 If you receive a message that is really for someone else or you want another MicroMD EMR user
to handle the call, you can highlight the message and click the Forward button.

 If the phone message pertains to a specific patient and you want to view their chart before
returning the phone call, you can simply highlight the message and click the Open Chart
button.

 If you would like to print your list of messages, click the Print List button. This prints each
message and its contents to make it easy for you to return calls on the run.
Table 4.3

Filters Available for the Phone Messages List

Field

Description

Date Range

To display a list of messages for a specific time period, you can make a selection
from the Date Range drop-down or set the range using the From and To fields. The
From field in the date range defaults to the date of the earliest item in the list.

Type

From the Type drop-down you can select whether you want to display all
messages, only those tagged as a call you need to make or those tagged as calls
you received.

Patient

You can filter the list to display only those messages pertaining to a specific
patient. Type the patient’s name in the field. If the system finds a match, it enters
the patient. If not, the Search window opens so you can find and insert the
appropriate patient’s name.

Route

The Route filter allows you to display only those messages you have received or
those messages you have sent to others in the system.

Rec’d From/Sent

To filter the list to include only those messages you have received from a specific
user in the system (or sent to a specific user), select that user from this drop-down.


Completed

This drop-down changes to Received From when
you select Received from the Status drop-down and
to Sent to when you select Sent from the Status
drop-down.

Once you mark your phone messages as done, the system removes them from
your active list. If you would like to see those messages again, simply select
Completed from this drop-down list.
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Portal Updates
The Portal Updates section of the Desktop is available for those practices who have purchased the Henry
Schein Secure Chart Patient Portal. Any time a patient’s medical information changes in their chart or
during an encounter or if someone queues up the patient’s C-CDA to be published to the portal, the
information appears in the Portal Updates section.

Figure 4.17 Portal Updates

Publishing to the Portal
When you want to publish C-CDAs to the portal from Portal Updates, you have a couple of options. You can
use the Patient filter to search for updates that need to be published for a specific patient, or you can use
the Select button in the lower right to select multiple updates to publish in bulk.
Once there is a check mark in the S column for the patient updates you want to publish, click the Queue
CDA button. That’s it!

○

If there is an update that you do not want to appear on
the patient’s account online, place a check mark in the S
column and click Do Not Publish.

Review the list at the end of every day to clear out all outstanding patient charts that need to be published
to the Patient Portal. This helps provide patients with their medical information in a timely manner.
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Editing the Information Before Sending to the Portal
If you want to limit the specifics sent to the patient online, you can place a check mark in the E column for
that update entry or entries. When you click the Queue CDA button, the system displays CDA Data Edit
window (Figure 4.18) for each patient.
Use the Include All and Exclude All buttons to indicate the information you want to share with the
patient. Typically, the only information you would potentially exclude would be extremely sensitive
information potentially harmful or unnecessary information to share with the patient.

Figure 4.18 CDA Data Edit Window
Click OK when satisfied with the information being shared with the patient. Be cautious when using this
feature. If you select multiple patients, an individual CDA Data Edit window displays for each patient. You
need to click OK on each window before you can finish. If you have hundreds of patients, this could take
some time.

Publish Log
The Publish Log is patient-specific and shows you the updates various users have sent to the selected
patient’s portal account. To open the log, highlight a patient’s name and click the Show Publish Log
button.
You can see the categories of information on the left that you can publish to the patient's account. When
you select a category, the right side displays the log for that item. If you want to see only those log entries
related to a specific staff member, you can select that person from the Published by drop-down. You can
also filter the listed entries by the date it was published.



The Published by drop-down displays those EMR users
activated for the Patient Portal and with their user
account also established online.
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Prenatal Care

Figure 4.19 Publish Log

Prenatal Care
For obstetrics and gynecology practices, the Prenatal Care section of the Desktop can provide a central
location to manage prenatal patients. The list defaults to patients with an estimated due date that falls
within the current week (i.e., Sunday through Saturday). The yellow “sticky” displays the details of the
selected patient’s last prenatal visit. You can access the OB dashboard for the patient, as well as open their
chart from this section of the Desktop. For more in-depth details about this OB Care features, please see
Chapter 18.

Prescriptions and Prescription Requests
MicroMD EMR provides a central location for you to manage your prescriptions and prescription requests:
your Desktop. Under the My Workflow button, the Prescriptions list allows providers to review all
prescription requests that have been submitted to them. This allows the provider to quickly open and
respond to the requests. Front desk users can use this list to view the list of replies to the requests they
have sent to providers and receive any instructions regarding the request.
The default values for the filters at the top depend on your user role and your user functions. For example,
for a user with the Write Prescriptions function associated with their account, the Status drop-down
defaults to Requested to show all of the prescription requests the user needs to approve.
For a user with the Nurse role (and no Write Prescriptions permission), the Status drop-down defaults to
Action to show all of the prescriptions for which the physician has asked she perform a task. For all roles,
the date range defaults to the date of the oldest item in the list (the From field) and today’s date (the To
field).

○
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For in-depth details about creating and processing
prescriptions, please refer to Chapter 21.
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Reception
The Reception section of the Desktop is only for those MicroMD EMR users with the role of Receptionist.
The receptionist in your office is generally in charge of checking in your patients, calling patients to confirm
appointments, writing/printing letters and more. The Reception section of the Desktop provides intuitive
tools specifically for the receptionist.

Figure 4.20 Reception Section on the Desktop
To access this section, verify that you are on the Desktop and choose the Reception option in the Desktop
Navigator. The system displays the receptionist’s console. From this window, you can display the list of
patients with appointments for today with a specific provider.
Once you display the patient(s), you can perform a variety of functions for the selected patient. You can
click the Print button to print a patient information sheet (page 9.23). You have a variety of tools available
for the selected patient from entering a phone message to writing letters to creating prescription requests.
Click the Tools button and select the task you want to perform. Please see the appropriate section of the
manual for more details on any of the tools in this drop-down.



You can also right-click a patient in the list to access a
quick list of the tasks you can perform.

If you want to edit the existing patient’s demographics or other patient details, click the Edit button and
select the task from the drop-down menu.
Once you check a patient into the system, MicroMD EMR displays the patient on the right side of the
window and begins their journey through your practice. You can use the Route Patient button to indicate
where the patient is in their visit. (See page 4.32 for more details on Scheduled Visits.) You can also see a
history of their visit with the Router History button.
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Records Request
MicroMD EMR includes a feature to request and send patient records. When a patient or provider contacts
your practice to ask for records, you have the option to print paper records, send them electronically or
make them available on the Patient Portal.

Viewing Records Requests
Click the Records Request section to display requests in your Desktop. You can filter the list of record
requests using the Filters area at the top of the list. Table 4.4 explains the filters in more detail.

Figure 4.21 Records Request Desktop
There are a number of buttons in the Records Request Desktop (Figure 4.21):

 Click the New button to create a records request and send it to yourself or another user in your
practice so they can complete the request. The request then appears in the Desktop Navigator.
As with other Desktop Navigator tasks, the system displays the number of unaddressed
requests. See page 4.28 for more details on creating a records request.

 Click the Open button to view the request in the Patient Record Request window.
 Once the request is completed, click the Mark as Done button to remove the request from your
Desktop. When a user sends a record request to multiple recipients and one of those recipients
marks the request as Done, the system marks it as Done for everyone and removes the request
from the Desktop of all recipients in the request.

 Click the Print Request button to print just the highlighted request.
4.28
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 Click the Print List button to print the entire list of records requests displayed on the Desktop.
 To view the chart of the patient the record request was made for, click the Open Chart button.
Table 4.4

Filters Available for Records Requests

Field

Description

Request Date

To display a list of requests for a specific time period, you can make a selection
from the Request Date drop-down or set the range using the From and To fields.

Status

Once you mark the records requests as done, the system removes them from
your active list. If you would like to see those messages again, simply select
Completed from this drop-down list.

Type

From the Type drop-down you can view requests completed or to be completed
via paper, electronic copies or send to the MicroMD Patient Portal.

Patient

You can filter the list to display only those requests pertaining to a specific
patient. Type the patient’s name in the field. If the system finds a match, it enters
the patient. If not, the Search window opens so you can find and insert the
appropriate patient’s name.

Received From

To filter the list to include only those requests you have received from a specific
user in the system, select that user from this drop-down.

Creating New Records Requests
Once you receive a request for patient records, you can open the New Record Request window (Figure
4.22) from the Workflow Communicator or Desktop Navigator. The system can print paper records, send
them electronically, or make them available on the Patient Portal. Users can also print a chart report or
send a C-CDA, CCR or CCD health record from this window.

Figure 4.22 New Record Request Window

MicroMD EMR User’s Reference Manual Version 16.0

4.29

Chapter 4. Desktop: My Workflow

Referral Tracking

Referral Tracking
With MicroMD EMR, you have the ability to track referrals from your Desktop. This makes it easier to view
the status of the referrals you have out to other physicians and those referrals you have received from
other physicians. You can filter the list of referrals using the criteria available. In the Filters section of both
the Referrals Out and the Referrals In areas of the Desktop, you can choose to filter the current list by
provider, patient, department and referral status. You can use the Date Range section to limit your display
to a certain time frame.
Any MicroMD EMR user can view the Referrals Out and Referrals In options on their Desktop. They just
need to have the Referral Tracking function selected on their user account (page 1.16). Once you turn on
this function, the system adds the two options to the list under the My Workflow button.



If you can’t see the new options, click the Desktop
Navigator icon ( ) and move the items from the
Available Items side to the Selected Items side. See
page 3.3 for more details.

Figure 4.23 Tracking Referrals on the Desktop
The Referrals Out section of the Desktop provides information about those patients that have been
referred out to other physicians. The Referrals In section of the Desktop provides information about those
patients referred TO your practice by outside physicians.
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Referrals Out
There are times when you need to refer a patient out to a specialist for additional tests or consultations.
MicroMD EMR allows you to track these referral orders easily and quickly. When you record an encounter,
you can create a referral request for the patient. Those requests appear in the Referrals Out section of your
Desktop automatically. If the referral is for a user within your MicroMD EMR system, that order also appears
in the Orders section of their Desktop.

 To create a new order from the Desktop, click the New button and complete fields on the
window that opens.

 To edit or delete an existing referral, simply highlight the entry and click the Open or Delete
button as appropriate.

 You can change the status of the selected entry by clicking the Set Status button and choosing
the appropriate status.

 To print the list currently displayed in the window, click the Print List button.
 If you want to send an e-mail concerning the selected referral, simply click the Send Mail
button.



For more in-depth information about referring patients
out, please see page 15.11.

Referrals In
The system also allows you to track those patients referred to your practice from other physicians. For
those users with the Referral tracking function on their user account, they can add this information using
the Referrals In section of their Desktop. Users with access to a patient’s chart can also add referral-in
entries on the Medical Information tab of the chart (page 15.11).

 To add an referral-in entry, click the Add button and complete the fields on the window.
 To edit or delete an existing referral in, simply highlight the entry and click the Open or Delete
button as appropriate.

 You can change the status of the selected entry by clicking the Set Status button and choosing
the appropriate status.

 To print the list currently displayed in the window, click the Print List button.
 If you want to send an e-mail concerning the selected referral, simply click the Send Mail
button.



You can create a referral-in order from a new
appointment.
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Scheduled Visits
From the Scheduled Visits area you can easily view all the patients you have on the schedule today, their
appointment time, the staff member currently with the patient, and where they are in the practice. You
also have colored flags next to the patient that mimic the use of colored flags outside the doors of your
exam rooms.

○

If your practice does not use MicroMD PM, you must
use the Appointment Book to use Scheduled Visits.



If you see the portal icon in the Flags column, this
indicates that the patient has an active Patient
Portal account. If there is no icon, you can right-click
the patient and select Patient Portal Setup to
create an account for them.

Figure 4.24 Scheduled Visits

Establishing Stations and Flags
As you route patients, you can indicate which room the patient is in, as well as associate up to two colored
flags for each step of their visit. The stations in the system should relate to actual locations in your practice,
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such as exam rooms or vitals areas. We designed the flags in the EMR to mimic the flags you may have
outside the rooms of your practice.
You set up flags and stations using the MicroMD EMR Manager. See page 1.65 and page 1.66 for more
details.

Checking in Patients
Once you create stations and flags, you can begin using the Scheduled Visits to route patients through
your practice. The receptionist typically begins the process by checking in patients that arrive for their
appointment. She can check patients in using the Appointment Book or by using her Scheduled Visits,
although anyone can check the patient in using Scheduled Visits. In the Scheduled Visits, click the Checkin button (Figure 4.24). The Patient Check-in window opens (Figure 4.25).

○

When you click the New Encounter button (Figure
4.24) without checking in the patient first, the system
automatically takes you through the check-in
process.

Figure 4.25 Checking in a Patient
The Current Workflow section of the window is new and contains the stations and flags you created. The
Resource drop-down defaults to the current user. When checking in a patient, there is nothing new you
have to do, unless you created a Station for the waiting room. When you check a patient in, the system
displays Checked In as the patient’s current station automatically and changes the Check-In button for
that patient to the Route Patient button.

Routing Patients
You can route patients by either “picking up” the patient from the previous user or “dropping off” the
patient to the next user. The workflow of your practice determines how you use the Scheduled Visits
module.

Figure 4.26 Route Patient Window
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When you pick up a patient, you know in some way that the patient is ready for you. It could be the colored
flags you use outside the exam rooms, or the flags in the Scheduled Visits, or some other means. You can
highlight the patient’s entry and click the Route Patient button. The Resource drop-down defaults to you,
and you can set the flags if necessary. When you drop off a patient, you route the patient and select the
next user from the Resource drop-down.
For example, Andy Homer has an appointment at Summervale Medical Center. Jennifer, the receptionist,
highlights Andy within the list of scheduled visits and clicks the Check-in button to open the Patient
Check-in window. She verifies the information is correct and clicks the Check-In button.
Betty (one of the nurses) is in the back and notices in her Scheduled Visits that Andy has checked in and
has been waiting for a few minutes. She highlights his entry, clicks the Route Patient button and selects
Vitals Area from the Station drop-down. This lets the other nurses know that she is bringing Andy back,
and they can work with one of the other patients that have checked in.

Figure 4.27 Routing Patient – Picking Up
Now she can go out and call Andy back. She takes Andy back to the vitals area. She highlights his entry in
Scheduled Visits and clicks the New Encounter button to begin the encounter for Andy, recording his
vitals and taking some history. Once she creates this encounter, an encounter icon ( ) appears next to
Andy’s Scheduled Visits row.
Once she is finished with the pre-encounter, she clicks the Route Patient button and selects the doctor
from the Resource drop-down. She changes the Station drop-down to Exam 03 and selects the green flag
from the first Flags drop-down. The green flag tells the physicians at this practice that the patient is ready
for them, and she takes Andy to Exam 03.

Figure 4.28 Routing Patient – Dropping Off
Dr. Davidson is finishing with his last patient in Exam Room 3 and checks the Scheduled Visits section of his
Desktop. He sees an encounter icon ( ) next to Andy Homer’s scheduled visit, as well as the green flag. He
can also see that Andy has been waiting for 10 minutes.
When the doctor gets to his visit with Andy, he clicks the Route Patient button and changes the flag to
blue. (This is the practice’s indication that the physician is currently in the room with the patient.) Dr.
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Davidson highlights Andy’s Scheduled visits row and clicks the Open Encounter button to finish the
encounter.
Once Dr. Davidson signs the encounter, the system automatically changes Andy’s Current Resource to
Seen Today. If Dr. Davidson is done with Andy but doesn’t sign his encounters right away, he can click the
Mark As Seen button to finish routing the patient. Andy can now go home, feeling better.

Waiting Time
The routing system includes a timer that displays how long a patient has been at their current location.
This appears under the Waiting column of the Scheduled Visits area and the Waited column in the Routing
History window. The system begins the timer once you check in the patient. The timer resets each time a
user changes something on the Route Patient window. The Duration column represents the overall time of
the entire visit.

Classification
The Classification column displays the choice made in the Appt Type drop-down in the Add Appointment
window. You can also filter the list based on Classification.

○

For those using MicroMD PM, this column is also
color-coded to match the classification colors in the
PM.

Routing History
The system keeps track of every stage of the patient’s visit when you use Scheduled Visits. It includes a
time stamp, the length of the wait with that resource, the name of the assigned station, the resource, and
any flags associated with each step of the visit. Click the Routing History button to open the Routing
History window. The system displays the total time of the visit at the bottom of the window.

Figure 4.29 Routing History Window

Filtering Scheduled Visits
To help you manage the list of patients, you can easily sort the appointments using the fields in the Filter
section (Figure 4.30). View all the appointments for a particular day or filter the list by patient, station, and
provider. Check the Include Scheduled, Include Checked-In, or Include Seen Today checkboxes to filter
results by a patient’s current status in the system. See Table 4.5 for more in-depth information about these
fields.
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Figure 4.30 Scheduled Visits Filter
Table 4.5

Filters Available in Scheduled Visits

Field

Description

Appt Date

The system defaults this filter to today’s date. If you want to view the list of visits
for a different day, simply select that date from the calendar drop-down.

Patient

To filter the list to a specific patient, type the name of the patient, or click the
Lookup icon (

) to open the Select Patient window.

Station

To filter the list by one of the stations, select it from this drop-down.

Resource/Provider

To filter the list by a specific provider or resource, select the provider or resource
from the drop-down. If the provider you want is not in your Common List, click
the Lookup icon (

) to open the Reference List Viewer window.

 For those users with the role of Receptionist associated with their user
account, the system defaults this drop-down to <Receptionist>. This
displays the list of patients for all providers for whom the user is a
receptionist.

 For those users with one of the four physician roles (Physician, Physician
Assistant, Nurse Practitioner, Non-physician Caregiver), this drop-down
defaults to their name, filtering the list to just their patients.

 For any other user, the system defaults this drop-down to <COMMON>,
which displays the list of appointments for all providers in the user’s
Common List.

○
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If a user has multiple roles and one is the
Receptionist role, the receptionist default takes
priority and this drop-down defaults to
<Receptionist>.
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Filters Available in Scheduled Visits (continued)

Field

Description

Location

To filter the list of appointments by the workplace(s) assigned to your user
account, make the proper selection in the drop-down. MicroMD EMR uses the
choice made in the Location field on the Add Appointment window.

○
Include: Scheduled,
Checked-In, and
Seen Today

The <ALL> option in the Location drop-down
displays all appointments where the Location field
on the appointment matches any of the workplaces
associated with your user account.

The Include filters allow you to further customize your list of scheduled visits to
meet your workflow needs. You have a few options:

 Scheduled: This option displays all patients that are on the schedule. For
users with the role of Receptionist, the system checks this box by default to
allow them to easily check in patients.

 Checked-In: This option displays all patients where a user has checked the
patient into the practice.

 Seen Today: This option includes those patients whose encounters were
signed or where the physician has clicked the Mark As Seen button.



Once the provider on the encounter signs the encounter,
the system automatically marks their station as Seen
Today. Click the Mark As Seen button to do this manually.

Creating a New Encounter
You start an encounter from the Scheduled Visits window by clicking the New Encounter button. Once
there is an encounter started, the New Encounter button changes to the Open Encounter button, and the
system displays an encounter icon in the scheduled visit. Anyone that needs to open the encounter can
click this button to do their portion of the encounter; however, once the physician for whom the encounter
was created has signed off on the encounter, other users will not be able to edit this encounter.

Pending Orders for a Visit
The order pending indicator appears in Scheduled Visits when there is a pending order (e.g., an EKG or a
throat culture). Once the user performs the order, the system removes the icon from the display.
For example, Dr. Davidson can see that there is an EKG order pending for Andy Homer in Exam Room 1. He
decides to wait until the order is complete before he visits with Andy.

MicroMD EMR User’s Reference Manual Version 16.0

4.37

Chapter 4. Desktop: My Workflow

Test Results

Mark As Seen Button
The Mark As Seen button gives you the ability to route patients through the Scheduled Visits screen as if
you signed their encounter and the appointment is over. Place a check mark in the Include Seen Today
checkbox to view the patients that have completed their visit.

○

The Mark As Seen button is enabled only for the provider
for whom the encounter was created.

Test Results
You can also use the Desktop to view test results that have been added to patients’ charts but that you
have not yet viewed. The results from diagnostic and lab tests you have ordered, including diagnostic tests
and lab orders, appear in this section of your Desktop. Once you mark the set of results as viewed, the
system removes the entry from your list.

Figure 4.31 Test Results on Physician’s Desktop

Viewing Test Results
To view a set of results, highlight the test and click the Open Result button. The appropriate results
window opens and provides the details of the test, including who performed it and any additional
comments. Once you have reviewed the results, close the results window and click the Mark as Viewed
button. This removes the selected entry from your list. You can still view the results within the patient’s
chart (page 13.17) or filter this window to show you those tests you have marked as viewed.
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Viewing Results for a Single Patient Using View Grouped
If you want to see all of the selected patient’s results by date ordered, highlight one of the patient’s results
and click the View Grouped button (Figure 4.31). This opens the View Results Grouped window that
displays the results of each test for the patient and the date it was ordered.

○

The system only displays those test results that were
ordered on the date of the result you highlighted.

Figure 4.32 View Results Grouped Window
The Open Orders section of the window lists any outstanding orders that have not yet been performed for
the patient. You can double-click an order to view the details.

Filtering the List of Results
In the Results section, you can filter the displayed results:

 Choose All Results to include the patient’s test results from all provider orders.
 Choose My Results to only list results from your orders.
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Marking the Results as Viewed
Once you have reviewed the results, you can click the Mark All As Viewed button to remove the results
from your task list. When you click Mark All As Viewed, the system only marks YOUR test results as
viewed. It does not mark results belonging to other providers.

Results Analysis and Note
You can quickly add your analysis and/or internal notes to any or all of your test results from the View
Results Grouped window. If the results displayed have any text in the Results Analysis or the Notes, the
respective icon turns yellow.

Figure 4.33 Results Analysis and Notes
Click the Add Result Analysis icon (
only that test result.

) or the Add Result Note icon (

) to enter your information for

Alternatively, if you want to write an analysis or note that applies to all of your test results currently in
the view, you can enter that blanket text in the appropriate field and click the appropriate Add to all
Results button.

Other Activities for Test Results
If you need to forward the results of a test to another MicroMD EMR user, you can click the Forward Result
button on the results list. The recipient can view the results you forward in their Test Results list. These
results have the type of CC: Lab or CC: Diagnostic.
If you need to send an internal mail (page 4.11) to a MicroMD EMR user regarding the patient’s results, you
can click the Mail button.
To create a reminder (page 4.17) for the highlighted result, click the Create Reminder button.

Transcription
Some physicians prefer to verbally record their visit with the patient and then hire a transcriptionist to
document the encounter for them. MicroMD EMR allows you to continue this practice. The Transcription
section of the Desktop is available only to those users with the role of Transcriptionist assigned to their
user account. You can filter your list using the options in the Filters section.

○

4.40

The Dictation tool used for recording an encounter for the
transcriptionist is only available on the Text Encounter.
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Figure 4.34 Transcriptions to Process
If the physician uses another method to record an encounter with the patient, you can still use the
transcription tool in the system to document the patient’s visit.
For more in-depth details about transcribing for a physician, please see page 27.44.

Transition of Care
The Transition of Care utility creates a workflow task item for either importing or exporting a C-CDA, CCR or
CCD file to or from a patient chart. You can then access the Transition of Care (In) or Transition of Care
(Out) windows from the Workflow Communicator section of a patient chart or the main menu.



Use the Rules Manager under the Tools menu to trigger
on Transition of Care when you open the patient’s chart
or create an encounter to remind you to perform any
number of reviews on their Medical Information.
The Transition of Care option only activates the rule if
the transition has a Begin Date within 365 days of the
day you open the chart or create the encounter, etc.
See page 27.22 for details on using the Rules Manager.
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Viewing Transition of Care Requests
Click the Transition of Care section in the Navigator to display requests in your Desktop (Figure 4.35). You
can filter the list of record requests using the Filters area at the top of the list. Table 4.6 explains the filters
in more detail.

Figure 4.35 Transition of Care Desktop
There are a number of buttons in the Transition of Care Desktop:

 Click the New button to create a transition of care request. You have the option to select
Transition In or Transition Out. Make the appropriate selection to open the Transition of Care
(In) or Transition of Care (Out) window. Once the request is saved, it then appears in the
Desktop Navigator. As with other Desktop Navigator tasks, the system displays the number of
unaddressed requests. See page 4.43 for more details on creating a transition of care request.

 Click the Open button to view the request in the Transition of Care (In) or Transition of Care
(Out) window.

 Once the request is completed, click the Mark as Done button to remove the request from your
Desktop. Completed requests can still be viewed by selecting Completed in the Status field of
the filter.

 Click the Print button to print just the highlighted request.
 Click the Print List button to print the entire list of transition of care requests displayed on the
Desktop.
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 To view the chart of the patient the transition of care request was made for, simply click the
Open Chart button.
Table 4.6

Filters Available for Transition of Care Requests

Field

Description

Date Range

To display a list of transition of care requests for a specific time period, you can
make a selection from the Request Date drop-down or set the range using the
From and To fields.

Direction

From this drop-down, you have the option to show all transition of care requests,
requests that have come into the office (In) or requests to send patient records to
another office (Out).

Status

Once you mark the records requests as done, the system removes them from your
active list. If you would like to see those messages again, simply select Completed
from this drop-down list.

Patient

You can filter the list to display only those requests pertaining to a specific patient.
Type the patient’s name in the field. If the system finds a match, it enters the
patient. If not, the Search window opens so you can find and insert the appropriate
patient’s name.

Provider

To filter the list by the user who made request, select the appropriate name in the
drop-down.

Creating a Transition of Care Request (In)
When you receive a patient from a specialist or a facility and you have taken over the care of that patient,
you can create a transition of care record for that patient, creating a documented intake record for the
patient. From this window, you can also request the patient’s care documentation from the transferring
physician or facility.

Figure 4.36 Transition of Care (In) Window
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Transition of Care

Transitions of care factor into qualifying for incentive
programs. Refer to the MicroMD EMR incentive program
documents for more details.

To receive a patient from another practice, click the New button in the Transition of Care section of your
Desktop and select Transition In from the drop-down menu. This opens the Transition of Care (In)
window (Figure 4.36).
In this window, you can enter from where the patient transitioned, the date your care of them began, and
the type of records sent to you from the previous specialist or facility. You can import the C-CDA, CCR, or
CCD file you received from the previous practice (click the Import C-CDA/CCR/CCD button) and reconcile
the data into the patient’s chart (page 10.15).
Click the RxHub Meds button to display the RxHub Medication History window where you can add a
medication to the patient’s chart and verify the information you have in the EMR is up-to-date. See
page 21.46 for more details on working with the patient’s medication history from RxHub.
The Summary of Care Status drop-down tracks your activity in receiving and incorporating the patient’s
information from the transferring physician or facility. You can change the status manually, but MicroMD
EMR detects when you perform these actions in the system and changes the drop-down automatically for
you. Table 4.7 explains the statuses in detail.


Table 4.7

For those participating in the incentive programs, the
status selected for the incoming Transition of Care helps
to determine whether you meet the Numerator
requirements for the Request and Accept Summary of
Care measures in the incentive programs. Please refer to
the MicroMD EMR incentive program documentation for
more information.

Summary of Care Status Options

Status

Description

Unavailable

This status means that the provider requested the Summary of Care from the
transferring provider or facility and the document was not available.

Requested

This status means that the provider has asked the transferring physician or
facility for the patient’s Summary of Care record. When you click the Mail button
and send a request to the transferring physician or facility, the system
automatically changes the status to Requested.

Received

This status indicates that the provider has received the patient’s record from the
transferring physician or facility but has yet to incorporate the data into the
patient’s chart in MicroMD EMR.

Incorporated

This status means that you have imported the CDA you received from the
transferring physician or facility into the patient’s chart and reconciled the data.
The system automatically changes the status when you click the Apply button on
the Data Reconciliation window (Figure 10.9 on page 10.16).
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Creating a Transition of Care Request (Out)
When you transfer a patient’s care to a specialist or another facility, you can create a transition of care
record for that patient, creating documentation of the patient’s transfer.

Figure 4.37 Transition of Care (Out) Window



Transitions of care factor into qualifying for incentive
programs. Refer to the MicroMD EMR incentive program
documents for more details.

To send a patient to another practice, click the New button in the Transition of Care section of your
Desktop and select Transition Out from the drop-down menu. This opens the Transition of Care (Out)
window (Figure 4.37).
In this window, you can enter where the patient was sent, the date the new facility’s care of the patient
began, the type of records you sent to the new specialist or facility. You can also export the patient’s
records from MicroMD EMR in a C-CDA, CCR or CCD file (click the Export C-CDA/CCR/CCD button),
depending on your practice’s preference (page 1.35). You can also import any other documents you
receive or send out during the transition.
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Unidentified Items
All unidentified items are located in one section of the Desktop, including unidentified labs, prescriptions,
and transcriptions. The Unidentified Items section of the Desktop is available only to those users with the
Unidentified Items function assigned to their user account (page 1.16) and the items they are allowed to
view selected at that time.
Depending on your user permissions, you could be able to view any or all of the following: Attachments,
Lab Results, Hospital Reports, Vaccines, Rx Requests, Appointments, Cardiology, and/or Diagnostic
Results.

Figure 4.38 Unidentified Items on the Desktop
To narrow the list of unidentified items, you can filter the window to just those items you want to review.
You can filter by date, type, patient and provider.

○

4.46

The Provider drop-down lists only those providers listed
in the displayed items. This list may include providers who
are not MicroMD EMR users.
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When you highlight an unidentified item, MicroMD EMR displays all known information about the item at
the bottom of the window in the yellow area. Use this information to help find the appropriate patient or
provider in your system.

○

Once a user identifies a lab result with a patient and/or
provider, the system creates an entry in the Audit Log
reports.

How an Item Becomes Classified as UNIDENTIFIED
To successfully add an imported item to a patient’s chart, MicroMD EMR must be able to identify both the
patient and the provider associated with the item. Once the system successfully identifies each item,
MicroMD EMR automatically enters the data into the appropriate patient’s chart.
If MicroMD EMR is unable to identify either the patient, the provider associated with an item, or a resource
associated with an item, the system classifies that item as UNIDENTIFIED and adds it to this list on your
Desktop.

 Patient: When MicroMD EMR receives an item, the system tries to identify the patient. To identify
the patient, MicroMD EMR tries to match specific details that were received with details of a
patient in the MicroMD EMR database. The system performs up to two checks in order to identify
each item.
MicroMD EMR first tries to identify the item using the last name, first name and date of birth that
were received with the item. If this is not successful, the system tries to match the patient’s date
of birth and internal MicroMD EMR ID. If MicroMD EMR is still unable to successfully identify the
patient, it classifies the item as UNIDENTIFIED and highlights the name in the Patient column in
light blue.

 Provider: The system also tries to match the provider details in the item with the details of a
provider in the MicroMD EMR database. The system first tries to match the provider’s last name
and UPIN number. If this is not successful, MicroMD EMR tries to match the provider’s first name
and last name. If this is still not successful, the system classifies the item as UNIDENTIFIED and
highlights the name in the Provider column in light blue.
The system does not insert the unidentified item into any chart and does not associate it with any provider
or resource. Once this happens, you must manually associate these UNIDENTIFIED items with the
appropriate provider and patient.

Identifying the Patient
When MicroMD EMR receives an item, MicroMD EMR tries to match the patient’s details in the item with the
details of a patient in your database. The system first tries to identify the results using the last name, first
name, and date of birth received with the item. If this is not successful, the system tries to match the
patient’s date of birth and internal MicroMD EMR ID. If MicroMD EMR is still unable to successfully identify
the patient, the item is classified as UNIDENTIFIED. The difference could be as minor as a misspelling or
extra space.
To identify the patient in unidentified item:

Procedure

Details

1. Verify that you have the Desktop displayed.
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Procedure (continued)

Details (continued)

2. In the Desktop Navigator section, click My
Workflow and choose Unidentified Items
from the options available.

The system displays the list of unidentified items
you have permissions to view.

3. Locate and select the item that you want to
identify.
4. Verify that the space for the patient’s name
appears with a light blue background.

This light blue highlight indicates that the system
could not match the item with a patient in your
database.

5. Click the Identify Patient button.

The patient search window opens.

6. Locate the appropriate patient and click OK.

The system associates the patient with the
selected item.
If both the patient and the provider of the selected
item are now identified, the system removes the
entry from the list and places them in the chart of
the appropriate patient and in the correct
provider’s Desktop.
If the provider is still unidentified, the entry
remains in the list of unidentified items.

○

Every set of lab results is associated
with a specimen. When you identify a
patient with a specific set of lab
results, MicroMD EMR automatically
identifies that same patient for all
other unidentified lab results
associated with the same specimen.

Identifying the Provider
When MicroMD EMR receives an item, MicroMD EMR tries to match the provider’s details in the item with
the details of a provider in your database. The system first tries to match the provider’s last name and UPIN
number. If this is not successful, MicroMD EMR tries to match the provider’s first name and last name. If this
is still not successful, then the result is classified as UNIDENTIFIED. The difference could be as minor as a
misspelling or an extra space.

○
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In the list of unidentified items, MicroMD EMR displays the
columns Date, Provider and Patient. The Provider
column shows the data that was received in place of the
provider’s UPIN number. Often the “UPIN number”
received is in fact the provider’s name.
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To identify the provider in an unidentified item:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click My
Workflow and choose Unidentified Items
from the options available.

The system displays the list of unidentified items
you have permissions to view.

3. Locate and select the set of results that you
want to identify.
4. Verify that the space for the provider’s name
appears with a light blue background.

This light blue highlight indicates that the system
could not match the item with a provider in your
database.

5. Click the Identify Provider button.

The Reference List Viewer window opens and
displays your Common List of providers.

6. Locate the required provider and click Insert.

The system associates the provider with the
selected item.
If both the provider and the patient of the selected
item are now identified, the system removes the
entry from the list and places it in the chart of the
appropriate patient and in the correct provider’s
Desktop.
If the patient is still unidentified, the entry remains
in the list. The newly identified provider’s name
appears followed by the name downloaded
originally.

○
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Every set of lab results is associated
with a specimen. When you identify a
provider with a specific set of lab
results, MicroMD EMR automatically
identifies that same provider for all
other unidentified lab results
associated with the same specimen.
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Discarding Unidentified Items
There may be times when you simply need to discard items in the unidentified list. For example, if the
batch of lab tests were tainted in some way, and the lab informs you that the results from a particular day
are no good, you can remove them from the system.
To discard unidentified items:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click My
Workflow and choose Unidentified Items
from the options available.

The system displays the list of unidentified items you
have permissions to view.

3. Locate and select the set of items that you
want to remove.
4. Highlight the item you want to remove and
click the Delete button.

The system discards the item and removes it from
the list.

Deleting Items for a Specific Provider
There may be times where you need to delete all of the unidentified items for a specific provider in the list
displayed. For example, Dr. Tom Pollock regularly submits his patients for lab tests. Dr. Pollock, however, is
not a MicroMD EMR user and therefore is not set up to electronically receive lab results for his patients. The
laboratory that performed the lab tests for the practice does not know this and returned all results
electronically to the practice—including results for Dr. Pollock. You can easily remove all results for Dr.
Pollock from MicroMD EMR.

○

The system deletes only those entries in the displayed list.
If you have filtered the list to include only certain dates
and then choose to delete by provider, the system only
deletes the items in the list for that provider.

To discard lab results for a specific provider:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click My
Workflow and choose Unidentified Items from
the options available.

The system displays the list of unidentified items
you have permission to view.

3. Use the available controls to display those
unidentified items that you want to delete.
4. Select the item you want to delete, then click
the Delete button.
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Desktop: Patient Care
When a user has a Nurse, Nurse Practitioner or Non-Physician Care Giver role assigned to their user
account, the system enables the Patient Care button on their Desktop (Figure 5.2). As you click through
the different areas under the Patient Care button, the system remembers the patient you selected in the
previous section and automatically displays that patient’s information for you.
For example, you entered Andy Homer’s vitals and now you need to see the results of any nursing care
requests for Mr. Homer. When you choose the Nursing care option, the system automatically enters Andy
Homer in the Patient field and you can view any orders right away, eliminating the extra steps of searching.

In This Chapter
In this chapter, we cover the following sections of the Desktop:

 Chronic Care Management (page 5.1)
 Goal Monitoring (page 5.3)
 Group Encounter Charting (page 5.4)
 Health Concerns (page 5.5)
 Immunizations (page 5.6)
 Nursing Care (page 5.7)
 Screening and Prevention (page 5.8)
 Vital Signs (page 5.9)

Chronic Care Management
The Chronic Care Management (CCM) section of the Desktop allows providers to view all of the practice’s
CCM patients in one central location in the software. To enable the Desktop option, simply add the Chronic
Care Management function to their user account (page 1.16).
You can use the filters to narrow the list of patients to the ones you want to review. You can also use the
Patient field to search for and select a specific patient.
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Chronic Care Management

Figure 5.1 Chronic Care Management
The Resource/Provider filter applies to the provider selected in the Billing Provider field of the patient’s
Chronic Care Management consent entry (page 17.33).
The Total Time filter allows you to narrow the list of patients to either those whose current total recorded
non-complex time is less than 20 minutes (the minimum allowed for billing non-complex CCM) or those
whose current total recorded complex time is less than 60 minutes (the minimum allowed for billing
complex CCM). For example, if the end of the month is next week, and you want to makes sure you've hit
those minimum billing amounts, you can use this filter to see the list of CCM patients you need to review.



5.2

For more detailed information on Chronic Care
Management, please see page 17.31.
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Goal Monitoring
Physicians can set goals for a patient to help them eliminate or overcome risks to their health. Tracking
and monitoring these goals is easy with MicroMD EMR and not limited to the physician’s functions in the
system. Any MicroMD EMR user can view the Goal Monitoring option on their Desktop. They just need to
have the Goal Monitoring (Desktop) function selected on their user account (page 1.16). Once you turn on
this function, the system adds the Goal Monitoring option to the list of available choices under the Patient
Care button (Figure 5.2).

Figure 5.2 Goal Monitoring from the Desktop
Once you have your Goal Monitoring list displayed, type the patient’s name in the Patient field. If the
system finds a match, it enters the patient. If not, the Search window opens so you can find and insert the
appropriate patient’s name. The system displays the list of the goals attached to the patient’s chart. To
add a goal to the patient’s chart, click the Add button. To edit or delete a goal, highlight the entry and click
the Edit and Delete buttons as appropriate.
To add a tracking entry to a goal, highlight the goal and click the Add Monitor button. The system adds the
monitor as the first entry in the row. To edit a monitor, highlight the monitor and click the Edit Monitor
button and edit the entry.
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When you click the Print button, the system prints a report on the selected goal, including details of the
goal and each of the monitor entries created for the goal.



For more detailed information on Goal Monitoring, please
see page 17.23.

Group Encounter Charting
For use with behavioral health or therapy practices, MicroMD EMR provides you with the ability to
document encounters easily in a group setting. With the help of Patient Groups (page 6.18), you can create
encounters for group sessions that you hold with your patients and maintain that group documentation.

Figure 5.3 Group Encounter Charting
Click the Patient Care button on your Desktop to access the Group Encounter section. By default, this
section displays all group encounters, whether or not they’ve been signed. You can filter the list as needed
and access various sections of patient charts.


5.4

For more detailed information on Group Encounter
Charting, please see page 23.54.

MicroMD EMR User’s Reference Manual Version 16.0

Health Concerns

Chapter 5. Desktop: Patient Care

Health Concerns
The Health Concerns section of the Desktop allows you to record all concerns about the patient's health
(whether your own concerns, those from your patient, or concerns from another provider), associate risk
scores with the health concerns and set up a Care Plan to address the health concerns to track the
patient's progress in the Care Plan.

Figure 5.4 Health Concerns on the Desktop
Type the patient’s name in the Patient field. If the system finds a match, it enters the patient. If not, the
Search window opens so you can find and insert the appropriate patient’s name. The system displays the
patient’s list of health concerns.
To the add a new concern to the patient’s chart, click the Add button. To edit or delete an entry in this list,
highlight the entry and click the Edit or Delete button as appropriate.



For more detailed information about Health Concerns,
please see page 17.25.
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Immunizations
The Immunizations section of the Desktop (under the Patient Care button) provides a useful way for you
to record and review a patient’s immunizations without opening their chart. The system also allows you to
print the list of immunizations already administered to the patient from the displayed series. This option is
only available on the Desktop for those users with one of the following roles assigned to their user account:
Nurse, Nurse Practitioner or Non-Physician Care Giver.

Figure 5.5 Immunizations on the Desktop
Type the patient’s name in the Patient field. If the system finds a match, it enters the patient. If not, the
Search window opens so you can find and insert the appropriate patient’s name. The system displays the
patient’s list of immunizations.
If you want to record that you administered a vaccine in the series, highlight the appropriate column and
click the Administer button.
You also have several utilities available in this window to help you work more efficiently. Click the Print
button to print a list of the vaccines already given to the patient. This is particularly useful to provide a
vaccine history to a parent.


5.6

Refer to Chapter 17 for in-depth details on the Health
Maintenance module.
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Nursing Care
Nursing care requests can range from administering medications to inserting IVs. The Nursing Care section
of the Desktop provides a way for you to review any requests for a specific patient. To access this section of
the desktop, choose the Nursing care option in the Desktop Navigator (under the Patient Care button).
This option is only available on the Desktop for those users with one of the following roles assigned to their
user account: Nurse, Nurse Practitioner or Non-Physician Care Giver.

Figure 5.6 Nursing Care on the Desktop
Type the patient’s name in the Patient field. If the system finds a match, it enters the patient. If not, the
Search window opens so you can find and insert the appropriate patient’s name. The system displays the
patient’s list of nursing care. This list displays only those nursing care requests that have been performed
and indicates whether the user signed off on the request.
To the add a new request to the patient’s chart, click the Add button. To edit or delete an entry in this list,
highlight the entry and click the Edit or Delete button as appropriate.



Refer to Chapter 15 for in-depth details on orders.
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Screening and Prevention
The Screening & Prevention section of the Desktop allows you to record when you performed a procedure
in a program scheduled for a patient. The system color codes each of the scheduled procedures, and the
legend on this window explains what each color means. To access this section of the desktop, choose the
Screening & prevention option in the Desktop Navigator (under the Patient Care button). This option is
only available on the Desktop for those users with one of the following roles assigned to their user account:
Nurse, Nurse Practitioner or Non-Physician Care Giver.

Figure 5.7 Screening and Prevention on the Desktop
Type the patient’s name in the Patient field. If the system finds a match, it enters the patient. If not, the
Search window opens so you can find and insert the appropriate patient’s name. The system displays the
patient’s list of programs.
If you want to record that a procedure listed in the program is complete, highlight the appropriate row. In
the lower-left corner of the yellow sticky area, select the date you would like to use for administering the
procedure, and click the Administer button. For that row, the number in the Given column will increase by
1, and the date selected for administering the procedure will populate in the Given column next to the
number.


5.8

Refer to Chapter 17 for in-depth details on the Health
Maintenance module.
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Vital Signs
For those users who record the patient’s vital signs and other statistics before the patient’s visit with the
physician, the system provides an area on the Desktop where the user does not have to open the patient’s
chart. Choose the Vital signs option in the Desktop Navigator to access this section (under the Patient
Care button). This option is only available on the Desktop for those users with one of the following roles
assigned to their user account: Nurse, Nurse Practitioner or Non-Physician Care Giver.

Figure 5.8 Vital Signs on the Desktop
Type the patient’s name in the Patient field. If the system finds a match, it enters the patient. If not, the
Search window opens so you can find and insert the appropriate patient’s name. The system displays the
patient’s list of vital signs.
Click the Add button to create a new entry. To edit or delete an entry, simply highlight the entry and click
the Edit or Delete button as appropriate.

○

You can edit or delete a set of vitals within 24 hours of
recording the measurement. After 24 hours, you can no
longer edit the patient’s vitals. However, a user with
access to the patient’s medical information can delete a
set of measurements at any time from within the patient’s
chart.
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You also have several utilities available in this window to help you work more efficiently. Click the Utilities
button and choose the task you want to perform. See the appropriate section of the manual for more indepth information about the task.



5.10

Refer to page 13.10 for in-depth details on adding Vital
Signs to the patient’s chart.
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Desktop: Administration
Just like the options available under the My Workflow button, there are a variety of options available
under the Administration button, depending on the roles and functions assigned to your user account.
When a user has the Practice Manager or Administrator role associated with their user account, the
system activates the Administration button on their Desktop (Figure 6.1). The system also displays the
Administration button whenever any user has an administrative function assigned to their user account
(e.g., Reports).

In This Chapter
In this chapter, we cover the following sections of the Desktop:

 Administrative Panel (page 6.2)
 Application Users (page 6.17)
 Billing Preparation (page 6.18)
 Chart Merging (page 6.18)
 External Transcriptions (page 6.18)
 Manage Patient Groups (page 6.18)
 Patient Transport (page 6.19)
 Reports (page 6.20)
 Stock Management (page 6.20)
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Administrative Panel
The Administrative Panel is the central location where an administrator in the practice can perform most
of their work, helping to streamline their day. From monitoring interfaces and faxes to managing the
practice’s contacts, the user can simply click a button and access the tools they need. Click the
Administration button on the Desktop to access this option. This option is available only to those users
with one of the following roles associated with their user account: Practice Manager or Administrator.

Figure 6.1 Administrative Panel

6.2
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Recall/Reminder Builder
MicroMD EMR allows you to search for patients by a number of criteria and generate patient recalls in a
mail merge format or print a list of selected patients. Click the Recall/Reminder Builder button in the
Advanced Reporting section of the Administrative Panel (Figure 6.1) to access this function.

Figure 6.2 Recall/Reminder Builder

Creating a Recall Reason
You can base your recall on a variety of conditions in the Query triggers at the top of the window, such
as age, gender, allergies, immunizations, etc.
To create/edit a patient recall reason:

Procedure
1. Click on the Administrative Panel section
in the Desktop Navigator.

Details

○

Only users with the Administrator or
Practice Manager role associated
with their account have access to the
Administrative Panel.

2. Click the Recall/Reminder Builder button. The Recall/Reminder Builder window opens
(Figure 6.2).
3. Select the practice from the drop-down.
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Procedure (continued)

Details (continued)

4. Select an existing reason or click New
Reason to create a new reason.

The New Reason button displays the following
window. Simply name the recall reason, enter the
default number of days before the patient should
come back and then associate it with an
Appointment Class.

5. Enter the appropriate query conditions in
the Query section.

Click the Delete Row or Add Row buttons to
remove or add additional conditions to the query.

6. Click the Save Reason button if you’ve
made any changes.

You can now generate a list of recalls.

Generating Recalls and Reminders for Patients
Once you have your recall reasons in the system and the criteria established for each reason, you can
begin to generate your recalls.

Procedure
1. Click on the Administrative Panel option
in the Desktop Navigator.

2. Click the Recall/Reminder Builder
button.

Details

○

Only users with the Administrator or
Practice Manager role associated
with their account have access to the
Administrative Panel.

The Recall/Reminder Builder window opens
(Figure 6.2).

3. Select the practice from the drop-down.
4. Select an existing reason from the list.
5. Click the Run button to create the
recall list.

A list of patients that meet the selected criteria
appears in the window.

6. Select the patients to include in the recall
by placing a check mark next to their
name.

You can also use the Select All or De-Select All
options on the Select button drop-down to select
patients quickly.

7. Click the To Worklist button to transfer
the list of patients to the Recall Worklist
area of the Desktop.

6.4



Click the Print button to print a list of
the selected patients, along with
their contact information.
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Procedure (continued)

Details (continued)

8. Repeat for any other recalls you want to
generate.
9. Click the Close button to exit the window.

Recall Worklist
After you create the recall from the Recall/Reminder Builder, the Recall Worklist under My Workflow
displays all of the recalls that need to be managed and allows you to take action on those recalls or
reminders. You can work this list in a way that is most efficient for you. You can call patients, send a
notice to the Patient Portal, send an e-mail, or generate a mail merge document to mail to the patient.
Simply select the appropriate patients and click the action you want to take for the selected patients.
Table 6.1 explains the buttons available for the worklist.

Figure 6.3 Recall Worklist on the Desktop
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Buttons Available for the Recall Worklist

Button

Description

Select All / De-Select All

Selects or de-selects all entries in the list.

Mark Recalled

Click this button to indicate that the selected patients were recalled by
other means.

Declined

Click this button to indicate that the selected patients have declined the
recall. The system removes the patient(s) from the list for all future
recalls for the specified reason.

Publish

If you want to use the Patient Portal to recall the selected patients, click
the Publish button. The system publishes a standard message stating
the need for the patient to contact the office due to the recall reason.
For example, “A friendly reminder: Please contact [provider name]’s
office to address [recall reason].”

○

Make sure all of the patients in your selected list have
portal access. If any patient in your selection list does
not have portal access, MicroMD EMR does not
publish to any of the patients.

To send mail merge letters to the selected patients, click the Mail Merge
button to open the Mail Merge window. See page 25.4 for detailed
information on printing mail merge documents from a report.

Mail Merge

 Choose the letter template you want to send.
 Move the patients over to the right pane.
 Click the Print button.



Click the Create Labels button first to create
address labels for the patients in the list.

Click this button to open the chart of the highlighted patient.

Open Chart

Objective Measure Calculations and Clinical Quality Measures
The Objective Measures and Clinical Quality Measures calculations are for those practices planning to
participate in government incentive programs. MicroMD EMR includes the tools to meet these objectives,
calculate them and report them to appropriate agencies if needed.



Refer to Chapter 29 for details on using the system for
Incentive Programs.

Activate Send and Receive Labs
Some lab interfaces require you to retrieve and send labs to their system manually. If you have one of the
interfaces, simply click this button to send lab requests and retrieve lab results.
6.6
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Immunization Upload
The system allows you to interface with a state vaccine registry. Once this is set up, you can view the status
of the uploads with the Immunization Upload task.

○

Contact your local authorized MicroMD reseller or Henry
Schein Medical Systems for more information on the
installation and configuration of state immunization
registries.

Figure 6.4 Immunization Uploads
From this window, you can see the date the vaccine was sent to the registry, as well as the patient’s name
and the specific vaccine. If you highlight the vaccine’s entry, the system displays the details in the yellow
area below the list, including the status of the electronic message to the registry. If you need to re-send the
vaccine, you can highlight it and click Resend. You can change the status of the selected vaccine entry and
print the displayed list of vaccine entries. You can also open a new mail message from this window (click
Send Mail).
If you need to make any adjustments to the entries in this window, you can highlight the entry and click the
Correct button. This allows you to fix items so they will upload correctly.
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Fax Monitoring
If you have the Fax Manager installed and you use this to send faxes from the system, you can monitor
faxes from within the main MicroMD EMR program, instead of going to the MicroMD EMR Manager. You can
do so using the Administrative Panel option on your Desktop.

○

This option is available only to those users with the
Administrator role assigned to their user account.

Click the Administration button on your Desktop and choose Administrative Panel from the list of
available options. To monitor faxes, simply click the Fax Monitoring button on the panel. This opens the
Fax Monitoring window. You can filter the list of sent faxes by provider, by their status and by the date they
were sent.

Figure 6.5 Fax Monitoring
From this window, you can see the current status of the fax. If you highlight the fax, the system displays the
details in the yellow area below the list. You can highlight the fax and click Resend if a fax failed. You can
delete a fax, change the status of the fax and print the displayed list of faxes. You can also open a new mail
message from this window (click Send Mail).

Demographics Dump
This feature is currently not in use.

6.8
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Prescription Monitoring
MicroMD EMR users have the ability to send prescriptions to pharmacies via an electronic file through
Surescripts. The Prescription Monitoring task allows you to see the history of these communications and
their current status. You can filter the list by user who sent the request, the status of the request and/or the
date range that the prescription was sent.

Figure 6.6 Prescription Monitoring
If you highlight the prescription, the system displays the details in the yellow area below the list. If the
prescription communication failed, you can highlight the entry and click Resend to have the system try
again. You can delete an entry, change the status of the prescription and print the displayed list of entries.
You can also open a new mail message from this window (click Send Mail). To print the list currently
displayed in the window, simply click the Print List button.
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Surveillance Monitoring
The system includes options to send files to agencies that monitor public health trends. When users create
encounters in the system that contain the monitored assessment codes, the system adds the patients to
surveillance monitoring. The interface sends information automatically to your selected registries.

Figure 6.7 Surveillance Monitor
To establish health surveillance settings, you first need to set up the external communication in the
MicroMD EMR Manager and tell the system what assessment codes to track. Once you have that
communication established, you can use the Surveillance Monitoring option under the Administration
button to send those files.

○

Your MicroMD support and interface teams perform the
setup for you once you purchase the interface.

When you open Surveillance Monitor window (Figure 6.7), the records meeting your criteria appear in this
list. From here, you can manually export the data (click the Export button); attempt to send a failed item to
the registry again (click the Resend button); send the selected patient’s information to someone (click the
Send Mail button).
The Filters at the top of the window allow you to narrow the information to include in the export file.

6.10
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Template Managers
Under the Miscellaneous Tasks section of the Administrative Panel, there are several template managers.
With these managers, you build the templates your staff can use throughout the system for patient labels,
specialist labels, labels for lab orders, and more. Please refer to the following sections for more
information:

 Label Template Manager (page 26.8)
 Prescription Template Manager (page 21.2)
 Fax Cover Sheet Manager (page 27.42)



The overall use of the template managers is similar
across all managers.

Patient Groups Manager
Patient Groups allow you to sort patients into various categories based on any number of criteria. This is
especially useful for reporting purposes and for communicating with your patients effectively. For
example, you can add all of your diabetic patients to the Diabetes patient group (either manually or
automatically). Now when you have reporting to do for diabetic patients or you have a letter that needs to
go out to all your diabetic patients, you can simply generate information for that group.
For more details on patient groups and the Patient Groups Manager, please refer to page 6.18.

Reassign User Tasks
For those times when a MicroMD EMR user leaves your practice and you mark their user account as
inactive, you need a way to reassign some of the tasks available in the system, such as reminders and lab
results that may still be active in the system. To avoid losing these items to the ether, MicroMD EMR
provides this console (under Administration > Administrative Panel > Reassign User Tasks) so you can
reassign many of these items.



This action is irreversible so be absolutely certain you
want to continue.
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Figure 6.8 Reassigning User Tasks
Click the Lookup icon (
) next to the Re-assigning tasks of field to choose the user whose tasks you
need to transfer to another MicroMD EMR user. Choose the user for each of the tasks you need to reassign.
If you want to reassign them all to the same user, choose the user for the first task and click the Copy to All
button. Once you are satisfied with the assignments, click the Re-assign button.



Remember: This action is IRREVERSIBLE. Proceed with
caution.

Satisfaction Questionnaire
The Satisfaction Questionnaire allows you to create a series of questions you can present to your patients.
The questions are completely up to you and help you find out how your patients perceive your practice.

Consent
The Consent section of the Administrative Panel allows you to create entries for the Consent section of the
patient chart, in addition to the consent features built into the program. Please refer to page 9.19 for more
information.

Bulk Patient CDA Export
Users with the Practice Manager role assigned to their user account have the ability to export CDA files for
multiple patients at one time. From the Desktop, click the Administration button. In the Miscellaneous
Tasks section, click the Bulk Patient CDA Export button.

6.12
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Figure 6.9 Bulk Patient CDA Export

Exporting Patient Care Records
You can use the Filters section at the top of the window to refine the list of patients for whom you want
to export data. You can choose a specific patient, a group of patients, patients of a single provider or a
group of providers. You can even narrow the list down to specific encounters. The patients you select
appear in the list below the filters.
You can choose to simply select the patients and click the Export button. Select the patients by
placing a check mark in the S column of each patient or using the Select button to select multiple
patients at once.



If you only have a few patient for whom you do not want
to export data, click the Select button and select Select
All from the drop-down menu. Then simply remove the
check mark from the few patients for whom you do not
want to export data.

Or, if you want to edit a patient’s data before the export, place a check mark in the E column for those
patients. When you click the Export button, the system displays an editing window for each patient
you marked. Remove check marks next to any items you want to omit from the export.
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Figure 6.10 Editing a Patient Care Record for Export
To export patient care records:

Procedure

Details

1. Search for the patient(s) for whom you
want to export data using the Filters
section.
2. Click the Search button.

The patients who match the criteria you set in the
Filters section appear in the list.

3. Place a check mark in the S column next
to each CDA you want to export.

If you want to edit the individual patient’s CDA
before exporting, place a check mark in the E
column.



Click the Include All or Exclude All
buttons to select items quickly.

4. Click the Export button
5. The system prompts you for a location to
save the export file.
6. Select a location on the computer and
click OK.

6.14

The Edit Bulk Patient CDA Export window opens.
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Procedure (continued)

Details (continued)

7. Remove the check mark from any section
that you do not want to include in the
bulk export.

8. Click the OK button.

○

This action applies to ALL selected
patients in the export.

At this point, the system displays the CDA Data Edit
window for any patient you elected to edit specific
data (Figure 6.10 on page 6.14). Make your edits for
each patient and click OK.
The system builds the export file(s) and saves them
to the location you specified.



Depending on the number of
patients you selected, this process
could take some time. Please be
patient.

Scheduling an Export
Exporting data for a large number of patients can take up quite a bit of processing time on the system
and render the computer unusable for a period of time. To help minimize the time you need to tie up
your computer, MicroMD provides you with the ability to schedule your export.

Figure 6.11 Scheduling an Export
When you click the Schedule Export button, you can establish the search criteria that tells MicroMD
which patients you want to include in the export, based on the Encounter Date or the Appointment
Date, as well as when you want the system to perform the export.
You have the following schedule options from the CDA Export drop-down:

 One Time: You can schedule a one-time export for any date and time in the future.
 Every Day: The export occurs seven days a week at the time you enter in the Export Time field.
 Week Days: The export occurs Monday through Friday every week at the time you enter in the
Export Time field.

 Specific Days: You can choose any combination of days for the export to run at the time you
enter in the Export Time field. Simply place a check mark in the appropriate checkbox(es).
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 Monthly: You can choose the day of the month on which you want the export to run at the time
you enter in the Export Time field.

CHDP Extra Form Setup
For use with Medicaid practices in California, the CHDP Extra Form Setup option allows you to establish
the codes that can automatically help MicroMD EMR complete portions of the form for you. Simply click
the magnifier icon ( ) to select the appropriate codes. If an encounter contains these codes as indicated
on the form, the system enters the information in the appropriate locations of the form.

Figure 6.12 CHDP Extra Form Setup
The CHDP form information appears under the Extra button on the Bill Builder window (page 24.2). When
preparing to send the bill over to the PM, click the Extra button and select the CHDP Assessment form. The
CHDP Assessment window opens and pre-populates the information from the patient’s encounter and
refreshing existing data from last time. Simply review the remaining sections of the form (click Next to
navigate to other pages on the form). Click Finish when complete.



6.16

The information entered transfers to the same form in
MicroMD PM.
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Application Users
MicroMD EMR allows you to view lists of MicroMD EMR users based on the roles assigned to the users. You
can list all registered users, or just those users who are currently logged in to the system. Only users with
one of the following user roles can access the Application Users section of the Desktop: Administrator or
Practice Manager.

Figure 6.13 Listing MicroMD EMR Users
To list all MicroMD EMR users, first verify that you have your Desktop displayed. Simply click the
Administration button and select Application Users from the options available. The system displays a list
of the roles available in the system and the number of users assigned to each role.

 Click a role and the system displays the actual users assigned to that role.
 Choose the Users option at the top of the window to display all users.
 Choose the Logged-on option to filter the list to display only those users currently logged in to
the system.

○

The system includes both active and inactive users in
these lists.

MicroMD EMR User’s Reference Manual Version 16.0

6.17

Chapter 6. Desktop: Administration

Billing Preparation

Billing Preparation
The Billing Preparation section of the Desktop provides the billing person in the practice a central location
where they can work through all of the encounters that are ready to be billed either to the patient’s
insurance or directly to the patient. The Billing Preparation option is available to users with one of the
following user roles assigned to their user account: Billing Personnel or Practice Manager.



For more details on billing in MicroMD EMR, including
information on this section of the Desktop, please refer to
Chapter 24.

Chart Merging
There are times in the life of a practice where you discover that you have duplicate charts for a patient. The
Chart Merging section of the Desktop allows you to correct this. Chart Merging is available to any user with
the Merge Charts function associated to their user account.



For more details on charts in MicroMD EMR, including
information on this section of the Desktop, please refer to
Chapter 10.

External Transcriptions
MicroMD EMR provides an interface to an outside vendor who can transcribe files for you. When the files
come over to the EMR, you can manage those incoming transcriptions from here.



For more in-depth details about transcription in MicroMD
EMR, please see page 27.44.

Managing Patient Groups
MicroMD EMR provides practices with a way to create Patient Groups in their database. Patient Groups are
patients that have a significant common characteristic. For example, you could create the Patient Group
ASTHMATIC to include all patients that have been diagnosed with chronic asthma. When you add a patient
to a Patient Group, MicroMD EMR adds a “sticker” to the patient’s chart. The sticker is color-coded
according to the color that you specified for the group.
The Manage Patient Groups option on the Desktop is available to any user with the Manage Patient
Groups function associated to their user account.



6.18

For more details on managing Patient Groups, please see
page 9.24.

MicroMD EMR User’s Reference Manual Version 16.0

Patient Transport

Chapter 6. Desktop: Administration

Patient Transport
For those practices that need to help patients to various sections of the facility, the system provides a
transportation tracking area on the Desktop. The Administration button is available on the Desktop for
users with Patient Transport function.

Figure 6.14 Managing Patient Transport Requests
You can filter the list of transport requests using the options in the Transport Filter Criteria section. The
entries in the list must satisfy all items you specify in the filter.
To add a transport request, click the New Request button and complete the information on the window
that opens. Once you click OK, you can then print the request (highlight the entry and click Print) and hand
that printout to the appropriate personnel.
Once the transportation of the patient is complete, you can enter the details of who performed the
transport and when they performed it. Highlight the appropriate request in the list and click the Open
button. Complete the edits to the request and click OK.
To delete a request from the list, simply highlight the entry and click the Delete button. If you want to print
the entire list, click the Print List button.
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Reports
In every practice, there is always a need to generate reports pertaining to the business of your practice and
to generate information for papers that physicians write over the years. The reporting capabilities in
MicroMD EMR are flexible enough to meet the needs of most users. The Reporting option on the Desktop is
available to any user with the following functions assigned to their user account: Reports (Admin) and/or
Reports (All).
The Reports (Admin) function allows the user to work with only those reports that do not contain specific
patient information. The Reports (All) function allows the user to generate any report, as long as they have
a role that allows access to patient information.



For more details on running reports in the system, see
Chapter 25.

Stock Management
MicroMD EMR allows your practice to maintain an inventory of the medication samples and immunization
supplies you have in stock. The system needs to know your inventory in order for the stock to be accurate.
The Stock Management option on the Desktop is only available to users with the Manage Stock function
assigned to their user account.

Figure 6.15 Stock Management on the Desktop
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Creating Inventory Entries in the Database
Before you can manage stock in MicroMD EMR, you need to create the list of items you want to track in
your database. This includes the type of stock item, from vaccines to medications to supplies, and the cost
of each item. Once you add this list to your database, you can then tell the system how much of each item
you have on hand (page 6.22).

Figure 6.16 Adding an Item to the Database
To add items to the database:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button and choose Stock
Management from the options available.
3. Click the Add button.

The Stock Item Details window opens (Figure 6.16).

4. From the Category drop-down, select the
appropriate classification for the item you
want to enter.

The selection you make from this drop-down
determines the reference list that opens for the
Item name field. If you do not enter a category
here, the system prompts you to choose one when
you click the Lookup icon (
name field.

5. Click the Lookup icon (
name field.

) next to the Item

) next to the Item

This opens the appropriate reference list for you to
choose the item you want to track.

6. Locate and insert the item.
7. In the Description field, enter any useful
information about the item.
8. From the Units drop-down, select the format
of the unit.

For example, bottle(s), tablet(s), syringe(s).

9. In the Price per unit field, enter the cost of a
single unit of the item.
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Procedure (continued)

Details (continued)

10. In the Publically Supplied Price per unit field,
enter the amount you charge for the item.

This allows for enhanced pricing options for
vaccines. When a staff member uses stock and
places a check mark in the Publically Supplied
checkbox on the Stock Usage window (Figure 6.20
on page 6.25), the system automatically changes
the Price per unit field to the price you enter here.

11. Click OK when satisfied with the stock
item’s details.
12. Repeat step 3 through step 10 for each item
you want to add to the stock management.

Committing Stock to the System
Once you create your list of stock items, you need to enter the inventory details when you actually have
physical items to track. This includes where in your practice you have the item stored, who ordered the
amount being entered, the lot number (if applicable) and more. You also need to do this when you
replenish your inventory.

Figure 6.17 Adding New Stock Purchases
To add a new stock purchase to the system, highlight the item in the list to which you want to add stock.
Click the Stock button and select Add Stock from the drop-down menu. Table 6.2 explains the fields in
detail.
Table 6.2

Fields on the Add New Stock Window

Field

Description

Receipt No

The system automatically populates the Receipt No when you save the new
stock record.

Stock Item

The system automatically populates the Stock Item when you save the new
stock record.

Location

Select the physical location where you will store the quantity you are about to
enter. If the location you need does not exist, click the Lookup icon (
),
enter a useful name for the new location, select the department and click OK.
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Fields on the Add New Stock Window (continued)

Field

Description

Ordered by

The system automatically populates the Ordered by field the current user. If
you need to change the user, you can select the user from this drop-down.

Date Received

The system populates the Date Received field automatically with today’s
date. Select the correct date if you received the stock item on a different date.

Invoice No

Enter either the supplier’s invoice number or your PO number to help you
track your stock items.

Comment

In the Comment field, enter any additional useful information regarding your
addition of quantities to the system. This comment field holds 255 characters.

Supplier

From the Supplier drop-down, choose the distributor for the supplies. If the
supplier does not appear in this list, you can click the Lookup icon (
) next
to the Supplier drop-down to access the Supplier Manager. Please see
page 6.24 for more details.

Manufacturer

From the Manufacturer drop-down, choose the maker of the supplies. If the
manufacturer does not appear in this list, you can click the Lookup icon (
next to the drop-down to access the Vaccine Manufacturers reference list.

)

Ref # / Brand Name

If there is a reference number or you want to include the brand name for the
supplies, enter that in the Ref #/Brand Name field.

Lot Number

To add a lot number for this item, type a number in this field or click the
Lookup icon (
) to choose one from the list. Whenever someone uses an
item from this lot, the Lot Number stays with that stock item’s entry
throughout the system.

Lot Exp. Date

Enter the lot’s expiration date in the Lot Exp. Date field.

Quantity Received

In the Quantity Received field, enter the number of units you just received.
The system adds the number you enter to the existing quantity in the system.

Cost Per Unit

In the Cost Per Unit field, enter how much it cost you for a single unit of this
item. Once you tab out of this field, the system automatically calculates the
Total Cost field for you.

Total Cost

The Total Cost field calculates automatically multiplies the Quantity Received
field with the Cost Per Unit field when you tab out of the Cost Per Unit field.
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Adding a New Supplier
From the Supplier Manager, you can add new suppliers, edit existing ones or remove suppliers from the
list. These are the vendors from which you order medications, operation kits and more. To access the
Supplier Manager, click the Managers button (Figure 6.15 on page 6.20) and select Supplier Manager
from the drop-down menu.

Figure 6.18 Supplier Manager
To add a new supplier to the system, simply click the Add button and complete the fields on the window
that opens. If you need to edit the entry for the stock item (e.g., edit the price, change the type of unit) or
you no longer carry the item, you can simply highlight the entry and click Edit or Delete as appropriate.

Adjusting an Existing Stock Item
Once you have entered stock items, you can adjust the items you have in stock. You can choose to split a
quantity between locations. You can also correct mistakes that were made when entering the purchase
into the system, like entering 50 units of an item when in fact it was 500 units.

Figure 6.19 Adjusting a Stock Item
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To adjust an item in stock:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button and choose Stock
Management from the options available.
3. Highlight the stock item to which you want
to adjust.
4. Click the Stock button and select Adjust
Stock from the drop-down menu.

The Stock Adjustment window opens (Figure 6.19).

5. Make the changes needed.

○

When you make an adjustment, you
must change both the Actual Lot
Quantity field and the Actual
Quantity at Location field, identified
by a green bullet ( ), to keep the
quantities between the whole lot and
the portion stored at the location
synchronized.

6. Click OK when finished.

Using an Item from Stock
You can use an item from stock in the system in a variety of ways. You can subtract the item from within the
Stock Management section of the Desktop. Providers can indicate when they write a prescription on the
Prescription Pad that they want to give one of the samples you have in stock.

Figure 6.20 Using an Item from Stock
To use an item from within the Stock Management section of the Desktop, click the Stock button and
select Use Stock from the drop-down menu. Complete the remaining fields on this window as appropriate
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and click OK. Table 6.3 explains the fields on the window in more detail.
Table 6.3

Fields on the Stock Usage Window

Field

Description

Transaction Id

This is a system-generated ID.

Stock

From the drop-down, select the item you want to use. The system populates
the Unit and Price Per Unit fields for you.

Location

From this drop-down, select the location from which you want to use the stock
item. This helps the system accurately track the appropriate inventory for you.

Lot Number

Select the lot number from the drop-down. You can also click the Lookup icon
(

), locate and insert the lot from which you want to use the item.

Used By

This field defaults to the current user. Click the Lookup icon (
different user if necessary.

Usage Type

From this drop-down select how you want to account for this item from stock.
Do you want to charge the patient? Do you want to charge the department
selected? If the item is a sample and you do not charge anyone, select Sample.

Patient

If this item is for a patient, type the patient’s name in the search field or click the
Lookup icon (

) and select a

). Locate and insert the patient’s name.

Department

This field defaults to the department you are currently logged into.

Comment

Enter any additional information that would be useful for future reference.

Date Used

This field defaults to today’s system date. Change the date if necessary.

Reference No

Enter the identifying number required by your practice for using this item. This
could be an invoice number, an authorization number—whatever is
appropriate for your practice.

Publically Supplied

Place a check mark in this option if your use of this stock item has different
pricing than the normal cost. The system populates the Price per unit field with
the amount entered in the Publically Supplied Price per unit field on the Stock
Item Details window (Figure 6.16 on page 6.21).

Quantity Used and
Units

Enter the quantity of the item that you want to use. The Units field populates
automatically when you select the item from the Stock drop-down.

Price Per Unit

This field populates automatically when you select an item from the Stock
drop-down list.

Charge Amount

You can enter the total charge amount (Price Per Unit field multiplied by the
Quantity field) or you can click the Calculation icon (
) next to the Total
Amount field and have the system do the calculation for you. If you click this
icon, the system overwrites any text you type in this field.

Sales Tax

6.26

Enter the sales tax for the transaction. If you click the Calculation icon (
)
next to the Total Amount field, the system overwrites any text you type in this
field.
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Fields on the Stock Usage Window (continued)

Field

Description

Total Amount

Click the Calculation icon (
) next to the Total Amount field, and the system
multiplies the Price Per Unit field multiplied by the Quantity field. The system
computes the sales tax for you and then adds the sales tax to the result.

Amount Paid

Enter the amount of the payment for this item.

Transactions Manager
If you need to review your stock management transactions, the Transactions Manager (Figure 6.21)
provides you with a wealth of information in one central location. You can also add, deduct, and adjust
your inventory items from this window. You can access the Transactions Manager window under Stock
Management > Managers button > Transaction Manager).

Figure 6.21 Transactions Manager
Each tab provides you with details on how items were added to the EMR (click the Stock Added tab); how
items were marked as “used” in the EMR (click the Stock Used tab); and how inventory items were
adjusted in the EMR (click the Stock Adjusted tab). The Stock Audit tab provides a running “change
history” of almost every action performed within Stock Management.



If the color of the text on the Stock Added, Stock Used,
or Stock Adjusted tab is blue, there are items listed on
that tab.
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When you highlight an item on one of the tabs (except for the Stock Audit tab), the yellow “sticky” below
the list displays the details of the transaction. The buttons provide several additional actions you can
perform on that tab.



Refer to the following sections for details on adding and
editing the items on each tab:
 Stock Added tab (page 6.22)
 Stock Used tab (page 6.25)
 Stock Adjusted tab (page 6.24)

The filters along the top of the window allow you to refine the list of inventory displayed. Table 6.4 explains
the filters in more detail.
Table 6.4

Filters on the Transactions Manager Window

Field

Description

Stock Item

From the Stock Item drop-down, you can select a specific item to narrow
the current list to display only transactions for that item. The transactions
displayed must also match the other filter criteria you set.

Date Range

You can use the Date Range fields to narrow the current list to display only
transactions that occurred on a specific day (e.g., all transactions
performed Yesterday) or within a specific date range.

Location

To filter the list to display only transactions for item stored in a specific
location, select that location from this drop-down.

Audit Category

For use only with the Stock Audit tab, you can filter the audit log to display
only history for transactions related to adding stock to the system, using
stock, or adjusting stock.
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Using Lists in the EMR
Throughout MicroMD EMR, there are lists of data from which you can choose the items you need when
performing your tasks. You can pick from lists of users, diagnoses, procedures, medications, allergies and
more.

In This Chapter
In this chapter, we cover how to:

 Open and use Reference Lists (page 7.2)
 Use a Common List (page 7.4)
 Manage Common Lists through the Common List Builder (page 7.5)
 Use Index Lists in the Reference List Viewer (page 7.17)
 Use Smart Lists in the Reference List Viewer (page 7.18)

Overview
MicroMD EMR provides various Reference Lists that help you enter discrete information into your patients’
medical records. Each Reference List contains the list of items that are available for a particular category.
For example, the Medication Reference List contains the list of medications based on a national drug
database.

Figure 7.1 Reference List
You have the following types of lists available to you in the EMR:

 Reference Lists (page 7.2): Some of the MicroMD EMR Reference Lists contain thousands of
entries. The Medications list, for example, contains over 40,000 entries. Other Reference Lists
contain less than 100 entries. The Reference Lists are comprehensive—containing all the entries
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that you need for the specified category. However, if a given Reference List does not contain an
entry that you require, you can add that item to the list.

 Common Lists (page 7.4): To simplify the selection process when using Reference Lists, the
system lets you use Common Lists. A Common List contains those entries from the Reference
List that you use most frequently. You have one Common List for each Reference List, and they
are user-specific.

 Index Lists (page 7.17): The Index list contains categories that you can select to help narrow your
search.

 Smart Lists (page 7.18): Smart Lists help you search a specific list of items and include lists such
as In-house procedures; Patient’s long-term medications; Practice-preferred medications.

Reference Lists
You use a MicroMD EMR Reference List Viewer (Figure 7.1) to access any of the MicroMD EMR Reference
Lists. The Reference List Viewer helps you to locate and select the required entry from a list of data.
The Reference List Viewer enables you to:

 Filter the entries displayed in the viewer
 Search for a specific entry
 Add an entry to the Reference List
 Add an entry to your Common List
 Remove an entry from your Common List
 Select an entry from a Reference List and insert it into the appropriate box
 Search by codes
Opening the Reference List Viewer
You can open a Reference List Viewer from anywhere in the system where you need to access a list of data
included in the system for a specific category (e.g., medications). Typically, you access the viewer by
clicking the Lookup icon ( ). The Reference List Viewer window for that category opens. The system
generally defaults the view to your “All” list, but you can access the information in the database by clicking
the Common, Index, or Smart buttons as appropriate. Simply highlight the item you want to use and click
the Insert button.

Figure 7.2 Lookup Icon


7.2

You can also double-click an entry in the Reference List
Viewer to insert the entry into the appropriate dialog box.
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Filtering the Reference List Viewer
When you access a Reference List in the Reference List Viewer, you filter the list in a variety of ways:

 Common: Click the Common button to display your Common List for the Reference List that is
displayed. Your Common Lists contain only your most frequently used entries for the category.
See Figure 7.4 on page 7.5.

 Index: Many of the items in each Reference List are broken down into categories. The Index
button displays only those entries in the category you choose. Many of the available categories
have subcategories. For example, you could select to display only those plans in the Pathology
> Surgical subcategory. See Figure 7.8 on page 7.17.

 Smart: Some items in some of the Reference Lists are grouped into miscellaneous categories.
The Smart button displays only those entries in the selected miscellaneous category. For
example, you could select to display the list of medications based on a specified generic or
specific ingredient. See Figure 7.9 on page 7.18.

 All: Displays an alphabetical list of all the entries that are in the selected Reference List.
Searching for an Entry in a Reference List
When you access a Reference List in the Reference List Viewer, you can use the Search field to find the item
in the list. You can choose to search either the entire Reference List or just the filtered portion of the
Reference List (Figure 7.1 on page 7.1).
Simply type a few letters (at least two) of the word you want to find, and the system automatically begins
to display the entries that match. For example, if you want to find Penicillin G, you could begin typing
peni, and the system starts narrowing the list.



You can right-click within the list of entries and select
either Match first letters only or Match any letters in
word to help you find what you need. You can set your
preference for this search method in your User
Preferences (page 1.84).

Showing Additional Information About a Reference List Entry
In the Medications, Diagnoses and Procedures Reference Lists, the system provides you with the ability to
access additional details about an entry in the list. This additional information may be in the MicroMD EMR
database, or the system can locate the information on the Internet for you. To access the additional
information, simply click the information bubble icon (

) at the bottom of the Reference List Viewer.

Figure 7.3 Accessing Additional Information
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Adding an Entry to a Reference List
The MicroMD EMR Reference Lists are comprehensive—containing all the entries that you should need for
the specified category. However, if a given Reference List does not contain a needed entry, you can add to
the Reference List.


○

If you add a medication to the Medications list, the new
medication does not have any cross-checking
associated with it. When you prescribe the added
medication, MicroMD EMR cannot perform a drug-todrug interaction cross-check or a drug-to-allergy
interaction cross-check.

MicroMD EMR has a number of Reference Lists that, for
medical security reasons, have restrictions on adding
new entries. The user must have the Add reference data
function to add an entry to one of these restricted lists.
For example, the following lists are restricted:
Medications, Procedures, Social Problems, Habits,
Assessment, Objective, Sexual History, Vaccine Suppliers
and Immunizations.

To add an entry to a Reference List:

Procedure
1. Click the Lookup icon (

Details
The Reference List Viewer window opens and displays
your Common List for the appropriate category.

).

2. Click the New button at the bottom of the
Reference List Viewer.

A window opens that allows you to enter details of the
new entry.

3. Enter the details and then click OK.

MicroMD EMR adds the new entry to the appropriate
Reference List.

Common Lists
To help you simplify the selection process when using Reference Lists, MicroMD EMR allows you to create a
Common List. This list is a filter of sorts that displays only those entries that you use most frequently. This
Common List generally appears as a drop-down in a field that displays a Lookup icon ( ). Each Common
List is a subset of the associated Reference List.
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Figure 7.4 Common Lists
For example, if there are about 25 medications your practice prescribes most frequently, you can create a
Common List that contains just those 25 medications rather than scrolling through an extensive list of
medications every time.
You have a separate Common List for each Reference List, and they are user-specific. You do not share
them with anyone else and can modify the lists as frequently as you need. When you are added as a
MicroMD EMR user, all your Common Lists are initially empty. You can build your Common Lists gradually
while you work with MicroMD EMR, or you can use the Common List Builder. To add to the list while you
work, simply highlight the entry and click the Add to Common List button at the bottom of the window
(e.g., Figure 7.1 on page 7.1).

Common List Builder
The Common List Builder is a useful tool that allows you to build your Common List for various modules in
the system, all from a single window (under Tools > Common List Builder). The Categories section on the
left are all of the Common Lists available in the system. Once you select an item in the Categories section,
the Available Items section populates with all of the items within the selected category. You can then move
the items you want over to your Common List.
Each tab of the Available Items section allows you to add items to your Common List in a different way.

 Copy tab: You can copy the Common List(s) of other users for the selected category.
 Calculate tab: You can calculate the Common List for the selected category based on your use
of the program.

 Specialty tab: You can also populate your Common List for the selected category based on your
specialty.

 Import tab: If you collaborate with a MicroMD EMR user from another practice across the
country, you can import their Common List.

 Lookup tab: The system allows you to go back to basics and populate your Common List one
item at a time.
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Figure 7.5 Common List Builder



ICD codes appear to the left of all Assessments. If there is
no code, an “[X]” appears as a placeholder. Typically, this
means there is no equivalent ICD-10 code associated
with the selected code.

Editing Items from the Common List Builder
You can edit most items using the Common List Builder, as well as from the various areas of the system
where you access those reference lists.

Procedure

Details

1. Select Tools > Common List Builder from the
main menu.

The Common List Builder window opens (Figure
7.5).

2. Click the Lookup tab.
3. Click the All button and search for the item
you want to edit.
4. Highlight the appropriate and click the down
arrow next to the New button.

The editing window opens for that item.


7.6

If there is no down arrow next to the
New button for the item, you cannot
edit the item.
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Procedure (continued)

Details (continued)

5. Edit the item and click OK.

If you have updated one or more items that are in
your Common List, the system displays a red alert
triangle icon.
If you have made edits to an item that are also in
your Common List and would like to update all of
the codes or all of the descriptions at one time,
right-click an item with a red alert triangle. The
pop-up menu displays options for replacing all
codes or for replacing all descriptions.

Copying a SINGLE Common List FROM Another User
The MicroMD EMR Common List Builder allows you to copy any Common List from another MicroMD EMR
user. The Common List Builder also allows you to create your Common Lists by copying ALL of another
user’s Common Lists. This is particularly useful when someone joins an existing practice. The new MicroMD
EMR user can copy all of his or her Common Lists from another user who is well established in the MicroMD
EMR system.

○

When you copy a Common List from another user, the
Common List Builder appends entries to your Common
List. It does not delete any existing entries from your
Common List.

To copy a Common List from another MicroMD EMR user:

Procedure

Details

1. Select Tools > Common List Builder from the
main menu.

The Common List Builder window opens (Figure
7.5 on page 7.6).

2. Verify that you have the Copy tab displayed.
3. Highlight the appropriate Reference List from
the Categories pane on the left side of the
window.

The system displays your current Common List for
the selected category on the right-hand side of the
window.

4. On the Copy tab, click the Lookup icon (

).

The Reference List Viewer window for System
Users opens.

5. From the list of MicroMD EMR users, select the
user whose Common List you want to copy,
and click Insert.

The system displays that user’s Common List
(page 7.4) for the selected category.
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Procedure (continued)

Details (continued)

6. Highlight the entry you want to copy and click
the right arrow icon.

MicroMD EMR adds the selected item to your
Common List, displayed on the right side of the
window.

7. Repeat step 6 for each entry you want to copy
to your Common List.



Click the double arrow icon to copy all
of the entries in the selected user’s
Common List to your list.



To remove an item from your Common
List, simply highlight the entry in the
right side of the window and click the
Delete icon ( ). This does not
remove the item from the database,
only from your Common List.

8. When finished, click Close to exit the Common
List Builder.

Copying ALL Common Lists FROM Another User
The MicroMD EMR Common List Builder allows you to copy all the Common Lists FROM another user to the
user currently logged in. This is particularly useful when someone joins an existing practice and needs to
set up their user profile quickly.

○

When you copy all Common List from another user, the
Common List Builder appends entries to each of the
destination lists. It does not delete any existing entries.

To copy all Common Lists from another MicroMD EMR user:

Procedure

Details

1. Select Tools > Common List Builder from the
main menu.

The Common List Builder window opens (Figure
7.5 on page 7.6).

2. Click the Copy All From button at the bottom
of the window.

The appropriate Copy all Common Lists window
opens.

7.8
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Procedure (continued)
3. Click the Lookup icon (

Details (continued)
).

The Reference List Viewer window for System
Users opens.

4. From the list of MicroMD EMR users, select the
user whose Common Lists you want to copy
and click Insert.
5. If you want the system to clear ALL of your
Common Lists before adding the new lists,
simply place a check mark in the Remove
existing common lists from the target user
checkbox.
6. Click OK to copy all Common Lists from the
selected user.

The system appends the entries to the appropriate
lists (unless you chose to clear the existing
Common Lists first).

7. When finished, click Close to exit the Common
List Builder.

Copying a SINGLE Common List TO Other Users
If there is a single Common List you want to copy OUT to one or more providers, you can use the Common
List Builder to do so. From the main menu select Tools > Common List Builder. When you select the
Common List you want to share (e.g., Habits), you can click the Copy To button (Figure 7.5 on page 7.6).
The Copy To button opens the Copy Common Lists To window that allows you to choose a single user, a
group of users, or a combination of users and groups. To add a user or group, double-click the user or
group on the left side (or click the Add button).

Figure 7.6 Copy a Single Common List to Other Users
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If you want to clear out the selected users’ Common List, place a check mark next to Remove existing
common list from the target user(s).



Use caution when removing another user’s common
list. You could ruin their entire workflow if you do so
without prior warning.

Copying ALL Common Lists TO Other Users
Practices also have the ability to copy all of a single user’s Common Lists OUT to one or more users in the
system. From the main menu, select Tools > Common List Builder. Under the Categories pane, you can
click the Copy All To button (Figure 7.5 on page 7.6).
To enable the Copy All To button, you must have the
Copy All Common Lists To user function assigned to your
user account.

○

The Copy All To button opens the Copy All Common Lists To window that allows you to choose a single
user, a group of users, or a combination of users and groups (Figure 7.6). To add a user or group, doubleclick the user or group on the left side (or click the Add button). If you want to clear out the selected users’
Common List, place a check mark next to Remove existing common lists from the target user(s).

Figure 7.7 Copy All Common Lists to Other Users

Sorting Your Common List
You can alphabetize and/or reorder your Common Lists to better suit your needs. When you set the order
here in the Common List Builder, you set the default for the selected Common List throughout the system.
Use the up and down arrow icons ( and ) to move the entries to a specific order in the list, or click the
a-z icon (
) to alphabetize the list.
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You can also click the Remove all icon (
) to clear out
the entries chosen in the selected Common List.
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When you access your Common Lists in the system, you also have the option to change the way the
Common List displays “on the fly”. When you right-click the Common List, you can choose Alphabetize
Common List from the pop-up menu, which sorts the list to display in A-to-Z order. Once you exit the
window and return, the list displays in your default order specified in your Common List Builder.

Calculating a Common List
If you have been using the EMR for some time, the system can help you determine which items should be
in your Common Lists, based on the frequency with which you have used the items in the selected
category. For example, Dr. Webb wants to enhance her Medications Common List with the medications
she actually prescribed most frequently, rather than what she thinks she prescribes.

○

This ability is only available on certain Reference Lists
and reviews the last 12 months of data.

To calculate a Common List:

Procedure

Details

1. Select Tools > Common List Builder from
the main menu.

The Common List Builder window opens (Figure 7.5
on page 7.6).

2. Highlight the appropriate Reference List
from the Categories pane on the left side of
the window.

The system displays your current Common List for
the selected category on the right-hand side of the
window.

3. Click the Calculate tab.
4. In the Maximum number of items to display
field, enter the maximum number of entries
that you want to appear in the calculated
list.

For example, if you enter 25 then MicroMD EMR will
display the 25 items that appear most commonly in
your previous encounters in descending order of
frequency.

5. Click the Calculate button.

MicroMD EMR displays the most frequently used
items in the left hand panel of the Common List
Builder in descending order of frequency.


6. In the calculated list, highlight the entry that
you want to add to your Common List and
click the right arrow icon ( ).
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Each entry in the calculated list that
is already in your Common List is
highlighted in light blue.

MicroMD EMR adds the selected item to your
Common List, displayed on the right side of the
window.
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Procedure (continued)
7. Repeat step 6 for each entry you want to
copy to your Common List.

Common List Builder

Details (continued)



Click the double arrow icon to copy all
of the entries in the selected user’s
Common List to your list.



To remove an item from your
Common List, simply highlight the
entry in the right side of the window
and click the Delete icon ( ).

8. When finished, click Close to exit the
Common List Builder.

Specialty Common Lists
If your MicroMD EMR team has created a specialty-specific Common List for you, you can access that list
through the Specialty tab of the Common List builder.

Procedure

Details

1. Select Tools > Common List Builder from the
main menu.

The Common List Builder window opens (Figure
7.5 on page 7.6).

2. Click the Specialty tab.
3. Highlight the appropriate Reference List from
the Categories pane on the left side of the
window.

The system displays your current Common List for
the selected category on the right-hand side of the
window.

4. Select the appropriate specialty from the
Specialty drop-down.

The system displays the contents of the Common
List for that specialty in the area below the dropdown.

5. Highlight the item you want to use from this
Common List and click the right arrow icon.

All items copied to your Common List appear with
a light blue background.
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To use all of the items in the
specialty Common List, click the
double arrow icon.
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Exporting/Importing a Common List
There may be times when you need to import the Common List of another MicroMD EMR user who uses
another database on your network. You might also want to share your Common List with someone else.
This could be someone in your practice or someone across the country. Very similar to importing or
exporting templates (page 2.13), you can access your network or the CliniBank site.

Exporting a Common List to a Folder on Your Network
If you want to share your Common List with another MicroMD EMR user with access to your network,
you can export your list. This could be helpful if you share a building with a colleague and that
colleague also has MicroMD EMR but uses their own database.
To export a Common List to a folder on your network:

Procedure

Details

1. Select Tools > Common List Builder from
the main menu.

The Common List Builder window opens (Figure
7.5 on page 7.6).

2. Click the appropriate category in the
Category section.

The system displays your current Common List
in the My Common List section of the window.

3. Click the Export button in the My Common
List section.

The Import/Export Templates Manager dialog
box opens (Figure 2.5 on page 2.13) and displays
all of the XML files in the folder you selected.

4. On the right side of the window, click the
Local/Network tab.
5. Click the Browse icon ( ) at the bottom of
the Import/Export Templates Manager
window.

The Browse for Folder dialog box opens.

6. Locate and select the folder where you want
to save the exported file.
7. Click OK.
8. Click the Export button.

MicroMD EMR converts the selected Common
List to an XML file and saves the XML file to the
folder you selected on your network.

Importing a Common List from Your Network
If you want to share your Common List with another MicroMD EMR user with access to your network,
you can export your list. Once that file is exported, that user can then import your list into MicroMD
EMR. This is also true if they exported their list to the network and you want to import it into your
system. This could be helpful if you share a building with a colleague and you each have your own
MicroMD EMR system.
To import a Common List from your network:

Procedure

Details

1. Select Tools > Common List Builder from
the main menu.

The Common List Builder window opens (Figure
7.5 on page 7.6).
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Procedure (continued)

Common List Builder

Details (continued)

2. Click the appropriate category in the
Category section.
3. Click the Import tab.
4. Click the Import button.

The Import/Export Templates Manager dialog box
opens (Figure 2.5 on page 2.13).

5. Click the Browse icon ( ) at the bottom
of the Import/Export Templates Manager
window.

The Browse for Folder dialog box opens.

6. Locate and select the folder that contains
the Common List you want to import.
7. Click OK.

The system displays the list of all XML template
files that exist in the specified folder.

8. Highlight the Common List XML file that
you want to import.
9. Click the Import button.

MicroMD EMR converts the selected XML file into a
usable Common List and copies the items into the
Available Items section.

10. Highlight the item you want to use from
this imported Common List and click the
right arrow icon ( ).

All items copied to your Common List appear with
a light blue background.



To use all of the items you imported,
click the double arrow icon.

Exporting Common Lists to CliniBank
MicroMD EMR allows you to export any of your Common Lists to share with other users. When you
export a list, the system converts the list into an XML file. When a MicroMD EMR user imports the XML
file (page 7.15), the system re-converts the XML file into a usable Common List.
When you export to the CliniBank site, you can export only to the Temp folder on the FTP site. Once
accepted, the list moves to the appropriate folder in CliniBank—where all MicroMD EMR users can
access and import the item.
To export a Common List to CliniBank:

7.14

Procedure

Details

1. Select Tools > Common List Builder from
the main menu.

The Common List Builder window opens (Figure
7.5 on page 7.6).

2. Click the appropriate category in the
Category section.

The system displays your current Common List in
the My Common List section of the window.
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Procedure (continued)

Details (continued)

3. Click the Export button in the My Common
List section.

The Import/Export Templates Manager dialog
box opens (Figure 2.5 on page 2.13) and displays
all of the templates in the folder you selected.

4. On the right side of the window, click the
CliniBank tab.

The system connects via your Internet connection
to display the available folders on the CliniBank
site.

5. On the CliniBank tab, highlight the Temp
folder.

6. Click the Export button.



You can export only to the Temp
folder of the CliniBank site. HSMS
personnel review the items in this
folder before making them available
to other.

MicroMD EMR converts the selected list to an XML
file and copies the new XML file to the CliniBank
site. The new file appears in the list of files in the
Temp folder.

Importing Common Lists from CliniBank
MicroMD EMR allows you to export any of your MicroMD EMR Common Lists to share with other users.
When you export a list, MicroMD EMR converts the list into an XML file. Once the file is exported to the
CliniBank site, you can then import that file into your system. When you import the XML file, the system
re-converts the file into a usable Common List.
To import a Common List from CliniBank:

Procedure

Details

1. Select Tools > Common List Builder from
the main menu.

The Common List Builder window opens (Figure
7.5 on page 7.6).

2. Click the appropriate category in the
Category section.

The system displays your current Common List
in the My Common List section of the window.

3. Click the Import tab.
4. Click the Import button.

The Import/Export Templates Manager dialog
box opens (Figure 2.5 on page 2.13).

5. On the right side of the window, click the
CliniBank tab.

The system connects via your Internet
connection to display the available folders on
the CliniBank site.

6. Locate and select the Common List you
want to import.

All lists that you can import are in XML format.

7. Click the Import button.

MicroMD EMR converts the selected XML file into
a usable MicroMD EMR Common List.
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Procedure (continued)

Details (continued)

8. Highlight the item you want to use from this
imported Common List and click the right
arrow icon ( ).

All items copied to your Common List appear
with a light blue background.



To use all of the items you imported,
click the double arrow icon.

Manually Building a Common List
If you want to pick and choose entries to build Common Lists manually, the Common List Builder provides
a central location that allows you choose the category, build the list and move to the next category. You
can also build your Common Lists during your day-to-day use of the system.
To manually build a Common List with the Common List Builder:

Procedure

Details

1. Select Tools > Common List Builder from the
main menu.

The Common List Builder window opens (Figure
7.5 on page 7.6).

2. Click the Lookup tab.
3. Highlight the appropriate Reference List from
the Categories pane on the left side of the
window.

The system displays your current Common List for
the selected category on the right-hand side of the
window.

4. From the list of available items, highlight the
entry that you want to add to your Common
List and click the right arrow icon ( ).

The system copies the item to your Common List.

5. Repeat step 3 and step 4 for any other entries
that you want to add to your Common List.



To remove an item from your Common
List, simply highlight the entry in the
right side of the window and click the
Delete icon ( ). This does not
remove the item from the database,
only from your Common List.

6. Click Close to save the changes to your
Common List and close the Common List
Builder.
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Index Lists
Index lists in the system provide categories, based on the type of data you are currently searching. For
example, if you have the Reference List Viewer window open for procedures (Figure 7.8), the Index button
contains categories of procedures to help you find precisely the procedure you want to use. If you have the
Reference List Viewer window open for medications, the Index button displays categories of medications
instead. This is true when you access a reference list within an encounter or outside of an encounter.

Figure 7.8 Index List
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Smart Lists

Smart Lists
A Smart List is a subset of a Reference List, and you access them through the Smart button on any
Reference List, if this option is available (Figure 7.9). The available Smart Lists vary depending on the type
of Reference List you have open. A Smart List typically provides a specialized set of entries, based on the
type of list you have open or on the task you are performing. Smart Lists help simplify the data-selection
process.

Figure 7.9 Smart List
For example, assume that a provider wants to prescribe a long-term medication for a patient who has
been taking the medication for the past few years. Instead of locating the medication in the extensive
medications Reference List, the provider can display the patient’s list of medications through the Smart
List and select the required medication from a much shorter list.

○

Not all Reference Lists have a Smart List associated with
them. If the Smart button is disabled, there is none for the
selected Reference List.

The system populates Smart Lists in a variety of ways. Smart Lists include the following types of lists:

 Lists that vary from patient to patient and are dependent on the medical details of the patient
whose chart is currently open. These lists change as the patient’s medical information changes
(e.g., lists of the patient’s past diagnoses and medications).

 Lists that are the same for all users in a particular practice (e.g., practice-preferred medications
and in-house procedures). You use the MicroMD EMR Manager to modify these Smart Lists.

 Lists that are built into the system. These lists are the same for all MicroMD EMR users (e.g.,
medications that contain specified ingredients, lists of assessments that relate to specific parts
of the human body). These lists cannot be modified.
7.18
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There are several Smart Lists available in the system within certain Reference Lists. Table 7.1 explains these
lists in more detail.
Table 7.1

Smart Lists Available in MicroMD EMR

Field

Description

Assessments
Anatomic

When you select Anatomic from the available Smart lists menu, the system
displays a diagram of the human body. This allows you to click the area of
the patient’s anatomy for related assessments, making it easier and more
efficient to find the correct entry. You cannot add an assessment to or
delete an assessment from any of the anatomic Smart Lists.

Patient’s Past
Diagnoses

When you select Patient’s Past Diagnoses from the available Smart list
menu, the system displays a list of all diagnoses entered during past
encounters.

Patient’s Problem List

When you select Patient’s Problem List from the available Smart list
menu, the system displays a list of all the medical issues previously entered
in the patient’s problem list, including the terminated problems.

Medications
Patient - Current
Medications

When you select the Patient – Current Medications option from the Smart
button, the system displays all of the medications in the patient’s chart
where the end date has not passed today’s date. This is the default view for
the Prescription Pad and is the view with which you are most familiar. The
system also includes those medications that do not have a date in the End
date field.

Patient - Upcoming
Refills

You can view a list of those medications for which the patient is due for a
renewed prescription. Select Patient – Upcoming Refills from the Smart
button. If the patient has not requested a renewal within a certain amount
of time from the end date on the prescription, the system includes it in this
list.
Each user can set the number of days prior to the end date of a prescription
that the medication appears in the Upcoming Refills list. Enter that number
of days in the Refill Days Prior field under Tools > User Preferences >
Prescriptions.
For example, a nurse has her User Preference set to seven days. A patient’s
prescription for Lipitor expires in five days. The nurse happens to have the
patient on the phone requesting a refill for one of his other prescriptions.
While on the Prescription Pad, she clicks the Smart button and selects
Patient – Upcoming Refills to see if there are any other medications she
can request for the patient at the same time.
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Table 7.1

Smart Lists

Smart Lists Available in MicroMD EMR (continued)

Field

Description

Patient - Past
Medications

To display the patient’s prescription history, not including their current
prescriptions, select Patient’s Past Prescriptions from the available Smart
list menu in the Medications Reference List.

Practice-Preferred
Medications

MicroMD EMR allows your practice to maintain a list of medications that
providers should prescribe when possible. When you select PracticePreferred Medications from the Smart list menu in the Medications
Reference List, the system displays the list of those medications for your
practice. To add or remove from this list, use the MicroMD EMR Manager
(page 1.63).

Stock Medications

The Stock Medications option under the Smart button displays an entry
for each item you have listed in the Stock Management module. Each item
in Stock Management can have inventory in multiple locations in your
practice. The Stock Medications list reflects this by showing an entry for
each location.
The Stock Medications list also displays the location of the medication and
how many are left at that location. Once you create the prescription and
authorize a medication from the list you have in stock, click the Stock
button on the Prescription Processor window to deduct the appropriate
units from inventory.

Potentially Suitable
Medications Based On
Assessments

MicroMD EMR determines the suitable medications for the patient based on
the assessments you enter in the patient’s encounter. When you select this
menu item from the available Smart list menu in the Medications Reference
List, the system displays the list of those suitable medications. MicroMD
EMR derives the list of potentially suitable medications using information
from a national drug database.

Generic/Ingredient Set

This option allows you to change the way the Reference List Viewer window
searches for a medication. Once you choose this option, the window
changes so you can search based on the ingredient you enter in the search
field.
For example, you can choose this option and then type the ingredient
acetylcysteine in the search field. The system will then display all
medications containing this ingredient.



7.20

In the above example, MicroMD EMR displays only
those medications where Acetylcysteine is the only
active ingredient. Medications that have
Acetylcysteine as one of multiple active ingredients
are not displayed.
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Smart Lists Available in MicroMD EMR (continued)

Field

Description

Contains ingredient

When you select Contains ingredient from the available Smart Lists for the
Medications Reference List, the system displays the Reference List Viewer
window for the medication ingredients. Search for and double-click the
ingredient you want. The system filters the list of medications to only those
drugs that contain your ingredient as one of the active ingredients.

Equivalent Medications
(for selected drug)

When you select a medication, you can have the system find equivalent
medications for you in the database. Once you have found your medication
and highlighted it in the Reference List Viewer, select Equivalent
medications from the Smart list menu and then choose the type of
equivalence you want. The system filters the list accordingly.

Plan: Procedures
Practice-Preferred
Procedures

MicroMD EMR allows your practice to maintain a list of specific procedure
codes that providers should use when prescribing a plan to a patient. When
you select Practice-Preferred Procedures from the Smart list menu in the
Procedures Reference List, the system displays the list specified for your
practice. To add or remove from this list, use the MicroMD EMR Manager
(page 1.61).

In-House Procedures

MicroMD EMR allows your practice to specify which procedures are
performed within the practice. When you select In-House Procedures from
the Smart list menu in the Procedures Reference List, the system displays
the list specified for your practice. To add or remove from this list, use the
MicroMD EMR Manager (page 1.70).

Based on Diagnosis

This option displays the list of procedures that meet the CMS medical
necessity guidelines for the patient’s diagnoses in the current encounter.

Plan: Labs
Based on Diagnosis

This option displays the list of panels and tests that meet the CMS medical
necessity guidelines for the patient’s diagnoses in the current encounter.

Practice-Preferred
Panels and Tests

MicroMD EMR allows your practice to maintain a list of specific labs that
providers should use when ordering tests for patients. When you select
Practice-Preferred Panels and Tests from the Smart list menu in the Labs
Reference List, the system displays the list specified for your practice. To
add or remove from this list, use the Practice-Preferred List tab in the
MicroMD EMR Manager (page 1.63).

In-house Laboratories

MicroMD EMR allows your practice to specify which labs are performed
within the practice. When you select In-House Laboratories from the
Smart list menu in the Labs Reference List, the system displays the list
specified for your practice. To add or remove from this list, use the MicroMD
EMR Manager (page 1.70).
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Table 7.1

Smart Lists

Smart Lists Available in MicroMD EMR (continued)

Field

Description

Signs (in an encounter)
Anatomic

When you select Anatomic from the available Smart list menu, the system
displays a diagram of the human body. This allows you to click the area of
the patient’s anatomy for related physical signs, making it easier and more
efficient to find the correct entry. You cannot add a sign to or delete a sign
from any of the anatomic Smart Lists.

Symptoms (in an encounter)
Anatomic

When you select Anatomic from the available Smart list menu, the system
displays a diagram of the human body. This allows you to click the area of
the patient’s anatomy for related symptoms, making it easier and more
efficient to find the correct entry. You cannot add a symptom to or delete a
symptom from any of the anatomic Smart Lists.

Immunizations
Immunizations Due

To see a list of vaccines scheduled for the patient, select Immunizations
due from the available Smart list menu for the Immunizations Reference
List.

Past Immunizations

To see the patient’s immunization history with your practice, select Past
immunizations from the available Smart list menu for the Immunizations
Reference List.
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Maintenance
If you have a stand-alone MicroMD EMR system, you can manage some of the data in your database
through the EMR. MicroMD EMR provides distinct Contact Managers that allow you to maintain the list of
general contacts, specialists, pharmacies and insurance plans in your system. Patients within your system
then link to some of this data.



If you have an interface with a practice management
system, data only travels from the PM to the EMR in the
interface. As such, the interface does not recognize
when you make a change in the EMR. You should only
make data changes in your PM system.

In This Chapter
In this chapter, we cover how to:

 Add general contacts to you EMR database (page 8.1)
 Add specialists to your EMR database (page 8.3)
 Add pharmacies to your EMR database (page 8.5)
 Add insurance plans to your EMR database (page 8.7)
 Add service facilities to your EMR database (page 8.10)

Adding General Contacts to Your Database
In addition to the Specialist Manager, Pharmacy Manager, Insurance Manager, and Service Facility
Manager, MicroMD EMR also provides practices with a central phone book to house their business contacts
(Figure 8.1).

Figure 8.1 Contact Manager
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Adding General Contacts to Your Database

Managing Contacts
You can search for any contact using the Find field at the top of the window. You base that search on a
variety of fields. Select the basis of your search from the Using field. This includes name, address, phone
and fax.

 To edit or delete a contact from the system, simply highlight the entry and click Edit or Delete
as appropriate.

 To add a contact to your general contacts, click the Add button, complete the necessary fields
and click OK.

○

The Contacts tab allows you to create a list of individuals
at the place of business with whom you work most often.

Phone Number Fields for General Contacts
The phone number fields on the Contacts tab provide staff members with the ability to indicate the type of
phone number they want to enter for this individual. The labels for the Business, Cell, Home and Fax are
drop-down lists with additional labels you can choose to identify the phone number more precisely.
This feature also stores the numbers you enter under each label. Even if you do not have them displayed,
the system has saved the number you entered under the selected label. For example, you can save the
contact’s home phone number under the Home label but choose not to display it.

Figure 8.2 Phone Field Drop-down
Simply click the label to access the drop-down list (e.g., click the word “Business”). MicroMD EMR displays a
check mark next to the phone number field labels that you have already used to store a number for this

8.2
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contact. Any label without a check mark is an empty slot. Select the label you want to use and enter the
number.

○

Changing a label only changes the label for that contact.

Adding Specialists to Your Database
MicroMD EMR allows you to manage the list of specialists to which providers in your practice refer patients
out and the specialists that refer patients to your practice. By maintaining this list, you can easily associate
any patient in the system with a specialist in the list. If the details of the specialist change, use the
Specialist Manager to make the required changes—in one place. Once you change the details in the
Specialist Manager, the system propagates those changes to all associated patient charts.

Figure 8.3 Specialist/Provider Manager
You can access the Provider/Specialist Manager under Tools > Contact Managers > Provider/Specialist
Manager. Table 8.1 explains the fields in more detail.

 To edit or delete a specialist from the system, simply highlight the physician’s entry and click
Edit or Delete as appropriate.

 To add a specialist to the database, click the Add button, complete the necessary fields and
click OK.
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Table 8.1

Adding Specialists to Your Database

Fields on the Specialist/Provider Edit Window

Field

Description

Surescripts Provider

If the provider you want to add is registered with Surescripts, you can
automatically populate their data. Click the Lookup icon (
insert the appropriate provider.

), find, and

Title

From the drop-down, choose the physician’s title. The choice made here
appears in various places with the physician’s name (e.g., in the patient’s
contact list).

First Name, Last Name
and Suffix

Enter the physician’s name and an appropriate generation indicator if
necessary (e.g., Sr., Jr., I, II).

Prof Suffix

Enter the physician’s professional suffix (e.g., for a medical doctor, type MD).
MicroMD EMR frequently includes this suffix whenever it displays or prints
the physician’s name.

UPIN

For billing purposes, enter the physician’s UPIN number in this field.

NPI

As required for submitting claims to most carriers, enter the referring
physician’s National Provider Identifier (NPI).

Specialty

Select the physician’s specialty from this drop-down. You can search for
physician’s based on this data so be sure to include it.

Service Location

From the drop-down, select the type of location at which the specialist or
provider works.

Additional info

Enter any comments or remarks about the specialist or the institution
(relative to the physician) that may be useful to other MicroMD EMR users.

Clinic

If the specialist works for a hospital or other body, enter the institution’s
name in this field.

Address 1, Address 2,
City, State, and Zip

Enter the address and contact details of the specialist.

Communication
Preference

From this drop-down, select the method your practice should use to contact
this specialist. This is for informational purposes only.

Phone, Phone 2, Fax,
Mobile, Beeper and Email

Enter the contact details of the specialist.

Direct Address

The Direct Address field is this specialist’s Surescripts address for secure
messaging through the Surescripts Clinical Interoperability Network (CIN).

Automatically Send CDA
with referral

If the specialist has the ability to receive secure messages through the
Surescripts CIN, you can choose to send the patient’s electronic chart
automatically to the address entered in the Direct Address field when you
create a referral order.

8.4

○

The E-mail field is a different address from the Direct
Address field.
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Adding Pharmacies to Your Database
MicroMD EMR allows you to manage the list of the pharmacies used by the patients in your practice. By
maintaining this list, you can easily associate any patient in the system with a pharmacy in the list. If the
details of the pharmacy change, use the Pharmacy Manager to make the required changes—in one place.
Once you change the details in the Pharmacy Manager, the system propagates those changes to all
associated patient charts.

 To edit or delete a pharmacy from the system, simply highlight the pharmacy and click Edit or
Delete as appropriate.

 To add a pharmacy to the database, click the Add button, complete the necessary fields and
click OK. Table 8.2 explains the fields on the Add Pharmacy window in detail.

Figure 8.4 Pharmacy Manager
The Pharmacy Manager is divided into two sections. The upper section lists all the pharmacies in the
practice-wide list of pharmacies. The lower section displays the details of the selected pharmacy,
providing you with quick access to the information you want.

○

MicroMD checks the NCPDP of each pharmacy in your
Pharmacy Manager. If the system finds any of the mailorder pharmacies, the system automatically sets the new
Pharmacy Type flag to Mail Order. All others will be set to
Retail until Surescripts provides that information in the
data they send to MicroMD EMR.
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Fields on the Add Pharmacy Window

Field

Description

Pharmacy Name

Click the Lookup icon (
) to search for the pharmacy. Once you find the
correct pharmacy, click the Insert button.

Address, City, State,
and Zip

Specify the address of the pharmacy.

Contact person

Specify the details of the main contact person at the pharmacy.

Is 24 hour

From this drop-down, choose whether the pharmacy has 24-hour pick-up or if
this is not applicable for this pharmacy.

E-mail

If the pharmacy has an e-mail address you can use to communicate with the
pharmacy, enter that address here.

Additional info

Enter any additional information about the pharmacy that may be relevant.

Pharmacy Type

Select the type that best describes this pharmacy. MicroMD automatically sets
this drop-down from the Surescripts data sent to the EMR.

Store Number

If the pharmacy’s store number is available and relevant to submitting
prescriptions, enter that number here.

Cross Street

Enter any directional information that may be useful when sending a patient
to this pharmacy. This could be beneficial if the store’s address is on one
street, but the store front faces another street.

NCPDP ID

If this is a Surescripts-registered pharmacy and you want to send prescriptions
electronically with this pharmacy, enter the unique NCPDP identification
number provided by Surescripts for this pharmacy. This number allows the
Surescripts interface to send prescriptions to this pharmacy correctly.

Phone #

Enter the main phone number for the pharmacy. This is primarily for your
records should you need to contact the pharmacy.

Add. phone #

If the pharmacy has an alternate phone number for you, enter that number in
this field. For example, if the pharmacy has two lines you can call, enter the
second phone number here.

Fax #

For those pharmacies that do not accept electronic prescriptions, the system
can fax the prescription using the number you enter here.

Rx Transmission

This drop-down indicates the method by which the pharmacy sends
prescription requests and receives prescriptions from physicians.
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Adding Insurance Plans to Your Database
Before you can add an insurance plan to a patient’s chart, you must have the data in your database.
MicroMD EMR allows you to manage the list of insurance companies and insurance plans used by your
patients. By maintaining the list globally, you can easily associate an existing insurance company and plan
with any patient in the system.
If the details of any insurance company or plan change, you can use the Insurance Manager to make the
required changes in one place only. The system automatically reflects these changes in all the associated
charts.

Figure 8.5 Insurance Manager Window



If you have a practice management interface, we
strongly recommend that you DO NOT ADD, EDIT OR
DELETE INSURANCE CARRIERS FROM WITHIN MICROMD
EMR. You should maintain this information using the
practice management software.

Adding Insurance Carriers
Each insurance company is an insurance carrier that offers different plans. Generally, the practice
management system populates this information for you. If you should need to add carriers to your standalone system, you can do so.

 To edit or delete insurance companies from the database, simply highlight the entry and click
Edit or Delete as appropriate.

 To add insurance companies to the database, click the Add button under the Insurance
Companies pane, complete the necessary fields and click OK. Table 8.3 explains the fields in
detail.
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Table 8.3

Adding Insurance Plans to Your Database

Available Fields on the Add New Insurance Company Window

Field

Description

Carrier Code

Enter the appropriate identification number for this carrier. This field is typically
the unique system ID for the carrier in your practice management system.


Carrier Name

This code cannot be changed once saved.

Enter the name of the insurance carrier. For example, Anthem BC BS.

Adding Insurance Plans to Insurance Carriers
Each insurance company is an insurance carrier that offers different plans. These plans could have
different deductibles, co-pays, etc. Generally, the practice management system populates this information
for you. If you should need to add plans to the carriers in your stand-alone system, you can do so.
To edit or delete a plan from an insurance carrier, simply highlight the plan and click Edit or Delete as
appropriate.
To add an insurance plan to an insurance carrier:

Procedure

Details

1. Select Tools > Contact Managers >
Insurance Manager from the main menu.

The Insurance Manager window opens (Figure 8.5
on page 8.7) and displays a list of all the insurance
companies currently listed in the database.

2. In the Insurance Companies pane, highlight
the insurance company to which you want to
add a plan.
3. Under the Insurance Plans for section on the
right, click the Add button.

The Add New Insurance Plan window opens.

4. Enter the required information and click OK.

Table 8.4 explains the fields on this window in
detail.

Table 8.4

Fields on the Add Insurance Plan Window

Field

Description

Plan name

Enter the name of the insurance plan.

Carrier

This is the carrier to which you want to add this plan.

Plan code

Enter the code of the plan. This typically comes from the carrier of the plan (in
the Insurance Companies pane).

Plan type

Select the type of the plan (e.g., Blue Cross, CHIP, Medicare, Medicaid).

Source of Payment

Select the appropriate source of payment for this plan. This indicates from
where this plan sends payment to the practice.

Contact Details

Enter the contact details of the person responsible for the plan.
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Fields on the Add Insurance Plan Window (continued)

Field

Description

Comment

Enter any additional information that would be useful to those viewing this
insurance plan.

Mapping Insurance Plans for Lab Systems
The Mapper button on this window allows you to map the insurance companies listed in your practice
management system with the insurance companies recognized by the lab company with which you
interface. Often the insurance company listed in the practice management system has a slightly or very
different name than the name known by the lab company and stored in the EMR reference database.

Figure 8.6 Insurance Mapper
Select the appropriate lab from the System to map drop-down. MicroMD EMR lists the insurance plans
recognized by the lab company on the left side of the window and those recognized by the practice
management system on the right. Simply highlight the insurance plans you want to map and click the Add
button. To remove a mapping, highlight the plan on the right side and click the Delete icon.

Exporting a Mapping Template for the Lab Company
Instead of mapping each insurance manually, you can provide most laboratory companies with an
electronic file, and they will map the insurances for you.
To generate the file to give to the lab company:

Procedure

Details

1. Select Tools > Contact Managers >
Insurance Manager from the main menu.
2. Click the Mapper button.
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Procedure (continued)

Details (continued)

3. Right-click the white area in the Insurance
Plan Map side of the window and select
Export.
4. Name the file and click Save.

Importing the Mapping File
Once the lab company has mapped the insurances, you can easily import the file they provide.
To import the mapped file provided by the lab company:

Procedure

Details

1. Select Tools > Contact Managers >
Insurance Manager from the main menu.
2. Click the Mapper button.
3. Select the appropriate lab company from
the System to map drop-down.
4. Right-click the white area in the Insurance
Plan Map side of the window and select
Import from the pop-up menu.
5. Navigate to the file and click Open.

Add Service Facilities to Your Database
When you add hospitalization history to a patient’s chart (page 14.14), you have the ability to specify the
facility (e.g., hospital or nursing home) where the patient stayed for this record. You can manage that list
from the Service Facility Manager.

 To edit or delete service facilities from the database, simply highlight the entry and click Edit or
Delete as appropriate.

 To add a service facility, click the Add button, complete the necessary fields and click OK. Table
8.5 explains the fields on this window in detail.


Table 8.5

Remember: If you have an interface with a practice
management system (MicroMD PM included), do not
edit service facilities from the EMR. You must make any
changes in the practice management system.

Fields on the Add Service Facility Window

Field

Description

ID

This is a unique internal database number assigned by the system when you save
a new entry.

Modified and
Created

These are the dates when someone changed this record (Modified) and when the
record was first added to the system (Created).
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Fields on the Add Service Facility Window (continued)

Field

Description

Facility Type

Select the kind of facility represented by this entry. The following options are
available:

 IP – Hosp: Choose this option for those facilities that are primarily in-patient
hospitals.

 IP/OP – Hosp: Choose this option for those hospital facilities that perform
both in-patient and outpatient services.

 NH: Choose this option for a nursing home facility.
 OP – Hosp: Choose this option for those hospital facilities that only perform
outpatient hospital services.

 Other: Choose this option for all other facilities you create in the system (e.g.,
house calls, treatment centers)
Name

Enter a useful name or description for the facility this entry represents.

Address

Enter up to two lines for the facility’s address and enter the ZIP code. The city and
state display automatically when the user enters a unique ZIP code.

Phone, Alternate
Phone, and Other
Phone

Users may enter a seven-digit phone. Type an X followed by up to a four-digit
extension. Do not use parentheses, spaces, or hyphens. Enter an area code, if
applicable.

Fax

Users may enter a seven-digit facsimile number. Enter an area code, if applicable.

Web Site

Enter the facility’s web site address, if applicable.

Web Site Sched.

Enter the facility’s scheduling web site, if applicable. The scheduling web site
typically is a secure site.

E-Mail

Enter the facility’s e-mail address, if applicable, or a contact person’s e-mail
address.

Mammo. Cert

Enter the facility’s Mammography Certification number assigned to their
mammography machine, if applicable, for submitting claims to insurance
companies.

NPI

Enter this service facility’s NPI number provided by the insurance carrier.

CMS Location

Select the appropriate CMS location. The system pulls the list of these locations
from the data files downloaded from Medicare and included in the system’s
database. This information is used in RBRVS reporting.

Default POS

To set the default place of service code for all charges posted for a certain facility,
select that code from this drop-down. When this facility appears in the Bill
Builder (page 24.2), the system automatically changes the choice in the POS
column for all procedures to the facility’s default POS code.
For example, anyone that lives at the South Avenue Skilled Nursing facility would
have the majority of their charges posted with a POS of 31 – SKILLED NURSING
FAC. Specifying the default place of service for the South Avenue facility as 31
allows Summervale Medical Center to take some of the human error out of the
billing equation.
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Patient Information
MicroMD EMR allows you to maintain comprehensive personal information for each of your patients, aside
from their medical information. This includes the patient’s address, cell phone numbers, members of their
family that also visit your practice and more.

In This Chapter
In this chapter, we cover how to:

 View a patient's demographics (page 9.2)
 View the summary of a patient's chart (page 9.4)
 View a patient’s personal details (page 9.5)
 Establish family links (page 9.6)
 Insert a patient's photograph (page 9.9)
 View patient contact information (page 9.11)
 Associate providers with a patient (page 9.15)
 View the patient’s insurance details (page 9.17)
 Implement health information access and consent forms (page 9.19)
 Print a patient demographics report (page 9.23)
 Provide a user with emergency access to patient charts (page 9.24)
 Manage patient groups (page 9.24)

Overview
MicroMD EMR allows you to maintain comprehensive demographic information for each patient. You can
view the patient’s personal contact information, their social security number, date of birth, occupation,
nationality, and more. MicroMD EMR divides the patient’s demographic information into three sections:
Personal, Contacts and Insurance.
Two of the three primary modules in MicroMD EMR, the Desktop and the Chart Manager, allow you to
manage the patient’s demographic details.

 Desktop: The Desktop provides receptionists quick access to patients’ demographic
information for tasks they need to perform (Figure 9.1).

 Chart Manager: The Chart Manager is primarily used by providers. Once a provider has a
patient’s chart open, he or she can use the Chart Navigator section to access the patient’s
personal demographic details quickly. See Chapter 10 for more details on working with patient
charts.



MicroMD EMR receives basic demographic, contact and
insurance information from the practice management
system.
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Viewing a Patient’s Demographics
Depending on your user roles and functions, you can view the patient’s personal details through their chart
or through your Desktop. For the most part, if you have MicroMD EMR, you probably have a practice
management system to add or edit your patient demographics, contacts and insurance information. If you
want to view the patient’s information, you can do so easily in the EMR.

Figure 9.1 Patient Demographics from the Desktop



If you have a practice management interface, we
strongly recommend that you do not edit patient
details from within MicroMD EMR. You should maintain
the patient’s personal information using the practice
management software.

Accessing the Patient’s Details from Your Desktop
If you do not have access to patient charts but need to edit patient demographics, you can do so through
your desktop. Typically, this is a user with the Receptionist role.

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the My
Workflow button.
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Procedure (continued)

Details (continued)

3. Choose the Demographics option.

The system displays the demographics search
functions on the right.
If you have the appropriate roles and functions,
you can edit the patient’s demographics if needed.
Simply click the Edit button to access the Edit
Patient Information window. Click OK when
finished.

4. Choose the Search for option and locate your
patient.
5. Highlight the appropriate patient in the right
pane to display the demographics at the
bottom of the window.

Accessing the Patient’s Details from Their Chart
If you have one of the following roles assigned to your user account, you can access the patient’s
demographics and other details from within their chart: Physician, Nurse, Physician Assistant, Nurse
Practitioner or Non-Physician Care Giver. The patient’s details appear on the Patient Demographics tab
of the chart (Figure 9.2).

Figure 9.2 Patient Demographics Tab
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Viewing the Summary of a Patient’s Chart

To view the patient’s demographics from their chart:

Procedure

Details

1. Open the patient’s chart and click the
Demographics tab.
2. In the Chart Navigator section, click the
Personal button.
3. Choose the Personal Details option.

The system displays the patient’s demographics
on the right. (Table 10.1 on page 10.8 explains the
fields in detail.)
If you have the appropriate roles and functions,
you can edit the patient’s demographics if needed.
Simply click the Edit button to access the Edit
Patient Information window. Click OK when
finished.

Viewing the Summary of a Patient’s Chart
When you first open the patient’s chart, the system displays the Chart Summary section of the Patient
Demographics tab (Figure 9.3). This part of the chart gives you a brief overview of the patient’s
demographics, including a picture of the patient for your reference. The bottom of the window displays an
area called the “Chart Board”. You can customize this area to suit your personal needs when you review
charts (page 1.92).

Figure 9.3 Chart Summary of Patient Demographics Tab
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If the patient’s family members also visit your practice and have charts created in the system, you can link
the charts together in a “chain” of sorts. At the bottom right of the tab is a section for family members
(page 9.6).

Viewing Patient Personal Details
You can view the patient’s demographics from within the patient’s chart or from your Desktop. When you
view the patient’s personal details from your Desktop, you can also view the insurance, contact, and
consent details using the same window. If you view the patient’s personal details from within their chart,
you access the insurance, contact, and consent information separately from the demographics
information. Table 10.1 on page 10.8 explains the fields in detail.

Figure 9.4 View Patient Information Window from Desktop



If you have a practice management interface, we
strongly recommend that you DO NOT EDIT patient
details from within MicroMD EMR. You should maintain
the patient’s personal information using the practice
management software.
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Establishing Family Links
When you attend to a patient, it is often useful to have quick access to the medical and demographic
information of the patient’s family members listed in the EMR. With MicroMD EMR, you can group patients
into families. When you open the chart of any patient, MicroMD EMR allows you to quickly page through
the charts of all the family members of that patient, provided they are a patient within your practice. At a
glance, you can review the medical status of all members of the family.

○

To record the patient’s family medical history, you do so
on the Medical Information tab (page 14.9).

Figure 9.5 Family Manager
To remove a family member from the patient’s list, highlight the entry on the right and click the Delete
icon ( ). To modify the family member’s relationship, highlight the entry on the right and click the Modify
icon ( ).
To add a family member to the patient’s chart:

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the My
Workflow button.
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Procedure (continued)

Details (continued)

3. Choose the Demographics option.

The system displays the demographics search
functions on the right.
If you have the appropriate roles and functions,
you can edit the patient’s demographics if needed.
Simply click the Edit button to access the Edit
Patient Information window. Click OK when
finished.

4. Choose the Search for option and locate your
patient.
5. Highlight the appropriate patient.

The patient’s demographic details display at the
bottom of the window.

6. Click the Edit button.

The Edit Patient Information window opens
(Figure 10.5 on page 10.8).

7. Click the Family/Photo tab.
8. In the Family members section, click the
Set button.

The Family Manager window opens (Figure 9.5).

9. Search for the family member or display the
patient’s extended family network.

A patient’s extended family consists of the family
members for those people listed in the patient’s
own family list.

10. Highlight the family member in the left side of
the window and click the Add button.

The system displays the Family Relationship
window.

11. Select the appropriate relationships between
the patient and the family member and
click OK.
12. Repeat step 9 through step 11 for each family
member you want to add.
13. Click Close.
14. In the Edit Personal Information window,
click OK to close the window and save
your changes.
MicroMD EMR User’s Reference Manual Version 16.0

9.7

Chapter 9. Patient Information

Establishing Family Links

Change History
The Change History lists all changes made to a patient’s demographics (e.g., address, name, phone
number, etc.)
Access the patient’s Change History from the Desktop (under My Workflow > Demographics > Change
History button) or in the patient’s chart (under Demographics > Change History).

Figure 9.6 Demographics Change History
The system displays a list of all changes to the patient’s information, with the most recent change at the
top of the list. The following columns make up the change history:

 The Action By column includes which user modified the information or completed an action.
 The Date column includes a date and time stamp for when the change or action was made.
 The Action Details (or Item) column includes a brief description of the change or action. The text
in blue is the resulting change made by the user.
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Inserting the Patient’s Photograph
Every chart in the system can include a picture of the patient. The picture helps you and other users
identify the patient and avoid treating the wrong patient. When you open the patient’s chart, the system
displays the patient’s picture on their Demographics tab. You can also view the patient’s picture through
your Desktop when viewing the patient’s demographics.

Figure 9.7 Patient Picture
You can insert a patient photo into the chart in a variety of ways. Typically, staff members manage the
patient’s photo through the practice management system.

Adding an Image
The system provides the ability to scan and store patient pictures. You can scan a picture provided by the
patient (e.g., scan their driver’s license). You can also use a digital camera and retrieve the picture from the
camera.

Figure 9.8 Scan Patient Picture Window
To scan a patient’s picture into their account:

Procedure

Details

1. From the Demographics tab of a patient’s
chart, click Personal Details in the Chart
Navigator.
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Procedure (continued)

Details (continued)

2. Click the Edit button.

The Edit Patient Information window opens
(Figure 10.5 on page 10.8).

3. Click the Set Photo button.

The Scan Patient Picture window opens (Figure
9.8).

4. Click the Acquire Image icon ( ) at the top
of the window and follow the instructions
from your scanner or camera.

For instructions on using your scanner or camera,
please refer to the reference materials provided by
the manufacturer.

OR
Click the Select Image icon (
existing saved image.

) to insert an

5. Once you have successfully added the photo,
click the Close icon ( ).

OCR Scanning
With the proper hardware and software specifications, MicroMD EMR can populate some demographics
into a chart when you scan a patient’s driver’s license. Scanning with an optical character recognition
(OCR) scanner saves time and reduces potential errors when entering information. The system can also
capture the photo on the license and save it as the patient picture.

○

Contact Henry Schein Medical Systems or your local
authorized reseller for more information on OCRcompliant scanners.

If you click the Acquire/OCR Image icon ( ) on the Scan Patient Picture window (Figure 9.8 on page 9.9)
to scan a patients’ driver’s license, the system populates select demographic data into the Demographics
tab of the chart when you click the Update Patient Information icon. The following fields may be
populated if they are identified with OCR scanning:

 First Name

 Address2

 Date of Birth

 Last Name

 City

 Gender

 Middle Name

 State

 SSN

 Address1

 Zip

○

9.10

If you use the OCR option to scan the driver’s license of a
patient with demographic information already saved, the
system replaces some fields with information from the
card. The system will not delete other demographic
information not identified from the scan.
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Patient Contact Information
MicroMD EMR allows you to maintain information on multiple emergency contacts, next-of-kin,
miscellaneous contacts, pharmacies, a primary care provider and specialists for each patient. MicroMD
EMR provides two tools that let you manage contact information: the Chart and the Desktop.

Managing Contact Details
MicroMD EMR allows you to maintain details of several types of contacts for every patient. There is no limit
to the number of each type that you can specify for each patient. You just simply mark which one is the
primary contact of that type. You can classify a contact as a guarantor, next of kin, employer, emergency
contact, miscellaneous contact, parent, legal guardian, caregiver, grandparent, next of kin and policy
holder. Miscellaneous contacts can include anyone whose details are important to the patient. For
example, if the patient is in a wheelchair and must be driven around, you could include the patient’s driver
as a miscellaneous contact.

Figure 9.9 Managing Patient Contacts from the Desktop
When you add a contact to a patient’s chart, you can either select the contact from a list of their existing
contacts or add a new contact. The list of existing contacts includes any patients that are specified as
family members (page 9.6). The benefit of selecting an existing contact is that many of the relevant details
are immediately available—you do not need to type them in.
To add a contact to a patient’s chart from the Desktop:

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the
My Workflow button.
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Procedure (continued)

Details (continued)

3. Choose the Demographics option.

The system displays the demographics search
functions on the right.
If you have the appropriate roles and functions, you
can edit the patient’s demographics if needed.
Simply click the Edit button to access the Edit
Patient Information window. Click OK when
finished.

4. Choose the Search for option and locate
your patient.
5. Highlight the appropriate patient.

Their demographics display at the bottom of
the window.

6. Click the Edit button.

The Edit Patient Information window opens (Figure
10.5 on page 10.8).

7. Click the Contacts tab.
8. In the Contact Type section, select the
Contacts option.

The system displays the patient’s current contacts in
the right pane.

9. Click the Add button to add a contact to the
patient’s chart.

If you need to edit an existing contact, you can
highlight the person and click Edit.
The Add contact window opens.

10. From the Contact Type drop-down, select a
category for the contact you want to enter.
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Procedure (continued)

Details (continued)

11. If the person you want to add is already a
contact in your database (Existing contact)
or an existing patient in the practice (Contact
is a patient), select the patient from the
appropriate drop-down.
OR
If the person is new to your database,
choose the New contact option.
12. If this contact is the main contact for the
patient, place a check mark in the Primary
checkbox.
13. Complete the remaining fields on this
window as appropriate and click OK.



Click the Insert Patient’s Address
button if the contact and the patient
have the same address.

Associating a Pharmacy with a Patient
MicroMD EMR allows you to associate pharmacies with patients. There is no limit to the number of
pharmacies that you can associate with any patient, and you can specify one of the pharmacies on the
patient’s list as their primary pharmacy. Simply place a check mark in the Preferred Pharmacy checkbox
on the Add Pharmacy window when you add/edit the pharmacy entry for the patient.

Figure 9.10 Patient Pharmacy
You have a practice-wide list of pharmacies (page 21.60), just like the list of insurance plans used by your
practice. When you add a pharmacy to a patient’s chart, you pull from that master list.
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To add a pharmacy to a patient’s chart through the Desktop:

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the My
Workflow button.
3. Choose the Demographics option.

The system displays the demographics search
functions on the right.
If you have the appropriate roles and functions,
you can edit the patient’s demographics if needed.
Simply click the Edit button to access the Edit
Patient Information window. Click OK when
finished.

4. Choose the Search for option and locate
your patient.
5. Highlight the appropriate patient.

Their demographics display at the bottom of
the window.

6. Click the Edit button.

The Edit Patient Information window opens
(Figure 10.5 on page 10.8).

7. Click the Contacts tab.
8. In the Contact Type section, highlight
Pharmacy.

The system displays the patient’s current
pharmacies in the right pane.

9. Click the Add button to add a pharmacy to the
patient’s chart.

If you need to edit an existing pharmacy, you can
highlight the entry and click Edit.
The Add Pharmacy window opens for the selected
type (Figure 9.10).

10. Click the Lookup icon (
Pharmacy field.

) next to the

11. Highlight the pharmacy you want to add to
the patient’s chart and click Insert.

This displays your practice’s master list of
pharmacies.
If you have the appropriate role and function, you
can add a pharmacy to the practice’s master list
from here if needed.

12. Place a check mark in the Primary Pharmacy
checkbox if this should be the patient’s default
pharmacy for new prescriptions.
13. Click OK in the Add Pharmacy to patient
contacts window to save your changes.
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Associating Providers with a Patient
MicroMD EMR allows you to associate a primary care provider, specialists and referring physicians with
each patient. There is no limit to the number of providers and specialists that you can specify for a patient.
You simply mark which one is the primary.

Figure 9.11 Patient Providers
You have a practice-wide list of specialists (page 8.3), just like the list of insurance plans used by your
practice. For each of the three lists for the patients, the system pulls from that one master list when you
add a physician to a patient’s chart.
To associate a provider with a patient from the Desktop:

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the My
Workflow button.
3. Choose the Demographics option.

The system displays the demographics search
functions on the right.
If you have the appropriate roles and functions,
you can edit the patient’s demographics if needed.
Simply click the Edit button to access the Edit
Patient Information window. Click OK when
finished.

4. Choose the Search for option and locate your
patient.
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Procedure (continued)

Details (continued)

5. Highlight the appropriate patient.

Their demographics display at the bottom of
the window.

6. Click the Edit button.

The Edit Patient Information window opens.

7. Click the Contacts tab.
8. In the Contact Type section, highlight
Providers / Specialists.

The system displays the patient’s current providers
in the right pane.

9. Click the Add button to add a provider to the
patient’s chart.

If you need to edit an existing provider, you can
highlight the entry and click Edit.
The Add Provider/Specialist window opens.

10. Click the Lookup icon (
Provider field.

) next to the

11. Highlight the provider you want to add to the
patient’s chart and click Insert.

This displays your practice’s master list of
specialists.
If you have the appropriate role and function, you
can add a provider to the practice’s master list
from here if needed.

12. From the Role drop-down, select the option
that best indicates the association between
the provider and the patient.
13. Place a check mark in the Primary checkbox if
the selected provider is the patient’s primary
physician of that type.
14. Click OK in the Add Provider/Specialist
window to save your changes.
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Patient Insurance Details
Each chart in MicroMD EMR can include details of the patient’s insurance policies. Maintaining insurance
information is essential because it facilitates the timely and accurate charging of billable procedures.



If you have a practice management interface, we
strongly recommend that you do not edit insurance
details from within MicroMD EMR. You should maintain
the patient’s personal information using the practice
management software.

MicroMD EMR allows you to maintain information on multiple insurance plans for each patient. You can
record the details of a patient’s primary, secondary and tertiary insurance plans.

○

Before you can add an insurance plan to a patient’s
chart, you must have the data in your database. MicroMD
EMR allows you to manage the list of insurance
companies and insurance plans used by your patients
(page 8.7).

○

MicroMD EMR identifies the patient’s default Plan Set with
a green check mark icon ( ).



For those with MicroMD PM, the system pulls over the
patient’s Plan Set information as well. This is
informational only, and you should not edit Plan Sets in
the EMR.

Each chart in MicroMD EMR can contain details of the patient’s medical insurance information. Insurance
information is divided into two components:

 Insurance Company and Insurance Plan details: This is practice-wide data.
 Insurance Policy information: This information is relative to each individual patient.
To add a new insurance policy to a patient’s chart:

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the
My Workflow button.
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Procedure (continued)

Details (continued)

3. Choose the Demographics option.

The system displays the demographics search
functions on the right.
If you have the appropriate roles and functions, you
can edit the patient’s demographics if needed.
Simply click the Edit button to access the Edit
Patient Information window. Click OK when
finished.

4. Choose the Search for option and locate
your patient.
5. Highlight the appropriate patient.

Their demographics display at the bottom of
the window.

6. Click the Edit button.

The Edit Patient Information window opens (Figure
10.5 on page 10.8).

7. Click the Insurance tab.

The system displays the patient’s current insurance
plans in the right side of the window.

8. Click the Add button to add an insurance
policy to the patient’s chart.

If you need to edit an existing policy, you can
highlight the policy and click Edit.
The Add Insurance Plan window opens.

9. Complete the fields on this window as
appropriate and click OK.
Table 9.1

Table 9.1 explains the fields on this window in detail.

Fields on the Add Insurance Plan Window

Field

Description

Plan Set

The Plan Set field is a display field for informational purposes only and display
the Plan Set sent over from MicroMD PM.

Insurance Type

Select whether this is the patient’s primary, secondary or tertiary plan.
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Fields on the Add Insurance Plan Window (continued)

Field

Description

Plan name

Click the Lookup icon (
plan from your system.

Policy number

Specify the patient’s policy number for this plan. You must enter information in
this field and/or the Group number field.

Group number

Specify the insurance group number. Either Policy number and/or Group number
must be specified.

ID number

Specify the ID number for this plan.

Accept assignment

Specify whether or not the insurance company accepts assignment for
collection.

Effective date

Specify the date from which the policy is active for the patient.

Expiration date

Specify the date on which the policy for this patient is no longer effective.

Deductible

Specify the amount of money that the patient should pay before the insurance
coverage commences.

Co-Pay

Specify the co-pay amount—a predetermined fee the patient pays directly to the
provider for a product or service.

Co-Insurance

Specify the co-insurance percentage for the patient if applicable.

Comment

If there is additional information you need to share about this insurance plan,
enter that information in this field.

Insured

This field indicates whose insurance policy this is. Choose the appropriate
option:

) next to the Plan name field to select an insurance

 Self: Choose this option if the patient is the policy holder. The system
chooses this option by default.

 Other: Choose Other if someone other than the patient is the policy holder.
You must specify the name of the policy holder and the relationship of the
policy holder to the patient. If the policy holder is not a current patient in the
practice, you can click the Add Insured button to enter the information for
that person.

Implementing Health Information Access and Consent Forms
All MicroMD EMR users can access the demographic information of all patients, and those MicroMD EMR
users that have specified user roles may be permitted to access patient medical information. However,
MicroMD EMR allows your patients to specify which providers can access the medical information in their
charts.



By default, each new chart created in MicroMD EMR,
including those created automatically by your practice
management interface, enables all providers to access
the patient’s medical information.
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Implementing Health Information Access and Consent Forms

For details on Immunization Consent forms, see
page 17.10.

Each patient can specify that the following providers or groups of providers can access his or her medical
information:

 All providers in the practice
You can give all providers in the system access to the patient’s medical information. After
specifying that all providers in the practice have access to the patient’s medical information,
you can then exclude specific departments and providers.

 All providers in specified departments
You can specify that all providers in specific departments should have access to the patient’s
medical information. After selecting a department, you can you can exclude specific providers
by expanding the department’s list and then disabling specific providers.

 Specific providers
You can specify that only specific providers have access to the patient’s medical information.

Viewing Current Patient Authorization
You can use the Chart Manager or the Desktop to see which providers are permitted to view a patient’s
medical information. The Chart Manager shows health information access information in two separate
lists:

 With approval: The list of all providers that are permitted to view the patient’s medical
information.

 Without approval: The list of all providers that are NOT permitted to view the patient’s medical
information.

Editing Patient Authorization
You can view and edit the patient’s health information access through their chart or through your Desktop.
Any MicroMD EMR user can change the authorization details for any patient’s chart. The system records
all changes made. The Patient Authorization Form report details all changes made to the patient’s
authorization (page 9.22).



If you make changes to a patient’s list of authorized
users who can view their health information, you should
print an updated Patient Consent Form for the patient
to sign.

To edit a patient’s authorization:

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the My
Workflow button.
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Procedure (continued)

Details (continued)

3. Choose the Demographics option.

The system displays the demographics search
functions on the right.
If you have the appropriate roles and functions,
you can edit the patient’s demographics if needed.
Simply click the Edit button to access the Edit
Patient Information window. Click OK when
finished.

4. Choose the Search for option and locate
your patient.
5. Highlight the appropriate patient.

Their demographics display at the bottom of
the window.

6. Click the Edit button.

The Edit Patient Information window opens
(Figure 10.5 on page 10.8).

7. Click the Health Information Access tab.
8. Place a check mark next to the providers that
can access the patient’s chart, and remove the
check mark from those that cannot.



Place a check mark next to All
Providers to give all providers in the
practice access the patient’s medical
information.
If you specify that all providers in the
practice have access to the patient’s
medical information, all new
providers created in the system will
have access to the patient’s medical
information by default.

9. Click OK to save your changes.

Completing Health Information Access Forms
MicroMD EMR provides a Patient Authorization Form that you can print for the patient to sign anytime they
make changes to their list of approved providers. The system also provides a Patient Authorization Form
so you can list all changes to the patient’s group of approved access to their medical information.
To complete a patient authorization form:

Procedure

Details

1. Open the patient’s chart and click the
Demographics tab.
2. In the Chart Navigator section, choose
the Health Information Access option.

MicroMD EMR displays the list of users with and without
access to the patient’s chart.

3. Click the Print button and select Patient
Authorization Form from the drop-down
menu.

The Forms Reference List Viewer opens.
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Procedure (continued)

Details (continued)

4. Locate the authorization form you want
to complete.

You can create your own or use the Standard form.

5. Review the form and make any edits you
need to make.
6. If you have an electronic signature device
or a tablet computer, double-click the
signature area to allow the person to sign
the device.

MicroMD EMR captures the signature and stores the
signed form in the Forms section of the patient’s chart
(in the Miscellaneous section of the Medical
Information tab).

7. Click Next until you get to the final step of
the form.
8. Choose the method for sending a copy of
the form to the patient.

You can also choose other methods of producing
the form.

9. Click the Finish button to save the form to
the patient’s chart.

Printing the Patient’s Authorization History Report
The Authorization History Report provides you with a list of all changes made to the patient’s health
information access authorization. When your practice removes permission from users or adds a user to the
patient’s list, MicroMD EMR records that change in the authorization history.
To print the patient’s authorization history report:

Procedure

Details

1. Open the patient’s chart and click the
Demographics tab.
2. In the Chart Navigator section, choose the
Health Information Access option.

MicroMD EMR displays the list of users with and
without access to the patient’s chart.

3. Click the Print button and select
Authorization History from the dropdown menu.

The Print Options dialog opens.

4. Select the method you want to use to
submit this report.

You can choose one of the following options:

 Batch: Sends the report to the practice’s Batch
Basket (page 27.14) for processing at a later time.

 Mail: MicroMD EMR creates a PDF of the report and
opens a blank internal mail message (page 4.11)
so you can send the report to another practice
user.

 Preview: Displays the report on the screen for you
to review. From the preview, the File menu has
several other options for distributing the report.

 Print: Sends the report to the printer you have
selected.
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Attaching Patient Consent/Refusal Documents
If you have a consent document or a refusal document that the patient has signed and you want to include
it in their chart, you do so under the Attachments section of the Desktop or the Attachments section of the
Medical Information tab in the patient’s chart.
When you attach the file, you select either the Signed Consent folder or the Refused Consent folder. See
page 20.1 for more details on attaching documents.



When you name the file, include the appropriate date at
the beginning of the file name. This will allow you to
view the documents by date when you sort the window
by folder.

Printing a Patient Demographics Report
MicroMD EMR provides a detailed report that practices can print from the patient’s chart. This report lists
the patient’s demographics currently on file (e.g., full name, phone number, address). The system also
allows you to choose print the patient’s insurance and emergency contact information. Simply place a
check mark next to the information you want to include.

Figure 9.12 Demographics Report

○

If a piece of information does not appear in the patient’s
chart, the system does not display the item on the report.
For example, if the patient’s chart does not contain an
entry in the Marital Status field, Marital Status: does not
appear on the report.

You can print the Patient Demographics Report from a variety of locations in MicroMD EMR.

 From your Desktop, click the My Workflow button and select Demographics from the available
options. Search for and highlight the patient and click the Print button (Figure 4.3 on page 4.4).

 From within your Desktop Tools (page 3.2) or your Chart Tools (page 10.3), click Chart Reports
and generate the Demographics Report.

 From within the patient’s chart, select Print > Patient Demographic Report from the
main menu.
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Emergency Access
MicroMD EMR allows users to access a patient’s chart in an emergency situation. Emergency access is a
temporary solution when an authorized user cannot be in the office and a normally unauthorized user
needs to access the patient’s chart.



It is important to establish these settings before you have
an emergency situation.

You should select a user to be granted emergency access. Once you decide on that user (or users), edit
each user’s account (EMR Manager > Users & Facilities > Roles > Edit) and place a check mark next to the
Emergency Access function.
When the user with emergency access attempts to open the chart, the system displays a dialogue box
asking them to enter a reason why the chart needs to be accessed.

Figure 9.13 Emergency Access Dialogue Box
The system keeps records of emergency access in the Audit Log reports.

Managing Patient Groups
MicroMD EMR provides practices with a way to create Patient Groups in their database. Patient Groups are
patients that have a significant common characteristic. For example, you could create the Patient Group
ASTHMATIC to include all patients that have been diagnosed with chronic asthma. You could also create
one called DIABETIC to group those patients diagnosed with diabetes.

Figure 9.14 Patient Group Indicator
When you create a Patient Group, you specify a color for that group. When you add a patient to a Patient
Group, MicroMD EMR adds a “sticker” to the patient’s chart (Figure 9.14). The sticker is color-coded
according to the color that you specified for the group. The colored sticker is clearly visible on the upper
right-hand corner of all tabs in the patient’s chart.
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All MicroMD EMR users who can access a patient’s chart can add the patient to a Patient Group; however,
not all users can see or print a list of the patients included in a specified Patient Group.



You can also use the MicroMD EMR reports (page 25.5)
to generate lists of patients that meet specified
conditions. MicroMD EMR allows you to add these
patients to existing Patient Groups from the report.

You can populate each Patient Group that you create either manually or automatically:

 Manually: A MicroMD EMR user must associate each patient with the Patient Group.
 Automatically: MicroMD EMR automatically adds patients to and removes patients from the
Patient Group based on the population conditions you set for the Patient Group. MicroMD EMR
runs a procedure once each day (around 3:15 a.m.) to regenerate all Patient Groups set to
populate automatically.

○

Only a MicroMD EMR user who has the Manage Groups
function associated with their user account checked in
the MicroMD EMR Manager under their user functions can
manage Patient Groups.

Managing Patient Groups for Your Practice
Any user can work with Patient Groups in the system if they have the Manage Groups function assigned to
their user account in MicroMD EMR. With this function, you have the ability to create new Patient Groups
and edit/delete existing Patient Groups. When you create a new group or edit an existing one, you have the
ability to indicate if you want to populate that group manually (page 9.28) or let the system populate the
group automatically based on certain conditions.

Figure 9.15 Managing Patient Groups
To edit or delete an existing Patient Group, simply highlight the Patient Group and click the Edit or Delete
button as appropriate.
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To create a new Patient Group in your database:

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the
Administration button.

If you do not have this button under the My
Workflow button, you do not have the security
function to manage Patient Groups.

3. Choose the Manage patient groups option.

The system displays the current groups in the
drop-down and the patients associated with the
selected group in the right side of the window.

4. Click the Patient Groups Manager button.

The Patient Groups Manager window opens.

5. Click the Add button.

The Patient Groupings window opens.

6. Complete the necessary fields for the new
Patient Group and click OK.

Table 9.2 explains the fields on this window in
detail.
When you add a new Patient Group, MicroMD EMR
automatically assigns a number to the group. This
number appears inside the sticker of the Patient
Group when the sticker appears in a patient’s
chart.
This number assists with visual identification of the
Patient Group, along with the color. You cannot
change the number that is assigned to a Patient
Group.

7. Click Close in the Patient Group List window.
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Fields Available on the Patient Groupings Window

Field

Description

Group Name

Enter a useful description for the Patient Group. This is the name displayed
when users associate a group to a patient (page 9.28).

Population Method

Select the method for adding patients to the Patient Group.

 If you want to add patients to this particular group on a case-by-case basis,
select Manual from the drop-down.

 If you want to establish conditions so the system automatically
adds patients to this particular group, select Automatic from the
drop-down.
Group Color

Click Select Color to color code the Patient Group. This sets the color of the
“sticker” that appears at the top of a patient’s chart when a user assigns them
to this Patient Group.
Click the OB Care, CCM Enrolled, or CCM Declined buttons to use the built-in
indicator for those groups.

Appear in Chart

Specify whether or not you want the “sticker” for this Patient Group to appear
in patient charts. This option may be useful where group information is
confidential, such as where the group contains HIV patients.

Group Code

If your system imports Patient Group information from a practice
management system that uses patient groups, enter the code of the group
as it appears in communication with the practice management system. This
option is available only if you select Manual from the Method of Applying
drop-down.

Conditions

Click the Conditions button to establish criteria that each patient must meet
before the system adds them to this Patient Group automatically. This button
is available only when you select Automatic from the Method of Applying
drop-down. (See page 25.14 for more details on creating queries.)

Apply with date
restrictions

Place a check mark in this option to regenerate Patient Groups daily during the
dates you specify in the Start Date and End Date fields, based on the criteria
you set under the Conditions button. This option is available only when you
select Automatic from the Method of Applying drop-down.
If a patient who met the criteria yesterday, but something changed and they
do not meet the criteria today, the system removes the patient from the group
when it repopulates the lists.

Start Date

When you place a check mark next to Apply with date restrictions, you need to
specify the date after which MicroMD EMR should begin to populate this
Patient Group automatically, based on the criteria you set under the
Conditions button.

End Date

When you place a check mark next to Apply with date restrictions, you need to
specify the date after which MicroMD EMR should stop populating this Patient
Group automatically.
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Adding Patients to a Patient Group Manually
You can add patients to a Patient Group either manually or automatically. When you let the system do so
automatically, you cannot also add patients to that same group manually. It’s an either/or situation. (If you
want the system to add patients to a group automatically, see Table 9.2 for the options you need to set on
the patient group.)

○

The system creates a log entry anytime a user or the
system adds a patient to a Patient Group or when a user
or the system removes a patient from a Patient Group.
You can view these entries in any of the Audit Log Reports.

When you want to add patients to a group that was set to add patients manually, you can either add
patients one at a time or you can use the reporting module and do so in a batch.

○

Remember: All MicroMD EMR users who can access a
patient’s chart can add the patient to an existing Patient
Group; however, these users cannot see or print a list of
the patients included in a specified Patient Group.

Add Patients One at a Time—From the Desktop
When you want to add a single patient to a group manually, you can do so either through your Desktop
or through the patient’s chart. You can only add the patient to the group from the Desktop if you have
the Manage Group function associated with your user account.

Procedure

Details

1. Click your Desktop tab.
2. In the Desktop Navigator section, click the
Administration button.
3. Choose the Manage Patient Groups option.

The system displays the current groups in the
Patient Group drop-down. Patients who are
members of the currently selected group appear
in the list.

4. Select the group to which you want to add
the patient from the Patient Group dropdown.
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5. Click the Add Member button.

The system displays the Select Patient window.

6. Search for the patient and click Insert.

The system adds the patient to the Patient
Group and displays the appropriate “sticker” on
their chart.
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Add Patients One at a Time—Within a Patient Chart
If, when visiting with a patient, a provider decides that a patient should be included in a certain Patient
Group, they can assign the patient to a group from within the patient’s chart. There are some groups
that the system assigns automatically to the patient’s chart, and you cannot remove them from the
chart.
To add a patient to a Patient Group from within their chart:

Procedure

Details

1. Open the patient’s chart.
2. In the Chart Tools section, click the
Patient Groups item.

You can also click the Patient Groups area in the
corner of the chart to open the list of groups. If you
use this method, click the Edit button on the
window that opens.
The Edit Patient Groups window opens.

3. Under Available Groups, highlight the
group you want to associate with this
patient and click the Add button.



You can also drag and drop from the
Available Groups side of the window
to the Patient Groups side to
associate the patient with the group.

To remove a patient from a group, highlight the
group under Patient groups and click the Delete
button.
4. Click OK to save your changes and return
to the patient’s chart.
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A colored sticker that represents the Patient Group
appears in the upper right-hand corner of the
patient’s chart.
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Printing a List of Patients in a Specified Patient Group
Those MicroMD EMR users with the Manage Groups security function have the ability to generate a list of
patients within specified Patient Groups. For example, Betty at Summervale Medical Center needs to send
out a letter about the new blood-sugar monitoring devices the practice now has. She can generate a report
of all patients in the DIABETES group the practice created.
To print a list of patients in a specified Patient Group:

Procedure

Details

1. Verify that you have your Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button.
3. Choose the Manage Patient Groups option.

The system displays the current groups in the
drop-down and the patients associated with the
selected group in the right side of the window.
If you do not have this option under the My
Workflow button, you do not have the security
function to manage Patient Groups.

4. Select the appropriate group from the Patient
Group drop-down.

The system displays all the patients currently
associated with the selected group.

5. Click the Print List button.

You can choose one of the following options:

 Batch: Sends the list to the practice’s Batch
Basket (page 27.14) for processing at a later
time.

 Mail: MicroMD EMR creates a PDF of the list
and opens a blank internal mail message
(page 4.11) so you can send the list to another
practice user.

 Preview: Displays the list on the screen for you
to review. From the preview, the File menu has
several other options for distributing the list.

 Print: Sends the list to the printer you
have selected.

Printing Mail Merge Letters for the Whole Patient Group
Authorized MicroMD EMR users can print mail merge letters to a list of patients in a specified patient group.
This is particularly useful when you want to print a standard letter to all members of a Patient Group or just
a few.
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When you use the mail merge facilities in MicroMD EMR,
you can also use the same window to print address
labels for those letters and in the same order.
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Refer to page 26.2 for details on creating mail merge
letter templates.

To print a mail merge letter to a list of patients in a specified patient group:

Procedure

Details

1. Verify that you have your Desktop displayed.
2. Click the Administration button in the
Desktop Navigator section.

The system displays the available options for the
roles associated with your user account.

3. Choose the Manage Patient Groups option.
4. From the Patient Group drop-down, select the
group that contains the members for whom
you want to print letters.

The display window lists all the patients currently
included in the selected group.

5. Click the Utilities button and select Mail
Merge for Group from the drop-down menu.

The Mail Merge window opens and lists all the
patients in the selected Patient Group (Figure 25.3
on page 25.4).

6. Click the Lookup icon (
Template field.

The Load Letter Template window opens.

) next to the Letter

7. Locate and load the appropriate template.

See page 26.2 for details on creating letter
templates.

8. If you need to change the provider for the
letters, click the Lookup icon ( ) next to the
Provider field and insert the appropriate
provider.
9. Move the appropriate patients from the Group
List side to the Send Letters to side of the
window.

You can drag and drop, double-click or use the
arrow icons to move patients back and forth.

10. Click Print.

The system merges the letters and sends to your
printer. If you want to print labels for these letters,
click the Create Labels button (page 26.8).
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Charts Module
The Chart Module is one of the core ingredients to an efficient paperless office. MicroMD EMR provides an
intuitive workflow throughout the Chart Module and its relationships with other areas of the program.

In This Chapter
In this chapter, we cover:

 Using the Charts Module (page 10.1)
 Creation of new charts (page 10.7)
 Opening an existing chart (page 10.11)
 Printing a chart (page 10.13)
 Exporting/importing a chart (page 10.15)
 Encrypting/decrypting patient data files (page 10.17)
 Reviewing communication and tasks related to the patient (page 10.19)
 Navigating multiple open charts (page 10.20)
 Viewing charts of family members (page 10.20)
 Closing a chart (page 10.21)
 Viewing audit log of changes to patient’s chart (page 10.21)
 Merging duplicate charts (page 10.22)
 Creating and sending reminders (page 10.26)
 Adding a Patient Alert Note (page 10.28)

Overview
Each patient in MicroMD EMR has a chart. You cannot have a patient in the system without a chart. The
chart—also known as the electronic medical record (EMR) or electronic health record (EHR)—is a record of
all the information that the health facility has about the patient.

○

Remember: Only those users with appropriate access
rights for managing patient charts can open, create or
modify patient charts.

Charts include both demographic and clinical information:

 Demographic Information consists of the patient’s non-clinical information. It includes personal
details (such as address, phone numbers, etc.), as well as the patient’s insurance and relevant
contact information.

 Clinical Information consists of medical history and current encounter details.
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Overview

- Medical Information: Medical Information includes details of the patient physical health,
including allergies, habits, long-term medications and problems. The system divides the
medical information into a number of categories, including: Medical (Chapter 13), Histories
(Chapter 14), Orders (Chapter 15), Specialties (Chapter 16), Health Maintenance (Chapter
17), Women’s Health (Chapter 18), and Miscellaneous (Chapter 20).

- Encounter details: The Encounter Details are the specifics of the patient’s visit(s) to the
practice. For details on viewing and managing the patient’s encounter information, see
Chapter 22.
The Chart Manager provides access to the charts of all patients in the system. You can view and edit
existing information and add new information to the charts. The Chart Manager allows you to manage
both the clinical and non-clinical information in your patients’ charts. You can access patient charts
through the Charts tab (Figure 10.1). (See page 10.11 for other ways of opening a patient chart.) With the
Chart Manager, you can have a maximum of nine charts open at the same time.

○

Access to the charts of some patients may be restricted
due to the patient’s authorization (page 9.19).

○

Users with specific user roles can access all features
inside the Chart Manager. Some users can access only a
limited set of functions, and other users cannot access the
Chart Manager at all. For more details on roles and
functions, see page 1.16.

The Chart Manager has four tabs: Demographics, Medical Information, Summary, and Encounter. Each
tab enables you to access and manage different aspects of the patient’s chart.

Figure 10.1 Areas of the Patient’s Chart
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Demographics Tab
The Demographics tab allows you to manage the non-medical information for a patient, including
personal details such as birthday and phone number. This tab also includes insurance and contact details.



For more in-depth details about this tab, see Chapter 9.

Medical Information Tab
The Medical Information tab is where you store and manage everything medical for the patient. This tab
contains several information categories, including medical problems, histories and medications.



For more in-depth details about this tab, see Chapter 12
through Chapter 20.

Summary Tab
The Summary tab of a patient’s chart contains a brief list of all encounters created for the patient. At the
bottom of the tab, you can display information about patients that you find most useful to you when
reviewing charts.



For more in-depth details about this tab, see page 22.24.

Encounter Tab
The Encounter tab provides in-depth details about each encounter recorded for the patient, no matter
who recorded the encounter.



For more in-depth details about this tab, see Chapter 22.

Chart Tools
When you display the Chart Manager in the MicroMD EMR Application Work Space, MicroMD EMR displays
tools in the Chart Tools section based the tools chosen under the Modify Toolbox icon ( ). These tools
are available no matter which tab you choose in the patient’s chart. Please refer to the appropriate
sections of the manual to learn about each of the tools.
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Chart Tools

Figure 10.2 Chart Toolbox
You can customize the tools displayed in your toolbox. If you only use a few tools, you might choose to
display only those tools. You might also choose to put those tools at the top of the toolbox and move those
you use less frequently near the bottom.



You don’t have to keep a tool in the Chart Tools display
in order to use it. You can run the tool from within the
Toolbox manager. Simply highlight the tool and click
the Run button.

To customize the Chart Tools section:

Procedure

Details

1. Open a patient’s chart.

You need to have a chart open to access the Chart
Tools section.

2. Click the Modify Toolbox icon (
Chart Tools section header.

10.4

) in the

The Toolbox Manager window opens. You can also
edit this display from your User Preferences
(page 1.84).
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Procedure (continued)

Details (continued)

3. In the Available Toolbox Items section,
highlight the tool you want to display and

The system adds your choice to the Provider Toolbox
side of the window. You can also drag and drop the
item between sections or double-click the entry to
move it.

click the right arrow icon (

).

4. Repeat step 3 for each tool you want to
display.
5. Use the up and down arrows on the right to
change the order of the items.

This changes which item displays first, second, etc.

6. Click OK when satisfied with your list.

Chart Navigator
The Chart Navigator provides a number of options that determine the section of the patient’s chart that is
displayed on the right. The available options vary depending on the chart tab you display. At the bottom of
the Chart Navigator are also various navigation buttons that help organize the options available to you.
These buttons also vary depending on the chart tab you click when navigating a patient’s chart.

Figure 10.3 Chart Navigation
Click any of the options to access the appropriate section of the patient’s chart. Depending on the tab you
are on, you can click the Modify icon ( ) in the header and choose to hide or display the various options.

○

If you are on the Medical Information tab, you only
choose what displays in your Common List for the tab.
See page 12.5 for more details.
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Chart Header

Chart Header
The chart’s header is available wherever you are in the chart. It contains brief details to identify the patient,
as well a few indicator buttons to help alert you to important information about the patient.

Figure 10.4 Chart Header
You have the following tools available from the patient’s chart header:

 Reminders button (

): Click this button to open the Reminder Manager. This manager
contains all reminders set for this patient, either for yourself or sent to the patient. For more
details about using reminders, see page 10.26.

 Alerts button (

): Click this button to display the Alert List for this patient. You only see this
button if there is at least one alert (or more) in the patient’s chart. For more details about alerts,
see page 13.6.

 Patient Alert Note button (

): This button displays a pop-up window with a message
regarding the patient. Click the button to display the message. For more details on the alert
note, see page 10.28.

 Patient Group stickers: If you see colored “stickers” at the top right of the patient’s chart, this
patient belongs to one or more patient groups in the EMR. Click the sticker to view the patient
group. See page 9.24 for more details on patient groups.

 Close Chart button: Click this button to close the currently displayed chart. If only one chart is
open, then the Close Chart button closes the chart and displays either the Desktop or the Appt
Book tab, depending on the last one you viewed.
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Creation of New Charts
You enter a new patient into MicroMD EMR by creating an account for that patient in your practice
management system. The integration between your practice management system and MicroMD EMR
automatically creates a new chart in the EMR.
DO NOT create a new chart from the EMR if you have
both MicroMD EMR and a practice management
system.



If your MicroMD EMR installation is integrated with
your practice management system, MicroMD EMR
automatically imports patients’ basic demographic,
contact and insurance information directly from the
practice management system. If you edit from within
MicroMD EMR, you could cause data synchronization
issues.

Initially, the new chart may include only the patient’s personal information, and possibly a picture of the
patient. After the creation of a new chart, you can add both clinical and non-clinical information to it.
You can also associate a new patient with other patients who already exist in the system. This allows easy
and quick access to the charts of the patient’s family members. When you create a new chart, the system
validates that a chart does not already exist for that person. The system checks the patient’s last name, first
name, date of birth and social security number.

○

Remember: Only those users with appropriate access
rights for managing patient charts can open, create or
modify patient charts.

For those practices with ONLY MicroMD EMR: To create a new patient chart from anywhere in the system,
select Chart > New from the main menu. You can also press the Ctrl + N key combination on the keyboard.
This displays a new Patient Demographics window (Figure 10.5) with any defaults already populated. For
defaults on a new patient chart, see page 1.35.
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Figure 10.5 Fields in the Patient Demographics Window
Table 10.1 Fields Available on the Patient Demographics Window

Field

Description

Last Name, First Name
and MI

This displays the patient’s name.

Address 1, Address 2,
City, State, Zip, and
Country

This displays the patient’s address.

Home Phone

This displays the patient’s home phone number.

Cellular Phone

This displays the patient’s cellular phone number.

Work Phone

This displays the patient’s work phone number.

Alternate Phone

This displays any other phone number provided by the patient as a means to
get in touch with them.

Primary Phone

From this drop-down, select which of the phone number fields is the patient’s
preferred primary contact number. This number then displays throughout
the system as the patient’s main phone number.

10.8
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Table 10.1 Fields Available on the Patient Demographics Window (continued)

Field

Description

2ndary

From this drop-down, select which of the phone number fields is the patient’s
preferred secondary contact number if they cannot be reached at their
primary phone number.

Fax

This displays the patient’s fax number.

Email

This displays the patient’s e-mail address. MicroMD EMR uses this address for
all patient notification messages.

Mobile Email

This displays the e-mail address available for the patient’s cell phone or PDAtype device (e.g., a Blackberry).

Confidential Comm

When your practice has private information to share with the patient, the
selection in the Confidential Comm drop-down provides you with guidance
on the patient’s communication preference and whether you can leave a
message.

Main Provider

This displays the patient’s primary physician. This field is included for
informational and reporting purposes only.

Primary Guarantor

This displays the primary individuals or entities who pledge financial
responsibility for the patient.

Primary Employer

This displays the patient’s primary place of employment.

Emp Start Date and end This displays the date the patient began work with the Primary Employer and
the date they stopped working there (if applicable).
Primary PCP

This displays the patient’s primary care physician.

Primary Referring

This displays the patient’s referring doctor.

Reporting Status

This displays whether the system should include the patient in reports
generated for the practice. There are times when a patient account is not
really a patient. This allows you to exclude those accounts from any reporting
and avoid inaccurate data.

Comment

This displays any additional information that pertains to the patient.

Mother Last Name, First
Name, MI and Maiden
Name

Particularly useful for pediatrics, these fields display the name of the patient’s
mother.

Maiden Name

This displays the patient’s maiden name.

Birth Name (Last), Birth
Name (First), and MI

These fields display the patient’s name and should be the name that appears
on their birth documents. This information is required for exported charts
and generally pulls from your practice management system.

Birth State and Birth
Country

These fields display where the patient was born and should be the location
that appears on their birth documents. This information is required for
exported charts and generally pulls from your practice management system.

Suffix

This displays the patient’s suffix. MicroMD EMR does not display the patient’s
suffix in most dialog boxes.
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Table 10.1 Fields Available on the Patient Demographics Window (continued)

Field

Description

Title

This displays the patient’s title. The system includes this title with the
patient’s name throughout MicroMD EMR.

SSN

This displays the patient’s SSN.

Marital status

This displays the patient’s marital status. This field is included for
informational and reporting purposes only.

Sex

This displays the patient’s sex at the time of their birth.

Gender Identity

From the Gender Identity drop-down, select the gender with which the
patient most closely identifies himself or herself. This can be the same or
different from their sex assigned at birth. The recommended best practice is
to ask the patient, “What is your current gender identity?”

Sexual Orientation

From the Sexual Orientation drop-down, select the patient’s inherent or
immutable and enduring emotional, romantic or sexual attraction to other
people. The recommended best practice is to ask the patient, “Do you think
of yourself as...?”

Date of Birth

This displays the patient’s date of birth.

External MRN

This displays the patient’s external ID. This is the patient’s ID in the practice
management software.

Chart Status

This drop-down indicates whether the patient’s chart is active or inactive. You
can indicate if the patient is deceased. MicroMD EMR displays only Active
charts throughout the program.

Family Size

This displays the size of the patient’s family. This field is included for
informational and reporting purposes only.

Industry

This displays the industry in which the patient works. This field is included for
informational and reporting purposes only.

Occupation

This displays the patient’s occupation. This field is included for informational
and reporting purposes only.

Yearly Income

This displays the patient’s annual income. This field is included for
informational and reporting purposes only.

Race

This displays the patient’s race. The patient could have multiple choices
displayed in this list. Click the list icon next to the drop-down to display the
races chosen for this patient. This field is included for informational and
reporting purposes only.

Ethnicity

This option displays whether or not the patient is of Hispanic origin. The
patient could have multiple choices displayed in this list. Click the list icon
next to the drop-down to display the ethnicities chosen for this patient. This
field is included for informational and reporting purposes only.

Religion

This displays the patient’s religion. This field is included for informational and
reporting purposes only.
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Table 10.1 Fields Available on the Patient Demographics Window (continued)

Field

Description

Language

This displays the patient’s home language. This field is included for
informational and reporting purposes only.

Nationality

This displays the patient’s nationality. This field is included for informational
and reporting purposes only.

Country of Origin

This displays the patient’s country of origin.

Immigration Date

This displays the date on which the patient immigrated.

Education Level

This displays the highest level of schooling the patient has reached. Their
highest grade level displays in the Highest Grade drop-down.

Highest Grade

This displays the highest level of grade school the patient has reached. The
highest educational level displays in the Education Level drop-down.

Migrant

This indicates if the patient is a migrant. This field is included for
informational and reporting purposes only.

Homeless

This indicates if the patient is homeless. This field is included for
informational and reporting purposes only.

Veteran

This indicates if the patient is a veteran. This field is included for
informational and reporting purposes only.

Opening an Existing Chart
You can search for a patient chart using a variety of patient demographic information. The choices
available for searching appear in the Based on drop-down on the search window (Figure 10.6). You can
open an existing chart from areas throughout the system. Whenever you open a chart, the system displays
the Open Chart window (Figure 10.6) if it doesn’t already know which patient’s chart you want to view.

Figure 10.6 Open Chart Window

○

The Alias column refers only to the data returned from
MicroMD PM. There is no Alias field in MicroMD EMR.

By default, the system searches for patients’ charts based on the patient’s last name. You can change the
default search criteria to any of the above options in your User Preferences (under Tools > User
Preferences > General). (See page 1.84 for more details on user preferences.)
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Opening an Existing Chart

When you search for a chart using the default option Last
Name, First Name, you can enter the first few characters
of the patient’s last name followed by a comma followed
by the first few characters of the patient’s first name.
For example, typing Jon, Pe locates the chart of Peter
Jones, but not Paul Jones.

To open an existing chart:

Procedure

Details

1. Select Chart > Open from the main menu.

You can also click the Open Chart icon ( ) on the
top toolbar. If you do not currently have any charts
open, you can click the Chart tab to launch the
search window.
The Open Chart window opens (Figure 10.6).

2. From the Based on list, select the type of data
you want use to find the patient’s chart.

For example, if you only have the patient’s chart
number, select Chart No from the drop-down. By
default, this field is Last Name, First Name.

3. Type the appropriate text in the Search for
field and press Enter.

The system displays all of the patient charts that
match the text you entered.
For example, if the patient’s last name is Brennan,
you could type Brennan, Bre or even just Br.
Because the search is not case-sensitive you could
even type brenn.



Place a check mark in the Today’s
Appointments checkbox at the
bottom of the Open Chart window to
display only those charts of patients
with appointments on the schedule
for today.

MicroMD EMR lists only charts of Active patients. It
does not list charts of Inactive and Deceased
patients. For details on the Chart status field, see
Table 10.1 on page 10.8.
4. Double-click the chart you want to open.

MicroMD EMR opens the Charts tab and displays
the patient’s chart. This chart becomes the current
active chart.

5. Review the summary and the patient’s picture
to verify that you have the correct chart open.
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Printing a Chart
MicroMD EMR enables you to print a hard copy of a patient’s chart, either the entire chart or just a portion
of it. You might need to send a copy to a specialist or a portion of the information to an outside lab. From
within a patient’s chart, select Print > Print Chart from the main menu.

Figure 10.7 Chart Report Window



For information on how to print a demographics report—
one that does not contain medical information, see
page 9.23.

When you print a patient’s chart, you can choose to include the following information in the printout:

 demographic information—including insurance and contact information
 medical information
 encounter information
 insurance information
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Printing a Chart

To print the chart, make your selections and click the Print button. The system displays the preview
window for you. Once you’re satisfied with the report, select File > Print from the main menu of the
preview window.



You can also send the report through mail (page 4.11) or
to the practice’s Batch Basket (page 27.14).

Demographic Information
The Demographics information checkbox prints information from the Patient Details section of the
patient’s chart; however, there are two options that allow you to print additional information on the
report:

 Place a check mark in the Include insurance information checkbox to include the patient’s
insurances on the report. The system pulls this information from the Insurance Plans section of
the Demographics tab (page 9.17).

 Place a check mark in the Include contact information checkbox to include the patient’s
personal contacts, pharmacy list, and associated providers and specialists. The system pulls
this information from the Contacts, Pharmacies, and Providers / Specialist sections of the
Demographics tab (page 9.11).

Medical Information
You can choose which information from the Medical Information tab of the patient’s chart you want to
include in the printout. Click the Lookup icon ( ) next to the Medical Information field (Figure 10.7 on
page 10.13) to open the Medical Information Report window (Figure 10.8).

Figure 10.8 Medical Information Report Window
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Select the medical information you want to include in the chart report and click OK.



The system remembers the choices you made the last
time you used this window, just like when using the
Standard Encounter Report (page 22.59).

Encounters
If you want to include encounters in the chart report, you must use an Encounter Report template so
MicroMD EMR knows how to format the encounters. The templates afford you an immense flexibility to
dictate the contents of the printout. You create Encounter Report templates under Tools > Encounter
Tools > Report Templates (page 22.61).
The encounter filters in the Chart Report window (Figure 10.7 on page 10.13) includes the same search
fields and functionality as the Encounter Summary Filter (Figure 22.16 on page 22.26), as well as date fields,
and allows you to limit which encounters print in the chart report.

○

Only signed encounters print when you include
encounters in the report.

○

If you only want to include the last revision when there are
multiple versions of an encounter, place a check mark in
the Print last revision only checkbox.

Exporting and Importing C-CDA/CCR/CCD Records
MicroMD EMR can export and import Clinical Document Architecture (C-CDA), Continuity of Care Record
(CCR) and Continuity of Care Document (CCD) health records. Healthcare professionals use these files for
health information exchange.

○

Each type of record has a slightly different format so be
sure you export or import using the correct item.

○

Exporting and importing a specific file type depends on
your practice’s setting in the MicroMD EMR Manager
(page 1.35).



For information on importing the Patient Health
Information form from the MicroMD Patient Portal, please
see the main Henry Schein Secure Chart Patient Portal
User Guide.
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Exporting/Importing the File
When you export the patient’s information, the system creates an XML file and a human-readable file for
each type. When you import an XML file, MicroMD EMR displays the file for you in a report format and stores
it in the patient’s folders in MicroMD Document Management.

Exporting a Chart
To export a C-CDA, CCR or CCD record, simply open the patient’s chart and select Chart > Export/
Import Chart (C-CDA/CCR/CCD) > Export from the main menu. Name the file appropriately and click
Save.

Importing a Chart
When you import a patient’s chart, you must reconcile the data contained within the file with the data
contained within the patient’s chart.

Figure 10.9 Data Reconciliation Window
To import a saved file and reconcile the data:

Procedure

Details

1. Open the patient’s chart.
2. Select Chart > Export/Import Chart (CCDA/CCR/CCD) > Import from the main
menu.

10.16

The Data Reconciliation window opens (Figure 10.9).
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Procedure (continued)

Details (continued)

3. Click the Import New CDA button.

The Import file (C-CDA/CCR/CCD) dialog opens.

4. Locate the patient’s file and click Open.
5. From the drop-down, select the file you
imported and click the Load button.



To view the data before loading, click
the View button.

6. In the New Info pane, place a check
mark next to each piece of data you
want to import into the patient’s chart.

The Current MedInfo pane displays the information
currently recorded in the patient’s chart.

7. Click the Add button.

The system displays the data in the Reconciled
Info pane.

8. When satisfied with the data, click the
Apply data.

Encrypt/Decrypt Files
You have the option to create encrypted patient health records that are not human-readable. This allows
you to transfer electronic files safely and ensure only authorized personnel can view the patient’s data. You
can provide the “key” to the receiver of the file.

Setting up Encryption/Decryption in MicroMD EMR
To set up encryption in MicroMD EMR, you must create an encryption key that the system programs into
the file so that you and the receiving party are able to open the file. You only need to do this once at the
practice level.



You MUST write the pass phrase down before you click
OK. You cannot retrieve it in the future, and you cannot
see the characters as you type.

In the MicroMD EMR Manager, click System Settings > Security and click the Edit button. In the
Encryption Passphrase field (Figure 10.10), type the practice-wide code or password and click OK.
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Figure 10.10 Encryption Pass Phrase on the Security Settings Window

Encrypting a File
When you want to encrypt a patient’s data file, you must have the patient’s chart open. Once you have the
patient’s chart open, simply select Chart > Encrypt File from the main menu. Navigate to the file you want
to encrypt and click the Open button.
The system re-saves the data file using the triple DES (3DES) encryption algorithm, which includes the pass
phrase you created in the Encryption Passphrase field (Figure 10.10).



Double-click the *.html file that you just encrypted to
open it. You should see a string of letters and numbers
instead of patient data.

Decrypting a File
To decrypt a file sent to you, you must have the patient’s chart open for whom you are about to decrypt
and import data. Once you have the patient's chart open, simply select Chart > Decrypt File from the main
menu. Navigate to the file you want to decrypt and click the Open button.
The system re-saves the file and will prompt you for the pass phrase needed to unlock and read the file.
The third party sending you the patient file should provide you with this key. You can then view the file
and/or import the file into the patient’s chart.

Hashing a File
If you need to send the patient’s chart to a third party through a secure FTP site or other secure
communication method where the file needs to be encrypted using SHA-1 or SHA-2 encryption standards,
you can “hash” the file and then send it securely.

○

MicroMD EMR uses SHA-1 and SHA-256 encryptions to
produce two files you can use: a *.has file (SHA-1) and a
*.sha2 file (SHA-256).

To hash a file, you must have a patient chart open. Once you have the chart open, select Chart > Hash File
and browse to the file’s location. When you click the Open button on the Open File for Hashing window,
the system re-saves the file with an additional date/time stamp in the file name and with the extension
*.has. The system also creates a second file with the same file name but using the SHA-2 algorithm. The
extension on that second file is *.sha2. This allows you to upload the file most compatible with the third
party’s software.
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Patient Communication
MicroMD EMR provides a central location in each patient’s chart where you can view all communication
sent and received regarding the patient. You can also track the orders that requested for the patient that
still need to be performed, as well as other tasks relevant to the individual patient. Messages from patient
sent through the Patient Portal also appear in the Mail section of the Workflow Communicator.



The Workflow Communication window is a reflection of
your Desktop but for only the current patient. See
Chapter 4 for details on each section in the Workflow
Communication window. Most of the options and
available actions are the same.

Figure 10.11 Workflow Communication
To access the communication panel, simply select Chart > Workflow Communication from the main
menu while you have the patient’s chart open. You can also add the item to the Chart Tools section
(page 10.3) or click the Workflow Communication icon ( ) on the top toolbar.
Choose the appropriate category on the left (Figure 10.11), and the system displays the list of items in the
right side. If a category has items within it, the system displays a number next to the item to show you how
many are in that category.
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Moving Between Open Charts
You can easily switch between any of the open charts in MicroMD EMR. Simply click the drop-down arrow
next to the Open Chart icon ( ) on the top toolbar (Figure 10.12). The system displays a list of all the
charts you currently have open. The check mark indicates the chart currently displayed in the window.
Select the chart you want to display. The system displays the chart without closing the others.

Figure 10.12 List of Open Chart



If you have fewer charts open than the maximum, you
can click one of the <open> choices in the drop-down list
to open an additional chart.

Each MicroMD EMR user can have a maximum of nine charts open simultaneously, although the system
only displays one at a time. Practices can change that maximum if they choose. Perhaps a practice prefers
physicians to only have three charts open at a time to avoid workflow issues with other users who may
need access to those charts. (See page 1.35 for this setting.)

Viewing Charts of Family Members
When you create a chart for a patient, you can link the patient’s chart to the charts of other family
members. MicroMD EMR allows you to scroll through the charts of all family members, using the current
patient as the central point. The order of the charts is based on the age of the patients.



The Chart Summary of each chart (on the
Demographics tab) lists all the family members of the
patient—together with their ages (Figure 10.13).

Figure 10.13 Family Members Listed in Chart Summary
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On the top toolbar, use the Previous Family Member icon ( ), Return to Original Patient icon ( ), and
the Next Family Member icon ( ) to scroll between the charts of the family members. You can use the
Family Member navigation buttons when you display any of the four tabs inside the patient’s chart.

 Clicking the Previous Family Member icon opens the chart of the next youngest family
member.

 Click the Next Family Member icon opens the chart of the next oldest family member.



If the Previous Family Member icon ( ) is disabled, the
current patient does not have any younger family
members with charts in the EMR.
If the Next Family Member icon ( ) is disabled, the
current patient does not have any older family members
with charts in the EMR.

Closing a Chart
You can have a maximum of nine charts open simultaneously in MicroMD EMR. When you no longer need a
patient’s chart, you have several options for closing the chart.

 Select Chart > Close Current Chart from the main menu.
 Select File > Close Chart from the main menu.
 Click the Close Chart icon (

) at the top right of the chart.

 Press the Shift + X key combination on the keyboard while you are in the chart.

Change History
Whenever someone makes a change to the patient’s chart, whether it is a change to their demographics
information, modifications to their medical information or edits made to an encounter, the Change History
tracks this information for you.
Change History is available in the Demographics, Medical Information, Summary or Encounter tabs
and tracks the following on each:

 Demographics tab (page 9.8): The Change History for this tab tracks changes made to the
Personal Details section.

 Medical Information tab (page 12.12): The Change History for this tab tracks edits made to
each piece of medical information in the patient’s chart from their problem list to the letters
added to their chart.

 Summary tab (page 22.30): The Change History on the Summary tab records which users
create and save encounters for the patient and when.

 Encounter tab (page 22.37): The Change History for this tab tracks input or modifications made
to any data element within the encounter and even documents when the encounter was viewed
by a user.
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Merging Duplicate Charts
When you merge charts, MicroMD EMR copies information from the chart that you want to remove and
inserts it into the chart that you want to keep. Duplicate charts exist where a user inadvertently creates a
second chart for a patient, not realizing there is already one in the system. Duplicate charts pose severe
health risks to patients because not all medical data may be present in both charts.

○

To ensure that charts are merged in a controlled manner,
only MicroMD EMR users with appropriate access rights
can merge duplicate charts. Only users who have been
assigned the Merge Charts function can merge charts.

○

For those practices who merge patient accounts in
MicroMD PM, the system also merges the patient’s chart in
the EMR. Always remember to post any outstanding
pending charges in the MicroMD PM, associate any orders
to the patient chart you want to keep in the EMR, and
associate the correct insurance with outstanding orders.

For example, Betty created a chart for patient John Apple on his first visit. Her chart was under John Apple.
Dr. Davidson used this chart when he visited with John Apple that day and made some notes about John’s
adverse reaction to his last medication.
Jennifer, on a different day, created a different chart for John Apple but spelled his name incorrectly
(which is why she couldn’t find his chart). That new chart was under John Appel.
Dr. Webb used the new chart that Jennifer created (under John Appel) when she visited with John.
Unfortunately, Dr. Davidson’s notes about John’s medication reaction are in the chart that Betty created,
not the one Dr. Webb currently has open. During his visit, she prescribed him the medication to which he
had the adverse reaction. If John doesn’t tell Dr. Webb about his reaction, he could end up in the hospital
with more serious problems.

Merge Duplicate Charts
When you merge duplicate charts, MicroMD EMR maintains one of the charts and deletes the other. You
specify which chart to maintain and which chart to discard. Typically, you choose to maintain the chart
with the most accurate demographic data. When you merge the charts, MicroMD EMR copies information
from the chart that is to be discarded and inserts it into the chart that is to be maintained. (See page 10.24
for details on the data kept and the data discarded.)
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Merging duplicate charts is an irreversible process.
After two charts have been merged, they cannot be
separated into individual charts.
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Figure 10.14 Chart Merging Screen on Desktop



BEFORE YOU MERGE THE CHARTS, remember to print a
full report on the chart you want to remove, including
all information in the report (page 10.24).

To merge duplicate charts:

Procedure

Details

1. Verify that you have your Desktop displayed.
2. Click the Administration button and select
Chart merging from the available options.
3. In the Chart to be discarded section, click the
Lookup icon ( ) next to the Patient field.

The Select Patient window opens.

4. Select the patient chart you want to remove
from the system and click Insert.

MicroMD EMR inserts the patient’s name into the
Chart to be discarded field and displays details
about the patient in the yellow area.

5. In the Chart to be maintained section, click
the Lookup icon ( ) next to the Patient
field.

The Select Patient window opens.
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Procedure (continued)

Details (continued)

6. Select the patient chart you want to keep in
the system and click Insert.

MicroMD EMR inserts the patient’s name into the
Chart to be maintained field and displays details
about the patient in the yellow area.

7. Once you have verified that you have the
correct duplicate charts selected, click the
Merge button.

The Merge Patient Confirmation window opens
and displays all of the information the system will
transfer over to the chart you want to keep in the
system.

8. Review the information and place a check
mark in the Confirm merging of these patients
checkbox.

The system enables the Merge button.

9. Click the Merge button.

The Confirm Patient Merging dialog opens.

10. Type your MicroMD EMR password to confirm
the chart merge and click OK.

The system merges the charts you have selected.

11. Print a full report on the chart that you kept in
the system, including all available details.

See page 10.13 for more information on printing
the patient’s chart.

12. Compare the printout from the deleted chart
and the printout from the final merged chart
to reconcile duplicate or conflicting
information.



After you merge duplicate charts,
ensure that these changes are
reflected in all ancillary systems—
such as the associated Practice
Management System.

Information Copied and Deleted When Merging
When you merge duplicate charts, MicroMD EMR maintains one of the charts and deletes the other. What
MicroMD EMR does with the data depends on the type of data. Before merging duplicate charts, always
print a full report on the chart you want to remove, including all information in the report. Check the report
for duplicate and conflicting medical information after you merge the charts. For details on how to print a
chart, see page 10.13.
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Duplicate data can result after merging charts. For
example, if a patient had Asthma recorded in both
Chart A and Chart B, after the merge, Chart A will have
two entries for Asthma.
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Conflicting data can result after merging charts. For
example, if a patient had Asthma recorded in Chart A
and No history of Asthma recorded in Chart B, after the
merge, Chart A will have two conflicting entries for
Asthma.



Always review the chart after merging.

Demographic Information
All demographic information is maintained in the chart that is to be kept (Chart A). No demographic
information is kept from the chart that is to be discarded (Chart B).

Encounter Records
All encounter records are maintained from the chart that is to be kept. All encounter records are
copied from the chart that is to be discarded. For example, if there were four encounter records in
Chart A and five encounter records in Chart B, after merging, Chart A will have nine encounter records.

Medical Information
Type 1 medical information consists of Menarche information, Pregnancy Summary, Genetic
Screening, and Pediatric Development. For this type of medical information:

 If Chart A (the chart you want to keep) has any information in a given medical information
category (e.g., Pediatric Development information), the system keeps this data and discards any
corresponding data in Chart B (the chart you want to delete).

 If Chart A (the chart you want to keep) has no information in a given medical information
category (e.g., Pediatric Development information), the system copies this information (if it
exists) from Chart B (the chart you want to delete).
Type 2 medical information is all other medical information not included in Type 1. For this type of
medical information:

 The system maintains all medical information from Chart A (the chart you want to keep)
 The system copies all medical information from Chart B (the chart you want to delete).
For example, if a patient has three problems recorded in Chart A and two problems recorded in Chart
B, after the merge, Chart A will have five problems.



Duplicate data can result after merging charts. For
example, if a patient had Asthma recorded in both
Chart A and Chart B, after the merge, Chart A will have
two entries for Asthma.
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Conflicting data can result after merging charts. For
example, if a patient had Asthma recorded in Chart A
and No history of Asthma recorded in Chart B, after the
merge, Chart A will have two conflicting entries for
Asthma.



Make sure to review the patient’s Medical Information
tab after merging to remove duplicates and conflicting
entries.

Patient Reminders
A patient reminder is a note attached to a patient’s chart and sent to a user to alert them about something
pertinent in the patient’s chart. You can also use Patient Reminders to send letters to patients in the
Recall/Reminder Builder (page 6.3). When a patient has reminders associated with their chart, the
Reminder icon ( ) in the patient’s chart header animates. Simply click this icon to access the Reminder
Manager window (Figure 10.16).

Figure 10.15 Patient Reminders Notification
For example, Betty received a radiology report for patient Andy Homer in which Dr. Webb requested that
the patient repeat the X-ray in three months’ time. Betty created a reminder to contact Andy about the Xray follow-up three months from now. When the practice processes their recalls and reminders in three
months, Andy’s reminder will go out.
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Figure 10.16 Patient Reminder Manager



You can also access the patient’s list of reminders
through the Workflow Communication window
(page 10.19).

Patient reminders provide a system whereby you can maintain a log of the plans and instructions that the
patient is required to undergo outside the practice. This log is especially important in the managed-care
environment where it is often required by the insurers. The insurers use the logs to avoid unnecessary
referrals and for their utilization reviews.
Most reminders concern issues such as immunization requirements, reviewing results of laboratory tests,
and reviewing results of prescribed procedures. However, a reminder can relate to anything that is relevant
to a particular patient. Although reminders are usually created during an encounter, you can create a
reminder at any time. When you create a patient reminder, the system attaches that reminder to the
patient’s chart. You can also send the reminder to a specified MicroMD EMR user, including yourself, so that
it appears on that user’s Desktop (page 4.17).
You can filter the list to show just the open reminders for a patient (check the Show open reminders only
checkbox), or you can filter the list to display only reminders with a future date in the Activate on field
(check the Show future reminders checkbox).

 To view a reminder, you can double-click the reminder or simply highlight the reminder and
click the View button.

 To add a new reminder for this patient, click the Add button and complete the fields on this
window.

 To remove the reminder from patient’s chart, highlight the reminder and click the Delete
button.

 To print the reminder, click the Print button.
 To “terminate” a reminder, highlight the reminder and click the Done button. When the
requirements of a reminder have been fulfilled, the owner of the reminder can change the status
of the reminder from Open to Done. This is known as terminating a reminder.

○

The person to whom a reminder was sent is the owner of
the reminder.
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A reminder that has the status Done is still part of the patient's chart. When a reminder is no
longer required at all, the owner of the reminder can delete it from the patient's chart.

○

A user with the role Administrator can change the status
of any reminder to Done and can delete any reminder.

Patient Alert Note
The Patient Alert Note is simply a sticky note attached to the patient’s chart. You can use this note in any
way you choose. There is no history with this note, and any changes you make overwrite the existing text
within the note.

Figure 10.17 Patient Alert note
The Patient Alert Note icon in the patient’s header changes depending if there is content in the alert note:

 If the icon looks like a piece of paper (

), there is no note contained with the note.

 If the icon looks like a piece of paper with a pencil (

), someone has written a note on this

patient’s chart.

Adding Text to the Patient Alert Note
When you click the icon to open the note, simply type the message you want to convey to the person who
opens the note and click the Accept icon ( ). The message window closes and the icon in the patient’s
header changes.



If you want to undo your recent typing AND you have NOT
clicked the Accept icon yet, you can click the Reset icon
( ) to go back to the original text.

Clearing a Patient Alert Note
If you want to remove the Patient Alert Note, simply open the note, highlight the text, press the Delete
button on your keyboard, and click the Accept icon ( ).
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Typically, the receptionist manages the schedule for providers in the practice. If you have a fairly large
practice with several receptionists capable of scheduling appointments, MicroMD EMR is robust enough to
handle your needs. To manage the schedules of others, a MicroMD EMR user must have the role of
receptionist and be assigned as the receptionist to the users whose schedules the receptionist is to
manage.



If your EMR system receives appointment information
electronically from your practice management system,
DO NOT USE MicroMD EMR to add new appointments or
to edit or delete existing ones. You must use the
practice management system to perform all of these
functions. The practice management system sends all
appointment information to the EMR.



If you have issues with appointments not appearing in
the EMR, please see page 4.46 for details on unidentified
appointments as a possible solution.

In This Chapter
In this chapter, we cover how to:

 Set up appointment schedules (page 11.3)
 Schedule appointments (page 11.16)
 Search for existing appointments (page 11.21)
 Search for available time slots (page 11.22)
 Print and send appointment reminders (page 11.24)
 Manage multiple appointment schedules (page 11.26)
 Print appointment schedules (page 11.27)
 Manage on-call schedules (page 11.29)
 Check patients in (page 11.36)
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Overview

Overview
All MicroMD EMR resources—both users and facilities—can have their own appointment schedules. The
Appointment Book allows you to manage these schedules. You can access the Appointment Book in a
variety of ways. You can set MicroMD EMR to prompt you to choose which module you want to open each
time you log in (page 1.87). If you already have MicroMD EMR open, you can simply click the Appt Book tab.
You could also click the Appt Book icon ( ) on the top toolbar.

Figure 11.1 Appointment Book

○

You can specify that you do not want to use the MicroMD
EMR Appointment Book to manage an appointment
schedule for a specific MicroMD EMR user. This is
useful when the user is a receptionist who manages
appointment schedules for other resources only. For
more details on displaying appointment schedules,
see page 11.26.

All MicroMD EMR users can access their own appointment schedules. In addition, a user who has the role of
Receptionist can access the schedule of any resource for which they have been designated as the
receptionist. You assign the role of Receptionist using the MicroMD EMR Manager. You can also indicate for
whom the person is a receptionist. For details on maintaining multiple appointment schedules under a
single receptionist user, please see page 1.22.
For example, Betty Lopez is responsible for managing the appointment schedules for three physicians. If
Betty’s user role is Receptionist for each of the three physicians, she can schedule appointments for all
three physicians.
The MicroMD EMR Appointment Book contains six tabs. Each tab presents a different view of an
appointment schedule and gives you access to an appropriate set of functions in the Navigation Panel:

 Day View
The Day view displays one day of the appointment schedule. You can add new appointments,
edit and delete existing appointments, and check in patients.

 Week View
11.2
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The Week view displays an entire week of the appointment schedule. You can add new
appointments, edit and delete existing appointments, and check in patients.

 Month View
This view displays a calendar for a single month and allows you to quickly open an appointment
schedule to a specified date. You can also manage the on-call schedules for your practice.

 Year View
With this view, you can display a calendar for an entire year and quickly open an appointment
schedule to a specified date. You can also use this view to display annual vacation days. Annual
vacation days include both national holidays and private vacation days.

 To Schedule View
This view allows you to manage unscheduled appointments. Unscheduled appointments range
from patients you add to a waiting list to appointments you need to reschedule. You can add,
edit, and delete these “unscheduled” appointments.

 MultiUser View
The MultiUser view allows you to simultaneously see one day of the appointment schedule of
numerous resources. The MultiUser view shows the schedules of some or all those resources for
which you are a receptionist, depending on your settings. You can specify which schedules to
display by using the Appointment Book Setup wizard (page 11.14) or selecting Appointments >
Edit Multiple ApptBook List from the main menu (page 11.26).

○

The MultiUser tab appears only if you have the role
Receptionist. For details on user roles, see page 1.16.

Setting up an Appointment Schedule
Before you can schedule appointments, you need to set up all appointment books for those users or
facilities for whom you will schedule appointments. This is only true if you are the receptionist for several
users or if you want to set up your own appointment schedule. You establish the resource’s availability,
vacation days and more.



You can use the Appointment Book Setup Wizard to set
up a new appointment schedule or to make changes to
an existing schedule.

Establish the Resource’s General Availability
The master availability schedule defines the times when a user or facility is available and when they are
not. You define the availability schedule for a typical week for user or facility. When you display an
appointment schedule for the resource, the Appointment Book superimposes the appointment schedule
over the availability schedule for that resource. This allows you to easily see when you can schedule
appointments and when you can’t.
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Figure 11.2 Resource Availability
The Availability Schedule is composed of time blocks. Each time block represents either available time or
unavailable time. For each available time block, you can specify the location (clinic and department)
where the resource is available for appointments.

○

Each MicroMD EMR user can view and edit his or her own
availability schedule. In addition, a receptionist can view
and edit the availability schedule of each resource for
which he or she is the receptionist. Be aware of any
possible conflicts.

You can edit or delete existing time blocks in the resource’s schedule. Simply place your cursor in the time
block and click the Edit or Delete button as appropriate. To clear an entire week’s availability schedule,
simply click the Clear All button.
he Appointment Type is indicated on the schedule in the Appointment Book for the available days and
times that are highlighted on the schedule.
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Figure 11.3 Appointment Type on the Appointment Note

Mapping Appointment Types Between the PM and EMR Programs
When PM is interfaced to EMR, the Map to PM field appears on the New Appointment Type window where
the Appointment Types can be mapped.

Figure 11.4 Mapping a PM Appointment Type to an EMR Appointment Type
To map a PM Appointment Type to an EMR Appointment Type, select the PM Appointment Type at the
Appointment Type field and then select the EMR Appointment Type at the Map to PM field and click OK.



Only Appointment Types from the MicroMD PM software
can be mapped to EMR Appointment Types. This does
not apply to other Practice Management systems.
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To establish the Availability Schedule for a resource:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button (

).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).


3. Select Appointments > Availability
Schedule Editor from the main menu.
4. For the appropriate day of the week, highlight
the starting time slot for which you want to set
the availability.

If you are not a Receptionist, you do
not have this drop-down.

The Availability Schedule Editor window opens
(Figure 11.2).



Use the horizontal scrollbar to view
Saturday and Sunday.

5. Click Add.

The Add Scheduled Time-Block window opens.

6. Complete the fields on the window and
click OK.

Table 11.1 explains these fields in detail. Once you
click OK, the system displays the time block in the
selected slots.

7. Repeat step 4 through step 6 for each time
block you want to specify.
8. Click OK when finished with establishing the
resources typical weekly availability.
Table 11.1 Fields on the Add Scheduled Time-Block Window

Field

Description

Begin time and
End time

In the Begin time field, enter the starting time for the time block you want to
specify. In the End time field, enter the time this availability block of time is
over.
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Table 11.1 Fields on the Add Scheduled Time-Block Window (continued)

Field

Description

Availability

From this drop-down, select whether this block of time is available for
scheduling or not. This drop-down also allows you to indicate if the resource
is generally unavailable except for emergencies.

Location

From this drop-down, select the appropriate practice location for this block of
time.

Appt Types

The Appt Types field allows you to list the types of appointments that users
can schedule during this time block.

Comment

Enter any useful information about this available (or unavailable) time block.

Establish Your Appointment Type List
Once you have established the Availability Schedules for each of your resources, you should then establish
your Appointment Type Common List. MicroMD EMR allows you to define different types of appointments
for the practice (i.e., appointment classes or categories). You can then assign a type to each appointment
to help facilitate the patient’s visit through the practice. Examples of appointment types include Followup, Well Visit, Sick Visit and Physical Therapy. The entries in your Appointment Type Common List are the
only entries that appear in the Appt Type drop-down on the Add Appointment window (Figure 11.10 on
page 11.17) when you schedule a new appointment.

Create Your Appointment Type Common List
The system includes a master list of appointment types. This master list is available to all MicroMD EMR
users in the practice. All users can add new types to the list; however, only those with Add reference
data checked in their user functions can edit existing entries. Only those users with access to the
MicroMD EMR Manager can delete entries from the database. (See page 1.16 for more details on user
functions.)

Figure 11.5 Appointment Type Manager
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○

Setting up an Appointment Schedule

Even though a receptionist modifies the schedules for
multiple users, his or her Common List of appointment
types is independent of the resources for which he or she
schedules appointments.

To establish your Appointment Types:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select Appointments > Appointment Type
Manager from the main menu.

The Appointment Type Manager window opens
(Figure 11.5 on page 11.7).

3. Click the All button to display all
appointment types in the system.
4. Search for and highlight the type you want
available to you when scheduling
appointments for all your resources.

5. Click the Add to Common List button.



The number in brackets at the
beginning of the type’s name (e.g.,
[45]) is the amount of time slotted for
the appointment (e.g., 45 minutes).

This type is now available in the Appt Type dropdown when scheduling a new appointment.

6. Repeat step 4 and step 5 for each
appointment type you want to make
available.
7. Click OK when finished.

Adding and Editing Appointment Types
If the list of appointment types does not suit your needs, you can edit existing entries to fine tune them
appropriately, or you can add new ones to the list if you cannot use any of the entries at all. For
example, if your usual time slot for the existing Follow-up Appointment Type is 10 minutes, not 15, you
need only change the duration of the type to 10 minutes.

Figure 11.6 Appointment Type Editing
11.8
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For each type of appointment, there is a length of time associated with that appointment. The
appointment length is set in minutes. Whenever you enter a new appointment into an appointment
schedule and select a type from the Appt Type drop-down, the system automatically sets the number
of slots in the schedule for the appointment based on the minutes entered in the type’s Duration field.
For example, Betty at Summervale Medical Center defines her New Patient appointment type as 45
minutes long. The practice’s slot length is set to 15 minutes so each New Patient appointment takes
up three (3) slots in the schedule.

○

If the number entered for the appointment type is not an
exact multiple of the slot length, the Appointment Book
rounds the length of the appointment up to the next exact
multiple. For example, assume that you have a slot length
of 15 minutes. If you create an appointment for an
appointment type that is 40 minutes long, the length of
the appointment is rounded up to 45 minutes.

To edit an existing appointment type, highlight the entry and click the Edit Type button. Only those
users with Add Reference Data checked in the MicroMD EMR Manager under their user functions can
edit an appointment type.
To add a new type of appointment:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select Appointments > Appointment Type
Manager from the main menu.

The Appointment Type Manager window opens
(Figure 11.5 on page 11.7).

3. Click the New Type button.

The New Appt Type window opens (Figure 11.6
on page 11.8).

4. Enter the details of the appointment type
and click OK.

Table 11.2 explains the fields on the window in
detail.
The system adds the new type to the master list.
You then need to add this to your Common List
to make it available to you.

Table 11.2 Fields Available on the New Appointment Type Window

Field

Description

Appt. Type

Enter a useful name for the new appointment type. This is the text that
appears in the drop-down when scheduling a new appointment.

Encounter Category

Select the category you want to associate with this appointment type. This
sets the default for the encounter when a provider creates a new encounter
for an appointment associated with this type.
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Table 11.2 Fields Available on the New Appointment Type Window (continued)

Field

Description

Duration

Enter the number of minutes the system should allot for this type of
appointment. Based on the number of minutes entered here and the slot
length you have specified for this schedule (page 11.12), MicroMD EMR
automatically fills the appropriate number of slots for an appointment of this
type.

Patient Instructions

If you enter text in this field, the system includes these instructions on all
related patient reminders that you print. For example, if you want the patient
to fast before their lab appointment, type No food or drink for 12
hours before your appointment. This helps us get an
accurate reading of your true blood sugar level. This
text then prints in the patient’s reminder (page 10.26).

Establish Personal Vacation Days for the Resource
Private vacation days are days on which the user is on vacation or the facility is unavailable. Private
vacation days can be either Professional or Personal. You use the Year tab of the Appointment Book to
view the resource’s private vacation days. These appear in red on the calendar. These days also appear as
red on the Day, Week and Month tabs, although it is easier to get an overall picture using the Year tab You
use the Vacation Day Manager to establish the resource’s private vacation days.

Figure 11.7 Private Vacation Day Manager

○

Each MicroMD EMR user can manage his or her own list of
private vacation days. In addition, a receptionist can
manage the list of private vacation days for each resource
for which he or she is the receptionist.

Along with private vacation days, the practice also has its holidays where the office is closed for business.
These days appear in blue on the Year tab. You use the MicroMD EMR Manager to set and maintain Practice
Holidays (page 1.43).
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To establish the resource’s private vacation days:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button (

).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).



If you are not a Receptionist, you do
not have this drop-down.

3. Select Appointments > Vacation Day
Manager from the main menu.

The Private Vacation Day Manager window opens
(Figure 11.7). You can also click the Vacation Day
Manager link in the Appointment Book Tools
section of the window.

4. Click the Add button.

The Private Vacation Days window opens.

5. Complete the fields on this window and
click OK.

The system adds the vacation day to the list. Table
11.3 explains the fields of the window in detail.

6. Repeat step 4 and step 5 for each private
vacation day you want to add to the
resource’s schedule.
Table 11.3 Fields on the Private Vacation Days Window

Field

Description

Start date

Enter the first day of the resource’s vacation.

Number of days

Enter the length of the vacation time for this entry. The system takes this
number of days and applies it to the date in the Start Date field. The system
then marks the resource’s calendar accordingly.

Vacation type

Select either Personal or Professional. This is for reference purposes only.
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Table 11.3 Fields on the Private Vacation Days Window (continued)

Field

Description

Show time as

From this drop-down, indicate whether the resource is out of the office during
this vacation period, observing normal business hours during the period, or
only available for emergencies during the vacation period.

Recurs annually

If this vacation period spans the same date range every year for this resource,
choose Yes. If not, choose No. This makes it easier to update the resources
vacation days in years to come.

Message

Type a useful description of this vacation period. This text appears at the
bottom of the Year tab when you click the date on the calendar.

Establish Any Miscellaneous Settings
Miscellaneous settings include the slot length and which appointment books you would like to display on
the MultiUser tab.

Setting Slot Length for a Schedule
Physicians and other resources typically work with fixed-duration time slots for all their appointments.
When you schedule a new appointment, you use time slots to define the length of the appointment.
For example, Dr. Davidson at Summervale Medical Center prefers to schedule his patients in 15-minute
time slots or multiples of 15 (i.e., 30-minute appointments or two time slots, 45-minute appointments
or three time slots, etc.).




If you want to use the MultiUser tab for scheduling, the
system takes the slot length of the resource selected
using the resource button (
appointment book.

) at the top of the

You can specify a different slot length for the
appointment schedule of each MicroMD EMR user and
facility.

To set the slot length:

Procedure

Details

1. Verify that you have the Appointment
Book displayed.
2. Select the appropriate resource from the
resource drop-down button (

).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).


11.12

If you are not a receptionist, you do
not have this drop-down.

MicroMD EMR User’s Reference Manual Version 16.0

Setting up an Appointment Schedule

Chapter 11. Appointments Module

Procedure (continued)

Details (continued)

3. Select Appointments > Set Slot Length
from the main menu.

The Set Slot Length window opens and displays the
current slot length for the resource.

4. Select the appropriate length from the
drop-down and click OK.

The appointment schedule for the resource adjusts
accordingly and displays the new schedule times.

Modify Which Schedules Display on MultiUser Tab
Depending on your needs, you may not need to view all of the schedules for which you are the
receptionist. If you are the receptionist for some schedules only as a backup or maybe there are
schedules that you do not access every day, you can choose to display only those schedules that you
need to access regularly. The system allows you to adjust your appointment books to a more
manageable display. By default, the system displays all of the schedules for which you are the
receptionist.



If you want to use the MultiUser tab for scheduling, the
system takes the slot length of the resource selected
using the resource button ( ) at the top of the
appointment book.

To edit which appointment books MicroMD EMR displays:

Procedure

Details

1. Verify that you have the Appointment
Book displayed.
2. Click the MultiUser tab.
3. Select Appointments > Edit Multiple
ApptBook List from the main menu.
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Procedure (continued)
4. Place a check mark in the Display column
for each appointment schedule you want
available on the MultiUser tab.

Setting up an Appointment Schedule

Details (continued)



To reorder the schedules from left to
right on the tab, highlight the entry
and use the up and down arrows (
and ).

5. In the Maximum number of schedules
visible simultaneously field, enter how
many you want displayed on the screen at
one time.

The system displays all of the schedules with a
check mark in the Display column. If the number
of schedules exceeds the number you indicated
here, the system displays a horizontal scrollbar at
the bottom of the tab so you can access the
remaining schedules easily.

6. Click OK when finished.

The system adjusts your MultiUser tab
accordingly.

Appointment Book Setup Wizard
You have learned all about the various settings required to establish a working appointment schedule for
each resource. The Appointment Book Setup Wizard provides all of these tasks within a useful tool that
steps you through the process quickly.

Figure 11.8 Appointment Book Setup Wizard
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To use the Appointment Book Setup Wizard:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button (

).

3. Select Appointments > Appointment Book
Setup Wizard from the main menu.

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).
You can also click the Appointment Book Setup
link in the Appointment Toolbox or click the
Appointment Book Setup Wizard icon ( ) on
the top toolbar.
The wizard window opens (Figure 11.8).

4. Establish the resource’s availability schedule
and click Next.

See page 11.3 for more details.

5. Define your Common List of appointment
types and click Next.

See page 11.7 for more details.

6. Create the list of private vacation days for this
resource and click Next.

See page 11.10 for more details.

7. Establish any miscellaneous settings and
click Finish.

See page 11.12 for more details.

Appointment Book Toolbox
When you display the Appointment Book in the MicroMD EMR Application Work Space, MicroMD EMR
displays an appropriate set of tools in the Appointment Book Toolbox. These tools are available no matter
which tab you choose in your appointment book.

Figure 11.9 Appointment Book Toolbox
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○

Scheduling Appointments

Unlike the Desktop Toolbox, you cannot add or remove
any tools from the Appointment Book Toolbox.

Table 11.4 Appointment Book Tools Available

Tool

Description

Find Patient
Appointment

Click this link to locate existing appointments for a specific patient and their
family members (page 11.21).

Find Slot

Click this link to search an appointment schedule to find open appointment
slots (page 11.22).

Appointment Book
Setup

Click this link to set up or edit the appointment schedule for a resource
(page 11.14).

Vacation Day
Manager

Click this link to manage the private vacation days in each resource’s
appointment schedule (page 11.10).

Print Schedule

Click this link to print appointment schedules for the resources in your practice
(page 11.27).

Scheduling Appointments
Once you have all of your providers’ schedules established and your display just how you want it, you can
begin to schedule patients. Once you make an appointment, you can see the patient’s name displayed in
the time slot(s). You can double- or triple-book appointments if needed. Simply create multiple
appointments in the same time slot.
The Appointment Book allows you to schedule appointments for patients, but it also allows you to
schedule other non-patient appointments, such as meetings or other time not involving a patient.



11.16

If your EMR system receives appointment information
electronically from your practice management system,
DO NOT USE MicroMD EMR to add new appointments or
to edit or delete existing ones. You must use the
practice management system to perform all of these
functions.
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Figure 11.10 Appointment Window
To schedule a new appointment:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button ( ).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).



If you are not a receptionist, you do
not have this drop-down.

3. Double-click inside the appropriate time slot.

The Add Appointment window opens (Figure 11.10
on page 11.17). You can also place your cursor in
the time slot and click the New Appointment icon
( ) on the top tool bar or select Appointments >
New from the main menu. You can also right-click
the time slot and select New from the pop-up
menu.

4. From the Appointment Class section, select
whether this is a Patient appointment or a
Non-Patient appointment.

The system displays the appropriate fields in the
Appointment Details section of the window.
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Procedure (continued)

Scheduling Appointments

Details (continued)

5. Edit the fields in the When section if necessary. The system defaults to the date, time and number
of slots you chose on the schedule. Use the Find
Slots button to search the entire schedule for open
slots. See page 11.22 for more details on the Find
Slots feature.
6. Enter the patient’s name in the Patient field.

The system displays the Select Patient search
window if it does not find an exact match to the
text you typed or if it has found multiple matches. If
you need to enter a new patient, click the New
Patient button to create a new chart.


7. Complete the remaining fields in the
Appointment Details section and click OK.

If you have a practice management
system communicating with your
EMR, DO NOT enter patients using
the EMR. Use your practice
management system.

The system adds the appointment to the
appointment book based on the information you
entered. Table 11.5 explains the fields on this
window in more detail.

Table 11.5 Fields on the Add Appointment Window

Field

Description

Appointment Class Section
Patient

Choose Patient from this section if this is an appointment for the patient.
Patient appointments can have appointment types, referrals and reminder
information.

Non-Patient

Choose Non-Patient if this appointment is not for a patient. Typically, nonpatient appointments are meetings the physician has to attend or other types of
time not involving a specific patient.
For example, Dr. Davidson has a meeting with some medical students on
November 7, 2019, at 11:00 a.m.

When Section
Appt. Start

Enter the start time for the appointment. This date defaults to the time and date
of the time slot you chose when creating the new appointment. If you need to
choose a different time and/or date, you can do so from here. Simply choose
the correct time from the drop-down and use the calendar icon to choose the
correct date.

Appt. Length

Enter the number of time slots you want to schedule for this appointment. This
field changes if you select an Appointment Type with a specified number of
minutes. The system automatically calculates how many slots needed for the
appointment type.
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Table 11.5 Fields on the Add Appointment Window (continued)

Field

Description

Find Slots

If you need to search for open slots instead of scheduling in the current time
slot, click the Find Slots button. See page 11.22 for details on this feature.

Appointment Details Section – Patient Appointment
Urgent

Place a check mark in this box if the appointment is pressing in nature. When
you mark this checkbox, the system displays a red exclamation point ( ) in the
appointment schedule next to the patient’s name.

Patient

Select the patient for whom you want to schedule the appointment. You can
type the patient’s last name and press Enter. The system displays the Select
Patient search window so you can locate the patient. You can also click the
Lookup icon ( ) to open the Select Patient window right away and search for
the patient.

New Patient

If this is a brand-new patient that is not in the system, click the New Patient
button and create a new chart for the patient. You cannot create a new
appointment unless the patient is in your database.


Appt. Type

If you have a practice management system
communicating with your EMR, DO NOT enter
patients using the EMR. Use your practice
management system to enter new patients.

Select the type of appointment you want to schedule. The only entries that
appear in this list are those that appear in your Appointment Type Common
List. (Please see page 11.7 for more details on creating your Common List for
Appointment Types.) Once you choose an Appointment Type, the system
adjusts the Appt. Length field based on the number of minutes established for
the Appointment Type.



You can use the Lookup icon ( ) next to the dropdown to choose a type that doesn’t appear in your
drop-down or to add to your Common List right
from here.

Appt. Status

Select the current status of this appointment. Typically, if this is a brand-new
appointment, you want to choose Unconfirmed. You can generate a report
based on the PATIENT APPOINTMENTS template using the status field. This
could help you call patients to confirm their appointments.

Location

Select where the patient should go for their visit. This Location list includes only
those departments associated with the resource and defaults to the user’s
current location (under Tools > User Preferences). See page 1.15 for details on
how to associate a resource with a department.

Results to

This feature is currently not in use.
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Table 11.5 Fields on the Add Appointment Window (continued)

Field

Description

Referral

If you have any incoming referrals created for the patient, the system displays
those orders in this drop-down. If the creator of the incoming referral added an
authorization number, that number displays in the drop-down. If there is no
authorization number, the system displays the specialist’s name who referred
the patient to you.
If you want to create a new incoming referral order from the appointment,
simply select < new referral> from the drop-down list. This opens the Referral-in
Order window. See page 4.31 for details on completing this window.

Patient Instructions

If you enter text in this field, the system includes these instructions on all related
patient reminders that you print. For example, if you want the patient to
remember to fast for 12 hours before their lab appointment, type No food or
drink for 12 hours before your appointment. This helps
us get an accurate reading of your true blood sugar
level. This text then prints in the patient’s reminder (page 10.26).



If you select an Appointment Type for this
appointment that has text in the Patient
Instructions field, the system defaults the Patient
Instructions field of the new appointment with that
text. You can change as needed. See page 11.7 for
more on associating patient instructions with a type.

Comment

Enter any additional information about the appointment. The system prints the
comment when you print an appointment reminder.

Remind patient
about appointment

Click this button to send an electronic reminder to the patient about this
appointment. This opens the Patient Memo window and allows you to specify
the details of the message. Please see page 11.24 for more information about
sending appointment reminders.

Formularies

Use this button to display the patient’s prescription eligibility or to manually
launch the eligibility check. See page 21.40 for more details on the e-Prescribing
module.

Patient Alert Note

Click this icon to open the Patient Alert Note window (page 27.6). To increase
communication with all parts of your practice, this editable patient alert
window appears in the header of every patient’s chart, in Scheduled Visits, in
the patient’s appointment, and in the floating toolbar of MicroMD PM.

Appointment Details Section – Non-Patient Appointment
Description

Enter a useful title for this appointment. The text you type here displays on the
appointment schedule. For example, type Meeting with Interns for Dr.
Davidson’s meeting with his group of students.

Comment

Enter any additional information about the appointment. The system prints the
comment when you print an appointment reminder.
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Editing an Appointment
You can change the details of any future appointment; you cannot edit the details of an appointment that
has already passed. You can, however, change the status of an appointment that has already passed.
To change the details of an appointment, simply open the appointment and change the details as
appropriate. You can also place your cursor in the appointment and select Appointments > Edit from the
main menu. If you prefer, you can right-click the appointment and select Edit from the pop-up menu. You
can also place your cursor in the appointment and click the Edit Appointment icon ( ) on the top
toolbar.

Deleting an Existing Appointment
You can delete any future appointments from an appointment schedule that you manage. You cannot
delete an appointment on a date that has passed or for a patient who has already checked in.
To delete an existing appointment, you can place your cursor in the appointment and select Edit > Delete
from the main menu. If you prefer, you can right-click the appointment and select Delete from the pop-up
menu. You can also place your cursor in the appointment and click the Delete Appointment icon ( ) on
the top toolbar.

Moving an Appointment
MicroMD EMR allows you to move any existing future appointments in any appointment schedule that you
manage. You can move the appointment to another time on the same day, to another day, or even to the
appointment schedule of another resource.
To move an appointment, you can place your cursor in the appointment and select Edit > Move from the
main menu. If you prefer, you can right-click the appointment and select Move from the pop-up menu.
Enter the details and click OK.



You can also move an existing appointment by dragging
the thick upper border of the appointment to the
required location.

If you want to move an appointment between resource schedules, click the MultiUser tab. You can then
drag and drop the appointment to the new time slot on the other resource schedule. See page 11.26 for
more details about working with multiple schedules.

Searching for Existing Appointments
MicroMD EMR provides practices with the ability to view a list of appointments for specific patients,
including those for their family members. Make sure you have the appropriate resource selected and click
the Find Patient Appointment link in the Appointment Toolbox. You can also click the Find Patient’s
Appointments icon ( ) on the top toolbar or select Appointments > Find Patient’s Appointments from
the main menu.
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Figure 11.11 Find Appointments Window
Staff members can search for existing for the patient, as well as for their family members, including past
appointments. To view a list of the patient’s appointments across all resources, place a check mark in the
Include all appointment books checkbox. Double-click an entry to open the schedule for the day of that
patient’s appointment (or click the Go to Appointment button).

Finding Available Appointment Slots
When you need to schedule an appointment but are having a tough time finding any open slots, let
MicroMD EMR do the search for you. To search for available appointment times quickly, make sure you
have the appropriate resource selected and click the Find Slots link in the Appointment Toolbox.

Figure 11.12 Find Available Slots Window
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This feature only works if you have established the
resource’s Availability Schedule (page 11.3).

To search for open slots and schedule an appointment:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button ( ).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).


3. Click the Find Slots link in the Appointment
Toolbox.

If you are not a receptionist, you do
not have this drop-down.

You can also click the Find Available Slots icon ( )
on the top toolbar or select Appointments > Find
Available Slots from the main menu.
The Find Available Slots window opens (Figure 11.12).

4. In the Criteria section of the window,
indicate the kind of time slot you want to
find.

This includes how many time slots the appointment
needs to cover; if the patient needs to see the
resource when he, she or it is at a specific location; or
to limit the search to those open slots labeled as a
certain appointment type.

5. In the When section of the window, narrow
the slot search to specific days, times and at
what point in the calendar to start the
search.
6. Click the Find now button.

The open slots that meet the selected criteria appear
in the lower portion of the window. If no open slots
are available for the selected dates or times, widen
the scope of your search.
MicroMD EMR initially searches for and displays
available appointment slots that occur within one
week of the specified Starting point. If no available
slots are found, MicroMD EMR continues to search up
to four weeks from the specified Starting point for
available slots.
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Click the Find More button to find
additional slots. Each time you click the
button, MicroMD EMR searches an
additional seven-day period for available
appointment slots that meet the criteria.
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Procedure (continued)

Details (continued)

7. Highlight the slot you want to schedule and
click the Go to slot button.

You can also double-click the entry row.

8. Schedule the appointment.

See page 11.16 for details on scheduling
appointments.

MicroMD EMR takes you to the appointment schedule
for the selected day.

Printing Appointment Reminders
When you schedule an appointment for a patient while they are still in the office (or even if you are on the
phone with them), you can print the reminder document to hand to them in person or send it through the
mail.
To print an appointment reminder:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button ( ).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).



If you are not a receptionist, you do
not have this drop-down.

3. Locate and highlight the patient’s
appointment.
4. Select Print > Print Appointment Reminder
from the main menu.

You can also right-click the appointment entry and
select Print Reminder from the pop-up menu.

5. Click OK to print the reminder.

Sending an Appointment Reminder to a Patient
MicroMD EMR allows you to send notification to a patient to remind them about a future appointment. The
reminder can be an e-mail message or a phone call. When you create a reminder, you specify the exact text
of the reminder to be sent. You can also have the system delay the reminder based on your choice in the
Activate on drop-down in the reminder window.

 E-mail Reminders: MicroMD EMR sends an e-mail reminder about the appointment to the
patient’s e-mail address. The system can also send the reminder to an additional carbon-copy
address (CC). You establish your practice’s e-mail reminder system under the Communications
button in the MicroMD EMR Manager (page 1.53). You must also have a patient’s e-mail address
entered on their demographics window (page 9.5).

 Phone Reminders: When you have a telephony interface, MicroMD EMR can make a telephone
call to remind the patient about an appointment. You set up this kind of interface in the
MicroMD EMR Manager under the Communications button (page 1.53).

 SMS Reminders: This feature currently not in use.
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To send an appointment reminder to a patient:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button ( ).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).



If you are not a Receptionist, you do
not have this drop-down.

3. Locate and open the appointment for which
you want to send a reminder.

The Edit Appointment window opens (similar to
Figure 11.10 on page 11.17).

4. At the bottom of the Edit Appointment
window, click the Reminder icon ( ).

The Patient Messages and Memos window opens.

5. Enter the reminder details and click OK.

Table 11.6 explains the fields on this window in
detail. The fields available vary depending on the
transmission method chosen.

6. Click OK to close the Edit Appointment
window.
Table 11.6 Fields on the Patient Messages and Memos Window

Field

Description

Patient

This field defaults to the patient whose appointment you opened. This is the
patient that will receive the reminder. If no patient name appears, click the
Lookup icon ( ) next to the Patient field and select the appropriate patient.

Activate on

This is the date on which MicroMD EMR will activate the reminder. By default,
this is today’s date. You can change this field if needed.

Date Created

The system displays the date on which the reminder was first created. You
cannot edit the creation date.
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Table 11.6 Fields on the Patient Messages and Memos Window (continued)

Field

Description

Deliver By

Select the appropriate type of reminder from this drop-down. The fields in the
bottom portion of the window change based on this choice. There are three
choices: Phone and Other.

Phone

This option is available only when you choose Phone from the Deliver By dropdown menu. Enter the phone number that the system should pass to the
telephony interface for calling the patient. By default, MicroMD EMR inserts the
patient’s home phone number from the patient’s chart.

To

This option is available only when you choose Other from the Deliver By dropdown. Specify the recipient of the reminder. By default, MicroMD EMR inserts
the patient’s e-mail address from the patient’s chart.

CC

This option is available only when you choose Other from the Deliver By dropdown. Enter a name to which you want MicroMD EMR to send a copy of the
appointment reminder.

Subject

This option is available only when you choose Other from the Deliver By dropdown. Enter a short description of the reason for the reminder. This appears as
the subject line of the message sent to the patient.

Message

Enter the text of the message you want MicroMD EMR to send to the patient,
regardless of the transmission method chosen.

Multiple Appointment Schedules
The MicroMD EMR Appointment Book allows receptionists to manage appointment schedules for multiple
resources. This is particularly useful in a scenario where one person is responsible for managing schedules
for a number of other users and facilities. For setup information, please see page 11.13 for details on
defining which schedules to display.
For example, Betty Lopez is responsible for managing appointments for three physicians: Dr. Davidson, Dr.
Kumar and Dr. Webb. When Betty’s user account was established, she was assigned as the receptionist for
these three providers. This allows her to access and manage their appointment schedules.

○

Only a MicroMD EMR user with the role of Receptionist
can access the appointment schedule of other MicroMD
EMR users and resources (page 1.16).

You can use the resource drop-down arrow ( ) on any of the tabs to view individual schedules, or you
can use the MultiUser tab to view several schedules at once. The MultiUser tab of the MicroMD EMR
Appointment Book allows receptionists to work with multiple appointment schedules.
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Figure 11.13 MultiUser Tab
By default, the system displays all of the schedules for which you are the receptionist. Depending on your
needs, you may not need to view all of the schedules for which you are the receptionist. If you are the
receptionist for some schedules only as a backup or maybe there are schedules that you do not access
every day, you can choose to display only those schedules that you need to access regularly. Once you edit
this display order, the system displays only what you tell it to display (page 11.13).
The MultiUser tab displays only a daily view of the appointment schedules and has the same basic
functionality as the Day tab. You can use the MultiUser tab to:

 Create, edit, move, and delete appointments
 Search for existing appointments
 Find available appointment slots
 Check-in both scheduled and non-scheduled patients



You can use the MultiUser tab to move an appointment
from one resource to another. Simply drag and drop the
appointment.

Printing Appointment Schedules
MicroMD EMR allows you to print appointment schedules for the resources in your practice. You can print
an appointment schedule for any resource whose appointment schedule you manage. By default,
MicroMD EMR prints concise schedules; however, you can select to print either concise or comprehensive
appointment schedules.

 Concise: The system prints each appointment on a single line with basic details.
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 Comprehensive: The system prints each appointment on multiple lines, including complete
details about the patient (e.g., demographics, insurance plans).

○

If you select to print appointment schedules for
multiple resources, MicroMD EMR starts each report
on a new page.

Figure 11.14 Appointment Schedule Window
To print appointment schedules:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select Print > Appointment Schedule from
the main menu.

You can also click the Print Schedule link in the
Appointment Book Tools section.
The Appointment Schedule window opens (Figure
11.14).

3. In the From and To fields, select the date
range for the appointment schedules you
want to print.

These fields default to today’s date. If you want to
print the schedule for a single day, enter the same
date in both fields.

4. From the Form Type drop-down, select the
format of the schedule.
5. Move the providers and/or resources for
which you want to print a schedule from the
Available Resources side to the Print
Schedules for side of the window.

You can drag and drop the resources. You can also
highlight the resource and click the Add icon ( ).
You can also double-click the resource to move
them to one side or the other.

6. Click OK.

The Print Options window opens.

7. Select any special options and click OK.

MicroMD EMR sends the appointment schedules to
the selected printer.
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Managing On-Call Schedules
The MicroMD EMR Appointment Book allows you to manage the “on-call” schedules for the practice. You
use the Month tab of the Appointment Book to manage the on-call schedules. You can view the on-call
schedules per user or for the entire practice. You can also view on-call schedules for a specific department.

○

The calendar icon indicates vacation days. See
page 11.10 for more details on the Vacation Day Manager.

Figure 11.15 On Call Schedules Using the Month Tab

Viewing and Adding On-Call Schedules
The Month tab allows you to display the schedule for a single user, for a specific department or for an
entire practice. Simply click the Lookup icon ( ) next to the On-Call Schedule for field. This opens the
On-Call Schedule Filter window (Figure 11.16). Choose the schedule you want to see and click OK.

Figure 11.16 On-Call Schedule Filter
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The system displays the User image ( ) on each day with an on-call schedule. Simply click the day to
view the list of people on call for that day. Highlight a user to see their details displayed in the yellow area
on the right.

○

When using the Month tab, the system ignores the choice
made from the resource drop-down arrow ( ). Use the
Lookup icon ( ) to view different on-call schedules.

You can edit or delete existing on-call users. Simply highlight the user in the list and click the Edit or Delete
button as appropriate.
To add an on-call user:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Click the Month tab.
3. Locate and select the day on which you want
to add an on-call user.

In the right section of the window, MicroMD EMR
lists the users on call for that day, if any.

4. Click the Add button.

The Add On-Call User window opens.


5. Enter the required details and click OK.

You can also right-click a day and
select New Call from the pop-up
menu.

MicroMD EMR adds the user to the on-call schedule
on the specified day and displays their contact
information in the yellow area of the window.

Printing an On-Call Schedule
The MicroMD EMR Appointment Book allows you to print on-call schedules for the practice. You can print
an on-call schedule for a specific user, a specific department within the practice, or for the entire practice.
The system prints the on-call schedule for the calendar month currently displayed.
To print an on-call schedule:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Click the Month tab.
3. Display the schedule that you want to print.

11.30

See page 11.29 for details on viewing the schedule.
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Procedure (continued)

Details (continued)

4. Select Print > On-Call Schedule from the
main menu.

You can also click the Print button next to the OnCall Schedule for field. The system displays the
printer dialog window.

5. Choose any special options and click OK.

The system prints the displayed schedule.

Unscheduled Appointments
Unscheduled appointments range from those patients who need to reschedule an existing appointment
to those appointment requests that come from third-party applications or from a physician currently
visiting with a patient. If you maintain a waiting list for appointments, those are also considered
unscheduled appointments.

Figure 11.17 To Schedule Tab
The To Schedule tab of the Appointment Book displays a list of these unscheduled appointments. When
you view the To Schedule tab, you can filter the display to list appointment for all three types of
unscheduled appointments or just one type at a time.
There are three types of unscheduled appointment:

 Waiting List Appointments (page 11.32): This type of appointment can be either:
- A new unscheduled appointment. For example, Andy Homer phones in with a chronic
complaint. He would like an appointment to see the doctor as soon as possible.

- An existing appointment that the patient was unable to keep. For example, Andy Homer
made an appointment two weeks ago, but due to personal problems, he was unable to
keep the appointment. You can place the existing appointment on the waiting list.

 Appointments to Reschedule (page 11.35): This type of appointment is an existing appointment
that was placed on the reschedule list. For example, a patient Andy Homer phones to say that
he cannot make his appointment scheduled for 10:00 a.m. tomorrow and would like to
reschedule. You can either immediately reschedule the appointment or place the appointment
on the reschedule list—to be rescheduled at a more convenient time.

 Appointment Requests (page 11.32): These are requests made by a physician for an
appointment for a specific patient. For example, Dr. Kumar has just completed an encounter
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with Andy Homer. The physician would like to see Andy again in two months time for a followup visit. When Dr. Kumar makes a request for a follow-up appointment, the request is listed in
his appointment schedule as an unscheduled appointment.

Add an Unscheduled Appointment to the Waiting List or as an Appointment Request
The MicroMD EMR Appointment Book allows you to add entries to a waiting list. A waiting list is helpful
when a patient calls and can only come in for an appointment on certain days. If your schedule is currently
full during those times, you can place the patient on the waiting list. The Appointment Book also allows
providers to create appointment requests. If the provider requests a follow up, the receptionist can
schedule that with the patient when they check out.

Figure 11.18 Appointment Request Window
To add an entry to the waiting list or to the appointment requests:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button ( ).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).



If you are not a Receptionist, you do
not have this drop-down.

3. Click the To Schedule tab.

The system displays the list of unscheduled
appointments for the selected resource.

4. Select Appointments > Add from the
main menu.

The Add Appointment Request window opens
(Figure 11.18).
You can also click the Add Unscheduled
Appointment icon ( ) on the top toolbar or click
the Add button at the bottom of the window.

11.32
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Details (continued)

5. Enter the patient’s name in the Patient field.
6. Complete the remaining details for
the request.

Table 11.7 explains the fields in this section in more
detail.

○
7. From the Put patient on the following list
section, choose the list for which you want to
create this appointment request and click OK.

The following fields are required for
requests exported to MicroMD PM:
Patient, Appt Type, Location, and
Patient Instructions.

Once you click OK, MicroMD EMR adds the new
request to the appropriate list.



Typically, you would not create a new
appointment for the Reschedule List.
You would move an existing
appointment to that list. See
page 11.35 for details on rescheduling
appointments.

Table 11.7 Fields Available on the Appointment Request Window

Field

Description

Patient

If there is no patient selected, click the Lookup icon ( ) next to the Patient
field and choose the appropriate patient for this request. This field is required
for requests exported to MicroMD PM.

Appt Book

This drop-down defaults to the resource you currently have selected, but you
can select a different resource if necessary.

Time Period

In the Time Period fields, choose the time frame in which the patient is
available for an appointment.

Urgent

If the patient’s appointment is of a pressing need, place a check mark in the
Urgent checkbox. This displays a red exclamation point next to the request on
the To Schedule tab.

Appt Type

Select the appropriate appointment type for this request. When you select
the type, the system changes the Appt Length field to the number of minutes
established for this type. This field is required for requests exported to
MicroMD PM.

Location

Select the practice location where the patient needs an appointment. This
field is required for requests exported to MicroMD PM.

Contact Patient

Indicate whether the patient needs to be contacted.
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Table 11.7 Fields Available on the Appointment Request Window (continued)

Field

Description

Patient Instructions

Enter any instructions pertinent to this appointment for the patient. These
instructions print on the patient reminder. For example, remind the patient to
fast 12 hours before their appointment. This field is required for requests
exported to MicroMD PM.

Additional
Requirements

Enter any additional information necessary regarding this appointment.

Put patient on the
following list

Choose the list in which you want this request to be stored.

Editing and Deleting an Unscheduled Appointment
MicroMD EMR allows you to edit the details of an unscheduled appointment and still keep that
appointment on the list. You can also delete appointments from these lists. Simply highlight the entry in
the list and click Edit or Delete as appropriate.



You can generate a report that lists patients who are on
the waiting list, reschedule list or appointment request
list. See Chapter 25 for details on reporting.

Scheduling an Appointment from the List
When an appointment becomes available, you can schedule the patient’s appointment right from the To
Schedule tab. When you schedule any appointment from the unscheduled lists, MicroMD EMR removes
the appointment from the list and inserts it into the resource’s appointment schedule.
To schedule an unscheduled appointment:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button (

).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).


3. Click the To Schedule tab.

11.34

If you are not a receptionist, you do
not have this drop-down.

The system displays the list of unscheduled
appointments for the selected resource.
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Procedure (continued)

Details (continued)

The Add Appointment window opens and displays
4. Highlight the appointment you want to
the existing details of the selected appointment.
schedule and select Appointments >
Schedule Appointment from the main menu.
You can also click the Schedule Appointment
button below the list or click the Schedule
appointment icon ( ) on the top toolbar. If you
prefer, you can right-click the appointment and
select Schedule Appointment from the popup menu.
5. Edit the details of the appointment as needed
and click OK.



Click Find Slots for assistance in
finding available appointment slots.

Once you click OK, MicroMD EMR removes the
entry from the list of unscheduled appointments
and inserts the appointment into the appointment
schedule.

Rescheduling an Appointment
If a patient calls in and needs to reschedule an appointment, you place that appointment on the
Reschedule List and reschedule it from there. You can find the Reschedule List on the To Schedule tab of
the Appointment Book.
To transfer an existing appointment to the list of appointments waiting to be rescheduled:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button (

).

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).



If you are not a receptionist, you do
not have this drop-down.

3. Click the Day, Week or MultiUser tab and
select the appointment you want to place on
the reschedule list.
4. Select Appointments > Place on Reschedule
List from the main menu.

The Edit Appointment Request window opens. The
system automatically selects Reschedule from the
Category drop-down.
You can also right-click the appointment and
select Place on Reschedule List for the popup menu.
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Procedure (continued)

Details (continued)

5. Edit the remaining fields as necessary and
click OK.

See Table 11.5 on page 11.18 for details on the
fields of this window.
The system removes the appointment from the
resource’s appointment schedule and adds it to
the reschedule list.

Check-In Module
The Check-In Module is the start of the patient’s visit when they arrive at your office. There are several ways
to check in a patient, including a right-click option in the appointment schedule and a check-in button in
various Desktop modules. When the patient’s appointment is over, the front desk personnel can check the
patient out and receive their co-payment right away. This entire process allows for the calculation of the
length of time that the patients are spending in the office, as well as their wait times.
If a patient has an appointment on the schedule and they have arrived for that appointment, you need to
check them into the system. This lets the system know that the patient is ready to be seen and starts their
route through the practice.
To check in a patient:

Procedure

Details

1. Verify that you have the Appointment Book
displayed.
2. Select the appropriate resource from the
resource drop-down button ( ).

3. Locate and select the appointment for the
patient whom you want to check in.

11.36

The name of the resource appears at the top of the
Appointment Book (Figure 11.1 on page 11.2).



If you are not a Receptionist, you do
not have this drop-down.

○

You must highlight the appointment
to enable the check-in option.

MicroMD EMR User’s Reference Manual Version 16.0

Check-In Module

Chapter 11. Appointments Module

Procedure (continued)

Details (continued)

4. Select Appointments > Check In Patient
from the main menu.

You can also click the Check In Patient icon ( ) on
the top toolbar. You can also right-click the
appointment and select Check In Patient from the
pop-up menu.
The Patient Check-in window opens.

5. Choose the appropriate department for this
patient and any workflow choices.

The fields on this window default to the values from
the appointment. Table 11.8 explains the fields in
more detail.

6. Click the Check-In button.

Once you click Check-In, MicroMD EMR checks the
patient into the system and places a check mark in
the appointment schedule.

Table 11.8 Fields on the Patient Check-In Window

Field

Description

Urgent

This indicates if the reason for the patient’s visit is pressing in nature.

Patient

Select the patient you want to check in. Click the Lookup icon (
Select Patient search window so you can locate the patient.

Appt for

Select the main physician the patient will see.

Department

Select where the patient is currently located. This defaults from the patient’s
appointment.

Current Workflow

The fields in the Current Workflow section pertain to your practice’s use of
Scheduled Visits (page 4.32).
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Medical Information Tab Overview
One of the most important parts of a patient’s chart is the information you gather about their life, from
personal medical problems to their living conditions to their family history. The Medical Information tab
is the central location where you can access all of this information. This tab also provides access to letters
on file for the patient and to the patient’s most confidential health information.



Imaging features are intended for documentation and
patient education purposes and should not be used for
diagnosis or treatment.

In This Chapter
In this chapter, we cover:

 General information (page 12.2)
 Information about displays on the Medical Information tab (page 12.3)
 Recording negative medical information (page 12.4)
 Terminating an entry (page 12.5)
 Common List for the Medical Information tab (page 12.5)
 Modifying Medical Information categories (page 12.8)
 Chart Navigator templates (page 12.9)
 Audit Log of changes to the patient's Medical Information (page 12.12)
 Marking Medical Information as reviewed (page 12.12)
 Recording medical history (page 12.15)
 Medical Information report (page 12.20)
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Overview

Overview
Within the patient’s chart, there is a Medical Information tab (Figure 12.1). This tab houses the majority of
the patient’s medical history, list of problems, medications and more. The Chart Navigator section of the
tab is different from the navigator for the Demographics tab, Summary tab and Encounters tab, although
the Chart Tools section stays the same for all.

Figure 12.1 Medical Information Tab
The Chart Navigator provides a number of controls that determine the section of the patient’s chart the
system displays in the Chart Manager. At the bottom of the Chart Navigator section are various category
buttons. When you display the Medical Information tab of the Chart Manager, each button that appears
represents a separate medical information category, such as Histories, Medications and Orders. Each
medical information category is divided into a number of sub-categories. For example, the Medical
category is sub-divided into Medications, Problem List, Alerts, Allergies, etc. (Figure 12.2).

Figure 12.2 Chart Navigator for Medical Information Tab
Click any category button (e.g., Medical), and the selected category button changes from blue to orange,
and the Chart Navigator shows a list of sub-categories available (e.g., Medications, Problem List, Alerts,
and Allergies).
Choose any sub-category to display the associated content. The color of the heading text in each medical
information sub-category indicates whether or not the sub-category contains any data (Figure 12.2).

 If the heading is blue, there is at least one entry in the sub-category.
 If the heading is black, there are no entries in the sub-category.
12.2
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General Information about Displays
The list window of the Medical Information tab shows the list of entries for the selected sub-category. For
example, if you select the Allergies sub-category, the system displays a list of all the allergies, or lack of an
allergy, recorded for the selected patient. The system can display either all entries (including old entries),
or it can display only the current items.

Figure 12.3 Category Display Area

Display Order
You can change the order in which the system displays the entries in the list. By default, all medical
information sub-categories are in order of date, with the most recent entries at the top of the list. To
change the order in which the system displays the items, click the header of the appropriate column. For
example, to display the entries in alphabetic order of the problem description, click the Problem column
header. Click the Problem column header again to reverse the display order.

Blue Status Bar
The blue status bar under the display area of each sub-category (Figure 12.4) indicates that items in the
selected sub-category were reviewed in an encounter or in the Medical Information tab of the patient’s
chart.
The system includes the name of the user who last reviewed the item along with a time and date stamp in
the center of the bar. The far left corner of the status bar displays the number of items included in the
selected sub-category.

Figure 12.4 Category Status Bar and Buttons
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Alert Icon
An Alert icon ( ) next to an item indicates that the entry has been flagged as an alert. MicroMD EMR allows
you to designate specific medical information entries in a patient’s chart as Alerts. For example, you can
flag a Habit as an alert. The system displays an Alert button (
that button to display a list of all the patient’s alerts.

○

) at the top of the patient’s chart. Click

Alerts are not available for some medical information
sub-categories.

For more in-depth details on how to use alerts, see page 13.6.

Current Medical Information
You can choose to display only current entries for the sub-category selected. Current entries are entries
that presently apply to the patient. For example, if you display long-term medications and select to display
only current long-term medications, MicroMD EMR displays only those long-term medications that the
patient is on right now.
To display only current entries, place a check mark in the Current checkbox.

○

The Current checkbox is not enabled for some medical
information sub-categories.

If you want this checkbox marked by default, you can do with your user preferences. Select Tools > User
Preferences from the main menu. Highlight the Medical Information category and place a check mark in
the Default Medical Information Items to Current checkbox.

Recording Negative Medical Information
MicroMD EMR allows you to record “negative” information in a patient’s chart. The absence of an allergy,
for example, can be just as significant in your diagnosis as the presence of an allergy.
For example, Andy Homer is not allergic to shellfish. Since this negative information was recorded in his
chart specifically as Not allergic to Shellfish, you can see that the trouble he now presents with is most
likely not related to an allergic reaction to the shrimp he ate last night, and you can rule it out for now.

○


12.4

The ability to enter negative medical information is not
available for some medical information sub-categories.

MicroMD EMR always presents negative medical
information in blue text.
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Terminating an Entry
When you need to terminate an entry, whether it is a long-term medication or a problem from which the
patient no longer suffers, you do not delete the entry—you terminate it. This leaves the entry in the system
and easily accessible. You can still reference the entry in the future should you need.
Simply highlight the entry and click the Terminate button. The system displays a prompt (Figure 12.5) and
allows you to enter a date and a reason for the termination. Complete this window and click OK.

Figure 12.5 Terminating an Entry

Common List for Medical Information Tab
MicroMD EMR includes a comprehensive way for managing your patient's medical information by dividing
medical information into several categories and over 50 sub-categories. Some categories and subcategories may not apply to specific providers. For example, a pediatrician will probably never have the
need to access the Geriatric sub-category for any of his patients. Therefore, you can define your own
Common List of medical information sub-categories.

Figure 12.6 Common List of Medical Categories
After a provider has developed a Common List, there may be little reason for the provider to ever look
outside of his Common List for a patient’s medical information. The Chart Navigator displays the Common
List category button only if you have at least one category chosen in your Medical Information Chart
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Navigator Manager (Figure 12.7).



You can choose to display only your Common List of
medical information categories and hide the other
categories. For more information, see step 5 on page
12.7.

Editing the Common List
The Medical Information Chart Navigator Manager allows you to create and modify your Medical
Information Common List. You can access this manager from the Modify Toolbar icon ( ) in the Chart
Navigator section header, or you can modify this list through your User Preferences (under Tools > User
Preferences and choose the Medical Information category).

Figure 12.7 Medical Information Common List Manager
To edit your Common List of Medical Information categories:

Procedure

Details

1. Open a patient’s chart in the Chart Manager
and click the Medical Information tab.
2. Click the Modify Toolbar icon (
Chart Navigator section header.

) in the



You can also right-click inside the
Chart Navigator and select Common
List Manager from the pop-up menu.

The Medical Information Chart Navigator Manager
window opens. If you already have a Common List,
the entries in your list appear in the right-hand pane.

12.6
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Details (continued)

3. In the Common List - Available Items side,
highlight the category you want to add to
your Common List.
4. Click the Add icon (

).

5. Repeat step 3 and step 4 for every category
you want to include in your Common List.

The entry moves to the Common List - Selected
Items side of the window. You can also double-click
the entry to move it back and forth.
If you do not want to display all of the categories
and only want to display this Common List, place a
check mark in the Display only commonly used
categories checkbox. The system displays only the
list of items you just created.

6. In the Common List - Selected Items side of
the window, use the up and down arrow
icons to re-order your Common List to suit
your needs.
7. Click OK when finished creating your
Common List.

Other Defaults
In addition to creating your common list of Medical Information categories, MicroMD EMR allows you set
some other display defaults and action defaults:

 Include Inactive Problems with Current: If you want the system to display the patient’s inactive
problems at the same time you display their current problems, place a check mark next to
Include Inactive Problems with Current. When you place a check mark next to Current in the
Problem List display, the system automatically places a check mark in the Inactive checkbox.

 Default Medical Information items to display only current items: If you prefer to display only
those entries in the patient’s chart that do not have an end date (i.e., current entries), place a
check mark in the Default Medical Information items to display only current items checkbox.

 Medical information Medications display order: If you want MicroMD EMR to sort your
medications alphabetically in the following locations, select Alphabetical from the Medical
Information Medications display order drop-down. To sort by the date you prescribed the
medications, select Last prescribe date at top.

 Apply auto-review on medical information: You can also have the system automatically mark
items as “reviewed” for you. Simply select Yes from the drop-down and set the amount of time
you want the system to wait before doing so. For more information about automatically
reviewing medical information, please see page 12.13.

 Navigator Template: If you do not want to use a Common List, where all categories display in a
single pane, you can use Navigator Templates. This allows you to keep the sections organized
while still paring down the list to just what you need. Please see page 12.9 for more details on
Navigator Templates.
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Customize Medical Information Categories
MicroMD EMR allows practices to edit the titles of the existing Medical Information categories (i.e., Medical,
Histories, Orders, Specialities, Health Maintenance, Women’s Health, Behavioral Health, and
Miscellaneous). You can also create Navigator Templates by specialty (e.g., OB/GYN) or by type of user
(e.g., Nurse).

Figure 12.8 Chart Navigator “Categories”

Customizing Category Titles
There are several ways to customize the category titles on the Medical Information tab. You can choose to
change the order in which the categories display and you can rename the categories. You can also hide
categories you do not need. For example, select the Behavioral Health category and click the Hide button
if you are a gastroenterology practice. Simply click the Show button on that category to make the category
active again.



Rather than renaming the existing category titles, create
new titles and hide the default titles. This allows you to
reactivate them in the future if necessary.

To add a Medical Information category:

Procedure

Details

1. Open the MicroMD EMR Manager.
2. Click the Reference Lists button.
3. Click the Customizable Lists tab.
4. Select the Medical Info Category Titles option. The current list of all Medical Information
categories displays on the right.

12.8
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Procedure (continued)

Details (continued)

5. Click the Add button.

The Custom Lists window opens.

6. Enter the title of the new category in the
Description field and click OK.

The system saves the category and assigns an
internal code.

Chart Navigator Templates
Practices can also create templates that standardize the title on the main section buttons on the Medical
Information tab of the patient charts. For example, if you have several specialties in your practice, you can
create a Chart Navigator template for each specialty that customizes the Chart Navigator to meet their
documentation needs.

Figure 12.9 Chart Navigator Templates
To access the Chart Navigator template manager, click the Navigator Templates button (Figure 12.9). On
the Medical Information Navigator Templates window, the far left displays the list of current templates in
your system. When you highlight a template, the Selected Items pane on the far right displays the sections
that appear under each category of the Chart Navigator for that template.
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Customize Medical Information Categories

Any changes you make to a template affect all users
who have chosen to use that template.

To create a Chart Navigator template:

Procedure

Details

1. Open the MicroMD EMR Manager and log in.
2. Click the Reference Lists button.
3. Click the Customizable Lists tab.
4. Select Medical Info Category Titles entry and
click the Navigator Templates button.

The Medical Information Navigator Templates
window opens (Figure 12.9).

5. Click the New button.

The New Item window opens.

6. In the Template Name field, enter a title for
the template.

7. In the Description field, enter some additional
information about the purpose of the
template.

○


8. Click OK.

12.10

Enter your description now if you
want one. You cannot go back and
edit the description.

The text you enter in the Description
field displays when you hover the
cursor over the template name in the
list of templates on the left.

Your new template appears in the under the
Medical Info pane on the left side of the window.
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Details (continued)

9. From the Available Items pane, select a
Medical Information section you want to
include in your new template
10. Click the right arrow button to move the
option to the Selected Items pane.
OR

The Medical Categories window opens so you can
select the Medical Information category with which
you want to associate the section.

Drag-and-drop the section title to the
Selected Items pane.
11. Select the category title and click OK.
12. Repeat step 9 through step 11 until you have
all the sections you want to include in the
template.

To reorder the sections within a category, highlight
the item and click the up and down arrows ( and
) as needed.
To remove an item, simply click the Delete icon
( ).

13. Once you are satisfied with your new
template, click the Close button.

Using Navigator Templates
Staff members with access to the patient’s chart can use any of the Chart Navigator templates created in
the system. Each user can select the template either in their user preferences or from the Chart Navigator
options within a patient’s chart.

Figure 12.10 Template Option

 From User Preferences: To access the option under your user preferences, select Tools > User
Preferences and click the Medical Information category. You can select your template from the
Navigator Template drop-down (Figure 12.10).

 From a Patient’s Chart: From within a patient’s chart, click the Medical Information tab and
click the Modify Toolbar icon ( ) in the Chart Navigator. You can select your template from
the Navigator Template drop-down (Figure 12.10).
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Change History
When anyone makes a change to any of the data on the Medical Information tab, the system tracks who
made the change and when. In each section of this tab, you can right-click any entry and select either
Change History [This Entry] or Change History [All Entries] from the pop-up menu.

Figure 12.11 Medical Information Change History
When you select Change History [This Entry], the system displays a list of all changes to the selected
item, with the most recent change at the top of the list. When you select Change History [All Entries], the
system displays a new window that lists all changes made to all items in the current list. The following
columns make up the change history:

 The Action By column displays which user modified the information or completed an action.
 The Date column displays a date and time stamp for when the change or action was made.
 The Item column indicates the item to which this history entry pertains.
 The Action Detail column displays a brief description of the change or action. The text in blue is
the resulting change made by the user.
For example, Dr. Davidson can right-click Andy Homer’s peanut allergy entry and see that Betty (the nurse)
changed it from a severe allergy to a mild allergy. He knows Andy and is familiar with his allergy. He can
now talk to Betty and find out more.

Marking Medical Information as Reviewed
MicroMD EMR gives providers the ability to manually mark the patient’s medical information as “reviewed”
with the provider’s name and a date and time stamp. You can do this on the Medical Information tab of
the patient’s chart or in the review section of the encounter.
These two sections are linked, so if you create an encounter for that patient during the same day as you
reviewed their chart, the system records that information in the review section of the encounter
automatically. Conversely, if you review medical information while in the encounter, the system records
that in the patient’s chart.
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Reviewing Medical Information
In every section of the Medical Information tab, there is a Reviewed button. To mark a section as
“reviewed” within the Medical Information tab, click the Reviewed button (Figure 12.12). The system
records the user, date and time and includes a review message in the blue status bar (Figure 12.4 on page
12.3). For more details on the Review History, see page 12.13.

Figure 12.12 Reviewing Medical Information
For example, Dr. Davidson sees he has an appointment with Andy Homer today and opens his chart to
review his medical information. As he looks over the records in the Medical Information tab, he clicks the
Reviewed button. When he works in the encounter record during Andy Homer’s visit, those items already
appear as “reviewed” within the review section of the encounter. During the visit, he finds some more
information to review and does so. The chart updates with the date and time stamp of the review.

Automatic Review of Information
If you would like the system to mark the medical information for you automatically, you can set this up in
your user preferences (under Tools > User Preferences > Medical Information). Place a check mark in the
Apply auto-review on medical information field.

○

You can also set this at the practice level in EMR Manager.
This sets the default for all users, and they can change it
under their User Preferences. In the EMR Manager, click
the System Settings button. You can find the setting on
the Practice tab.

When you set the timer and review the patient’s chart, the system automatically records the date and time
that you reviewed that section of the patient’s chart, as long as you stay in that section for the number of
seconds indicated. This is also true when you review information from within an encounter.
For example, Dr. Davidson has this option set to 10 seconds. He opens Andy Homer’s chart to the Allergies
section of the Medical Information tab. As he reviews Andy’s allergies, the system tracks as 10 seconds go
by and then automatically records that Dr. Davidson has reviewed the patient’s allergies and displays the
date and time stamp in the status bar (Figure 12.4 on page 12.3).

Review History
The review history displays a list of who reviewed each section of the patient’s medical information and
when. To open the Medical Information Review History window, click the Reviewed drop-down button
and select Show Review History (Figure 12.12).
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Figure 12.13 Medical Information Review History
On the left side of the Medical Information Review History window, the system shows categories with
current information in blue text, just like on the Medical Information tab. Categories with no information
are shown in black text.
The right side of the window displays the history of who reviewed each section of the Medical Information
tab and when they reviewed it. The filters at the top allow you to narrow the review history to display the
records you want:

 Click the Category drop-down and select the medical information category whose review
history you want to display. The system defaults to the category you had selected when you
opened the review history.

 Select a user from the Reviewed by drop-down to filter the review history by a certain user in the
EMR.

 To filter the review history by date, enter the date range in the Date fields. The system defaults
this filter to all dates.



To quickly view recently reviewed items, select Today,
Yesterday, Past Week, or Past Month from the dropdown to filter the items by the corresponding selection.

This window also allows you to mark the information as reviewed. There are three buttons at the bottom of
the window that allow you to quickly mark information as reviewed:

 Since you are already in the Medical Information tab of the chart, the Review Now button is
disabled. If you are in an encounter, this button is enabled and allows you to access the
information in the patient’s chart.
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 Click the All Reviewed button to mark all medical information categories at once. The system
only marks the categories that contain information (those in blue).

○

The left side refreshes when you exit the review history.

The Reviewed button moves the highlighted item into the Patient’s Medical Info Reviewed panel.

Recording Medical History
The Medical History Recorder helps you with the process of recording the patient’s medical history. When
you attend to a patient, you can use the Medical History Recorder to guide you through a series of
questions that you ask the patient, instead of searching through the Chart Navigator for the appropriate
categories. You can use templates customized to your needs. This helps to accurately record the patient’s
relevant medical history quickly and efficiently.
Although practices typically use the Medical History Recorder with new patients, you can use the recorder
with established patients, if and when the need arises. For example, if an established patient presents with
signs of diabetes, you can use the history template created for diabetes to record the patient’s medical
history that relates specifically to diabetes.

○

The History templates only record certain categories. The
drop-down in the template shows you the current
categories available.

When you use the Medical History Recorder to record information into a patient’s chart, MicroMD EMR
inserts the information directly into the appropriate section(s) of the Medical Information tab of the
patient’s chart.
For example, Dr. Webb used the Medical History Recorder to record that Andy Homer is allergic to
penicillin. MicroMD EMR inserted the details of the allergy into the Allergies sub-category of Andy’s chart.

History Templates
You create and develop history recording templates to streamline and refine the history-taking process.
You use the History Template Builder to do the creating and developing. You can also copy and edit
existing templates. When you create a new history recording template, you can save the template either to
the Personal folder or the Shared folder. You cannot save a template to the Standard folder. You can,
however, copy a template from the Standard folder and save it into the Personal or Shared folders. Then
you can edit the template as needed. For more details on each type, see page 2.8.
History templates can contain entries for the certain sub-categories in the Medical History category
(Figure 12.14). For example, you can create a History Recording Template called FIRST VISIT - ADULT and
include peanuts, shellfish and milk in the Allergies (Non Drug) section of the recorder since these are the
typical questions asked of a first-time patient.
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Figure 12.14 History Template Builder



If someone has created a History Template that you
want to use, but you want to make some modifications,
highlight the template, click Copy, and then save it to
your Personal folder. Then you can edit the template as
necessary without changing their version.

To create a new history recording template from scratch:

Procedure

Details

1. Select Tools > History Templates from the
main menu.

The History Template Manager window opens and
lists all your personal history recording templates.

2. Click New.

The History Template Builder window opens (Figure
12.14).

3. From the Medical Category drop-down,
select the sub-category you want to add to
the template.

The left window of the History Template Builder
displays your Common List for the selected
category.

4. Use the available filters and search facilities
to locate the item in the category that you
want to add to the template.

For example, if you chose Allergies (general), use
the controls to find Bee Stings.

5. Highlight the entry and click the Add button.

MicroMD EMR adds the selected entry to the
template and displays it on the right side of the
window.
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Procedure (continued)

Details (continued)

6. Repeat step 4 and step 5 for each item you
want to add to your template in this subcategory.

You can also reorder the items you select. By
default, the system alphabetizes this list. Highlight
the entry and click the up and down arrow icons (
and ) to move the entry to the appropriate order
within that category.



If you reorder the items in the
category, but then would like to go
back to the way the system ordered
the list, simply click the a-z icon.

7. Repeat step 3 through step 6 for each subcategory.
8. Click OK when satisfied with your template.

The Save History Template window opens.

9. In the Template name field, enter a useful
title for your template.

This name is how you distinguish the templates
from each other when you want to use one.

10. Choose the folder in which you want to save
the template.

You can choose either Personal (available only to
you) or Shared (available to multiple users). See
page 2.8 for more detailed information on Personal,
Shared and Standard folders.

11. Click OK.

The system adds the new template to the folder you
chose. Congratulations! You can now use your new
template with the History Recorder.

Using the Medical History Recorder
You can use the History templates with the Medical History Recorder to record a patient’s medical history.
When you load a template into the recorder, the system pulls information from the patient’s chart to show
you the history items in your template already recorded for the patient. A plus sign (+) that appears to the
left of any entry (i.e., on the left side of the Medical History Recorder) indicates that the entry already exists
in the patient’s medical record, and the entry is positive. A minus sign (-) that appears to the left of any
entry indicates that the entry already exists in the patient’s medical record, and the entry is negative (i.e.,
absent).
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Figure 12.15 Medical History Recorder
To use the Medical History Recorder:

Procedure

Details

1. Open the patient’s chart and select Chart >
First Visit History from the main menu.

You can also click the First Visit History icon (
the top toolbar.

) on

The Load History Template window opens and lists
all your personal History Templates.
2. Locate and highlight the template you want
to use for this patient’s history.

You can use a template in any of the folders.

3. Click Load.

The Medical History Recorder window opens (Figure
12.15). The left side of the Medical History Recorder
window displays the choices from the template that
you loaded. The right side of the window displays
medical information already recorded for those
items in the patient’s chart.
If you discover that you loaded the wrong template,
click the Clear button in the lower left. Then click the
Load Template button to choose a different
template. The system loads the items in the
template. If you have not cleared the existing
template, the system loads on top of the existing
items, adding to the list.

4. Highlight an entry in the left side of the
window.

12.18

For example, under Habits, highlight Smoker.
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5. Click the appropriate button that describes
the entry you want to make for the selected
item.
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Details (continued)
Click the Present button (
) to display the
appropriate window with the item already selected.
You can make the appropriate choices and click OK.
The Absent button (
) allows you to quickly add
a No Known entry to the patient’s chart for the
selected item. See page 12.4 for details on this type
of entry.
The All button (
) allows you to quickly add a No
Known entry to the patient’s chart for all of the items
in the sub-category with the selected item.


6. Click Close when satisfied with the
history session.
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Remember: Every history item that
you address increases your increases
your E-and-M code.

The system adds all of the histories entries you just
made into the appropriate areas of the Medical
Information tab. When you create an encounter on
the same day, the system pulls into the Assessments
area of the encounter any problem list items you
added from the history recorder.
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Medical Information Report
The Medical Information Report prints the patient’s medical information from his or her chart. When you
generate the report, the system allows you to specify the categories of medical information you want to
display in the report. You can include all medical information in the patient’s chart, including terminated
items, or choose to print only the patient’s current medical information.

Figure 12.16 Medical Information Report Options
To create and print a medical information report:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on using charts.

2. Select Print > Medical Information Report
from the main menu.

The Medical Information Report window (Figure
12.16) opens for the selected patient.

3. In the Report Destination section, choose
what you want the system to do with the
resulting report.

You can send the report straight to a printer, or you
can simply view the report. You can print the report
from the view if you choose.

4. In the Medical Information section, place a
check mark next to any sub-categories you
want the system to print.
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Click the Select All button to place a
check mark next to all categories. Use
the De-select All button to remove all
the check marks.
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Details (continued)

5. Place a check mark in the Include current
information only checkbox if you only want to
print information not marked as terminated.
6. Click OK.
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MicroMD EMR generates the report and either
sends the report to the printer or displays it on the
screen, depending on the choice you made in the
Report Destination section.
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The Medical category button provides access to a host of medical information about the patient. The
system provides areas where you can record medical details such as the patient’s medications; allergies
(both drug- and non-drug-related); any medical problems they have had or currently have; or a clinical
profile graph related to a condition like diabetes.

In This Chapter
In this chapter, we cover adding the following medical information to the patient’s chart:

 Medications (page 13.2)
 Problems (page 13.3)
 Alerts (page 13.6)
 Allergies (page 13.8)
 Vital Signs (page 13.10)
 Laboratory Results (page 13.17)
 Clinical Profiles (page 13.20)
 Nursing Care (page 13.23)
 Diagnostic Tests (page 13.25)
 Implantable Devices (page 13.27)
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Medications
Tracking a patient’s medications can be an important part of providing great healthcare. MicroMD EMR
provides a central area in their chart where you can view the medication list, including past and present
medications.

Figure 13.1 Medication List in the Patient’s Chart
Medications are separated into three categories: long-term medications (LTM), prescriptions (Presc), and
other medications or over-the-counter drugs (Other). To filter the medications according to these
categories, add or remove check marks in the filter at the top of the list. For example, if you want to view
only a patient’s current long-term medications, remove the check marks from the Presc and Other
checkboxes.



13.2

For more in-depth information about this section and the
prescription module, please see Chapter 21.
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Problem List
MicroMD EMR allows you to maintain a list of problems with which the patient suffers. The problems listed
in the system can be those the patient currently has or those that the patient has had in the past. To view
the patient’s problem list, click the Medical button and choose Problem List.

○

Users can decide to show inactive problems when
viewing a patient’s current problem list. In the Medical
Information section of the User Preferences window
(Tools > User Preferences), place a check mark in the
Include Inactive Problems with Current to enable this
user preference.



If the Problem List title appears in blue text, the patient
has at least one entry in his problem list. If the Problem
List title appears in black text, the patient has no entries
in his problem list.



For additional information about a problem list item,
click the information icon ( ) in the yellow “sticky” area,
including access to patient education and VisualDx.

You can add the patient’s health issues to their problems list or you can add negative information for a
specific problem (e.g., No known problem of Heart Disease). To specify no know problems at all, please see
page 12.4.

Figure 13.2 Add Problem to Patient Chart
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To edit or delete an existing problem, simply highlight the entry and click Edit or Delete as appropriate.

○

If you need to mark an existing problem as no longer
applicable to the patient, you should not delete the entry.
You should mark it as Terminated (page 12.5).

○

You can view an audit history for each problem in a
patient’s chart. Simply click the Activity button on the
Edit Problem window (Figure 13.2). The Problem Activity
History window opens and provides you with a history of
each change to that patient’s Problem List item.

To add a problem to a patient’s list of problems:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Medical
button and choose Problem List from the
available options.

The system displays a list of the patient’s
problems.

3. Click the Add button.

The Add Problem dialog box opens (Figure 13.2).

4. Complete the necessary information.

Table 13.1 explains the fields in detail.

5. Click OK or Apply/New.

The system adds the new problem to the patient’s
list. (See page 12.5 for details on terminating
entries.)
If you click the Apply/New button, the system adds
the problem to the patient’s list and clears the
window so you can continue adding more
problems.



If you add a current problem to a list
that has the No known problems
entry, MicroMD EMR deletes the entry.

Table 13.1 Fields on the Add Problem Window

Field

Description

No problem of

Place a check mark in this option and select a diagnosis from the Diagnosis
field to indicate that the patient was checked for a specific problem and found
to not have the indicated problem.
For example, Dr. Davidson screened Andy Homer specifically for amyotrophic
lateral sclerosis (ALS) and found he does not have it. The doctor made a
notation in Andy’s chart with an entry of No problem of Amyotrophic lateral
sclerosis in Andy’s Problem List.

13.4
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Table 13.1 Fields on the Add Problem Window (continued)

Field

Description

Diagnosis

Click the Lookup icon (

Chronicity

From the drop-down select how often this problem repeats.

Diagnosed by

Select the physician who diagnosed the patient’s problem.

Onset

Choose when the patient’s problem started. You can enter an exact date, an
approximate date, or an approximate time period (e.g., three years ago).

Status

Choose the appropriate description of the problem.

) to insert the appropriate diagnosed problem.

 Active: The problem is ongoing and is currently being treated, such as
diabetes.

 Inactive: The problem is not currently active but can become present
again, such as eczema.

 Resolved: The problem was successfully treated, such as a singular case of
bronchitis.
Status Date

Choose when the change in the problem status occurred. You can enter an
exact date, an approximate date, or an approximate time period (e.g., three
years ago). You can also enter the patient’s age when the problem started.

Include as Functional
Status and Include as
Cognitive Status

For use when exporting a patient’s chart to an electronic file, these options
allow you to identify this problem as “functional” or “cognitive”. This informs
MicroMD EMR so the system can include the entry in the appropriate section of
the C-CDA/CCR/CCD anytime you export the patient’s chart.

Comment

Enter any additional information in the Comment field.
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Alert List
MicroMD EMR allows you to maintain an Alert List for each patient. This list of alerts displays all the
patient’s conditions of which anyone who opens the patient’s chart should be made aware. If there are any
entries in the Alert List, the animated Alert button (
13.3).

) appears at the top of the patient’s chart (Figure

Figure 13.3 Alert List
An Alert List can include issues such as severe allergies, extreme habits, serious problems, gynecological
conditions to monitor and long-term medications you need to know the patient is taking. An Alert List can
also include critical social, surgical, family or medical history issues.



13.6

MicroMD EMR automatically prompts you to include
particular vital signs and statistics in the patient’s Alert
List, as well. For more details, see page 13.15.
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View the Patient’s List of Alerts
The system displays the patient’s list of alerts when you select View > Alert List from the main menu or
click the Alerts button ( ) at the top of the chart. To view the medical category for alerts, choose the
Alerts category from the list of available options in the Chart Navigator section (Figure 13.3).

Figure 13.4 Patient’s Alert List

Add or Remove an Alert from the List
You can add alerts to a patient’s Alert List from several areas of the program. If you see an Alert checkbox,
you can add the item to the list (Figure 13.5).

Figure 13.5 Mark an Item with an Alert
To remove an alert from the category list of alerts, simply highlight the item and click the Remove button.
The system removes the check mark from the item’s Alert checkbox and removes the item from the Alert
List. It does not remove the item itself.
For example, Andy smokes over three packs of cigarettes per day. You add the patient’s Smoking Status as
an entry in his list of Habits and set the smoking habit as an alert. A year later he has reduced his
consumption to five cigarettes per day. You can remove Smoker from the Alert List but still keep it on
Andy’s list of habits.
To add an alert to an item in the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, locate and choose the
sub-category that contains the item you want
to mark with an alert.

For example, to add an alert to a patient’s habit,
click the Medical button and choose Habits.

3. Highlight the item you want to flag and
click Edit.

The appropriate dialog box opens.
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Procedure (continued)

Details (continued)

4. Place a check mark in the Alert checkbox.

See Figure 13.5.

5. Click OK.

The system adds the selected item the patient’s
Alerts List.

Allergies
MicroMD EMR allows you to maintain a list of the patient’s allergies. This is useful information for anyone
who views the patient’s chart and can help you improve patient care. The system can help your practice
avoid prescribing an inappropriate medication or ineffective treatment plan.

Figure 13.6 List of Patient’s Allergies
To edit or delete a patient’s allergy, simply highlight the entry and click Edit or Delete as appropriate.
When you delete an entry, the system either removes the item from the database or displays it with a
strikethrough, depending on the choice made for the practice (page 1.35).

13.8
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To add an allergy to the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the
Medical Information tab.
2. In the Chart Navigator, click the Medical
button and choose Allergies from the
available options.

The system displays a list of the patient’s allergies.

3. Click the Add button.

The Add Allergy dialog box opens.

4. Complete the necessary information.

Table 13.2 explains the fields in detail.

5. Click OK or Apply/New.

The system adds the new problem to the patient’s
list. (See page 12.5 for details on terminating entries.)
If you click the Apply/New button, the system adds
the allergy to the patient’s list and clears the window
so you can continue adding more.
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If you add an allergy to a list that has
the No known allergies entry,
MicroMD EMR deletes the entry.
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Table 13.2 Fields on the Add Allergy Window

Field

Description

Type

From the Type options, choose whether the patient’s allergy is drug-related. Your
choice here dictates the allergy list that displays when you click the Lookup icon
( ) next to the Allergy field.

Not allergic to

Place a check mark in this option and select an allergy from the Allergy field to
indicate that the patient was checked for a specific allergy and found to not be
allergic to the indicated medication or other indicated allergen.
For example, Dr. Davidson screened Andy Homer specifically for cat dander and
found that he is not allergic to it. The doctor made a notation in Andy’s chart with
an entry of Not allergic to Cat dander in Andy’s Allergies list.

Allergy

Click the Lookup icon ( ) to insert the appropriate allergy. The reference list
that opens (and the common list that displays in your drop-down) depends on
the choice you make in the Type options.

Diagnosed by

Click the Lookup icon ( ) next to the Diagnosed by field to choose the provider
associated with diagnosing the allergy.

Date identified

From the Date identified field, select when the allergy started. You can enter an
exact date, an approximate date, or an approximate time period (e.g., three years
ago). You can also enter the patient’s age when the allergy started.

Reaction

Click the Lookup icon ( ) next to the Reaction field to open the Reference List
for adverse reactions. The system populates this list from a SNOMED list of
adverse reactions.

Severity

Select the appropriate description in the Severity field.

Comment

Enter any additional information in the Comment field.

Terminated by and
Terminated date

Complete the Terminated fields on this window if the patient is no longer allergic
(e.g., when a child no longer has a strawberry allergy).
When you mark an allergy as “terminated,” the system does not remove the
allergy. It remains in the patient’s chart.

Vital Signs and Statistics
When you take the patient’s vital signs, weigh the patient and measure their height, the system allows you
to record this information quickly. You can do so from within an encounter or from the patient’s Medical
Information tab. From the Medical Information tab, you can add, edit or delete vitals, but you can also
graph the patient’s vital signs over time.

○
13.10

You can also use external devices to capture the patient’s
vital signs. Please contact your local authorized MicroMD
EMR reseller for more information.
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Figure 13.7 Vital Signs and Statistics



Place a check mark next to the Current checkbox to view
only those vital signs and statistics recorded today.

When you record vital signs, MicroMD EMR lets you use either metric or imperial units. However, when
MicroMD EMR displays vital signs, it always uses the system of measurement listed for the practice in the
MicroMD EMR Manager (page 1.35).

Recording Vital Signs and Statistics
MicroMD EMR allows you to record multiple sets of vital signs and statistics for each patient. When you
record a new set of vital signs, you do not need to record all the patient’s vital signs and statistics; you can
choose to record only those signs that are relevant to the patient’s current condition. For example, you
may need to measure and record only the patient’s temperature—not his pulse, blood pressure or any
other vital signs.

○

If you plan to use a device to record and import vitals into
MicroMD EMR, please be sure the device is installed and
working. Please refer to the documentation provided with
your device for further details on using it with the system.
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To edit or delete a set of vitals, highlight the entry and click Edit or Delete as appropriate (Figure 13.7). If
using an external device to record vitals, you can click the Edit button and use the device to recapture any
or all of the patient’s vitals.

Figure 13.8 Recording Vital Signs and Statistics
You can edit a set of vitals within 24 hours of recording the measurement. After 24 hours, you can no longer
edit the patient’s vitals. You can delete the set of measurements at any time.
To record a new set of vital signs from within the Medical Information tab:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Medical
button and choose Vital Signs & Statistics
from the available options.

The system displays a list of vitals taken for the
patient over time.

3. Click the Add button.

The Add Vital Signs & Statistics window opens
(Figure 13.8).
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Procedure (continued)

Details (continued)

4. Record the patient’s information as
appropriate.

Table 13.3 explains the fields in detail.

○

At this point, you can use your
external vitals device to capture the
patient’s vitals. Click the Get Vitals
button that is available to capture
from the device. The system displays
a capture icon ( ) while gathering
and importing data.
Once the data is ready, click Import
on the message prompt.

5. Click OK or Apply/New.

The system adds the new statistics to the patient’s
chart. If you click the Apply/New button, the
system adds the statistics to the patient’s chart
and clears the window so you can continue adding
more vitals.

Table 13.3 Fields on the Vital Signs and Statistics Window

Field

Description

Vital Signs
Measured on

Specify the date on which the vital signs were measured and the time at which
they were measured. MicroMD EMR defaults to the current system date and time.

Temperature

Enter the patient’s temperature. From the drop-down, select where the patient’s
temperature was measured. This drop-down pulls its default value from your
User Preferences (under Tools > User Preferences > General > Vitals Signs).

Pulse

Enter the number of heart beats per minute for the patient.

Pulse type

From the drop-down, select the best description of the patient’s pulse.

Resp rate

Enter the patient’s respiratory rate.

Peak flow

Enter the reading from the peak flow meter if you measured how much the
patient could exhale.

Oxygen saturation

Enter the appropriate percentage of oxygen saturation for this session with the
patient. If this percentage relates to tank air, place a check mark in the Tank
checkbox.

Tank

Place a check mark in this checkbox if the percentage entered in the Oxygen
saturation field relates to tank air.

Pain severity

On a scale from 1 to 10, rate the patient’s pain with them and record that
information here. The system uses the Comparative Pain Scale standard.

Systolic

Enter the patient’s systolic blood pressure.
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Table 13.3 Fields on the Vital Signs and Statistics Window (continued)

Field

Description

Diastolic

Enter the patient’s diastolic blood pressure.
Indicate whether the patient was standing, sitting or lying down when their blood
pressure was measured. This section pulls its default value from your User
Preferences (under Tools > User Preferences > General > Vitals Signs).

Left or Right

Indicate whether the patient’s blood pressure was measured on the left side or
on the right side of their body. This section pulls its default value from your User
Preferences (under Tools > User Preferences > General > Vitals Signs).

BP not taken

If there is a valid medical reason for not taking the patient’s blood pressure
reading or if the patient refused to have their blood pressure taken, select the
appropriate reason from the BP not taken drop-down. This is especially
necessary when participating in incentive program quality measures.

Statistics
Height

Enter the patient’s height.

Weight

Enter the patient’s weight.

Head Circ

Enter the circumference of the baby’s head. This option is only available when
the patient’s age is under six.

BMI

The system automatically calculates the patient’s Body Mass Index (BMI) based
on the height and weight data entered. It also displays the percentile into which
the patient’ s BMI falls*.



The system contains a set of medical calculators that
contain a BMI calculator (page 27.7).

* BMI percentile calculated based on recommendations provided by www.cdc.gov as of June 28, 2017.

BMI not taken

If there is a valid medical reason for not recording the patient’s height and weight
or if the patient refused to have their measurements taken, select the appropriate
reason from the BMI not taken drop-down. This is especially necessary when
participating in incentive program quality measures.

Edit Pregnancy
History

Click the History icon ( ) to edit the patient’s pregnancy history. This opens the
Women’s Health information viewer for pregnancy (page 18.15).

Last Menstrual
Period

Enter the date of the patient’s last menstrual period.

Edit Menstruation
History

Click the History icon ( ) to edit the patient’s menstruation history. This opens
the Women’s Health information viewer for menstruation (page 18.23).

Pregnant

Specify whether the patient is pregnant. This option is only available when
Female is listed in the Gender drop-down of the patient’s Demographics tab. If
Other, Unknown or Male is listed, the system disables these options. The
patient’s age must also be greater than eight (8) years old.
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Table 13.3 Fields on the Vital Signs and Statistics Window (continued)

Field

Description

EDD

Enter the patient’s expected date of delivery.

Nursing

Specify whether the patient is nursing.

Comment

Enter any additional information about this patient’s vital signs and/or statistics
that would be useful to know.

Patient-Generated Health Data
Patient-generated health data can come from devices the patient takes home, from our integrated
population health app, or from data submitted by the patient through the Health Information Form on the
MicroMD Patient Portal. See details about reconciling imported data on page 10.15.
Place a check mark next to the PGHD checkbox to include Patient-Generated Health Data in the list of vital
signs. To show only those vital signs readings from within your practice, you can remove the check mark to
hide the patient’s entries.



Patient-generated health data does not typically count
toward incentive program measures. Be sure to verify
your measure’s requirements.

Vital Sign Alerts
When you record vital signs and statistics for a patient, MicroMD EMR automatically informs you if specific
values are well outside the normal ranges. The system lets you add these abnormal vital signs to the
patient’s Alert List. When you save a set of vital signs and statistics that contains abnormal values, MicroMD
EMR displays the Abnormal Vital Signs and Statistics dialog box.

Figure 13.9 Vital Signs and Statistics Alerts
This notification allows you to select which entries to add to the patient’s alert list. MicroMD EMR checks
the following items when you record vital signs and statistics:

 Height and Weight: Patients up to age 20
 Head Circumference: Patients up to age 36 months
MicroMD EMR considers a vital signs entry to be out of the normal range if the recorded value:

 is less than the 5th percentile for the patient’s age
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 is more than the 95th percentile for the patient’s age
 varies by more than 10 percentiles from the previous recording of the same statistic
For example, Betty records the weight of Jolene, a 19-year-old patient, at 147 pounds. This places Jolene in
the 50th percentile for patients of her age. One year later, the patient’s weight has increased to 165
pounds, placing her in the 72nd percentile. Because the change in weight represents more than 10
percentiles, the weight check has failed, and MicroMD EMR gives you the option of adding the patient’s
weight readings to her alert list (page 13.6).

Graphing Vital Signs
You can display a graph of a patient’s vital signs and statistics measured over a period of time. This
provides a visual idea of any trends or patterns in the patients overall health. You can use the graph, which
you can also print if necessary, for patient education and motivation purposes.

Figure 13.10 Vital Signs Graph
To see a graph of the patient’s vital signs and statistics:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Medical
button and choose Vital Signs & Statistics
from the available options.

The system displays a list of vitals taken for the
patient over time.

3. Click the Graph button.

The Vital Signs Graph window opens (Figure
13.10).
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Procedure (continued)

Details (continued)

4. In the Vital Signs to Graph section, place a
check mark next to the vital sign you want
to see.

You can compare related vital signs and/or
statistics by selecting multiple vitals.
The system automatically updates the window for
you. You can click the Full Screen button to
maximize the graph to share with the patient. If you
change the months, click Redraw to generate the
graph with the new time frame. Click Print to print
the displayed graph.

Pediatric Growth Charts
For those physicians that work with pediatric patients, you can view graphs of the patient’s growth history
until the age of 21, provided you have recorded this information in MicroMD EMR over time. Simply click
the Growth button (Figure 13.7 on page 13.11). This displays the graphs you can then maximize, print,
export to an image and share with the patient and their parents. Choose the Infant or Child option on the
window to adjust the graphs accordingly. You can also place a check mark in the Down Syndrome
checkbox to adjust the graphs further to reflect the needs for patients with Down syndrome.



See page 16.3 for more charts and tests available to
pediatricians.



For more information on using a graph window, please
see page 25.7 in the MicroMD EMR Reports chapter.

Laboratory Results
MicroMD EMR allows you to record and manage laboratory results in a patient’s chart. The system also
allows you to display a list of all laboratory results that were sent to you that have not yet been viewed for
all your patients (page 4.38).



For details on creating lab result entries out of
attachments, please see page 20.5.
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Figure 13.11 Patient’s Lab Results
Each set of laboratory results has one of the following statuses:

 Final: When you record a complete set of laboratory results, you change the status of the results
from Incomplete to Final. No MicroMD EMR users can modify laboratory results that have the
status Final, except for the physician to mark them as Viewed.

○

All results received electronically have the status Final
and therefore cannot be edited.

 Preliminary: Lab companies send this status if they plan to send final results in the near future.
 In Progress: When you create a new set of laboratory results, they are automatically assigned
the status In Progress. Any MicroMD EMR user who can access a patient’s medical information
can modify any laboratory results that have the status In Progress.

 Incomplete: If the set of results does not include results for every test on the order, the system
assigns the status Incomplete. Any MicroMD EMR user who can access a patient’s medical
information can modify any laboratory results that have the status Incomplete.

 Final (Corrected): If the lab company sends along a corrected set of results, the status changes
to Final (Corrected) to let you know that the details within the results have changed.

 Rejected: If the lab tests were not performed for some reason, the results will come through with
the Result Status of Rejected.
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Once you have reviewed the patient’s test results and set the Result Status to Final, you need to mark the
results as “Viewed”. Simply click the Mark as Viewed button. Only the physician to whom the results were
sent can change the status to Viewed.



If the physician has staff members who review results for
him or her, they can identify those EMR users in the
physician’s User Preferences (page 1.93).

Each set of laboratory results can be entered into MicroMD EMR in one of two ways:

 Manually: After receiving a set of laboratory results, you can manually enter the results into the
patient’s chart (Figure 13.12).

 Electronically: Your practice can configure MicroMD EMR to receive laboratory results
electronically—directly from the laboratories. In such cases, the system is set to download the
files that contain the results at scheduled times each day. The timing and frequency of
downloads vary from laboratory to laboratory, and depending on your exchange mode, you can
configure MicroMD EMR for the convenient download times for your practice. Please contact
your local authorized MicroMD EMR reseller for more information.

Figure 13.12 Adding Lab Results Manually
To edit or delete a lab result, simply highlight the entry and click Edit or Delete as appropriate. You can
only edit those results that have a status of Incomplete. If the status is Final, you cannot edit the results.
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Clinical Profiles
MicroMD EMR allows you to maintain a list of clinical profiles as part of each patient’s chart. Each clinical
profile provides a graphical representation of specific aspects within the patient’s chart. For example, the
Diabetes profile shows the patient’s Serum Glucose and HbA1c levels over time, together with the patient’s
long-term medications.

Figure 13.13 Clinical Profiles

Adding a Clinical Profile to a Patient’s Chart
MicroMD EMR has a standard set of clinical profiles. You cannot edit or delete any of the standard profiles,
and you cannot add to the list of standard profiles. From the list of standard profiles, you can select which
profiles you want to associate with each patient’s chart. This makes it easy and quick to view specific
profiles for each patient. MicroMD EMR allows all physicians to add clinical profiles to a patient’s chart.
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Figure 13.14 Profile Graph Manager
To add a clinical profile to the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Medical
button and choose Clinical Profiles from the
available options.

The system displays a list of profiles currently
created for the patient.

3. Click Add.

The Profile Graph Manager window opens (Figure
13.14).

4. Locate and select the clinical profile you want
to use for this patient.

If you want to create your own template, see
page 13.22. For details on copying and editing an
existing template, see page 2.8.

5. Click Insert.

MicroMD EMR inserts the selected profile into the
patient’s chart.
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Viewing a Clinical Profile
Once you have a clinical profile inserted into the patient’s chart, any physician can view the profile in the
patient’s chart.
To view a clinical profile in a patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Medical
button and choose Clinical Profiles from the
available options.

The system displays a list of profiles currently
created for the patient.

3. Highlight the profile you want to view and
click the Run button.

The system displays the results in a graph window.

4. Click Close when finished.

Creating Clinical Profile Templates
MicroMD EMR comes with several Profile Graph templates built in. If you want to tweak any of the Standard
templates (or create your own template), you can select Tools > Profile Graphs from the main menu to
access the Profile Graph manager.
To create a new Profile Graph:

Procedure

Details

1. Select Tools > Profile Graphs from the
main menu.
2. Click the New button.

The Clinical Profile Wizard window opens.

3. From the Profile Type drop-down, select the
kind of information you want to graph.
4. in the Graph Title field, enter the name of your
template.

This is the text that will display in any lists.

5. Click the Next button.

The fields on the Data step vary depending on the
type of graph you have chosen to create.

6. Complete the fields on this step.
7. When satisfied about the information that will
display, click Finish.
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Nursing Care
This section of the patient’s chart displays all nursing care orders that have been performed for a patient,
either through an encounter or through the Medical Information tab. Nursing care requests can range
from administering medications to inserting IVs. This section displays the list of nursing care throughout
the patient’s history with your practice.

Figure 13.15 Nursing Care in a Patient’s Chart
To edit or delete a nursing care entry, simply highlight the entry and click Edit or Delete as appropriate.
You can only edit those orders that have not been signed.
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Figure 13.16 Nursing Care Request
To add a nursing care entry to the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Medical
button and choose Nursing Care from the
available options.

The system displays the list of nursing care
provided to the patient.

3. Click Add.

The Nursing Care window opens (Figure 13.16).

4. Complete all necessary fields related to the
request and click OK.

The system adds the care item to the Nursing Care
section of the patient’s chart and to the Desktop of
the person listed in the Requested By drop-down.
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Diagnostic Tests
The Diagnostic Tests section of the patient’s chart contains the results of procedures ordered for the
patient. For example, Dr. Davidson ordered an EKG for Andy Homer. The technician performed the test on
Mr. Homer, and the results were added to the patient’s chart in the Diagnostic Tests section.

Figure 13.17 List of Diagnostic Tests in Patient’s Chart
To edit or delete a test result entry, simply highlight the entry and click Edit/View or Delete as appropriate.
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Figure 13.18 Add Diagnostic Test Window
To add a test to the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Medical
button and choose Diagnostic Tests from the
available options.

The system displays the list the patient’s test
results.

3. Click Add.

The Add Diagnostic Test window opens (Figure
13.18).

4. Complete all necessary fields related to the
test and click OK.

The system adds the new test to the patient’s list.
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Implantable Devices
If you have patients with implantable devices (e.g., pacemakers, artificial hips, stents), MicroMD EMR allows
you to track these devices and generate reports (and letters) related to those devices (e.g., when a recall
occurs).

Figure 13.19 Implantable Devices in the Patient’s Chart
You can access the patient’s list of implantable devices on their Medical Information tab under the
Medical button in the Chart Navigator (Figure 13.19). To add an implantable device to the list, simply click
the Add button. This opens the Add Implantable Device List window (Figure 13.20). Enter any information
you have about the device that you want to track.

○

The Status and Contains HTC/P fields are required.
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Figure 13.20 Implantable Device Details
You have a few options for adding the device’s details to the window:

 You can manually enter all of the information you currently have.
 If you already have the Unique Device Identifier (UDI), you can enter that number in the
Unique Device Identifier (UDI) field, tab out of the field, and click the Parse UDI button. This
automatically breaks up the ID and populates the fields in the Production Identifiers section.
If you then click the Lookup DI button, the system automatically populates the Device
Description field and the fields in the Global Unique Device Identification Attributes section.

 You can click the Access GUDID Website link to search for the device information, record the
details you need, and add the information manually.
If you want to generate a report related to the implantable devices within your practice (perhaps there was
a recall), you can generate a report using most of the fields on the Implantable Device window.
On the Desktop under the Administration button, click Reports. You can find the Patient Implantable
Devices report under Medical Info (General) > Standard. See Chapter 25 for more details on the MicroMD
EMR reporting module.
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Working with patients over time allows you to get to know them, from their first breath to their first broken
arm to their varicose veins. All of this information makes up their medical history. MicroMD EMR provides
areas where you can keep track of this information.

Figure 14.1 History Categories



For women’s health histories, refer to Chapter 18.

In This Chapter
In this chapter, we cover the following:

 Adding a history item (page 14.2)

 Hospitalization History (page 14.14)

 Medical History (page 14.3)

 Asthma History (page 14.17)

 Surgical History (page 14.5)

 Environmental History (page 14.19)

 Social History (page 14.7)

 Surgical Procedures (page 14.20)

 Family History (page 14.9)

 Birth History (page 14.25)

 Habits (page 14.12)

 Sexual History (page 14.26)
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Adding a History Item
For each of history sections of the chart, you add an entry the same way. The only difference is that the
fields on each window vary depending on the category you selected (e.g., the Surgical History window has
different fields than the Family History window). The following sections in this chapter detail the fields on
for the Add window in each history category.

Figure 14.2 Adding a History Item
To add a history item to the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Histories
button and choose the appropriate history
section from the available options.

The system displays the list of the patient’s past
and present history entries for the selected
category.

3. Click the Add button.

The system displays the history entry window.

4. Complete the necessary fields.
5. Click OK or Apply/New.

The system adds the new history entry to the
patient’s list. (See page 12.5 for details on
terminating entries.)
If you click the Apply/New button, the system adds
the procedure to the patient’s list and clears the
window so you can continue adding more.
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Medical History
MicroMD EMR allows you to maintain a record of the patient’s medical history. Medical conditions in the
patient’s history can be either current maladies or maladies the patient has had in the past. The system
also allows you to record—as part of the patient’s chart—that the patient has no known medical history or
no known history of a specific condition. The No known medical history entry appears as the only entry.
(See page 12.4 for more details on the No known entry in a patient’s chart.)

Figure 14.3 Patient’s Medical History
To view the patient’s medical history, open their chart, click the Medical Information tab, click the
Histories button and choose Medical History from the available options (Figure 14.3).



Check the Current checkbox to view only the patient’s
current medical conditions.

Click the Add button to add a new entry to the patient’s chart. (See Chapter 12 for more details on other
actions you can perform with the entries in the list.) Table 14.1 explains the fields on the Add Medical
History window in detail.
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Figure 14.4 Medical History
Table 14.1 Fields on the Add Medical History Window

Field

Description

No history of

Place a check mark in this option and select a diagnosis from the Diagnosis
field to indicate that you reviewed the patient’s medical history with them and
found no history with a specific medical condition to enter.

Diagnosis

Click the Lookup icon ( ) next to the Diagnosis field to choose the
appropriate diagnosed condition.

Diagnosed by

In the Diagnosed by field, choose who diagnosed the patient’s problem.

Start date

From the Start date field, choose when the patient’s condition began. You can
enter an exact date, an approximate date, or an approximate time period (e.g.,
three years ago). Place a check mark in the Approx checkbox to indicate the
data in the Start date field is an approximation.

Comment

Enter any additional information in the Comments field.

Terminated by and
Terminate date

For details on terminating an entry in the patient's chart, please see page 12.5.
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Surgical History
MicroMD EMR allows you to maintain a record of the patient’s surgical history. Surgeries in the patient’s
history can be either current procedures or procedures the patient has had in the past. The system also
allows you to record—as part of the patient’s chart—that the patient has no known surgical history. The No
known surgical history entry appears as the only entry. (See page 12.4 for more details on the No known
entry in a patient’s chart.)

Figure 14.5 Surgical History
To view the patient’s surgical history, open their chart, click the Medical Information tab, click the
Histories button and choose Surgical History from the available options (Figure 14.5).



Check the Current checkbox to view only the patient’s
current procedures.

Click the Add button to add a new entry to the patient’s chart. (See Chapter 12 for more details on other
actions you can perform with the entries in the list.) Table 14.2 explains the fields on the Add Surgical
History window in detail.
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Figure 14.6 Add Surgical History Window
Table 14.2 Fields on the Add Surgical History Window

Field

Description

No history of

Place a check mark in this option and select a procedure from the Procedure field
to indicate that you reviewed the patient’s surgical history with them and found
no history with a specific surgery in their past.

Procedure

Click the Lookup icon ( ) next to the Procedure field to choose the appropriate
surgical procedure for this history entry. Highlight the appropriate procedure and
click Insert.

Diagnosis

Click the Lookup icon ( ) next to the Diagnosis field to choose a reason for the
surgery. Click the Add to problem list icon ( ) to add the selected diagnosis to
the patient’s list of problems.

Diagnosed by

In the Diagnosed by field, choose the person who diagnosed the patient’s
problem for which they had surgery.

Date

From the Date field, choose when this surgical procedure occurred. You can enter
an exact date, an approximate date, or an approximate time period (e.g., three
years ago). Place a check mark in the Approx checkbox to indicate the data in the
Date field is an approximation.

Comment

Add any additional, useful information about the surgery in the Comments field. If
you have X-rays or other images you want to attach related to this history item,
click the Lookup icon ( ).

Attachments

To attach documents to the surgical history, click the Lookup icon (
the Attachments field.
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Social History
MicroMD EMR allows you to maintain a record of the patient’s social history conditions. These social
conditions can be either those that the patient currently faces or ones that the patient has faced in the
past.

Figure 14.7 Social History
To view the patient’s social history, open their chart, click the Medical Information tab, click the Histories
button and choose Social History from the available options (Figure 14.7).



Check the Current checkbox to view only the patient’s
current social situations.

Click the Add button to add a new entry to the patient’s chart. (See Chapter 12 for more details on other
actions you can perform with the entries in the list.) Table 14.3 explains the fields on the Add Social History
window in detail.
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Figure 14.8 Add Social History Window



The Social History entry includes a Confidentiality
option to make a specific social history entry visible only
to physicians.

Table 14.3 Fields on the Add Social History Window

Field

Description

No history of

Place a check mark in this option and select a procedure from the Social
history field to indicate that you reviewed the patient’s social history with
them and found no history with a specific social issue in their past.

Social history

Click the Lookup icon ( ) next to the Social history field to choose the
appropriate social issue you want to enter into the history. Highlight the
appropriate social issue and click Insert.

Diagnosed by

Click the Lookup icon ( ) next to the Diagnosed by field to choose the
provider associated with diagnosing the item in the patient’s social history.

Start date

From the Start date field, choose when the social issue started. You can
enter an exact date, an age, a number of years, or a number of months. Place
a check mark in the Approx checkbox to indicate the data in the Start date
field is an approximation.

Confidentiality

If you want to restrict this history entry to be visible only to physicians, select
Physicians Only from the Confidentiality drop-down.

Comment

Enter any additional information in the Comments field.

Terminated by and
Terminated date

For details on terminating an entry in the patient's chart, please see
page 12.5.
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Family History
MicroMD EMR allows you to maintain a record of the patient’s family medical history. The conditions
related to family members can be those conditions the family member faces right now or it could be a
condition that occurred in the past. The Family History for a patient also provides a Family Tree that
depicts the patient’s familial history visually. You can filter the family tree by condition, making it easier to
determine genetic traits. See page 14.10 for more on the Family Tree.
The system also allows you to record—as part of the patient’s chart—that none of the patient’s family
members has any current problems. The No current family problems entry appears in the patient’s family
history record. See page 12.4 for details on the No known entry in a patient’s chart.

Figure 14.9 Family History
To view the patient’s family history, open their chart, click the Medical Information tab, click the Histories
button and choose Family History from the available options (Figure 14.9).



Check the Current checkbox to view only the patient’s
current family history.
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Adding a Family History Entry
Click the Add button to add a new entry to the patient’s chart. (See Chapter 12 for more details on other
actions you can perform with the entries in the list.) Table 14.4 explains the fields on the Add Family History
window in detail.

Figure 14.10 Add Family History Window
Table 14.4 Fields on the Add Family History Window

Field

Description

Family member name

Enter the name of the family member whose condition you want to add to
the patient’s chart. If the family member is a patient, you can click the
Lookup icon ( ) next to the field and insert the family member. If you
have added the family member to the patient’s chart (page 14.10), you can
select the family member from the drop-down.

Relationship

Select the family member’s relation to the patient. If you cannot find the
relationship in the drop-down, click the Lookup icon ( ) next to the
Relationship field to locate the one you need

Birth year and Current age

Enter the age at which the family member encountered the medical
condition.

Diagnosis

Click the Lookup icon ( ) next to the Diagnosis field to locate the
appropriate medical condition for the family member.

Diagnosed by

Click the Lookup icon ( ) next to the Diagnosed by field to choose the
provider associated with diagnosing the patient’s family member. If the
relative’s physician is not a current MicroMD EMR user, you can also type
freely in this field.

14.10
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Table 14.4 Fields on the Add Family History Window (continued)

Field

Description

Start date

From the Start date field, choose when the family member’s condition
began. You can enter an exact date, an approximate date, or an
approximate time period (e.g., three years ago). Place a check mark in the
Approx checkbox to indicate the data in the Start date field is an
approximation.

Comment

Enter any additional information in the Comments field.

Relative died as a result of
this condition and Age at
death

If the family member is deceased because of this condition, place a check
mark in this checkbox and enter their age when they passed away.

Terminated by and
Terminated date

For details on terminating an entry in the patient's chart, please see
page 12.5.

Viewing a Medical Family Tree
MicroMD EMR allows you to view a “family tree” of the patient’s family’s medical conditions. The tree
contains information from the patient’s chart only—it does not access the charts of any other patients to
extract information. The system populates the Medical Family Tree with information from the Family
History (page 14.9) and Genetic History (page 16.10) categories of the Medical Information tab.

Figure 14.11 Medical Family Tree
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Habits

To view a Medical Family Tree, open the patient’s chart, click the Medical Information tab, click the
Histories button and choose Family History. Click the Family Tree button. If you want to filter the list by
condition, click Filter and choose the condition(s) you want to see.



Red text in this window indicates that the family member
passed away as a result of the condition.

Habits
MicroMD EMR allows you to maintain a list of the patient’s habits. This list can contain those habits the
patient currently has or those that the patient has had in the past but has overcome.

Figure 14.12 List of the Patient’s Habits
To view the patient’s list of habits, open their chart, click the Medical Information tab, click the Histories
button and choose Habits from the available options (Figure 14.12).


14.12

Check the Current checkbox to view only the patient’s
current habits.
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Click the Add button to add a new entry to the patient’s chart. (See Chapter 12 for more details on other
actions you can perform with the entries in the list.) Table 14.5 explains the fields on the Add Habit window
in detail.

Figure 14.13 Add Habit Window
Table 14.5 Fields on the Add Habit Window

Field

Description

No history of

Place a check mark in this option and select a habit from the Habit field to
indicate that you reviewed the patient’s habits with them and found no
history with a specific habit to enter into their chart.

Category

Select the category of habit, especially important if you want to record the
patient’s smoking status. When you select Smoking Status, the Habit dropdown changes to Status.

Habit

From the Habit drop-down, select the habit you want to enter. The system
populates the drop-down from your Habits Common List. If you don’t see the
item you want, click the Lookup icon ( ) next to the Habit field to access all
habits in the database.


Diagnosed by

When you select Smoking Status from the Category
drop-down, the Habit field changes to Status. To
ensure proper coding and billing in MicroMD EMR,
you must record the patient’s smoking status
properly.

Click the Lookup icon ( ) next to the Diagnosed by field to choose the
provider associated with diagnosing habit. You can also type the physician’s
name if they are an outside provider not associated with your practice.
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Table 14.5 Fields on the Add Habit Window (continued)

Field

Description

Start date

From the Start date field, choose when the patient began experiencing the
habit. You can enter an exact date, an approximate date, or an approximate
time period (e.g., three years ago). Place a check mark in the Approx checkbox
to indicate the data in the Start date field is an approximation.

Frequency

In the Frequency field, enter how often the patient exercises this habit. For
example, if the patient smokes, enter how many cigarettes or packs they
smoke each day.

Comment

Enter any additional information in the Comments field.

Terminated by and
Terminate date

For details on terminating an entry in the patient's chart, please see
page 12.5.

Hospitalization History
If the patient has been hospitalized for a condition in the past, MicroMD EMR allows you to record this in
the system. The system also allows you to record—as part of the patient’s chart—that the patient has never
been in the hospital, as far as they know. The No hospitalization history entry appears as the sole entry in
the patient’s record. See page 12.4 for details on the No known entry in a patient’s chart.

Figure 14.14 Hospitalization History
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To view the patient’s list of hospitalizations, open their chart, click the Medical Information tab, click the
Histories button and choose Hospitalization History from the available options (Figure 14.14).
Click the Add button to add a new entry to the patient’s chart. (See Chapter 12 for more details on other
actions you can perform with the entries in the list.) Table 14.5 explains the fields on the Add
Hospitalization History window in detail.

Figure 14.15 Add Hospitalization History Window
Table 14.6 Fields on the Add Hospitalization History Window

Field

Description

Date admitted

From the Date admitted field, choose when the patient arrived at the hospital.
You can enter an exact date, an approximate date, or an approximate time
period (e.g., three years ago). Place a check mark in the Approx checkbox to
indicate the data in the Start date field is an approximation.

Date Discharged

The Date Discharged field populates automatically based on the number of
days you enter in the Length of stay field.

Length of stay and ER
Only

In the Length of stay field, indicate how many days the patient was in the
hospital. If the patient was only kept in the emergency room, place a check
mark in the ER Only checkbox.

Hospital

In the Hospital field, enter the name of the hospital for this record, if known.
You can also select from your practice’s list of hospitals. The system pulls the
list in the drop-down from your Service Facility Contact Manager (page 8.10).
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Table 14.6 Fields on the Add Hospitalization History Window (continued)

Field

Description

Unit

In the Unit field, enter the department in the hospital where the patient
stayed, if known. For example, ICU. The system pulls the list in the drop-down
from the Units tabs in all entries of your Service Facility Contact Manager
(page 8.10).

Admission reason

In the Admission reason field, enter what caused the patient to enter the
hospital. For example, car accident.

Number of previous
hospitalizations for
the same condition

If the patient has been hospitalized for the same reason multiple times, enter
the number of admissions in the this field.

Notes/Comment

Enter any additional information in the Comments field.

Diagnoses

Click the Lookup icon ( ) next to the Diagnosis field to locate and insert the
appropriate medical condition associated with this hospital stay.

Procedures

Click the Lookup icon ( ) next to the Procedure field to locate the
appropriate procedures performed during the patient’s hospital stay.

Hospital Reports

If you have a hospital report to attach to the history entry, click the Lookup
icon ( ) next to this field. On the window that opens, you can add
attachments, type free text and more.

Attachments

Click the Lookup icon ( ) next to the Attachments field to add any
documents to this record. For example, you can add any X-rays received from
the hospital for the patient’s broken foot.
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Asthma History
MicroMD EMR allows you to maintain a history of the patient’s asthma. You can enter detailed information
about when the patient last had a skin test, what triggers their asthma and more. The system also allows
you to record—as part of the patient’s chart—that the patient has no known history of asthma. The No
known asthma entry appears as the only entry. See page 12.4 for details on the No known entry in a
patient’s chart.

Figure 14.16 Asthma History
To view the patient’s asthma history entries, open their chart, click the Medical Information tab, click the
Histories button and choose Asthma History from the available options (Figure 14.16).
Click the Add button to add a new entry to the patient’s chart and complete the fields on the window. (See
Chapter 12 for more details on other actions you can perform with the entries in the list.)
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Figure 14.17 Add Asthma History Window
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Environmental History
MicroMD EMR allows you to capture and maintain a history of the patient’s environmental history. You can
enter detailed information about the patient’s living conditions and their work conditions.

Figure 14.18 Environmental History
To view the patient’s environmental history, open their chart, click the Medical Information tab, click the
Histories button and choose Environmental History from the available options (Figure 14.18).
Click the Add button to add a new entry to the patient’s chart and complete the fields on the window. (See
Chapter 12 for more details on other actions you can perform with the entries in the list.)
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Figure 14.19 Add Environmental History Window

Surgical Procedures
The Surgical Procedures section of the patient’s chart allows you to maintain a history of the patient’s
surgeries performed by your practice and the in-depth details of those surgeries. You can include the
details of procedures your practice performs on the patient, including who scrubbed in, what supplies
were used during the operation, and what precise steps were performed throughout the operation.
The Surgical Procedures section of the patient’s chart is
different from the Surgical History section (page 14.5):

○

14.20

 the Surgical History section of the patient’s chart
allows you to maintain a history of those surgeries
performed on the patient OUTSIDE of your
practice
 the Surgical Procedures section maintains the
history those surgeries performed by providers
WITHIN your practice.
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Figure 14.20 History of Surgical Procedures
When you click the Add button on the Surgical Procedures section of the patient’s chart, the system opens
the Operating Room window (Figure 14.21). The tabs on this window allow you to record a great deal of
detail.

Figure 14.21 Adding an Operation to the Patient’s Chart
You can also create templates for those surgeries that you perform frequently. The templates allow you to
establish the common steps involved in the surgery, as well as the estimated time for each step. Click the
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Template button to load an operation template you want to use. See page 14.22 for details on creating
operation templates.
The Clear button allows you to clear all data entered on all tabs, except the Surg. Summary and
Anesthetic tabs.

Operation Templates
The system provides you with the ability to create templates for the operations you perform frequently.
The templates allow you to establish the common steps involved in the surgery, as well as the estimated
time for each step. Once you have the typical information established, you can modify them on a case-bycase basis when recording the actual surgery in the system.
To access the operation templates, select Tools > Surgery Tools > Operation Templates from the main
menu. For details on working with templates in MicroMD EMR, please see page 2.8.
When you click the New button to create a new template, the system opens the Operation Wizard window
(Figure 14.22). This first step of the wizard allows you to establish the default steps that appear when you
load this template.

Figure 14.22 Operation Wizard



If the steps that come with the system do not suit your
needs, you can create a new step simply by clicking the
New Step button.

Highlight the step on the Available Steps side of the window and click the Add button to use it in your
template. You can also double-click the step or drag and drop it to the right side of the window.
When you add the step to the template, the Edit Operating Step window opens. This allows you to indicate
at what point in the progress of the surgery the step begins. Click Next to advance to the next step in the
template creation.

14.22
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Figure 14.23 Type of Personnel Typically Involved in the Operation



If the list of personnel types that comes with the system
does not suit your needs, you can create a new type
simply by clicking the New Personnel Type button.

Highlight the type on the Available Personnel Types side of the window and click the Add button to use it
in your template. You can also double-click the step or drag and drop it to the right side of the window.
When you use the template, you can then associate an actual MicroMD EMR user with the personnel type.
Click Next to advance to the next step in the template creation.
The next few steps of the wizard allow you to establish the typical equipment, surgery kits and materials
you use for this operation and the quantity of each. Each of these steps are similar in look and function to
the Operating Equipment window (Figure 14.24).

Figure 14.24 Equipment Typically Used for this Operation
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Highlight the step on the Available side of the window and click the Add button to use it in your template.
You can also double-click the step or drag and drop it to the right side of the window.
When you add the equipment, kit or material to the template, you should indicate the quantity of the item
typically used in the operation. Highlight the item and click the Quantity icon ( ) to enter how much of
the item you expect to be used. Click Next to advance to the next step in the template creation.

Figure 14.25 Operation Summary Template Typically Used for This Operation
After the materials step, the system allows you to choose to include an operation summary template.
When you record a surgery in the system, the Surg. Summary tab (Figure 14.21 on page 14.21) provides a
text area where you can record any additional information about the surgery. If you consistently want to
use the same type of data whenever you perform a surgery, you can create a summary template to use.
To add a summary template to the operation template, simply click the Lookup icon ( ) next to the
Operation Summary field. To remove the summary template from this operation template, click the
Delete icon ( ). For details on working with MicroMD EMR templates, please see page 2.8. See page 14.24
for details on Operation Summary templates.
Click Finish when satisfied with the template. Enter a name for the template and click Save.

Operation Summary Templates
Operation Summary templates work just like Text Encounter templates (page 23.37) without the SOAP
tabs. Operation Summary templates provide you with a Fields tab (page 26.4), a Pick Lists tab
(page 22.38), and a Quick Text tab (page 23.32).
To access the summary templates, select Tools > Surgical Tools > Operation Summary Templates from
the main menu.
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Birth History
This section of the patient’s chart provides a storehouse for information about the birth of the patient. This
is especially helpful for pediatric patients.

Figure 14.26 Recording Details of the Patient’s Birth

○

This section of the chart is not a list. There is only one
entry allowed.
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Sexual History
If you have sexual history that you want to record for the patient to help maintain detailed electronic
records, the system provides a section of the patient’s chart where you can create a list of issues that make
up the patient’s sexual history.

Figure 14.27 Sexual History
To view the patient’s sexual history, open their chart, click the Medical Information tab, click the
Histories button and choose Sexual History from the available options (Figure 14.27).



Check the Current checkbox to view only the patient’s
current history.

Click the Add button to add a new entry to the patient’s chart. (See Chapter 12 for more details on other
actions you can perform with the entries in the list.) Table 14.7 explains the fields on the Add Sexual History
window in detail.
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Figure 14.28 Add Sexual History Window



The Sexual History entry includes a Confidentiality
option to make a specific social history entry visible only
to physicians.

Table 14.7 Fields on the Add Sexual History Window

Field

Description

No problem of

Place a check mark in this option and select a behavior from the Description
field to indicate that you reviewed the patient’s sexual history with them
and found no issues with a specific behavior.

Description

From the Description drop-down, select the type of sexual behavior
represented by this history entry. The system pulls the items in the dropdown from your Sexual History Common List.

Diagnosed by

Click the Lookup icon ( ) next to the Diagnosed by field to choose the
provider associated with diagnosing this entry in the patient’s sexual
history. You can also type the physician’s name if they are an outside
provider not associated with your practice.

Start date

From the Start date field, choose when the patient began this sexual
behavior. You can enter an exact date, an approximate date, or an
approximate time period (e.g., three years ago). Place a check mark in the
Approx checkbox to indicate the data in the Start date field is an
approximation.

Number of partners

Enter the number of current partners related to this sexual history entry.

Number of past partners

Enter the number of past partners related to this sexual history entry.
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Table 14.7 Fields on the Add Sexual History Window (continued)

Field

Description

Confidential

If you want to restrict this history entry to be visible only to physicians, select
Physicians Only from the Confidentiality drop-down.

Treatment

Enter any details about the patient’s treatment related to this sexual history
entry, including if they had no treatment.

Comment

Enter any additional information in the Comments field.

Terminated by,
Terminated date and
Reason for termination

For details on terminating an entry in the patient's chart, please see
page 12.5.
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Medical Information: Orders
The Orders section of the patient’s chart houses all laboratory, procedure, referral, immunization and
nursing care orders placed for the patient throughout their history with your practice. You can also perform
any of these orders from this tab, as well as from your Desktop, as long as you have appropriate security
access to the patient’s chart. Any orders requested for the patient during an encounter also appear on this
tab, as well as your Desktop if you were assigned the task of completing the order.

In This Chapter
In this chapter, we cover:

 Laboratory Orders (page 15.2)
 Procedure Orders (page 15.6)
 ABN Forms (page 15.9)
 Referral Orders (page 15.11)
 Immunization and Nursing Care Orders (page 15.13)
 Administer Medication Orders (page 15.15)
 Performing Orders (page 15.16)
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Laboratory Orders
When a user creates a lab order for a patient in the system, that order also appears on this section of the
patient’s chart. You can manage the orders for this individual patient from their Medical Information tab.



If you want to manage orders assigned to you for several
patients, use your Desktop (page 4.19).

Figure 15.1 Laboratory Orders in a Patient’s Chart
If you need to add a laboratory order outside of an encounter, you can do so in this section of the patient’s
chart. To edit, delete or print an order, simply highlight the entry and click Edit, Delete or Print as
appropriate. When you click the Add button, the system opens the Laboratory Orders window (Figure
15.1).



The system remembers several fields per panel per lab
company when creating or editing an order and
populates them the next time you create a similar order.
Those fields are: Specimen Src, Collection Qnty, Units
and Account No.
If you have multiple panels on an order, the system
remembers the details for each of those panels.

15.2
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Figure 15.2 Add a New Laboratory Order
Complete the fields on this window and click OK. If you need to print the Advance Beneficiary Notice (ABN)
when you feel Medicare may not pay for the test, simply click the drop-down next to the Print ABN button
and select English or Spanish from the drop-down menu. This prints a form the patient can sign, and you
can keep for your records.
To add documents to the lab order, click the Lookup icon (
details on adding attachments, see page 20.1.



) next to the Documents Received field. For

To create a reminder in the patient’s chart about the test,
click the Reminder button (page 10.26).

To mark the order as performed, highlight the entry in the main window and click Perform. Complete the
fields on the window and click OK.
Table 15.1 Fields on the Laboratory Orders Window

Field

Description

Patient Name

Enter the patient’s name if the system has not already done so for you.

Ordered By

Enter the MicroMD EMR user ordering the laboratory test. This field defaults
to the current user.

Results To

Enter the provider to whom the system should send the results of this lab
test.
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Table 15.1 Fields on the Laboratory Orders Window (continued)

Field

Description

Assigned To

Enter the MicroMD EMR user(s) and/or group(s) responsible for this test.
The system uses the defaults you have set in the Default resources to
perform plan items section of your Encounter preferences (under Tools >
User Preferences).

Order Date

The system defaults to the current system date and time. Change this field
if necessary.

Complete By

If you need this order to be completed by a certain date, enter that date in
this field.

Priority

Select a priority for this lab test. The system defaults to Routine.

Laboratory

Choose the appropriate laboratory for this test. The system defaults to the
first laboratory in the list.

Panels/Tests

Click the Lookup icon ( ) to choose the panels/tests you want to include
in this order. The system automatically displays only those panels/tests
available for the laboratory selected in the Laboratory drop-down.

Diagnoses

Highlight a panel in the Panels/Tests field and click the Lookup icon ( )
next to the Diagnoses field to choose the appropriate assessment(s) for
that panel. You can associate multiple assessments with each panel.

LOINC

The LOINC field displays the panel-level LOINC for the selected panel. As
you select each panel in the Panels/Tests field, the LOINC field changes to
display the LOINC currently associated with the panel (if there is one). Click
the Lookup icon ( ) next to the field to add a code to the selected panel if
there isn’t one or to change the current code on the selected panel for this
order. Establish the default LOINC for the panel in the EMR Manager under
In-House Settings on either the Inhouse Labs or Custom Labs tabs
(page 1.71 and page 1.73, respectively).

Specimen Src

Select the type of specimen collected for the selected panel/test. The
system remembers the selection you make from this field and populates
the same choice the next time you create an order for this same panel for
this same laboratory company.

Collection Date
and Time

Enter the date and time you collected the specimen, if applicable at
this time.

Collection Qnty
and Units

Enter how much of the specimen that was collected. The system
remembers the selections you make in these fields and populates the same
choices the next time you create an order for this same panel for this same
laboratory company.

Comment

Enter any additional comments about this laboratory order.

Copy from button

If you have multiple panels in your laboratory order that have the same
details, you can click the Copy from button to copy the details from
another panel to the one selected.

15.4
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Table 15.1 Fields on the Laboratory Orders Window (continued)

Field

Description

Patient Insurance:
Primary and Secondary

The system displays the patient’s primary and secondary insurance plans
as established in their patient demographics.

○
Bill type

The system could display a message that there is no
mapping of the patient’s insurance to the laboratory.
Please see page 8.9 for more in-depth details about
mapping insurance companies to laboratories.

From this drop-down, you can indicate who is responsible for paying the
bill to the laboratory company:

 Patient Billing: When you select this option, the lab company sends the
full bill to the practice, assuming that the patient has paid the practice
the amount due.

 Client Bill (Account): With this option, the lab company sends the full
bill to the practice with the knowledge that the practice is responsible
for the amount due.

 3rd Party: When you select this option from the drop-down, MicroMD
EMR includes the patient’s insurance information with the lab order.
Once completed, the lab company sends the bill for the order to the
patient’s insurance company. They do not send a bill to the practice.

 Client Bill (Indigent): Select this option when there is an agreement
between the practice and the lab company to split the bill for the lab
service. The lab company sends the full bill to the practice with the
agreed percentage discounted off the bill.

 Client Bill (Sliding Scale): When you select this option, the lab company
figures the sliding fee based on the government’s scale and includes
that figure on the bill sent to the practice. The practice receives the full
bill with the knowledge that they have collected the appropriate sliding
fee amount from the patient.
Ordering Clinic

Select the clinic placing this order. This drop-down defaults to the clinic
selected Current Location drop-down in your Session Profile preferences
(under Tools > User Preferences).

Potentially dangerous
specimen
and Patient fasting

Place a check mark in the appropriate checkbox.

Clinical Info

This is a free-text area where you can enter any additional clinical
information regarding this laboratory order.

Additional clinical info

Click the down arrow ( ) and select the additional information you want
to add about this order, including blood lead and pathology information.
These options open different data-entry windows. Complete the windows
as necessary.
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Table 15.1 Fields on the Laboratory Orders Window (continued)

Field

Description

Specimen Collection

From this drop-down, select how the specimen for this order was or will be
collected. You can also indicate if the patient did not come in for the lab
work or if they were unable to provide a specimen.
If you select Patient Refused from the drop-down, the system displays the
Refusal Reason drop-down. Be sure to indicate the patient’s reason for
refusing the test.

Account No

The system displays a list of account numbers entered in the MicroMD EMR
Manager for the laboratory. The Account No field displays the account
number chosen for this laboratory order. (See page 1.58 for details on
entering account numbers for laboratory interfaces.)
The system remembers the selection you make from the Account No field
and populates the same choice the next time you create an order for this
same panel for this same laboratory company.

Order Status

This is the current status of the laboratory order. The system automatically
sets this drop-down to Requested when you create the order. Change this if
necessary.

Comment

Enter any additional comments about the order in general.

Documents Received

If you have external documents you need to add to the laboratory order,
click the Lookup icon ( ) next to the Documents Received field. This
opens the Add Attachment window. See page 20.1 for more details on this
window.
Click the Edit icon ( ) if you need to make changes to the document. This
opens the document in MicroMD Document Management (Chapter 28).

Procedure Orders
When you create an encounter, you have the ability to create an order that a procedure be performed on
the patient and assign it to MicroMD EMR user(s)/group(s). Whether your practice performs the procedure
in-house or the procedure is performed outside the practice, you can record the details of the procedure in
the patient’s chart. (See page 15.16 for details on performing orders.)

15.6
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Figure 15.3 Procedure Orders in a Patient’s Chart



If you want to manage orders assigned to you for several
patients, use your Desktop (page 4.19).

If you need to add a procedure order outside of an encounter, you can do so in this section of the patient’s
chart. To edit, delete or print an order, simply highlight the entry and click Edit, Delete or Print as
appropriate.
When you click the Add button, the system opens the Add Procedures Orders window (Figure 15.4).
Complete the fields on this window and click OK. (For details on adding attachments, see page 20.1.)
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Figure 15.4 Add a New Procedure Order



To create a reminder in the patient’s chart about the
procedure, click the Reminder button (page 10.26).

To mark the order as performed, highlight the entry in the main window and click Perform. Complete the
fields on the window and click OK.

○


15.8

The insurance section of the Add Procedures Orders
window allows you to select the insurance company that
pays for the procedures in the order. You can also enter
any pre-authorization information obtained from the
insurance company. This information is included in the
printout of the order.

When you hover your mouse over the blue arrow, the
system displays the insurance plan’s contact
information, as well as the subscriber’s information.
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ABN Form for Procedures and Labs
You can create ABN forms in the EMR for both procedures and laboratory orders. The ABN form is a
customizable Administrative Form, and practices can choose a separate ABN form per laboratory
company if necessary.
In the standard form for both labs and procedures, the system automatically populates the practice and
patient information. In the first drop-down in the NOTE area, you can choose the text that best suits your
need for the form. Once selected, this text populates the other areas of the form with that word.

Figure 15.5 ABN for Plan Items
In the first column of the middle section, the system populates the drop-down with the labs or procedures
listed in the order. This allows you to simply select the labs or procedures that apply to the ABN. The
middle column allows you to choose a reason from the standard list provided by CMS. Type the estimated
cost in the last column if known.
If you have an electronic signature device from Topaz Systems or a tablet computer, you can double-click
the signature area and capture the patient’s signature. If you prefer the patient sign a printed copy of the
form, simply click the Next button after you have completed the form and click the Print Form button.

Customized ABN Form
With the ability to capture an electronic signature, the ABN form is a customizable Administrative Form.
There is a standard form created already for you and is set by default in the system. If you would like to
make changes to this form, you can select Tools > Administrative Forms, copy the form into the Shared
folder and edit as needed. See page 20.18 for details on working with administrative forms.
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○

ABN Form for Procedures and Labs

If the form is to be used throughout workstations at your
practice, you must save the Administrative Form template
in the Shared folder.

Default ABN Form – Procedures
There is a standard ABN form created for procedures in the system; however, you can change this template
if your practice needs the ABN form to act differently or display different information. You can find this
default setting in the MicroMD EMR Manager under the System Settings button on the Practice tab
(Figure 15.6).

Figure 15.6 Default ABN for Procedures
Click the Lookup icon ( ) next to the Default ABN(s) for procedure orders field. This displays the ABN
Forms reference list and allows you to choose the form that displays for the English and Spanish options
on the Procedure Order window.

Default ABN Form – Labs
Each lab company has the potential to require different information on the ABN form you submit to them.
For that reason, you have the ability to associate a different ABN Administrative Form to each lab interface
individually if necessary. You can find this option on the last step of the System Integration Wizard when
setting up a laboratory interface in the MicroMD EMR Manager (click the Communication button and
select Laboratory in the System pane).

Figure 15.7 Default ABN for Labs
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Simply click the Lookup icon ( ) next to the English and Spanish fields of the Advanced Beneficiary
Notice (ABN) of Non-Coverage section (Figure 15.7) to choose the form you want to use.

Referral Orders
When you refer your patients out to specialists, the system provides you with the ability to record the
details of the referral, as well as printing a letter for the physician. When you receive the report (and any
other documents) back from the specialist, you can attach them to the referral to help you keep the
patient’s information organized.

Figure 15.8 Referral Orders Listed in Patient’s Chart



If you want to manage referrals for several patients, use
your Desktop (page 4.19).

If you need to add a referral order outside of an encounter, you can do so in this section of the patient’s
chart. To edit, delete or print an order, simply highlight the entry and click Edit, Delete or Print as
appropriate.
When you click the Add button, the system opens the Referral Order window (Figure 15.9). Complete the
fields on this window and click OK. (For details on adding attachments, see page 20.1.)
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Figure 15.9 Add a New Referral Order



To create a reminder in the patient’s chart about the
referral, click the Reminder button (page 10.26).

Click the Referral Letter button to print the referral letter right from this window. To fax the referral to the
specialist, simply click the Fax button. In order to use the fax, you need to make sure your system is set up
for faxing. See page 1.53 for more details on external communications.

○

To print the built-in Request for Referral, click the Print
button on this window.



Click the Mail button on the Print Options window to
send the referral order through Surescripts direct mail.

A referral has a variety of stages that you may need to record, from rejection by the insurance company to
your receipt of the referral report. Use the Status drop-down to record the referral’s current stage. You can
also use the Report type received drop-down to indicate the report sent to you by the other physician.
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The insurance section of the Referral Order window
allows you to select the insurance company that pays for
the procedures in the order. You can also enter any preauthorization information obtained from the insurance
company. This information prints on the order.

When you hover your mouse over the blue arrow,
the system displays the insurance plan’s contact
information, as well as the subscriber’s information.

Immunization and Nursing Care Orders
Both the Immunization Orders and Nursing Care Orders sections work identically. When you create these
orders in a patient’s encounter, the orders appear in the Orders section of the patient’s chart, as well as the
Desktop of the user(s) assigned to the order. From administering a DTaP to little Bobby or providing
chemotherapy to Andy Homer, you can record in-depth details about the item in the patient’s chart.

Figure 15.10 Nursing Care Orders in Patient’s Chart
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Immunization and Nursing Care Orders

If you want to manage orders assigned to you for several
patients, use your Desktop (page 4.19).

If you need to add an order outside of an encounter, you can do so in this section of the patient’s chart. To
edit or delete an order, simply highlight the entry and click Edit or Delete as appropriate. When you click
the Add button, the system opens the appropriate window (Figure 15.11). Complete the fields on this
window and click OK. (For details on adding attachments, see page 20.1.)

Figure 15.11 Add a New Immunization Order or New Nursing Care Order
You can tie the order to the patient’s insurance in the Insurance section and record whether you have
obtained authorization for the immunization or the nursing care.
To mark the order as performed, highlight the entry in the main window and click Perform. Complete the
fields on the window and click OK.
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Medication Orders
Medication orders are any medications that you need to administer within your practice (e.g.,
chemotherapy drugs or addiction therapy medications). These are not medications patients fill at a
pharmacy. When you create a medication order in a patient’s encounter, the order also appears in the
Orders section of their chart, as well as the Desktop of the user(s) assigned to the order.

Figure 15.12 Medication Orders in the Patient’s Chart



If you want to manage orders assigned to you for several
patients, use your Desktop (page 4.19).

If you need to add an order outside of an encounter, you can do so in this section of the patient’s chart. To
edit or delete an order, simply highlight the entry and click Edit or Delete as appropriate. When you click
the Add button, the system opens the Add Administer Med Orders window (Figure 15.13). Complete the
fields on this window and click OK. (For details on adding attachments, see page 20.1.)
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Figure 15.13 Add a New Order to Administer Medication
You can tie the order to the patient’s insurance in the Insurance section and record whether you have
obtained authorization for the medication you need to administer.
To mark the order as performed, highlight the entry in the main window and click Perform. Complete the
fields on the window and click OK.

Performing Orders
Once you have orders created in the EMR, there are a few ways to document the performance of an order:

 Desktop: Staff can perform orders from the Orders section of the Desktop. Simply highlight the
order and click the Perform button.

 Patient Chart: You can also perform an order from within the patient’s chart. On the Medical
Information tab, click the Orders button and choose the type of order you want to perform.
Highlight the order and click the Perform button.

 Encounter: Depending on your workflow, you can also perform an order from within the
patient’s encounter either while you still have it open or opening it again (as long as it hasn’t
been signed yet). On the Plan tab, highlight the procedure and click the Perform button.

15.16
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Medical Information: Specialties
The Specialties button on the patient’s Medical Information tab allows providers within the different
specialties to record medical data specific to their patients. For example, a pediatrician can access Denver
II Development Tests and record this information for the children they see. You can record information
specific to a diabetic patient, as well as information specific to allergy testing for a patient.

In This Chapter
In this chapter, we cover:

 Diabetes (page 16.1)

 Hearing Screening (page 16.8)

 Pediatric Development (page 16.3)

 Allergy Testing (page 16.9)

 Eye Examination (page 16.5)

 Genetic History (page 16.10)

 Vision Screening (page 16.6)

 Geriatrics (page 16.11)

 Hearing Examination (page 16.7)

Diabetes
The Diabetes section of the patient’s chart provides a way for you to document the patient’s glucose levels
over time. You can print a form that the patient takes home with them and that you can use to record the
data in the system when the patient returns.

Figure 16.1 Diabetes Section of Patient Chart
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Diabetes

If you want to edit or delete an instruction form, simply highlight the entry and click the Edit or Delete
button as appropriate. To print the list of entries on this window, just right-click anywhere in the top
portion of the window and select Print List from the pop-up menu. To print the details of an entry,
highlight the entry and click the Print button.
To create a new instruction form for the patient, simply click the Add button and complete the fields on
the window that opens (Figure 16.2), as few or as many as needed at the time. Once you have glucose data
to enter, you can open the form up and enter the data.

Figure 16.2 Diabetes Instruction Form
You can export this form to Microsoft Word or to WordPad. Click the Export button and choose the
appropriate format.

16.2
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Pediatric Development
The Denver II Development Tests are a standard used by pediatricians to track the growth and
development of their patients. MicroMD EMR provides access to these charts for physicians to record
appropriate data for their patients.

Figure 16.3 Pediatric Development in Patient’s Chart
This window displays the list of tests available, when they were first added to the patient’s chart and when
they were last updated. Highlight each test to display the details in the yellow area below the list. To
display the data from the tests in a visual format, click the Graph button. The graphs are similar to those
found in certain reports.
If you want to edit one or all of the tests, you can click the Edit button. This opens the Denver II
Development Tests window where you can choose the test you want to complete. If you want to complete
all of the tests at once, click the All Tests button.

MicroMD EMR User’s Reference Manual Version 16.0

16.3

Chapter 16. Medical Information: Specialties

Pediatric Development

Figure 16.4 Choosing the Tests to Complete
Once you click one of the buttons, the system displays a window that varies, depending on the test you
chose. All of the tests have sliders and a Set All to Normal button that allows you to record the results of
the development test. A check mark next to an item indicates that data was entered for the item. Click
Next on any of the windows to proceed to the next step of the test.

Figure 16.5 Completing the Test(s)
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Eye Examination
MicroMD EMR provides an area for a physician, nurse or other user with chart access to record eye
examinations they perform for the patient during their visit. The system allows you to record the patient’s
current vision correction, the results of their visual acuity test and other aspects of their vision.

Figure 16.6 Eye Examinations in a Patient’s Chart
If you need to edit or delete an exam in the list, simply highlight the entry and click the Edit or Delete
button as appropriate. The system also allows you to print the details of an eye exam. Highlight the exam
you want to print and click the Print button. To add a new eye exam to the patient’s chart, click the Add
button and complete the window that opens (Figure 16.7).
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Figure 16.7 Adding an Eye Exam to the Patient’s Chart

Vision Screening
The Vision Screening section of the patient’s chart is almost identical to that of the Eye Examination
section (page 16.5); however, the window that appears when you click Add only provides detail for the
recording the patient’s visual acuity at the time of the screening (Figure 16.8).

Figure 16.8 Adding a Vision Screening to the Patient’s Chart
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Hearing Examination
The system provides an area in the patient’s chart to record hearing examinations you perform on a
patient. You can record the patient’s normal hearing range, as well as conducting bone conduction tests.
The system also provides space to record the patient’s speech recognition threshold.

Figure 16.9 Hearing Examinations in a Patient’s Chart
The yellow area below the list provides the details of the exam. Click the right and left arrows at the top
right corner of the yellow area (
) to view each of the individual exam. To edit or delete an existing
entry, simply highlight the entry and click the Edit or Delete button as appropriate.
You can also graph the details of an exam. Highlight the exam you want to view and click the Graph button
to display the data in a diagram format.
If you want to write a report about an exam in the list, highlight the exam and click the Report button. This
opens a text editor that allows you to type the information you want to include. To print the details of an
exam, highlight the exam and click the Print button.
To add a new hearing examination to the patient’s chart, click the Add button and complete the window
that opens (Figure 16.10). Click the Next button to advance to the individual exams.
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Hearing Screening

Figure 16.10 Adding a Hearing Exam to the Patient’s Chart
When you record each hearing exam, you can record in increments of either 5 or 10. Simply choose the
appropriate number from the Increments of options.

○

If you change the increments from 5 to 10 on the exam
you are currently creating, the system must remove any
data that you entered because it hasn’t saved it yet.
If you change the increments from 5 to 10 on an existing
hearing exam, the system removes any data that was
entered in the increments of 5.

Hearing Screening
The Hearing Screening section of the patient’s chart is almost identical to that of the Hearing section;
however, the window that appears when you click Add provides a few of the normal frequencies and a
couple normal decibel levels to screen the hearing of each ear quickly (Figure 16.11).

Figure 16.11 Adding a Hearing Screening to the Patient’s Chart
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Allergy Testing
For allergists, MicroMD EMR provides an area in the patient’s chart to record allergy tests performed on the
patient, the results of the test and what method was used for the test.

Figure 16.12 Allergy Tests in a Patient’s Chart
The yellow area below the list displays the details of the selected allergy test. To edit or delete a test in the
list, simply highlight the entry and click the Edit or Delete button as appropriate. To print the details of a
test, highlight the entry and click the Print button. To add an allergy test to the patient’s chart, click the
Add button and complete the window that opens (Figure 16.13).

Figure 16.13 Adding an Allergy Test to the Patient’s Chart
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Click the Next button to proceed through the different kinds of tests. By default, the system automatically
places a check mark in the Not Tested checkbox. Once you choose a test result, the system removes the
check mark. Click Finish when satisfied with the recorded results.

Genetic History
For those physicians that have screened the patient’s history of common genetic diseases, including
any that have occurred in their family, the system provides a place for you to record the results of this
screening.

Figure 16.14 Genetic History in the Patient’s Chart
Once you add genetic history to the patient’s chart, it becomes a permanent part of the chart. You cannot
remove any of the entries. You can only edit them as needed. To record the results of the initial genetic
history, click the Add button and complete the fields that pertain to the patient (Figure 16.15). Click the
Lookup icon ( ) next to the Familial Relationship column to insert the family member with the disorder
or disease.
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Figure 16.15 Entering Genetic History Results



If you have already entered one of these items in the
patient’s Family History, the system automatically pulls
that information into the history results for you.

If you want to review the patient’s medical family tree, click the Genetic Tree button. For more details on
the medical family tree, please see page 14.11.

Geriatrics
The system also provides an area in the patient’s chart that allows physicians to record information
specific to older patients. This includes a depression scale, a short screening form to gauge the patient’s
mental state and a questionnaire to help you determine the patient’s ability to care for themselves.

Figure 16.16 Geriatrics Information in Patient’s Chart
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Geriatrics

To edit or delete an entry from this list, simply highlight the entry and click the Edit or Delete button as
appropriate. The system also allows you to compare scores for all the entries in the list. Click the Compare
button and the system displays just the scores from each entry in a list format so you can see if any trends
emerge. The Preview button provides the list of questions and their answers for the highlighted entry in
the list.
To add an entry, click the Add button and complete all of the fields on the form (Figure 16.17). Click Next to
advance through each step.

Figure 16.17 Completing a Visit with a Geriatric Patient

○

16.12

On all steps of the form, use the vertical scrollbar to
access all questions for that step.
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The Health Maintenance section of the patient’s chart provides in-depth information about the preventive
care you provide to them. MicroMD EMR provides interactive checking based on rules established in
screening-and-prevention and immunization templates that you create, improving clinical decision
making. You can also create goal-monitoring templates and create risk profiles for patients.

In This Chapter
In this chapter, we cover:

 Creating Screening-and-Prevention and Immunizations templates (page 17.1)
 Refreshing the Screening & Prevention and Immunizations sections (page 17.8)
 Managing immunization consent forms (page 17.10)
 Managing recommendations (page 17.12)
 Adding and maintaining patient goals in the chart (page 17.23)
 Adding and maintaining risk profiles in the chart (page 17.24)
 Working with health concerns in the patient’s chart (page 17.25)
 Enrolling the patient and adding time for a Chronic Care Management program (page 17.31)

Screening and Prevention/Immunizations
The Screening & Prevention and Immunizations sections of the patient’s Health Maintenance work the
same way, with just a few differences.

Templates
If you have standard prevention programs or series of immunizations you establish for your patients, the
system allows you to create templates for those standards of care. You can either use these templates
manually or add rules to the templates that allow the system to update the patient’s chart automatically
for you. There are two types of templates:

 Screening-and-Prevention: These are procedures, labs, nursing care and other preventive steps
you want the patient to have on a scheduled basis. For example, pregnant patients should have
a urinalysis, weight, blood pressure check and fetal heart tones at each visit.

 Immunizations: If you have standard immunization series that you perform for your patients,
you can create templates to help you quickly add those to the patient’s chart. For example, if
you are a pediatrician, you have several standard immunizations that children should have by a
certain age. Create a template for each of these immunizations so you only have to enter the
details once. Let the system automatically calculate the dates for you.

Starting a Template
To access the template builder for these, select Tools > Screening & Prevention Templates or
Tools > Immunization Templates from the main menu. This displays the template manager for the
type of template you want to create. Click the New button to start a new template. This opens the
appropriate template builder window (Figure 17.1).
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Screening and Prevention/Immunizations

Figure 17.1 Screening-and-Prevention Template Example
Starting a template is the same for both the Screening & Prevention and Immunizations sections. You
can indicate the source of your information (e.g., AMA Guidelines). The system also allows you to add
rules to the templates, as well as add reference materials. Table 17.1 explains the fields of this window
in more detail.



When you create a Health Maintenance template, that
template applies to everyone in the practice, even
when it is in your Personal folder.

Table 17.1 Fields on the Template Wizard Window

17.2

Field

Description

Template Name

Enter an easily identifiable name for the template. This text appears in the
Template column in the patient’s chart (Figure 17.6 on page 17.9).

Description

If you want to provide more detailed information about the template or the
recommendations contained within it, you can enter some text in this field. It
is for informational purposes and only displays when a user views the
properties of the template.

Sources

This is a simple text field where you can record where you received your
information for the recommendations you include in this template. This field
is for informational purposes only and does not display anywhere.

Created by

The Created by fields display the user who created the template and the
date they created it.

Last Modified

The Last Modified fields display the last user who made changes to the
template and when they made those changes.
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Table 17.1 Fields on the Template Wizard Window (continued)

Field

Description

Active

If you do not want the system to apply a template to patient charts, you
make it an inactive template by removing the check mark from the Active
checkbox. By default, every new template is active.



If you are in the middle of creating a template, you
can remove the check mark from the Active checkbox,
making it inactive until you are ready to use it.

Rules for template
activation

These are the rules that the system reviews when it refreshes a patient’s
Screening & Prevention and Immunizations recommendations. Click the
Lookup icon ( ) to add rules to the template and click the Modify icon
( ) to edit existing rules. To remove a rule from the template, click the
Delete icon ( ). See page 17.3 for more details on adding rules to a
template.

References

You can add documents, recordings or web pages to the template that you
can access from within the patient’s chart. Click the Lookup icon ( ) to
add a reference. Click the Modify icon ( ) to edit an existing. Click the
Delete icon ( ) to remove a reference. See page 17.5 for more details on
adding documentation to a template.

Adding Rules to a Template
When you add rules to templates, the patient or the information in their chart must meet each criteria
that you set before the system adds the recommendation to the patient’s chart. If you have more than
one rule listed in the template (i.e., two or more rule entries in the Rules for template activation field in
Figure 17.1 on page 17.2), the patient or the information in their chart must meet all of the criteria set in
all rules.



If you do not want the system to automatically add
recommendations to patient charts, simply do not add
rules to your templates.

To add a rule to the template, click the Lookup icon ( ) next to the Rules for template activation
field (Figure 17.1 on page 17.2). The name that you enter in the Rule Name field appears in the list of
rules that are in the current template.

○

You must provide a name for the rule or you cannot
save it.
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Figure 17.2 Rule Definition
The Activate rule for drop-down allows you to make the rule apply to the entire practice or a specific
department (of which you are a member). Click Next after you name your rule and set its activation.
At the heart of each rule you create is the query. The query defines exactly what conditions each piece
of data must meet before the recommendation can appear in the patient’s chart. The piece of data is
the information recorded in the patient’s chart—from their age to their problem list.

Figure 17.3 Define Queries for the Rule
MicroMD EMR allows you to create two types of queries: simple and complex. For more in-depth
information about creating queries, please see page 25.14.

 Simple: A simple query consists of only one condition (i.e., Age >= 40)
 Complex: A complex query is a query made up of a number of simple queries. You join simple
queries by the appropriate Boolean expressions “OR” or “AND” (i.e., Age >=40 AND Sex =
Female).
Some complex queries may include parentheses. For example, Betty at Summervale Medical
wants her template for a Nutritional Consultation to apply to female patients whose BMI
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indicates they are severely underweight or in the obese category. Her query would look like this:
(Last BMI > 29.9 OR Last BMI < 18.5) AND Gender = Female.
You use the Conditions for Activation section of the Rule Wizard to define this criteria. Table 17.2
explains the fields of this screen in more detail.
Table 17.2 Fields Available in the Rule Wizard

Field

Description

Field Name

The Field Name drop-down contains the place in the patient’s chart that should
have the value you enter in the Value field before the system applies the
template.

Condition

The full set of available conditions is: = (equal to), <> (not equal to), < (less than), >
(greater than), <= (less than or equal to), >= (greater than or equal to) and In List.
The set of conditions that is available depends on the field name you select. For
example, if you select the field name Sex, only the = condition is available. If you
select Family History, the conditions available are = and In List.

Value

Click the square icon ( ) next to the field to access the list of values available for
the choice you made in the Field Name drop-down.

Logical

The choices in the Logical drop-downs are the Boolean expressions (i.e., OR and/
or AND) used to connect queries.

Adding Reference Documents to a Template
MicroMD Document Management adds an immense flexibility to the system and allows you to include
a variety of reference documents to templates, including web addresses. Simply click the Lookup icon
( ) next to the References field (Figure 17.1 on page 17.2). For more details on working with the
attachments window, please see page 20.1.
When the system applies the template to the patient’s chart and there are references attached, the
system displays the references icon ( ) at the end of the line (Figure 17.6 on page 17.9).

Screening and Prevention Details
For Screening & Prevention templates, when you click Next on the Prevention Template Wizard
window (Figure 17.1 on page 17.2), the system displays the Prevention Details screen. You can add
procedures and set the details of each procedure’s schedule. These are the recommendations the
system adds when Screening & Prevention refreshes.
Simply click the Add button to add procedures to the list. The Recommendation Details window
opens (Figure 17.4).
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Figure 17.4 Recommendation Details Window
Table 17.3 Fields on the Recommendation Details Window

Field

Description

Prevention Program Section
Recommended

Click the Lookup icon ( ) next to the Recommended field to choose the
procedure you want to include in this template (e.g., fetal monitoring with
report).

Description

If you want to provide more detailed information about the recommendation,
you can enter some text in this field. It is for informational purposes.

Type

You can categorize this recommendation using the Type drop-down. This is
for informational purposes only and is in preparation for more enhancements
in the future.

Schedule Section
Date of procedure
to be defined later

When you choose this option, the system does not automatically calculate a
date for you. It allows you to schedule the date when the program is added to
the patient’s chart.

Each Visit

If you choose Each Visit, the system adds a new entry for today’s date when
you click the Refresh button (or when the system automatically refreshes).
For example, a template created for pregnant patients could include entries
to perform a urinalysis, weight check, blood pressure check and to monitor
fetal heart tones at every visit with the patient.

17.6
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Table 17.3 Fields on the Recommendation Details Window (continued)

Field

Description

NEVER –
Contraindicated

If this recommendation is contraindicated by something in the patient’s chart,
you would establish the appropriate rules for that “something” and choose
NEVER – Contraindicated for the recommendation.
For example, you have a Mammogram Screening template for all female
patients over the age of 40. However, you wouldn’t schedule this evaluation if
the patient has had a mastectomy. The mastectomy would appear in the
patient’s chart (probably in their Problem List or Risk Profile).
You could create a complementary template to the Mammogram Screening
template with rules that check the patient’s chart for a mastectomy. You add
the Mammogram Screening recommendation to that template, but you list it
as NEVER – Contraindicated.
When the patient’s Screening & Prevention refreshes, a contraindicated
recommendation outranks any other similar recommendation and displays in
the chart. See page 17.8 for more details on refreshing recommendations.

Repeating
Schedule

In the Repeating Schedule options, you can choose the details of a consistent
schedule for the selected recommendation. For example, you want a patient
to have a mammogram starting at age 50 and repeating every year.

Non-repeating
Schedule

In the Non-repeating Schedule section, you can establish a schedule that is
not a consistent span of time. Click the Add button to add a new date to the
schedule. To edit or delete a date from the schedule, click the Edit or Delete
button as appropriate.

Each procedure
should be applied
within

This section controls when each instance of this recommendation becomes
due in the patient’s chart (i.e., the date block turns yellow and remains
yellow). The system turns the date block yellow for this amount of time before
and after the scheduled date.
For example, the date block for this procedure in the patient’s chart is
01/01/2020. The procedure is due within 14 days of this date. On 12/18/2019,
the date block is blue for future. On 12/19/2019, the date block turns yellow
for due. On 01/15/2020, the date block turns red for missed.

Immunization Details
For an Immunization template, when you click Next on the Immunization Template Wizard window,
the system displays the Immunization Details screen (Figure 17.5). You can add immunizations and set
the details of the immunization’s schedule.
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Figure 17.5 Immunization Template Wizard—Immunization Details Step
Simply click the Add button to add a vaccine to this group of immunizations. Adding a vaccine to a
template is the same as adding a vaccine to the chart manually. Please see page 17.12 for more details.



You can use the up and down arrow icons ( and
rearrange the order of the immunizations in the
template.

) to

Refreshing Recommendations
Once you have your new templates created or rules added to your existing templates, the system is now
ready to populate the patient’s chart with your recommendations. Depending on the User Preference you
have set (page 1.84), the system either automatically refreshes for you when you open Health Maintenance
or refreshes when you click the Refresh button in Screening & Prevention or in Immunizations.
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Figure 17.6 Screening and Prevention in Patient’s Chart
The system displays the programs or immunizations in the Recommendations column, and the Template
column tells you which template made that recommendation appear. If there are references attached to
the template, the system displays the references icon ( ), and you can click this icon to display the list.

User Preference
The Screening & Prevention and Immunizations sections provide you with the ability to either refresh
the recommendations yourself or let the system refresh this tab automatically for you each time you
enter the tab. In the Miscellaneous section of your user preferences (under Tools > User Preferences),
there is a section called Health Maintenance. You can set the Refresh option to either Automatic or
Manual.

 Automatic: When you set the preference to Automatic, the system reviews the templates in your
system for any rules that apply to this patient each time you return to the Screening &
Prevention section or to the Immunizations section of the chart.

 Manual: When you set the preference to Manual, simply click the Refresh button in the lower
right. The system reviews the rules contained within the templates in your system (both in
your Personal folder, the Personal folder of other users, and in the Shared folder). If the patient
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meets any of the criteria set in the rules of those templates, the EMR adds those
recommendations to the chart.

○

If you edit or administer a recommendation, the system
ignores that item when refreshing.

Conflicting Recommendations – Who Wins?
The templates created for the Screening & Prevention section or the Immunizations section could
result in similar recommendations for a patient, but with a different time table. For example, there is a
template called Mammogram Screening. The rules for this template are general: All female patients
should have a mammogram every year starting at age 40.
However, there is also a template called Mammogram Screening, High-Risk. The rules for this
template include criteria to search if the patient has breast cancer as a current risk under the Risk
Profile section. If the patient does have this risk, the template calls for the patient to have a
mammogram every six months.
When MicroMD EMR encounters this conflict, the recommendation with the shortest interval wins (e.g.,
six months outranks one year). If one of the templates indicates that the recommendation is
contraindicated, that recommendation also takes priority.

Managing Immunization Consent Documentation
Depending on your practice’s policies regarding consent forms, MicroMD EMR can help you manage those
documents. You can either print a paper consent form/letter for parents or guardians to sign or provide an
electronic form for them to sign using a Topaz® electronic signature device or a tablet computer.

Figure 17.7 Adding Immunization Consent Form to Chart

Launch Consent Form
The Immunization Consent Form is an Administrative Form you can create (or you can use a built-in
Standard form). When you click the Consent button or select Consent Form from the drop-down
menu (Figure 17.7), the system first checks if there is a default template chosen in the MicroMD EMR
Manager (page 17.11). If there is a default form, the EMR displays that form. Otherwise, the system
prompts you to choose a form.
Once you complete the form and the appropriate people sign it, the system saves the form to the
Forms section of the patient’s chart (in the Miscellaneous section of the Medical Information tab). See
page 20.18 for more in-depth details on this section.
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Consent Form Templates
Creating an Administrative Form for your immunization consent allows you to standardize your
consent documentation and makes it simple to update. The system will automatically populate the
information for you and you can print a hardcopy of the document for the parent or guardian to sign,
or if you have an electronic signature pad, you can add a signature option to the form. When you use
the Administrative Form, the system automatically saves that completed form to the patient’s chart.
For details on creating Administrative Forms, please refer to page 20.18.



The Text Box control in the Administrative Form template
includes the Immunizations Due option.

Default Immunization Consent Form
Once you have your Administrative Form created, you can tell MicroMD EMR (using the MicroMD EMR
Manager) to use that form by default when you click the Consent button or select the Consent Form
option from the drop-down menu (Figure 17.7 on page 17.10).

Figure 17.8 Setting the Default Immunization Consent Form
In the MicroMD EMR Manager, click the System Settings button and click the Practice tab. Click the
Edit button to open the Practice Settings window (Figure 17.8). Click the Lookup icon ( ) next to the
Default immunization consent form field. From the Reference List Viewer window, you can find and
insert your Administrative Form. If you need to remove the default, click the Delete icon ( ) next to
the field.



You must save the Administrative Form you wan to use in
the Shared folder. See page 2.8 for details on template
folders.

Attaching a Consent Document
If you have an external consent document you need to add to the patient’s chart, you can select
Attach Consent Document from the Consent drop-down menu. This opens the Add Attachment
window where you can find the document on your computer or scan a document into the chart.
For details on using the Add Attachment window, please refer to page 20.2.
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Consent Letters
If you have letters created in the system that you use when administering immunizations, you can print
those documents from within Health Maintenance and save the letter to the patient’s chart. You can
also send the documents to the Batch Basket or to other users in the EMR. If you have a Direct Mail
address, you can also send a secure message to other secured external users.
When you select Print Consent Letter from the Consent drop-down menu, the system opens the
Write Letter window. Please see Chapter 26 for more details on writing letters.

Consent History
To see a history of consent documentation recorded for the patient, simply select Show Consent
History from the Consent drop-down menu. The Immunization Consent History window opens and
displays the title of each document, when it was completed, and the EMR user who completed it.
Click the View Document button to display the consent form for the selected entry.

Managing Recommendations in the Chart
MicroMD EMR allows you to create and maintain a comprehensive recommendation schedule for each of
your patients. Each row in Screening & Prevention or Immunizations represents a procedure or vaccine,
depending on which section of the chart you have displayed.
MicroMD EMR uses color-coding in the display to help you see at a glance which recommendation(s) the
patient has coming up, which ones have been administered and which ones they missed. Each
recommendation falls into one of the following categories:

 Administered
 Missed
 Future
 Due
 Refused
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Figure 17.9 Immunizations
In the Immunizations section, you also have the following view options:

 Grid: This is the default view of the immunization schedule with each program on its own row.
 Series: This option shows the immunizations individually, which breaks out the compound
immunizations into individual rows in alphabetical order

 Group: This option shows the immunizations individually but grouped by the vaccine group
separated in alphabetical order by the group name. If the individual immunization is in multiple
groups, it will show up within each group.

Adding a Screening and Prevention Program Manually
The system automatically adds Screening and Prevention recommendations to the patient’s chart if
there are rules on the templates (page 17.3). You can also add procedures to the patient’s Screening &
Prevention section manually.
To add procedures to the chart manually:

Procedure

Details

1. Open the patient’s chart and click the
Medical Information tab.
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Procedure (continued)

Details (continued)

2. In the Chart Navigator, click the Health
Maintenance button and choose
Screening & Prevention from the
available options.

The system displays the patient’s recommended
procedure schedule.

3. Click the Add button.

The Add Screening & Prevention window opens.

4. In the Add Screening & Prevention
window, click Add.

The Reference List Viewer window opens and
displays the list of procedures.


5. Locate and select the procedure that you
want to use and click Insert.
6. From the No. Procedures column, select
the number of times to perform this
procedure in relation to this program.

17.14

You can also add procedures by
loading a Screening and Prevention
template.

The procedure appears under Procedure Name.

○

If the program will be repeated
indefinitely, select Repeat from this
drop-down. The window that opens
in the next step does not contain the
procedure navigation in the top right
corner for a repeat procedure.
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Procedure (continued)

Details (continued)

7. Click the Details button.

The Procedure Details dialog box opens.

8. Specify the scheduling details for the next
procedure.

The Proc # arrows in the top right corner allow you
to scroll through the procedures in the program
and enter the scheduling details for the next
occurrence of each individual procedure.
Scheduling details include:

 The target date for the procedure.
 The time from the target date within which the
procedure should be applied.
9. Click OK.

Details of the program appear in the yellow note
below the program procedures.

10. In the Add Screening & Prevention
window, click OK.

MicroMD EMR adds the new recommendation to
the patient’s list.

Adding an Immunization Manually
The system automatically adds Immunization recommendations to the patient’s chart if there are
rules on the templates (page 17.3). You can also add immunizations to the patient’s Immunization
section manually.
To add immunizations to the chart manually:

Procedure

Details

1. Open the patient’s chart and click the
Medical Information tab.
2. In the Chart Navigator, click the
Health Maintenance button and
choose Immunizations from the
available options.
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Procedure (continued)

Details (continued)

3. Click the Add button.

The Add Immunization window opens.

4. In the Add Immunization window,
click Add.

The Reference List Viewer window for
Immunizations opens and displays your Common
List of immunizations.


5. Locate and insert the immunization you
want to add to the schedule.
6. From the No. Vaccines drop-down,
select the number of immunizations to
include in the series.

17.16

You can also add procedures by
loading an Immunizations template.

The immunization that you selected appears in
Vaccine Name column.

○

If the patient should receive the
vaccine yearly, select Repeat Yearly
from the drop-down.
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Procedure (continued)

Details (continued)

7. Click the Details button.

The Vaccine Details window opens.

8. Specify the scheduling details for the
first vaccine.

Verify that procedure 1 appears in the top right
corner of the window under Vacc. #.
The scheduling details for this vaccine procedure
include:

 Target date for administering the vaccine (in the
first section of the window)

 Time from the target date within which the
vaccine should be administered (in the bottom
section of the window).
9. Click the right arrow in the top right
corner of the window and specify the
appropriate scheduling details for the
next vaccine procedure in the series.

Verify that the number under the Vacc. # label is the
correct procedure within the series.

10. Repeat step 9 for the remaining
immunizations in the series.
11. Click OK when satisfied with the series.

The details established for each appears in the Add
Immunizations window (step 3 on page 17.16).


12. Click OK when finished.
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You can continue to add series of
procedures while in this window.
Just click Add again.

MicroMD EMR adds the new immunization series to
the patient’s immunization schedule.
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Reconciling Immunizations
When you have an immunization interface with a registry, the system updates immunizations nightly
for any patients you have scheduled for the following day when importing data. You can also reconcile
the patient’s immunizations as you review their chart.

Figure 17.10 Reconciling Immunizations

○

For setup information, please contact your MicroMD
Interface Team.

When the “receiving” portion of the interface is active, the system displays a Reconcile button at the
top of the patient's immunizations list (Figure 17.10). When the button is gray and looks like a normal
button, there were no immunizations to reconcile or the patient was not on the schedule. If, however,
the button is red, there are immunizations from the registry that need to be reviewed and, if
appropriate, imported into the patient's chart.

Figure 17.11 Vaccine Import Window
When you click the Reconcile button, the system displays the Vaccine Import window (Figure 17.11). If
the button was red, the system has already populated the Imported Vaccines pane for you. The
Current Vaccines pane displays all of the recommended vaccines listed in the patient’s chart.
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If the patient was added to your appointment schedule after the system checked for immunizations,
the Imported Vaccines pane is blank. You can click the Import from Registry button to check if the
patient has any immunizations you need to add to their chart.
The Last Updated field is the last time the system checked the registry for this patient. The Status field
displays the progress once you click the Import from Registry button.
Once the system receives any immunizations from the registry, MicroMD EMR displays the information
from the registry in the Imported Vaccines pane.



If the vaccine is already recorded in the patient’s chart,
the text appears in blue in the Imported Vaccines pane.

When you click the Add button, the system imports the vaccines into the appropriate slots of the
patient’s chart, and if the dates on the immunizations do not match the listed dates in the patient’s
chart for that vaccine, the system prompts you to choose the appropriate slot.



Hover over the vaccine in the Current Vaccines pane to
review the details of the vaccine, including lot number,
manufacturer, who performed the vaccination and
more.

Editing or Deleting a Recommendation
To edit or delete a recommendation from either Screening & Prevention or Immunizations, simply
highlight the recommendation and click Edit or Delete as appropriate.

Cancelling a Recommendation
If you choose to cancel an existing recommendation, click Edit and then the Cancel Program button.
Cancelling a recommendation keeps the recommendation in the patient’s chart for your records so
you can refer back to it in the future. The system marks the recommendation as “inactive” and does
not display it in the list unless you place a check mark in the Include Inactive checkbox. To continue a
cancelled recommendation, highlight the entry, click Edit and click Continue.

○

If a series of procedures or immunizations is set to repeat,
you cannot cancel the recommendation. You must
terminate it instead. Simply go through the same motions
as cancelling a recommendation, clicking Terminate
instead of Cancel Program. You can also choose to
continue a terminated recommendation.

Printing a List of Recommendations
To print the list of recommendations, simply click the Print button (Figure 17.9 on page 17.13). The
report includes only those procedures that have already been performed. The details include the
scheduled date of the procedure, the date that the procedure was actually performed, and the name
of the person who performed the procedure.
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Creating an Order from a Screening-and-Prevention Recommendation
From within the Screening & Prevention section, you can send a request to another user to perform a
procedure (e.g., colonoscopy procedure). Highlight the recommendation row, click the Order button
(or right-click and select Orders), and select the type of order you want to create (e.g., procedure,
immunization, labs). Complete the window that opens.
The order then appears in the Orders section of the user’s Desktop (page 4.19). Be sure to select the
appropriate user from the Assigned To field on the order.

Creating an Order from an Immunization Recommendation
You can also send a request to another user from within the Immunizations recommendation’s row to
perform an immunization (e.g., a pneumococcal vaccine). Highlight the date block within the
recommendation and click the Request button. Complete the window that opens.
The order then appears in the Orders section of the user’s Desktop (page 4.19). Be sure to select the
appropriate user from the Assigned To field on the order.

Marking a Prevention Recommendation as Performed
Once a user has performed a procedure within a program, the system needs to know that the
procedure is complete.
To record that a procedure within a program was performed:

Procedure

Details

1. Open the patient’s chart and click the
Medical Information tab.

17.20

2. In the Chart Navigator, click the Health
Maintenance button and choose Screening
& Prevention from the available options.

The system displays a list of the programs
created for the patient.

3. Find the program that contains the
completed procedure and highlight the
procedure that was performed.

For example, Betty at Summervale Medical
Center highlighted Mr. Homer’s the row
containing the Depression Screening procedure
(Figure 17.6 on page 17.9).
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Procedure (continued)

Details (continued)

4. Click the Administer button.

The Administer Prevention Program window
opens.

5. Verify that the correct program name and
procedure number appear at the top of the
window.
6. Enter the details of the performance of the
procedure and click OK.

In the list of the patient’s programs, the
background color of the specified procedure
changes appropriately.

Marking an Immunization as Administered
Once a user has administered an immunization within a series, the system needs to know that the
procedure was performed. You can complete a variety of information about the administration of the
vaccine, including the patient’s reaction to the vaccine (if any), why the patient refused the vaccine and
the lot number of the vaccine administered.
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Figure 17.12 Administration Details for an Immunization



To review a list of the patient’s allergies, click the Patient
Allergies button.

To mark that an immunization was administered:

Procedure

Details

1. Open the patient’s chart and click the
Medical Information tab.
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2. In the Chart Navigator, click the Health
Maintenance button and choose
Immunizations from the available options.

The system displays the patient’s immunization
schedule.

3. Find the series that contains the completed
immunization and highlight the vaccine
that was administered.

For example, Betty at Summervale Medical
Center highlighted little Linsey’s October MMR
entry (Figure 17.9 on page 17.13).

4. Click the Administer button.

The Administer window opens (Figure 17.12).
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Procedure (continued)

Details (continued)

5. Verify that the correct immunization name
and vaccine number within the series
appear at the top of the window.
6. Enter the details of the application of the
vaccine and click OK.

The background color of the selected
immunization changes to the appropriate color.

○

Be sure to sign the immunization if
appropriate. The system prompts
you for your password.

Goal Monitoring
MicroMD EMR helps you track the goals you set with the patient to eliminate or overcome risks to their
health. Once you establish a goal for the patient, you can then record a monitor entry for the goal as you
track the patient’s progress. You can also create goal monitoring templates for those that you establish
frequently for your patients. See page 17.24 for details on creating Goal Monitoring templates.
For example, if a patient is obese and needs to lose weight, the system helps you record when they began
their goal. As you get updates on their progress, you can add monitors that allow you to record the details
of their progress (or lack thereof).

Figure 17.13 Monitoring Goals in a Patient’s Chart
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Maintaining Goals in a Patient’s Chart
To edit or delete a goal, simply highlight the goal and click the Edit or Delete button as appropriate. To
print the patient’s list of goals, click the Print button.
To add a goal to the patient’s chart, click the Add button and complete the window that opens.
When you want to add a monitor to a goal, highlight the goal and click the Add Monitor button. The
monitor allows you to record details about the patient’s progress toward their goal. If you need to edit a
monitor, highlight the specific entry and click the Edit Monitor button.

Goal Monitoring Templates
If you have goals that you set for your patients that are basically the same, you can create a template for
that goal to help you efficiently add information to the patient’s chart. To access the goal monitoring
templates, select Tools > Goal Monitoring Templates from the main menu. This displays the Goal
Monitoring Template Manager. Click the New button to start a new template. This opens the Goal
Monitoring Template Builder window.

Figure 17.14 Goal Monitoring Template
Complete the details on this window, click OK and save the template in the Personal or Shared folder.

Risk Profile
MicroMD EMR allows you to maintain a list of risks relevant to each patient. This is the patient’s Risk Profile
and can contain entries such as “heart disease” and the factors in their life that contribute to that risk. Any
physician can view or modify this list.
To view a patient’s risk profile, open their chart, click the Medical Information tab and choose Risk Profile
from the available options. MicroMD EMR allows all physicians to view a patient’s risk profile.
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To edit or delete an entry from the patient’s Risk Profile, simply highlight the entry and click Edit or Delete
as appropriate.
To add a risk to the patient’s risk profile:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Health
Maintenance button and choose Risk Profile
from the available options.

The system displays the entries that make up the
patient’s Risk Profile.

3. Click Add.

The Add Risk Profile window opens.

4. Click the Lookup icon ( ) next to the
Description field to choose the appropriate
risk diagnosis.
5. Enter any contributing factors and additional
comments about the risk.
6. Click OK.

The system adds the new risk to the patient’s Risk
Profile.

Health Concerns/Patient Care Plan
The Health Concerns section of the patient’s chart allows you to record all concerns about the patient's
health (whether your own concerns, those from your patient, or concerns from another provider) and set
up a Care Plan to address those concerns, tracking the patient's progress in that plan. This central location
under Health Maintenance ties together Goal Monitoring and Risk Profile, along with other areas of the
patient's chart.
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Figure 17.15 Health Concerns in the Patient’s Chart
Access the section from within the patient's chart under Health Maintenance on the Medical
Information tab (Figure 17.15).

Adding a Health Concern
To add a Health Concern to the patient’s chart, simply click the Add button (Figure 17.15). The Add Health
Concern window opens (Figure 17.16).
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Figure 17.16 Health Concern Window
You can select the concern from the Health Concern drop-down. These correspond to the different
sections of the patient’s Medical Information tab. Once you select the section, the drop-down next to the
section’s name corresponds to the information recorded within that section. This allows to you to identify
the subject of your concern. Simply select the appropriate data.

Figure 17.17 Health Concern Header Information



Click the Add icon ( ) if you want to add new
information to the patient’s chart.

When you add a new concern, you can tie that concern to other areas of the patient’s chart. Any
information you add within the Health Concern reflects in the appropriate areas of the chart. For example,
if you enter a Environmental History Health Concern that the patient’s parents smoke, and this could
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contribute to the patient’s asthma, that environmental entry also appears in the Environmental History
section of the patient’s chart under Histories. Table 17.4 explains the fields and sections of this window in
more detail.
Table 17.4 Fields on the Health Concerns Window

Field

Description

Health Concern

The fields next to Health Concern allow you to specify the main concern you
want to record with this entry. For example, you’re concerned that the patient's
weight poses a significant risk to their health and contributes to the increasing
severity of other health conditions. In this example, you can select Vital Signs
and BMI from the drop-downs.

Responsible
Physician

The Responsible Physician field allows you to identify the physician who
initiated the concern, whether yourself (the default value) or another provider.
Click the Lookup icon ( ) to change the provider.

Selected Care Team

Click the magnifier icon ( ) to select the providers or specialists from the list in
the Providers / Specialists section on the patient’s Demographics tab. These
are the users who work with the patient and need to receive updates regarding
the interactions with the patient.

Start Date

Enter the date at which the concern came to your attention or when the
concern began. You can place a check mark next to Approx if the date you enter
is an estimated date.

End Date

If the patient has successfully addressed the Health Concern or if you need to
stop monitoring it, you can enter the stop date in the End Date field.

Comment

You can enter any other details about this Health Concern in the Comment field.
If you have a boilerplate text that you want to use, the Quick Text icon ( ) can
help you add information quickly.

Inactive Reason

The Inactive Reason allows you to record why you changed the Status field to
Inactive, rather than marking the Health Concern as Completed.

Risk Score

Mainly for use to meet Comprehensive Primary Care Plus (CPC+) requirements,
you can associate a score with this Health Concern entry to identify and flag
patients with complex needs. You can create your custom risk scores/labels in
the EMR Manager (page 1.66). Based on this score, you can then generate
patient groups and reports.

Status

This is the current state of the Health Concern:

 Active: If you and the patient are currently working toward mitigating this
Health Concern, have set goals, and are currently monitoring those goals,
you can keep the Active status.

 Inactive: If you need to make this Health Concern inactive (perhaps the
patient is deceased), you can mark the concern as Inactive.

 Completed: If the patient has successfully met the goals established for this
Health Concern, you can mark the concern as Completed.
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Table 17.4 Fields on the Health Concerns Window (continued)

Field

Description

Related Concerns

From the Related Concerns section, you can add information from other
sections of the patient’s chart that are pertain to this Health Concern. Simply
click the Add button to create a row and then select the chart section from the
Med Info Area drop-down. You can click the plus sign button ( ) to a new entry
to that section of the patient’s chart if one does not already exist. Or, if you
prefer, you can type text in the Description column instead.

○

If you type text in the Description column, the item
only appears in the Health Concern and not in the
related are of the chart.



When you select Generic under the Med Info Area
column, you can simply type in the column.

Related Risks

In the Related Risks section, you can add information from the patient’s Risk
Profile section of Health Maintenance. You can click the drop-down icon ( ) to
add a risk from the patient's chart or the Lookup icon ( ) to add a new risk to
their chart.

Goals and Goal
Monitors

If you want to create a Care Plan for this patient to address and overcome this
Health Concern, you can create a set of goals, schedule progress checks, and
add updates regarding the patient’s progress. Please see page 17.29 for more
details on using this section.

Goal Monitoring/Tracking
Once you discuss this Health Concern with the patient and decide upon a plan of action to resolve the
issue, you enter those goals directly within this concern. The Goal Monitoring section of the patient’s chart
also reflects any goals you add here.

Figure 17.18 Goal Monitoring
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Health Concerns/Patient Care Plan

When you print the Care Plan for the patient (page 17.30),
all of those goals and their current status print on the
document.

Inserting a Goal
In the goal monitoring section of the Health Concern entry, there are two ways to add a goal.

 You can click the drop-down arrow to insert any goals currently recorded in the patient’s chart
in the Goal Monitoring section of Health Maintenance.

 If you want to add a brand-new goal, click the add icon (

). This opens the Add Goal
Monitoring window (Figure 17.13 on page 17.23) where you can complete the details for the new
goal.

Ranking the Patient’s Goals
Within each Health Concern entry, you can rank the patient’s goals. For example, if you want the
patient to focus primarily on their weight loss over their smoking habit, you can click the Rank button
and adjust their priorities.

○

The ranking of goals only applies to the goals within the
Health Concern. Ranking does not apply outside the
Health Concern entry.

Recording the Patient’s Progress on a Goal
The bottom section of the Edit Health Concern window (Figure 17.18) allows you to track the patient’s
progress toward a goal and establish a schedule to help the patient meet the goals you want to set for
them. Simply highlight the goal you want to update and click the Add Monitor button.
The sticky note below the list of goals displays the monitors associated with the goal. If you need to
make changes to an existing entry, highlight the monitor in the sticky note and click the Edit Monitor
button.

Print the Patient’s Care Plan
The Care Plan includes all of the Health Concerns you have added to the Health Concerns section of the
patient’s chart. The Care Plan displays all of the details for the Health Concern, including dates, any related
concerns and risks; and evaluations, outcomes and interventions recorded in the Goal Monitoring section
of the Health Concern.
Simply click the Print Care Plan button from the Health Concerns section of the patient’s chart (Figure
17.15 on page 17.26).
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Chronic Care Management
The Chronic Care Management (CCM) feature in MicroMD EMR allows practices to record non-office-visit
interactions in the patient's chart for those patients with two or more chronic conditions, and then bill for
them using the appropriate billing codes at the end of the month. The Care Team can record this
information from a single dashboard on their individual Desktop in the EMR (under the Patient Care
button), without needing to create encounters and open the patient charts to access it.



When a patient is enrolled in the CCM module, MicroMD
EMR automatically begins the patient’s entry for each
new month. There is no need to “create” a billing month.

Figure 17.19 Chronic Care Management on the Desktop

○



To enroll patients in Chronic Care Management in
MicroMD EMR, the patient must have two or more chronic
conditions listed in their chart under Problem List (under
Medical) or Risk Profile (under Health Maintenance).

Chronic Care Management is mostly for Medicare
patients; however, some private insurance companies
allow you to bill for non–face-to-face time with the
patient. Please check with your insurance companies.
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Setting Up Chronic Care Management for Your Practice
There is minimal setup that you need to do to begin using the Chronic Care Management module. There
are two main settings you need to establish before you can begin effectively using the module:

 Identify the users who can record non–face-to-face time with the patient
 Establish whether MicroMD EMR should automatically create bills for the patients or if you want
providers to send the patient’s time to the PM manually

Setting up Users
Identifying your Chronic Care Management users is simple. Gather the list of MicroMD EMR users who
may record non–face-to-face time with the patient.

Procedure

Details

1. Open the MicroMD EMR Manager.
2. Click the Users & Facilities button.
3. In the System Users pane, highlight the
user you want to add to the Chronic Care
Management module.
4. Click the Roles tab.
5. Click the Edit button.
6. Place a check mark next to Chronic Care
Management.
7. Click OK.

Once you provide the Chronic Care Management
function to the user, they have access to the
Chronic Care Management sections of both the
Desktop and the patient’s chart.



If any user has permission to view
patient medical information, they
will also have access to the patient’s
Chronic Care Management.

Setting up Automatic Billing
If you want MicroMD EMR to create bills for your patients automatically at the end of the month, place
a check mark in the CCM Auto Billing checkbox in the EMR Manager (under System Settings >
Practice Settings).
At the end of every month, the system automatically determines whether there is enough Complex
time recorded for each of your CCM patients to bill the higher-value codes. If there is, the system sends
the complex CCM codes over to the PM for billing. If there is not enough complex time recorded, but
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there is enough Non-Complex time recorded for billing, the system sends the non-complex CCM codes
over to the PM for billing.



You identify the patient as either a Complex or NonComplex CCM patient in their CCM Consent entry.

Enrolling a Patient in Chronic Care Management
When creating chronic care management for a patient in MicroMD EMR, you enroll the patient in Chronic
Care Management through the Consent section of the patient’s Demographics tab (Figure 17.20). The
patient provides their consent for a specified billing provider, care team, chronic conditions, even the plan
set accepted for billing.

○

When you create the consent entry for Chronic Care
Management, make sure you add the patient’s care team
members to their Providers/Specialists list and that the
patient has the chronic care conditions listed in their
problem list. You will not be able to enroll them in the CCM
program without those details in place.

Figure 17.20 Enrolling a Patient in Chronic Care Management
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When you click the Add button in the Consent section of the Demographics tab, you can select the type of
consent you want to enter. When you select Chronic Care Management, the system displays your choices
for enrolling the patient. Table 17.5 explains the fields available.

Figure 17.21 Patient Consent Window



Once you enroll a patient in Chronic Care Management,
a green indicator ( ) appears on the patient’s chart
and near the patient’s name throughout the system. The
patient is also included in the Chronic Care Management
patient group. See page 17.36 for more details.



MicroMD EMR passes the patient’s status for the Chronic
Care Management program to MicroMD PM (i.e.,
Enrolled, Not Enrolled, or Declined). You can find the
information on the Patient Details window in the PM.

Table 17.5 Fields on the Patient Consent Window for Chronic Care Management

Field

Description

Consent given

To enroll the patient in the MicroMD EMR Chronic Care management
features, choose the Yes option. This allows you enter billing details, the
patient’s chronic conditions and more.

Billing Provider

From the Billing Provider drop-down, you select the provider who will
appear on the patient’s claims and who will appear as the encounter
provider. The list in the drop-down defaults to your Common List of
providers. See page 17.41 for more details on billing.
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Table 17.5 Fields on the Patient Consent Window for Chronic Care Management (continued)

Field

Description

Selected Care Team

Click the magnifier icon ( ) to select the providers or specialists from the
list in the Providers / Specialists section on the patient’s Demographics
tab. These are the users who need to receive updates regarding the
interactions with the patient. See page 17.36 for more details on recording
time spent with the patient.

Selected Chronic
Condition

This field allows you to identify the chronic conditions to be billed within
the Chronic Care Management model.

Plan Set for Billing

From this drop-down, select which set of plans you want to use for the
patient’s chronic-care billing. Please refer page 9.17 for details on plan
sets.

Type of CCM

Identify whether the patient’s type of chronic care management is NonComplex or Complex. This sets the default for the time entries added to the
patient’s chart (page 17.36) and tells MicroMD which billing codes to send
to MicroMD PM for billing for the total of those time entries (page 17.41).

Consent Date

This is the date on which you obtained agreement from the patient to
participate in your Chronic Care Management program. The field defaults
to the day you create this consent entry in the patient’s chart.

Termination Date

If the patient decides at any time to opt out of Chronic Care Management,
you can select the date from this field, and MicroMD EMR removes the
patient from the module and does not allow users to record non–face-toface time. The system changes the patient’s CCM Status to Declined.

Comment

If you need add additional notes or information about the patient’s
consent, you can enter that information in the Comment field.

Documents Received

You can use the Documents Received field to add any hardcopy
information you gathered from the patient related to their consent. For
example, you can scan into the system any consent letters the patient has
signed to enroll in the program.

Consent Letters button

The Consent Letters button allows you to print any documentation you
have created for the patient to sign or to provide education to the patient
when you enroll them. For the purposes of Chronic Care Management,
there are three standard letter templates to help you:

 CCM Consent
 CCM Stop
 CCM Welcome
Please refer Chapter 26 for more details on writing letters and using letter
templates.
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Chronic Care Management Patient Groups
Now that you have patients who are enrolled (or who have declined to enroll) in your Chronic Care
Management program, MicroMD EMR automatically adds those patients into one of two system-generated
Patient Groups: CCM Enrolled ( ) or CCM Declined ( ). The system displays the appropriate icon in the
patient’s chart header (Figure 17.22), as well as other areas throughout the system including Scheduled
Visits.

Figure 17.22 Chronic Care Management Patient Group Indicators



For details on working with Patient Groups, please refer to
the page 9.24.

Recording Interactions with the Enrolled Patient
Once you have the patient enrolled in Chronic Care Management, you can begin recording any non–faceto-face interactions you have with the patient related to their conditions right from the Desktop. MicroMD
EMR also displays the entries made within Chronic Care Management in the patient’s chart on the
Summary tab.

Figure 17.23 Non–Face-to-Face Time Window



Only patients who have enrolled or who have declined to
enroll in the program appear in the two Chronic Care
Management sections.

To record time spent in managing the patient’s care, you have two options:
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 You can open the Chronic Care Mgmt option on your Desktop under Patient Care (Figure 17.19
on page 17.31).
If you record time from your Desktop, simply click the Open Time button, click the Start button,
and use the Dashboard and Patient Monitor buttons to do your work.

 You can open the Chronic Care Management option in the patient’s chart on the Medical
Information tab under Health Maintenance.
If you record time from the patient’s chart, simply right-click the appropriate month from the
patient’s list and select Open Time from the pop-up menu. (You can also highlight the row and
click the Open Time button.
When you select the Open Time option (or click the Open Time button), the Non-face to Face Time
window opens (Figure 17.23). Across the top of the window are the action buttons you need to add the
time you’ve spent on the patient’s care and to review the patient’s chart. The main area of the window is
the time recorded for the selected month. (Table 17.6 explains the fields and buttons on this window in
more detail.)



MicroMD EMR displays the current total in the bottom of
the window.

To record new time simply click the New Row button. You can either use the Start and Stop buttons in the
toolbar as a “stopwatch” to time your activity, or you can manually change the Start Time and End Time
fields. The system automatically calculates the number of minutes for you either way. Enter details in the
Comment field and click Close.
When you click the Dashboard or Patient Monitor buttons to review areas of the patient’s chart, MicroMD
EMR automatically adds those categories you mark as reviewed to the Comment field. You can then enter
any additional notes you want for future reference.



Click the note icon (
writing and editing.

) to open the text area for easier

Table 17.6 Buttons and Fields on the Non-face to Face Time Window

Button/Field

Description

New Row

The New Row button creates a new time entry for the current user to record
their activity.

Start and Stop

You can use the Start and Stop buttons as a stopwatch to keep track of the time
you are currently spending on this non–face-to-face time with the patient. When
you click the Start button, the system enters the current time in the Start Time
field. When you click the Stop button, the system enters the current time in the
End Time field and automatically calculates the Minutes column for you. You
can edit these fields if necessary.

Send to Billing

You can establish automatic billing for the Chronic Care Management module
(page 17.32), but if you prefer to send to billing manually, you can click the Send
to Billing button. This button is only active if the patient’s total accumulated
time is at least 20 minutes for the current month.
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Table 17.6 Buttons and Fields on the Non-face to Face Time Window (continued)

Button/Field

Description

Dashboard and
Patient Monitor

The Dashboard and Patient Monitor buttons provide you with access to the
patient's chart directly from the time entry window. MicroMD EMR automatically
enters in the Comment field the name of any medical information sections you
mark as reviewed while in the dashboard or the patient monitor.



Click the Start button to start the time and then use
these buttons to review the patient’s chart. Once
you’re done, click the Stop button. You’ll see the
sections you reviewed listed in the Comments.

Recorded On

The date in this field is the date and time the user in the Recorded By column
created this entry. Generally, the time is the same as the Start Time column, but
they could be different.

Recorded By

This is the user who created this time entry and entered the information in the
Comment field.

Start Time, End
Time, and Minutes

These time fields make up the time entry and indicate how many minutes
the user in the Recorded By column spent on the activities they entered in
the Comment field. MicroMD EMR automatically calculates the total minutes
for this time entry based on the Start Time and End Time fields. You can see
the total accumulated minutes for the month at the bottom of the window
for this patient.

Type of CCM

The type of time defaults from the patient’s consent entry, and you can identify
if the time entry is different. See page 17.41 for details on billing.

Comments

The Comments field is where you record the activity you performed related to
the patient’s chronic conditions. This field in unlimited. You can write as much
information as needed. Click the note icon ( ) to open the editing window. You
can use the Spell Check icon ( ) to check your spelling. The Quick Text icon
( ) allows you to create text shortcuts specific to Chronic Care Management.
The Copy Previous option in the QT drop-down icon automatically enters the
same text from the most recent entry.
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Chronic Care Management Reporting
In the Chronic Care Management section of your Desktop, the Report Builder button allows you to find
patients in your practice who have not enrolled, who have enrolled, or who have declined, as well as
several other criteria. Simply set the criteria at the top of the window and click the Run button.

Figure 17.24 Report Builder Window
The list of patients who meet your criteria appears in the window. If you click the patient’s row, MicroMD
EMR displays information from the patient’s demographics, as well as the list of conditions from their
Problem List and Risk Profile.
The Chronic Care Management Report Builder comes with three pre-defined queries:

 Not Enrolled: This query returns a list of patients within your practice who have no Consent
entry in their chart for Chronic Care Management.

 Enrolled: This query returns a list of patients within your practice who do have a Consent entry
in their chart for Chronic Care Management, and who have elected to participate.

 Declined: This query returns a list of patients within your practice who do have a Consent entry
in their chart for Chronic Care Management, and who have elected not to participate in the
program at your practice.
You can add more criteria to any of these queries at the time you generate the list, but you cannot save any
changes to these pre-built queries. If you want to quickly and easily generate a list of patients in the future,
you can create and save your own queries.
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Figure 17.25 Saved Queries
You can right-click the Saved Queries list and select New Query to clear out the right side of the window,
add a new entry in the list, and set up the criteria you want to use to find patients in your system. (You can
also click the New Query button below the list.)
Generating a report uses queries. A patient appears in the list when they meet the criteria you establish in
the query. Table 17.7 explains your choices in the Field Name drop-down.



For more in-depth details about creating queries, please
refer to page 25.14.

Table 17.7 Options Available in the Field Name Drop-Down

Field

Description

CCM Status

When you select this field, the system looks at the choice made in each
patient’s consent window:

 Enrolled: The patient’s CCM Status is Enrolled if there is a consent entry
in the patient’s chart for Chronic Care Management where the Consent
given option is set to Yes.

 Declined: The patient’s CCM Status is Declined if there is a consent
entry in the patient’s chart for Chronic Care Management where the
Consent given option is set to No.

 Not Enrolled: The patient’s CCM Status is Not Enrolled if there is no
consent entry for Chronic Care Management in their chart.
Age, Chart Number,
Ethnicity, First Name,
Gender, Last Name,
and Race

These options allow you to choose various demographics criteria to
generate a specific report and pinpoint the patients you want to find.

Problem Chronicity

The Problem Chronicity option allows you to find patients based on the
choice made in the Chronicity drop-down on the individual Edit Problem
window in the patient's chart.

Problem List

The Problem List option allows you to find those patients with a specific
active diagnosis code listed in the Problem List of their chart.
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Table 17.7 Options Available in the Field Name Drop-Down (continued)

Field

Description

Problem List (ICD 10)

If you want to find patients who fall within a group of ICD-10 diagnosis
codes, you can select the Problem List (ICD 10) option. This allows you to
choose whether the patient has exactly a specific ICD-10 code (select =
from the Condition drop-down) or whether the patient needs to have one
of a group of ICD-10 codes (select Like from the Condition drop-down).
The Like condition allows you to use the “%” wildcard with your code to
pull patients with any codes within that set. For example, if you use Like
with the code V95.%, the system displays all patients with codes V95.1,
V95.2,...V95.21, etc. listed in their Problem List as Active.

Risk Factor

When you select Risk Factor from the drop-down, MicroMD EMR looks at
the patient’s Risk Profile (under Health Maintenance in their chart) for the
active specific risk code you enter here.

Risk Factor (ICD 10)

If you want to find patients who fall within a group of ICD-10 risk codes, you
can select the Risk Factor (ICD 10) option. This allows you to choose
whether the patient has exactly a specific ICD-10 code (select = from the
Condition drop-down) or whether the patient needs to have one of a group
of ICD-10 codes (select Like from the Condition drop-down).
The Like condition allows you to use the “%” wildcard with your code to
pull patients with any codes within that set. For example, if you use Like
with the code V95.%, the system displays all patients with codes V95.1,
V95.2,...V95.21, etc. listed in their Problem List as Active.

Billing the Patient
When billing for chronic care management, you can only bill once per patient during the month, and you
can only bill either non-complex CCM or complex CCM for an individual patient...not both.

Automatic Billing
When you turn on automatic billing, MicroMD EMR can take care of this for you. At the end of the
month, the system checks the patient’s time totals and determines the best codes to use based on the
time recorded in the patient’s chart. You can see any bills created for the patient in the Billing
Preparation under the Administration button of the Desktop.

○

The provider that appears on the bill is the provider
selected on the Patient Consent window in the Billing
Provider drop-down.

 Complex CCM billing: The system will check if there is enough complex CCM time recorded in
the patient’s chart to bill for the higher-value codes (otherwise it will check for non-complex
CCM time). MicroMD EMR will bill for the first 60 minutes of complex CCM time using 99487. Each
additional 30 minutes in the month bills with code 99489. If the recorded time is less than 60
minutes, MicroMD will not bill for complex chronic care management that month. The same is
true for the add-on codes if less than 30 minutes.

MicroMD EMR User’s Reference Manual Version 16.0

17.41

Chapter 17. Medical Information: Health Maintenance

Chronic Care Management

- Example 1: The patient’s total time marked as Complex for the month is 82 minutes, only
the first 60 minutes count, and the system can only bill for procedure code 99487. The
remaining 22 minutes is less than the 30 required to bill an instance of the add-on code
99489.

- Example 2: If the total complex time for the month is 131 minutes, MicroMD would create a
billing encounter with three lines:

• 99487 for the first 60 minutes
• 99489 for the next 30 minutes
• 99489 for the next 30 minutes
And in this case, the final bill is for 120 minutes.

 Non-Complex CCM billing: If there is not enough complex CCM time for the month to bill, the
system will check if there is at least 20 minutes of non–face-to-face interaction time with your
practice. MicroMD EMR creates a charge using procedure code 99490.

Manual Billing
If you want to bill manually, you can simply open the patient’s Non-face to Face Time window and
click the Send to Billing button (Figure 17.23 on page 17.36). This sends the information over to the
Pending Charges in MicroMD PM. The Send to Billing button is only enabled when the patient has
reached at least 20 minutes of billable time (minimum required for non-complex CCM billing).

○

Remember: You can only bill once per month per patient,
and you cannot bill both Non-Complex and Complex for
the same patient.



If the Send to Billing button is disabled, either the patient
has not yet reached 20 minutes of accrued interaction
time, the bill was already created for the month, or you
have set up automated billing.

Utilities Within Chronic Care Management
Many chronic-care patients call in simply to have a prescription refilled or to ask a question. Maybe after
speaking with the patient, you need to bring them in for an appointment. The Utilities drop-down button
provides you with quick access to a variety of tools without ever leaving the window. See the appropriate
section of this manual for more details on each of these tools.

Updating the Care Team
If you want to send an update to the patient's Chronic Care Management team, MicroMD EMR allows you
to send the list of recorded time with the patient to everyone at once, using their preferred method of
communication. Simply highlight the patient for whom you want to send an update, click the Utilities
drop-down button and select Send CCM Update.
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Figure 17.26 Send CCM Update Window
The Service Date field defaults to the current day’s date. The Sent To field displays the list of the providers
from the patient’s care team as specified in their consent window. Remove the check mark next to anyone
who does not need to receive your update (or select Do Not Send from the drop-down). The
communication method drop-downs default to the preference selected on the provider’s Communication
Preference field (under Tools > Contact Managers > Providers / Specialists Manager in the main menu).



If you want to include any additional comments to the
entire team, you can enter text in the Comment field to
be included with everyone’s update.

Depending on the communication method selected for each team member, when you click Send Update
button, the appropriate windows open to allow you to send, fax, or print the update for that member.
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Medical Information: Women’s Health
This category is only available for female patients. The Women’s Health section of the patient’s chart
allows you to enter a variety of history items related specifically to women’s health issues, from the onset
of menstruation through pregnancies to menopause.

○



You should read this chapter in its entirety before
working with the OB Care Module.

For an at-a-glance reminder of current pregnancies, look
for the blue OB icon ( ).

In This Chapter
In this chapter, we cover:

 OB Care Workflow (page 18.2)
 OB Care Dashboard (page 18.6)
 OB Care Record (page 18.7)
 OB Medical History (page 18.11)
 OB Genetic Screening (page 18.12)
 OB Initial Exam (page 18.13)
 Prenatal Visits (page 18.14)
 Pregnancy History (page 18.15)
 Prenatal Care on the Desktop (page 18.17)
 Antepartum Report (page 18.18)
 Fetal Ultrasound (page 18.20)
 Gynecology History (page 18.21)
 Menstruation History (page 18.23)
 Family Planning History (page 18.24)
 Labor and Delivery (page 18.26)
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OB Care Workflow
The OB Care Module is an interconnected feature with various sections of the female patient’s Medical
Information tab (under the Women’s Health button). These sections work together to help you record
data regarding the patient’s pregnancy:

 OB Care Record (page 18.7)
 OB Medical History (page 18.11)
 OB Genetic Screening (page 18.12)
 OB Initial Exam (page 18.13)
 Prenatal Visits (page 18.14)
 Pregnancy History (page 18.15)
 Fetal Ultrasound (page 18.20)
 Labor and Delivery (page 18.26)
There are a few important details and relationships you need to understand before you begin to use the
OB Care features in the software.

 If the patient has prior pregnancies before the current one, you MUST add their prior
pregnancies to the system before you create the OB Care Record. This ensures the patient’s
gravida para displayed throughout the system is accurate.

 When you complete the patient’s current pregnancy, the system will give you the opportunity to
create a new pregnancy history entry.

 Any visits that relate to the patient’s current OB Care Record should have Prenatal selected in
the Nature of Encounter section of the Encounter Header.

 When creating visits for an OB patient, you can only create OB visits through Scheduled Visits
and the OB Dashboard button.

 It’s easier to add all information for the OB sections of the Women’s Health section of the
patient's Medical Information tab through the encounter using an Encounter Wizard
template.

 Before you select Yes from the Pregnant drop-down in the patient’s vitals, be sure to enter the
patient’s pregnancy history first if they have previous pregnancies. When you select Yes from the
Pregnant drop-down, the system will prompt you to create a new OB Care Record if one does
not exist, and you need the patient’s pregnancy history to create an accurate record.
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entries before you create an OB Care Record for the
current pregnancy. This ensures that the correct
number of pregnancies appear in the patient’s record,
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OB Care Visit Example - Patient’s First Pregnancy
To help illustrate how to use the OB Care feature for a patient’s first pregnancy, please review the following
example. In this example, Linsey Homer is an existing patient with Dr. Webb, but this was Linsey’s first OB
visit. She suspected she was pregnant, so Dr. Webb had her stop at the lab for a pregnancy test.
Dr. Webb used the standard Prenatal Care encounter wizard that comes built into MicroMD EMR. When
Linsey came in for her first prenatal visit, the practice used the following workflow.

○

Your personal and practice workflows may differ from this
example, sometimes greatly. It is meant for illustration
purposes only.

Procedure

Details

Patient Intake
1. Nurse Betty checked Linsey in through
Scheduled Visits and started a new encounter
with the Prenatal Care Encounter Wizard
template.

Betty clicked the New Encounter button for this
first visit. For all future visits, the nurse will click the
OB Dashboard button to create a new prenatal
visit.

2. She chose Prenatal from the Nature of
Encounter section on the Encounter Header
and clicked OK to start the encounter.
3. In the Vital Signs section, the nurse
completed all of the standard temperature,
pulse, height, weight, and last menstrual
period.
4. Betty asked about Linsey’s previous
pregnancies, and Linsey indicated this is
her first.
5. Betty entered No known pregnancies in
Linsey’s pregnancy history.
6. Betty told Linsey the doctor would be in
shortly.

Doctor Visit
7. When Dr. Webb came in and opened the
encounter, she spoke with Linsey to let her
know that yes, indeed, Linsey was pregnant.
8. In the encounter, Dr. Webb opened the Vitals
entry and selected Yes from the Pregnant
drop-down.

The system prompted her to create a new OB Care
Record.

9. Dr. Webb clicked the Yes button.

The Add OB Care window opened (Figure 18.4 on
page 18.8).

MicroMD EMR User’s Reference Manual Version 16.0

18.3

Chapter 18. Medical Information: Women’s Health

OB Care Workflow

Procedure (continued)

Details (continued)

10. The doctor completed any necessary
information and clicked OK.

See page 18.8 for details on the OB Care Record
window.

11. Dr. Webb clicked the EDD Calc button and
entered all the necessary information to
calculate Linsey’s estimated due date.

See page 18.10 for details on this window.

12. She clicked OK on the Edit Vital Signs
window.
13. Dr. Webb continues with the steps of the
Encounter Wizard, and finishes Linsey’s visit,
including the OB Initial Exam and the
Prenatal Visits portions.

OB Care Visit Example - Patient’s Third Pregnancy, First Time with This Doctor
To help illustrate how to use the OB Care feature for a patient with previous pregnancies but who is new to
your practice, please review the following example. In this example, Kristi Skinner is an existing patient
with Dr. Webb, but Kristi is a new patient for Dr. Webb. Kristi’s previously physician retired and
recommended Dr. Webb. Kristi suspected she was pregnant, so Dr. Webb had her stop at the lab for a
pregnancy test.
Dr. Webb uses the standard Prenatal Care encounter wizard that comes built into MicroMD EMR. When
Kristi comes in for her first prenatal visit, the practice uses the following workflow.

Procedure

Details

Patient Intake
1. Nurse Betty checked Kristi in through
Scheduled Visits and started a new
encounter with the Prenatal Care
Encounter Wizard template.

For all future visits, the nurse will click the OB
Dashboard button to create a new prenatal visit.

2. She chose Prenatal from the Nature of
Encounter section on the Encounter Header
and clicked OK to start the encounter.
3. In the Vital Signs section, the nurse completed
all of the standard temperature, pulse, height,
weight, and last menstrual period.
4. Betty asked Kristi about any previous
pregnancies, and Kristi told Betty all about
her two kids, as well as the one she lost.
5. Betty added Kristi’s pregnancy history.
6. Betty told Kristi the doctor would be in shortly.

18.4
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Details (continued)

Doctor Visit
7. When Dr. Webb came in and opened the
encounter, she spoke with Kristi to let her
know that yes, indeed, Kristi was pregnant
again.
8. In the encounter, Dr. Webb opened the Vitals
entry and selected Yes from the Pregnant
drop-down.

The system prompted her to create a new OB Care
Record.

9. Dr. Webb clicked the Yes button.

The Add OB Care window opened.

10. The doctor completed any necessary care
information for Kristi’s pregnancy and
clicked OK.

See page 18.8 for details on this window.

11. Dr. Webb clicked the EDD Calc button and
entered all the necessary information to
calculate Kristi’s estimated due date.

See page 18.10 for details on this window.

12. She clicked OK on the Edit Vital Signs window.
13. Dr. Webb continued with the remaining steps
of the Encounter Wizard and finished Kristi’s
visit, including Kristi’s OB Initial Exam and
Prenatal Visit.

Completing a Pregnancy
Once the patient’s pregnancy is over, in MicroMD EMR, you need to finish the documentation and create
that pregnancy history entry. On the Clinical Dashboard window for the OB Care module (Figure 18.1),
there is a Complete Record button.
When you click this button, the system prompts you to enter the details of the patient’s delivery and the
information about the infant(s). Click Pregnancy History button to enter the final details about the
patient’s pregnancy to close out their prenatal care. Pregnancy History is also necessary for maintaining
accuracy during future pregnancies.
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OB Care Dashboard

Figure 18.1 Closing Out Prenatal Care

OB Care Dashboard
The Clinical Dashboard in the Prenatal Care and Scheduled Visits sections allows you to review the
patient’s chart quickly, without opening the chart. In Scheduled Visits, the OB Dashboard button replaces
the New Encounter button for existing OB care patients in the list. The dashboard also allows you to
create the new encounter from within the dashboard, rather than exiting the window.

Figure 18.2 OB Care Clinical Dashboard

18.6

MicroMD EMR User’s Reference Manual Version 16.0

OB Care Record

Chapter 18. Medical Information: Women’s Health

If you have a template created and saved in the OB Care templates folder (under Tools > Clinical
Dashboard Templates), the system automatically loads this template for you. If you do not have a
template saved in that folder, the system prompts you to select a template each time you click the OB
Dashboard button.



For details on creating Clinical Dashboard templates,
please refer to page 27.2.

OB Care Record
For obstetrics and gynecology, MicroMD EMR allows you to create an interconnected OB Care Record for
your patient. Anytime you attempt to create an entry in any of the sections linked to the OB Care Record,
the system prompts you create an active OB Care Record if one does not already exist. If there is already an
active OB Care Record, the system automatically connects your new entry in any of the sections listed
below with that active OB Care Record.

Figure 18.3 OB Care Record
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OB Care Record

Overview of the OB Care Record Window
At the top of all OB Care Record entries is a blue header (Figure 18.4) that contains pertinent information
about the patient including her age, date of birth, medical record number, gravida para (page 18.8), last
menstrual period (LMP), estimated due date (EDD) (page 18.10), and whether the current record is an
active pregnancy record. Table 18.1 explains the fields on this window in more detail.

Figure 18.4 OB Care Record Window
Figure 18.5
Table 18.1 Fields on the OB Care Record Window

Field

Description

LMP

The date of the patient’s last menstrual period displays from the patient’s vital
signs entry with the same date as the date selected in the Initial Care Date field.

Gest

This field displays the calculated gestational age. The system calculates this
date using the calculation method from your practice’s preference, which you
set in the MicroMD EMR Manager. You can find the Gestational Age Calculation
field on the Demographics tab (under System Settings button in the EMR
Manager).



If no preference was selected, the system defaults to
Nägele’s Rule.

G0 P0000

The gravida/para for the patient displays. Click the link to open the Pregnancy
Status window and make any entries you need to make.

EDD

When you click on the EDD link, the system opens the EDD Calculation window,
which allows you to enter all the dates necessary for the system to perform the
calculations for you. See page 18.10 for more in-depth details.

18.8
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Table 18.1 Fields on the OB Care Record Window (continued)

Field

Description

Active Pregnancy

If this record represents the patient's current pregnancy, there is a check mark
in the Active Pregnancy checkbox. MicroMD EMR pulls this data from the
patient’s Pregnancy History section.

○

Make sure the Pregnancy History section is up to
date before you create a new OB Care record.

Pregnancy number

The Pregnancy number is the pregnancy represented by this record. If the
patient has three pregnancies, and there is a 2 in this field, this record
represents the patient’s second pregnancy.

Initial Care Date

This date reflects the date you created the patient’s OB Care Record.

Vital Signs

In the Vital Signs area, the system displays the vitals taken for the patient on
the date that displays in the Initial Care Date field.

Providers

In the Providers section, select the various providers responsible for the patient
and the newborn. You can either click the Lookup icon ( ) next to the dropdown or type freely in the field if the provider is not in the system.

Hospital

From the Facility drop-down in the Hospital section, select the facility at which
the birth will occur.
Answer the remaining drop-downs of this section with either Yes or No. When
you select Yes, the system automatically inserts today’s date in the Date field
and prompts you to provide the patient with patient education regarding the
item.



This documentation counts toward your
performance in the EHR incentive programs.

Contact Information

In the Contact Information section, enter the name and phone number of the
husband or domestic partner, and the father of the baby (if different).

Comments

Enter any additional information in the Comments field.

Insurance Plans

This section is for informational purposes only and defaults from the patient’s
demographics.

Documents Received

Attach any related documents in the Documents Received section.
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OB Care Record

Estimated Due Date (EDD) Calculation
In the blue header of the OB Care Record, you can click the EDD link to open the EDD Calculation window
(Figure 18.6). From here you can enter all of the necessary information for the system to calculate the
patient’s estimated due date for you.

Figure 18.6 EDD Calculation Window
On the EDD Calculation window, adjust the dates appropriately. For each date you adjust, click the
Update button on the same row to recalculate the estimated due date wherever it displays.



Click the Change Log button to see the update history
for the due date on this pregnancy.

When calculating the patient’s estimated due date, the system uses the calculation method from your
practice’s preferences, which you set in the MicroMD EMR Manager. You can find the Gestational Age
Calculation field on the Demographics tab (under System Settings button in the EMR Manager). If there is
no preference selected, the system defaults to Nägele’s Rule.

 Nägele’s Rule: With this rule, MicroMD EMR adds 281 days to the patient’s LMP date to calculate
the estimated due date.

 Mittendorf-Williams Rule: With this rule, MicroMD EMR calculates the estimated due date for the
patient’s first pregnancy by adding 284 days to the patient’s LMP date. For any subsequent
pregnancies, the system adds 289 days to the patient’s LMP date to calculate the estimated due
date for those pregnancies.

○

18.10

MicroMD EMR calculates the gestational age based on
the formula from American Congress of Obstetricians
and Gynecologists (ACOG), where the “reference date” in
the calculation is the patient’s prenatal visit date in
MicroMD EMR. For more details, visit www.acog.org.
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OB Medical History
When you visit with a patient, you review their medical history to better inform your care decisions. The
system pulls in any information from the patient’s Problem List (page 13.3) to help you complete the
history form.

Figure 18.7 OB Medical History
Choose Neg or Pos to indicate if the patient has a history of the item. You can enter any additional
information in the comment field. To add a diagnosis code, click the Lookup icon ( ) next to the field or
click the drop-down arrow ( ) to select a diagnosis from the patient’s Problem List. Click Next to
advance through the history wizard and click OK when completed.

○

In general, you enter this information while recording an
encounter and do not need to add the patient’s history
separately. See page 18.2 for details on the
recommended workflow.
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OB Genetic Screening

OB Genetic Screening
Prenatal genetic screening helps to diagnose, as much as possible, whether the fetus presents with a
specific genetic disorder or condition. The OB Genetic Screening section of the patient’s chart allows you
to review various genetic disorders within the patient’s family history.

Figure 18.8 OB Genetic Screening
Choose Yes or No to indicate if the patient has the genetic disorder or condition in their family. If they aren’t
sure, you can choose Not Known. You can enter any additional information in the comment field. If you
chose Yes, click the Lookup icon ( ) next to the Relationship field to identify all family members
diagnosed with the condition. Click Next to advance through the screening wizard and click Finish when
completed.

○

18.12

In general, you enter this information while recording an
encounter and do not need to add the screening
separately. See page 18.2 for details on the
recommended workflow.
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OB Initial Exam
The OB Initial Exam section allows you to record the details about the patient’s first prenatal physical
exam. This section differs from a standard encounter in that it lets you easily record pregnancy-specific
details.

Figure 18.9 OB Initial Exam
You can set all entries to Normal by clicking the Set All to Normal button. This allows you to set the
options quickly and then only change items that need to be changed. Click OK to save your changes.

○

In general, you enter this information while recording an
encounter and do not need to add the initial exam
separately. See page 18.2 for details on the
recommended workflow.



You can only have one entry in the OB Initial Exam
section of the patient's chart.



Any entry marked as a status other than “Normal”, “No
Concerns”, or “Average” appears in red text.
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Prenatal Visits

Prenatal Visits
The Prenatal Visits section of the patient’s chart lists all visits where Prenatal was selected for the Nature
of Encounter section in the Encounter Header. When you create a prenatal encounter, you can record
additional information about the patient’s pregnancy. Whether you create the prenatal visit from within an
encounter or from within the Medical Information tab, the Prenatal Visit window allows you to enter
comprehensive information about the patient.

○

In general, you enter this information while recording an
encounter and do not need to add a visit separately. See
page 18.2 for details on the recommended workflow.

Figure 18.10 Prenatal Visit

Procedure

Details

1. From the patient’s chart, click the Medical
Information tab.
2. In the Chart Navigator, click the Women’s
Health button and choose Prenatal Visits
from the available options.

The system displays the list of all the patient’s
prenatal visits currently entered into the database.

3. Click the Add button.

The Add Prenatal Visits window opens (Figure 18.10).
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Procedure (continued)

Details (continued)

4. Enter the appropriate information.
5. Click OK.

If entering the visit data outside of an encounter, click
the Sign button.

Pregnancy History
MicroMD EMR allows you to maintain comprehensive details specific to the patient’s history of pregnancy.
You can record the delivery method of the infant and how long the mother was in labor. You can also
record information about multiple fetuses and any complications that occurred during the pregnancy.

○

Information entered in the Pregnancy History populates
the appropriate section in the patient’s Antepartum Form
(page 18.18).

Figure 18.11 Patient’s Pregnancy History
MicroMD EMR also allows you to record—as part of the patient’s chart—that the patient has no known
pregnancies. The No known pregnancies entry appears as the only entry. Please see page 12.4 for more
details on the No known entry in a patient’s chart.
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Pregnancy History

To view the patient’s pregnancy history, open their chart, click the Medical Information tab, click the
Women’s Health button and choose Pregnancy History from the available options. To edit or delete an
entry from this list, simply highlight the entry and click Edit or Delete as appropriate.

Figure 18.12 Pregnancy History Entry
To add a new pregnancy history item:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Women’s
Health button and choose Pregnancy History
from the available options.

The system displays the items that make up the
patient’s pregnancy history, if any.

3. Click the Add button.

The Add Pregnancy History window box opens
(Figure 18.12).

4. Enter all information as it applies to the
patient at this time.

To record multiple fetuses or complications with
the pregnancy, click the Add button in the Fetuses
section and/or the Complications section as
appropriate.
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Procedure (continued)

Details (continued)

5. Click OK to save your entry.

The system adds the new information to the
patient’s history.

Prenatal Care on the Desktop
The Prenatal Care section of the Desktop can provide a central location to manage your prenatal patients.
The list defaults to patients with an estimated due date that falls within the current week (i.e., Sunday
through Saturday), but you can select from several options in the EDD Date Range filter.



A red exclamation point ( ) next to the patient’s name
indicates a high-risk pregnancy patient.

Figure 18.13 Prenatal Care on the Desktop
Use the other filters to narrow your list of patients to suit your current needs. The yellow “sticky” displays
the details of the selected patient’s last prenatal visit.



The white area in the middle of the “sticky” lists each
fetus in the active pregnancy. Use the vertical scroll bar
to review the information.
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Antepartum Report

From the list you can perform the following actions:

 Open Chart: Click this button to open the selected patient’s chart.
 Print Report: Click this button to display the Antepartum Report window (Figure 18.14 on page
18.18). From here you can generate a report and either print or send the document to a third
party. See page 18.18 for more details on this report.

 Print List: Click this button to print the list of patients currently displayed in the window.
 Patient Monitor: Click this button to open the Patient Monitor window for the selected patient.
For details on working with the Patient Monitor, please see page 27.16.

 Sent Log: To see a list of each antepartum report printed or sent to a third party, click the Sent
Log button. You can reprint or resend the report as needed.

 Dashboard: Click this button to launch the Clinical Dashboard for the selected patient. If you
have a template created and saved in the OB Care templates folder (under Tools > Clinical
Dashboard Templates), the system automatically loads this template for you. If you do not
have a template saved in that folder, the system prompts you to select a template each time you
click the Dashboard button. See page 18.6 for more details on the OB Dashboard.

Antepartum Report
When you click the Print Report button in the Prenatal Care section of your Desktop, the system displays
the Antepartum Report window (Figure 18.14). On this window, you can place a check mark next to each
section you want to include in the report.

Figure 18.14 Antepartum Report
18.18
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The report relates to the pregnancy currently selected in the Pregnancy No drop-down; however, you can
change it if you need a report on a different pregnancy. Table 18.2 explains the fields on this window in
more detail.
Table 18.2 Fields on the Antepartum Report Window

Field

Description

Generate Report for

The Generate Report for field displays the patient’s name for whom
MicroMD EMR will create the report.

Report Destination

The Report Destination options indicate how you want to generate the
report. You have two options:

 Send directly to printer: Choose this option to display the printer
dialog when you click the OK button. From the Print Options
window, you can choose to send the report to the Batch Basket;
fax the report; send a mail message (and if available, a Direct Mail
address); or send the report to a printer in your office.

 Display in the Application Viewer: Choose this option to launch a
preview of the report. If you then want to send the report, you can
access various options from the File menu.
Additional Medical
Information

Place a check mark next to each piece of information you want to
include in the report. Use the Select All / Deselect All button to make
your choices quickly. The system remembers the choices you make for
the next time you open the window.

Pregnancy No

Select the pregnancy to which the information in the report relates. By
default, the system selects the patient’s current pregnancy.

Save Report to Document
Manager

If you want to add the document to the patient’s folder in MicroMD
DMS, place a check mark in this option.

Record report correspondence

Place a check mark next to this option to enable the correspondence
fields.
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Fetal Ultrasound

Fetal Ultrasound
MicroMD EMR allows you to maintain comprehensive history of the patient’s fetal ultrasounds. As the user
performs the ultrasound (or after they perform it), they can use this area to record the results of the scan,
including the position of the fetus, condition of the placenta and various measurements of the fetus.

Figure 18.15 Patient’s Fetal Ultrasound
To view the patient’s fetal ultrasound history, open their chart, click the Medical Information tab, click the
Women’s Health button and choose Fetal Ultrasound from the available options. To edit or delete an
entry from this list, simply highlight the entry and click Edit or Delete as appropriate.



You can set the default units of measurement for fetal
ultrasounds (i.e., centimeters or millimeters) for your
practice in the MicroMD EMR Manager under System
Settings. See page 1.34 for more details on the
Demographics options.

To add a fetal ultrasound entry:

Procedure

Details

1. From the patient’s chart, click the Medical
Information tab.
2. In the Chart Navigator, click the Women’s
Health button and choose Fetal Ultrasound
from the available options.

18.20

The system displays the list of all the patient’s fetal
ultrasounds currently entered into the database.
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Procedure (continued)

Details (continued)

3. Click the Add button.

The Add Ultrasound window opens (Figure 18.15).
The Pregnancy No field defaults to the current
active pregnancy.

4. Select the appropriate Fetus No from the
drop-down menu.
5. Complete the remaining fields as appropriate.
6. Repeat step 3 through step 5 for each fetus.
7. Click the OK button to save your entry.

Gynecology History
MicroMD EMR allows you to maintain comprehensive details specific to the patient’s gynecological history.
You should enter any gynecological problems (i.e., ovarian cancer, cysts). If the information you want to
enter relates specifically to the patient’s menstrual cycle, you should enter it under the Menstruation
History sub-category (page 18.23).

Figure 18.16 Patient’s Gynecology History
MicroMD EMR also allows you to record—as part of the patient’s chart—that the patient has no known
history of gynecological problems. The No known gynecology entry appears as the only entry. Please see
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Gynecology History

page 12.4 for more details on the No known entry in a patient’s chart.
To view the list of the patient’s gynecological history, open their chart, click the Medical Information tab,
click the Women’s Health button (Figure 18.16) and choose Gynecology History from the available
options.



Check the Current checkbox to view only the recent
problems listed for the patient.

To edit or delete an entry from this list, simply highlight the entry and click Edit or Delete as appropriate.
To terminate a gynecological problem in the patient’s history, click the Terminate button. (See page 12.5
for more details on terminating entries.)



Only delete an entry if it was a mistake. If the patient
suffered the condition in the past and no longer suffers
the condition, you should Terminate the entry instead.
This keeps the item in their history for future reference.

To add a new gynecological problem:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Women’s
Health button and choose Gynecology
History from the available options.

The system displays the patient’s history of
gynecological problems if there have been any.

3. Click the Add button.

The Add Gynecology dialog box opens.

4. Enter all information as it applies to the
patient at this time.
5. Click OK to save your entry.
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The system adds the new information to the
patient’s history.
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Menstruation History
MicroMD EMR allows you to maintain comprehensive details specific the patient’s menstruation cycle in
the Menstruation History section. You should enter any gynecological problems (e.g., ovarian cancer,
cysts) under the Gynecology sub-category (page 18.21). As part of the menstruation history, the system
also provides an area for you to record up-to-date menarche and menopause details for the patient.

Figure 18.17 Patient’s Menstruation History
To view the patient’s menstruation history, open their chart, click the Medical Information tab, click the
Women’s Health button and choose Menstruation History from the available options.



Check the Current checkbox to view only the active
history items for the patient.

To edit or delete an entry from the patient’s menstruation history, simply highlight the entry and click Edit
or Delete as appropriate. To view or edit the patient’s menarche information or to record the onset of their
menopause, simply click the Menarche button and enter the appropriate information.
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Family Planning History

To add a new menstruation history entry:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Women’s
Health button and choose Menstruation
History from the available options.

The system displays the list of issues that make up
the patient’s menstruation history.

3. Click the Add button.

The Add Menstruation History dialog box opens.

4. Enter all information as it applies to the
patient at this time.
5. Click OK to save your entry.

The system adds the new information to the
patient’s history.

Family Planning History
MicroMD EMR allows you to maintain a comprehensive history of the family planning methods employed
by the patient.

Figure 18.18 Patient’s Family Planning History

18.24

MicroMD EMR User’s Reference Manual Version 16.0

Family Planning History

Chapter 18. Medical Information: Women’s Health

MicroMD EMR also allows you to record—as part of the patient’s chart—that the patient has no known
history of practicing any birth control methods. The No known family planning entry appears as the only
entry. Please see page 12.4 for more details on the No known entry in a patient’s chart.
To view the list of the patient’s history of family planning, open their chart, click the Medical Information
tab, click the Women’s Health button (Figure 18.18) and choose Family Planning from the available
options.



Check the Current checkbox to view only the recent
problems listed for the patient.

To edit or delete an entry from this list, simply highlight the entry and click Edit or Delete as appropriate.
To terminate a family planning entry in the patient’s history, click the Terminate button (page 12.5).



Only delete an entry if it was a mistake. If the patient
used a birth control method in the past and no longer
uses that method, you should Terminate the entry
instead (e.g., Ortho Tri-cyclen makes her sick). This
keeps the item in their history for future reference.

To add a new family planning history entry:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Women’s
Health button and choose Family Planning
from the available options.

The system displays the patient’s family planning
history.

3. Click the Add button.

The Add Family Planning dialog opens.

4. Enter the appropriate information.
5. Click OK or Apply/New.

MicroMD EMR User’s Reference Manual Version 16.0

The system adds the new item to the patient’s
chart. If you click the Apply/New button, the
system adds the item to the patient’s chart and
clears the window so you can continue adding
more.
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Labor and Delivery
This section of the Medical Information tab allows you to maintain a history of the patient’s deliveries.
You can record every detail about the patient’s labor and the delivery of each of her babies from whether
there was a midwife to the delivery time of the placenta to any complications that arose during delivery.

Figure 18.19 Labor and Delivery Main
To edit or delete an entry on this window, highlight the entry and click the Edit or Delete button as
appropriate. If you want to print a delivery report for any of the entries on this window, highlight the entry
and click the Print button.
When you add a delivery to a patient’s chart, the system displays the Labor and Delivery window (Figure
18.20). Each tab of this window provides in-depth clinical details about the labor and delivery you want to
record. Complete any of the fields that contain the information you want to record.
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Figure 18.20 Labor and Delivery Details
To record labor and delivery details:

Procedure

Details

1. From the patient’s chart, click the Medical
Information tab.
2. In the Chart Navigator, click the Women’s
Health button and choose Labor & Delivery
from the available options.

The system displays the list of all the patient’s
entries currently entered into the database.

3. Click the Add button.

The Labor and Delivery window opens (Figure
18.20).
The Pregnancy No field defaults to the current
active pregnancy.

4. Click each tab and complete any information
you want to record.
5. Click the OK button to save your entry.
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Labor and Delivery
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Medical Information: Behavioral Health
The Behavioral Health section of the patient’s chart allows you add questionnaires to the patient’s chart
and track results for the patient.

In This Chapter
In this chapter, we cover:

 Adding a questionnaire to the patient’s chart (page 19.2)
 Creating questionnaire templates (page 19.2)
 Reviewing and comparing questionnaire results (page 19.6)

Overview
The Behavioral Health category of the Medical Information tab displays the list of questionnaires
completed for the patient. The yellow “sticky” displays the details of the selected questionnaire. The action
buttons on the right allow you to perform a variety of actions with the selected questionnaire.

Figure 19.1 Behavioral Health Section of Medical Information Tab



If you do not need this section, you can use Navigator
Templates (page 12.9) and hide the category.
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Adding a Questionnaire to the Patient’s Chart

Adding a Questionnaire to the Patient’s Chart
If you want to add a questionnaire to the patient’s chart, simply click the Add button in the Behavioral
Health Screening section of the chart (Figure 19.1) and select the questionnaire from the Questionnaire
drop-down (Figure 19.2). See page 19.2 for details on adding questionnaire templates to the system.

Figure 19.2 Behavior Health Screening Window
You can scroll through the questions on the right side of the screen or you can click the links on the left to
jump quickly to a different section. As you answer questions, if the template contains scoring information,
the score for each section appears in the header of that section. Click OK once you have completed the
questionnaire.
The system displays each questionnaire in the list. When you highlight the questionnaire, the sticky note at
the bottom of the window displays some details from the entry.

Behavioral Health Questionnaire Templates
MicroMD EMR comes with a standard questionnaire already created for you; however, you can create any
templates you need to create and score. From the main menu, select Tools > Questionnaire Templates.

 The Standard button on the left to see any questionnaires that have gone through an initial
approval process at MicroMD and uploaded to the Standard list for all practices.

 The Shared button displays those questionnaires created from other users who have uploaded
their templates to the shared directory.
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 The Personal button displays only those templates that you have saved to your user account.



See page 2.8 for more details on working with templates
in MicroMD EMR.

Figure 19.3 Questionnaire Template Manager
To add a new template, make sure you have the Personal button selected. When you save the template in
your Personal folder, you can work on the template until you’re ready to share it or submit it for inclusion
in the Standard templates. Click the New button, the Questionnaire Template window opens (Figure 19.4),
add your sections and questions/answers, and click OK.

Figure 19.4 Questionnaire Template Window
To expand/collapse an entry, click the plus sign ( ) or minus sign ( ). To make changes to a section,
question, or answer, highlight the item and click the Edit button. To remove an entry, click the Delete
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button. If you want to rearrange sections, questions, or answers, highlight the item you want to move and
click the up arrow ( ) or down arrow ( ), depending on where you want to position the item.



Each panel is dependent on entries made in the panel
above. When you highlight a section, the questions
pertain only to that section. When you highlight a
question, the answers apply only to that question.

Sections
Click the Add button in the Sections header to build each group of questions you need for your
questionnaire. This allows you to enter LOINC codes for the section and for the section’s score (Figure
19.5).

Figure 19.5 Add Section Window
If you need to select an existing section that you have already created, perhaps you have similar
questionnaires with the same title and LOINC codes, select that section from the Existing Section option.
To create a new group of questions, choose the New Section option. Enter the details for the section and
click OK.

Questions
To add questions to a section, highlight the section in the top pane and click the Add button in the
Questions pane in the middle. The Add Question window opens (Figure 19.6).

Figure 19.6 Add Question Window
On this window, you can type the text of your question in the Question field. Depending on the type of
interaction you want when answering the question, you can select one of the following options from the
Answer Type drop-down. You specify the answer choices in the Answers section.
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 Radio Button: This type of answer allows you to make a single choice from several options.
 Text Box: With this type of answer, you can simply type text in a blank field.
 Drop Down List: The drop-down list allows you to make a single choice from several options,
similar to a radio button. The benefit of a drop-down list is that you can save space if you have a
long list of choices.

 Checkbox: If you have several answers that apply to the questions, you can add all of the options
as individual checkboxes and users can make multiple choices in answer to the question. For
example, you may have a question where you want the user to “check all that apply.” You would
use the checkbox type of answer.

 Number Pad: If the answer to the question MUST be a numerical value, you can specify that the
answer use the number pad. The system will require the user to type a number or use the
number pad to enter a number. You can also specify any minimum and maximum limitations to
the value.

Answers
Once you have the question established, you can enter the answer options. Each answer option for the
selected question gets an entry in the Answers section.
Highlight the question in the Questions pane and click the Add button in the Answers section. The Add
Answer window opens (Figure 19.7). You can enter the text of the answer, the score, and the LOINC for the
answer if needed.

Figure 19.7 Add Answer Window
For example, if the question selected in the Questions section has requested a rating scale from Very Hard
to Declined to Specify, you could have five entries in the Answers section: Very Hard, Hard, Somewhat
Hard, Not Very Hard, and Decline to Specify (Figure 19.4 on page 19.3).
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Behavioral Health Reporting
For each patient, you can compare the results of the questionnaire(s) you perform. Click the Compare
button, and the system displays the Behavior Health Screening window. Select the questionnaire you
want to review from the Questionnaire drop-down, and the system displays all entries from the patient’s
chart that use that same template.

Figure 19.8 Behavior Health Screening Window
If you want to see the graph of a specific section of the questionnaire, select that section from the Graph
drop-down. The system displays the section scores in a visual format over a year’s time so you can review
the patient’s progress.
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The Miscellaneous section of the patient’s chart allows you to manage a variety of attachments, as well as
some other history items and confidential information.

In This Chapter
In this chapter, we cover:

 Saving attachments to the patient’s chart (page 20.1)
 Writing letters (page 20.12)
 Adding patient directives to the patient’s chart (page 20.14)
 Adding confidential information to the patient’s chart (page 20.16)
 Managing Patient Education information (page 20.17)
 Adding forms to the patient's chart (page 20.18)
 Managing incoming referrals (page 20.20)
 View the patient’s list of transitions of care into the practice (page 20.22)
 View the audit log of clinical decision support rule actions (page 20.22)

Attachments
MicroMD EMR lets you attach a variety of files to a patient’s chart from several areas of the program. For
example, you could attach:

 the recording of an interview with the patient
 photographs of the patient showing the progress of a skin condition over time
The Attachments section of the chart allows you to manage those files from a central location for the
patient. The system stores all of the file attachments in MicroMD Document Management. Please see
Chapter 28 for more details on using the document manager.



Imaging features are intended for documentation and
patient education purposes and should not be used for
diagnosis or treatment.
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Figure 20.1 Attachments in a Patient’s Chart
To view the list of attachments to a patient’s chart, open their chart, click the Medical Information tab,
click the Miscellaneous button and choose Attachments from the available options (Figure 20.1). Simply
click the Add button to add an attachment to the patient’s chart.
To view a specific attachment, highlight the entry and click Open (or double-click the entry to open it). To
delete an entry from this list, highlight the entry and click Delete.
If you want to view the patient’s entire folder in MicroMD Document Management, click the Folder button
(Figure 20.1).

Attachments Window
When you add an attachment to the patient’s chart, the Add Attachment window controls how you add
that attachment and if you want to associate that document with orders or other information in the
system. You can access this window from various areas in the system. Table 20.1 explains the fields of the
window in detail.
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Figure 20.2 Attachment Window
Table 20.1 Fields on the Add Attachment Window

Field

Description

Patient

When you add an attachment from within a patient’s chart, this field defaults to
the current patient.
From the Desktop, you can enter the patient to whose chart you would like to
attach the document, and if you do not want to associate the document with a
specific patient, you can leave this field blank. The system then saves the file
without association to your practice’s MicroMD Document Management File
Cabinet.

File Name

When adding an attachment to the patient’s chart, you enter a name for the
attachment in the File Name field and then select the method of attaching the
file from the drop-down icon (
) next to the field. You can:






Attach an existing file
Scan a document
Record an audio file
Create a link to an external website

Please see more details on each attachment method starting on page 20.6.
Service Date

You can associate a service date with an attachment. The date you enter in the
Service Date field carries over into MicroMD Document Management and allows
you to search for the document by this date.
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Table 20.1 Fields on the Add Attachment Window (continued)

Field

Description

Type

The Type field allows you to choose the kind of attachment you want to insert
into the patient’s chart and where you want to store it in MicroMD Document
Management. When you select a Type, the system defaults to the
recommended folder. If you select an order type or a Medical Information
category, the system activates the Order or Entry drop-down as appropriate.

Order or Entry

Once you make a selection in the Type field, the system displays the Order dropdown or the Entry drop-down, depending on which type you chose. In that
drop-down, the system displays those orders or entries that were created within
the last 180 days.
When you select the order or entry you want to associate with the attachment,
the system displays the Status drop-down.

Order Status

When you choose an order from the Order drop-down, the system displays the
Order Status drop-down. This drop-down defaults to the order’s current status.
When you change this drop-down, the system changes the status of the order
appropriately.

Create Test Result

This checkbox appears when you select Procedure Order/Result or Laboratory
Order/Result from the Type drop-down. When you place a check mark in this
checkbox, the system creates a row in the Test Results section of the provider’s
Desktop.
If you leave the box unchecked, the system simply adds the documents to the
order and to the Attachments section of the patient’s chart, without creating a
results entry.

Result Status

When you choose a status from the Result Status drop-down, the system
changes the Result Status on the selected order when you click Attach.

Folders section

The folder structure displayed here is the folder structure of the selected
patient’s chart in MicroMD Document Management. Whenever you make a
selection from the Type drop-down, the system automatically chooses the
appropriate MicroMD Document Management folder for you. If you want to
change the location for this particular attachment, you can select the
appropriate folder.

○

If you did not enter a patient (maybe you came to
this window through the Desktop), the folders
displayed in this section are the folders in your
practice’s file cabinet.

Attachment For

Select the MicroMD EMR user the system should notify of the attachment. When
you save the attachment, the system adds an entry to the Attachments section
of the selected user’s Desktop.

Comment

Enter any notes about the document that the user should know.

20.4

MicroMD EMR User’s Reference Manual Version 16.0

Attachments

Chapter 20. Medical Information: Miscellaneous

Table 20.1 Fields on the Add Attachment Window (continued)

Field

Description

Viewed

When you place a check mark in this box, the system marks the document as
viewed when it creates the attachment. If you are not the person listed in the
Attachment For field, you should not check this box.

URGENT!

If you want MicroMD EMR to display a red alert exclamation point ( ) next to the
attachment on the Desktop of the user in the Attachment For field, place a
check mark in the URGENT! checkbox.

Associating an Attachment
On the Add Attachment window, there is a section that allows you to associate the document with existing
orders in the system (or certain Medical Information categories) and to tell the system that the attachment
is actually a test result (for procedure or laboratory orders).

Figure 20.3 Associating an Attachment
When you make a selection from the Type drop-down, the Order or Entry drop-down appears (depending
on your Type choice). The system loads this drop-down with any entries that were created within the past
six months (180 days).
The Order Status drop-down appears when you select an order from the Order drop-down. This dropdown displays the current status of the selected order. To change the status of the order, simply make the
appropriate selection from the drop-down. Users can also change the status of the results from this
window using the Result Status drop-down.
For example, Betty at the front desk received the results for Andy Homer’s X-ray. She clicks Add Attachment
in her Desktop Tools and enters the patient’s name in the Patient field. She selected Procedure Order/
Result from the Type drop-down, the appropriate order from the Order drop-down and changed the Order
Status from Requested to Performed/Received. Since these are the final test results, she changes the
Result Status drop-down to Final.

Creating a Test Result from an Attachment
When you create orders in the system, you can either assign them to a staff member in the practice to
perform, or you might send the order to be completed at an outside vendor. When those results come
back, you need to attach those results to the order that was created, as well as be able to notify the
physician that the results are ready to view. The attachments window allows you to do this.
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Figure 20.4 Create a Test Result from an Attachment
When you open the attachments window, you select either Procedure Order/Result or Laboratory Order/
Result from the Type drop-down (Figure 20.4). The system loads the Order drop-down with any orders that
were created within the past six months (180 days).
Select the order to which you want to attach the results and change the Order Status drop-down
appropriately (typically Performed/Received).
Once you have the correct order selected, verify there is a check mark in the Create Test Result checkbox.
Once you click the Attach button, the system creates a test result on the Desktop of the user listed in the
Attachment For drop-down. See page 4.38 for details on the Test Results section of the Desktop.

○

If there was no order created in the system for the
attachment, you can simply select <NONE> from the
Order drop-down when you select either Procedure
Order/Result or Laboratory Order/Result from the Type
drop-down (Figure 20.4).
When the user selected in the Attachment For drop-down
reviews the Test Results section of their Desktop, they will
see a row reflecting this attachment.

Attaching an Existing File to a Patient’s Chart
MicroMD EMR allows you to add an existing file as an attachment to a patient’s chart. Although the files
that you attach can be in any format, we recommend that you attach only documents with commonly
used file types. This ensures that most users have the software required to access the files. The list of
common document file types includes *.doc, *.pdf, and *.html files. The system accepts common image
formats: *.bmp, *.gif, *.dxf, *.png, or *.jpg.

○

20.6

When you attach existing files that you want to open later
on your machine, you must have the appropriate
software installed to open the file.
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To add an existing file as an attachment to a patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.

You can also add an attachment from your
Desktop under Attachments (page 4.2).

2. In the Chart Navigator, click the
Miscellaneous button and choose
Attachments from the available options.

The system displays the entire list of attachments
(including images) in the patient’s chart.

3. Click the Add button.

The Add Attachment window opens (Figure 20.2 on
page 20.3).

4. From the File Name drop-down
Existing File from the menu.

, select

5. Navigate to the file you want to attach and
click Open.
6. Complete the Associate Attachment section
as appropriate.
7. In the Attachment For drop-down, select the
MicroMD EMR user the system should notify of
the attachment.

The system populates this drop-down from your
Common List of users. If you do not see the user
you want, click the search icon to insert the
appropriate user.

8. Add any additional information in the
Comment field.
9. Click Attach.

The system adds the file to the patient’s chart and
displays the file name in the list of attachments.

Scanning a File into a Patient’s Chart
MicroMD EMR allows you to scan an existing hard copy image and attach the scanned file to a patient’s
chart. This is a great tool if you have existing film of a patient that you want to include in their electronic
chart.

○

You must have a scanner installed and working on your
computer to use this feature.

○

When you scan images, ensure that your scanner is set to
scan at a resolution of 72 dpi or less. This keeps the size of
the files small so they do not use up the memory of your
server needlessly.
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To scan an image and attach it to the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.

You can also add an attachment from your
Desktop under Attachments (page 4.2).

2. In the Chart Navigator, click the
Miscellaneous button and choose
Attachments from the available options.

The system displays the entire list of attachments
(including images) in the patient’s chart.

3. Click the Add button.

The Add Attachment window opens (Figure 20.2 on
page 20.3).

4. In the File Name field, enter a useful filename
for the new attachment.

You must enter a file name before you can scan
a document.

5. From the File Name drop-down
Scan Document from the menu.

The MicroMD Scanning window opens.

, select

6. If you have multiple TWAIN devices
connected, click the Select button to choose
the one you want to use for this session.

This list displays all connected TWAIN devices. The
system defaults to the last device you used on this
workstation.
If you need to access the manufacturer’s setup
options for the device, you can click the Setup icon
( ) that is below the Select button in the
navigation band.

7. Check or uncheck the Multi-Page Scan and
Auto Close checkboxes as necessary.

With the Multi-Page Scan box checked, the system
allows you to scan an entire stack of papers (or
images) into a single file. If you remove the check
mark, you can scan an entire stack of papers (or
images), but the system separates each scan into
its own individual file.
When you place a check mark in the Auto Close
checkbox, the system automatically closes this
scanning window when the scan is complete.
The system defaults to the choices you made
during the last session for both of these options.

8. Click the Scan button when ready.

20.8

The system displays the manufacturer’s scanning
window for the device you have selected.
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Procedure (continued)

Details (continued)

9. Follow the instructions for your device.

Once MicroMD Document Management has
scanned the document(s) and/or image(s), it
displays the scan in the MicroMD Scanning
window.
At this point, you can close the window or add
another scan to the current document file. Click
the Append button to perform step 7 through step
9 again and add to the end of the current
document.

10. Close the MicroMD Scanning window when
finished.



This window closes automatically if
you have the Auto Close checkbox
checked.

11. Complete the Associate Attachment section
as appropriate.
12. In the Attachment For drop-down, select the
MicroMD EMR user the system should notify of
the attachment.

The system populates this drop-down from your
Common List of users. If you do not see the user
you want, click search icon to insert the
appropriate user.

13. Add any additional information in the
Comment field.
14. Click Attach.

The system adds the file to the patient’s chart and
displays the file name in the list of attachments.

Attaching a Dictation to a Patient’s Chart
MicroMD EMR allows you to record a dictation and save it to a patient’s chart. This is a great tool if you
prefer to record your notes on a patient’s file, rather than typing.

○

You must have a microphone attached and working on
your computer.

To create a dictation an attach it to the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.

You can also add an attachment from your
Desktop under Attachments (page 4.2).

2. In the Chart Navigator, click the Miscellaneous
button and choose Attachments from the
available options.

The system displays the entire list of attachments
(including images) in the patient’s chart.

MicroMD EMR User’s Reference Manual Version 16.0

20.9

Chapter 20. Medical Information: Miscellaneous

Attachments

Procedure (continued)

Details (continued)

3. Click the Add button.

The Add Attachment window opens (Figure 20.2
on page 20.3).

4. In the File Name field, enter a useful filename
for the new dictation.

You must enter a file name before you can create
the dictation.

5. From the File Name drop-down
, select
Create Dictation from the menu.

The Dictation Recorder window opens.

6. Click the Record button in the ribbon bar and
speak into your microphone.
7. Click the Stop button when finished.

You can click the Play button to hear your
recording before you save it.

8. When satisfied, click the main DMS button
and select Save Dictation from the dropdown menu.

If you are not satisfied with the dictation, select
Clear Dictation instead and start your recording
again.
9. Complete the Associate Attachment section as
appropriate.

See page 20.5 for details on document
associations.

10. In the Attachment For drop-down, select the
MicroMD EMR user the system should notify of
the attachment.

The system populates this drop-down from your
Common List of users. If you do not see the user
you want, click search icon to insert the
appropriate user.

11. Add any additional information in the
Comments field.
12. Click Attach.

20.10

The document appears in the patient’s chart
under Attachments. You can sort the list by the
Folder column to group the patient’s consents
and refusals together.
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Adding a Web Address to a Patient’s Chart
You can attach the shortcut to an Internet web site to a patient’s chart. This can save space on your server
by linking to an image on a PACS.
To add a web address to the patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.

You can also add an attachment from your
Desktop under Attachments (page 4.2).

2. In the Chart Navigator, click the
Miscellaneous button and choose
Attachments from the available options.

The system displays the entire list of attachments
(including images) in the patient’s chart.

3. Click the Add button.

The Add Attachment window opens (Figure 20.2 on
page 20.3).

4. From the File Name drop-down
Web Address from the menu.

, select

The File Name field changes to Web Address.

5. Type the web address into the Address field.
6. Complete the Associate Attachment section
as appropriate.

See page 20.5 for details on document
associations.

7. In the Attachment For drop-down, select the
MicroMD EMR user the system should notify
of the attachment.

The system populates this drop-down from your
Common List of users. If you do not see the user
you want, click the search icon to insert the
appropriate user.

8. Add any additional information in the
Comment field.
9. Click Attach.

The system adds the link to the patient’s chart and
displays the web address in the list of attachments.

Signing an Attachment
Once you have finalized an attachment to the patient’s chart, you can click the Sign button to prevent any
changes being made to the attachment or to the entry in the chart.
Whenever someone views or prints a signed PDF or image file, the attachment displays or prints a
“Document digitally signed by” notice at the top of the file indicating who signed it and when. Simply make
sure you have a check mark in the Print Image Annotations checkbox when you print the document.

Figure 20.5 Print Options Window
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○

Managing Letters in a Chart

If the document is signed, users can no longer add Page
Notes or Document Comments.

Managing Letters in a Chart
When you write letters related to a patient, the system allows you to add those letters to the patient’s
chart. For example, you could attach:

 a scan of a referral letter received in the mail from another doctor
 a referral letter that you wrote in the system and sent to another doctor

Figure 20.6 List of Letters in the Patient’s Chart
Each letter that you attach can be an existing file, or you can use MicroMD EMR to compose the letter.
Existing files can be in any format. However, you must have the required software installed to view or edit
the files after you attach them to the patient’s chart.
To view a letter in the list, simply highlight the entry and click Open. To delete a letter, highlight the letter
and click Delete.
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Adding an Existing Letter to a Patient’s Chart
MicroMD EMR allows you to attach electronic files of existing letters to a patient’s chart. These could be any
file format, including Microsoft Word or scanned images. If you want to view the document, though, you
must have the software installed and working on your computer.
To add a letter to a patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the
Miscellaneous button and choose Letters
from the available options.

The system displays the entire list of letters
currently associated with the patient’s chart.

3. Click the Attach button.

The Add Letter window opens.

4. Click the Browse button.
5. Navigate to the file you want to attach and
click Open.

The system displays the name of the attachment in
the File name field.

6. In the Sent from field, enter the sender of
the letter.

You can type text in this field if the sender is an
outside source (e.g., ABC Insurance Company). If a
MicroMD EMR user with the role of Physician sent
the letter, click the Lookup icon ( ) to insert the
appropriate user.

7. In the Sent to field, type to whom the letter is
addressed.
8. Add any additional information in the
Comments field.
9. Click Attach.
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The system adds the file to the patient’s chart and
displays the file name in the list of attachments.
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Writing a Letter and Attaching It to a Chart
When you want to compose a letter, MicroMD EMR allows you to attach a copy of the letter to the patient’s
chart. Generally, when you write a letter in the system, you select Print > Letter from the main menu when
you’re in the patient’s chart. If you want to create a letter directly from this sub-category, click the Write
button (Figure 20.6 on page 20.12). See Chapter 26 for more in-depth details on creating letters.

Managing Patient Advance Directives
Patients prepare an advance directive to express their wishes regarding medical intervention and other
decisions in the event that he or she becomes incapacitated and unable to make those decisions. Advance
directives can include a living will, a healthcare proxy, or any other directive that the patient requests.

Figure 20.7 List of Patient’s Advance Directives
To view the list of the patient’s directives, open their chart, click the Medical Information tab, click the
Miscellaneous button (Figure 20.7) and choose Patient Directives from the available options.
To edit or delete a patient directive, simply highlight the entry and click Edit or Delete as appropriate.



To terminate a directive, edit the directive and enter a
date in the End date field. This keeps the directive in
the patient’s history for future reference.

MicroMD EMR allows you to add advance directives. Each advance directive is strongly recommended to
have a start date and end date.
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To add a new patient advance directive:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the
Miscellaneous button and choose Patient
Directives from the available options.

The system displays the entire list of directives the
patient has requested.

3. Click the Add button.

The Add Patient Directives window opens.

4. From the Subject drop-down, select the type
of directive you want to add.
5. In the Start date field, enter the effective date
of the directive.

For example, Andy Homer has surgery scheduled
for September 27, 2019. He wants to establish a
living will for the duration of the surgery. Betty at
Summervale Medical Center enters this date in the
Start date field.

6. In the Instruction field, enter the details of
the directive.
7. To attach documents to the patient directive,
click the Lookup icon ( ) next to the
Documents Received field.

This opens the Attachments window. Please see
page 20.1 for more details on adding attachments.

○
8. Click OK when finished.
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You must save the directive before
you can attach a document.

The system adds the new directive to the
patient’s chart.
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Managing Confidential Information
MicroMD EMR allows you to enter confidential information into a patient’s chart. Only the provider who
enters the confidential information can access that information or even see that the confidential entry
exists. For example, Andy Homer has severe depression but doesn’t want his wife to know. His wife also
visits the same practice and would appear as a family member.

Figure 20.8 List of Confidential Information
To view the list of the confidential information entries in a patient’s chart, open their chart, click the
Medical Information tab, click the Miscellaneous button (Figure 20.8) and choose Confidential Info from
the available options.



The system displays only those confidential entries
that you entered. You cannot view those created by
other providers.

To view or edit a confidential entry, simply highlight the entry and click Edit. To delete a confidential entry,
highlight the entry and click Delete. In all cases, the system prompts you for your password to confirm your
access rights to the information.
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To add a new confidential entry to a patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the
Miscellaneous button and choose
Confidential Info from the available options.

The system displays the list of your entries in the
patient’s chart.

3. Click the Add button.

The Add Confidential Info dialog opens.

4. Enter the appropriate information.
5. Click OK.

The system adds the new item to the patient’s
chart.

Managing Patient Education Information
MicroMD EMR allows you to maintain a list of the patient education material that was given to each
patient. Each time you give a patient some education material, you can record it in the patient’s chart. The
Patient Education Library in the system allows you to manage the patient education documentation for
the practice.
Entries in the list may have been added:

 manually by a MicroMD EMR user
 automatically when a MicroMD EMR user presented the education material to the patient during
an encounter

MicroMD EMR User’s Reference Manual Version 16.0

20.17

Chapter 20. Medical Information: Miscellaneous

Adding Forms to a Patient’s Chart

Figure 20.9 Patient Education Materials Given to the Patient
To view the list of the education materials provided to the patient, open their chart, click the Medical
Information tab, click the Miscellaneous button (Figure 20.9) and choose Patient Education from the
available options.
To edit or delete an item from the list, simply highlight the entry and click Edit or Delete as appropriate. To
add a new patient education entry to a patient’s chart manually, click the Add button. For details on the
Patient Education Library, see page 27.8.

Adding Forms to a Patient’s Chart
The system comes with a set of built-in administrative forms. When necessary, you can complete any of
these forms for your patients. After completing a form, you can then save the completed form in the
patient’s chart, print a copy of the form, and even fax the form to someone. Some examples of forms
included in the system are:

 Ante partum record
 Camp Health Form
 HIPAA Disclosure Form
 Preschool/Daycare Physical Exam
You can create your own set of templates, customize existing ones to suit the needs of your practice, or you
can use the standard forms as they are. See page 2.8 for in-depth details on working with templates in
general.
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Administrative Form Templates
Creating Administrative Form templates is exactly the same as creating Form Encounter templates. The
only difference is that Administrative Forms cannot include clinical patient information. To create form
templates, select Tools > Administrative Forms Templates from the main menu. Please see page 23.42
for information on working with the form designer.

Adding an Administrative Form to the Chart
When you add a form to a patient’s chart, the Form Wizard helps you complete the form. When you
complete a form for a patient, the Form Wizard extracts certain information directly from the patient’s
chart. For example, when you complete a Camp Health Form for a patient, the Form Wizard can extract the
patient’s name, birth date, current long-term medications, current problems, immunization history, and
vision screening results from the patient’s chart and inserts the information directly into the form.

Figure 20.10 Example Form Wizard
To view the list of the forms created for the patient, open their chart, click the Medical Information tab,
click the Miscellaneous button and choose Forms from the available options.
To edit or delete an item from the list, simply highlight the entry and click Edit or Delete as appropriate.
To add a new form to a patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
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Procedure (continued)

Details (continued)

2. In the Chart Navigator, click the
Miscellaneous button and choose Forms
from the available options.

The system displays the list of the forms already
completed in the patient’s chart.

3. Click the Add button.

The Reference List Viewer window opens for
Forms.

4. Use the controls to find the form you want to
add to the chart.

See page 7.2 for details on working with a
Reference List Viewer.

5. Click Insert.

The system inserts the form into the Form Wizard
(Figure 20.10).

6. Complete the step(s) of the form.
7. Click Finish to close the Form Wizard when
you complete the final step.

The system saves the patient’s data in a linked
copy of the form. When you edit the template upon
which you based the form, the one in the patient’s
chart changes to reflect the edit.

Managing Incoming Referrals
The system provides an area on the patient’s chart where you can record when the patient is referred to
you by another physician. This helps you maintain records for patients for whom you are not their primary
physician.
For example, Dr. Lisa Webb is an oncologist. Dr. Davidson sends his cancer patients to her. Dr. Webb
records her encounters with these patients but also needs to maintain a history related to the referral
process. She can do so on the Medical Information tab of the patient’s chart.
If the patient’s appointment in the system has a referral associated with it, the referral automatically
appears in this list on the patient’s chart. You can also create a new record manually.
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Figure 20.11 Referred Patient’s History
To edit or delete a referral entry, simply highlight the entry and click the Edit or Delete button as
appropriate. If you need to add a referral entry manually, click the Add button and complete the fields on
the Referral-in Order window (Figure 20.12).

Figure 20.12 Referral-in Order Window
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Transition of Care In
The Transition of Care In section of the patient’s chart lists any incoming transition records created for the
patient when the provider becomes responsible for that patient’s healthcare. For more details on
managing transitions of care into the practice, please refer to page 4.43.

CDS History
The CDS History section of the patient’s chart provides an in-depth view into how users of the EMR have
interacted with the rules your practice has created as they relate to this patient. Your practice creates rules
in the Rule Manager (page 27.22).

Figure 20.13 CDS History
The system records all actions against a rule from the time it displays the rule to the time the window
closes, with the most recent actions first in the list.
For example in Figure 20.13, Dr. Primary triggered two rules:

 Entry 1: On April 4, 2019, at 4:00 in the afternoon, Dr. Primary triggered the “Elevated Blood
Pressure” rule when he opened Andy Homer’s chart. The system displayed the rule to the
doctor, but we can tell no actions were taken because the only other log entry is that the doctor
closed the window.

 Entry 2: Just a few minutes later, Dr. Primary triggered the “Diabetes Mellitus” rule during the
encounter when he added a diabetes assessment to Andy’s note, and the system displayed the
rule to him. The doctor then added the two plan items that were recommended to him and
shared the education material with the patient. Once he was done, he applied his changes.
To print the history, click the Print button at the top of the list.
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Prescriptions
Whether you are a physician writing a brand-new prescription for a patient or a nurse requesting a
prescription refill for a patient, the system provides just what you need where you need it for recording the
patient’s medication needs. If you provide samples from stock, you can also record that you filled the
prescription from inventory.

In This Chapter
In this chapter, we cover how to:

 Create and use custom prescription forms (page 21.2)
 Add prescription functions to a user account (page 21.4)
 Set the drug database expiration, if necessary (page 21.7)
 Work with the Prescription Pad (page 21.8)
 Adding a Sig to the Prescription (page 21.13)
 Process a prescription (page 21.16)
 View the history of a prescription (page 21.22)
 Process all prescriptions from an encounter (page 21.22)
 Add a new medication to the system (page 21.23)
 Use the Dosage Manager (page 21.25)
 Handle prescription requests (page 21.29)
 Indicate how to send prescriptions for certain schedule drugs (page 21.37)
 Generate a provider prescription history report (page 21.38)
 Print the word “COPY” on unused forms (page 21.38)
 Configure your system to use Surescripts (page 21.39)
 Electronically prescribe medications and use formulary data (page 21.40)
 Handle e-prescribing failovers and set up to receive notifications (page 21.48)
 Maintain the medication list in a patient’s chart (page 21.49)
 Maintain the pharmacy reference list (page 21.59)
 Process electronic prior authorizations (ePA) for medications (page 21.61)
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Prescription Forms
MicroMD EMR comes with a prescription form built into the system that you can use to print prescriptions.
However, you may want to design your own to meet your unique needs. MicroMD EMR allows you to create
your own prescription form using the data that you prefer, adding a logo and formatting the layout the way
that works for your practice. You can define your templates using the Administrative Panel.

○

This option is available only to those users with the
Administrator role assigned to their user account.

Creating Your Custom Form
Before you can print a custom form, you need to create it. You create prescription form templates on the
Administrative Panel on your Desktop (Figure 6.1 on page 6.2). In the Miscellaneous Tasks section, you can
click the Prescription Template Manager task to open the appropriate manager. From the manager
window, you can add new prescription form templates, copy existing ones and otherwise manage your
templates.



You can customize an existing template from the
Standard folder. Simply copy the template into your
Personal folder and edit.

Figure 21.1 Custom Prescription Forms
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To create a new prescription form template:

Procedure

Details

1. Verify that you have your Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button and choose
Administrative Panel from the available
options.

The system displays the panel in the right side of the
window (Figure 6.1 on page 6.2).

3. From the Miscellaneous Tasks section, click
the Define prescription templates task.

The Prescription Template Manager window opens
and displays your list of personal templates.

4. Click the New button and select either 2 Rx/
Page or 4 Rx/Page from the drop-down
menu.

The system opens a blank prescription form.

5. From the Form Controls section, drag and
drop the control you want to use in your
template.

The String Field control is the main control that
allows you to pull data from the patient’s chart and
print on the prescription.
For more details on using these controls, please
refer to page 23.43 under Form Controls.

6. Arrange the control where you want it on the
page.
7. From the Control Properties section, format
the control as needed.
8. Repeat step 5 through step 7 for each control
you want to add to the form.

For the String Field control, click the Lookup icon
( ) next to the Default field to choose the data you
want to use for that instance of the field.



Place a check mark in the Print ‘VOID’
across any unused prescriptions on
the page checkbox to invalidate any
empty forms that print.

9. Click OK when satisfied with your new
prescription form.

The Save Prescription Template window opens.

10. In the Template name field, enter a useful
title for your template.

This name is how you distinguish the templates from
each other when you want to use one.

11. Choose the folder in which you want to save
the template.

You can choose either Personal (available only to
you) or Shared (available to multiple users). See
page 2.8 for more detailed information on Personal,
Shared and Standard folders.

12. Click OK.

The system adds the new template to the folder you
chose.
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Default Prescription Forms
If you always want to use a certain template for printing your prescriptions, you can set this form as your
default. You can also set your supervising physician. MicroMD EMR also allows you to specify different
prescription forms for sending via fax versus printing the prescription. Some states have this requirement,
and MicroMD EMR helps you comply. Access these preferences in the General category under Tools > User
Preferences. For more details on the user preferences, please refer to page 1.86.

○

Each practice can set their default prescription forms, too.
Please see page 1.47 for more details on this practice
setting.

Prescription Functions
Each user can have different prescription functions assigned to their user account. There are several user
functions related to prescribing medications. (Please see page 1.16 for details on assigning user roles and
functions.)

 The Write Prescriptions function allows you to provide any staff member with appropriate
licenses the ability to write prescriptions.

 The Write Prescriptions on Behalf user function allows you to provide staff members the ability
to write prescriptions on behalf of a prescribing provider but doesn’t allow them to write
prescriptions on their own.

 The Authorize Refill Requests user function allows a user to process the list of refill requests for
any physician.

 The Set Prescription Warning Level function enables the Drug-Drug Warning Level and DrugAllergy Warning Level fields in the user’s preferences (page 1.86) and allows the user to change
the warning levels that display for prescriptions they write.

 The Drug-drug Interaction Severity function controls which users can edit the Drug Severities
reference list in the MicroMD EMR Manager (under Reference Lists > User-Defined Additions).
This only applies users with the Practice Manager role and/or the Administrator role, which are
the only ones who have access to the MicroMD EMR Manager.

Write Prescriptions
Users with one of the following four roles may have this function assigned to their account (page 1.16):
Physician, Physician Assistant, Nurse Practitioner or Non-physician Caregiver. However, you can also
assign any user the ability to write prescriptions, or you can remove this function from any user. Please
refer to page 21.8 for more details on writing prescription in the EMR.



21.4

Only those users with appropriate licenses should be
given this user function. If you want the user to write
prescriptions under a physician’s name, use the Write
Prescriptions on Behalf user function.
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Write Prescriptions on Behalf of Someone Else
When you write prescriptions on behalf of someone else, the system activates the Provider drop-down on
the Prescription Pad. The drop-down pulls from the list of prescribing providers in the practice. Simply
choose the appropriate provider and write the prescription.



If you only work with certain physicians in the practice,
click the Lookup icon ( ) and add those physicians to
your Common List of Prescribing Providers. Only those
names will appear in the Provider drop-down in Figure
21.2, streamlining your work.

Figure 21.2 Provider Drop-down on Prescription Pad
The user with this function can write prescriptions, but those prescriptions appear in the system and
through Surescripts as if they were written by the selected provider. The prescription’s history and the
Provider Rx Report display the user who recorded the prescription so you can reference it later if necessary.



The Formulary Panel displays for any provider in the list
who is registered with Surescripts. See page 21.40 for
more details on eligibility and formularies.

Authorizing Refill Requests
Users who have the ability to authorize refill requests have a filter in the Prescriptions section of their
Desktop. This filter allows you to select which provider has asked you to handle their list. This list contains
the list of prescribing providers in the practice (and the current user so you can get back to your own list).
Simply select the appropriate provider from the User filter and approve or deny the refills. For more details
on working with refill requests, please refer to page 21.29.

Figure 21.3 Filter for Authorizing Requests
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Set Prescription Warning Level
Depending on the policies at your practice, you can allow providers to change the drug-to-drug and drugto-allergy warning levels that they receive in the prescription module or you can prevent them from
changing the choices you establish at the practice level (page 1.86). When you place a check mark in the
Set Prescription Warning Level checkbox, the system enables the Drug-Drug Warning Level and DrugAllergy Warning Level fields in the user’s preferences (Figure 1.55 on page 1.84) and allows the user to
change the warning levels that display for prescriptions they write.

Drug-drug Interaction Severity
If necessary, you can set the drug-to-drug interaction severity for specific medication combinations
prescribed by your practice. With this user function, those users with the Practice Manager role and/or the
Administrator role can add to and edit the Drug Severities reference list in the MicroMD EMR Manager
(under Reference Lists > User-Defined Additions).

Figure 21.4 Drug Severities



If you configure a drug-to-drug severity level that
differs from the Reference Database severity level from
Surescripts, your configuration will apply only to that
exact combination of drugs and dosages.

Procedure

Details

1. In the MicroMD EMR Manager, click the
Reference Lists button.

The Reference List Manager displays.

2. On the User-Defined Additions tab, select
Drug Severities.

21.6

MicroMD EMR User’s Reference Manual Version 16.0

Drug Database Expiration Warning

Chapter 21. Prescriptions

Procedure (continued)

Details (continued)

3. Click the Add button.

The Drug to Drug Severity Level window opens.

4. Click the Lookup icon ( ) next to the
Medication 1 field to select the first
medication.
The current severity level displays in the Original
Severity Level field.

5. Click the Lookup icon ( ) next to the
Medication 2 field to select the second
medication.
6. From the New Severity Level drop-down,
select the level you want the drug
combination to use.
7. Click the OK button when finished.

Drug Database Expiration Warning
MicroMD EMR can warn you if the drug database has expired. A red warning appears on the bottom of both
the medication section of an encounter and on the Prescription Pad window. You can manually change
the expiration date through the EMR Manager.

Figure 21.5 Drug Database Expiration Warning
To specify an expiration date for your drug database:

Procedure

Details

1. Click the System Settings button in the
MicroMD EMR Manager.
2. Click the Practice tab.
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Details (continued)

3. Click the Edit button.

This opens the Practice Settings window.

4. Click Reference database expires after dropdown to specify the number of months after
which you would like the database to expire.



If you leave this field blank and do
not specify an expiration time, the
system does not display a message.

5. Click OK.

Prescription Pad
Your Prescription Pad allows you to create a prescription for any medication for any patient—just like the
pad you keep in your pocket. When you save a prescription, MicroMD EMR saves the details of the
prescription in the patient’s chart. You do not have to open a patient’s chart to create a prescription. To
access the Prescription Pad, click the Prescription Pad link in the Chart Tools (page 10.3), or the Desktop
Tools (page 3.2).

Figure 21.6 Prescription Pad
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Structure of the Prescription Pad
The top portion of the Prescription Pad is the prescription header. This section contains the patient for
whom this prescription pertains. Other information includes: patient’s birth date, age, weight, date of their
last visit and preferred pharmacy. The right side of the prescription header varies slightly depending if this
is a prescription request or an actual prescription.

○

When the patient has no pharmacy listed in their chart
and you choose a pharmacy for their prescription, the
system automatically adds it to the patient’s chart as
their preferred pharmacy. Next time you create a
prescription for the patient, the system displays this
pharmacy as their default.

The left side of the Prescription Pad displays the Medications Reference List Viewer. By default, this section
displays the patient’s list of medication history. If the same medication was prescribed throughout the
history, the system only displays the most current prescription of the medication. The system also
indicates when the medication was last prescribed. If you would like to see your Common List of
medications, simply click the Common button at the top.



To return to the patient’s list of medications, click the
Smart button and select Patient’s Medications from
the drop-down menu.

The right side of the Prescription Pad is where you build the patient’s prescription. The top section on the
right lists the medications included in the prescription (just drag and drop from the left). The rest of the
right side is where you establish the dosage, duration, and frequency of the prescription.
When working with the details of a medication’s prescription:

 If you add a medication from the patient’s list of medications (i.e., prescriptions, long-term
medications or other medications), the Prescription Pad copies all dosage, dispense and
duration details, as well as any recorded associated diagnoses for the medication, to the new
prescription.

 If you have a dosage formula established in your Dosage Manager for a medication, and that
formula is the only one for that medication, the system automatically copies those dosage
details when you prescribe the medication.

 In many instances, once you complete the sig for the prescription and enter the appropriate
Duration, the system automatically calculates the End Date field and the total units in the
Dispense Information section for you.

○

The system also takes into account the number of refills
entered in the Dispense Information section when
calculating the End Date field.

 When a medication’s description indicates the type of medication (e.g., tablet, capsule), the
system automatically selects the correct type from the Dosage drop-down in the Sig Editor
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window and for the total units displayed in the Dispense Information section for the
prescription.

Prescription Warnings
Each time you prescribe a medication, MicroMD EMR uses a national drug database to perform a number
of verification procedures. If it finds a conflict, the system displays a warning message (Figure 21.7 on page
21.10) and requires that you make a decision whether or not to continue with the prescription of the drug.



Highlight a drug and click the information bubble icon
( ) at the bottom of the Prescription Pad. Select Show
Warnings to view any cautionary information about the
drug before you prescribe it.

MicroMD EMR checks whether the medication conflicts with:

 any other medication in the current prescription
 any medication prescribed for the patient in the past 12 months
 any of the patient’s current long-term medications
 any of the patient’s current allergies
 ICD codes of any current problems in the patient’s problem list (drug-disease contraindications)
 the patient’s age (drug-age conflicts)
 duplicate medications in the patient’s active list
When this message appears, the system displays all warnings associated with the prescription. If you
receive a drug warning, you can still prescribe the medication by clicking the Prescribe Anyway button, or
cancel the prescription by clicking the Don’t Prescribe button.

Figure 21.7 Drug Interaction Warnings
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The system combines warnings into the same row when
the Conflict Type, Conflict Severity, and Description
columns are identical for the medication you tried to
prescribe.

Within each Conflict Severity, the system sorts your drug warnings in the following order:

 Allergy warnings
 Drug-to-drug warnings
 Precautions
 Drug-to-disease warnings
Creating a Prescription or Request with the Prescription Pad
You can write prescriptions using the Prescription Pad if you are a user with one of the following roles
associated with your user account: Physician, Nurse Practitioner, Non-Physician Caregiver or Physician
Assistant. You can create prescription requests using the Prescription Pad if you are a user with one of the
following roles associated with your user account: Nurse or Nurse Practitioner.
To create a prescription or a prescription request using the Prescription Pad:

Procedure

Details

1. Select Tools > Prescription Pad from the
main menu.

You can also click the Prescription Pad link in the
Chart Tools or Desktop Tools sections. You can click
the Prescription Pad icon ( ) on the top toolbar
to access this tool as well.

2. Type the patient’s name in the Patient field.

The system automatically populates the field if it
finds a precise match. Otherwise, the Select Patient
window opens.

3. Review the Drug Allergies section.
4. Locate the appropriate medication.

By default, the system automatically displays the
patient’s current list of medications under Available
Medications. Each medication has an indicator:

 [LTM]: Long-term medication (page 21.52)
 [Presc]: Current Prescription (page 21.50)
 [Other]: Other medication (page 21.57)
You can search the entire list of medications in the
database with the Common, Index, Smart and All
buttons.

○
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Details (continued)

5. Drag and drop the medication you want to
prescribe to the Medication List section.

The system automatically populates any dosage
information from a medication re-prescribed
from the patient’s list or if the medication has a
dosage template created in the Dosage Manager
(page 21.25).
If the dosage information does not automatically
populate, the system pops up the Sig Editor
window.

6. Enter the dosage, duration and dispensing
information for the selected medication and
click OK.

See page 21.13for in-depth details on creating a
structured sig.
You can also use the Dosage Manager tool from the
Sig Editor window. Click the Dosage Manager icon (
) next to the Dosage section. See page 21.25 for
more in-depth details about this useful tool.
If you want someone to administer the medication
in-house, select the user from the Administer by
drop-down. This adds the medication order to the
user’s desktop.

7. Click the Lookup icon ( ) next to the
Associated Diagnoses field to enter the
diagnosis for the medication.

○

Users who create prescription
requests cannot add associated
diagnoses. Skip step 7 through step 9.



You can right-click the diagnosis on
the prescription and select Add to
Problem List.



You can highlight a medication and
click the Delete icon ( ) to remove
it from the list; however, you cannot
delete the medication once you save
the prescription.

8. Locate the appropriate diagnosis and
click Insert.
9. Repeat step 7 and step 8 for each diagnosis
you need to associate with the medication.

Completing the Prescription
10. Repeat step 4 through step 9 for each
medication you want to prescribe for the
patient.
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Procedure (continued)

Details (continued)

11. Once you have added all medications and
completed all details, click the Authorize
Prescription button.

This opens the Prescription Processor window
(Figure 21.12 on page 21.16).



When you click the Authorize
Prescription button, this is just like
signing a prescription form on your
paper pad. The system records this
in the Prescription History
(page 21.22).

12. Perform the appropriate actions.

For details on using the Prescription Processor
window, please see page 21.16.

13. Click Close to exit the Prescription Pad.

MicroMD EMR records all the medications included
in the prescription list in the patient’s chart. For
details on viewing the patient’s list of prescribed
medications, see page 21.49.

Adding a Sig to a Medication
In the Prescription Pad, in the encounter, or in the Medications section of the chart, when you add a
medication, the Sig area is blank unless you have a Dosage Manager entry for that medication or if you are
re-prescribing a medication. If you do not have a Dosage Manager entry for the specific medication, but
you do have instruction templates, you can access the Dosage Manager with the drop-down button (Figure
21.8).

Figure 21.8 Structured Sig on a Prescription
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○

Adding a Sig to a Medication

There will be some pharmacies that do not send requests
in a structured format. The system saves this information
as text in the Additional Dosage Instructions section,
which displays in the Sig section of the prescription pad.

Adding a Sig for a Medication
If you are not re-prescribing a medication and you do not have a dosage manager template associated
with the medication, the system automatically opens the Sig Editor window (Figure 21.9). As you complete
the fields on the window, the system automatically translates that information into patient-friendly text at
the bottom of the window under Sig Text.



Click the Edit Sig icon (
window if needed.

) to open the Sig Editor

Figure 21.9 Sig Editor Window
Next to the Route field and the Timing fields are also Clarifying Text fields you can use to include
additional details needed to help the patient know the method to take/use the medication and how often
to take/use it. For example, you could type the text with food in the Clarifying Text field for Route. The
additional text appears in the Sig Text field at the bottom.
Once you have completed the prescription instructions, click OK. The system displays the patient-friendly
dosing instructions in the Sig section of the prescription (Figure 21.8 on page 21.13).
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When you type text in the Additional Dosage
Instructions field, the system tacks that information to
the end of the patient-friendly text.
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Multiple Instructions for a Single Medication
There are some prescriptions with more complicated instructions that vary from the basic “take one pill a
day” prescription. For example, if you need to create a step-down prednisone 5 mg tablet prescription, the
Structured Sig format makes this easy for you to accomplish.
After you add the first part of the prescription instruction, click the green Add icon ( ) on the Sig Editor
window to add a new set of instructions. This creates another page to the prescription instructions and
allows you to enter the same type of information.

Figure 21.10 Further Prescription Instructions
The drop-down at the top of the window allows you to tell the patient how this new set of instructions
relates to the previous instruction.
You have the following relational options:

 THEN: When you select THEN from the drop-down, the patient performs the first set of
instructions first when taking the medication and the second set of instructions after that. And
so on if you have multiple sets of instructions. See Figure 21.10.

 AND: When you select AND from the drop-down, the patient should perform both sets of
instructions at the same time when using the medication.

 OR: Selecting OR from the drop-down communicates to the patient that either set of
prescription instructions is acceptable when using the medication. For example, the patient can
take a single tablet once a day or half a tablet twice a day.

 NOT: The NOT instruction is useful when you have a medication that the patient should never
take a certain way.
As you build your prescription, the system displays the current patient-friendly prescription instructions at
the bottom of the window. Once you have completed the patient’s instructions, click OK.

Figure 21.11 Multiple Prescription Instructions
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Using the Prescription Processor Window
Once you create a prescription with the Prescription Pad or approve a prescription request, you can either
print the prescription, send the prescription directly to the pharmacy (either by fax or electronic file) or
send the prescription to the front desk to perform some action (e.g., phoning in the prescription).

Figure 21.12 Prescription Processor Window

Medication List
The left side of the window displays a list of all medications entered on the prescription. Each medication
has the details of the prescription and a checkbox. These checkboxes indicate which medication(s) will be
involved when you click one of the action buttons in the right side of the window. Generally, there is a
check mark next to every medication on the list when the window first opens so you can perform the same
action on all of them. Rearrange the check marks as needed. You can use the Deselect All and Select All
button at the bottom of the window if needed.

○

If you have already processed a medication in the list, the
system leaves the checkbox blank by default.



Once you perform an action on a medication, the system
displays the last action in green text next to the
medication (Figure 21.12).

If you denied a medication on a prescription request, the system strikes out that medication and changes
it to red text. The system does not include these denials in any action performed on the right.
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Dispensing Statuses
With electronic prescriptions, providers can choose whether to receive dispensing statuses from the
pharmacy and which statuses are most important to them. In addition, providers can choose to receive a
dispensing status per medication.

Fill Indicator
For each medication you prescribe, you can choose the level of dispensing status you would like to
receive for this prescription for this patient. You make that choice on the Prescription Processor
window. Table 21.1 explains the statuses in more detail.

Figure 21.13 Fill Indicator Selection



Set your default preference with the RxFill Indicator
drop-down in the Prescriptions section of your user
preferences (page 21.19).

If you decide later, after sending the prescription, that you want the pharmacy to send dispensing
information to you, you can click the Process Rx button for a medication, select the type of status you
want to receive, and click the Send button again. The system updates the prescription message at the
pharmacy. From that point forward, the pharmacy should send you those statuses when the action
occurs in the pharmacy’s computer system.
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Table 21.1 Fill Indicator Statuses

Status

Description

All Fill Statuses

Select this option to receive dispensing status information for every
dispensing action taken at the pharmacy for this prescription. This
includes when the patient's prescription is:






Dispensed
Partially Dispensed
Not Dispensed
Transferred

For the Not Dispensed status, there is a certain amount of time that
elapses at the pharmacy before the pharmacy marks the prescription in
their system as not picked up by the patient and the pharmacy puts the
medication back on the shelf.
The dispensing status displays in the Prescriptions section of your
Desktop. See page 21.19 for more details.
All Fill Statuses Except
Transferred

Select this option to receive dispensing status information for every
dispensing action listed above, except when the pharmacy transfers the
prescription to another pharmacy.

Dispensed And Partially
Dispensed

Select this option to receive dispensing status information only for
prescriptions that the pharmacy dispensed or partially dispensed.

Partially Dispensed And
Not Dispensed

Select this option to receive dispensing status information when the
pharmacy only partially dispenses the patient’s prescription or doesn’t
dispense it at all.
For the Not Dispensed status, there is a certain amount of time that
elapses at the pharmacy before the pharmacy marks the prescription in
their system as not picked up by the patient and the pharmacy puts the
medication back on the shelf.

Not Dispensed And
Transferred

Select this option to receive dispensing status information only when
the pharmacy does not dispense the medication or when they transfer
the prescription to another pharmacy.
For the Not Dispensed status, there is a certain amount of time that
elapses at the pharmacy before the pharmacy marks the prescription in
their system as not picked up by the patient and the pharmacy puts the
medication back on the shelf.

Partially Dispensed

Select this option to receive dispensing status information just when the
pharmacy only partially dispenses the patient’s prescription.

Not Dispensed

Select this option to receive dispensing status information only when
the pharmacy does not dispense the medication at all.
For the Not Dispensed status, there is a certain amount of time that
elapses at the pharmacy before the pharmacy marks the prescription in
their system as not picked up by the patient and the pharmacy puts the
medication back on the shelf.
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Table 21.1 Fill Indicator Statuses (continued)

Status

Description

Cancel All Fill Statuses

If you do not want to receive any (or you no longer want to receive)
dispensing status information in the Prescriptions section of your
Desktop for this prescription, select Cancel All Fill Statuses.

Dispensing Statuses on the Desktop
Once the prescriber has their status preferences set up, those statuses appear in the prescriber’s
Desktop under Prescriptions (Figure 21.14). Set the Route filter to Sent to see the statuses of the
prescriptions you’ve sent out. In the Rx Status column of the entry, the system displays the status of
that prescription.

Figure 21.14 Dispensing Status in the Sent List

User Preference for Fill Indicator
You can set your default preference for the Fill Indicator drop-down depending on your personal
needs. For example, you only want to receive the dispensing status of a medication when you
prescribe certain controlled substances. You could set your RxFill Indicator preference to Cancel All Fill
Statuses and then only choose the status you want to receive at the time you prescribe. For all other
prescriptions, you would not receive dispensing status information. See Table 21.1 on page 21.18 for
details on each status.
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Figure 21.15 RxFill Indicator User Preference

Editing Prescriptions
You have the ability to go back to the Prescription Pad from the Prescription Processor window and edit a
prescription before you send it off to the pharmacy or process it some other way. This allows you to correct
any mistakes before committing the prescription to the patient’s chart. Simply click the Edit button to
return and make changes.

○

If you have already sent a medication or printed the
prescription, you cannot edit the medication.

Actions to Perform
Once you create the prescription, you can either print the prescription to a printer in your office, send the
prescription directly to the pharmacy through Surescripts or the MicroMD EMR Fax Manager, or you can
send the prescription to another user to handle.

Select a Pharmacy
The Pharmacy drop-down defaults to the patient’s preferred pharmacy and that pharmacy’s
transmission method (Send via field). See page 21.59 for details on adding pharmacies to the system.
Some notes about the Pharmacy drop-down:

 This drop-down populates from the list of pharmacies entered in the patient’s chart and
defaults to the patient’s primary pharmacy.

 If none of the pharmacies is marked as the patient’s primary pharmacy, the system uses the first
pharmacy in the patient’s list as the default.
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If you need to send the prescription to a pharmacy not listed in this drop-down, simply click the
Lookup drop-down icon ( ). You can choose to search either the list of your practice’s pharmacies
or the entire pharmacy list in the database.



You can set a patient’s preferred pharmacy. Once set, the
system automatically selects that pharmacy by default
every time you create a new prescription for the patient.

Handwritten Prescription
The Written button on the Prescription Processor window allows the physician to indicate that the
prescription was handwritten on paper and handed to the patient. This helps keep accurate records of
the patient’s prescriptions. Click this button to tag the selected medications as being handwritten.

Dispensing Samples
The Prescription Processor has the ability to dispense a medication as a sample. Click the Sample
button to indicate that you fulfilled the patient’s prescription by giving them a sample of the
medication. The system tags the selected medications appropriately.

Printing a Prescription
To print the selected prescription(s), simply select the printer and the form (if your practice allows
providers to select forms) and click the Print button. The system defaults the Printer drop-down to the
printer currently set as your system default.
The Prescription Form drop-down defaults to the form you have selected in the General category of
your User Preferences (under Tools > User Preferences). The system pulls the choice selected in the
Printed prescription form (default) field.
If your practice allows providers to choose different prescription forms on the fly (page 1.47), you can
select one from the drop-down or click the Lookup icon ( ) to find the one you want.

Sending a Prescription Electronically
If you would like to send the selected medications to a pharmacy electronically, simply select the
pharmacy at the top of the window, choose the medication(s), and click the Send button. See
page 21.40 for more on electronic prescriptions.

Assign to Staff
If you want to send the prescription to someone else in the office to finish (e.g., send to the front desk
to print), this final section allows you to choose the action and/or write more details (e.g., fill from
samples).
Select the user to whom you want to send the instructions, choose an action or write a note, and click
the Assign button. Once you click this button the prescription appears on the user’s Desktop in their
Prescriptions list.



The system enables the Assign button only after you
place a check mark next to an action or enter a note.
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Checking Prescription Eligibility
Once the physician reaches the Prescription Processor window, he or she may need to review the
patient’s prescription eligibility before selecting a pharmacy to receive the prescription. The
Prescription Eligibility icon (



) behaves just as it does in the Prescription Pad.

For more details on eligibility, please refer to page 21.41.

Prescription History
MicroMD EMR maintains a history of all actions performed on a medication, from the time it was submitted
to the time it was completed. This includes when users forward the request or if the provider denied the
request.
On the Desktop, simply highlight the request and click the Rx History button. You can also right-click the
request and select Rx History from the pop-up menu. You can find this button in the patient's chart under
Rx Requests and Rx Sent to Pharmacy in their Workflow Communication or in the Medications section of
their Medical Information tab.

Figure 21.16 Prescription History

Processing All Prescriptions from an Encounter
MicroMD EMR provides a way for you to process all medications prescribed during the encounter with a
patient if you have closed the encounter without processing them. You have the option to process a
prescription for a single medication in the encounter, without processing prescriptions for all the
medications prescribed, or you can quickly print all prescriptions.
When you open a patient’s chart and click on the Encounter tab, the system enables the Encounter
Prescriptions option in the main menu under the Print menu. From here you can select Quick
Prescription Print or Process Prescription.

 The Quick Prescription Print option simply sends all medications directly to your computer’s
default printer using the default prescription form you have set in your User Preferences.

 When you select Process Prescription, the system opens the Prescription Processor window
where you can choose which medications you want to print, send to the pharmacy or send to
another MicroMD EMR user to handle.
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Adding a New Medication
You can add a medication or compound to the list of medications in the MicroMD EMR database. You can
add a new medication to the system anywhere that you insert medications.


○

If you add a new medication, MicroMD EMR is unable to
perform any crosschecking with the new medication
regarding drug and allergy interactions when you
prescribe the medication.

Only a user with the function Add reference data can
add a medication to the medications reference list.
See page 1.16 for more details on assigning roles
and functions.

Figure 21.17 Adding a New Medication

Adding a New Medication
To add a medication to the list of available medications:

Procedure

Details

1. Select Tools > Prescription Pad from the
main menu.

You can also click the Prescription Pad link in the
Chart Tools or Desktop Tools sections. Click the
Prescription Pad icon ( ) on the top toolbar to
access this tool as well.
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Procedure (continued)

Details (continued)

2. Change the Location drop-down only if
necessary.

This drop-down defaults from the Location dropdown set in your Session Profile (under Tools >
User Preferences).

3. Type the patient’s name in the Patient field.

The system automatically populates the field if it
finds a precise match. Otherwise, the Select
Patient window opens.

4. Click the New Medication button.

The Add New Medication window opens (Figure
21.17).

5. Enter a name for the new medication as well
as the other details for the medication.

6. Click OK.



Remember: The system will not
cross-check this drug.

The system adds the medication to the list.

Compound Medications
When creating non-standard medications in the system, you must include the ingredients of compound
medications and identify the form of that medication. When you select Compound from the Composition
Type drop-down, you must add the ingredients of that compound medication.

Figure 21.18 New Fields When Adding a Non-Standard Medication

○

You cannot prescribe a compound medication without an
ingredients list.

In the Includes Ingredients section:

 Click the Lookup icon (

) to open the Ingredients reference list. You can also click the dropdown arrow and select either Ingredient Set or Medication List to choose the appropriate item
for the compound.

 Search for your first ingredient and either double-click it or click the Insert button to add it to
the compound.

 Identify the details of the ingredient for the compound.
 Click the Lookup icon (
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 Continue building the compound until complete.
 Click the OK button when you are satisfied with the new medication.

○

You cannot create a compound medication without
listing the ingredients and the “recipe” details of those
ingredients.

Using the Dosage Manager
The Dosage Manager allows you to maintain a list of your most commonly used medication dosage
formulas. This useful tool makes prescribing the dose for a medication quick and easy. You can create
formulas for a specific drug that you prescribe in a certain way every time. You can create a list of the
common doses you use most frequently. To use the Dosage Manager, you click the Dosage Manager icon
(

) on the Prescription Pad (Figure 21.6 on page 21.8).

Figure 21.19 Dosage Manager
For example, Dr. Webb prescribes prednisone so she created a template entry in the Dosage Manager for a
step-down prescription of prednisone.
The Dosage Manager can filter the list of formulas in three ways for you:

 Your formulas for a specific medication
This list displays only those dosage formulas that you have defined for the selected medication.

 Your Common List of dosage formulas
This list displays only those dosage formulas that you have defined and then added to your
Common List of dosage formulas.
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 All your personal formulas
This list displays all dosage formulas you have established in the system.
Each formula that you define can include any or all of the following details:

 dosage quantities
 dispense quantities
 the duration for which the patient should take the medication
 prescription refill details
 substitution details
Adding, Editing, Deleting Formulas
To edit or delete a dosage formula, simply highlight the entry and click Edit or Delete as appropriate. To
add a new dosage formula to the Dosage Manager:

Procedure

Details

1. Select Tools > Dosage Manager from the
main menu.

The Dosage Manager window opens, listing your
Common List of dosage formulas.
You can also click the Dosage Manager icon (
on the Prescription Pad.

)

2. Click Add.

The Medication Formula window opens.

3. If you want to create a new dosage formula for
a specific medication, click the Lookup icon
( ) next to the Medication field.

You can skip this step if you only want to establish
common dosages not related to a specific
medication.

4. Click the Edit Sig icon (

The Sig Editor window opens.

).

5. Enter the sig information for the new formula
as required.

See page 21.13 for details on creating a
structured sig.

6. Click OK on the Sig Editor window.
7. Enter the Dispense Information for your
formula if needed.
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Procedure (continued)

Details (continued)

8. Click OK.

MicroMD EMR adds the new entry to the
Dosage Manager.

Inserting Dosage Details Using the Dosage Manager
To use the Dosage Manager when prescribing a medication, you can simply click the Dosage Manager
icon (
) or you can click the arrow next to the Dosage Manager icon on the Prescription Pad to choose
other options.

Figure 21.20 Dosage Manager
The arrow next to the Dosage Manager icon displays some quick shortcuts for you. If you have established
some dosage formulas for the selected medication, you can select My Dosage Formulas from the dropdown menu and choose from the list. The Dosage Manager opens:

 If you have any medication formulas defined for the selected medication, the Dosage Manager
displays your dosage formulas for the selected medication.

 If you have no medication formulas defined for the selected medication, the Dosage Manager
displays your Common List of dosage formulas.
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Recommended Dosage
The system also provides you with the ability to view the recommended dosage for your selected
medication and calculate based on the patient’s height and weight. Select Recommended Dosage
from the drop-down menu. The recommended dosage information comes from a national drug
database.

○

The dosage information that MicroMD EMR recommends
may be for a different strength of the selected medication.
Be sure to modify the dosage according to the strength of
the prescribed medication.

Figure 21.21 Recommended Dosage
For each medication, the system provides the recommended dosage depending on the planned use of
the drug. The system can also perform dosage calculations for you based on the parameters you set in
the Dosage Calculator section. Once you add your parameters, click the Calculate icon ( ). The
system displays the final calculation in the Result field. Adjust the parameters and click the icon again
to refine the dosage.

Check Dosage
The Dosage Manager also provides the ability for you to verify the dose you already entered for the
medication. Select Check Dosage from the drop-down menu. The system checks the dosage and
indicates if the dosage passes the check or fails for a whatever reason.
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Working with Prescription Requests
MicroMD EMR provides a central location for you to manage your prescriptions and prescription requests:
the Prescriptions list on your Desktop (Figure 21.22 on page 21.30). You can filter this list to display only
those prescriptions with which you want to work.
MicroMD EMR allows one user to request a prescription from a physician. If the provider has registered with
Surescripts, they could also receive requests from pharmacies in the network. Typically, a receptionist or a
pharmacy requests a prescription from a physician.
For example, Betty, the receptionist, receives a phone call from Andy Homer, a patient with Dr. Webb. Andy
says that he has just finished the monthly supply of his medication. He requests refill for the next month, as
well a refill for one of his long-term medications. Betty submits a prescription request to Dr. Webb for the
two medications. When Dr. Webb receives the prescription request, she can:

 Accept all information in the prescription request and create the prescription
 Refuse to prescribe all medications in the prescription request
 Refuse to prescribe some of the medications in the prescription request and create the
prescription for the remaining medications

 Modify some of the dosage and dispense details in the prescription request and then create the
prescription.

○

All MicroMD EMR users have permission to create
prescription requests. However, you can send
prescription requests only to those users with the role of
Physician, Nurse Practitioner, Non-Physician Caregiver or
Physician Assistant.

Filtering the Prescriptions List
The default values for the filters at the top depend on your user role. For example, the physician’s Status
drop-down defaults to Requested to show all of the prescription requests he needs to approve. The
nurse’s Status drop-down defaults to Action to show all of the prescriptions for which the physician has
asked she perform a task. For all roles, the date range filter defaults to the date of the oldest item (the From
field) to today’s date (the To field).

Filtering the List as a Physician (or Similar) Role
If you are a user with the role of Physician, Nurse Practitioner, Non-Physician Caregiver or Physician
Assistant, the Status drop-down defaults to Requested, and the Route drop-down defaults to
Received. This displays all of those prescription requests sent to you from other MicroMD EMR users
and any requests sent to you through Surescripts.
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Figure 21.22 Default Desktop of Physician
The Route drop-down for a user with one of these roles contains an extra option that does not appear
for the user with the Nurse or Receptionist role. That extra option is the Prescribed option. When you
select Prescribed from the Route drop-down, the system displays all of those prescriptions you have
written or requests that you have addressed (that also meet the other criteria in the filter). For
example, you want to see all of the prescriptions you have written over the past week for Andy Homer.
You would select Past week from the Date Range drop-down, Prescribed from the Route drop-down
and type Homer, Andy in the Patient field.
The Mechanism column in the list indicates the method that was used to send the prescription request
to you, including via Surescripts. The Rx Status column indicates the current status of the request. This
reflects the options listed in the Status drop-down. You can sort the list in this window by using any of
the filter options at the top. For example, if you would like to see all of the requests sent to you by Betty
Lopez, you would select Betty’s name from the Received from drop-down. The window refreshes and
you see only those requests sent to you from Betty.

Filtering the List as a Nurse or Receptionist Role
If you are a user with the role of Nurse or Receptionist, the Status drop-down defaults to Action, and
the Route drop-down defaults to Received. This displays all of those requests that providers have sent
to you to print, fill from stock, or any other action regarding the prescription.
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Figure 21.23 Desktop of Nurse

Creating a New Prescription or Prescription Request
MicroMD EMR allows you to create a prescription request and to send the request to a provider for
approval. Prescription requests are typically for refills of current prescription or long-term medications.
To create a new prescription or prescription request from your Desktop, simply click the New Rx button
(Figure 21.22 on page 21.30) or the New Request button (Figure 21.23), as appropriate for your role. This
opens the Prescription Pad. Please see page 21.8 for details on using the Prescription Pad.

Processing Prescription Requests
The Prescriptions list on your Desktop also provides you with the ability to process prescription requests or
perform the actions assigned to you regarding a prescription. With the streamlined approval process, you
can approve and process prescription requests directly from the request. Simply highlight the request you
want to process and click the Process Rx button (Figure 21.22 on page 21.30).
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Figure 21.24 Prescription Request
Once you review the request, you can select the drop-down arrow next to the medication you want to
process. Simply select Approve or Deny (and the reason for denial). Once you have reviewed all
medications on the request, click the Authorize Prescription button (Figure 21.24) and the Prescription
Processor window opens (Figure 21.25).



Once you click the Authorize Prescription button, the
system records your “signature” in the database and
the status of the request.

When you receive a prescription request through Surescripts from a pharmacy, you have an additional
option called Replace to use when you want to replace it with a different drug or with the same drug at a
different dosage.
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Figure 21.25 Prescription Processor Window
The left side of the Prescription Processor window contains the list of medications requested. The
checkbox next to each medication indicates which medications are included in the transmission method
you use on the right side of the window.
For example, the prescription request could contain a mix of those schedule drugs that you cannot send to
the pharmacy electronically and those that you can. The checkbox allows you the flexibility to uncheck
those that you cannot send electronically and send only the electronic prescriptions. Once that is
complete, you can change up the check marks and print just those that you need to print. Next to the
medication’s name and in green text, the system displays the last transmission action performed on the
medication.



The system includes every medication with a check
mark in the action you perform, even if you have
already performed an action. Be sure to remove the
check mark from those items you do not want to
include in the action.

The right side of the window are the methods by which you can get the approved prescriptions to the
pharmacy. Click the button next to each section of the right once you have set the fields appropriately.

 You can send the checked prescriptions to a printer in your office. If your practice allows
physicians to choose their own prescription form, you can do so from the Template field. Select
from your Common List drop-down or click the Lookup icon ( ) to choose another template.

 You can send the prescription to the pharmacy electronically. This includes either via fax or via
Surescripts. Simply select the method from the Send via drop-down.

 You can assign the task to another user, multiple individual users, and/or user groups. Simply
select the user(s) from the Assigned to field and place a check mark next to the task you want
them to perform. The prescription appears in each user’s Desktop under Prescriptions.
However, if one user has the prescription open on their Desktop, the system locks the
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prescription and prevents any other user from opening the prescription. When a user marks the
item as complete, the system removes the prescription from everyone’s Desktop to avoid
multiple processing. If these choices do not meet your needs, you can type additional
information in the Note field.



In this section of the window, you must either choose
an action or add text to the Note field to enable the
Assign button.

Forwarding a Request
There may be times when you, as a provider, need to forward a prescription request to another provider
instead of addressing the request yourself. Simply highlight the request in the list on the Desktop and click
the Forward button (Figure 21.22 on page 21.30).
You can add any additional comments to the request if you want. Once you have selected the person to
whom you would like to forward the request, click the Forward button at the bottom of the window. The
system removes it from your list and adds it to the other provider’s list. You can view it again if you select
Sent from the Route drop-down (Figure 21.22 on page 21.30).

Figure 21.26 Forwarding a Request

Deleting a Request
If you have not authorized a prescription yet (i.e., the status is still Requested), you have the ability to
delete the request from the system. Simply highlight the request and click Delete.



The system disables the Delete button for those requests
you cannot delete.

Request and Process Prescriptions in an Encounter
Nurses can request refills and physicians can process those requests from within the encounter. When
starting an encounter for another user, simply add a medication to the medication section of the
encounter. The user completing the encounter sees the request just as they would on a normal
prescription request.
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Figure 21.27 Prescriptions Requests within an Encounter
To process the prescriptions in an encounter, simply click the drop-down next to the prescription name to
approve or deny the request (Figure 21.27). The Refill Requests button turns red when there are requests
in the encounter (page 22.15).
For example, Betty at Advanced Family Practice begins an encounter for Dr. Davidson. While on the
Medication tab of the Encounter Builder, she selects a medication to refill from Andy Homer’s medication
list and adds it to the encounter. She saves the encounter when she finishes.
Dr. Davidson opens the encounter (which defaults to the Subjective tab) and sees the Refill Requests
button highlighted. He clicks the Medication tab to view the request in the Patient Medications area. He
clicks the drop-down and selects Approve to approve the medication.

Unidentified Prescription Requests
When you receive a prescription request from a pharmacy through Surescripts, there are times when the
system cannot identify the patient or the provider on that request. The system funnels those requests into
the Unidentified Items section of the Desktop. To see this section, you must have the Unidentified Rx
Requests function assigned to your user account.
To narrow the list of unidentified requests, you can filter the window to just those requests you want to
review. You can do so by the provider and/or by the date (or date range) of the request.
When you highlight an unidentified request, MicroMD EMR displays all known information about the
request at the bottom of the window. Use this information to help find the appropriate patient or provider
in your system.

Identifying the Provider
When MicroMD EMR receives a prescription request, MicroMD EMR tries to match the provider’s details
contained in the request with the details of a provider in your database, as well as the patient
submitted. The system must be able to match both the provider and the patient. The difference could
be as minor as a misspelling or an extra space.

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click My
Workflow and choose Unidentified Items
from the options available.
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Details (continued)

3. Select Rx Requests from the Item Type
drop-down.
4. Locate and select the request that you want
to identify.
5. Verify that the space for the provider’s name
appears with a cyan background.

This cyan highlight indicates that the system
could not match the request with a provider in
your database.

6. Click the Identify Provider button.

The Reference List Viewer window opens and
displays your Common List of providers.

7. Locate the required provider and click
Insert.

The system associates the provider with the
selected request.
If both the provider and the patient of the
selected request are now identified, the system
removes the entry from the list of unidentified
requests and places it in the correct provider’s
Desktop.
If the patient is still unidentified, the entry
remains in the list of unidentified requests. The
newly identified provider’s name appears
followed by the name downloaded originally.

Identifying the Patient
When MicroMD EMR receives a request from a pharmacy, MicroMD EMR tries to match the patient’s
details in the request with the details of a patient in your database. If MicroMD EMR is unable to
successfully identify the patient, the result is classified as UNIDENTIFIED. The difference could be as
minor as a misspelling or extra space.
To identify the patient in an unidentified prescription request:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click My
Workflow and choose Unidentified Items
from the options available.
3. Select Rx Requests from the Item Type
drop-down.
4. Locate and select the request that you want
to identify.
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5. Verify that the space for the patient’s name
appears with a cyan background.

This cyan highlight indicates that the system
could not match the request with a patient in
your database.

6. Click the Identify Patient button.

The patient search window opens.
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Procedure (continued)

Details (continued)

7. Locate the appropriate patient and click OK.

The system associates the patient with the
selected request.
If both the patient and the provider of the
selected request are now identified, the system
removes the entry from the list of unidentified
requests and places it on the correct provider’s
Desktop.
If the provider is still unidentified, the entry
remains in the list of unidentified requests.

Rejecting Unidentified Requests
There may be times when the request should not have reached your practice, and you need to send a
message back to the pharmacy. Simply highlight the request and click the Reject Request button. The
system sends a message back to Surescripts with a denial message “patient unknown” and removes
the request from your list.

Electronic Transmission of Schedule Drugs
Many states have regulations regarding the electronic transmission of prescriptions. Controlled
substances are heavily regulated. Depending upon your state, you may be required to prohibit the
electronic transmission of schedule II and/or schedule III – V controlled substances. MicroMD EMR provides
options to block electronic transmission (i.e., via fax and/or Surescripts) for two categories of controlled
substances:

 Schedule II medications
 Schedule III – V medications

Figure 21.28 Prescription Defaults Window
To access this window, open the MicroMD EMR Manager, click the System Settings button and click the
Prescriptions tab. When you click the Edit button, the Prescription Defaults window opens. Simply select
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Provider Prescription History Report

the appropriate option from the drop-downs in the Sending Schedule Drugs section. Click OK when
finished.



If you would like to send prescriptions for schedule drugs
electronically, please contact your local authorized
MicroMD EMR reseller for more information on our
MicroMD EPCS Gold program.

Provider Prescription History Report
For those providers whose states require them to generate and print a history of the prescriptions the
individual provider has written, the Provider Prescription Report prints a list of the medications prescribed
within the indicated date range. The system remembers the date you printed the report last and adjusts
the default date range accordingly. This report is available to any user with the Physician, Nurse
Practitioner or Physician Assistant role associated with their user account.
To generate the report, select Print > Provider Rx Report from the main menu anywhere in the EMR. The
system displays the Rx History Report window. Set the date and click the Print button. Sign the report and
retain for your records as necessary.

Figure 21.29 Provider Prescription Report
Practices can set a reminder to physicians to print this report every so often. In the EMR Manager, you can
set this time frame on the Prescriptions tab under the System Settings button. In the Remind provider to
print prescription history report every drop-down (Figure 21.28 on page 21.37), set your time range.

Printing the Word “COPY” on Unused Forms
There are times when a practice needs to print the same prescription a second time. Perhaps the patient
needs a hard copy of an electronic prescription, or your state requires that the word “COPY” appear on a
prescription generated as a duplicate. You can have MicroMD EMR print the word “COPY” on those
duplicate prescriptions, even if the first method was faxed or sent through Surescripts.
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Figure 21.30 Option to Print the Word “Copy”
In the MicroMD EMR Manager, you can choose how you want the system to behave. You can find this
option on the Prescriptions tab under the System Settings button (Figure 21.28 on page 21.37).
The options in the Prescription copies should be marked ‘Copy’ drop-down are:

 Always: The system places a check mark in the Mark prescription as ‘COPY’ if this is not first
printing checkbox and does not allow the user to change it.

 Yes (but allow override): The system places a check mark in the Mark prescription as ‘COPY’ if
this is not first printing checkbox by default but allows the user to change it on a case-by-case
basis.

 No (but allow override): There is no check mark in the Mark prescription as ‘COPY’ if this is not
first printing checkbox by default; however, the user can check the box as needed.

 No: There is no check mark in the Mark prescription as ‘COPY’ if this is not first printing
checkbox by default, and the user cannot change it.

Configuring the System to Use Surescripts
MicroMD EMR allows practices to submit their prescriptions to pharmacies via Surescripts, a company that
facilitates the electronic transmission of prescription information between physicians and pharmacists.
Typically, your MicroMD EMR support team configures your system to work with Surescripts. Once this
configuration is complete, you send your prescriptions as detailed in this chapter. If the pharmacy is
registered with Surescripts, the system automatically selects Surescripts as the method of transfer.
Otherwise, the system chooses to send the prescription via fax.

○

Due to legal constraints, users cannot send prescriptions
for certain controlled substances electronically unless
registered for the MicroMD EPCS Gold program. They
must send prescriptions for these controlled substances
by fax to a pharmacy.
If your system is set up to send faxes, users can fax the
prescriptions from within MicroMD EMR. Otherwise, they
can print the prescription for these substances and
manually fax them to the pharmacy.
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After you create a prescription and send it to a pharmacy via Surescripts, MicroMD EMR lets you manage
and track the progress of your prescription’s journey to the pharmacy. Currently, all electronic prescription
requests are received via Surescripts. After you process a prescription request, you use Surescripts to
return the resulting prescription directly to the pharmacy that originally submitted the request.



The MicroMD EMR Desktop lets users manage and
process all the electronic prescriptions they send
(Prescriptions sent mail folder) and requests they
receive (Rx requests inbox mail folder). Users with the
Administrator or Practice Manager role assigned to
their user account can monitor all faxes sent through
Surescripts using the Administrative Panel on their
Desktop (page 6.8).

Please contact your local authorized MicroMD EMR reseller for more information about configuring your
system for use with Surescripts.

e-Prescribing and Formularies
By integrating with Surescripts-RxHub, MicroMD EMR provides physicians valuable information about a
patient’s prescription coverage right at the prescription-writing window. RxHub provides formulary data
from the patient’s prescription plan directly to MicroMD EMR. This data includes what the patient can
expect to pay for this specific drug, as well as any restrictions about the drug that may cause it not to be
covered. If the drug is not a preferred drug for that plan, they might provide a list of alternatives the
physician can prescribe that are covered. These transaction sets also allow the physician to review
medications the patient has filled from other prescribers.

○

For details on setting up your system to use SurescriptsRxHub, please contact your local authorized MicroMD
EMR reseller for more information.

Once the e-Prescribing module is set up on your system, you can begin using it. There are three portions
to the use of RxHub: Eligibility, Medication History and Formularies.

 Eligibility: Eligibility is the simple overview of the patient’s coverage with the listed
Prescription Plan.

 Formulary: Formulary is the in-depth, detailed look into the patient’s available coverage for
each and every medication. From the patient’s co-pay to the suggested alternatives that you
should use instead to the amount the patient can expect to pay based on the pharmacy, even
down to how much the patient has remaining to reach their deductible.

 Medication History: The history provided from RxHub is the list of medications the patient has
filled over the last two years and who prescribed the medication.
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Eligibility
Eligibility is the simple overview of the patient’s coverage with their prescription plan(s). To get this
information, MicroMD EMR sends a request based on your appointment schedule. By the time the patient
arrives, their information is at your fingertips.

○

If a patient calls in and they aren’t on the schedule, you
can update their eligibility manually. Simply select
Update Eligibility from the RxHub drop-down icon (

).

There are several places to view the patient’s prescription eligibility:

 From the Appointment Detail window
 From the Prescription Pad
 From the Medication section of an encounter
The view is the same for all. To view the patient’s eligibility, simply click the RxHub icon (
Eligibility Benefit Manager from the drop-down menu (Figure 21.31).

) and select

Figure 21.31 Opening Eligibility Manager
The RxHub icon ( ) is red if the patient’s eligibility is not current, and it is green if the information was
checked within the last 24 hours.
The Eligibility Benefit Manager window that opens displays all of the patient’s current coverages (Figure
21.32). The top portion of the window displays the demographics information you have on file for this
patient. There is also a field called Office Notes. This allows your practice to record any information about
this patient in relation to eligibility in general. The system retains the Office Notes independent of updating
the patient’s eligibility.
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Figure 21.32 Eligibility Benefit Manager
The information on the bottom portion of the window is the information returned from RxHub. The
important information here is whether the patient has Retail and/or Mail-order drug coverage, as well as
the patient information on the right.



If any of the patient information on the right is red, this
indicates that the prescription plan has different
information on file for the patient than you do. You
should verify the details with the patient.

Formulary Information
Once the system has the patient’s eligibility information, it can then display the patient’s formulary details
for any medication that you want to prescribe. This information includes the status provided by the
pharmacy plan, the patient’s co-pay details, any coverage restrictions, any alternative drugs you should
consider and if prior authorization is required. You can view this information anywhere you can prescribe a
medication in the system.
When you select a medication to prescribe, the system displays the formulary information on the right of
the prescription area.
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For those users with the Write Prescriptions on Behalf
and Authorize Refill Requests functions, the formulary
display panel only appears on the Prescription Pad or in
the encounter for the providers in the list who are
registered with Surescripts.
If the provider for whom you are writing a prescription or
for whom you are authorizing refill requests is not
registered with Surescripts, you do not have access to the
formulary information for the patient.

If no one has checked the patient’s prescription eligibility
in the last 24 hours or the eligibility check did not return
an eligible plan, the system does not display the
formulary panel for you.

Figure 21.33 Formulary Information
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Formulary Status
The Formulary Legend pop-up window explains the labels that appear next to each medication. You can
access this pop-up through the RxHub icon (
down menu.



). Simply select Show Formulary Legend from the drop-

You can also hover over the icons next to each
medication to display their meaning.

Prescription plans rate drugs based on their efficacy and their value when comparing to other drugs of the
same class that are used to treat a particular diagnosis. They give those drugs a status that results in the
following:

 On formulary – preferred level ( -

): A preferred drug is the drug the prescription plan covers
and prefers that you use. The rating scale is between 1 and 99, with 1 being the lowest priority.
For example, you see two drugs listed: one at preferred level 3 and the other at preferred level 8.
The drug that is more preferred by the prescription plan is the drug at level 8.

 On formulary (

): A drug with a blue dot is a drug that the prescription plan covers.

 Off formulary (

): A red dot is off formulary. Drugs with this formulary status have been rated as
less effective than the preferred alternatives and could result in greater out-of-pocket expenses
for the patient and should be avoided if possible.

 Not reimbursable (

): This indicates that the patient’s prescription plan does not cover this
drug, and the patient is responsible for any prescription cost.

 Unknown ( ): If the system is unable to determine the formulary status, the prescription plan
does not return enough information in the file or if there is an error during the transaction, the
system displays an unknown status.

 Prior authorization ( ): This indicates that the drug selected requires prior authorization before
you can complete the prescription.

Coverage Details
On the top of the window (Figure 21.33) is the detailed coverage information for the selected medication.
You can view the patient’s co-pay information with this payer, any coverage restrictions (e.g., age limits,
gender limits, prior authorization) and any alternatives the payer prefers you to use instead of the selected
medication.
The drop-down displays the list of prescription plans returned when the patient’s prescription eligibility
was checked. You can switch between multiple coverages to see which plan makes the most sense for the
patient. Once you select a coverage, the system records the coverage and includes this in the e-Prescribing
Activity Report each week.

○
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The data files from Surescripts-RxHub can contain the following information:

 Pricing information: The Surescripts Real-Time Prescription Benefit feature displays complete,
patient-specific drug benefit and cost information, in real time, down to the dose (Figure 21.33
on page 21.43). To see pricing for the medication at different pharmacies, select a different
pharmacy to re-retrieve the information. The system updates the information in real time from
Surescripts.

 Coverage Restrictions: If the payer’s coverage of the selected drug has any restrictions or
additional information, those restrictions display in the middle area of the Formulary Details
panel—from text messages to quantity limits.
The following are the types of information that could come across from the payer:

- Age Restriction
- Gender Restriction
- Medical Necessity
- Prior Authorization
- Quantity Limits
- Resource Links (e.g., The payer may include a hyperlink to more detailed information they
want you to have.)

- Step Therapy
- Text Messages (e.g., The payer may include a free text message to you about the coverage
on the drug or about the drug itself.)

 Alternatives: If the selected medication is not a preferred medication, the system displays any
alternatives provided by the payer at the bottom, in order from most preferred to least. Simply
drag and drop the medication to prescribe it. The system prompts you to delete the original
medication. You can also double-click the alternative medication to choose it.

Figure 21.34 Alternatives

 Physicians’ Desk Reference (PDR): When processing a prescription, the PDR Brief pops up if
available for the selected prescription and displays for a few seconds before automatically
closing. To open the PDR Brief again, simply click the PDR button at the bottom of the
Formulary Details window. The PDR Brief features links to full prescription labels, boxed
warnings, safety alerts, patient education materials, medication adherence programs, and
financial assistance offers.
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Medication History
One of the more popular features of the integration with RxHub is the ability to retrieve the patient’s
medication history from other providers outside the practice. This history reflects the list of medications
the patient has filled in the last two years through their current insurance company, and the date they filled
it. This history could also contain the days supply and who prescribed the medication.



You can sort the columns to group medications or dates
together. Simply click the column header to sort.

For example, Dr. Davidson views the Medication History from RxHub for Andy Homer. He can see who
prescribed Oxycodone for Andy and how often Andy filled the prescription. If the payer returns the
information, Dr. Davidson can even see how much the other physician prescribed and can click the plus
icon ( ) to view a more comprehensive fill history of the selected medication.

○

On the RxHub Medications window, you can add the
selected medication to the patient’s chart as a long-term
medication (click the LTM button) or as an “other”
medication (click the Other button). When you click one
of these buttons, the appropriate window opens.

Figure 21.35 RxHub Medication History
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Displaying the Medication History
To view the patient’s medication history, you can do so from a few places in the EMR.

 On the Prescription Pad or the Medications section of an encounter, click the RxHub icon (

)

and select Show RxHub Medications from the drop-down menu.

 In the Medications section of the patient’s chart (on the Medical Information tab under the
Medical button), click the RxHub Meds button.

Fill Date Verification
The system displays the patient’s dispensing history for each medication. If the system cannot match
up a medication’s fill data with a precise prescription written in the patient’s chart, the Fill Date
Verification link displays in red at the bottom of the window. To identify the matching prescription for
the fill data, click the Fill Date Verification link and associate the prescription with the appropriate
dispensing information.

Patient Consent
Patients can choose whether they want your practice to view the medication history from RxHub and
what history you can view. By default, the system allows all history from RxHub to display when you
select Show RxHub Medications from the RxHub icon (

).

If the patient requests a change to this information, you can document the details of the patient’s
consent in their chart in the Consent section of the chart (Demographics tab).

Figure 21.36 Patient Consent
There are two parts to the patient’s consent for their prescription history from RxHub: whether the
patient wants your practice to access their history and what information they agree to share.
To add the patient’s consent or record their refusal, click the Add button in the Consent section of the
Demographics tab and select the appropriate option:
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 Surescripts RxHistory: When you select Surescripts RxHistory from the drop-down, you can
choose Consent Denied or Consent Given. When you choose Consent Denied, the system
prevents the practice from viewing the patient’s medication history. The RxHub Medication
History window displays Patient has opted out in red.

 Surescripts: When you select Surescripts from the Consent for drop-down, you need to choose
whether the patient only wants you to view prescriptions prescribed from your practice or if you
have permission to view all prescriptions from RxHub.

- Clinic-prescribed only: This option filters the RxHub Medication History window to display
only those medications prescribed by physicians in the practice. No external prescriptions
appear in the history, and the window displays Clinic-prescribed only in red.

- All Prescriptions: This option is the default and allows providers to view all medications in
the RxHub Medication History. The window displays All prescriptions in red.



For more details on adding consent to the patient’s
chart, please see page 9.19.

e-Prescribing Failovers and Notifications
When a prescription does not transmit electronically after three tries, the system automatically switches
the prescription to Interfax to make sure the patient doesn’t have to wait at the pharmacy because the
prescription never arrived. In the meantime, the system notifies you when the technology has failed,
allowing you to address the issue promptly. An electronic prescription can fail either on the practice’s end,
the MicroMD end, or the Surescripts end.
To help monitor this quickly in the system, you can tell MicroMD EMR to notify the appropriate personnel
through the internal mail feature in the system. These subscriptions allow you to monitor interfaces with
your system. Electronic prescriptions are part of the Clinigration module. When the Clinigration module
fails, you can have the system notify the appropriate personnel.

Figure 21.37 Subscriptions Tab
21.48

MicroMD EMR User’s Reference Manual Version 16.0

Medication List in the Patient’s Chart

Chapter 21. Prescriptions

To create subscriptions, click the Monitoring button in the Manager and click the Subscriptions tab
(Figure 21.37). To add a subscription, simply click the Add button. You can choose to have the system send
a MicroMD EMR internal mail message to the specified user(s), rather than an external e-mail. For more
details on creating and using subscriptions in the system, please see page 1.78.
When you select Internal Mail from the Mechanism for notification drop-down (Figure 21.37), the system
creates a message in the Mail section of the selected user(s) Desktop. This message contains the details of
the error and helps the user address the issue promptly.

Medication List in the Patient’s Chart
Tracking a patient’s medications can be an important part of providing great healthcare. MicroMD EMR
provides a central area in their chart where you can view the medication list, including past and present
medications. You can access the patient’s list of medications on the Medical Information tab. Click the
Medical button and choose Medications from the options available.

Figure 21.38 Medication List in the Patient’s Chart
Medications are separated into three categories: long-term medications (LTM), prescriptions (Presc.), and
other medications or over-the-counter drugs (Other). To filter the medications according to these
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categories, add or remove check marks in the filter. For example, if you want to view only a patient’s
current long-term medications, remove the check marks from the Presc and Other checkboxes.



For additional information about a medication, click the
information icon ( ) in the yellow “sticky” area,
including access to patient education and VisualDx.

Prescriptions
MicroMD EMR maintains a history of all the medications prescribed for each patient. You can prescribe
medications for patients directly in an encounter, through the Prescription Pad or from this option on their
Medical Information tab. When you prescribe a medication, the system saves the details of the
prescription in the patient’s chart.
When you prescribe a medication, MicroMD EMR allows you to specify comprehensive dosage details for
the medication. The Dosage Manager simplifies the task of inserting dosage details (page 21.25).

Figure 21.39 List of the Patient’s Prescriptions
To view the list of only the patient’s prescriptions, open their chart and click the Medical Information tab.
Under the Medical button, choose the Medications option and make sure there is a check mark only in the
Presc. checkbox.
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Place a check mark in the Current checkbox to display
only the patient’s active prescriptions.

From this window, you can prescribe medications, re-prescribe a medication, add a current prescription to
the patient’s list of long-term medications or view all medications prescribed to the patient. You can also
add comments to a prescription (e.g., Charlotte Smith has certain problems with a medication, but you
feel confident she’ll be okay with the drug.). These comments could help other physicians when they work
with Charlotte, and she mentions anxiety about the side effects.



Right-click the medication and select Check interaction
for the pop-up menu to view any warnings for the drug.
Click the Details button on the Drug Warning window to
find out more.

Adding a Prescription
To add a prescription to this list, click the drop-down next to the Add button and select Add Rx from
the drop-down menu. The system opens the Prescription Pad (page 21.8).
Typically, when you create a new prescription, you either print the prescription at that time, you send
the prescription directly to the pharmacy or you forward it to the front desk. You can process the
prescription from the Medical Information tab. Simply click the Process Rx button. See page 21.8 for
details on processing prescriptions, and see page 21.22 for more information on processing
prescriptions from within an encounter.

Re-Prescribing a Medication
If you want to re-prescribe a medication in the list, highlight the medication and click the Re-prescribe
button. The system opens the Prescription Pad (page 21.8). To view a history for a prescription, click
the Rx History button (page 21.22).

Fill Date Information
Surescripts automatically returns any dispensing information sent from the pharmacy, and MicroMD
displays the Rx Filled status for the prescription. To view the dispensing information, right-click a
prescription in the list and select Fill Date Information from the pop-up menu.

Figure 21.40 Fill Date Information
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However, not all pharmacies send this information electronically. To enter dispensing information
manually, simply click the New icon ( ) at the top of the window and edit the fields in the row. If you
need to edit dispensed information after saving it, click the Edit icon ( ) on the row you want to
change. To delete a row, click the Delete icon ( ) on the row you want to remove.

Long-Term Medications
MicroMD EMR allows you to manage your patients’ long-term medications. Long-term medications are
those medications that the patient uses on an extended basis. Long-term medications always have a start
date and may have an end date if the patient no longer needs the medication.

○

An entry in the patient’s list of long-term medications
indicates that the patient was instructed to take the
specified medication. It does not indicate that the
medication was actually prescribed in MicroMD EMR.

The system also allows you to record—as part of the patient’s chart—that the patient has no known longterm medications by clicking the No LTM’s button. The No current long-term medications entry appears
as the sole entry in the patient’s record. See page 12.4 for more details on the No Known entry.

Figure 21.41 List of the Patient’s LTM Prescriptions
To view the list of only the patient’s long-term medications, open their chart and click the Medical
Information tab. Under the Medical button, choose the Medications option and make sure there is a
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check mark only in the LTM checkbox (Figure 21.41).



Place a check mark in the Current checkbox to display
only the patient’s active long-term medications.

To edit or delete an existing long-term medication, simply highlight the entry and click Edit or Delete as
appropriate.



You should only edit the details of a long-term
medication when the details were incorrectly entered
or were not complete. If you want to change the
dosage of the medication, create a new entry in the
patient’s chart with the new dosage details.

To terminate a long-term medication, click the Terminate button. You can then enter the reason you
terminated this medication so you can refer back to it if needed. See page 12.5 for details on terminating
an entry.



You should only delete an entry if it was a mistake. If
the patient was on the medication for a while and they
no longer need the drug, you should Terminate the
entry instead. This keeps the item in the patient’s
history for future reference.

You can add a medication to this list while prescribing medications during an encounter or when
prescribing a medication using the Prescription Pad by clicking the LT icon on the right section of the
window.

○

Adding a long-term medication to a chart directly does
not automatically create a prescription for the drug. You
must still prescribe the drug to the patient (page 21.55).
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Figure 21.42 Long-Term Medication Entry
To add a new long-term medication to a patient’s chart:

Procedure

Details

1. Open the patient’s chart and click the Medical
Information tab.
2. In the Chart Navigator, click the Medical
button and choose Medications from the
available options.

The system displays a list of all the patient’s
medications past and present.

3. Click the Add button and select Add LTM from
the drop-down menu.

The Add Long-Term Medication dialog box opens
(Figure 21.42).

4. Click the Lookup icon (
Medication field.

) next to the

5. Locate the appropriate drug and click Insert
and complete the Sig for the medication.
6. In the Originally Prescribed section, enter the
person who initially instructed the patient to
take the medication and when.

This could be a user within your system or a
previous physician (you can enter the name of a
non-MicroMD EMR user in this field if needed).
You can also select Unknown from this drop-down
if necessary.

7. Complete the Dispense Information section.
8. Enter any additional information in the
Comment field.
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Procedure (continued)

Details (continued)

9. In the Reminder section, indicate if you want a
reminder to create a new prescription if one is
overdue for the medication.

This could be useful for those prescriptions that do
not allow refills like ADHD medications and require
a prescription every time.
From the drop-down in the Reminder section,
select the user for whom you want the reminder.
The reminder appears on that user’s Desktop in
the Reminders section.
In the days field, enter the number of days that
pass after the End Date you want the system to
generate the reminder if a prescription hasn’t been
created yet.

10. Enter an Associated Diagnosis if necessary.
11. Click OK or Apply/New.

The system adds the new item to the patient’s
chart. If you click the Apply/New button, the
system adds the item to the patient’s chart and
clears the window so you can continue adding
more.

Prescribing Long-Term Medications
MicroMD EMR allows you to quickly create prescriptions for any medication on the patient’s list of
long-term medications. Simply highlight the entry in the list of long-term medications and click
Prescribe. The system displays the Prescription Pad with the details of the medication completed for
you. Make any edits necessary and click Save. For more details on using the Prescription Pad, see
page 21.8.

Printing a List of Long-Term Medications
If you need to print the patient’s list of long-term medications, MicroMD EMR provides an easy way for
you to do so. MicroMD EMR allows you to print a list of the patient’s long-term medications.
To print the list of the patient’s current long-term medications, filter the medications list to display
only long-term medications and click the Print List button. The system prints the list to the selected
printer.

Holding a Long-Term Medication
You have the ability in MicroMD EMR to place a hold on a patient’s long-term medication and then
restart the medication again in the future. This is especially helpful if you only want to change the
dosage of the medication and do not want to re-enter all of the information.

Procedure

Details

1. Open the patient’s chart and click the
Medical Information tab.
2. In the Chart Navigator, click the Medical
button and choose Medications from the
available options.
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Medication List in the Patient’s Chart

Details (continued)

3. Verify there is a check mark in the LTM filter
checkbox.
4. Highlight the long-term medication you
want to place on hold.
5. Click the Edit button.
6. In the Terminate / Hold section, complete
the date and reason you want to stop this
medication.

7. Click OK.

The Edit Long-Term Medication dialog box opens
(Figure 21.42 on page 21.54).



You can also click the Terminate
button to enter this information
quickly.

The system places this medication on hold until
you enter a date in the Restart section of this
window. The system essentially terminates the
medication and displays the medication in blue
text.

Restarting a Long-Term Medication
You can restart any medication that you have terminated or put on hold. Once you restart the
medication, the system actually creates a new entry for you.

Procedure

Details

1. Open the patient’s chart and click the
Medical Information tab.
2. In the Chart Navigator, click the Medical
button and choose Medications from the
available options.

The system displays a list of all the patient’s
medications past and present.

3. Verify there is a check mark in the LTM
filter checkbox.
4. Highlight the medication you want
to restart.
5. Click the Edit button.
6. In the Restart section, select the date you
want to restart the selected long-term
medication.

7. Click OK.

21.56

The Edit Long-Term Medication dialog box opens
(Figure 21.42 on page 21.54).



You can change the medication
details at this time, or you can go
back in and edit after you click OK.
The details you change now reflect in
the new entry, not the old.

The system creates a new entry. You can now edit
the medication as needed.
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Other Medications
There are times when it is important to know whether the patient is taking any over-the-counter
medications or whether they have other prescriptions from other physicians. The Other Medications
category allows you to record these medications.
To view the list of only the patient’s other medications, open their chart and click the Medical Information
tab. Under the Medical button, choose the Medications option and make sure there is a check mark only in
the Other checkbox.



Check the Current checkbox to display only the active
medications.

To edit or delete an existing medication, simply highlight the entry and click Edit or Delete as appropriate.



You should only edit the details of a medication when
the details were incorrectly entered or were not
complete.

To terminate a medication, click the Terminate button. You can then enter the reason you terminated this
medication so you can refer back to it if needed. (See page 12.5 for more details on terminating an entry.)



You should only delete an entry if it was a mistake. If
the patient was on the medication for a while and they
no longer need the drug, you should Terminate the
entry instead. This keeps the item in the patient’s
history for future reference.

Figure 21.43 Other Medication Entry
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To add a new over-the-counter medication or one prescribed by another physician:

Procedure

Details

1. Open the patient’s chart and click the
Medical Information tab.
2. In the Chart Navigator, click the Medical
button and choose Medications from the
available options.

The system displays a list of all the patient’s
medications past and present.

3. Click the Add button and select Add Other
from the drop-down menu.

The Add Other Medications dialog box opens (Figure
21.43).

4. Click the Lookup icon (
Medication field.

) next to the

5. Locate the appropriate drug and click Insert.
6. Complete the Sig if necessary and enter
Dispense Information.
7. In the Originally Prescribed section, enter
the person who initially instructed the
patient to take the medication and when.

If the physician is a MicroMD EMR user, you can click
the Lookup icon ( ) and insert the appropriate
provider.
You can also select Unknown or Patient from this
drop-down if necessary.

8. Complete the Terminated section if the
patient no longer takes the medication.

When you click the Terminate button to end the
medication, the system completes this section
automatically.

9. Enter any additional information in the
Comment field.
10. Click OK.

The system adds the new item to the patient’s chart.

Common List for “Other” Medications
You can create a Common List to use for the “Other” medications list. This list is different from the one
used for medications in general. In the Common List Builder (under Tools > Common List Builder), the
Medications (Other) category allows you to create this Common List.
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Figure 21.44 “Other” Medications Common List
Each tab of the Available Items section allows you to add items to your Common List in a different way.
You can copy the Common List(s) of other users for the selected category. You can calculate the Common
List for the selected category based on your use of the program. You can also populate your Common List
for the selected category based on your specialty.
If you collaborate with a MicroMD EMR user from another practice across the country, you can import their
Common List. Finally, the system allows you to go back to basics and populate your Common List one
item at a time.

Pharmacy Reference Lists
Once you click the Lookup icon ( ) next to a Pharmacy field, the system displays the Reference List
Viewer window for Pharmacies (Figure 21.45 on page 21.60). Each button in this window has a particular
behavior:

 Common: Each user has a Common List of pharmacies. When you click the Common button,
the list you have created displays. This is a list you can create of the pharmacies you use most
often with your patients when you click an Add to Common List button. You can add a
pharmacy to your Common List “on the fly” or you can use the Common List Builder to create
your list (under Tools > Common List Builder).

○

If you have entries in your Common List, MicroMD EMR
displays this list by default when you open the Pharmacy
Reference List. Otherwise, the system opens the All list.

 Index: The Index button allows you to filter the reference list by the pharmacy type: currently
either Mail Order or Retail.
MicroMD EMR User’s Reference Manual Version 16.0
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 Smart: The Smart button displays the list of your practice’s preferred pharmacies. Any user can
add to this list of preferred pharmacies.

 All: When you click the All button, the window displays all pharmacies provided by Surescripts
listed in the reference database. It also displays any pharmacies added by the practice.

Adding to the Practice Preferred Pharmacy List
There are two concepts to review: practice-entered pharmacies and practice-preferred pharmacies.

 Practice-entered pharmacies are those that do not exist in the data sent from Surescripts.
These pharmacies are those your practice can create in the system manually and are stored in a
separate location in the database. These do not update when the list from Surescripts updates
every week.

 Practice-preferred pharmacies are those pharmacies your practice can “tag” as the ones you
want your providers to use most frequently.



You can use the Smart button to view only the list of your
practice’s preferred pharmacies.

Figure 21.45 Add a Pharmacy to Your Preferred List
To add a pharmacy to your preferred list, simply right-click the pharmacy’s entry in the Reference List
Viewer window for Pharmacies (Figure 21.45) and select the Add to Practice Preferred List option from
the pop-up menu. To take the pharmacy off the preferred list, select the Delete from Practice Preferred
List option.

Add/Edit a Pharmacy Manually
If the pharmacy the patient needs to visit is not in the list provided by Surescripts, you can add a new
pharmacy to the system manually. Click the New Pharmacy button on the Reference List Viewer window
for Pharmacies (Figure 21.45). This opens the Add Pharmacy window. (See page 8.5 for details on the
Pharmacy Contact Manager and using this window.) If you need to edit the pharmacy’s details, highlight
the pharmacy, click the drop-down arrow and select the Edit option.
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Figure 21.46 Edit a Pharmacy

○

When adding or editing a pharmacy manually, these
changes override any information provided by
Surescripts in the weekly updates to your system (based
on the NCPDP ID number for the pharmacy).

Electronic Prescription Prior Authorization (ePA)
The optional Electronic Prior Authorization (ePA) module for prescriptions allows practices to send prior
authorization requests for medications electronically within the EMR. When a provider prescribes a
medication and the patient has coverage data returned in their formulary, the system automatically
checks to see if prior authorization is necessary. If the medication requires prior authorization, the system
automatically sends over the initiation request and displays an indicator within the formulary window
(Figure 21.47).



The system keeps a Prescription History of the
prescription prior authorizations for future reference.

Figure 21.47 Prior Authorization Notification in the Formulary Details
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Configuring User Preferences
Your MicroMD support team helps you with registration and guides you through any setup of the overall
Electronic Prescription Authorization module. Once completed, each prescribing physician should identify
EMR users authorized to process electronic prior authorizations.

Figure 21.48 Authorized Staff for a Physician
Each prescribing physician user should select Tools > User Preferences from the main menu and select
Prescriptions from the Preference Category pane. In the Rx Prior Authorization staff field, click the Lookup
icon ( ) and insert all users who can process prior authorizations for this physician.

Processing Prior Authorization
When a prescription requires prior authorization, the system displays the ePA icon next to the prescription
on the Prescription Processor window (Figure 21.49).

Figure 21.49 ePA Icon
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You have two choices with this drop-down icon:

 Complete: Select Complete to process the questions required to process the prescription or
acknowledge the prior authorization if there is no action to be taken.

○

The Pharmacy Benefit Manager (PBM) may send over
more than one set of questions.

 Forward to staff: Select Forward to staff to send an action to the Prescriptions section of the
staff member’s Desktop. See page 21.62 to identify authorized staff members.
If the system already knows, based on the formulary data, that the medication requires prior authorization,
it automatically sends a request for you and the icon shows in green. You can also initiate an ePA request if
necessary.



The system displays “Sent for ePA” next to the
medication name if a request has been sent.

Completing Prior Authorization Form
When you select the Complete option or an authorized staff member processes the request from their
Desktop, the system displays the external Task History screen on the Surescripts system.

Figure 21.50 Task History Screen (Illustration Only - Actual Fields May Differ)
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Click the link that appears in the Task column (Figure 21.50). Typically, if there are questions to be
answered, the task will be to complete the prior authorization.

○

Once you complete the prior authorization questions, you
will need to acknowledge the approval or the denial of
the medication to complete the process.
When the prior authorization is denied, the prescriber
receives a mail message to inform them that further
action will need to be taken.

When you click the completion link, the Surescripts system takes you to questions you need to answer.
From here you can review patient and provider information. Simply click the Start button and answer
the questions needed to complete the prior authorization, add optional comments, and/or upload
supporting documentation files.

Figure 21.51 Worklist Screen (Illustration Only - Actual Fields May Differ)

ePA on the Desktop
If the prescriber chooses not to address the prior authorization requirement at the moment of prescribing,
MicroMD EMR automatically creates an action and adds it to the prescriber’s and designated staff’s
Desktop Prescriptions. From this area, both the prescriber, as well as designated staff, can take action on
the prior authorization by highlighting the prescription and clicking the Process ePA button. This displays
the Surescripts screen as it does when using it from the Prescription Processor window.
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ePA Statuses
Each electronic prior authorization contains a status. On the Desktop, the system displays that status in
the yellow “sticky” note in the ePA Status field. Table 21.2 identifies the most common statuses for an
electronic prior authorization transaction.
Table 21.2 ePA Status Descriptions in MicroMD EMR

ePA Status

Description

Draft

Message is being formed to be sent.

Pending

Message waiting for sending.

Assigned

Message ePA is assigned to a user to complete the next task (on the PBM side).

Distributed

The listed item was sent to the listed recipient.

Accepted

The listed item was accepted by the listed recipient. The user took action or
began to take action on the task.

Released

The listed item/task was locked, and the lock was released by the user who
accepted it. It was not completed. “Complete PA Form” tasks will lock upon
being accepted when the user selects the Start button.

Complete

The ePA message case has been completed and requires no further action on the
part of the prescriber or the PBM/payer. This may have been the result of an
approved/denied ePA message or closed status returned by the PBM/payer.

Cancelled

An approved “Cancelled” response was received from the PBM/payer. The ePA
message was cancelled. When a cancel status is found, the ePA initiate button is
available so a user can re-initiate if necessary.

Errored

An error condition was met that resulted in the ePA message case erroring out.
The message must be restarted by the initiator.

In Progress

The electronic prior authorization case is currently in progress and is awaiting
action from either the prescriber or the PBM/payer. The case may be
“completed” and responded to by the PBM/payer, but the task is in progress until
it is acknowledged by a user in the ePA Process window to complete the message
workflow.

Table 21.3 Electronic Prior Authorization Log Codes

Code

Description

433

ePA third-party processing found a payer and message recipient updated.

358, 360

The receiver is not the PA processor for this patient. The Closed Reason Code in the
response message is CO for 358 and CP for 360.

510

Third-party processor found

513

Sending secondary PAInitiationRequest

511

PDR form found

514

Sending Surescripts closed PAInitiationResponse
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Managing Encounters
An encounter is a visit between a patient and a provider. Over time, a patient may undergo numerous
encounters in the practice and with various physicians. MicroMD EMR allows you to record—in the
patient’s chart—the details of each of those visits.

In This Chapter
In this chapter, we cover how to:

 Use the Encounter Ribbon (page 22.7)
 Customize descriptor lists in your system (page 22.16)
 View a summary of the patient’s encounters (page 22.24)
 View details of a patient’s encounter (page 22.31)
 Copy and delete encounters (page 22.33)
 Revise an encounter (page 22.34)
 Edit an encounter (page 22.35)
 Review the audit log of changes made to each encounter (page 22.37)
 Minimize encounters (page 22.38)
 Create and use Pick Lists (page 22.38)
 Create and use a CliniGuide (page 22.42)
 Attach notes to an encounter and to items in an encounter (page 22.48)
 Add impressions to an encounter (page 22.53)
 Print a Patient Care Plan from the visit for a patient (page 22.54)
 Create an Encounter Report (page 22.57)

Overview
Each encounter in a patient’s chart is an “encounter record”. The system also allows you to establish the
method of recording an encounter that best suits you and how you work. The Summary tab of a patient’s
chart (Figure 22.15 on page 22.25) is where you can view a list of all the individual patient’s encounters and
access them to review. (For more in-depth information on the Summary tab, see page 22.24.)
Each time you open your patient’s chart and click the Encounter tab (Figure 22.22 on page 22.32), you view
your patient’s most recent encounter/progress note. Encounters/progress notes are the most important
part of your patient’s chart as they detail comprehensive medical information concerning each patient
visit.

Recording Encounter/Progress Note
Different providers use different approaches based on their personal work preferences and the needs of
the particular patient’s case. You all follow the required medical and legal guidelines laid down for
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documenting patient information. However, you implement these guidelines in different ways. MicroMD
EMR allows you to keep your personal style.
The standard, textbook encounter/progress note consists of:

 SOAP
 ROS
 Review of problems
 Review of medical information
This format is standard and familiar. However, you may not follow this precise formula during every patient
visit. Sometimes, it is enough to create a quick encounter/progress note. At other times, the patient’s
medical situation requires a complete, comprehensive description.
When using MicroMD EMR, you need to create a SOAP progress note for each patient visit that you perform.
You are also asked to take an active role in entering discrete data that is later used for billing and reporting
purposes.

○

“Discrete data” is information about the patient and their
medical health that can be parsed into tidbits of
information that the system can store in a database
format. This allows the system to pull the information in a
variety of ways and provides flexibility in interpreting the
data and using it for billing.

MicroMD EMR provides you with several tools for recording encounters.

 Encounter Builder
The Encounter Builder is the original encounter creator. It allows you to create an encounter/
progress note easily, and it allows you the flexibility to adapt to each patient’s needs using the
same tool. For more in-depth details on how to use the Encounter Builder, please see page 23.2.

 Encounter Wizard
The Encounter Wizard templates provide individual sections of data as steps in a window. After
completing each step, you click the Next button to advance to another set of data. You can
move back and forth through the steps as needed. For more in-depth details on how to use
Encounter Wizards, please see page 23.18.

 Text Encounter
The Text Encounter is a free-form text editor that allows you to type text, use a voice recorder
and insert discrete data from the database. This type of encounter is not quite as flexible as
other tools, but useful in its own right. For more in-depth details on how to use the Text
Encounter, please see page 23.23.

 Form Encounter
The Form Encounter Builder allows you to use checkboxes, drop-down lists, search fields and
more to create encounter records with forms that resemble the paper forms that they replace.
Form Encounters have a great deal of flexibility and are useful when transitioning from paper to
electronic records. For more in-depth details on how to use Form Encounters, please see
page 23.40.

22.2
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Encounter Record
Each time you attend to a patient you create a new encounter record in the patient’s chart. The encounter
record contains the details of the encounter, including the patient’s symptoms, any plans you prescribe,
and/or lab tests you want to order.
Each encounter record has a responsible provider. The responsible provider is the provider who performs
the encounter—and usually records the encounter in MicroMD EMR. Anyone can edit an unsigned
encounter; however, only the provider who is responsible for a given encounter record can sign the
encounter. After the responsible provider signs an encounter record, even that responsible provider
cannot make changes to the record.
Only those providers who have been given access to view a patient’s medical information can view the
patient’s encounter records. Any provider can make a revision of an existing encounter record and then
modify the revision as required. (For details on creating an encounter revision, see page 22.34.)
Each encounter record that you create is also associated with a main procedure code. A procedure code is
an industry-defined code that identifies the type of the encounter. Procedure codes help to streamline the
billing of services that you provide to your patients. For details on generating billing information with
MicroMD EMR, see Chapter 24.

New Encounter Window
The New Encounter window is typically the starting point for the majority of MicroMD EMR users. This
window allows you to create a new encounter record and specify the information in the encounter header.
You can also choose the recording tool you want to use for the current encounter.

Figure 22.1 New Encounter Window
You can create a new encounter from several places in the EMR. To create an encounter while in the
patient’s chart, click the New Encounter task in the Chart Tools section of the window or select Chart >
New Encounter from the main menu. Table 22.1 explains the fields on this window in detail.
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Table 22.1 Fields on the New Encounter Window

Field

Description

Patient name

Type the patient’s name you want associated with the encounter or click the
Lookup icon ( ) to open the Select Patient window.

Encounter Selected

The system displays any active pre-encounters created for the patient in this
drop-down. The pre-encounter entry contains the date of the pre-encounter,
which provider the encounter was created for, and some identifying detail of
the encounter. This field defaults to New. (See page 23.2 for more details on
pre-encounters.)

Encounter for

Select the user who will complete the encounter. Click the Lookup icon (
to open the Reference List Viewer window.

)

The system performs a check before inserting a default user in this field:

 If you create the encounter from an appointment, the system defaults to
the provider linked to that appointment.

 If there is no appointment, the system defaults to the physician listed as
the patient’s provider.

 However, if you have one of the following four roles, the system defaults to
you: Physician, Physician Assistant, Nurse Practitioner or Non-physician
Caregiver.
Transition of Care (if
applicable)

If you received a patient from the care of another physician and you need to
tie this encounter to that transition of care, select the appropriate entry from
this drop-down. See page 4.41 for more information on transitions of care in
the EMR.
You must link a Transition of Care to the encounter to meet requirements for
the Health Information Exchange measure in the Promoting Interoperability
category of the Quality Payment Program (QPP). Please refer to the MicroMD
EMR Objective Measures Guide: Performance Year 2019 for more details on
meeting the measure.

Encounter level
category

The system pulls the default for this drop-down from the Encounter level
category field under the Encounter category in your user preferences (under
Tools > User Preferences). This is mainly for reporting purposes.

Encounter level

From this drop-down, select the encounter level for this visit. The system
pulls the default for this drop-down from the Encounter level field under
the Encounter category in your user preferences (under Tools > User
Preferences).

○

22.4

When you make a selection from the Encounter level
drop-down, the system automatically selects the
appropriate Encounter level category appropriate
for that level.
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Table 22.1 Fields on the New Encounter Window (continued)

Field

Description

Examination type

From this drop-down, select the type of visit under which the current visit with
the patient falls. The system pulls the default for this drop-down from the
Encounter Examination type field under the Encounter category in your user
preferences (under Tools > User Preferences).

Record encounter
using the

Select the recording tool you want to use to record the current encounter. The
system pulls the default for this drop-down from the Recording method field
under the Encounter category in your user preferences (under Tools > User
Preferences).

○

If you select either the Encounter Wizard or Form
Encounter recording method, be sure to specify the
name of the wizard or form the system should load
when you record the encounter.

Restricted/
Confidential Data

Placing a check mark in this checkbox limits access to this encounter to only
those users with the Restricted or Confidential Data function associated with
their user account (page 1.16). It also hides the details of the patient’s
encounter on the Summary tab for everyone. Set your default value in your
Encounter preferences (under Tools > User Preferences). Your user account
must have the Restricted/Confidential Data function assigned to it to make
this checkbox and user preference visible.

Performed in
department

Select the location of the patient’s visit. This drop-down defaults from the
choice made in your Session Profile (under Tools > User Preferences). Please
see page 1.84 for more details about setting your user preferences.

Location Type

Identify the type of department selected in the Performed in department
drop-down. The Location Type field defaults from the Department Type dropdown when the department was created. Please see page 1.8 for more details
on adding departments to the system.

Nature of Encounter

From this section, choose the general category of encounter that this currently
fits. The system pulls the default for this drop-down from the Recording
method field under the Encounter category in your user preferences (under
Tools > User Preferences).

Encounter Timing

The system defaults the Date and Time fields to the current system date and
time. From the Duration field, select the amount of time it took to complete
your visit with the patient from start to finish. The system pulls the default
for the Duration drop-down from the Encounter duration field under the
Encounter category in your user preferences (under Tools > User
Preferences).
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Table 22.1 Fields on the New Encounter Window (continued)

Field

Description

Additional personnel
involved in the
encounter

Generally, this section is blank when you first create the encounter, unless you
are certain of the other parties that will be involved. If you know who will be
part of the visit, you can simply click the Lookup icon ( ) next to the field
and insert the appropriate resources.
As you create the encounter, however, MicroMD EMR automatically adds those
users to whom you assign orders or other patient plan actions. For example, if
you order a dressing for Andy Homer and Jennifer is the nurse responsible for
that, she appears in this list when you save the encounter.
You can view this information after saving the encounter. Display the
appropriate encounter on the Encounter tab and select Edit > Edit
Encounter Header from the main menu. To edit existing providers on the
encounter, highlight the provider in this section and click the Modify icon (
See page 22.35 for more details about editing the encounter header.

Reason for encounter

).

This section of the New Encounter window allows you to enter the reason the
patient has come to visit you in the first place (e.g., chest pains, sleeplessness).
Click the Lookup icon ( ) next to this field to insert the appropriate reason.
To delete a reason from the list, simply highlight the item and click the Delete
icon ( ).



You can have the system automatically add this
reason to the encounter. Under Tools > User
Preferences, select the Encounter category. Place a
check mark in the Add “Reason for Encounter” to
Patient Symptoms checkbox. See page 1.88 for
more on setting your user preferences.

My New Encounter
When you want to create a new encounter, you have two options. You can click the New Encounter task,
make all your choices on the window that opens, click OK to open your encounter recording tool and then
begin documenting the encounter. Or you could just click the My New Encounter task in the Chart Tools
section. This opens your default recording tool automatically. The system sets information in the
encounter header based on the choices you make in the Encounter category of your user preferences
(under Tools > User Preferences). See page 1.88 for more details on setting these defaults. See page 22.36
for details on editing the information in the encounter header.

Title Bar of Encounter
On the header of the encounter ribbon, you will find basic information about the patient including the
patient’s full name, sex, years of age and date of birth. To the left of that information will be the Step count
as you work through the encounter (if applicable). To the right of the patient information, the system
displays the location and the service date of the encounter.
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Figure 22.2 Title Bar of Encounter

Encounter Ribbon
The Encounter Ribbon is located at the top of each encounter recording tool and is made up of a series of
tabs. Each of these tabs contains a set of buttons that are organized by the type of function they perform.

Encounter Tab
The Encounter tab includes functions you use frequently when completing most encounters. This is the
default tab for every encounter recording tool except the Text Encounter tool. On this tab, you find the File,
Template, Tools, and Medical Information sections. The Refill Request, Impression Encounter Notes,
Image Annotation, Test Results, and Vital Signs buttons light up to indicate items that should be
reviewed when completing the encounter. For more information on highlighted buttons in the Encounter
Ribbon, see page 22.15.

Figure 22.3 Encounter Tab of the Encounter Ribbon
Table 22.2 Buttons on the Encounter Tab of the Encounter Ribbon

Button

Description

File Section
Save

Click the Save button to save an encounter. This is helpful if you have entered
quite a bit of information and want to prevent the loss of your hard work.

Preview

Use the Preview button to preview an encounter in discrete-data format.
For options when printing an encounter, use the Printing section of the
Administration tab. Refer to page 22.10 for additional information on those
buttons in the Encounter Ribbon.

○

When you click the Preview button, the system
automatically saves the encounter and then displays
the preview. This also creates any orders you have
added to the encounter.
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Table 22.2 Buttons on the Encounter Tab of the Encounter Ribbon (continued)

Button

Description

Change History

Click this button to open a list of all the changes made to the encounter. You
can select specific date/time/user from the From and To drop-downs to narrow
the list to display specific changes.

Lock Screen

This button locks the application for you to prevent unauthorized access while
you are away from the screen. The system clears the screen and displays a
password entry window. Enter your password or activate the fingerprint
scanner to unlock the system. For more information on locking MicroMD EMR,
see page 2.5.

Templates Section
Load Template

To open a template into an encounter, click the Load Template button and
select the appropriate template in the Load CliniGuide window. See page 22.42
for more details on CliniGuides.

Save as Template

When creating an encounter, you may want to save it as a template to cut down
on steps in future encounters. Click the Save as Template button to open the
Save CliniGuide window.

Copy Encounter

This button allows you to copy the details of an existing encounter into the one
you currently have open. Once you select the encounter you want to copy,
choose individual items from the Encounter Copy Details window and click OK.

Tools Section
Dashboard

This button provides access to the Clinical Dashboard from within the
encounter. You can have both windows open at the same time. For more
information about the Dashboard, please see page 27.2.

Refill Request

This button is red when prescription requests were created in a pre-encounter.
Click the Refill request button to display the requests in the Encounter Page
(Medication) window.
Refer to page 22.15 for more information on highlighted buttons in the
Encounter Ribbon. Please see page 21.29 for more details on prescription
requests.

PHD

The Patient Health Data button (PHD) indicates that the patient has submitted
health information through the Patient Portal. When the button is red, this
indicates there is data you need to reconcile and insert into the patient’s chart.
When you click the PHD button, you can reconcile patient data (page 10.15).

Impression

Click this button to add an impression to the encounter or view impressions.
This button is green if impressions already exist for the encounter. See
page 22.53 for more details on impressions and page 22.15 for more details on
highlighted buttons in the Encounter Ribbon.

Encounter Notes

Click this button to add or view encounter notes. The Note dialog opens. See
page 22.48 for more details about working with encounter notes. Refer to
page 22.15 for more information on highlighted button in the Encounter
Ribbon.

22.8

MicroMD EMR User’s Reference Manual Version 16.0

Encounter Ribbon

Chapter 22. Managing Encounters

Table 22.2 Buttons on the Encounter Tab of the Encounter Ribbon (continued)

Button

Description

Image Annotation

Click this button to add diagrams and annotations to the patient’s encounter.
This button also allows you to view annotations left by other users for the
encounter. See page 28.23 for more details on images and annotations. Refer to
page 22.15 for more details on highlighted buttons in the Encounter Ribbon.

Medical Calculators

This button provides access to the Medical Calculators in MicroMD EMR. This
extensive collection of calculators includes a variety of tools to help you while
you record an encounter. For more details on the medical calculators, please
see page 27.7.

Medical Information Section
Patient Monitor

Click this button to open the Patient Monitor window. See page 27.16 for
information on the Patient Monitor.

Document Manager

Click this button to access patient-related documents. For more information on
using MicroMD Document Management, refer to Chapter 28.

Test Results

Click the Test Result button to view a list of all the patient’s test results in the
Test Results window. Refer to page 22.15 for more details on highlighted
buttons in the Encounter Ribbon.

Medical Info
Summary

Click this button to display a quick summary of the patient’s medical
information, also known as the Medical Information Report. Please see
page 12.20 for more details about this helpful report.

Vital Signs

Click the Vital Signs button to display the patient’s vital signs in the Medical
Information Viewer window. For more information on encounter vital signs,
please see page 22.33. Refer to page 22.15 for more information on highlighted
buttons in the Encounter Ribbon.

Medical Info

Click this button to add, edit or delete medical information from the patient’s
chart while recording an encounter. When you click this button, the Medical
Information Review window opens. This window is a stand-alone version of the
patient’s Medical Information tab (on the patient’s chart). See Chapter 12 for
more details on the sections of this tool.

History Recorder

Click this button to access the History Recorder within an Encounter.

Editing Tab
The Editing tab is used in the Text Encounter recording tool and is disabled in other encounter recording
tools. It includes buttons for managing the fields of a text encounter and utilizing word processing
functions. On this tab, you find the Fields, Clipboard, Proofing, Basic Text, Insert, Editing, and Zoom
sections.



For more information on using the Editing tab with Text
Encounters, refer to page 23.23.
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Administration Tab
The Administration tab includes a number of important functions not specific to recording encounter,
such as appointments and requests. This tab includes the Requests, Printing, Prescriptions, Quality and
Tools sections. The Process Prescriptions button lights up to indicate you have not processed all the
prescriptions in the encounter. The Quality Measures button also lights up when you have quality
measures to which you need to attest.

Figure 22.4 Administration Tab of the Encounter Ribbon
Table 22.3 Buttons on the Administration Tab of the Encounter Ribbon

Button

Description

Requests Section
Request Appt

Click this button to open the Add Appointment Request window. After you
complete the fields and click OK, the system adds the request to your Appointment
Book on the To Schedule tab. The MicroMD EMR user assigned as your receptionist
can also view this request on their To Schedule tab. For more in-depth details on
appointment requests, see page 11.32.



If you have an interface with MicroMD PM, this
request also appears in the PM.

Route Patient

To route the patient to another resource or station while in an encounter, click the
Route Patient button. See page 4.33 for more information on routing patients.

Orders

When you click the Orders button, the Order Builder window opens. You can use
this window to edit, delete and print the orders. The system only opens the Order
Builder window if there is at least one plan item with an associated order recorded
in the encounter. If the order has already been performed, the system does not
display the item.

Reminders /
Follow-up

When you record an encounter, the Encounter Ribbon allows you to add reminders
to the patient’s chart. These could be personal reminders for you or reminders for
patient follow-up procedures. Simply click the Reminder/Follow-up button. The
system displays the Reminder / Patient Follow-up window (page 10.26).

Send to
Transcriptionist

If you record an encounter where you record dictations and you need to send the
encounter to the transcriptionist, the Encounter Ribbon allows you to do this. Click
the Send to Transcriptionist button. This opens the Assign to Transcriptionist
window. See page 27.44 for more information on transcription.
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Table 22.3 Buttons on the Administration Tab of the Encounter Ribbon (continued)

Button

Description

Printing Section
Encounter
Report

When recording an encounter, you can generate a variety of reports based on the
patient’s encounter history. Click the Encounter Report button on the Encounter
Ribbon to select what kind of report you want to generate. (The system
automatically saves your encounter when you click this button.) You can select any
of the following print options:

 Based on Template: The system allows you to create Encounter Report
templates and use those templates to generate consistent reports. For details
on printing a template-based report, see page 22.61.

 Standard: The system comes with a basic encounter report built into the
Encounter Ribbon. When you select Standard from the Encounter Report task,
the system displays a window where you can specify which categories of
encounter information and medical information you want to include in the
report. For details on the standard encounter report, see page 22.59.

 Quick Print: When you select Quick Print, the system prints the standard
encounter report using the same settings that you specified the last time you
printed a standard encounter report. MicroMD EMR sends the encounter report
to the default printer. For details on the standard encounter report, see
page 22.59.

○



These print options are available only for encounters
that were recorded using the Encounter Builder,
Encounter Wizard, or the Text Encounter Recorder.

If you use an Encounter Wizard that contains an
encounter report, this button displays the reports
attached to the template.
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Table 22.3 Buttons on the Administration Tab of the Encounter Ribbon (continued)

Button

Description

Patient
Education

With MicroMD EMR, you have a Patient Education Library (page 27.8) and a national
drug database. Click the Patient Education button to select the material you want
to print. You can access education material in the following ways:

 Search the library: Select the Select Education Material option from the
Patient Education drop-down button to search the library for the information
you want to print. The system opens the library for you and defaults to your
Common List of materials.

 Automatically search for material based on the prescribed medications in the
encounter: If there are medications prescribed in the encounter, the Patient
Education button lists those medications. Select a prescribed medication to
show the available education material for that medication in a national drug
database.

 Select education material associated with a recorded encounter entry:
MicroMD EMR lets you associate each patient education document in the
Patient Education Library with multiple encounter entries, such as
assessments, medications, laboratory results and plans. If the patient’s
encounter has an entry associated with patient education material, the Patient
Education button lights up and lists those documents in the drop-down so you
can easily provide the patient with relevant materials.
Patient Care
Plan

A Patient Care Plan lists all the procedures that were prescribed during an
encounter. You cannot omit any procedures that were prescribed in the encounter
from this report. You can use a Patient Care Plan as a checklist to ensure that the
patient undergoes all the prescribed procedures. The Patient Care Plan indicates
whether or not each item in the care plan has been completed.



You can also print the Patient Care Plan from the
Encounter tab of the patient’s chart. Select Print >
Encounter Patient Care Plan from the main menu.

Forms

MicroMD EMR allows you to attach Administrative Forms to the encounter record
(e.g., camp forms). When you click the Forms button, the system displays your list
of templates. Load the template and edit as necessary. See page 20.18 for details
on Administrative Forms.

Letters

The Encounter Ribbon provides quick access to letter templates to print a letter for
the patient after you record the encounter. Click the Letters button to display the
Write Letter window. Pick the template and whether you want to save the letter to
the patient’s chart. See page 26.5 for in-depth details about printing letters for
patients.

Referral Letters

If you decide during the encounter to refer the patient out to a specialist or other
service and you create a referral order, you can quickly and easily generate a
referral letter from the Encounter Ribbon. Click the Referral Letters button to
select the referral for which you want to print a letter. This opens the Print Letter
window. Pick the template and whether you want to save the letter to the patient’s
chart. See page 26.5 for in-depth details about printing letters.
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Table 22.3 Buttons on the Administration Tab of the Encounter Ribbon (continued)

Button

Description

Prescriptions Section
Process
Prescriptions

The system displays this button in red if you have not processed all the
prescriptions within an encounter. Click this button to open the Prescription
Processor window. For more information on processing prescriptions, please see
page 21.16. Refer to page 22.15 for more information on highlighted buttons in the
Encounter Ribbon.

Quality Section
Quality
Measures

The system displays this button in red if the patient chart or encounter does not
meet the requirements of the selected quality or objective measures. Click this
button to open the Patient Quality Measures window. For more information on
meeting quality measures, see page 29.1. Refer to page 22.15 for more information
on highlighted buttons in the Encounter Ribbon.

○

The system automatically saves your encounter
when you click this button.

Tools Section
Encounter
Header

This button opens the Edit Encounter Header window. See page 22.3 for more
information on editing the Encounter Header.

Face x Face Time This button opens the Encounter Face Time window so you can record the duration
of the visit. This is especially useful in session-oriented specialties.

The following buttons on the Encounter Face Time window allow you to record
multiple sessions for a single encounter and then submit the entries for billing.

 New Row: Click the New Row button to create a new entry.
 Start/Stop: When the session begins, click the Start button. When the session
ends, click the Stop button. The time will be entered into the comment area of
the Bill Builder. For those with MicroMD PM + EMR, the information is also then
passed to MicroMD PM Pending Charges and retained as a sequence note.

 Submit: The Submit button is only active when the Bill Builder window is
open. When selected, the data from the Encounter Face Time window will be
added to the Encounter Information Comment field.

 Close: This button closes the Encounter Face Time window and saves any
added or edited data.
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Research Tab
The Research tab includes research-related buttons. When you click the General Search, Latest News,
and Journal Articles buttons, the system automatically opens a drop-down menu associated with
selections you have made inside the encounter under Assessment.
For example, Dr. Davidson diagnoses a patient with a form of bronchitis and clicks the Latest News button
on the Research tab. A drop-down appears and he selects Bronchitis with airway obstruction to launch
a search on the Internet for the latest news on that form of bronchitis.

Figure 22.5 Research Tab of the Encounter Ribbon
Table 22.4 Buttons on the Research Tab of the Encounter Ribbon

Button

Description

General Search

When you select an encounter item from this task, the system launches a search
on the Google® web site using that text.

Frequently Used
Sites

The Frequently Used Sites button allows you to access frequently used Internet
sites. The system comes with a multitude of useful internet sites built into the
database. You can also add your own list of useful sites to the database. Click the
Frequently Used Sites button, and the system displays the Reference List
Viewer window for Internet sites. See page 7.2 for more details on using a
Reference List Viewer.

Latest News

22.14

○

Henry Schein Medical Systems does not endorse any
of the sites included in the database of internet sites.



The easiest way to use this feature is to click the
Index button and choose a category of web sites to
display. You can also add your favorites to your
Common List.

When you select an encounter item from this task, the system launches a search
on the web site using the selected text. The system uses the web site you select
from the Latest News drop-down in the Miscellaneous category under Tools >
User Preferences. If you have nothing chosen in your User Preferences
(page 1.84), the system uses medicalnewstoday.com by default.
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Table 22.4 Buttons on the Research Tab of the Encounter Ribbon (continued)

Button

Description

Medical Definitions

If you need to know the medical definition of a medication, you can select the
medications you prescribed in the encounter. The system launches a search
with that text on The Free Dictionary by Farlex web site (http://medicaldictionary.thefreedictionary.com/).

Journal Articles

When you select an encounter item form this task, the system launches a search
on the pubmed.gov web site using the selected text. This web site is a service of
the National Library of Medicine and the National Institutes of Health.

Highlighting in the Encounter Ribbon Bar
When you open an encounter, the system shows you that you have actions that you need to take or items
that you need to review. The system lights up the buttons on the Encounter Ribbon in red to indicate
actions you need to take. If the button is green, there is simply an item that exists for review.

Figure 22.6 Highlighted Button in Encounter Ribbon
The system highlights the following buttons:

 Refill Requests
This button is red when you have prescription requests on the encounter that you have not
approved or denied. When you click this button, it displays only those refill requests created
during the pre-encounter. Please see page 21.22 for more information on requesting and
processing prescriptions in an encounter.

 PHD
This button turns red if the patient submitted health data using the Patient Health Information
form through the Patient Portal. When you click this button, the system opens the Data
Reconciliation window so you can incorporate the patient’s new information into their chart.
See page 10.15 for details on reconciling data from an imported file. Please refer to the Henry
Schein Secure Chart Patient Portal User Guide for details on the portal.

 Impression
This button is green if impressions exist for the encounter. Click to open the Impression/ Finding
Note window. See page 22.53 for more details on Impressions.

 Encounter Notes
If an encounter has notes included, the system lights up the Encounter Notes button in green.
Click the button and select the name of the encounter note you would like to view. See
page 22.48 for more information on viewing and adding encounter notes.
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 Image Annotation
The system lights up this button in green if patient-specific documents were modified or
annotated while in an encounter. Click the Image Annotation button to open the annotated
image in MicroMD Document Management. For more information on using MicroMD Document
Management, refer to page 28.23.

 Test Results
This button is red if there are test results for the patient not marked as “viewed.” Click the button
to open the Test Results window and view the list of all the patient’s test results, regardless if
they are for tests ordered during the current encounter. The button turns green if one of the
results that was viewed was for a test requested for this encounter.
For example, Andy Homer came in with a sore throat and the nurse ordered a throat culture
automatically. That result is now back, along with a few others for last week’s visit about his
chest pains. The Test Results button is red. Dr. Davidson viewed all of the test results and since
one of those results was of today’s throat culture, the button turned green.

 Vital Signs
If there are vital signs recorded today for this patient, this button is green.

 Patient Education
This button is green if there are patient education materials associated with an assessment or
plan item selected in the encounter.

 Process Prescriptions
This button is red if you have not processed all the prescriptions within an encounter. The
system does not allow you to sign the encounter or send it to billing until you either print the
prescriptions or send them to the pharmacy electronically. For more information on processing
prescriptions, please see page 21.16.

 Quality Measures
This button is red if you have quality measures selected in your User Preferences, and this
encounter qualifies for the denominator and you have not met the requirements for the
numerator. Click the button to display the list of quality measures for which this encounter
qualifies. For more information on quality measures in an encounter, please see page 29.1.

 Face x Face Time
This button is green if recorded time exists for this patient in this encounter.

Descriptors Within an Encounter
Descriptors in an encounter allow you, as a person recording the visit, to qualify symptoms, signs and
diagnoses you enter into the system. This ranges from whether Mr. Homer’s current depression is normal
given the time of year or whether the phlegm little Bobby coughs up is green or brown in color.
You can highlight the item in the encounter area (e.g., Phlegm) and then click a descriptor (e.g., Amount).
The bottom of the window changes depending on the kind of descriptor you choose. For example, the
choices available to qualify the Size descriptor are different than the choices available for the Status
descriptor. Once you highlight a descriptor and enter a qualifier, the descriptor name turns bold.
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Figure 22.7 Descriptors in the Encounter Builder

Descriptor Common List
All of the descriptors have a Common List that you can use to minimize the choices displayed for that
descriptor. For example, you can limit the choices you see for the descriptor called COLOR to only those
qualifiers you use most often. If you have a Common List created, the system displays the Common List by
default when you highlight the descriptor. To view the entire list, simply click the All button.



You can tell which list of values the system has displayed
by the label on the button. If the label is bold, that is the
list displayed.
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Figure 22.8 Descriptor Common Lists
To edit the Common List for a descriptor, click the Modify icon ( ) next to the Common button (Figure
22.8). This opens the Encounter Descriptor Common List Builder window (Figure 22.9).

Figure 22.9 Common List Builder for Descriptors
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Simply drag and drop the items to the right side to select the items you want to see every time you
highlight that descriptor. You can double-click each item to move it back and forth, or use the arrow icons
in the center of the window. Click OK when finished.

Searching Your Descriptor Values
At the top of your list of descriptor values, there is a search field (Figure 22.10). If you have a large list of
values, you can begin typing in this field to find the value you want to choose. The system automatically
begins to filter your list of values as you begin to type. For example, if you begin to type the word “cold”, the
system begins to filter the list of values as soon as you type the letter “c” and filters even further when you
type the next letter “o”.

Figure 22.10 Searching Descriptor Values
To remove the filter, simply delete the text from the search field.

Customizing Descriptors
Any EMR user at your practice with the appropriate functions can manage these descriptor preferences
through the Descriptor Manager available through the Tools menu. This tool is available for those users
with the following user functions assigned to their user account.

 Edit Master Descriptor List: The Master Descriptor List allows you to change the order of the
descriptors available and the descriptor values available to all EMR users.

 Manage Item Descriptor Sets: The Item Descriptor Sets contain those descriptors that you want
available to all EMR users for individual symptoms, signs and diagnoses.

○

You should provide these functions only to a limited
number of users in your practice, preferably those in
authority.

Master Descriptor List
The Master Descriptor List allows you to customize the values used to qualify symptoms, signs and
diagnoses. By default, for example, the Descriptor category Precip. By for Symptoms contains the
values Alcohol and Chocolates. You need to add the value Alcoholism, and since your practice never
uses the value Chocolates, you want to remove it. The Master Descriptor List allows you to edit the list
accordingly. This ability is available to those users with the following function assigned to their user
account: Edit Master Descriptor List.



When you edit the values in the Master Descriptor List,
this changes the values available to all users in the
encounters.
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Figure 22.11 Master Descriptor List
To access the Master Descriptor List, select Tools > Encounter Tools > Descriptor Manager from the
main menu. Select Master Descriptor List from the drop-down (Figure 22.11).
The Master Descriptor List contains the lists of descriptors and values for use in encounters to describe
symptoms, signs and diagnoses. To edit the list, simply click the appropriate tab, highlight the
descriptor category in the Descriptors pane. The system displays the values available for that category
Values pane, as well as whether those values appear in the encounter as radio buttons or checkboxes.

 Click the Add and Delete buttons appropriately to edit each list to suit your needs. When you
delete an entry, the system prompts you to confirm. In this confirmation, the system also
provides you with the number of templates that contain the value you want to delete. If you
choose to go ahead and delete the value, the system removes the value from any templates.
The next time someone uses the template, the value is no longer available.

 To alphabetize the list of descriptor categories and/or values, simply click the a-z icon (

) at

the top of each pane. If you want to reorganize the descriptor categories and/or values,
highlight the entry you want to move and click the up or down arrow icons ( and ) as
appropriate. Be sure to click OK to commit your changes.

 If you want to control how all values within the selected descriptor display in the encounter, you
have two options: radio buttons or checkboxes.

- Radio buttons are mutually exclusive values. The person entering information in the
encounter can choose only one of the values within the same descriptor. For example, for
the descriptor called Severity, you may want to restrict the provider to selecting only one of
the following options: Severe, Moderate, or Chronic.

- Checkboxes allows the person entering information in the encounter to select multiple
values within the same descriptor. For example, for the descriptor called Precip. By, the
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provider could enter that the patient's breathing is precipitated by Climbing stairs,
Exercise, Heat, and Lying down.

○

Normal/Abnormal, Absent/Present, Positive/Negative,
and Yes/No options are built into the encounter as radio
buttons and cannot be added or removed. You can still
add other related options under the Norm/Abn descriptor
as either radio buttons or checkboxes.

Item Descriptor Sets
The Descriptor Manager also allows you to create a list of descriptors specific to a symptom, sign and/
or diagnosis. For example, for the sign of Bruise, we do not need all of the descriptor categories and
values available; we only need a few of the most common related to a bruise (Figure 22.12).

Figure 22.12 Item Descriptor Sets



Once you customize a symptom, sign or diagnosis, the
system moves all of the items you checked to the top of
the list to make it easier for you to see the existing list of
active values.

When you create a customized symptom, sign or diagnosis, MicroMD EMR displays that list by default
when you choose the symptom, sign, or diagnosis (Figure 22.14 on page 22.24). See page 22.22 for
more details.
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To remove the customization from a symptom, sign or diagnosis, simply highlight the entry in the Item
Descriptor Sets pane and click the Remove button.
To customize the descriptor list for a symptom, sign or diagnosis:

Procedure

Details

1. Select Tools > Encounter Tools >
The Descriptor Manager window opens (Figure
Descriptor Manager from the main menu. 22.11 on page 22.20).
2. Select Item Descriptor Sets from the dropdown list.
3. Click the appropriate tab.

For example, if you want to create a customized
list for a sign, click the Signs tab.

4. In the Item Descriptor Sets pane, click the
New button.

The appropriate Reference List window opens.

5. Locate the symptom, sign or diagnosis you
want to use and click Insert.

The system adds the item to the Item Descriptor
Sets pane.

6. Highlight the entry in the Item Descriptor
Sets pane.

The system populates the Descriptors pane with
the available categories for the symptom, sign or
diagnosis.

7. Place a check mark next to each of the
descriptor categories you want to view for
the symptom, sign or diagnosis.

8. Highlight one of the checked entries in the
Descriptors pane.
9. Place a check mark next to each of the
values you want to view for the symptom,
sign or diagnosis.



Click the Show All and Hide All
buttons to help you quickly mark and
unmark multiple checkboxes.

The system populates the Values pane with the
values listed in the Master Descriptor List for that
category.



Click the Show All and Hide All
buttons to help you quickly mark and
unmark multiple checkboxes.

10. Click OK when satisfied.

Add a Value
In the Descriptor Manager under Item Descriptor Sets, practices can add new descriptor values per
individual symptom, sign and diagnosis. For example, Summervale Medical Center wants to include
another color option ONLY for the sign of Bruise. They want to add “Greenish Brown” to the list.
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Figure 22.13 Item-Level Descriptors

○

Only a user with the Manage Item Descriptor Sets user
function on their user account can make changes to this
section of the Descriptor Manager.

To add a value to a descriptor for a symptom, sign or diagnosis, make sure you have the Item Descriptor
Sets selected in the drop-down of the Descriptor Manager (Figure 22.13). On the appropriate tab, either
select an Item Descriptor Set or add a new one.
In the Descriptors pane, highlight the descriptor for which you want to add a value. In the Values pane,
click the Add button and type the name of the value you want to create and press the Enter key on your
keyboard. The system adds the new value.

○

You can distinguish user-defined values from system
values by the text color. User-defined values are blue, and
system values are black.

Delete a Value
You can delete any user-defined value from the system. Simply highlight a value (identified by blue text)
and click the Delete button. If there are one or more templates with the descriptor value included, the
system warns you how many templates are affected by this deletion. This gives you the opportunity to
cancel the action if necessary.

Symptom-, Sign- and Diagnosis-Specific Descriptors
The custom descriptor list works the same regardless of the encounter recording tool you use. If there is a
Item Descriptor Set established for a certain symptom, sign or diagnosis (e.g., customized list for the sign
Bruise), the system enables several buttons for you on the window (Figure 22.14).
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Figure 22.14 Options for Descriptors
The plus sign icon ( ) next to the Descriptors section allows you to expand the list to show all of the
available categories. The plus sign changes to a minus sign ( ). Click the icon again to collapse the
descriptors the list again.
To add/edit descriptors for an entry while in the expanded view, simply right-click the entry and select
Field Details from the drop-down menu. This displays the details window that includes the appropriate
descriptors.
The system also adds a Sympt. Specific, Sign Specific, or Diag. Specific button in the values area,
depending on where you are in the encounter. Click this button to display only those values marked in the
Item Descriptor Sets of the Descriptor Manager (page 22.21) for the symptom, sign, or diagnosis.

Viewing a Summary of Existing Encounters
The Summary tab of the patient’s chart allows you to view brief information about existing encounters,
while the Encounter tab allows you to view extensive details about an individual encounter. The tab
displays the date the encounter was recorded, who recorded it, the chief complaint, the diagnosis and
more (Figure 22.15).



Hover your cursor over an encounter in the list to display
header information from that encounter (if available).

Summary List
The Summary tab displays a list of the patient’s encounters and pre-encounters, including bits of clinical
information. You can filter this list by the provider who created the encounter (page 22.25), and you can
sort the list by each of the columns. By default, the system displays the list of encounters chronologically
with the most recent encounter at the top of the list. Double-click any encounter to see the details of the
encounter in the Encounter tab of the patient’s chart.
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Figure 22.15 Summary Tab of a Patient’s Chart
Each encounter in the summary list displays a maximum of one complaint, assessment and medication
that was recorded. The plus sign icon ( ) next to an entry indicates that more than one complaint,
assessment or medication was recorded in the encounter.
If you choose the Summary Expanded option in the Chart Navigator section on the left, the system shows
all the recorded entries, listing all medications and/or plans from the encounter and identifying
medications with an (M) and plan items with a (P).
The Status column indicates the current state of the item (e.g., if the encounter was signed or an
attachment still needs to be reviewed).

○

One-line summaries of encounter revisions (page 22.34)
appear in green text. One-line summaries of co-signed
encounter revisions appear in magenta text.

Patient Activity
The Summary tab of the patient’s chart provides you with a chronological view of the patient’s
encounters, as well as other activities that occur outside of the encounter (e.g., phone messages and
internal mail). While the workflow communicator lists these items by type, the Summary tab can list all
activities by date and present the provider with an idea of what has happened with the patient since their
last visit.

Encounter List Filter
The Summary tab of the patient’s chart displays a list of all the patient’s encounters in your practice,
regardless of the provider who created the encounter. You can filter that list to display encounters by a
number of criteria.
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Click the Filter button to open the Summary Filter window (Figure 22.16). This allows you to filter the list of
records according to a number of criteria, including (but not limited to) encounter details and patient
activities. The Reset button clears the choices made under the Filter button.

○

You can find the defaults for this window in the Chart
Summary Options section of your user preferences
(under Tools > User Preferences).

Figure 22.16 Summary Filter
When you click one of the drop-downs, the system displays a dynamic list of options (Figure 22.17). The
system defaults the drop-downs of each field to show items in descending order according to the number
of occurrences and displays that number next to the description of each item. To show the list
alphabetically, click the sort A-Z link a the top. Place a check mark next to each item by which you want to
filter the list of encounters.

Figure 22.17 Dynamic Drop-down Options
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For example, Dr. Davidson wanted to see a list of encounters where Andy’s chief complaint was shortness
of breath. In the Encounter Summary Filter window, he clicked the drop-down next to the Chief Complaint
field. The drop-down window included Shortness of breath as a complaint that was used in past
encounters. He placed a check mark next to Shortness of breath and clicked OK. The encounter list
displayed only those encounters, making it easy for Dr. Davidson to review them and provide Andy with
even more quality of care.

Print and Export the Encounter List
You can print the list of encounters currently displayed and export that list to an external file. To print the
currently displayed list of encounters, simply click the Print button (Figure 22.15 on page 22.25).
To export the currently displayed list of encounters to an external file:

Procedure

Details

1. Click the Print button.
2. On the Print Options window, click the
Preview button.

The Print Preview window opens.

3. Select File > Export from the main menu.

The Save As dialog window opens.
4. Navigate to the location where you want to
save the file created.
5. Type a name for the file in the File name field.
6. Choose the type of file you want to create
from the Save as type drop-down.



The most common files to create are
CSV files and Microsoft® Excel files.

7. Click Save.

Patient Documents Icon
The documents icon ( ) on the Summary tab (Figure 22.15 on page 22.25) provides you with access to
MicroMD Document Management. When you click the documents icon, the system opens the search
window in the document management system and defaults to the patient’s folders (Figure 22.18).
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Figure 22.18 MicroMD Document Management from Summary Tab
For example, Dr. Davidson wants to see only those documents added to Andy Homer’s chart yesterday.
The results from Andy’s X-ray came in yesterday. Dr. Davidson clicks the documents icon ( ) and selects
Yesterday from the Service Date drop-down. When he clicks the Search button, the system displays all
documents with yesterday’s date.
For more details on using this window, please see page 28.25.
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Patient Overview
The Patient Overview option allows providers to display a Clinical Dashboard view of the patient’s chart
(Figure 22.19). This view provides each provider the opportunity to create their own summary of a patient’s
chart, containing only the data they want to review.

Figure 22.19 Patient Overview Window
The Patient Overview uses the Clinical Dashboard as the basis of its display. If you want to see the patient's
information using a different Dashboard template, you can click the Lookup icon ( ) next to the
Template field to choose the template.
To tell MicroMD EMR which template you want to display in this section by default, choose the template
from your User Preferences. Select Tools > User Preferences from the main menu. In the Chart
Preferences category, click the Lookup icon ( ) next to the Patient Overview Dashboard field and
choose the template you want to use.
See page 27.2 for more information for more information on the Clinical Dashboard.



If you would like to see the Summary tab view every time
you open a patient chart, select Tools > User
Preferences from the main menu and, in the Chart
Preferences category, select Summary from the Open
chart to drop-down.
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Change History
The Change History on the Summary tab displays changes made to the encounters in general or if
someone prints the list of encounters on the Summary tab. If a user creates a new encounter, edits an
existing encounter, or deletes an encounter, the system records the user and when they performed the
action. Choose the Change History option on the Summary tab to view the list of actions performed
against the patient’s encounters.

Figure 22.20 Summary Tab Change History
The system displays a list of all changes to the patient’s information, with the most recent change at the
top of the list. The following columns make up the change history for the Summary tab:

 The Action By column includes which user modified the information or completed an action.
 The Date column includes a date and time stamp for when the change or action was made.
 The Encounter Descriptor column in this section includes the encounter number, the user for
whom the encounter was created, and a timestamp that reflects when it was created. This helps
you locate the correct encounter.

 The Action Details column includes a brief description of the change or action.
Displaying Non-Clinical Encounter Information
While on the Summary tab, MicroMD EMR also allows you to see the non-clinical information recorded for
any encounter. The non-clinical information includes the encounter date, time, type, and nature of the
encounter. Highlight the encounter on the Summary tab and select Edit > View Encounter Information
from the main menu. You can also click the View Encounter Information icon ( ) on the top toolbar.
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Figure 22.21 Encounter Properties
You cannot change any of the information in the dialog box. For details on how to change any of the
clinical or non-clinical information in an encounter record, please see page 22.36.

Viewing Details of an Existing Encounter
The Encounter tab of the patient’s chart allows you to view extensive details about an existing encounter,
while the Summary tab allows you to view a brief information about the encounters. The Encounter tab
displays a single encounter at a time.

Encounter Details
The Encounter tab of the patient’s chart displays details of any recorded encounter. The format in which
the system displays the encounter on this tab depends on the tool used to record the encounter. For
example, if you used a Form Encounter, the system displays the first page of the form on this tab for that
encounter. If you used a Text Encounter for a different encounter, the system displays the information from
the encounter as text on this tab when you view that encounter.

○

The Encounter tab lets you only view the details of an
encounter. You cannot use the Encounter tab to directly
edit any encounter details. You must click the Edit button.
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Figure 22.22 Encounter Tab of a Patient’s Chart
The top portion of the tab provides the Encounter Header information. You can also view the patient’s vital
signs recorded on the date of the encounter. If none were recorded on that date, the area on the tab is
blank. Click the Vital Signs icon (
) to add, edit or delete vitals. See page 13.10 for more details on
working with patient vitals in the system.
The two buttons on the top right of the tab allow you to sign the encounter (page 24.15) or edit/view the
encounter. See the appropriate section for the tool used to record the encounter if you need information
about editing an encounter.

○

Depending on the tool you used to create the encounter,
MicroMD EMR can display the details either in discrete or
text format, based on your Encounter Display user
preferences setting (page 1.88). You can also change this
view on a case-by-case basis using the options in the
Chart Navigator section.

Navigating Encounter Records
When you use the Encounter tab of a patient’s chart to view the details of an encounter, you can scroll
through all the patient’s encounter records. You use the Previous Encounter icon ( ) on the top toolbar
to scroll to the encounter(s) chronologically before the current encounter displayed. The Next Encounter
icon ( ) scroll to the encounter(s) chronologically after the current encounter displayed. The Current
Encounter icon ( ) takes you to the most recent encounter in the list.
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Managing Encounter Vital Signs and Statistics
The system provides several methods of recording and managing vital signs. For in-depth details, please
see page 13.10.

Copying and Deleting Encounter Records
MicroMD EMR allows you to copy existing encounters to use as a basis for the one you want to record. You
can also delete an encounter you entered as long as it’s not signed.



Please see page 22.34 for details on revising an existing
encounter.

Copying an Encounter Record
MicroMD EMR allows you to make a copy of an existing encounter and use that copy as a “template” for a
new encounter.
For example, Dr. Webb visits with Andy Homer every week for his cancer treatment. Today’s visit is almost
identical in documentation to Andy’s previous encounter. To record today’s encounter, Dr. Webb makes a
copy of the previous encounter and edits the copy according to how Andy presents today.

○

You can create a copy of an encounter for which you are
responsible or for any other encounter. You can make a
copy of an encounter before or after the encounter is
signed.

To copy an encounter from the Desktop:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Highlight the encounter you want to copy.
4. Select Edit > Copy Encounter from the main
menu.

The system creates a copy of the selected
encounter in the patient’s chart and inserts the
current date and time into the encounter record.
You can now edit the encounter as needed.

Deleting an Encounter Record
If an encounter or pre-encounter has been erroneously entered into a patient’s chart you can delete the
encounter. You cannot delete an encounter after you have signed it.

○

Only the provider for whom the encounter was created
can sign off on the encounter (unless co-signing is in
place).
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To delete an encounter:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Highlight the encounter you want to delete.
4. Select Edit > Delete Encounter from the main
menu.

The system removes the encounter from the
patient’s chart.

Revising an Encounter Record
After an encounter is signed (and co-signed, if applicable), you cannot edit the information in the
encounter record. If you need to edit the information in that specific encounter after it has been signed,
you create a Encounter Revision. You can then modify the Encounter Revision as needed.

○

You can create up to 10 revisions of an encounter, based
on the practice’s choice in the Max revisions per signed
encounter option under System Settings (page 1.35).

Figure 22.23 Encounter Revisions
On the Summary tab of the patient’s chart, Encounter Revisions appear as separate encounter entries but
display with green text. The R column on the Summary tab indicates how many revisions the encounter
has gone through.
On the Encounter tab, when displaying the original encounter for which there is a revision, the system
displays a link in the header of the encounter. This indicates to you that an Encounter Revision exists and
provides the date of the revision. Click the link to open the Encounter Revision.
When displaying the Encounter Revision, the system displays a link in the header of the revision. This
indicates to you that this is an Encounter Revision and provides the date of the original encounter. Click
the link to open the original encounter.

○

22.34
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To create a revision of an encounter record:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Find the encounter you want to revise.
4. Select Edit > Create Revision from the main
menu.

The system adds the Encounter Revision to the
patient’s list of encounters.
You can also right-click and select Create Revision
from the pop-up menu.

5. Revise the encounter as needed.

Editing an Encounter
There are two types of information you can edit in an encounter, provided you are the one who created the
encounter and you have not signed it yet. You can edit the clinical information in the encounter (e.g.,
assessments, symptoms), or you can edit the information in the encounter header (e.g., encounter level,
personnel involved with the encounter).

○

The system locks the encounter when one user already
has it open for editing.

Editing Clinical Information
When you make changes to an encounter record, you use the same tool that you used to originally record
the encounter. For example, if you originally recorded the encounter using the Encounter Wizard, then you
use the Encounter Wizard to make changes.

Figure 22.24 Edit Button on Encounter Tab
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To modify the clinical information in an encounter record:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Find the encounter you want to edit.
4. Right-click and select View Encounter
from the pop-up menu.

The system opens the encounter and switches to the
Encounter tab in the patient’s chart.
You can also double-click the encounter on the
Summary tab. On the Encounter tab, you can also
use the navigation buttons in the top toolbar to scroll
back and forth through encounters.

5. Select Edit > Edit Encounter from the
main menu on the Encounter tab.

You can also click the Edit button on the Encounter
tab (Figure 22.24).
The system opens the encounter using the same tool
used to create the encounter and allows you to make
changes as needed.

Editing the Encounter Header
If you want to change the information in the Encounter Header and you have not signed the encounter yet,
you can do so simply. All changes to the unsigned encounter are tracked through the Change History.
To change encounter header details:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Find the encounter whose header you want
to edit.
4. Right-click and select View Encounter from
the pop-up menu.

The system opens the encounter and switches to
the Encounter tab in the patient’s chart.
You can also double-click the encounter on the
Summary tab. On the Encounter tab, you can also
use the navigation buttons in the top toolbar to
scroll back and forth through encounters.

5. Select Edit > Edit Encounter Header from the
main menu on the Encounter tab.

The Edit Encounter Header dialog opens, identical
to the New Encounter window (Figure 22.1 on page
22.3).

6. Edit the information as needed and click OK.
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Change History
Whenever anyone makes any changes to an encounter, the system tracks these actions in the Change
History found on the Encounter tab. To access the change history, click the Change History link in the
Chart Navigator (Figure 22.25). Anytime a user views the encounter, the system records their name and the
date/time they viewed the encounter. The system also records every detail of an encounter, when it was
changed and by whom. The Changed From column displays the original data, while the Changed To
column reflects the data that the system currently now holds for that patient. You can use the From and To
drop-downs to review each set of changes on the encounter.

Figure 22.25 Encounter Tab Change History
The system color codes the text:

 Red text: Text in red was removed from the system.
 Blue text: Text in blue was edited.
 Green text: Text in green is data that was added to the system.
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Minimizing Encounters
When working with encounters, you can minimize an encounter so you can access other areas of the
system while creating or editing an encounter. For example, Betty knocks on the door while Dr. Davidson is
with patient Andy Homer to ask him to print the admission authorization for the previous patient whom he
just sent to the hospital. Dr. Davidson can minimize Andy’s encounter and access the rest of the system.

Figure 22.26 Minimizing the Encounter
When you click the Minimize button (Figure 22.26), the system puts the encounter into the Holding Area
(Figure 22.27). To open an encounter in the Holding Area, simply click the Holding Area icon ( ) and
select the patient’s encounter you want to open.

Figure 22.27 Encounter Holding Area

Pick Lists
A Pick List is like a drop-down field. These fields help you when you’re creating templates for Text
Encounters, Form Encounters, and other forms in the system. You can use the same Pick List in a variety of
templates. MicroMD EMR comes with a standard set of Pick Lists you can use. You can also add new Pick
Lists and edit any user-defined Pick Lists. You cannot edit or delete a standard Pick List, and you cannot
delete a user-defined Pick List.

○

When you make a change to the entries in a Pick List, the
system makes the change to all instances of the Pick List.

For example, a Pick List called Pain Severity may include the following options: Intense, Moderate and
Slight. The Pain Severity Pick List appears in the encounter template surrounded by arrows and
highlighted (Figure 23.14 on page 23.23).
When you click the <<Pain Severity>> field in an encounter based on this template, the system displays the
options available: Intense, Moderate, Slight. You can select the appropriate one for the patient.
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Types of Pick Lists
You can create your own Pick Lists or you can use those that come standard with MicroMD EMR. When you
create your own Pick List, you must specify the kind of data you want to appear in the list. You can create
lists that contain your own text or you can create lists using the discrete data in the system. (See page 22.41
for more details on creating a new Pick List.)

Figure 22.28 Pick List Types
You indicate which way you want to create a new list using the Type drop-down. You can select Free Text (a
list containing your own text) or one of the discrete data categories (e.g., Medication, Review of Systems,
Subjective). For example, if you select the Medication Pick List type, you can select medications from the
database and include them in the Pick List, displaying only the ones you want to make available for choice
in the encounter or form.

Displaying the List of Existing Pick Lists
You use the Form template, the Text template or an Administrative Form template to display the list of Pick
Lists that exist in your database. From these areas, you can create new Pick Lists or edit existing userdefined lists. You can access the Pick Lists in your system for:

 Form Encounter template: Select Tools > Encounter Tools > Form Encounter Templates from
the main menu. Click the New button and add the Pick List (User-defined) control to the design
area. Click the Lookup icon ( ) next to the Pick List field. This opens the Pick Lists Reference
List Viewer window. (For more in-depth details on creating a new Form Encounter template, see
page 23.42.)
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Figure 22.29 Pick List from Form Template

 Text Encounter template: Select Tools > Encounter Tools > Text Encounter Templates from
the main menu. Click the New button and click the Pick Lists tab at the bottom. This displays
the Pick Lists in the system. (For more in-depth details on creating a new Text Encounter
template, see page 23.37.)

Figure 22.30 Pick List from Text Template
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 Administrative Form template: Select Tools > Administrative Form Templates from the main
menu. Click the New button and add the Pick List (User-defined) control to the design area.
Click the Lookup icon ( ) next to the Pick List field. This opens the Pick Lists Reference List
Viewer window.

Creating New Pick Lists
MicroMD EMR comes with a standard set of Pick Lists. You can add new Pick Lists and edit any of the
existing user-defined Pick Lists. When you create a new Pick List, the Pick List can be accessed and edited
by all MicroMD EMR users.



You cannot delete any existing Pick List—neither userdefined nor standard. So be sure you want to create a
new one.

To create a new Pick List:

Procedure

Details

1. Display the list of Pick Lists in your system
through the Form template, the Text template
or the Administrative Form template.

See page 22.39 for more information on how to
view the existing Pick Lists.

2. Click the New button.

The New Pick List window opens (Figure 22.28 on
page 22.39).

3. From the List Type drop-down, select the kind
Pick List you want to create.
4. In the List Name field, enter a descriptive
name for the new list.

This is how you distinguish this Pick List from the
others in your system.
If you select <<Free Text>> from the List Type dropdown, proceed to step 5. If you select a discrete
data category (e.g., Medication), skip to step 9.

Creating a Free-Text Pick List
5. Click the Add button.

The Add New Pick List Item dialog box opens.

6. In the Field Name field, enter the text you want
to appear in the drop-down of the Pick List the
user sees and click OK.
7. Repeat step 5 and step 6 for each entry you
want to add to the Pick List.
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Procedure (continued)

Details (continued)

8. Click OK when satisfied with the new Pick List.

Creating a Discrete-Data Pick List
9. Click the Add button.

The appropriate Reference List Viewer window
opens.

10. Locate the item you want to appear in the
drop-down of the Pick List the user sees.
11. Click Insert.
12. Repeat step 10 and step 11 for each entry you
want to add to the Pick List.
13. Click Close to exit the Reference List Viewer
window.
14. Click OK when satisfied with the new Pick List.

CliniGuide
A CliniGuide is a tool that helps you record an encounter with the Encounter Builder and the Encounter
Wizard. When you use one of these encounter recorders, you can load a CliniGuide to make your session
faster. You can also build a CliniGuide into an Encounter Wizard template. You add CliniGuide templates to
the current encounter using the Load Template button in the Encounter Ribbon (Figure 22.31).

Figure 22.31 Loading a CliniGuide Template
You can use a CliniGuide in two ways: to document by exception or as a guide to the selections you need to
review. You also have the ability to pre-populate answers, allowing you to document by exception. In this
case, the system inserts the data into the encounter record—unless you delete or modify items. Instead of
a yellow question mark icon, MicroMD EMR places a white note icon to the left of each entry.
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Figure 22.32 Options from a CliniGuide Template
For example, a patient presenting with otitis media almost always presents with the same symptoms and
signs. The assessment is almost always the same diagnosis code, and your instructions or plan for such a
patient is almost always the same. You could create a CliniGuide specific to the majority of your otitis
media cases and then document only by exception. You could also create a CliniGuide for:

 All new patients to the practice
 Women over the age of 50
 Every follow-up visit for juvenile diabetics
When you create a CliniGuide, MicroMD EMR places a yellow question mark icon ( ) to the left of each
entry. When you load this CliniGuide into the Encounter Builder or Encounter Wizard, the same yellow
question mark icon appears next to the entry. This indicates that there are questions that you should
answer. Once you address the item and enter at least one qualifier for a descriptor, the system changes the
yellow question mark to a white note icon (

).

○

If you do not specify at least one qualifier for an entry (i.e.,
the entry still has a yellow question mark icon to its left
when you sign the encounter), the system does not record
that entry as part of the encounter after you sign it.

○

To remove a defined data item from the encounter after
you apply a CliniGuide template, simply highlight the item
and click the Delete icon ( ).

Standard CliniGuides
CliniGuides, just like other templates, have Personal, Shared and Standard folders. The standard
CliniGuides installed with MicroMD EMR are based on CMS guidelines. For more details on working with
items in the Personal, Shared or Standard folders, please see page 2.8.
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Creating a New CliniGuide
When you create a new CliniGuide, you can save the CliniGuide as either a personal guide or a shared
guide, depending on the roles and functions that you have been assigned. You cannot save the CliniGuide
as a standard guide. For more details on working with items in the Personal, Shared or Standard folders,
please see page 2.8.

Figure 22.33 Example CliniGuide Data
To create a new CliniGuide:

Procedure

Details

1. Select Tools > Encounter Tools >
CliniGuides from the main menu.

The CliniGuide Manager window opens and lists all
your personal CliniGuides.

2. Click the New button.

The CliniGuide Builder window opens and displays
the Subjective/HPI tab. The CliniGuide Builder
works in a manner similar to the Encounter Builder
(page 23.2).
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Details (continued)

3. Drag and drop (or double-click) the item you
want to include on this tab of the CliniGuide
over to the right side of the builder.

○

4. Right-click each descriptor for the symptom
and select Create as a question from the
pop-up menu.

To change the whole item to a
question that will not save in the
encounter unless purposely
changed, right-click the item on the
right side and select Mark Item as
Question from the pop-up menu.

The selected descriptors for each symptom change
from black text to green underlined text.

5. Repeat step 3 and step 4 for each item you
want to include and for each tab you to
specify in this CliniGuide.
6. Click OK when satisfied with the entire
CliniGuide.

The Save CliniGuide window opens.

7. In the Name field, enter a useful title for your
CliniGuide.

This name is how you distinguish the CliniGuides
from each other when you want to use one.

8. Choose the folder in which you want to save
the template.

You can choose either Personal (available only to
you) or Shared (available to multiple users). See
page 2.8 for more detailed information on Personal,
Shared and Standard folders.

9. Click OK.

The system adds the new CliniGuide to the folder
you chose.

Using a CliniGuide
To use a CliniGuide to assist you to record an encounter, you load the CliniGuide into the Encounter
Builder or the Encounter Wizard. When you create a template for the Encounter Wizard, you can also
specify that the Encounter Wizard automatically load one or more CliniGuides whenever someone uses
the template. (See page 23.20 for more details on Encounter Wizard templates.)
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Figure 22.34 Loading a CliniGuide
When you load a CliniGuide, MicroMD EMR copies data from the CliniGuide into the tabs of the Encounter
Builder. For the Encounter Wizard, the EMR will copy these areas if those areas are included in the wizard
setup. Loading a CliniGuide is a cumulative process. When you load a CliniGuide, the CliniGuide adds to
any existing information in the Encounter Builder or Encounter Wizard. It does not overwrite existing items
and does not repeat any items that already exist.



You can load more than one CliniGuide into the
Encounter Builder or into the Encounter Wizard.

When you load a CliniGuide into the encounter, you can also choose to load only specific elements of a
CliniGuide if you want (page 22.47).

Figure 22.35 Load a CliniGuide Template into an Encounter
To use a CliniGuide:

Procedure

Details

1. Begin your new encounter using the
Encounter Builder.

See page 23.2 for in-depth details about using the
Encounter Builder.

2. Click the Load Template button on the
Encounter tab of the ribbon bar.

The system displays the Load CliniGuide window.
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Procedure (continued)
3. Highlight the CliniGuide you want to use and
click Load.

Details (continued)



Begin typing the name of your
CliniGuide in the Name field to
search your list of templates.

The system populates the Encounter Builder with
the choices established in the CliniGuide. There are
yellow question mark icons ( ) next to each entry
that came from the CliniGuide.
If you choose to load only specific elements of a
CliniGuide into your encounter, click Select before
Load (page 22.47).
4. Highlight an entry that displays the yellow
question mark icon ( ) to its left.

The descriptors that the CliniGuide suggests you
address are in green text and underlined (Figure
22.33 on page 22.44).

5. Click the descriptor and enter appropriate
qualifier(s).
6. Finish recording your encounter, repeating
step 4 and step 5 for each item that came
from the CliniGuide.

○

The yellow question mark icon ( )
changes to a white note icon ( )
each time you enter a qualifier for an
item. At the end of your encounter,
the system only keeps those entries
with the white note icon.

Loading Only Certain Elements of a CliniGuide
When you load a CliniGuide, you can load the entire guide or only certain elements of the guide. Instead of
clicking Load, you click Select before Load. Place a check mark in the Include column for each item you
want and then click Finish.

Figure 22.36 Editing a CliniGuide Before Loading
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You can also address each of the items in the CliniGuide before you load it into the encounter. Simply
make the appropriate choices in each step of the CliniGuide and then click Finish.



The Set All button allows you to mark descriptors en
masse for the CliniGuide before you load it.

Attaching Notes to an Encounter Record
MicroMD EMR allows users to attach, edit or delete notes from the encounter record. As you sit with the
patient or review their chart later, you can enter general notes about this visit, or you can add notes to
individual entries on the patient’s encounter to further document the visit.

Figure 22.37 Encounter Note Window
MicroMD EMR allows you to attach two types of notes to encounter records either when you record the
encounter or after recording the encounter:

 General encounter note
You can add general notes to an encounter even after you sign the encounter.

 Note on a specific SOAP item (e.g., a note on a patient’s symptom)
You cannot add notes to a specific SOAP item after you sign the encounter. Once you sign the
encounter, you can only view item notes.

Attaching a General Encounter Note
The system provides an area on the Encounter tab of a patient’s chart that displays the general notes
associated with the encounter. These are notes relating to the encounter as a whole, not linked to a
specific item. Any provider who views the encounter can add general notes. This is useful for physicians
who share patients.
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Figure 22.38 General Encounter Notes
To attach a general note to an encounter:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Find the encounter to which you want to
add a note.
4. Right-click and select View Encounter from
the pop-up menu.

The system opens the encounter and switches to
the Encounter tab in the patient’s chart.

5. In the Chart Navigator section on the left,
click the Encounter Note task.

The Note window opens (Figure 22.37 on page
22.48).


6. In the Title field, type a useful description for
the encounter note or choose a title by
clicking the drop-down next to the field.

The system lists any existing notes
for the encounter under Encounter
Note task.

This text appears in the list under the Encounter
Note task and helps you distinguish multiple notes
from one another.

7. Enter the details of your encounter note.
8. Click OK to close the Note window.

The system adds the note to the list in the Chart
Navigator section.

Viewing a General Encounter Note
If you have already signed the encounter or you did not create the encounter, you cannot edit a note
attached to an encounter. However, you can view the note.
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To view a general note attached to an encounter record:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Find the encounter that contains the note you
want to view.
4. Right-click and select View Encounter from
the pop-up menu.

The system opens the encounter and switches to
the Encounter tab in the patient’s chart.

5. In the Chart Navigator section on the left,
click the appropriate note under the
Encounter Note task.

The Note window opens (Figure 22.37 on page
22.48).

6. Click the appropriate tab to view the details of
the note.
7. Click OK to close the Note window.

Deleting a General Encounter Note
You can delete a note you created on one of your encounters only before you sign it. Once you sign the
encounter, you cannot make any changes to the note or delete it from the encounter.

○

The owner of the encounter note may still delete the
encounter note even after the encounter has been signed.

To delete a general note attached to an encounter:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Find the encounter that contains the note you
want to view.
4. Right-click and select View Encounter from
the pop-up menu.

The system opens the encounter and switches to
the Encounter tab in the patient’s chart.

5. In the Chart Navigator section on the left,
click the appropriate note under the
Encounter Note task.

The Note window opens (Figure 22.37 on page
22.48).

6. Click the Delete button.

The system confirms that you want to delete
everything from the note and exits the note.
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Attaching a Note to a SOAP Item in an Encounter
If you used either the Encounter Wizard or the Encounter Builder to record an encounter, you can attach a
general note to the encounter as a whole or a note specific to a particular SOAP item within the encounter.

○

When you add a note to a SOAP item, the white note icon
( ) to the left of the entry changes to a yellow note icon
( ).

Figure 22.39 Adding a Note to a SOAP Item
To attach a note to a specific SOAP item in an existing encounter record:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Find the encounter that contains the SOAP
item to which you want to add a note.
4. Right-click and select View Encounter from
the pop-up menu.

The system opens the encounter and switches to
the Encounter tab in the patient’s chart.

5. Click the Edit button.
6. Select the appropriate encounter tab.
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Procedure (continued)
7. Click the white note icon (
appropriate SOAP item.

Details (continued)
) next to the

8. In the Title field, type a useful description for
the encounter note or choose a title by
clicking the drop-down next to the field.

The Note window opens.

The system defaults the title to the name of the
SOAP item.

9. Enter the details of your encounter note.
10. Click OK to close the Note window.

The system changes the note icon from white to
yellow.

Viewing a Note Attached to a SOAP Item
If you have already signed the encounter or you did not create the encounter, you cannot edit a note
attached to a SOAP item in the encounter. However, you can view the note.
To view a note attached to a SOAP item in the encounter:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
3. Find the encounter that contains the note you
want to view.
4. Right-click and select View Encounter from
the pop-up menu.

The system opens the encounter and switches to
the Encounter tab in the patient’s chart.

5. Find the item with a yellow note icon (
click the icon.

The Note window opens (Figure 22.37 on page
22.48).

) and

6. Click OK to close the Note window.

Deleting a Note Attached to a SOAP Item
You can delete a note you created on one of your SOAP items only before you sign the encounter. Once
you sign the encounter, you cannot make any changes to the note or delete it from the encounter.
To delete a note attached to a SOAP item in an encounter:

Procedure

Details

1. Open the patient’s chart.

See Chapter 10 for details on working with charts.

2. Click the Summary tab.
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Procedure (continued)

Details (continued)

3. Find the encounter that contains the note you
want to view.
4. Right-click and select View Encounter from
the pop-up menu.

The system opens the encounter and switches to
the Encounter tab in the patient’s chart.

5. Find the item with a yellow note icon (
click the icon.

The Note window opens (Figure 22.37 on page
22.48).

) and

The system confirms that you want to delete
everything from the note and exits the note.

6. Click the Delete button.

Impressions in an Encounter
There are times when a physician needs to write free text to better document the patient’s visit, as well as
discuss the differential diagnosis. On the Assessments tab of the encounter, the physician can type his or
her overall impression of the patient’s visit. The system displays the Impressions button on the Encounter
Ribbon in green when there is impression text. You can click this button at any time to add an impression
or view/edit the existing impression. Please see page 22.7 for more details about the Encounter Ribbon.

Figure 22.40 Impressions in the Encounter
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Patient Care Plan
The Patient Care Plan (also called a “Visit Summary”) is a document prepared after an encounter for the
patient to take home with them as a tool they can use to better manage their health. It is a review of the
care they received that day, along with other important information from their chart to take away from
their visit.

Figure 22.41 Patient Care Plan from Encounter Ribbon
You can provide the patient with the Patient Care Plan from the Administration tab of the Encounter
Ribbon (Figure 22.41). You have several options in the drop-down:

 Print: From this option, you can print the document to an office printer.
 Message Only: With this option, you can open a message editor and send a secure message to
the patient through their Patient Portal account.

 Document: This option allows you to publish the Patient Care Plan to the patient’s account on
the MicroMD Patient Portal. You can choose the same sections as when you print the care plan,
but you also have the option to include the patient’s electronic chart (C-CDA) and edit that CDA
before you send it.

 Do Not Publish: If you decide that the information does not need to be shared with the patient
on the Patient Portal, you can select this option.



You can also access the Patient Care Plan from the
Scheduled Visits section of the Desktop (page 4.32). The
Patient Care Plan button in the Scheduled Visits
section is enabled only when there is an encounter
created for that appointment.

When you click the Patient Care Plan button on the encounter ribbon, the system displays the Chart
Report window (Figure 22.42). The Patient Care Plan Options allow you to include extra information in the
patient’s document, in addition to the sections included by default. To include any of the extra sections,
simply place a check mark next to the option you want to provide the patient. Table 22.5 on page 22.56
explains the options in more detail.
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Figure 22.42 Patient Care Plan Options



The system remembers the choices you made the last
time you generated a plan and automatically makes
those choices for you.

By default, the system automatically includes the following medical information on the Patient Care
Plan document:

 Most recent vital signs entry
 Diagnosis resulting from the visit
 Medications prescribed during the visit
 List of all current medications as of this visit
 List of any medication allergies
 Diagnostic tests/procedures that were performed or ordered during the visit
 Patient instructions from the encounter

Figure 22.43 Patient Care Plan
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○

Patient Care Plan

If the patient does not have data in a particular section of
the encounter (e.g., no immunizations or no medications),
the system does not include the empty section in the
document.

Table 22.5 Additional Options for the Patient Care Plan Document

Field

Descriptions

Include Next
Appointments

You can choose to include a list of the patient’s upcoming appointments in
the Patient Care Plan. When you place a check mark in the Include Next
Appointments checkbox, the system lists all of the patient’s future
appointments with any providers at your practice, along with the location.

Include Future
Preventive Care/
Immunizations

When your visit with the patient is finished, the next step is to discuss what
the patient has coming up. When you place a check mark in the Include
Future Preventive Care/Immunizations checkbox, the system lists any
Screening and Prevention or Immunizations entry found in Health
Maintenance marked with a status of Future (i.e., tagged with a blue
background).

Include Medication List

When you place a check mark in the Include Medication List checkbox, the
system prints a separate page of the report containing a wallet-sized list of
the patient’s long-term medications, as well as current prescriptions, that
the patient can cut out, fold up and slip into their wallet. This prints as many
cards as they need for their complete list.

22.56

MicroMD EMR User’s Reference Manual Version 16.0

Printing an Encounter Report

Chapter 22. Managing Encounters

Table 22.5 Additional Options for the Patient Care Plan Document (continued)

Field

Descriptions

Include Immunization
Record

Aside from the immunizations given during the visit, you can choose to
print the list of immunizations the patient has received, as recorded in the
EMR. This prints a separate page of the Patient Care Plan and includes a
grid with the vaccine down the left side and the dates the vaccine was given
across the top (up to six dates).

Include Inactive/
Resolved Problems

By default, the system excludes inactive or resolved problems when
printing the patient’s Problem List on the Patient Care Plan. If you would
like to include those entries in the document for the patient’s reference, you
can place a check mark in the Include Inactive/Resolved Problems
checkbox. The system includes these inactive problems, along with the
status of the item (i.e., Inactive or Resolved).

Include CDA

The Include CDA option is only available when you select Document from
the Patient Care Plan drop-down button in the Encounter Ribbon. This
option allows you to publish both the Patient Care Plan document AND the
rest of the patient’s chart (C-CDA) to the MicroMD Patient Portal at the same
time.
You can place a check mark in the Edit Before Publishing checkbox choose
the sections of the patient's chart you want to share with them.

Printing an Encounter Report
After you record an encounter, MicroMD EMR allows you to print an encounter report based on the data
within the encounter, along with data from the Medical Information tab of the patient’s chart (only
current information). It can also include goal monitoring information from the patient chart.
The report has a built-in format (page 22.59). You also have the option to create Encounter Report
templates to meet your needs and use those to print reports (page 22.61). When you launch the Encounter
Report, the system opens the Print Encounter Report window (Figure 22.44). Table 22.6 explains the fields
on this window in more detail.
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Figure 22.44 Printing an Encounter Report
There are several locations from you can print an encounter report:

 From within the patient’s chart while you are on the Encounter tab, you can select Print >
Encounter Report from the main menu of the application.

 From within the patient’s chart while you are on the Encounter tab, you can click the Print icon
on the top toolbar of the application and select Print Encounter from the drop-down menu.

 From within the encounter, you can click the Encounter Report button on the Administration
tab of the Encounter Ribbon.
Table 22.6 Options Available on the Print Encounter Report Window

Field

Description

Report Type Section
Standard Encounter Report

If you want to print the report that comes standard with MicroMD
EMR, you can choose the Standard Encounter Report option. Click
the Settings button to identify the information you want to
appear in the report. See page 22.59 for more details.

Print Form

This option is no longer in use.

22.58

MicroMD EMR User’s Reference Manual Version 16.0

Printing an Encounter Report

Chapter 22. Managing Encounters

Table 22.6 Options Available on the Print Encounter Report Window (continued)

Field

Description

Encounter Template

If you have created encounter report templates unique to your
needs, you can click the Lookup icon ( ) next to the Encounter
Template field and select the template you want to use. See
page 22.61 for details on creating Encounter Report templates.

Add Insurance Plan ID to footer

Place a check mark in the Add Insurance Plan ID to footer
checkbox to include insurance company and policy number to
the bottom of each report page. Select the appropriate plan set
from the drop-down.

Save Report to Document Manager Place a check mark in the Save Report to Document Manager
checkbox if you want to save the document to the Document
Management module.



You can find the report in the Chart Note folder.

Record report correspondence
Sent from, Sent To Type, Sent to,
Reason, Sent using, Sent on, and
Comment

If you would like to share the patient’s encounter report with a
third party, you can place a check mark in the Record report
correspondence checkbox and complete the fields in this section.



When you select Referring Provider from the Sent To
Type drop-down, you can choose from the Providers
and Specialist reference list in the Sent to field.

Standard Encounter Report
MicroMD EMR has a built-in encounter report format you can use to create a document from the selected
encounter; however, you can choose the sections of the patient’s chart to include in the report, as well as
edit the report before you print or send it. When you launch the Encounter Report (page 22.60), click the
Settings button to display additional options.
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Figure 22.45 Encounter Report Options
When you generate a standard Encounter Report, MicroMD EMR saves the settings that you selected in the
Encounter Report window (Figure 22.45). The next time you open the Encounter Report window, MicroMD
EMR displays the saved selections. Table 22.7 explains the options in more detail.



MicroMD EMR also uses these saved changes when you
select Quick Encounter Print in the system.

Table 22.7 Options on the Standard Encounter Report Window

Field

Description

Default Report
Destination

You can choose how you want to view your report. You can send the report
directly to the printer, or you can view the report in a window where you can
edit the report’s text before you print it.

Output Type

The Output Type options control how the text displays on the report:

 If you choose Discrete, the system includes only the discrete data
recorded in the encounter, with no user-friendly text.

 If you choose Narrative, the system includes discrete data in the report,
as well as phrases that make the report easier to read. MicroMD EMR
adds narration only to encounter information. The system does not
add narration to data from the Medical Information tab of the
patient’s chart.
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Table 22.7 Options on the Standard Encounter Report Window (continued)

Field

Description

Encounter Information

The options in the Encounter Information section controls whether the
following prints on the report:

 Display Provider Header: Place a check mark in this checkbox to display a
block of text containing the provider’s name and contact information
from the selected encounter at the top of the report.

 Print Measures: Place a check mark in this checkbox to include any codes
added to the Measures sub-tab in the encounter (page 29.2).

 Print Encounter Note: For use with the Text Encounter only, place a
check mark in this checkbox to include the text of the encounter in
the generated document.

 Image Annotation: Place a check mark next to Image Annotation to
include any mark ups from images added to the patient’s chart during the
encounter (page 28.23).
Medical Information

Place a check mark next to each category you want to include in the
Encounter Report. Please refer to Chapter 13 through Chapter 20 for more indepth details on any of the Medical Information categories.

Encounter Report Templates
MicroMD EMR allows you to print encounter reports customized to your practice’s needs by basing a report
on an encounter report template. When you print an encounter report based on a template, MicroMD EMR
extracts the specified information and inserts it into the report:

 Patient information—extracted from the patient’s chart
 Physician information—extracted from the MicroMD EMR Manager, after determining the
appropriate physician assigned to the patient

 Practice information—extracted from the MicroMD EMR Manager



Encounter Report templates can include the patient’s
current problems and current long-term medications.
To ensure confidentiality of medical information, only
MicroMD EMR users that are able to access patient
charts can produce reports that contain medical
information. See page 1.16 for more on user roles and
functions.



To ensure that the information in the reports that you
print is always complete and up to date, ensure that the
information in the MicroMD EMR Manager is complete
and up to date—both for the practice and for all MicroMD
EMR users.

These templates allow you to quickly generate reports that have a consistent format. Encounter report
templates can contain static text or data fields.
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Figure 22.46 Encounter Report Templates
To edit, delete, rename or print a hard copy of an encounter report template, simply highlight the template
and click the appropriate button. If you want to copy a template, highlight the template and click the Copy
button. Select the folder where you want to store the copy and click OK. This is extremely useful when you
want to modify a template to meet special needs.

○

You cannot delete or rename any of the templates in the
Standard folder.

Creating a New Encounter Report Template
When you create a new template, you start with a blank template. Then, you add text and fields to the
blank template to produce the standardized encounter report you want. When you save the new
template, you can define the template to be either personal or shared. For more details on Personal,
Shared and Standard folders, please see page 2.8.
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Figure 22.47 Creating an Encounter Report Template
The Merge Fields section on the left of the window allows you to pick and choose the data you want to
include in your encounter report. The available fields are the majority of the data in the patient’s chart,
including their encounters. When you print a report based on a template, MicroMD EMR extracts
specific information from the database and inserts it into the document:

 Patient information—extracted from the patient’s chart
 Physician information—extracted from the MicroMD EMR Manager
 Clinic information—extracted from the MicroMD EMR Manager
The right side of the window is your report template. You can type and format the text however you
like. When you insert merge fields from the left side of the window, the system highlights those fields
with a background color so you can distinguish the fields from plain text.

○

If you choose to rename your report sections (page 1.90)
and then choose the Encounter (All Entries) field for your
report template, only reports generated from encounters
using the Encounter Builder or the Encounter Wizard will
display the renamed sections. Reports generated from a
Text Encounter only display the renamed sections when
you use the individual section fields in the report
template.
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To create a new encounter report template:

Procedure

Details

1. Select Tools > Encounter Tools > Report
Templates from the main menu.

The Encounter Report Template Manager window
opens and displays your Personal folder by default.

2. Click the New button.

The Encounter Report Template Builder (New
Encounter Report Template) window opens
(Figure 22.47).

3. Type your text in the right side of the
window and insert fields from the left
as appropriate.

You can format your text as needed using the
editor’s top toolbar. See page 22.64 for more
information on working with fields.



If you have the appropriate software
installed, you can use the Voice
Recognition button on the Editing
tab. This activates your third-party
application to type text based on
your speech.

4. Click OK.

The Save Encounter Report Template
window opens.

5. Click the Personal folder or the Shared
folder, depending on where you would
like to save this template.

The window displays the appropriate folder.
Remember: You cannot save to the Standard
folder.

○

If you chose to save the template in
the Shared folder and the template
applies to a specific department
within the practice, select that
department from the Dept dropdown.

6. In the Template name field, enter a useful
title for the template.

Other users should be able to understand quickly
the purpose of the template.

7. Click OK to save the template.

The new template appears in the appropriate
folder in the Encounter Report Template Manager
window.

Working with Fields in a Template
When you create a new template or edit an existing template, you can insert fields similar to mail
merge fields in Microsoft® Word. A field is a placeholder for a specific piece of data from the database.
When you print an encounter report based on a template that contains merge fields, MicroMD EMR
replaces the placeholder with the appropriate data.
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For example, Dr. Webb at Summervale Medical Center created her Encounter Report template. In the
report, she typed Dear and then inserted the merge field PATIENT NAME (FIRST). When she prints the
report, the system inserts the patient’s name, so the printed report actually reads, “Dear Andy”.
You choose the fields you want to insert from the Merge Fields section of the Encounter Report
Template Builder (New Encounter Report Template) window (Figure 22.47 on page 22.63).

○

Some fields in a template populate the encounter report
with the patient’s current problems and current longterm medications. To ensure confidentiality of medical
information, only those MicroMD EMR users with access to
patient charts can produce reports that contain medical
information. For details on how to modify user access,
please see page 1.11.

To insert a field into a template, simply place your cursor in the appropriate location in the right side of
the window and double-click the entry in the Merge Fields section to insert the field. You can also drag
and drop the entry where you want it to appear in the report.



Use the Common and Index buttons in the Merge Fields
section to make locating required fields easier.

To delete a field from a template, simply highlight the field (the field flashes when selected) and click
the Delete Field button at the top of the Encounter Report Template Manager window.

Formatting an Encounter Report Template
When you create a new template or edit an existing template, you can define the format of the
template. Formatting includes making text bold, italic, underlined, justification, etc. To format a
template, simply highlight the text and use the controls within the editor to change the text
accordingly. Please see page 23.23 for details on using the editing ribbon.
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Recording Encounters
An encounter is a visit by a patient to a provider. Over time, a patient may undergo numerous encounters
in the practice and with various physicians. MicroMD EMR allows you to record—in the patient’s chart—the
details of each of the patient’s encounters in the practice.

In This Chapter
In this chapter, we cover how to:

 Establish default values to make you more efficient when recording encounters (page 23.1)
 Create pre-encounters (page 23.2)
 Record encounters using the Encounter Builder (page 23.2)
 Record encounters using the Encounter Wizard (page 23.18)
 Create Encounter Wizard templates (page 23.20)
 Record Text Encounters (page 23.23)
 Create Text Encounter templates (page 23.37)
 Record Form Encounters (page 23.40)
 Create Form Encounter templates (page 23.42)
 Record Group Encounters (page 23.54)

Setting the Encounter Recording Defaults
MicroMD EMR allows you to specify a number of default settings that relate to recording encounters,
including the encounter recording tool you prefer, the encounter level you use most frequently, and the
typical personnel to whom you send certain types of orders. For details on setting user preferences for
recording your encounters, please refer to page 1.88.



The Users and Facilities section of the Roles and
Functions window now has a Disable Personal Enc
Templates option to enable MicroMD Administrators to
prevent users from loading personal encounter
templates and a Disable Standard Enc
Templates.option to prevent users from loading
standard encounter templates.
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Pre-Encounters
When any user begins an encounter for someone else, the system keeps this record in the system as a preencounter only until the provider for whom it was created opens and edits that record. Once that record
has been edited by that provider, only users with proper roles and access assigned can edit it again.
For example, Betty Lopez starts the visit with patient Andy Homer. She clicks the New Encounter link in her
Desktop Tools and creates the encounter for Dr. Davidson. When she saves this encounter, the system sets
the status of the encounter as Pre-encounter. Dr. Davidson has a couple of options. He can use his Desktop
to access this encounter (page 4.5), or he can do so through the patient’s chart from the Summary tab
(page 22.24). Once he opens the encounter and begins editing, it has now become a full encounter record
that only he and others with appropriate roles and access rights can edit.
Once that pre-encounter is in the system, MicroMD EMR displays it on the Encounters section of the
Desktop for both the person who created the encounter and the person for whom it was created. See
page 4.5 for more details on using the Encounters section of the Desktop.



You cannot go through the Check-In process or sign a
pre-encounter until the day of the patient's visit.

Encounter Builder
The Encounter Builder allows you to rapidly record the details of a clinical encounter. With the Encounter
Builder, you can select symptoms, signs, diagnostic assessments and treatment options from the system’s
extensive reference lists. When you record a visit with the Encounter Builder, you can simply click through
each tab to document your encounter (Figure 23.1).



Learn how to use the Encounter Builder from scratch and
then learn about the CliniGuide (page 22.42) to help prepopulate standard encounters in your practice.

You can choose to enter as much or as little information as you want about the encounter. Keep in mind,
however, that there are certain data requirements for billing the encounter. Check with your billing
department if you are unsure of the minimum requirements.

23.2
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Figure 23.1 Encounter Builder Window
The left side of the Encounter Builder contains the Reference List Viewer, allowing you to access and select
data from the database. The right side contains the entries you have made in the encounter you are
currently building. Each tab of the Encounter Builder allows you to document and record a different aspect
of the encounter. The system displays the tabs of the Encounter Builder based on the SOAP note that is
familiar to providers—Subjective, Objective, Assessment and Plan—with additional tabs important for
providers to access easily.



For details on the Encounter Ribbon, please see
page 22.7.

Encounter Area
Each tab in the Encounter Builder has its own encounter area. This area of the tab displays all entries you
(or another user) have made to this encounter. For example, the encounter area on the Subjective/HPI
tab shows all symptoms recorded for the patient during their visit. This area also contains several icons
that allow you to perform tasks on the encounter entries and on the encounter area itself.
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Figure 23.2 Encounter Area on a Tab

○

The icons in the encounter area vary slightly depending
on the tab selected in the Encounter Builder.

Adding/Removing an Entry from the Encounter Area
To add an entry to the encounter, simply search for the item in the Reference List (the left side),
highlight it and drag it over to the encounter area (the right side). You can also double-click the item or
click the To Patient button.

Removing an Entry from the Encounter Area
There could be times when you add the wrong entry by mistake or you determine that you need a
different, more accurate entry. If you need to remove an item from the encounter area, simply highlight
the item and click the Delete icon ( ).

Resizing the Encounter Area and its Entries
MicroMD EMR allows you to resize the encounter area of a tab. This is useful when a particular list of
entries is too long to display fully. When you expand this area, the system hides the bottom area of the
tab. To expand the encounter area, simply click the Expand/Contract icon (
to contract the area and re-display the bottom area of the tab.

○

). Click the icon again

You cannot expand or contract the encounter area of the
Medication tab.

If you want to expand each encounter entry to display its descriptors and qualifiers, simply click the
Expand icon (
(

23.4

) next to the arrows. To collapse the details of the entry again, click the Collapse icon

) next to the arrows.
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Re-ordering the Entries and Categories in the Encounter Area
There may be times when you need to reorder items or categories in the encounter area. To move an
item up or down the list, highlight the encounter entry and click the Up arrow icon ( ) or Down arrow
( ) icon as appropriate. To reorder an entire category of items, highlight the category heading and
click the Up arrow icon ( ) or Down arrow icon ( ) as appropriate.

Figure 23.3 Re-order an Entry or Category

Re-categorizing Entries in the Encounter Area
The symptoms and signs that you add to the encounter area are categorized. On a new installation,
the Encounter Builder adds all symptoms under the category CHIEF COMPLAINT and all signs under
the heading GENERAL EXAMINATION. When you add a review of systems entry to the patient encounter
area, MicroMD EMR automatically adds the review of systems entry under an appropriate category. If
necessary, you can re-categorize this entry.
The categories window also allows you to access the Common List Manager to edit your Common List
of categories. This allows you to show only the categories you use most often and/or edit the order in
which those categories display in the encounter by default. To open the Category Common List
Manager window, click the Modify icon ( ) next to the Common button (Figure 22.8 on page 22.18).
Please see page 22.17 for more details on creating Common Lists.

Figure 23.4 Re-categorizing an Entry
To re-categorize an entry in the encounter area:

Procedure

Details

1. Highlight the entry in the encounter area.
2. Click the Categorize icon (

).

MicroMD EMR opens the appropriate window
(Figure 23.4).

3. Choose the appropriate category for the
item you highlighted.
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4. Click OK.

The system changes the category for the item
selected.

○

The system remembers the category
you associated with a sign or
symptom within an encounter and
uses the same category the next time
you use that sign or symptom.

Subjective/HPI Tab
Patients come into your office for a variety of reasons. The Subjective/HPI tab allows you to record the
symptoms with which the patient presented and document those symptoms in detail. For details on
adding items to the encounter area, please see page 23.3.

Figure 23.5 Subjective/HPI Tab
In addition to the other actions in the Patient Symptoms bar (Figure 23.5), once you add patient symptoms
into an encounter, you can click the VisualDx icon ( ) to launch the VisualDx web site with possible
diagnosis matches. See page 27.13 for more details on VisualDx.

Review Tab
As part of the visit with the patient, you review their symptoms, as well as their existing problems and other
medical information. The Review tab in the Encounter Builder allows you to review these items quickly,
making appropriate entries in the encounter area.
There are sub-tabs in this section of the Encounter Builder. Each tab is a different type of review:

 Review of Systems
 Review of Problems
23.6
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 Medical Information Review

Figure 23.6 Review Tab
For example, CMS requires that you ask the patient about his or her allergies—if they have any—at each
visit. MicroMD EMR allows you to record that you discussed this information with the patient and to record
if their peanut allergy has worsened from a mild allergy to a more severe allergy.
Please see page 23.11 for details on creating an encounter with the Encounter Builder.

Objective Tab
The Objective tab allows you to make a record of your examination of the patient and the signs with which
the patient presents. Please see page 23.11 for details on creating an encounter with the Encounter
Builder.

Figure 23.7 Objective Tab in Encounter Builder
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Visit Tests
For those users creating pre-encounters for other users, the Visit Tests tab allows you to enter procedures
and lab orders that need to be completed prior to the next user continuing the encounter. This tab works
just like the Plan tab (page 23.9), except the user cannot create referrals. Please see page 23.11 for details
on creating an encounter with the Encounter Builder.

Assessment Tab
The Assessment tab provides the area for you to indicate the patient’s diagnosis. In the encounter area of
the Assessment tab, the system provides you with the Chronic Problems icon ( ) and the Assessment
Information icon ( ), as well as the standard icons.

Figure 23.8 Assessments Tab in Encounter Builder
The Chronic Problems icon ( ) allows to access the patient’s problems list quickly. You can either add
the selected problem to the patient’s list or you can edit their existing list. If you need information related
to their diagnosis (e.g., disease guidelines from the Internet, valid procedure codes for the selected
diagnosis or materials for patient education), click the Assessment Information icon ( ) and make your
selection. Please see page 23.11 for details on creating an encounter with the Encounter Builder.

Medication Tab
You use the Medication tab of the Encounter Builder to prescribe medications for a patient during an
encounter. When you prescribe a medication, the Encounter Builder checks whether the medication
conflicts with:

 any other medication prescribed in this encounter
 any of the patient’s long-term medications
 any of the patient’s drug allergies
 the patient’s diagnoses

23.8
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○

The system also checks against drugs returned in the
patient’s RxHub Medication History. For details on ePrescribing, please see page 21.40.

If MicroMD EMR detects a conflict, it issues an interaction warning. You have the ability to choose the level
of warning you want the system to display. The drug interaction information comes from a national drug
database. Please see page 1.47 for more details on this preference and Chapter 21 for details on the
Prescription Module.

Figure 23.9 Medication Tab in Encounter Builder
On the Medication tab, you can check the patient’s recorded drug allergies before you prescribe a drug.
Simply click the Patient Allergies icon ( ). After you prescribe a medication during an encounter, you
can also add the medication to the patient’s list of long term medications. Click the LT icon (
) and
make the appropriate choice. See page 21.52 for more information on long-term medications. There is
also an information bubble icon ( ) that provides access to a variety of information related to the
selected medication.

○

Click the PDR button to review available prescription
labels, boxed warnings, safety alerts, patient education
materials, medication adherence programs, and
financial assistance offers.

Please see page 23.11 for details on creating an encounter with the Encounter Builder.

Plan Tab
The plan that you prescribe for a patient is a fundamental component of any encounter record. You use
the Plan tab of the Encounter Builder to prescribe action items for the patient. These action items could
fall into the following categories: patient instructions, procedures, nursing tasks, labs, patient-level
instructions, referrals, immunizations, and nursing care instructions.
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Figure 23.10 Sub-Tabs on the Plan Tab of Encounter Builder
If you need information about the procedures you have selected, the Plan Information icon ( ) gives you
access to the valid diagnosis codes for the selected procedure, as well as access to the Internet to find
information linked to the selected procedure.

Orders and Reminders
When you save an encounter, MicroMD EMR creates an order for each plan on which you have checked
the Create Order checkbox. The system then sends notification of each order to the resource that you
specified to perform the order. Each resource can use their Desktop to manage the order requests that
they receive. For more details on using the Orders section of your Desktop, please see page 4.19.
To view a list of the orders created for the encounter, click the View Created Orders icon (
encounter area. This opens the Order Builder window.

) in the

You can also create a reminder for the patient right away and have it activate on the appropriate date.
Click the Create reminder button ( ) on the Encounter Ribbon. See page 10.26 for details on patient
reminders.

Patient Instructions
Patient instructions are straightforward text entries that you can customize to meet your needs.
MicroMD EMR also gives you the ability to establish patient instructions that automatically create an
appointment request when added to an encounter, such as one named “RTC in 6 months”, for
example.
When you create a new patient instruction, there is a checkbox called Use for appointment request
(Figure 23.11). When you place a check mark in this box, the system displays appointment request
options. This allows you to set the defaults for the appointment request. The system creates the
appointment request once you save the encounter.

○

23.10

The most important information to set as a default is the
Time Period section (e.g., this instruction returns a
patient in three weeks).
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Figure 23.11 New Instruction Window

Using the Encounter Builder
The MicroMD EMR Encounter Builder helps you to record the details of each encounter with your patients
in an easy-to-use window, designed with the SOAP note in mind. Recording the details of an encounter
includes a number of steps. Some steps are optional—not all the steps are required to build every
encounter. For example, you do not have to prescribe a medication or a patient plan to complete an
encounter.
To record an encounter with the Encounter Builder:

Procedure

Details

1. Open the patient’s chart.
2. Select Chart > New Encounter from the
main menu.

You can also click the New Encounter link in the
Chart Tools section.
The New Encounter window opens (Figure 22.1 on
page 22.3).

3. Complete the header information for the
encounter and click OK.

See page 22.3 for details on the New Encounter
window.
The Encounter Builder window opens (Figure 23.1 on
page 23.3) and defaults to the Subjective / HPI tab,
ready for you to enter symptoms.

Record Patient Symptoms
4. Locate and highlight the appropriate
symptom on the Available Symptoms side.
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Details (continued)

5. Click the To Patient button.

The system adds the symptom to the encounter and
displays it on the Patient Symptoms side of the
window. The system also displays a grid of
descriptors for the selected symptom (e.g., Aggrav.
By and Allev. By in Figure 23.5 on page 23.6).



For details on how to change the
category of a symptom, see page 23.5.

6. Click one of the entries in the HPI for section
on the right side of the window.

The system displays a group of qualifiers below the
HPI section for the descriptor you selected.

7. Select the appropriate qualifiers to fully
characterize the selected symptom.

The list of qualifiers differs appropriately for each
descriptor. As you select each qualifier, the system
adds the descriptor and qualifier under the selected
symptom in the encounter area.
For more in-depth information about descriptors,
please see page 22.16.

8. In the Comment field, enter any additional
information needed for the descriptor.

The text you enter appears as the qualifying
information for the symptom.

9. Repeat step 4 through step 8 for each
symptom with which the patient has
presented during this visit.

Recording the Patient Review
10. Click the Review tab on the Encounter
Builder window.

MicroMD EMR defaults to the Review of Systems
sub-tab. See page 23.6 for more details on the
Review tab.



Spending time with the patient
reviewing their history potentially
increases your encounter level,
which translates into more revenue
for your practice.

11. Under the Available Symptoms for ROS
section of the window, locate and highlight
the symptom that you want to add to the list
of systems reviewed.
12. Click the To Patient button.

MicroMD EMR adds the selected symptom to the
Patient Systems Reviewed encounter area.

13. Click one of the entries in the HPI for section
on the right side of the window.

The system displays a list of qualifiers for the
descriptor you selected.

23.12
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14. Select the appropriate qualifiers to fully
characterize the selected symptom.

The list of qualifiers differs appropriately for each
descriptor. As you select each qualifier, the system
adds the descriptor and qualifier under the selected
symptom in the top right portion of the window.

15. In the Comment field, enter any additional
information needed for the descriptor.

The text you enter appears as the qualifying
information for the symptom.

16. Repeat step 11 through step 15 for all the
systems you have reviewed during this visit.
17. Click the Review of Problems sub-tab.

The system displays the patient’s list of current
problems. See page 13.3 for more in-depth details
on the patient's problem list.
18. Highlight the problem that you have
reviewed with the patient and click
To Patient.

The system adds the problem to the encounter area.

19. Click one of the entries in the Descriptors for
section on the right side of the window.

The system displays a list of qualifiers for the
descriptor you selected.

20. Select the appropriate qualifiers to fully
characterize the status of the selected
problem.

The list of qualifiers differs appropriately for each
descriptor. As you select each qualifier, the system
adds the descriptor and qualifier under the selected
symptom in the top right portion of the window.

21. In the Comment field, enter any additional
information needed for the descriptor.

The text you enter appears as the qualifying
information for the symptom.

22. Repeat step 18 through step 21 for all the
problems you have reviewed during this
visit.
23. Click the Medinfo Review sub-tab.
24. Locate and highlight the category that you
have reviewed with the patient and click To
Patient.
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25. Repeat step 24 for each category you review
during the patient’s visit.

Recording the Patient’s Signs
26. Click the Objective tab on the right side of
the Encounter Builder window.

The system defaults to your Common List of patient
signs.

27. Locate and highlight the appropriate
symptom on the Available Signs side.
28. Click the To Patient button.

The system adds the sign to the encounter and
displays it on the Patient Signs side of the window.
The system also displays a grid of descriptors for the
selected patient sign. The grid is standard for every
sign.
By default, the system adds signs under the category
GENERAL EXAMINATION. For details on how to
change the category of a sign, see page 23.5.

29. Click one of the entries in the Descriptors for
section on the right side of the window.

The system displays a list of qualifiers for the
descriptor you selected.

30. Select the appropriate qualifiers to fully
characterize the selected patient sign.

The list of qualifiers differs appropriately for each
descriptor. As you select each qualifier, the system
adds the descriptor and qualifier under the selected
patient sign in the top right portion of the window.
The signs appear in bold type and the descriptors
and qualifiers appear in regular type.

31. In the Comment field, enter any additional
information needed for the descriptor.

The text you enter appears as the qualifying
information for the sign.

32. Repeat step 27 through step 31 for each sign
you want to enter for this patient’s visit.

Prescribing Visit Tests
33. Click the Visit Tests tab.
34. Click one of the available plan sub-tabs on
the left side of the window.

The system displays the appropriate Reference List
Viewer for the selected type of plan.

23.14
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35. Locate and highlight the appropriate plan
item on the left side of the Encounter Builder
window.
36. Click the To Patient button.

The system adds the item to the encounter and
displays the current list of plans on the right side of
the window.

37. In the Comment field, enter any additional
information about the selected plan.
38. Complete the Performance Status section
as necessary.

Remember to place a check mark in the Create
Order checkbox if the item is a lab test, a procedure
or some other plan to be scheduled.

○

Turn on Expert Settings (page 1.84) to
have the system populate these fields
according to the choices you made the
last time you ordered that procedure,
laboratory test, etc. in an encounter.

39. Repeat step 34 through step 38 for each test
you want performed during the visit with the
patient.

Recording Your Diagnosis of the Patient
40. Click the Assessment tab.

By default, the Available Diagnoses section displays
your list of common diagnoses.

41. Locate and highlight the appropriate
diagnosis on the Available Diagnosis side.

See Figure 23.8 on page 23.8.

42. Click the To Patient button.

The system adds the diagnosis to the encounter and
displays it on the Patient Diagnoses side of the
window. The system also displays a grid of
descriptors for the selected patient assessment. The
grid is standard for every diagnosis.

43. Click one of the entries in the Descriptors for
section on the right side of the window.

The system displays a list of qualifiers for the
descriptor you selected.

44. Select the appropriate qualifiers to fully
characterize the selected patient sign.

The list of qualifiers differs appropriately for each
descriptor. As you select each qualifier, the system
adds the descriptor and qualifier under the selected
patient diagnosis in the top right portion of the
window.
The diagnosis appear in bold type and the
descriptors and qualifiers appear in regular type.
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45. In the Comment field, enter any additional
information needed for the descriptor.

The text you enter appears as the qualifying
information for the diagnosis.

46. Repeat step 41 through step 45 for each
diagnosis you want to enter for this patient’s
visit.

Prescribing Medications During Encounter
47. Click the Medication tab.

The system displays your Common List of
medications.
You can also enter prescriptions using the
Prescription Pad outside of an encounter
(page 21.8).

48. Locate and highlight the appropriate drug or
other prescription item on the Available
Medications side.
49. Click the To Patient button.

The system adds the medication to the encounter
and displays it on the Patient Medications side of the
window. The system also displays the prescription
options for the medication.

50. Specify the sig for the medication.

See page 21.25 for details on the Dosage Manager.

OR
Click the Dosage Manager icon ( ) to
select from your list of common prescription
details.
51. Click the Lookup icon ( ) next to the
Associated Diagnoses field to enter the
diagnosis for the medication.

A drop-down menu opens. You can choose a
diagnosis you already entered in the encounter, or
you can choose Select Diagnosis to associate a
different one to the medication.

○

Users with the Nurse role creating preencounters cannot add associated
diagnoses to the medications. Skip
step 51 and step 52.

52. Repeat step 51 for each diagnosis you need
to associate with the medication.
53. Repeat step 48 through step 52 for each
medication you want to prescribe.

23.16

For each medication that you prescribe, you can
print the prescription after you finish the encounter.
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Prescribing Patient Plans
54. Click the Plan tab.
55. Click one of the available plan sub-tabs on
the left side of the window.

See Figure 23.10 on page 23.10.
The system displays the appropriate Reference List
Viewer for the selected type of plan.

56. Locate and highlight the appropriate plan
item on the left side of the Encounter Builder
window.
57. Click the To Patient button.

The system adds the item to the encounter and
displays the current list of plans on the right side of
the window.

58. In the Comment field, enter any additional
information about the selected plan.
59. Complete the Performance Status section
as necessary.

Remember place a check mark in the Create Order
checkbox if the item is a lab test, a procedure or
some other plan to be scheduled.

○

Turn on Expert Settings (page 1.84) to
have the system populate these fields
according to the choices you made the
last time you ordered that procedure,
laboratory test, etc. in an encounter.

For a procedure or a referral order, you can also
enter the appointment date (if known) in the
Scheduled On fields. This carries over into the order.
60. Repeat step 55 through step 59 for each plan
you want to prescribe as a result of this visit
with the patient.

Completing the Encounter
61. When satisfied with the encounter, click OK
to close the Encounter Builder.
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You should now finalize your encounter using the Bill
Builder (page 24.2) and sign your encounter—or
send it to be co-signed (page 24.15).
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Encounter Wizard
The MicroMD EMR Encounter Wizard helps you to record the details of each encounter with your patients
and contains a number of steps on the screen. The specific steps, the number of steps, and the order in
which the steps appear in the Encounter Wizard, depend solely on the template that you load when you
begin the encounter.

Figure 23.12 Encounter Wizard Window – Example Step One
MicroMD EMR comes with a number of standard Encounter Wizard templates. You cannot modify or delete
any of these standard templates, but you can copy them as either personal or shared templates, and then
modify the copies as required. See page 2.8 for more details on Personal, Shared and Standard folders.
When you use the Encounter Wizard to record the details of an encounter, MicroMD EMR saves all the
information in the patient’s chart. After using the Encounter Wizard to record an encounter, you use the
Encounter tab of the Chart Manager to view the details of the encounter.

○
23.18

Once you create an encounter with an Encounter Wizard,
you can only edit the encounter using the Encounter
Wizard.
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To use the Encounter Wizard to record an encounter:

Procedure

Details

1. Open the patient’s chart.
2. Select Chart > New Encounter from the
main menu.

You can also click the New Encounter link in the
Chart Tools section.
The New Encounter window opens (Figure 22.1 on
page 22.3).

3. Complete the header information for the
encounter.

See page 22.3 for more details on the New
Encounter window.

4. From the Record encounter using the dropdown list, select Encounter Wizard.

The system displays a drop-down list with your
Common List of Encounter Wizards and a Lookup
icon ( ) next to the drop-down.

5. Select the Encounter Wizard you want to use
or click the Lookup icon ( ) to insert the
one you want to use.
6. Complete the remaining information on the
New Encounter window and click OK.
7. Click Next after completing each page of
the wizard.

8. Click Finish when you complete the last step.
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The system opens the first step of the selected
Encounter Wizard.



You can use the GoTo button to
display any page in the current
Encounter Wizard template.

The system closes the Encounter Wizard, saves
the encounter and adds the details to the patient’s
chart.
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Encounter Wizard Templates
The MicroMD EMR Encounter Wizard helps you to record your encounters. Encounter Wizard templates
define the steps you see when you load that template into the Encounter Wizard. Templates allow you to
customize the Encounter Wizard to meet the needs of your practice. For example, the structure of an
encounter with a new patient would vary significantly from a telephone encounter with a returning patient
who was requesting additional medication.
When you create a new Encounter Wizard template, you can start either with a blank template or with a
copy of an existing template that you want to modify. You can save the template in the Personal folder or
in the Shared folder. See page 2.8 for details on working with Personal, Shared and Standard folders.

Figure 23.13 Encounter Wizard Template Builder Window
To create a new Encounter Wizard template:

Procedure

Details

1. Select Tools > Encounter Tools >
Encounter Wizard Templates from the
main menu.

The Encounter Wizard Template Manager window
opens and lists all your personal Encounter Wizard
templates.

2. Click the New button.

The Encounter Wizard Template Builder window opens
to the first step (Figure 23.13).

3. From the list on the Available Steps side
of the window, highlight the step you
want to add to your template.

23.20



The yellow area below the list
explains the selected step.
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4. Click the Add button.

You can also double-click the entry or drag and drop it
to the Template Steps side of the window.
When you add Medical Information as a step in the
template, you must choose the categories you want to
review with this wizard. Click the Lookup icon ( ) in
the Step Details section to add categories. Chapter 13
through Chapter 20 explain the categories in
more detail.
When you add Medical History as a step in the
template, you must specify which of those templates
you want to use. Click the Lookup icon ( ) in the Step
Details section to add History Recorder templates.
Please see page 12.15 for more details on history
templates.
When add an “as Text” step, you can specify the Text
Encounter templates you want to use for that step.
Click the Lookup icon ( ) in the Step Details section
to add templates. See page 23.37 for more details
about Text Encounter templates.



5. Repeat step 3 and step 4 for each step
that you want to add to the template.

Use the re-order icons ( and ) to
change the sequence of the steps.

6. When satisfied with the steps chosen and
the order in which they appear, click
Next.

The system displays the next step of the template
builder. This step allows you to add CliniGuide
templates (page 22.42) and Encounter Reports
(page 22.57) to the template.

7. Click the Lookup icon (
CliniGuides section.

The Load CliniGuide window opens.

) next to the

8. Locate and load the CliniGuide you want
to include in the Encounter Wizard
template.
9. Repeat step 7 and step 8 for each
CliniGuide you want to include.
10. Click the Lookup icon ( ) next to the
Encounter Reports section.

The Load Encounter Report Template window opens.

11. Locate and load the report template you
want to include in the Encounter Wizard
template.
12. Repeat step 10 and step 11 for each
report you want to include.
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Procedure (continued)

Details (continued)

13. Click Finish when satisfied with the
Encounter Wizard template.

The Save Encounter Wizard Template window opens.

14. In the Template name field, enter a useful
title for your template.

This name is how you distinguish the templates from
each other when you want to use one.

15. Choose the folder in which you want to
save the template.

You can choose either Personal (available only to you)
or Shared (available to multiple users).

16. Click OK.

The system adds the new template to the folder you
chose.
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You use the MicroMD EMR Text Encounter Recorder to record text-based encounter records. You build
this encounter using a text editing window (Figure 23.14). You can format the text just like standard wordprocessing software.

Figure 23.14 Text Encounter Recorder
With the Text Encounter Recorder, you can include two types of text in the encounter record:

 Free text: Free text is text that you type into the encounter record to describe part of the
encounter. This text is unique to the encounter record only. The system cannot extract any of
this information for use elsewhere.

 Predefined data: Predefined data is text that you select from one of the following three sources
in the database:

- MicroMD EMR reference lists, including Subjective, Review, Objective, Assessment,
Medication and Plan.

- Quick Data: This is data that you select from various MicroMD EMR fields (similar to mail
merge fields), such as Patient’s Name and Practice Address.

- Quick Text: Quick Text are commonly used phrases that you have predefined in the system
(similar to Autotext entries in Microsoft® Word).
Reference data that is inserted into an encounter record is referred to as a field. Fields appear in the Text
Encounter Recorder with a colored background. The Text Encounter Recorder is composed of two
sections: the Reference List Viewer (on the left side) and the Encounter Record Editor (on the right side).
The tabs at the bottom of the Reference List Viewer allow you to access various sets of pre-defined data.
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Figure 23.15 Accessing Data for the Encounter
The first several tabs give you access to the MicroMD EMR reference lists. The Quick Data tab provides
access to various fields in the system (e.g., patient name), and the Quick Text tab gives you access to your
predefined phrases and other wording.

Structure of Text Encounter Recorder
The order of the tabs in the Text Encounter mimic the typical SOAP note structure. See page 23.2 for more
on these tabs. The Editing tab of the Encounter Ribbon (page 22.9) provides easy access to various areas
of the program while you are recording your encounter. If you created a Text Encounter template, you can
click the Load Template button to append to the current encounter. Refer to page 23.37 for details on Text
Encounter templates.

Using the Text Encounter to Record a Visit
To create a new Text Encounter record:

Procedure

Details

1. Open the patient’s chart.
2. Select Chart > New Encounter from the main
menu.

You can also click the New Encounter link in the
Chart Tools section.
The New Encounter window opens (Figure 22.1 on
page 22.3).

3. Complete the header information for the
encounter.
4. From the Record encounter using the dropdown list, select Text Encounter.
5. Complete the remaining information on the
New Encounter window and click OK.

The system opens the Text Encounter Recorder.

6. Build your encounter in the text area.
7. Click OK when satisfied with the encounter.
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The system saves the encounter and adds any
discrete data to the patient’s chart.
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Using the Zoom Tool
The Zoom tool allows you to fit the entire Text Encounter (horizontally) in the window, eliminating any
need to scroll across your document. The system sets this zoom value to 100%, allowing the system to
eliminate the horizontal scrollbar and fit the text within the editing window.

Figure 23.16 Zoom Tool
If you would like to set your own default value, select Tools > User Preferences from the main menu. In
the Miscellaneous category, you can set the percentage you want to use for the text editor in the Default
the text editor zoom to field. Once you set this value, the system automatically sets the zoom to this
percentage every time you open a text editor.

Spell Checker
The Spell Checker is a tool you can use when creating and using Text Encounters, as well as Encounter
Wizards containing the “…as Text” options. There is no setup required to use the spell checker. If
necessary, you can find the dictionaries using the MicroMD EMR Manager. Click the System Settings
button and click the Directories tab. The directory listed next to Spelling Dictionary is where the system
houses the dictionaries used for the spell checker. See page 1.40 for more information.

Checking Spelling
Anytime you want to check the spelling of the text in your document, simply click the Spell Checker
button at the top of the text editor (Figure 23.17) or press the F7 key on your keyboard. You can also
right-click the text area and select Spell check document from the pop-up menu.

Figure 23.17 Spell Checker
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All users have access to the common dictionary and
can add new words to it. Any additions to the
dictionary are then available to everyone.



For example, if Dr. Webb adds “mesothelioma” to the
dictionary, that word is now available to Dr. Davidson
and all other users on the system.
For that reason, it is very important to verify that you
have spelled the word correctly before you add it to the
dictionary. The same holds true for those words you
choose to autocorrect.

When you launch the spell checker, the system searches through the text in the editor. When it finds a
word that is not in the dictionary, a window opens (Figure 23.18). From this window, you have a variety
of options on how to handle the incorrect word.

Figure 23.18 Spell Checker Pop-up
You can choose to ignore the word that the spell checker has flagged for you. Click either Ignore (just
this instance) or Ignore All (all instances in this document). If you want to change the incorrect
spelling, highlight the correct suggestion or type the correct word in the Not in Dictionary field. Click
either Change (just this instance) or Change All (change all instances in this document).
If the word is actually spelled correctly, you can choose to add the new word to the dictionary so that
subsequent spelling checks do not flag the word as incorrect. Simply click the Add button.
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Be careful about the words you add to the dictionary
and the words you choose to autocorrect. These
changes are global and affect all users.
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Options Available per User
Each user has the ability to choose how the spell checker works for them. Simply click the Options
button on the Check Spelling window (Figure 23.18) and place a check mark next to the options that
match the way you want the system to work (Figure 23.19).

Figure 23.19 User Options for Spelling Check

Editing the Contents of the Dictionary
There may be times when you need to edit the contents of the dictionary. Perhaps someone added a
word to the dictionary, but the word was spelled wrong or they did not mean to add the word. You can
also create autocorrect entries in the dictionary. This allows the spell checker to automatically fix
certain words for you. If you always type “recieve” instead of “receive”, you can create an entry that
automatically fixes this word correctly for you.

Figure 23.20 Editing the Contents of the Dictionary
Simply click the Dictionaries button (Figure 23.18 on page 23.26). Any words that have been added to
the dictionary appear in the Words list box. Use the scrollbar to view the entire list. To view the details
of a word, highlight the word in the list. The Action drop-down tells you what the system will do when it
encounters this word. If you’ve established an autocorrect entry, the Other word field, in conjunction
with the Action drop-down, tells you what the system will do when it encounter the word spelled as it
is in the Words field.
For example, in Figure 23.20, when the system encounters the word “recieve” spelled as shown in the
Words list, based on the choice in the Action drop-down, the system will automatically replace the
word in your encounter or letter with “receive” spelled as it is in the Other word field, but it will use the
case of the word in your encounter or letter. If the word checked in the encounter is “Recieve”, the
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system automatically corrects it to “Receive”. If the word checked is “RECIEVE”, the system corrects
your encounter or letter to “RECEIVE”, using the same case you did.

○

The system autocorrects a word only when you run the
spell checker.

To remove a word that a user added to the dictionary or to remove an autocorrect entry, simply
highlight the word and click the Delete word button. To add a word to the dictionary, type the correct
spelling in the Words field, select Ignore (skip) from the Action drop-down and click the Add word
button.
To add an autocorrect entry, type the word spelled the way you usually type it by mistake (e.g.,
recieve) in the Words field. Type the word correctly in the Other word field (e.g., receive). From
the Action drop-down, select the action you want the system to perform. Click the Help button for
more details on the options available.

Inserting Text into the Text Editor
With the text editor in the Text Encounter Recorder, you can type text, use speech recognition or import
text from an existing file. If you have a tablet with handwriting recognition, you can also use the stylus to
enter information in the encounter. After you insert the text, you can modify and format the text using the
available formatting controls.

Typing Text
Simply make the open text area on the window the focus of your cursor and begin typing part of the
encounter.

○

Remember, however, that if you only enter simple text
without using data from the database, you cannot
experience many features of MicroMD EMR.

Replacing Text
The Replace button allows you to find a bit of text and replace it with new text. The Find button allows
you to search through the document for the text you type in the Find what field. Click the Undo button
to cancel the last change you made. Each time you click the Undo button, you step backward through
the changes you’ve made to the text.
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Speech Recognition
To use the speech recognition feature, you must have a microphone attached to your computer. Once
you have this attached, simply click the Voice Recognition button in the encounter ribbon. The circle
on the button flashes green while recording. To turn it off, click the Voice Recognition button again.

○

You must “train” the speech recognition facility to
recognize your voice and accurately translate your words
to text. You do so under Tools > Dictation > Train. For
more details on training this feature, please see
page 27.44



If you use a third-party speech recognition software, you
do not have to click the Voice Recognition button to
record your text. Please refer to the original
manufacturer’s instructions.

Importing the Text of a Document
If you have text for this encounter in another document, click the Document button on the encounter
ribbon. Navigate to the file and click Open. The system appends the contents of the file to the
beginning of the encounter.

○

The system recognizes *.doc, *.docx, *.rtf and *.txt files
for importing.

Using Reference Data in a Text Encounter Record
The Text Encounter Recorder allows you to insert reference data into Text Encounter records. After you
insert reference data, you define the details of the data. For example, after prescribing a particular
medication for a patient, you can specify the dosage details for the medication or add the medication to
the patient’s list of long-term medications.

Inserting Reference Data into a Text Encounter Record
The Text Encounter Recorder allows you to insert reference data into an encounter record. Reference
data that is inserted into an encounter record is referred to as a “field”. When you insert a field, the
system displays that field with a colored background (Figure 23.14 on page 23.23). You cannot change
the background color of fields in the Text Encounter Recorder. After you insert a field, you can specify
the details of the field (page 23.31).
The reference data that you can insert into an encounter record includes the following reference lists:
Subjective (S tab), Review (Review tab), Objective (O tab), Visit Tests (VT tab), Assessment (A tab),
Medications (M tab) and Plan (P tab).
To insert a reference-data entry, simply choose the reference list you want to use, highlight the entry
and click To Patient. You can also double-click or drag and drop the entry to the text editor.
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Deleting a Field from a Text Encounter
The Text Encounter Recorder allows you to delete a reference data field from an encounter record.
Simply highlight the field and click the Delete Field button in the Encounter Ribbon. You can also
highlight the field and press the Delete key on your keyboard or right-click and select Delete Field
from the pop-up menu.

Accessing Additional Reference Data Functionality
The Text Encounter Recorder allows you to access additional functionality for each reference data
entry that you insert into an encounter record. The additional functions that are available vary
depending on the type of the reference data entry you select.
Simply right-click the entry in the text editor to view your options. For example, on a medication that
you enter, you have the options shown in Figure 23.21.

Figure 23.21 Options on a Reference Data Entry

Useful Shortcuts
MicroMD EMR provides you with a number of shortcuts that you can use to quickly access your
Common Lists of reference data while you record an encounter. Other shortcut keys you can use while
working in Text Encounters, letter templates, referral letter templates and Encounter Report
templates.
Table 23.1 Shortcut Keys in Text Editor

23.30

Shortcut

Description

F7

Runs the spell checker tool.

Ctrl + C

Copies the selected text to the Windows clipboard.

Ctrl + X

Cuts the highlighted text and places it on the Windows clipboard.

Ctrl + V

Pastes the clipboard text into the current field

Ctrl + F

Launches the search feature and allows you to quickly search through your
document for a word or phrase.

Ctrl + H

Launches the search feature and allows you to quickly search through your
document for a word or phrase and replace the selected word/phrase with another.
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Table 23.1 Shortcut Keys in Text Editor (continued)

Shortcut

Description

Ctrl + A

Selects all text in the document.

Ctrl + P

Prints the current window or the selected item.

Ctrl + D

Opens the Font dialog box so you can quickly format the selected text.

Ctrl + E

Opens the Save As dialog box and allows you to save the current encounter or
template in a rich-text format file (RTF).

Ctrl + I

Allows you to insert a document from an external file.

Ctrl + O

Allows you to load a Text Encounter template when using Encounter Wizards or
Text Encounters.

Defining Details of a Field
After you insert reference data into a Text Encounter record, you can define the details of the data,
including the descriptors and their qualifiers, prescription details and the creation of plan orders.
To define the details of a field in the Text Encounter Recorder, place your cursor in the field and click
the Field Details button at the top of the window. This opens the appropriate details or descriptors
window. Enter the information and click OK.
For example, if the field is a sign, the Subjective Details window opens and allows you to add in-depth
information about the sign.



You can also double-click the field or right-click and
select Field Details from the pop-up menu.

Using Quick Data in a Text Encounter Record
The Text Encounter Recorder allows you to insert Quick Data into an encounter record. Quick Data
includes fields such as Patient Name (Full Name) and Patient Address. To insert a Quick Data entry, simply
click the Quick Data tab, highlight the entry and click the To Patient button. You can also double-click the
entry or drag and drop it to the text editor.
When you insert Quick Data into an encounter record, MicroMD EMR inserts the actual value of the Quick
Data entry. For example, in the encounter for Andy Homer, you double-click the Patient Name Quick Data
entry. The system inserts the words “Andy T Homer” into the text editor of the encounter (Figure 23.22).
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Figure 23.22 Example of Quick Data
The system provides various categories to help you quickly display the types of fields available. Use the
controls of the Reference List Viewer section to find the data you need. See page 7.2 for details on using the
Reference List Viewer.

Using Quick Text in a Text Encounter Record
The Text Encounter Recorder allows you to insert frequently used phrases and other wording into an
encounter record quickly. The phrases that you create are known as Quick Text. You can access and use
any Quick Text phrase created by any MicroMD EMR user in the practice. However, you can modify only
your own Quick Text phrases. You cannot edit those created by another user.

Creating Quick Text
The Text Encounter Recorder allows you to add new phrases to your existing list of Quick Text phrases.
The Quick Text phrase is a way to create a system of “shorthand” or “shortcut” set of words that, when
used, expand into the lengthy text you really want to include in the encounter.



You can also use the Quick Text feature to create a
shortcut for headings or other simple text (e.g., words
difficult to type quickly) you want to insert by dragging
and dropping or by double-clicking the mouse.

For example, Dr. Webb at Summervale Medical Center is an OB/GYN and often prescribes bed rest for
her patients later in their pregnancy. She created a Quick Text entry called BED REST. When she uses
this entry in her Text Encounter, the system enters the entire paragraph into the encounter instead:
Patient instructed to stay in bed for the next few weeks. Activity
restricted to necessary movements only.
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Figure 23.23 Quick Text Manager
To edit or delete a quick text entry, highlight the entry once in the manager and click Edit or Delete as
appropriate.
To add a new Quick Text phrase to the system:

Procedure

Details

1. Open the patient’s chart.
2. Open an existing Text Encounter record or
create a new one.

See page 23.24 for details on creating a new Text
Encounter.

3. Click the Quick Text tab.
4. Click the Manager button at the bottom.

The Quick Text Manager window opens (Figure
23.23).

5. Click the Add button.

The Quick-Text editor window opens.

6. In the Name field, enter a useful title for the
quick phrase.

This is the text that appears in the list of entries on
the Quick Text tab. Make this a name you can
identify quickly without deciphering it.
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Details (continued)

7. In the Text field, type the text of the Quick
Text entry as you want it to appear in the
text editor.
8. Click OK.

MicroMD EMR adds the new phrase to the list.

9. Click Close to exit the Quick Text Manager
window.



Click the All button on the Reference
List Viewer if you do not see your new
phrase.

Inserting a Quick Text Phrase into an Encounter Record
The Text Encounter Recorder allows you to insert Quick Text phrases into an encounter record. You
can insert any Quick Text phrase in the system—whether you created the phrase or not.
To insert Quick Text phrase, simply click the Quick Text tab, highlight the entry and click the To
Patient button. You can also double-click the entry or drag and drop it to the text editor.



The system displays the full text of the entry in the area
below the list so you can view what you are about to add.

Loading a Template into the Text Encounter Recorder
MicroMD EMR allows you to load Text Encounter templates into your Text Encounter records. The
templates can contain text, reference data, fields and Pick Lists. You can load multiple templates into a
single Text Encounter record. See page 23.37 for more details on creating templates.



If you load a template into an encounter you have
already started, the system appends your data. It does
not remove the existing data.

To load a template into the Text Encounter Recorder:

Procedure

Details

1. Open an existing Text Encounter or create a
new one.

See page 23.24 for details on creating a new Text
Encounter.

2. Position your cursor where you want to insert
the template.
3. Click the Load Template button on the
Encounter tab in the ribbon bar.

The Load Text Encounter Template window opens.

4. Select a template from the list and click Load.

MicroMD EMR loads the selected template into the
encounter record. You can edit and format the
loaded text as needed.
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Inserting Dictation Notes into a Text Encounter Record
MicroMD EMR allows you to insert dictation notes into a Text Encounter record. The dictation notes are
saved as sound files together with the encounter record. When you view the encounter record, you can
listen to the dictation notes.

Figure 23.24 Recording a Dictation
Dictation notes differ from entering text using the speech recognition tool. Dictation notes are simply your
verbal notes about the patient’s encounter. Speech recognition actually types the words you speak into
the encounter record and does not save a sound file.
When you click the Dictation Notes button and there are dictations already recorded, the system displays
a drop-down that lists those dictations, along with a New Dictation option. The system numbers the
dictations beginning with number one. Each new dictation is added to the list and numbered accordingly.
If you delete a dictation from within the list, the system renumbers the dictations.
To insert a dictation note into a Text Encounter record:

Procedure

Details

1. Open an existing Text Encounter or create a
new one.

See page 23.24 for details on creating a new Text
Encounter.

2. Position your cursor where you want to insert
the dictation note.
3. Click the Dictation Note button on the
Encounter Ribbon.

The recording tools appear over the ribbon bar
(Figure 23.24).

4. Use the controls to record your note.
5. Click Save when satisfied with the dictation.

The system inserts a field into the text editor. For
example, DICTATION NOTE 1.

Managing Discrete Data
The Text Encounter Recorder allows you to manage the discrete data in a Text Encounter record. “Discrete
data” is information about the patient and their medical health that can be parsed into tidbits of
information that the system can store in a database format. This allows the system to pull the information
in a variety of ways to show you the picture you need to see of the patient. This also provides flexibility in
interpreting the data and using it for billing.
Managing discrete data includes the following tasks, which you do within the encounter:

 Inserting discrete data into an encounter record

MicroMD EMR User’s Reference Manual Version 16.0

23.35

Chapter 23. Recording Encounters

Text Encounters

 Deleting discrete data from an encounter record
 Specifying details of a discrete data entry
The system is also able to analyze the text within an encounter record, searching for potential discrete
data elements. The system lists the potential discrete data elements that it locates. You can then specify
each element in the encounter record you want to convert from text into a discrete data field.

Figure 23.25 Discrete Data Manager in Text Encounter
To extract discrete data from a Text Encounter record:

Procedure

Details

1. Open an existing Text Encounter or create a
new one.

See page 23.24 for details on creating a new Text
Encounter.

2. Click the Discrete Data button in the
Encounter Ribbon.

The Discrete Data Manager window opens (Figure
23.25). Under Actual Discrete Data on the right side
of the window, MicroMD EMR lists all the discrete
data elements that already exist in the encounter
record—if there are any.

3. Click the (NLP) Extract Data button.

MicroMD EMR searches the encounter record for
data that it thinks could be discrete, and it lists
those items under the Potential Discrete Data
section on the left side of the window.
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Procedure (continued)

Details (continued)

4. Highlight the entry you want to turn into
discrete data and click the Add button.

You can also add all of the suggested items by
clicking the Add All button.


5. Click OK to close the Discrete Data Manager.

To edit the details of discrete data
while in the manager, click the Edit
icon ( ) next to the entry on the
right side of the window.

MicroMD EMR updates the encounter to reflect the
changes that you made in the Discrete Data
Manager.

Text Encounter Templates
MicroMD EMR allows you to use templates when you record a Text Encounter using the Text Encounter
Recorder. Templates help you:

 increase the speed with which you can record an encounter.
 consistently record your encounters in a standard manner.
Text Encounter templates can contain both static text and fields. When you load a template into the Text
Encounter Recorder, the text and fields from the template appear in the text editor at the cursor location.
After loading a Text Encounter template, you can add free text and fields to the encounter record, and even
edit and format the loaded text and fields. For details on how to load a template into the Text Encounter
Recorder, see page 23.34.

Figure 23.26 Text Encounter Template Builder
With the Text Encounter Template Builder you can include two types of text in an encounter template, free
text and pre-defined data. Free text is text that you type into the encounter template to describe part of the
encounter. For details, see page 23.28.
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In a template, you can enter predefined text that you select from a field and contains data from MicroMD
EMR reference lists (page 23.29); Fields, also called Quick Data in an encounter, (page 23.39); Quick Text
(page 23.32); or Pick Lists (page 23.39). Pick Lists are like drop-down fields and contain a specific set of
choices.
To edit or delete an existing template, simply highlight the template in the Template Manager and click
Edit or Delete as appropriate.
To create a new Text Encounter template:

Procedure

Details

1. Select Tools > Encounter Tools > Text
Encounter Templates from the main menu.

The Text Encounter Template Manager
window opens.

2. Click New.

The Text Encounter Template Builder window
opens (Figure 23.26).

3. Enter the text, reference data, Fields (or Quick
Data), Quick Text, and Pick Lists you want in
the new template.
4. Format the contents of the template as
needed.

See page 23.38 for more details about formatting
text in the text editor.

5. Click OK when satisfied with the new Text
Encounter Template.

The Save Text Encounter Template window opens.

6. In the Template name field, enter a useful title
for your template.

This name is how you distinguish the templates
from each other when you want to use one.

7. Choose the folder in which you want to save
the template.

You can choose either Personal (available only to
you) or Shared (available to multiple users). See
page 2.8 for more detailed information on
Personal, Shared and Standard folders.

8. Click OK.

The system adds the new template to the folder
you chose.

Formatting a Text Encounter or a Text Encounter Template
When you create/edit a Text Encounter or create/edit a Text Encounter template, you can format the text
just like you can with a traditional word-processing software. You can bold text, italicize it, change the
alignment of paragraphs and more.

Figure 23.27 Formatting Toolbar in Text Editor
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In the Basic Text section of the Encounter Ribbon, you can click the Paragraph icon ( ) to access the
Paragraph formatting window. This allows you make the text left justified, centered and more. This feature
also allows you to create outlines around paragraphs of text.
Click the Font icon ( ) to access font faces and type sizes. The Numbering icon (
numbered lists, as well as bulleted lists.

) allows you to create

Using Text and Data in a Text Encounter Template
When you build an encounter template, you can insert reference data just like with a blank encounter. With
a template, however, you can predefine the answers to the fields in a template if needed. This allows you
to proceed through a standard encounter (e.g., a well visit) quickly and accurately.
Simply insert the reference data as you would a blank encounter (page 23.29) and then edit the field
details (page 23.31). When you load the template, these answers are pre-populated for you and you can
document by exception.

Inserting Pick Lists into a Text Encounter Template
A Pick List is like a drop-down field. When you load a template containing a Pick List, you can choose the
most suitable option for the individual patient for that specific encounter with them. For example, a Pick
List called Pain Severity may include the following options: Intense, Moderate, and Slight. The Pain
Severity Pick List appears in the encounter template surrounded by arrows and highlighted (Figure 23.28).

Figure 23.28 Pick Lists in a Text Encounter
When you click the <<Pain Severity>> field in an encounter based on this template, the system displays the
options available: Intense, Moderate and Slight. You can choose the appropriate one for the patient.
MicroMD EMR comes with a standard set of Pick Lists you can use for Text Encounters, Form Encounters
and other forms in the system. You can add new Pick Lists and edit any user-defined Pick Lists. You cannot
edit or delete a standard Pick List. For more in-depth details about Pick Lists in the system, please see
page 22.38.
To delete an existing Pick List from the template, simply highlight the field in the text editor and click
Delete Field.
To insert a Pick List into a Text Encounter template:

Procedure

Details

1. Position your cursor in the Text Encounter
record at the place in the template where you
want to insert the Pick List.
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Procedure (continued)

Details (continued)

2. In the Reference List Viewer on the left of the
Text Encounter Template Builder, click the
Pick List tab.

MicroMD EMR displays your Common List of Pick
List entries.

3. Locate and highlight the Pick List you want to
use and click To Patient.

The system adds the Pick List field to the template
at your cursor’s location.
You can also double-click the entry or drag and
drop it to the text editor side of the window.

4. Format the text as needed.
5. Click OK when satisfied with your Pick List in
the template.

Form Encounters
The MicroMD EMR Form Encounter provides an online form that you can complete to record the
encounter. The electronic form can contain checkboxes, drop-down lists, search fields and more, similar to
choices you find when completing a form on the Internet.

Figure 23.29 Form Encounter – Example
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Creating a Form Encounter
Each encounter that you record is based on a template. These templates often resemble the paper forms
that they replace and can have multiple pages. For example, you can create a Form Encounter template
that mimics your superbill exactly and then load that template when you create an encounter.
To create a new encounter using the Form Encounter:

Procedure

Details

1. Open the patient’s chart.
2. Select Chart > New Encounter from the main
menu.

You can also click the New Encounter link in the
Chart Tools section.
The New Encounter window opens.

3. Complete the header information for the
encounter.

See page 22.3 for more details on the New
Encounter window.

4. From the Record encounter using the dropdown list, select Form Encounter.

The system displays a drop-down list with your
Common List of Form Encounters and a Lookup
icon ( ) next to the drop-down.

5. Select the Form Encounter you want to use or
click the Lookup icon ( ) to insert the one
you want to use.
6. Complete the remaining information on the
New Encounter window and click OK.
7. Click Next after completing each page of the
electronic form.

The system opens the first page of the selected
Form Encounter.



You can use the GoTo button to
display any page in the current form.

8. Use the Encounter Ribbon to complete any
necessary tasks for the encounter.

See page 22.7 for more details about the
Encounter Ribbon.

9. Click Finish when satisfied with the
encounter.

The system closes the Form Encounter, saves the
encounter and adds the details to the patient’s
chart.
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Form Encounter Templates
Form Encounter templates define the content and structure of the encounter when you choose to
document a visit with the Form Encounter. Each Form Encounter template contains a number of controls,
such as checkboxes, text fields and radio buttons. You use these controls to record the details of an
encounter.

Figure 23.30 Form Encounter Template Builder Window
Some of the controls in a template are standard Windows® controls; others are unique to MicroMD EMR.
For each control that you add to a Form Encounter template, you specify the properties of the control.
Some controls, such as checkboxes, allow you to record discrete data as part of the encounter.
When you arrange the required controls on a page, MicroMD EMR provides you with a number of
positioning tools. These tools help you to align the controls, distribute the controls and make the controls
the same size (height and/or width). Each Form Encounter template can contain multiple pages.

Creating a New Form Encounter Template
When you create a Form Encounter template, you can start either with a blank template or with a copy of
an existing template that you want to modify. You build a new Form Encounter template by adding
controls to a blank template and specifying the properties of each control.
To create a new Form Encounter template:

Procedure

Details

1. Select Tools > Encounter Tools > Form
Encounter Templates from the main
menu.

The Form Encounter Template Manager window
opens and lists all your personal Form Encounter
templates.
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Procedure (continued)

Details (continued)

2. Click New.

The Form Encounter Template Builder window opens
(Figure 23.30).

3. From the Form Controls section, drag and
drop the control you want to use in your
template.

See page 23.43 for more details on each control.

4. Arrange the control where you want it on
the page.

See page 23.45 for details on the properties available.

5. From the Control Properties section,
format the control as needed.

See page 23.45 for details on the properties available.



You can also duplicate controls using
Cut, Copy and Paste functions
(including between pages).

6. Repeat step 3 through step 5 for each
control you want to add to the form.
7. Click OK when satisfied with the new
Form Encounter template.

The Save Form Encounter Template window opens.

8. In the Template name field, enter a useful
title for your template.

This name is how you distinguish the templates from
each other when you want to use one.

9. Choose the folder in which you want to
save the template.

You can choose either Personal (available only to you)
or Shared (available to multiple users). See page 2.8 for
more detailed information on Personal, Shared and
Standard folders.

10. Click OK.

The system adds the new template to the folder you
chose.

Form Controls
The Form Controls section of the Form Template Builder provides all of the controls you can add to your
template that allow you to enter data for the encounter. You can drag and drop a control to the template
design area. The system also allows you to double-click an entry in the list to add it to the design area.

Figure 23.31 Form Controls
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You can add a variety of controls to an electronic form. Table 23.2 explains each available control in more
detail. For details on setting the properties for each of these controls, see Table 23.3 on page 23.46.
Table 23.2 Controls Available on Form Templates

Field

Description

Check Box

The Check Box option allows you to add a single choice to the form. This is good
if you want the provider or other user to only check a box if the answer is yes.
MicroMD EMR places a small orange square to the left of each discrete-data
checkbox. When you record an encounter using a template that contains a
discrete-data checkbox, MicroMD EMR could ask you to specify additional data
for the item.

Date Field

The Date Field allows the user to click the arrow to display a drop-down calendar
and select the appropriate date from the calendar when they load the template.
They can also type in a date field.

Drop-down List

If you want to provide several options to those using this form, but you want to
conserve space on your form, you can add a drop-down field. This allows the
user to select from a list of items and the rest of the items are hidden from the
display. Users can only select one option from the list.

Encounter Button
(SOAP)

Add an encounter button to provide the user with access to the appropriate
encounter page (e.g., Subjective, Assessment, Review). For more details on the
sections of the encounter, please see page 23.2.

Group Box

Group boxes allow you to contain a set of controls and organize the appearance
of your online form. For example, you have a set of controls that all relate to the
patient’s vital signs and you have a set of controls related to the patient’s
medications, all on the same page of the form. You can use a group box to
surround each set of controls, visually separating them from each other and
making it easier for users of form.

Heading

A heading control is simple a way for you to add titles, subtitles and other useful
text on the electronic form. Do not confuse this with a label.

Label

A label is the control used to display the name of a field, drop-down or other item
on the page. For example, add a label “Patient Name” next to a text field where
you want the user to enter the patient’s name.

Line

The Line control allows you to add a graphic line to the form to help organize
your form and make it easy to read.

Lookup Button

Add a Lookup Button control to your form encounter to allow the user to access
a Reference List and add specific data from the database. For example, if you
want the user to choose an assessment and insert it into the form.
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Table 23.2 Controls Available on Form Templates (continued)

Field

Description

Medical Info Button

When using a template that has a Medical Information button, the user can
click the button to access the Medical Information Viewer window. The window
displays the section of the patient’s chart associated with the control in the
template (e.g., allergies, problems, hospitalization history). Highlight the
information you want to add to the encounter and click Insert. Typically there is
a text field linked to a Medical Information button and that field displays the
information you choose to insert.

Option Buttons

The Option Buttons control provides users of the template with several options
displayed at the same time, and they may only choose one of the multiple
options.

Pick List (User
Defined List)

A Pick List is a special drop-down that allows the user to select only one option. A
Pick List does not allow you to enter any option other than those listed. See
page 22.38 for more details on Pick Lists.

Picture for
annotation

The Picture for annotation control allows you to load an image or diagram that
the user of the template can click and open in MicroMD Document Management
(Chapter 28). From MicroMD Document Management, the user can edit and add
notes.

Providers Signature

If the physician has captured his or her signature in their User Preferences
(page 1.97), the Providers Signature control will pull in that image.

Rich Text

This type of text box is meant primarily for the insertion of the Immunization
Grid, especially helpful when creating and completing Camp Health Forms for
patients. This feature displays the patient’s complete immunization history and
the administration dates in a grid format with the immunizations down the left
and the dates to the right.
Once you drag and drop this control into place, resize it as needed to fit on your
template. The system automatically populates the Default field for you with the
Immunizations (Grid) option.

String Field

To gather a simple phrase or a single line of text from the user, use the String
Field control. You can also use this control to display information from the
patient’s chart, such as their first name or their age.

Text Box

To gather a paragraph of text from the user (such as impressions), use the Text
Box control. You can also use this control to display information from the
patient’s chart, such as their allergies or their current list of medications.

Setting Control Properties
The Control Properties section of the Form Template Builder allows you establish the behavior,
appearance and other aspects of each control you add to the template. The properties that you can set for
each control vary by the type of the control. Table 23.3 explains all of the available properties in detail and
in alphabetical order.

MicroMD EMR User’s Reference Manual Version 16.0

23.45

Chapter 23. Recording Encounters

Form Encounter Templates

Figure 23.32 Control Properties Section of Form Template



Not all of these fields are available with every control.

Table 23.3 Fields Available in the Control Properties Section

Field

Description

Alignment

The Alignment drop-down allows you to indicate the justification of the text
entered in the field. For example, if you want all of your date fields to be rightaligned, you can select Right from the Alignment drop-down for each field.

Attach to Field

Used for the Encounter Button, Lookup Button and Medical Info Button controls,
Attach to Field is where you indicate the data you want to access when you click
that button on the electronic form. At the bottom of the Control Properties
section, the system displays the type of control you need to associate with the
button selected (i.e., a string field or a text box).

Border

From this drop-down, you can select the border that appears around the selected
control on the electronic form. Not all controls have this option.

Control Type

All controls have the Control Type property, and this property indicates what kind
of control you have selected in the design area (e.g., checkbox, drop-down list,
Medical Info Button). You cannot edit this field.

Data Type

The Data Type field allows you to indicate the kind of information available when
you use this control during an encounter and is available for several form controls.
Please see page 23.49 for more details on setting the properties for checkboxes
and page 23.50 for option buttons. You cannot edit this field on the Pick List
control.

Default

This field allows you to choose what data populates the selected control when you
(or another user) first see it in an encounter. For example, if you want to display a
patient’s list of allergies on the Form Encounter template, you can create a text
box and set the Default field to Allergies.
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Table 23.3 Fields Available in the Control Properties Section (continued)

Field

Description

Drop Down

The drop-down control allows you to select generic information to help clarify
another data entry.

Font

The Font section is available on nearly all controls of the Form Template Builder.
They are basic formatting functions (e.g., font face, bold and italic).

Heading Level

This property is available for the Heading control. MicroMD EMR comes with three
built-in heading levels that help you to format your form consistently.

Lookup

This property is available for the Lookup icon ( ) control on a form. You must
attach a field to the Lookup icon and then specify which Reference List Viewer you
want the icon to display when clicked in the encounter. The Lookup drop-down
allows you to do that. Simply select the appropriate list from the drop-down.

Medical Info

This property is available for the Medical Info Button control. You must attach a
field to the Medical Info Button and then specify which part of the patient’s
Medical Information tab you want the button to display when clicked in the
encounter. The Medical Info drop-down allows you to do that. Simply select the
appropriate list from the drop-down.

Name

The Name field in the properties of a control identifies the control. For example, if
you need to attach a field to an Encounter Button, Lookup Button or Medical Info
Button, the text in the Name field is what appears in the Attach to Field drop-down
list. You cannot edit the Name field.

No of columns

This field is available for the Option Button control and indicates how you want
the options to display on the form. Select the number of columns and MicroMD
EMR evenly distributes the options across the number of columns. See page 23.50
for more details about setting properties for Option Buttons.

Pick List

When you insert the Pick List control, you need to specify which Pick List you want
to display in the drop-down. Click the Lookup icon ( ) next to the Pick List field
to insert the appropriate list. See page 22.38 for more details about Pick Lists.

Picture

The Picture property allows you to specify which picture or diagram you want to
display when you click the picture space in a form. Click the Lookup icon ( )
next to the Picture field to insert the appropriate image.

Position

All controls have the same position properties that help you fine tune the control’s
position and size form’s page. There are four properties: X, Y, width, and height.






X: This indicates the distance of the control from the left side of the form.
Y: This indicates the distance of the control from the top of the form.
Width: This indicates the width of the control.
Height: This indicates the height of the control.
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Table 23.3 Fields Available in the Control Properties Section (continued)

Field

Description

Text

The Text property is available on several controls. Enter the label of the control in
the Text field. For some controls, this text comes from the data you choose to
display (e.g., discrete data for a checkbox).



If you need a label for a control without a Text field,
you can use the Label control.

Setting Form Template Properties
The Form Template Builder allows you to set a number of properties for the online form, including
background color and tab sequence. These properties can apply to the entire form or to a single page
within the form. Table 23.4 explains the available options in more detail. To edit the properties of a form or
form page, click on the background of the design area and be careful not to select a control. The Control
Properties section (Figure 23.33) changes appropriately.



You know you have the form selected when the Control
Type field displays the word “Form”.

Figure 23.33 Form Properties
Table 23.4 Properties Available for the Form Encounter Template

Field

Description

Page Color

MicroMD EMR displays the color selected from the Page Color drop-down as the
background color of the current page of the template. The system does not
display the selected color in the design area—only as the border to the template.
When you use the form to record an encounter, the system displays the color
then. The background color also prints when you choose to print a form.
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Table 23.4 Properties Available for the Form Encounter Template (continued)

Field

Description

Page Title (for
printout)

The text you type in the Page Title (for printout) field appears when a user prints
the form. The text does not appear on the screen when you view the template or
the encounter based on the template.

Tab Sequence

Click the Tab Sequence button to set the order in which the focus of your cursor
moves between controls on the current page when you press the Tab key. On the
window that opens, highlight the entry and use the up and down arrows ( and
) to change the order.

Snap to Grid

When you place a check mark in the Snap to Grid checkbox, each control you add
to the template automatically aligns to the closest points on the grid when you
place the control within close proximity to the grid.

Top margin and
Left margin

The Top margin and Left margin fields allow you to adjust the alignment of the
form when you print the form to a hard copy. The Top margin field controls the
distance from the top edge of the page to the object that is at the highest point on
your form. The Left margin field controls the distance from the left edge of the
page to the object that is farthest to the left on your form.

Setting Checkbox Properties
Aside from the standard control properties, there are other considerations when adding a checkbox to
your form. When you add a checkbox to your form template, the data type for a checkbox can be either free
text (i.e., you type your own label for the checkbox) or a specific piece of discrete data from the system.
If you select Free Text from the Data Type drop-down, you can enter the label for the checkbox in the Text
field. When you record an encounter that contains a free-text checkbox, MicroMD EMR records only
whether or not you placed a check mark in the box. MicroMD EMR does not record any other information
regarding the checkbox.

Figure 23.34 Free-Text Checkbox Properties
If you select one of the discrete data options from the Data Type drop-down, click the Lookup icon ( )
next to the Text field and insert the data you want to use. When you record an encounter that contains a
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discrete-data checkbox, MicroMD EMR records the information associated with the checkbox as discrete
data in the encounter record. When you place a check mark in a discrete-data checkbox, MicroMD EMR
may prompt you for additional information.

Figure 23.35 Discrete Data Checkbox Properties



When you view the form as an encounter, the system
displays a small orange square ( ) to the left of each
discrete-data checkbox.

Setting Option Button Properties
Other than the standard properties for controls, option buttons have some special instructions. When you
add a set of option buttons to your form, the system automatically displays two buttons. You can,
however, add as many as you need and just like checkboxes, you can use either free text or discrete data. In
addition, with option buttons, you can also choose to create a set of buttons based on a Pick List instead.

Figure 23.36 Option Button Properties
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Figure 23.37 Option Button Data Window
Click the Set Data button to access the Option Button Data window (Figure 23.37). From this window, you
can select the discrete data list from which you want to create options or you can click the Add from Pick
List button.

○

When you create a set of options from a Pick List, you
cannot edit the text of the option. You can remove an
option or add an option to the list, but you cannot edit
unless it is a user-defined item.

Alignment and Sizing Controls in a Form Encounter Template
When you arrange the required controls on a page, MicroMD EMR provides you with a number of
positioning tools. These tools help you to align the controls, distribute the controls, and give the controls
the same height and/or width.
If you have a series of controls you have added to the design area and you want to line them up evenly, you
can simply highlight the controls and select one of the choices under the Align button at the top of the
design area (Figure 23.30 on page 23.42). Table 23.5 explains the options you have.



MicroMD EMR always aligns all selected controls relative
to the control that you select first.

Table 23.5 Alignment Options Available for Form Controls

Field

Description

Alignment
Left

This option aligns the left border of all selected controls with the left border of the
first control you selected.

Right

This option aligns the right border of all selected controls with the right border of
the first control you selected.

Vertical Center

This option aligns the left-to-right center point of all selected controls with the leftto-right center point of the control that you first selected.
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Table 23.5 Alignment Options Available for Form Controls (continued)

Field

Description

Top

This option aligns the top border of all selected controls with the top border of the
control that you first selected.

Bottom

This option aligns the bottom border of all selected controls with the bottom
border of the control that you first selected.

Sizing Options
Same Width

This option resizes the width of the selected controls to the width of the control
that you selected first.

Same Height

This option resizes the height of the selected controls to the height of the control
that you selected first.

Same Width
and Height

This option resizes both the width and height of the selected controls to the width
and height of the control that you selected first.

Distribution Options
Even Vertical
Spacing

This option makes the vertical spacing between each adjacent control the same as
the distance that exists between the first two controls.

○
Even Horizontal
Spacing

When you evenly distribute controls, MicroMD EMR
disregards the Snap to Grid setting.

This option makes the horizontal spacing between each adjacent control the same
as the distance that exists between the first two controls.

Adding and Arranging Pages in the Form Encounter Template
You can add multiple pages to your template (limit of 10 pages). Simply click the New Page button at the
top of the design area. The navigation buttons help you access the multiple pages of your template.
When someone uses the template to record an encounter, the system displays a Next button to move
through the pages of the encounter.
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Figure 23.38 Form Encounter Page Options
You can also reorder pages in the Form Encounter Template and insert pages in between other pages of
the template. Click the drop-down arrow next to the New Page button (Figure 23.38) and select the action
you want to take from the drop-down menu. When you choose to reorder pages, the system displays the
Page Order window. Use the up and down arrow icons ( and ) to change the order of the pages in the
template.
To delete a page, navigate to the page and select the Delete Page option in the drop-down.

Preview a Form Encounter
While you develop the Form Encounter Template, you can also preview the template and see how it will
look to someone who uses it in an encounter. Click the Preview button at the top of the template builder
(Figure 23.39).

Figure 23.39 Preview Button in Form Encounter Template

MicroMD EMR User’s Reference Manual Version 16.0

23.53

Chapter 23. Recording Encounters

Group Encounter Charting

Group Encounter Charting
For those practices who perform multiple sessions using patient groups (e.g., eating disorder therapy),
MicroMD EMR provides Group Encounter Charting. Group Encounter Charting allows you to create a single
“group” encounter with the same information for every patient in the group and then customize the
encounter for each patient. Throughout the life of the group encounter, you can append additional
sessions to each patient's encounter and add different patients to the group. Once the encounters are
complete (e.g., at the end of the day or the end of the patient's visit), you can sign off on the encounters.

Figure 23.40 Group Encounters on the Desktop
To access Group Encounters, click the Patient Care button on the Desktop and choose the Group
Encounter option. From here you can view the list of group encounters and also create new group
encounters. By default, the system displays all group encounters that are In progress (i.e., a group
encounter that has at least one individual patient encounter that has not been signed off) and those
encounters that are Completed (i.e,. group encounters where all individual encounters within the group
are signed off) for the current day.
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Use the filters at the top to find group encounters based
on Date Range, Provider, Status and more.
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Group Encounter Action Buttons
The action buttons available for the Group Encounters allow you to work directly from the Group
Encounter list and apply changes to multiple patients at once, as well as perform actions for single
patients within the group. Table 23.6 explains each button in detail.
Table 23.6 Buttons Available for Group Encounters

Button

Description

New Group Enc

Create a new encounter for a group of patients.

Edit Group Enc

Edit the selected group encounter in the list above.

Open Encounter

Open the encounter for only the selected patient in the sticky to the left. From
there, you can just view the individual patient's encounter or you can choose
to edit the individual encounter.

Open Chart

Open the chart for only the selected patient in the sticky to the left.

Health Maint.

You can view the various Health Maintenance sections of the individual
patient selected in the sticky to the left. When you select Add Health
Maintenance Program from the drop-down, you can choose the patient(s)
within the group to whom you want to apply the program.

Utilities

The Utilities drop-down allows you to print mail merge documents for the
group or complete administrative forms and write letters for the individual
patient selected in the sticky to the left. You can also print various items.

Patient Groups
Before you can create a Group Encounter, you need to have groups of patients created within the system.
See page 9.24 for details on creating patient groups. Once you have your patient groups created, you can
begin adding group encounters.

Adding a New Group Encounter
A user can start a new group encounter by clicking the New Group Enc button. This opens the Add Group
Encounter window (Figure 23.41). When you select the patient group in the Patient Group List section, the
Patient Encounters section reflects any existing unsigned Group Encounters for any of the patients in the
list.
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Figure 23.41 Adding a New Group Encounter
Make all of your selections and entries on the window and click the Create/Append Encounters button.
MicroMD EMR creates a new encounter for each patient in the Patient Group List that doesn't already have
an existing Group Encounter created. If a patient has an existing Group Encounter, the system append that
encounter with your information. See the sections below for a description of each area of the window.

Group Name
Users can choose from a Group Name that has already been created or add a new group by choosing
the reference icon. The drop-down list contains the Common List of group names. If choosing an
existing group that has been populated with patients then the system will automatically populate the
patients from that group in the Patient Group List section once selected. If adding a new group then
the user can populate the patients using the patient group list reference icon.

Patient Group List
Click the reference list icon next to the Patient Group List field. From this window, you can select all of
the patients that need to be in this group encounter. When you select the patient group from the dropdown, the patients found in that group populate the Group Member pane. Move the patients from the
Group Member pane to the Group Session pane. All of the patients listed in the Group Session pane will
be included in the group encounter.
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Figure 23.42 Adding Patients to the Group Encounter
You can add patients from several different patient groups either individually or the whole group for
the group encounter. Use the arrow buttons to move patients back and forth.

 The double-arrow buttons move all of the patients displayed in the list to the other side.
 The single-arrow buttons move only the selected patient to the other side.
Group Note
Group Encounters are text encounters. Any text that you add to this section of the window applies to
all patients in the current Patient Group List. You can write in this section from scratch or you can
choose the Text Encounter option and click the Text Encounter Template icon (
) to use a
template that you've created. See page 23.37 for details on creating Text Encounter Templates.



Use the Copy Previous icon ( ) in a Text note to bring
forward the information entered in the note created
directly before the current note.

MicroMD EMR User’s Reference Manual Version 16.0

23.57

Chapter 23. Recording Encounters

Group Encounter Charting

Figure 23.43 Group Note on a Group Encounter
The documentation added here will be appended to any existing encounters or added to a new
encounter for the patients in the list.

Patient Encounters
The Patient Encounters section lists all existing unsigned group encounters for any of the patients in
the Patient Group List section.



Patients could have an encounter from within this group
encounter or from other group encounters.

Figure 23.44 Patient Encounters Within This Group Encounter
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The plus sign ( ) next to each patient's name allows you to add a patient-specific note to the
encounter. You can double-click each row to access the individual patient's encounter. You can also
right-click each encounter to sign or open the encounter, or to open the Patient Monitor.

○

You can only record group encounters using the Text
Encounter type.
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Generate Billing Information
MicroMD EMR allows you to prepare billing information for each recorded encounter and to send this
information to your practice management system. Editing the information ahead of time from within
MicroMD EMR helps ensure the correct information in both the EMR and the PM.

In This Chapter
In this chapter, we cover how to:

 Use the Bill Builder (page 24.2)
 Edit the list of procedures on a bill (page 24.3)
 Assign diagnosis codes to procedures (page 24.4)
 Justify a procedure (page 24.5)
 Calculate the level of an encounter (page 24.7)
 Validate billing information (page 24.10)
 Send billing information to the practice management system (page 24.14)
 Sign and co-sign an encounter (page 24.15)
 Use Billing Preparation (and billing status) on the Desktop (page 24.20)

Overview
Once you complete an encounter, the time comes to send the bill to your practice management system so
you can generate claims to the insurance company. The heart of billing in the EMR is the Bill Builder
window (Figure 24.1). The system automatically displays the Bill Builder window at the end of every
encounter so you can verify billing information. The Bill Builder helps you:

 Assign diagnoses to procedures
 Correct potential billing errors
 Calculate the level of an encounter
Once the physician submits the encounter to the billing department (see page 24.14 for more information
on sending an encounter to billing), the biller can pick it up and finish processing. They can edit/prepare
billing information for the encounter either in the EMR or once exported to the practice management
system. The Billing Preparation section of the Desktop allows the billing personnel to clean up an
encounter before it reaches the practice management system.
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Bill Builder Window
The Bill Builder window allows physicians to verify the billing details gathered during the encounter. This
helps physicians minimize questions from the billing department once the system exports the bill to the
practice management system, and it increases claims-processing efficiency.

Figure 24.1 Bill Builder Window
The Bill Builder window is divided into the three sections:

 The Header section contains pertinent data about the patient, including insurance information
and referring provider, as well as encounter details such as date and time of the patient’s visit.
See page 22.36 for more details on editing the encounter header information.

 The Billing Information section of the Bill Builder lists all the procedures and diagnoses
included in the encounter, as well as validation information. See page 24.3 for more details on
editing procedures and diagnoses and page 24.10 for details on validation.

 The Signature section is the final step of the encounter. When you have recorded everything you
want to document in the encounter and finished verifying the billing information, you enter your
password to finalize the encounter, as well as send the bill to the practice management system
and print a billing report for the encounter. See page 24.15 for more details on signing
encounters.


24.2

If you need to re-open the encounter to make changes,
click the Return to Encounter button at the bottom of
the window.
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Editing the List of Procedures on a Bill
The Bill Builder lets you modify the procedures included on the claim for each encounter. In addition, you
can specify the details (i.e., modifiers, units, provider) of each procedure that is included. Table 24.1
explains the columns of a procedure line in more detail. To edit a procedure line, simply click in the
column you want to edit and make changes. Modifying the list includes:

 Adding procedures to the list
 Assigning modifiers to procedures
 Adjusting units of procedures
 Deleting procedures from the list
 Making a procedure not billable
The procedure remains in the list of procedures—but is marked not billable. Procedures with no
check mark in the Bill checkbox are not included in the final bill that is sent to your practice
management system. Non-billable procedures are included for record-keeping purposes only.

 Assigning diagnoses to procedures
MicroMD EMR assigns diagnoses that the provider recorded in the encounter to the appropriate
procedures. For more in-depth details, see page 24.4.

 Resetting the list to the list of procedures that are recorded in the encounter
When you reset the list, MicroMD EMR deletes all billing information that was entered after the
encounter was created. For example, you use the Bill Builder to delete a procedure from the list
of procedures to be billed in the encounter. If you click Reset, the Bill Builder reloads the
information that is stored in the encounter and adds any deleted procedure(s) back into the bill.

○

Making changes in the Bill Builder window only edits the
information sent to the practice management system for
the claim. Changes made in this window do not transfer
to the documented encounter.

Table 24.1 Columns in the Procedure Line

Field

Description

D

If you add notes to a plan using the Comment field, the system reflects that here.
The icon is yellow ( ) when comments exist. Click the icon to edit if necessary.
The contents of this icon also provide the insurance company with additional
documentation for claims processing.

V

This column displays the cross-coding validation indicator: Error (
Warning ( ). See page 24.10 for more details on validation.

Procedure

The system displays the procedure code in this column.

POS

This column indicates the place of service for the procedure, which you define in
the Location Type field of the New Encounter window. Click the drop-down to edit
this if necessary.
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Table 24.1 Columns in the Procedure Line (continued)

Field

Description

M1, M2, M3 and M4

These fields allow you to select any required modifiers for the procedure entered.
Click each modifier column to access the drop-down list of modifiers. If any
modifiers were added to the plan item during the encounter, those modifiers
carry through to these fields per procedure line.

Date From and
Date To

For those line items that span multiple days, you can enter the service date range
of those items in the Date From and Date To column. The system defaults to the
current visit date for both.

Description

This column displays the description associated with the selected procedure
code.

Unit

Enter the number of units applicable to this procedure. For example, if the
procedure is “removal of skin tags” and two skin tags were removed, type 2 in
this field. The Unit field carries over from the plan item added during the
encounter, but you can change it here if needed.

○

If you added two of the same procedure in the
encounter, the system creates two individual rows
for the item.

Rendering
Provider

The provider listed defaults to the provider for whom the encounter was created.
You can change this column if necessary, and if your practice uses MicroMD PM,
that information carries over to the charges in MicroMD PM.

Bill

The system displays a check mark in this box if the Bill for Item field within an
encounter is set to Yes. You can change this if necessary.

Diag

This diagnosis reference (or pointer) column allows you to associate diagnosis
codes with the correct procedure line(s). Edit this column to reflect the
appropriate diagnosis and procedure association. See page 24.4 for more details
on associating diagnoses with procedures.

Assigning Diagnoses to Procedures
The MicroMD EMR Bill Builder assigns diagnoses automatically to the procedures recorded in an
encounter. You can determine the diagnosis(es) assigned to a procedure using the Diag column of the
procedure line (Figure 24.2). The system uses “pointers” to the appropriate diagnosis fields in the Billing
Information section of the Bill Builder.

24.4

MicroMD EMR User’s Reference Manual Version 16.0

Justifying a Procedure

Chapter 24. Generate Billing Information

Figure 24.2 Diagnosis Pointers
The system uses the following logic to assign assessments to procedures:

 The system assigns the first four assessments to the office visit code.
 For the other procedure lines, if the system finds one or more diagnoses recorded in the
encounter that justify the procedure, it assigns each of those justifying diagnoses to the
procedure (up to four).

 If the system finds no justifying assessments in the encounter for a recorded procedure, it
assigns the first four recorded assessments to the procedure.
For example, Dr. Davidson recorded the encounter shown in Figure 24.2. The first procedure is the E&M
code. The system assigned Diagnosis A, Diagnosis B and Diagnosis C to the procedure. For the second
procedure line, only the diabetes code from the encounter (i.e., E11.9) justifies the Hemoglobin A1c so the
system assigns the pointer to the Diagnosis A field. The lipid panel is justified by the diabetes and
hyperlipidemia codes from the encounter so the system assigns the pointers to the Diagnosis A and
Diagnosis C fields.
You can edit the Diag column to reflect the appropriate diagnosis and procedure association if necessary.
Simply type the diagnosis code pointers in the correct order or double-click the field and rearrange the
pointers into a different order in the Diagnosis window that opens (Figure 24.3).

Figure 24.3 Diagnosis Pointer Window

Justifying a Procedure
Each procedure recorded in the encounter requires a justifying assessment. The justifying assessment
must have a valid ICD code and corresponding description. When a provider records an encounter, all
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assessments in the encounter are based on SNOMED codes—not ICD codes. For billing purposes, it is
necessary to “convert” each SNOMED code in the encounter into an equivalent ICD code.

○

For billing information to pass the validation test, you
must specify at least one justifying assessment for each
procedure in the encounter. For details about validating a
bill, see page 24.10.



You can use MicroMD EMR to automatically assign
encounter assessments to procedures based on Optum
(Ingenix) mapping. For details on assigning assessments
automatically, see page 24.4.

In the Bill Builder (Figure 24.1 on page 24.2), MicroMD EMR provides you with several options for identifying
the justifying diagnosis. The system automatically assigns the diagnosis codes for you (page 24.4).
However, you can edit the procedure and choose an appropriate assessment. See page 24.3 for details on
editing a procedure. Highlight the procedure line and click the Lookup icon ( ) at the top of the Billing
Information section. You have three options:

 Encounter Assessments: Select Encounter Assessments from the drop-down menu to display
the Encounter Diagnoses window. This “converts” the SNOMED codes the physician used in the
encounter to the equivalent ICD diagnosis codes needed for billing. All the assessments
included in the encounter appear under the Medical Description column. Highlight the
appropriate code and click Insert.

Figure 24.4 Encounter Diagnoses

 Diagnosis Lookup: Select Diagnosis Lookup from the drop-down menu to display the
Reference List Viewer window for Diagnoses. This allows you to search for the exact code you
want to use. Highlight the code and click Insert.
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Figure 24.5 Diagnosis Reference List Viewer

 Justifying Diagnoses: Select Justifying Diagnoses from the drop-down menu to launch the
Reference List Viewer window for diagnosis codes where the system automatically displays the
possible assessments for the selected procedure.

Figure 24.6 Justifying Diagnosis Recommendations

Calculating the Level of an Encounter
MicroMD EMR includes an Encounter Level Calculator. The Encounter Level Calculator assists you in
determining the level of an encounter. The actual level of the encounter can be anywhere from a Level 1
through a Level 5. Each higher level means you could potentially get paid more for the procedure.
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Figure 24.7 Encounter Level Calculator
The Encounter Level Calculator uses information recorded in the encounter and in the history sections of
the Medical Information tab of the patient’s chart, as well as additional user input, to calculate and
suggest the level of the encounter. You use the Encounter Level Calculator after the details of an encounter
have been recorded. The system divides the Encounter Level Calculator into three areas: History,
Examination and Complexity of decision making. These areas are the three key components in
determining the level of evaluation and management (E/M) services.
Each of the three key areas displays two sliders on the right side of each section that represent the
Computed level and the Actual level of the encounter.

 Computed: This is the level of the encounter as determined by MicroMD EMR—based on
recorded encounter information, as well as additional user input. You cannot adjust the
computed level.

 Actual: This is the level of the encounter as defined by the user. This allows the user to override
the Computed value. By default, the Actual level is the same as the Computed level when you
first open the Encounter Level Calculator. Move the slider to the left or to the right to adjust the
Actual level. Changes that you make to the Actual levels affect the overall calculated encounter
level.
To calculate the level of an encounter:

Procedure

Details

1. Verify that you have the Bill Builder open.

See page 24.2 for more details.

2. Click the Encounter Level Calculator icon

The Encounter Level Calculator window opens
(Figure 24.7).

(

) next to the Encounter level field.

3. Review the computed level in the History
section and adjust the Actual slider as needed.
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Details (continued)

4. Review the computed level in the Examination
section and adjust the Actual slider as needed.
5. In the Complexity of decision making section,
enter the required information.

The Computed and Actual levels change as you
enter the information.



Click the Lookup icon ( ) next to
the Problem/Options drop-down to
launch the Decision Wizard. The
wizards asks you questions and then
completes this section for you, based
on your answers.

6. In the Encounter Level section, click the
Calculate Encounter Level icon ( ).

The system displays the results of your
adjustments and suggests a level, based on the
actual values you entered in each section.

7. Click Close to close the Encounter Level
Calculate window.

The calculated encounter level appears in the
Suggested Encounter Level field in the Encounter
Level Calculator window.

8. Compare the suggested encounter level with
the recorded encounter level.
9. If you agree with the new level, click Insert.
If you do not agree, click Cancel.

If you click Insert, the system enters the level into
the billing information for the encounter. If you
click Cancel, the system uses the recorded
encounter level for billing purposes.

○

MicroMD EMR User’s Reference Manual Version 16.0

If you insert the suggested encounter
level, the system replaces only the
encounter level associated with the
billing information. The encounter
level originally recorded as part of
the encounter is not modified.
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Validating Billing Information
When MicroMD EMR validates billing information against the Optum database, it checks that each
assessment and procedure combination in the bill is allowed. The system also checks that each
assessment has a fourth or fifth digit; is appropriate for the gender of the patient; and is appropriate for the
age of the patient (including those specific to adults, specific to children, or specific to newborns). This
helps increase the accuracy of the claims you submit to the insurance companies.

Figure 24.8 Bill Validation
If MicroMD EMR detects any problems with the billing information, it displays the errors on the Bill Builder
window (Figure 24.8). You can then use the Bill Builder to fix the errors listed. We highly recommend that
you resolve all bill validation errors and warnings before submitting the bill to your practice management
system.
After you have reviewed and addressed any errors, you can save your changes and submit the billing
information to your practice management system. For details on sending the bill to the practice
management system, see page 24.14.

Validation Messages
When you prepare the bill for an encounter, you can see the reasons for the errors and warnings right on
the window. The system displays the reason(s) for the error/warning in the yellow validation section below
the procedures in the Bill Builder window (Figure 24.8). On the Plan tab in the encounter, you can also see
the reason(s) for the errors/warnings by hovering over the warning icon to display the message (Figure 24.9
on page 24.11).
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The system displays these warning indicators to simplify your workflow and allow you to address the items
quickly. There are two types of indicators displayed for procedures that may not pass the validation
checks. These errors and warnings appear throughout MicroMD EMR, including when you view encounters
as Discrete Data on the Encounter tab.

 Errors: The system displays an Error icon (

) to the left of any procedure that does not fully

pass validation.

 Warnings: The system displays a Warning icon (

) to the left of any procedure that passes
validation for the diagnosis but has other information associated with that procedure that may
cause problems during the claims process. This could be anything from a warning that the
selected code has a conflict with another procedure in the encounter to a warning that the code
you added in a female patient’s chart is for male patients only.

When you click on each procedure with an indicator, the yellow validation section changes appropriately.
Once you address each of the errors ( ) and warnings ( ), the system removes the validation messages
so you can submit the bill to your practice management system.



There may be multiple warnings or errors associated
with a procedure. Errors ( ) precede warnings ( ) in
the validation section.

Validation Within an Encounter
In the encounter, when you add a procedure on the Plan tab, the system performs checks against the
other procedures you have added, as well as against the diagnoses that appear on the Assessment tab.

Figure 24.9 Validation Within the Encounter
The system also verifies the gender and age of the patient against the information provided in the
database for the procedures. For example, if you add a female-specific procedure code to an encounter for
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an adult male and the database contains that information for the code, the system displays a message for
you when you hover over the warning icon on the Plan tab.

○

Any time that you make a change to the diagnoses and/
or procedures on the encounter, the system updates the
validation messages appropriately.

Additional Information for Diagnosis Codes
With this feature, you also have robust search capabilities for each procedure and diagnosis. On the
Assessment tab, you can highlight a diagnosis on either side of the window and click the information
bubble icon (

) on that side. This displays a menu of several options.

Figure 24.10 Information for the Selected Diagnosis
There are two options related to diagnosis codes: Valid Procedures and ICD Billing Information.
When you select Valid Procedures, the system displays a window that lists all of the procedures with
the selected diagnosis paired with it in the database. If there are no procedures with the selected
diagnosis, the system displays a blank window. Please see page 24.14 for more details about why this
could happen.
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When you select ICD Billing Information, the system displays a window containing the information
stored in the database for that code, including any age or gender restrictions for the diagnosis.

○

These options are available on all encounter recording
tools.

Additional Information for Procedure Codes
Just as you can with the diagnosis codes, the system provides similar options for procedure codes. On
the Plan tab, you can highlight a procedure on either side of the window and click the information
bubble icon (

) on that side. This displays a menu of several options.

○

These options are available on all encounter recording
tools.

Figure 24.11 Information for the Selected Procedure
There are three options:

 Justifying Diagnoses: When you select Justifying Diagnoses, the system displays a window
that lists all of the diagnosis codes that are paired with the selected procedure in the database.
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If the procedure had hundreds of diagnosis codes that justify using the procedure, the database
instead lists that procedure with the indicator “X”. Please see page 24.14 for more on messages.
When you choose one of the diagnosis codes, the system automatically adds the diagnosis to
the Assessment tab and performs checks with the other procedure codes on the encounter.

 Conflicting Procedures: When you select Conflicting Procedures from the menu, the system
displays a window that contains all procedure codes in the database that indicate some kind of
conflict with the selected procedure.

 Billing Information: When you select Billing Information, the system displays a window
containing the information stored in the database for that code, including any age or gender
restrictions for the procedure and any modifiers required for billing the selected procedure.

How Messages are Determined
When you decide to view the justifying diagnosis for a procedure, or you want to view the valid procedures
for a diagnosis, the system delves into the database to match up the codes for you and display those codes
that you can use together. There are several hundred procedure codes where there are no specific
diagnoses listed for the procedures. This is indicated by an “X”.
In these cases, when you perform a justifying-diagnosis search on a procedure in the EMR, the system
displays the search window, but with the phrase “No justifying diagnoses listed.”
In the database used for cross-checking, there are rows of procedure/diagnosis pairs. Those procedures
with no specific diagnosis codes associated with them are indicated by an “X”. For example, the following
procedure/diagnosis pairs appear in the database:

 36455

X

 71022

X

 91065

K90.89

 91065

K90.9

 91065

K91.2

On the reverse, if you perform a justifying-procedure search on a diagnosis in the EMR, you could end up
with no results in the search window that opens. This happens when the diagnosis does not appear as a
specific diagnosis in any of the rows. We can’t show you all the procedures with an “X” because this might
not be true. We err on the side of caution and leave the final decision to you.

Sending the Bill to the Practice Management System
Once you have finished the encounter and verified all of the billing details of the procedures in the
encounter, it’s time to send the bill over to the practice management system. Providers can click the Send
to Billing button when they are ready to submit the bill, but you can also set up the system so the system
sends the bill automatically to the practice management system when the provider signs the encounter (if
they haven’t already sent it).

○
24.14

You can electronically send a bill to your practice
management system only if MicroMD EMR is integrated
with your practice management system. Please contact
Henry Schein Medical Systems or your authorized
MicroMD reseller for more information.
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Manually Send Bill
You can send the bill to the practice management system at any time—just remember that you can only
submit the bill once. Simply click the Send to Billing button at the bottom of the window (Figure 24.1 on
page 24.2). Once you click this button the system automatically changes the status of the bill to Billed
(Sent). See page 24.20 for details on Billing Preparation on the Desktop.

○

You can send billing information to your practice
management system only once for each encounter. The
system disables the Send to Billing button once you
send the encounter over.

Automatically Send Bill
There is a setting in the MicroMD EMR Manager called Automatically bill when signing. You can find this
option on the Practice tab under the System Settings button. When you have this option set to Yes, the
system performs the following checks when you click the Sign (or Co-sign) button:

 When the user clicks the Sign button, the system checks to see if the encounter has already
been billed. If it has, the system does nothing regarding billing. If the bill has not been sent and
there is no co-signer required, the system sends the bill, changing the status to Billed (Sent) and
disabling the Send to Billing button. (See page 24.23 for details on bill status.)
If there is a co-signer required, the system does nothing regarding billing when the user clicks
the Sign button.

 When the user clicks the Co-Sign button on a co-sign encounter, the system checks to see if the
encounter has already been billed. If it has, the system does nothing regarding billing. If the bill
has not been sent, the system sends the bill, changing the status to Billed (Sent) and disabling
the Send to Billing button.

Signing and Co-signing an Encounter
After you have finished recording the encounter and verifying the billing information, it’s time to sign off on
the encounter. The system makes this process simple. You can sign an encounter from a variety of places
in the system—automatically after every encounter or wherever you see the Sign Encounter (or Co-sign
Encounter) button. You sign the encounter using the Bill Builder window.



Signing an encounter in MicroMD EMR is the same as
signing off on a paper chart. You are solely responsible
for the information contained in the encounter.

Figure 24.12 Signing an Encounter
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At the bottom of the Bill Builder window is the Signature section of the encounter (Figure 24.12). If you are
a provider who requires a co-signature on your encounters, the system lists those requirements in this
section. See page 24.16 for details on setting up co-signing requirements. If no one co-signs for your
encounters, the system displays No co-signing requirements specified.
To sign the encounter, simply enter your password and click the Sign (or Co-sign) button. To authenticate
your identity, signing an encounter requires your password. (See page 24.15 for details on the billing
actions that take place when you click the Sign button.)



For a list of encounters that you need to sign, please see
page 4.5.



To sign multiple encounters without re-entering your
password for each one, place a check mark in the Use
signature for next 10 encounters checkbox.

Co-Signing Requirements
Each user in MicroMD EMR can potentially have one or more physicians that are also responsible for
encounters they create. You establish those physicians in the MicroMD EMR Manager for each user that
requires a co-signature. At that time, you also establish the frequency with which the user requires a cosignature from a physician. See page 1.23 for more details on assigning a physician to co-sign a user’s
encounters and how often that signature is required.

Figure 24.13 Co-signer Needed on Your Encounter
Once you sign the encounter, it appears on the Desktop of the physician responsible for co-signing your
encounters. In the Encounters section, the system displays Unsigned (C) as the status of the encounter.
See page 4.5 for more details on this section of the Desktop.

Co-signing an Encounter
Some providers must or may have some of their encounter records co-signed by a fellow provider. When
you co-sign another provider’s encounter record, you have two options. You can sign the encounter as is,
without making changes, or you create a Co-Sign Encounter Revision and make any edits needed.

24.16
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Figure 24.14 Encounter Viewer Window

Co-sign an Encounter without Changes
If the provider for whom you co-sign encounters did a great job and you do not need to make any
changes to the documentation, you sign the encounter as is. If you need to make changes to the
encounter, please refer to page 24.18.
To co-sign an encounter:

Procedure

Details

1. Verify that you have your Desktop
displayed.
2. Click the My Workflow button in the
Desktop Navigator section.
3. Choose the Encounters section.

This displays all of the encounters you need to
sign.

4. From the list, highlight the encounter you
want to co-sign.

The Status of the encounter(s) you need to co-sign
is Unsigned (C). MicroMD EMR displays basic
details of the entry in the yellow area.

5. Click the Co-sign Encounter button.

MicroMD EMR displays the selected encounter in
the Encounter Viewer window (Figure 24.14).

6. Review the encounter.
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Procedure (continued)

Details (continued)

7. To sign without making any changes to the
encounter, click the Co-Sign (with no
changes) button.

The Co-sign Encounter window opens.

8. Complete the fields of the window and
click OK.

Co-Sign the Encounter with Changes
You have the option, if needed, to make changes to the encounter submitted to you and then co-sign
it. To do so, you create an Encounter Revision and then sign the Encounter Revision. This Encounter
Revision is called a Co-Sign Encounter Revision and appears on the Summary tab of the patient’s
chart in purple text. The system maintains a link between the two encounters. When you sign a CoSign Encounter Revision, MicroMD EMR simultaneously co-signs the original encounter.
To make changes to the encounter and then sign it:

Procedure

Details

1. Verify that you have your Desktop displayed.
2. Click the My Workflow button in the
Desktop Navigator section.
3. Choose the Encounters section.

This displays all of the encounters you need to
sign.

4. From the list, highlight the encounter you
want to co-sign.

The Status of the encounter(s) you need to cosign is Unsigned (C). MicroMD EMR displays basic
details of the entry in the yellow area.

5. Click the Co-sign Encounter button.

MicroMD EMR displays the selected encounter in
the Encounter Viewer window (Figure 24.14).

6. Review the encounter.
7. To make changes to the encounter before
you sign it, click the Create Co-sign
Encounter button.

MicroMD EMR creates a revision of the original
encounter and displays the new encounter in the
same Encounter Viewer window. There is now a
link in the header information of the window to
the original encounter. Click this link to switch
between the original and your revision copy.

8. Click the Edit button on the Co-sign
Encounter Revision.

MicroMD EMR opens the encounter in the tool
initially used to record the encounter.

9. Edit the encounter appropriately and save
it.

The Bill Builder window opens.

10. Verify the billing information.
11. Enter your password and click the Sign
button.

The system takes you back to the Encounter
Viewer.

12. Click the Close button.
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Signing Multiple Completed Encounters
When you have several completed encounters that you have already reviewed and are ready to sign,
MicroMD EMR allows you to sign multiple encounters at the same time.

Figure 24.15 Selecting Encounters to Sign on the Desktop
The Group Note indicator displays at the left of the patient name in the Patient column for patients who
are in group encounters.
If you want to sign multiple encounters, place a check mark next to each encounter you want to sign. If the
system still requires additional actions or information from you before you can sign the encounter, a
yellow warning indicator ( ) appears next to the checkbox for that encounter (Figure 24.15). If you need
to address issues, you can click the Open Encounter button to review the encounter and the Bill Builder.



Hover you cursor over the warning indicator to see what
you need to address before you can sign the encounter.

To sign the selected encounters, click the Sign Multiple button (Figure 24.15). The EMR displays the
Encounter Sign window and prompts you for your password.
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Limiting the Number of Unsigned Encounters
You can limit the number of unsigned encounters that the users in the system can have in their list. If they
reach the maximum number, MicroMD EMR does not allow them to create a new encounter record until
they have signed some of the unsigned ones. For details on setting the maximum number of unsigned
encounters for users in your practice, see page 1.35.



Each time you log in to MicroMD EMR, the Welcome
window displays your current number of unsigned
encounters.

Billing Preparation
The Filter Criteria section in the Billing Preparation of your Desktop (under the Administration button)
allows you to display a list of encounters to be billed. Table 24.2 explains the fields on this window in
detail.

Figure 24.16 Billing Preparation

○

Only those users with the Billing Personnel role assigned
to their user account have access to this section of the
Desktop.

The Group Note indicator displays at the left of the group encounters listed in the window.
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Hover the mouse over the group encounter to display the group name and session (date and time).

Figure 24.17 Group Note Indicator in Billing Preparation Section
MicroMD EMR lists only those encounters that meet all filter criteria. For example, you could display all
encounters:

 That took place on/after July 27, 2017 and on/before July 28, 2017
 And were performed by Dr. Paul Primary
 And are still to be billed
When you select an encounter in the displayed list, MicroMD EMR displays pertinent billing information
about the encounter in the yellow area of the window. Click the Open button (or double-click the
encounter) to make any changes to the bill before sending it to the practice management system.
To send the bill over to the practice management system, simply click the Set Status drop-down button
and change the status of the bill to Marked for Sending. This tells the system that the bill is ready for
export, and the interface picks up the encounter automatically.
Table 24.2 Filter Criteria on the Billing Preparation Screen

Field

Description

Date range

From the Date range drop-down, you can select a time frame or you can use the
From and To fields to specify a date range. In the From field, enter the beginning
date of the range you want to search. In the To field, enter the ending date of the
range you want to search. This date is the date the encounter was created.

Status

Select the appropriate billing status of the encounters you want to view to filter
the list displayed in the window. You can use this filter in conjunction with the date
range and one of the other filter choices on the window.

Patient

To view the list of signed encounters ready for processing for a specific patient,
select that patient using the Lookup icon ( ).

Dept.

To view the list of signed encounters ready for processing for a specific
department, select that department from the drop-down list.

Provider

To view the list of signed encounters ready for processing for a specific rendering
provider, select that physician using the Lookup icon ( ).
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Change History
MicroMD EMR tracks actions taken during bill preparation after a provider has sent the visit to billing. When
a user clicks the Send to Billing button, the audit process is activated in the background and the system
logs any changes made to the bill.
To view the Change History for auditing purposes, right-click an item listed in the Billing Preparation
section of the Desktop (under Administration) and select Change History [This Entry] from the pop-up
menu.

Figure 24.18 Selecting the Change History Option
The Change History window displays.

Figure 24.19 Change History Window
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Billing Status
Billing status is useful because it allows you to categorize all encounters into discrete categories. This, in
turn, helps you to more easily manage the task of preparing billing information for the encounters.
MicroMD EMR allows you to change the billing status of an encounter. The available status options are:

 To be Billed: When you create a new encounter in MicroMD EMR, the status of the encounter is
set to To be Billed. While preparing the billing information, the status of the encounter remains
To be Billed.

 Billed (Sent): The billing information has been sent to the practice management system.
 Marked for Sending: The billing information has been prepared and is now ready to be sent to
the practice management system. After MicroMD EMR sends the bill, the status is changed to
Billed (Sent).

 Not for Billing: No billing information for the encounter will be sent to the practice management
system.
To change the status of an encounter, simply highlight the encounter, click the Set Status button and
select the appropriate status from the drop-down.
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MicroMD EMR Reports
In every practice, there is always a need to generate reports pertaining to the business of your practice and
to generate information for papers that physicians write over the years. The reporting capabilities in
MicroMD EMR are flexible enough to meet the needs of most users. To ensure patient confidentiality for
medical information, only MicroMD EMR users with the Reports (All) and Reports (Admin) function
assigned to their account can access these reports. (See page 1.16 for more details on user roles and
functions.)

 The Reports (Admin) function allows the user to work with only those reports that do not
contain specific patient information.

 The Reports (All) function allows the user to generate any report, as long as they have a role that
allows access to patient information.

In This Chapter
In this chapter, we cover how to:

 Generate reports (page 25.3)
 Create mail merge reports (page 25.4)
 Add patients to Patient Groups from a report (page 25.5)
 Export data from a report (page 25.7)
 Graph data from a report (page 25.7)
 Create a new report (page 25.10)
 Copy reports (page 25.13)
 Define queries (page 25.14)

Overview
The MicroMD EMR reporting facilities allow you to create and run your own reports. You can use built-in
report templates or create your own reports. Using MicroMD EMR, you can create tailor-made reports to
meet the specific requirements of your practice. The list of possible reports is almost limitless since
MicroMD EMR derives the data for the reports from the standard MicroMD EMR database.
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Figure 25.1 Reporting Facilities
You can generate any of your administration reports from your Desktop (if you have administrative access
rights). Display your Desktop and click the Administration button. Choose Reports from the available
options (Figure 25.1).
The left side of the window displays the available categories of reports. The right side of the window
displays the list of reports within the selected category. From this window, you can generate reports,
create your own from existing ones, and more.

Report Templates
Each report that you create using the MicroMD EMR reporting facilities is based on a report template,
whether it’s a built-in template or one that you create for your own needs. The report template defines the
basic layout and structure of the report and the data fields used to generate the report. The system
contains a set of standard report templates. You cannot add to, edit, or delete these built-in report
templates.

○

After you create and save a report, you can no longer
switch the template upon which you based the report.

Each report template contains a list of fields that you can use in the query of any report that is based on the
template. Some fields are required in the queries of the report, while other fields are optional. Required
fields appear in the Reference List Viewer window in red text.
25.2
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For example, the Encounter Time report template includes the following two fields: Provider and
Encounter Date. When you create a report based on the Encounter Time template, you can include the
Provider and Encounter Date fields in the associated query.

Report Categories
In order to allow you to manage your reports effectively, you can organize the reports into categories. The
available report categories are pre-defined—you cannot add any new categories, or edit or delete any
existing categories. These report categories exist for each of the three report types (i.e., Personal, Shared,
Standard). See page 2.8 for more information on working with Personal, Shared and Standard templates.
Highlight a category in the Report Groups section, and the system displays all of the report templates
created for that category on the right (Figure 25.1). If you choose a different option from the Type section,
the list of reports changes for the selected category, depending on the contents of the folder you chose.

Generating a Report
You can use the MicroMD EMR reporting facilities to generate your reports. If a report contains a query that
has a parameter whose value is “Ask me for a value at run-time,” you will be required to enter a value for
the required field when you run the report.

○

You can hide identifying patient information. Simply
remove the check mark from the Show Patient Identifiers
checkbox if available on the report. This affects printing,
as well as exporting data.

Figure 25.2 Generating a Report
To generate a report:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button and choose the
Reports option.

The system displays the reporting facilities in the
right side of the window (Figure 25.1 on page 25.2).

3. From the Type section, choose the folder
location of the report you would like to
generate.

See page 2.8 for more information on Personal,
Shared and Standard templates.
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Procedure (continued)

Details (continued)

4. From the Report List Filter Criteria section,
select the category in which the report is
located.

On the right side of the window, the system displays
a list of the reports available in the selected
category.

5. Highlight the report you want to generate
and click Run.

The system generates the report automatically and
displays a new window. If there are parameters you
need to specify first, the system displays those fields
at the top of the new window. Choose the
parameters you want to use and click the Run
button at the top of the window. See page 25.14 for
in-depth details on defining report queries.

6. Click the Print button to print your report.

The Print window opens.


7. Select your printer and click OK.

You also have the option to merge
the patients in the report out to a
letter (page 25.4), to add the patients
in the report to a Patient Group
(page 25.5) or to export the report to
a file (page 25.7).

The system prints your report.

Creating Mail Merge Letters from Reports
The MicroMD EMR reporting facilities let you mail merge the results of a report with a letter template. This
allows you to send a standardized letter to patients that meet a specific set of criteria. In addition, the
system allows you to print labels for each patient in the list, making you task more efficient.
For example, you can generate a report that lists all patients over the age of 60. Then you could specify the
contents of a letter that would be sent to these patients. MicroMD EMR then prints a personalized letter for
each patient, using the patient’s address (and other demographic data) from the MicroMD EMR databases.

Figure 25.3 Mail Merging Data from a Report
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To mail merge data from a report into a letter template:

Procedure

Details

1. Generate the report.

See page 25.3 for more details.

2. Click the Mail Merge button.

The Mail Merge window opens.

3. Click the Lookup icon (
Template field.

The Load Letter Template window opens and lists
your personal letter templates by default. See
page 2.8 for details on accessing and working with
items in the Shared and Standard folders.

) next to the Letter

4. Highlight the letter template you want to use
for the mail merge and click Load.

The name of the selected letter template appears in
the Letter Template field. For details on Letter
Templates, please see page 26.2.

5. Click the Lookup icon (
Provider field.

The Reference List Viewer window opens and
allows you to specify another provider if necessary
for the purpose of the letter. The system sets this
field to the current user by default. You only need to
specify a provider if different than the current user.

) next to the

6. Highlight the appropriate provider and
click Insert.
7. Move the appropriate entries from the Report
Results side of the window to the Send
Letters To side of the window.

You can double-click the entries to move them back
and forth. You can also highlight the entry and click
the appropriate arrow icon in the middle.

8. Click the Print button.

The Print Options window opens.

9. Make any special choices and click OK.

The system prints the mail merge letters to the
specified printer.



You can print labels for each of the
members on your list. Simply click
the Create Labels button.

Adding Patients to Patient Groups from a Report
The MicroMD EMR report writing facilities allow you to add the patients in the report to your practice’s
Patient Groups. Once you add the patients to a Patient Group, the system displays the appropriate
“sticker” on their chart.
For example, you could generate a report that lists all patients over the age of 60. Once you view the report,
you can add those patients to your Patient Group called OVER 60. For more in-depth details about Patient
Groups, refer to page 9.24.
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Figure 25.4 Patient Groups Window
To add patients to a patient group:

Procedure

Details

1. Generate the report.

See page 25.3 for more details.

2. Click the Patient Groups button.

The Patient Groups window opens (Figure 25.4).

3. From the Patient Group drop-down, select the
group to which you want to associate patients
from the report.

The options in this drop-down are only those
Patient Groups set to populate manually. The
groups set to populate automatically do not
appear in this list.

4. Move the appropriate entries from the Report
Results side of the window to the Add Patients
to Group side of the window.

You can double-click the entries to move them
back and forth. You can also highlight the entry
and click the appropriate arrow icon in the middle.

5. Click Add to Group.

The system adds the patients displayed on the
right side of the window to the selected Patient
Group.

6. Repeat step 3 through step 5 for each group of
patients from the report that you want to add
to a Patient Group.



Remember to remove any patients
from the Add Patients to Group side
of the window that you do not want
to add to the next group.

7. Click Close when finished.
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Exporting Data from the Report
When you generate a report, there may be times when you need to save that data to an external file (e.g.,
text, Excel, comma-separated). This is extremely helpful if you need to manipulate the data from the report
for your purposes. Once you generate the report, simply click the Export button (Figure 25.2 on page 25.3),
choose the type of file you want to create with the data (Figure 25.5) and click Save.

Figure 25.5 Exporting Report Data to an External File Format

Saving Changes to the Report
Once you generate a report and are satisfied with the parameters, you have the option to save the
parameters in the current report, which alters the report, or to save the parameters as a different report
without affecting the original. Click the Save button on the report to change the current report so these
same parameters appear automatically the next time you open the report. This saves you time for those
reports you generate frequently. Click the Save as button to create the same report under a different name.
This preserves the original.

Graphing Capabilities
You have the ability to display a graph for several reports in MicroMD EMR. The system uses the data you
generate in the report to show you a visual representation of the data. The following standard reports have
this graphing ability:

 Clinical Indicators / Top 10 Diagnoses
 Encounters (Admin) / Unsigned Chart Rate
 Encounters (Admin) / Average Time per Provider
Simply generate the report and before you click the Run button at the top of the window, select Graph
from the Output drop-down (Figure 25.6).
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Figure 25.6 Graphing Capability
For more in-depth details about generating reports, please page 25.3.

Customizing the Current Graph Display
You can customize the look of the graph to better suit your needs. Double-click the graph area and the
appropriate Customize Report window opens (Figure 25.7), allowing you to customize your report view.
The tabs available in the Customizations window differ depending on the selected report.
You can also right-click the graph display and select the customization you want to make. The choices
available are the same as those available on the Customizations window.

○

25.8

Any customizations that you make are only available
while the report is open. Once you close the report, the
system reverts the report back to its default values.
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Figure 25.7 Customization Options for the Top 10 Diagnoses Report Graph

Printing/Exporting a Graphed Report
Once you have a report generated and displayed as a graph, you can print the graph or export it as an
image file. When you want to print the graphed report, you simply click the Print button at the top of the
window. The system prompts you to choose your printer and whether you want to print the graph in color
or monochrome (Printing Style). See Figure 25.8.

Figure 25.8 Printing a Graph
If you want to use the graph as an image in a presentation or report, the system provides several options in
the export window. Double-click the graph (or right-click the graph display and select Export Dialog from
the pop-up menu) and click the Export button (Figure 25.9). The system displays the Exporting window.
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Figure 25.9 Exporting a Graph
In the Export section, you choose the type of file you want to create. If you choose any of the image options
(i.e., BMP, JPG, PNG), the system disables the Printer option in the Export Destination section. In the Export
Destination section, you choose where you want to export the graph:

 Clipboard: This option simply copies the graph to the Windows clipboard so you can paste it
into a separate application such as Microsoft® Word or Paint.

 File: This option allows you to choose where you want to save the file type you chose in the
Export section. Click the Browse button to navigate to the location and to name the file.

 Printer: This option simply sends the graph to your printer. When you choose this option, the
system changes the Export button to a Print button.

Adding a New Report
MicroMD EMR allows you to create new reports based on the existing templates in the system. You can
customize these existing reports to meet the needs of your practice. There is no limit to the number of
reports that you can create.

○

Once you choose a template for a report, you cannot
change the template. You can choose to display different
data for the report when you first launch it, but you
cannot change the base of the report.

To edit, delete or rename an existing report, simply highlight the report and click Edit, Delete or Rename as
appropriate. You can edit and delete reports in the Personal and Shared folders. You cannot edit or delete
any of the built-in reports in the Standard folder.
To add a new report:

Procedure

Details

1. Verify that you have the Desktop
displayed.
2. In the Desktop Navigator section, click
the Administration button and select
the Reports options.

25.10

The system displays the reporting facilities in the right
side of the window (Figure 25.1 on page 25.2).
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Procedure (continued)

Details (continued)

3. From the Type section, choose the
folder location where you would like to
save the new report.

See page 2.8 for more information on the Personal,
Shared and Standard templates.

4. From the Report Category list, select
the category in which you want to save
the report.

On the right side of the window, MicroMD EMR displays a
list of the reports that already exist in the selected
category.

5. Click the New button.

The Add Report Wizard opens and displays the first step.

Name and Description
6. Click the Lookup icon (
Name field.

) next to the

You must associate a template with the report.
The Reference List Viewer window opens and displays
your Common List of report templates.

The right side of the Reference List Viewer window
displays the name and description of the selected
template, as well as the list of fields available in the
template. The system lists required fields in red text.

MicroMD EMR User’s Reference Manual Version 16.0

25.11

Chapter 25. MicroMD EMR Reports

Adding a New Report

Procedure (continued)

Details (continued)

7. Highlight the appropriate template and
click Insert.

The name and description of the selected template
appear in the first step of the Add Report Wizard.

8. In the Report Name field, enter a useful
name for the report.

MicroMD EMR uses this name to identify the report in
lists—it does not appear on any reports.

9. In the Description field, enter a brief
description of the purpose of the report
and the data it returns.

This description appears in MicroMD EMR only—it does
not appear on any reports. This description should help
any user understand at a glance the purpose of the
report.

10. From the Category drop-down, select
the category in which you want to save
the new report.

This defaults to the category you selected in step 4 on
page 25.11. Change this only if needed.

11. In the Type section, select to save the
report in the Personal or Shared folder.

This defaults to the choice you made in step 3 on page
25.11. Change this only if needed.

12. Click Next.

The Add Report Wizard moves to the next step.

Report Criteria
13. Create your report options using fields
in the Query section.

These are the search criteria that define what data the
system pulls into your report. See page 25.14 for in-depth
details on defining report queries.

14. From the Sort By drop-downs, select
how you want the system to organize
the finished report, if you want a
specified sort.
15. Click Next.

The Add Report Wizard moves to the next step.

Report Title
16. In the Report Title field, enter a title for
the report.
25.12
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Details (continued)

17. In the Report Sub-title field, enter a sub- This title appears underneath the main title on the report
title for the report.
you generate.
MicroMD EMR saves the report in the folder

18. Click Finish.

Copying a Report to a Different Category
The MicroMD EMR reporting facilities let you copy an existing report to a different category. When you copy
a report to a different category, MicroMD EMR keeps the existing report and creates a new report in the
specified location.
For example, assume that you have a report named Report1 in the category Patients Seen. If you now copy
the report to the Hospital Admissions category, then report Report1 will exist in both categories.
The ability to copy a report to another category is especially useful if you feel a report is easier to find under
another category. It is also helpful when someone saved the report under the wrong category. You can
copy the report to the correct category and delete it from the wrong one.
To copy a report to a different category:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button and choose the
Reports option.

The system displays the reporting facilities in the
right side of the window (Figure 25.1 on page 25.2).

3. Locate and highlight the report you want
to copy.
4. Click the Copy To button.

The Copy Report To window opens.

5. Locate and highlight the category to which
you want to save a copy of the selected report.
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Details (continued)

6. Choose which folder type under which you
want to save the report.

For details on Personal, Shared and Standard
templates, please see page 2.8.

7. Click OK.

MicroMD EMR copies the report to the location you
specify, leaving the original intact.

Defining Queries
At the heart of each report you create is the report query. The query defines exactly what conditions each
piece of data must meet before it can appear on the resulting report. The pieces of data are the fields
available in the selected report.

Figure 25.10 Define Queries for the Selected Report
MicroMD EMR allows you to create two types of queries: simple and complex.

 Simple: A simple query consists of only one condition (i.e., sex = male)
 Complex: A complex query is a query made up of a number of simple queries. You join simple
queries by the appropriate Boolean expressions “OR” or “AND” (i.e., sex = male AND age > 45).
Some complex queries may include parentheses. For example, you want your report to include
those encounters from either the Boardman office or the Canfield office for male patients. Your
query would look like this: (Clinic = Boardman OR Clinic = Canfield) AND sex = male.
You use the Query section of the Query Definition tab to define a query. Table 25.1 explains the fields of
this tab in more detail.

25.14
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Table 25.1 Fields Available on the Query Definition Tab

Field

Description

Field Name

The template on which you base your new report defines the list of field names that are
available for use in a query. For example, if a report is based on the “Completed
Immunizations” report template, the available fields are Age, Date Administered, and
Vaccine.
Some reports have required fields, that is, fields that must be included in the query. For
example, queries for reports that are based on the “Patients Seen” report template
must include the field Provider.

Condition

The full set of available conditions is “=, <>, <, >, <=, >=.” The set of conditions that is
available depends on the field name that you select. For example, if you select the field
name Gender, the available conditions are “=” and “<>”. If you select Date, the full set of
conditions is available.

Value

There are two ways for you to specify a value for a query:

 You can select a fixed value from a list. For example, if you will always run the
report for only female patients, you can select the value Female.

 If the value of the query changes each time you generate the report, you can
instruct MicroMD EMR to ask you to select a value before you the run the report. For
example, if you run the report sometimes for males and sometimes for females,
you would select Ask me for a value at run-time.
Logical

The choices in the Logical drop-downs are the Boolean expressions used to connect
complex queries.

Defining a Simple Query
You can generate some reports using a simple query. A simple query is a single condition that the data
should meet before it appears in the resulting report. For example, a report that lists all male patients
requires a simple query. That query would be Gender = Male.
To create a simple query:

Procedure

Details

1. Verify that you have the Query Definition
tab or the Report Criteria page displayed.

You see the Report Criteria page when you add a
new report. You see the Query Definition tab when
you edit an existing report (Figure 25.10).
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Procedure (continued)
2. From the Field Name drop-down, select the
first bit of data you want to include in the
report.

Defining Queries

Details (continued)



The system displays in red those
fields you must include in the report.

3. Select the appropriate operator from the
Condition drop-down.

The system displays only those operators available
for the type of data in the field chosen.

4. From the Value drop-down, click the icon
with three dots on it ( ) next to the dropdown.

The system opens the Field Value dialog.
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Procedure (continued)

Details (continued)

5. Either select a specific value this field must
meet every time you generate the report or
select Ask me for a value at run-time.

6. Click OK.
7. Click Finish or Next, depending if you are
editing or adding a report.

Congratulations! You have created a simple query.

Defining a Complex Query
Some reports require complex queries. A complex query contains a number of simple queries joined by
Boolean expressions (i.e., OR and/or AND). If you want to produce a report for all male patients over the
age of 45, you would need a complex query. That complex query contains the two simple queries: Sex =
Male AND Age > 45.

Figure 25.11 Example Complex Query
Some complex queries may require parentheses in order to correctly define the information you want to
pull out of the database. For example, if you want a report for all male patients that are either under 18 or
over 45, you would need three simple queries, two of which you should enclose with parentheses: Sex =
Male AND (Age < 18 OR Age > 45).
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Figure 25.12 Example Complex Query with Parentheses
The following example describes how Summervale Medical Center used the MicroMD EMR reporting
facilities to create a report containing a complex query. The report lists all the encounters that have been
recorded by Dr. John Abbott during the date range specified at the time they generate the report.

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button and choose the
Reports option.

The system displays the reporting facilities in the
right side of the window (Figure 25.1 on page 25.2).

3. From the Type section, choose the Personal
folder.
4. From the Report Category list, select the
Encounters (clinical) category.

On the right side of the window, MicroMD EMR
displays a list of the reports that already exist in the
Encounters (clinical) category.

5. Click the New button.

The Add Report Wizard opens and displays the first
step.

Name and Description
6. Click the Lookup icon (
Name field.

) next to the

7. Click the Index button and select
Encounters (clinical) from the drop-down
list.

The Reference List Viewer lists all the report
templates in the Encounters (clinical) category.
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Details (continued)

8. Highlight the Patient Encounters report
and click Insert.
9. In the Report Name field, type
Encounters for Dr. John Abbott
by Date.

MicroMD EMR uses this name to identify the report in
lists—it does not appear on any reports.

10. In the Description field, type This
report prints all the
encounters that have been
recorded by Dr. John Abbott
during a specific date range.

This description appears in MicroMD EMR only—it
does not appear on any reports. This description
should help any user understand at a glance the
purpose of the report.

11. In the Category drop-down, leave the
default value.

This defaults based on the choice you made in step 4
on page 25.18.

12. In the Type section, leave the default.

This defaults to the choice you made in step 3 on
page 25.18.

13. Click Next.

The Add Report Wizard moves to the next step.

Report Criteria
14. From the Field Name drop-down, select
Provider.



You can see that the selected
template has no required fields
because no fields appear in red text.

15. From the Condition drop-down, select =.
16. From the Value drop-down, click the icon
with three dots on it ( ) next to the dropdown.

The system opens the Field Value dialog.

17. Click the Lookup icon ( ) next to the field
for Please enter the provider.

This opens the Reference List Viewer window for
providers.

18. Select Dr. Abbott and click Insert.
19. Click OK on the Field Value dialog.
20. From the Logical drop-down list, select
AND.

This means that the patient encounters that appear
in the report must meet both sets of criteria.

21. In the second row, select Encounter Date
from the Field Name drop-down.
22. From the Condition drop-down, select >=.

This serves as the “From” date in your range.

23. From the Value drop-down, click the icon
with three dots on it ( ) next to the dropdown.

The system opens the Field Value dialog.
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Details (continued)

24. Choose Ask me a value at Runtime and
click OK.
25. From the Logical drop-down list, select
AND.

This means that the patient encounters that appear
in the report must meet both sets of criteria.

26. In the third row, select Encounter Date from
the Field Name drop-down.
27. From the Condition drop-down, select <=.

This serves as the “To” date in your range.

28. From the Value drop-down, click the icon
with three dots on it ( ) next to the dropdown.

The system opens the Field Value dialog.

29. Choose Ask me a value at Runtime and
click OK.
30. From the first drop-down in the Sort By
section, select Encounter Date.
31. From the second drop-down in the Sort By
section, select Ascending.

This prints all encounters recorded by John Abbott
with the most recent encounters at the top of the
report.

32. Click Next.

The Add Report Wizard moves to the next step.

Report Title
33. In the Report Title field, type List of
Encounters by Date.

This name appears on the report every time you
generate it.

34. In the Report Sub-title field, type
Encounters for Dr. John
Abbott – Specific Date.

This title appears underneath the title “List of
Encounters” you entered in step 33.

35. Click Finish.

Congratulations! Your report is now complete. To
generate the report, please refer to page 25.3.
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Letters in MicroMD EMR
MicroMD EMR allows you to quickly and accurately generate and print letters for patients and specialists in
your database. Not only can you use the letter templates built into the software, but you can also create
your own letter templates to meet the specific needs of your practice.

In This Chapter
In this chapter, we cover how to:

 Create letter templates (page 26.2)
 Print a letter based on template (page 26.5)
 Save a letter to the patient's chart (page 26.7)
 Print patient labels (page 26.8)
 Print specialist labels (page 26.9)

Overview
MicroMD EMR allows you to print a variety of customized letters easily and efficiently. Each letter that you
print is based on a letter template. The templates ensure that the letters contain the required information
and allow you to generate letters that have a consistent format.
For example, Summervale Medical Center created a letter template called “Work Release”. This template
defines the content and format for letters that requests a patient to be released from work due to existing
medical conditions. Now whenever Betty needs a letter for this purpose, she does not have to start from
scratch. She can just choose the patient, choose the template and print.
Printing a patient letter involves the following basic steps:

 Choose a patient
 Load a letter template
 Preview and edit the letter if necessary
 Print the letter
You can print a referral letter from the referral orders either from your Desktop or from within the patient’s
chart.



Letter templates can populate the patient’s current
problems and current long-term medications in the
resulting letter. To ensure confidentiality of medical
information, only MicroMD EMR users that are able to
access patient charts can produce letters that contain
medical information. For details on how to modify user
access, please see page 1.16.

MicroMD EMR User’s Reference Manual Version 16.0

26.1

Chapter 26. Letters in MicroMD EMR



Letter Templates

To ensure that the information in the letters you print is
always complete and up-to-date, ensure that the
information in the MicroMD EMR Manager is complete
and up-to-date—both for the practice and for all
MicroMD EMR users.

Letter Templates
The foundation for generating standardized letters is the template. Templates allow you to “boilerplate”
your documents, customizing only the information that is different. For example, you have the same letter
you send to all of your new patients. The only difference in the letter is the patient’s name and address. You
can create a letter template so you only have to write the letter once. You can find templates for patient
letters under Tools > Letter Templates and templates for specialists under Tools > Referral Letter
Templates.
To edit, delete, rename or print a hard copy of a letter template, simply highlight the template and click the
appropriate button. If you want to copy a template, highlight the template and click the Copy button.
Select the folder where you want to store the copy and click OK. This is extremely useful when you want to
modify a template to meet special needs.

○

You cannot delete or rename any of the templates in the
Standard folder.

Creating a New Letter Template
When you create a new template, you start with a blank template. Then, you add text and fields to the
blank template to produce the standardized letter you want. When you save the new template, you can
define the template to be either personal or shared. For more details on Personal, Shared and Standard
folders, please see page 2.8.

26.2

MicroMD EMR User’s Reference Manual Version 16.0

Letter Templates

Chapter 26. Letters in MicroMD EMR

Figure 26.1 Creating a Patient Letter Template
The Merge Fields section on the left of the window allows you to pick and choose the data you want to
include in your letter. When you print a letter based on a template, MicroMD EMR extracts specific
information from the database and inserts it into the letter. If there is no data in the patient’s chart for a
field included in the template, the system doesn’t print anything.
The right side of the window is your letter template. You can type and format the text however you like.
When you insert merge fields from the left side of the window, the system displays those fields in yellow.



You can paste an image into the letter template. Simply
open the image in Microsoft® Paint, select the image and
copy it. In the Letter Template, select Edit > Paste from
the main menu.

To create a new letter template:

Procedure

Details

1. For patient letters, select Tools > Letter
Templates from the main menu.

The Letter Template Manager window opens and
displays your Personal folder by default.

For specialist letters, select Tools > Referral
Letter Templates from the main menu.
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Procedure (continued)

Details (continued)

2. Click the New button.

The Letter Template Builder (New Letter
Template) window opens (Figure 26.1).

3. Type your text in the right side of the window
and insert fields from the left as appropriate.

You can format your text as needed using the
editor’s ribbon toolbar. See page 26.4 for more
information on working with fields.



If you have the appropriate software
installed, you can use the Voice
Recognition button to dictate your
letter to the system.

4. Click OK.

The Save Letter Template window opens.

5. Click the Personal folder or the Shared folder,
depending on where you would like to save
this template.

The window displays the appropriate folder.
Remember: You cannot save to the Standard
folder.

○

If you chose to save the template in
the Shared folder and the template
applies to a specific department
within the practice, select that
department from the Dept dropdown.

6. In the Template name field, enter a useful title
for the template.

Other users should be able to understand quickly
the purpose of the template.

7. Click OK to save the template.

The new template appears in the appropriate
folder in the Letter Template Manager window.

Working with Fields in a Letter Template
When you create a new letter template or edit an existing template, you can insert fields similar to mail
merge fields in Microsoft® Word. A field is a placeholder for a specific piece of data from the database.
When you print a letter based on the template and one that contains merge fields, MicroMD EMR replaces
the placeholder with the appropriate data.
For example, Betty at Summervale Medical Center created a Welcome Letter template. In the letter she
typed Dear and then inserts the merge field PATIENT’S NAME (FIRST). The system inserts the patient’s
name, so the printed letter reads, “Dear Andy”.
You choose the fields you want to insert from the Merge Fields section of the Letter Template Builder
window (Figure 26.1).
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○

Some fields in a letter template populate the letter with
the patient’s current problems and current long-term
medications. To ensure confidentiality of medical
information, only those MicroMD EMR users with access to
patient charts can produce letters that contain medical
information. For details on how to modify user access,
please see page 1.16.

To insert a field into a letter template, simply place your cursor in the appropriate location in the letter and
then double-click the entry in the Merge Fields section. You can also drag and drop the entry where you
want it to appear in the letter.



Use the Common list and Index features in the Merge
Fields section to make locating required fields easier.

To delete a field from a letter template, simply click inside the field and click the Delete Field button in the
ribbon bar. You can also right-click the field and select Delete from the pop-up menu.

Formatting a Letter Template
When you create a new letter template or edit an existing template, you can define the format of the
template. Formatting includes making text bold, italic, underlined, changing the line spacing, justification.
To format a letter template, simply highlight the text and use the controls within the editor to change the
size, face and color of the font. You can also change the alignment of text and the margins.

○

You can apply all the formatting techniques both to static
text and to fields in a template.

Printing a Letter
You can print a patient letter in a number of ways. If working with Patient Groups, you can print a letter for
the patients in a specific group (page 9.30). You can also print a patient letter from the Utilities or Tools
button found in several sections of the Desktop (e.g., Figure 4.14 on page 4.19 and Figure 4.20 on page
4.27). You can also write letters within the patient’s chart from the Medical Information tab or from the
main menu (under Print > Letter), if you have access to the patient’s chart.
When you create an order to send the patient to the specialist (whether from an encounter, their chart or
your Desktop), the system displays the order window (Figure 15.9 on page 15.12). From this window, you
can click the Referral Letter button to write a letter regarding the referral.
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Figure 26.2 Printing a Letter
The Write Letter window (Figure 26.2) functions the same in both the referral and the patient letters. The
Letter Template field simply pulls from a different set of templates. When printing a letter, you can also
specify that the system save a copy in the patient’s chart. (For details on how to access letters saved to the
patient's chart, please see page 20.12.)
To print an individual letter:

Procedure

Details

1. Verify that you have your Desktop displayed.

○
2. Click the Write Letter task in the Desktop
Tools section of your Desktop.

If printing a referral letter, click the
Referral Letter button on the Referral
Order window and skip to step 5.

The Select Patient window opens. If you cannot see
the Write letter task, click the Modify Toolbar icon
( ) and run the tool from the toolbox editor.
Please see page 3.2 for more details.

3. Search for and select the patient to whom
you want to write the letter.
4. Click the Insert button.
5. Click the Lookup icon (
Template field.

26.6

The Write Letter window opens (Figure 26.2).
) next to the Letter

This opens the Load Letter Template window.
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Procedure (continued)

Details (continued)

6. Search for and highlight the letter template
you want to use.

See page 2.8 for details on working with Personal,
Shared and Standard folders.

7. Click the Load button.

You can also double-click the template to load it.
The system enters that template into the Letter
Template field.

8. In the Sent from drop-down, select the
MicroMD EMR user sending the letter if
different from the current user logged into
the system.

This is especially helpful when a nurse or
receptionist needs to send a letter on behalf of the
physician.

9. In the Sent to and Comment fields, enter the
appropriate details if needed.

The Title field defaults to the Title from the Letter
Template. You can change this if needed. The Title
appears in the list of letters in the patient’s chart.

10. If you want to save the selected letter to the
patient’s chart, place a check mark in the
Save letter to patient’s chart checkbox.
11. Click the Preview/Edit or Print Letter
button as appropriate.

Click the Preview/Edit button to take a look at the
letter before you print it. This is helpful if you are not
sure that the template you chose is the right one.
From the Application Editor window, you can edit
the letter if needed, print the letter or cancel out of
the window and choose another template.



If you want to save the letter as a
separate file, click the Preview/Edit
button and select File > Export from
the main menu.

Save the Letter to the Patient’s Chart
For the majority of letters, you want to keep a copy of documents sent to the patient. To do this, you make
sure there is a check mark in the Save letter to patient’s chart checkbox on the Write Letter window (Figure
26.2 on page 26.6). If you do not want to save the selected letter to the patient’s chart, remove the check
mark from this option.
However, if there is a specific letter template that you rarely or never save to a patient’s chart (e.g., a
handout about the practice’s hours and services), you have the option to set the default for the Save letter
to patient’s chart checkbox so staff members do not have to remember to remove the clear the checkbox
every time.
When you create a letter template in the system, click the Properties button on the template. Remove the
check mark from the Save letter to the patient’s chart checkbox (Figure 26.3). You can change it when you
actually write the letter in the future if you choose at that time to save the letter to the patient’s chart.
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Figure 26.3 Default for Letter Template

Printing Patient Labels
You can also print labels for communication you need to send to patients through the mail or for other
uses. To print a single label for a letter you need to send, you can do so easily from the Desktop Tools
section of your Desktop.

○

If you generate letters from a list of patients in a Patient
Group and want to print labels for those patients, please
see page 9.30.

Figure 26.4 Printing Labels

26.8

MicroMD EMR User’s Reference Manual Version 16.0

Printing Specialist Labels

Chapter 26. Letters in MicroMD EMR

To print a label:

Procedure

Details

1. Verify that you have your Desktop displayed.
2. Click the Print label task in the Desktop Tools
section of your Desktop.

The Select Patient window opens.
If you cannot see the Print label task, click the
Modify Toolbar icon ( ) and run the tool from
the toolbox editor. Please see page 3.2 for more
details.

3. Search for and select the patient for whom
you need to print a label.
4. Click the Insert button.

The Labels window opens (Figure 26.4).

5. From the Label name drop-down, select the
size of labels you want to print.

The labels displayed in the window change
appropriately when you choose the size of the
label from this drop-down, as well as when you
choose the content of the label in step 6.

6. From the Label content drop-down, select the
type of data you want to print on the label.



The labels in the display may “stick”
on another size when you change
either of these drop-downs. If this
happens, try entering a number in
the Print Each Label field and
tabbing off the field. This should
reset the image. You can then reenter
the correct quantity and continue.

7. In the Display Quantity section of the window,
indicate how many labels you want to print.
8. Click Print when ready.

Printing Specialist Labels
MicroMD EMR provides the ability to print labels for communication you need to send to specialists
through the mail or for other uses. To print labels, you can do so easily using the Referring Physician Listing
report.

○

To access the reporting module for this report, you must
have the Reports (Admin) function assigned to your user
account. Please see page 1.16 for more details on user
roles and functions.

Create Referring Physician Listing Report
You need to create a Referring Physician Listing report in your Personal or Shared folders before you can
print labels for specialists. This administrative report creates a list of all referring physicians listed on

MicroMD EMR User’s Reference Manual Version 16.0

26.9

Chapter 26. Letters in MicroMD EMR

Printing Specialist Labels

patient encounters relevant to the date you enter. If a physician in your specialist list does not appear on
the Bill Builder window for the encounter during the date criteria you set, they do not appear in this list.
Once you have the report created and saved in either your Personal or Shared folder, you won’t have to
recreate it each time you want to print labels.



Please refer to Chapter 25 for in-depth details on the
reports module.

Printing Labels for the Referring Physician
Once you have the report created, you can use it to print the labels you need. To access the reporting
module for this report, you must have the Reports (Admin) function assigned to your user account. Please
see page 1.16 for more details on user roles and functions.
To print labels for referring physicians:

Procedure

Details

1. Open your Desktop tab.
2. Click the Administration button.
3. Click the Reports option.
4. Under the Administrative reports, highlight
the Referring Physician Listing report that you
created in either your Personal or Shared
folder.

5. Click the Run button.

○

The title of this report could be
something other than Referring
Physician Listing. Check with the
creator of the report if you are
unsure.

The Report Preview window opens.

6. Choose a date if necessary and click the
Run button.
7. Once the report generates, click the Mail
Merge button.

26.10

MicroMD EMR User’s Reference Manual Version 16.0

Printing Specialist Labels

Procedure (continued)

Chapter 26. Letters in MicroMD EMR

Details (continued)

8. Using the arrows in the middle, add the
appropriate providers to the right side of the
window.
9. Click the Create Labels button.

The Labels window opens.

10. If you have created a template, select that
template from the Label Template dropdown; otherwise, select the appropriate label
from the Label name drop-down.
11. Set the remaining options and click Print.
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Useful Tools
MicroMD EMR contains several useful tools that can make you more efficient and help you review patient
charts. From clinical dashboards to transcription, the tools available in MicroMD EMR allow you to use the
system to its fullest potential as you increase your efficiency and patient care.

In This Chapter
In this chapter, we cover how to

 Use Clinical Dashboards to review patient charts (page 27.2)
 Use practice-wide patient alerts shared between MicroMD PM and MicroMD EMR (page 27.6)
 Train the dictation tool to recognize your voice (page 27.7)
 Make the most of the Medical Calculators (page 27.7)
 View and use documents in the built-in Patient Education Library (page 27.8)
 Use VisualDx for additional information about medications, problems, or differential
diagnosis (page 27.13)

 Send or print reports and other documents in bulk with the Batch Basket (page 27.14)
 Use and create templates for the Practice Monitor (page 27.16)
 Implement rules to make the system work for you (page 27.22)
 Capture and use an electronic signatures throughout the system (page 27.30)
 Fax In/Out with Interfax (page 27.36)
 Transcribe for a physician (page 27.44)
 Review patient details, appointment history, planned visits, and billing from the PM (page 27.47)
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Clinical Dashboard
The MicroMD EMR Clinical Dashboard allows providers to obtain comprehensive and customized views of
their patients’ charts, clearly displaying the information they want to see at this time. For example, Dr.
Webb is reviewing Andy Homer’s chart. Andy is a diabetic patient and Dr. Webb wants to see a variety of
data in the chart that influences Andy’s condition. She can use the Clinical Dashboard to present this
information.

Figure 27.1 Clinical Dashboard
You can find the Clinical Dashboard in several locations, including the Chart Tools section. The MicroMD
EMR Clinical Dashboard has three tabs. The template you load defines the specific information displayed
on each tab when you open the dashboard. The loaded template also defines the layout of the
information on each tab. For details on Clinical Dashboard templates, see page 27.4. The following tabs
are available in the Clinical Dashboard:

 The Dashboard tab displays information from up to seven categories of medical or encounter
information from the patient’s chart (e.g., allergies, social history, vitals). For more details on any
of the categories displayed or on a selected encounter, click the More Information icon ( )
next to each section’s header.

 The Goal Monitoring tab displays information from the Goal Monitoring section of the patient’s
Medical Information tab (under Health Maintenance).

 The Graph tab displays up to four clinical charts (e.g., weight, blood pressure). Click Maximize
to display a specific chart at full screen zoom. Click Print to print a specific chart.

 The Immunizations tab displays information from the Immunizations section of the patient’s
Medical Information tab (under Health Maintenance).
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 The Screening & Prevention tab displays information from the Screening & Prevention section
of the patient’s Medical Information tab (under Health Maintenance).

Using Clinical Dashboards
You can use the MicroMD EMR Clinical Dashboard to see an overview of a specific area of the patient’s
medical information. When you open the Clinical Dashboard, you load a Clinical Dashboard template. The
template defines what categories of medical and encounter information the system displays in the
dashboard, as well as the clinical charts to display.
You can access the Clinical Dashboard while on your Desktop or while you are in the Charts Module. If you
are in the Desktop, the system prompts you to select a patient. If you are in the Charts Module, the system
automatically displays the Clinical Dashboard for the patient whose chart you have currently displayed.
To load a Clinical Dashboard:

Procedure

Details

1. Open the patient’s chart in the system.

See Chapter 10 for more details on working with
charts.

2. Select Chart > Clinical Dashboard from the
main menu.

You can also click the Dashboard link in the Chart
Tools section of the window or click the Clinical
Dashboard icon (

) on the top toolbar.

The Load Dashboard Template window opens and
lists all your personal Clinical Dashboard
templates by default; however, you can choose to
use a template from the Personal, Shared or
Standard folders.
3. Locate and select the dashboard template
you want to use for this patient.

If you want to edit a template to suit your needs,
see page 2.9 for details on how to copy and edit
templates.

4. Click Load.

MicroMD EMR uses the selected template and
loads the appropriate data from the patient’s
chart (Figure 27.1 on page 27.2).

Reviewing Information
Once you load a Clinical Dashboard, you can mark the information as reviewed right from the dashboard.
Simply click the Reviewed button as you read through the patient's information.

Figure 27.2 Reviewing Information in Clinical Dashboard
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Reviewing information in a dashboard is just like reviewing the patient’s chart. You can click the Reviewed
button or, if you have the setting established in your User Preferences (page 1.93), let the system do it for
you automatically. You can also click the Reviewed drop-down arrow and select Show Review History
from the menu to see who reviewed the category and when.



To display the section in the Medical Information Viewer
window (where you can access all of the action buttons
and see more detail), click the details icon ( ) in the
section’s header.

Clinical Dashboard Templates
You use the Dashboard Builder Wizard to create new Clinical Dashboard templates. The Dashboard
Builder Wizard defines the structure and content of each tab in the Clinical Dashboard.

Figure 27.3 Clinical Dashboard Template Wizard
When you create a new Clinical Dashboard template, you can save the template either in the Personal
folder, the Shared folder (if you have the Add templates to shared function), or in the OB Care folder. You
cannot save a template in the Standard folder. See page 2.8 for in-depth details on working with
templates.
To create a new Clinical Dashboard template:

Procedure

Details

1. Select Tools > Clinical Dashboard
Templates from the main menu.

The Dashboard Template Manager window opens
and lists all your Personal templates by default.

2. Click New.

The Dashboard Builder Wizard window opens
(Figure 27.3).
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Procedure (continued)

Details (continued)

3. From the Available Tabs pane, highlight the
tab you want to include in the dashboard
and click the Add button.

The system adds the tab to the Tabs Used In
Dashboard pane.
You can rearrange the order of the tabs using the up
and down arrow icons ( and ).

○

You can add multiple dashboards
and graphs; however, you can only
have one Goal Monitoring tab, one
Immunizations tab and/or one
Screening & Prevention tab.

4. In the Tab Label field, enter the text you
want to display when using this dashboard
template.
5. If adding a Dashboard or Graph tab, click
the Define Page Details button to choose
the information you want to display.

You can also choose the layout of the Dashboard
tab or define new graphs for a Graph tab.

Drag and drop the categories into the layouts to
build your tab.
6. Repeat step 2 through step 5 for each tab
you want to add to this Clinical Dashboard
template.
7. When satisfied with your new dashboard,
click OK.

The Save Dashboard Template window opens.

8. Select the folder where you would like to
save the template.
9. Enter a useful title for the template in the
Template name field.
10. Click OK.
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Practice-Wide Patient Alerts
To increase communication with all parts of your practice, there is an editable patient alert window in the
header of every patient’s chart (Figure 27.4), as well as in Scheduled Visits and Appointments. When you
click the Patient Alert Note icon ( ), the system opens the Patient Alert Note window (Figure 27.4). This
icon appears next to the patient’s name throughout the system and opens the same window each time.

Figure 27.4 Patient Alert Icon



Both MicroMD PM and MicroMD EMR share this Patient
Alert Note window. In the PM, you can click the Alert
Note icon ( ) in the floating toolbar.

On the Patient Alert Note window, you can simply type the information you want to share in the open
space of the note and click the Accept icon ( ).

Figure 27.5 Patient Alert Note Window
If you want to go back to the text that was in the note before you began typing, click the Reset icon ( ).
This removes your changes and reverts back to the original text. You must do this BEFORE you click the
Accept icon ( ).



27.6

When creating rules in the Rule Manager (page 27.22),
you can add a View Patient Alert Note action that allows
you to open the Patient Alert Note window.
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Dictation Tool
In order to use the Dictation Tool that is available in several areas of the program, you must first train the
tool to recognize words you speak. Please make sure that your microphone is attached to your computer
and working properly before proceeding. Simply select Tools > Dictation > Train from the main menu.
Follow the instructions on the window that opens (Figure 27.6) and on each consecutive step.

Figure 27.6 Training the Dictation Tool



The Dictation Tool does not work with Terminal Services.

Medical Calculators
You can use the MicroMD EMR medical calculators to perform a wide variety of medical-related
calculations, such as body-mass index, converting pounds to kilograms, and determining blood oxygen
content.

Figure 27.7 Medical Calculator
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You can access the medical calculator from the main menu under Tools > Medical Calculator or from
within one of the encounter recording tools by clicking the Medical Calculators icon on the Encounter
Ribbon (page 22.7).
The system populates default information from the patient’s chart into the medical calculators when
available. The system automatically includes a patient’s height, weight, age and gender if that information
is in their chart. If you open the calculator under Tools > Medical Calculator, there is no patient selected,
so there are no default values.
To use one of the medical calculators:

Procedure

Details

1. Select Tools > Medical Calculator from the
main menu.

The Medical Calculators window opens (Figure
27.7).
You can also use the medical calculators from
within an encounter. The steps for using the
calculator are the same.

2. From the sections on the left, select the
calculator you want to use.
3. Enter the values required on the right side of
the window in the Input Parameters section.

4. Click Calculate.

The right side of the window changes
appropriately.



For many of the available
calculators, you can enter data for
the calculation in either imperial or
metric units.

The system displays the result of the calculation in
the Results section, along with any additional
information if available.

5. Click Close when finished with the calculator.

Patient Education Library
You can use the MicroMD EMR Patient Education Library to maintain the set of literature that you provide
your patients on a variety of topics. The library comes with a set of standard documents. Many of these
standard documents are provided by the American Academy of Pediatrics and are available in both
English and Spanish. You can access the Patient Education Library in the main menu under Tools >
Patient Education Library.

○

27.8

You can only edit or delete user-created documents. You
cannot edit or delete the built-in library documents.
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Figure 27.8 Patient Education Library
To edit or delete a document from the library that you (or any user) added, simply highlight the entry and
click the arrow ( ) next to the Add button. Select Edit or Delete as appropriate. You cannot edit or delete
any of the built-in documents. Although you can add documents of any format, we recommend that you
add only documents with commonly used file types (e.g., Microsoft® Word documents, PDFs, web pages).
This ensures that most users have the software required to access the document.
The system categorizes all documents in the Patient Education Library. This makes it easier for MicroMD
EMR users to locate appropriate education material quickly. You can use the library’s search facility to
locate all documents that contain a specific text string in their descriptions. For example, you could search
for all documents in the library that contain “cholesterol” in their descriptions.

○

In order to view a document, you must have the
appropriate software installed. For example, to open a
file with a .pdf extension, you must have a PDF viewer
installed.

The system lets you associate each patient education document in the Patient Education Library with
multiple encounter entries. Each encounter entry can be an entry in one of the following reference lists:
Assessments, Medications, Laboratory Results and Plans. By associating a document with an encounter
entry, you make it easier for the provider to locate relevant patient education material when he records a
specific encounter entry. For more information about accessing Patient Education materials while in an
encounter (from the Administration tab), please see page 22.10.
For example, Dr. Webb diagnoses a patient with high cholesterol and records this in the patient’s
encounter. When finishing the encounter, Dr. Webb can then easily access all documents in the Patient
Education Library pertaining to cholesterol. Dr. Webb can print the relevant documents quickly and give
the printed copies to the patient.
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Viewing a Document in the Patient Education Library
You can view any document in the Patient Education Library. The controls in the library assist you in
locating the required documents. The Patient Education Library window contains:

 your Common List of patient education documents
 a Smart List shows only those documents that have associated links to encounter items
 Index shows those documents that are relevant to a specific category, such as immunizations or
pregnancy
To view a document in the patient education library:

Procedure

Details

1. Select Tools > Patient Education Library
from the main menu.

The Patient Education Library window opens
(Figure 27.8) and displays your Common List of
patient education material.

2. Locate and highlight the document you want
to view.

Chapter 7 explains using the reference lists in more
detail.
MicroMD EMR shows the associations for the
selected document in the right side of the window.

3. Click View Document.

You can also double-click the entry to view it.
The selected document opens in the appropriate
application.

Adding a Document to the Patient Education Library
The system allows you to add documents to the Patient Education Library if the built-in documents do not
suit your needs. Although you can add documents of any format, we recommend that you add only
documents with commonly used file types (e.g., Microsoft® Word documents, PDFs, web pages). This
ensures that most users have the software required to access the document.

○

You can also associate each document with types of
entries in an encounter. For details on linking a document
to types of encounter entries, see page 27.12.

Figure 27.9 Adding a Document to the Library
27.10
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To add a document to the Patient Education Library:

Procedure

Details

1. Select Tools > Patient Education Library
from the main menu.

The Patient Education Library window opens
(Figure 27.8 on page 27.9) and displays your
Common List of patient education material.

2. Click the Add button.

The Patient Education window opens (Figure 27.9).

3. In the Description field, enter a useful title for
the new education document.

MicroMD EMR display this name in the library.

4. From the Category drop-down list, select what
type of document you want to add.
5. If the document is an electronic file, click the
Lookup icon ( ) next to the File Name field.

If your document is a static web site, skip to step 7.

6. Navigate to the document you want to add
and click Open.

The system enters the path of the document in the
File Name field.

7. If you want to add a web site, enter the
address of the web page in the Web Site field.

○

You must store this document in a
central location on the network in
order for users of other computers to
access the document.



The web site must be stable and
static. If the address continues to
change, the entry in the library will
fail when you attempt to access the
document.

8. To associate this document with diagnoses,
medications, etc., click the Lookup icon ( )
next to the Link education entry to the
following items section.

To disassociate an item, highlight the entry and
click the Delete icon ( ). For more information
on linking documents to a specific type of
encounter type, please see page 27.12.

9. Select the type of encounter item with which
you want to associate the document.

The system displays the appropriate Reference List
Viewer window.

10. Locate the item and click Insert.
11. Repeat step 8 through step 10 for each
association.

For more information on linking documents to
encounter entries, please see page 27.12.

12. Click OK when finished.
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away. Simply search for the entry
using the All button to verify that it
appears in the list.
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Associating a Document in the Patient Education Library
MicroMD EMR lets you associate each document in the Patient Education Library, including the built-in
documents, with multiple types of entries in an encounter, including assessments, medications, lab results
and patient plans. By associating a document with an encounter entry, you make it easier for the provider
to locate relevant patient education material when he or she enters certain information.
For example, Dr. Webb diagnoses a patient with high cholesterol. After recording “high cholesterol” in the
patient’s encounter record, Dr. Webb can then easily access all documents in the Patient Education Library
pertaining to cholesterol when finishing the encounter. Dr. Webb can print the relevant documents quickly
and give the printed copies to the patient.
To associate a document in the Patient Education Library with a type of encounter entry:

Procedure

Details

1. Select Tools > Patient Education Library
from the main menu.

The Patient Education Library window opens (Figure
27.8 on page 27.9) and displays your Common List of
patient education material.

2. Locate and select the document you want to
associate with an encounter entry.

MicroMD EMR shows the existing associations for the
selected document in the right side of the window.

3. Click the Associate With button.

A drop-down menu opens.

4. Select the type of encounter entry with
which you want to associate the selected
document.

The appropriate Reference List Viewer window
opens.

5. Locate the item and click Insert.
6. Repeat step 3 through step 5 for each
association you want to make with the
document.

7. Click Close when finished.

27.12



To remove an association, highlight
that association in the right side of
the window and click the
Disassociate button.

Whenever a MicroMD EMR user enters a diagnosis,
medication, lab result or patient plan that matches
an association with a document, the system makes
this available to the user whenever on the Encounter
Ribbon. See page 22.15 for more in-depth details.
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VisualDx
MicroMD EMR comes with integration to VisualDx, an award-winning diagnostic clinical decision support
system. No purchase or setup is required. Once you add patient symptoms into an encounter, you can
click the VisualDx icon ( ) to launch the VisualDx web site with possible diagnosis matches for you to
review (Figure 27.10).

Figure 27.10 VisualDx in Action
The integration automates your search on VisualDx to display a differential diagnosis based on age, sex,
chief complaints and more. This tool is available in on the Subjective/HPI tab of the Encounter Builder,
Encounter Wizard, and Form Encounters (Figure 27.11). It is not available in a Text Encounter or in a text
step within the Encounter Wizard.

Figure 27.11 VisualDx Within the Encounter
You can also access VisualDx through the patient’s chart on their Medications list or their Problem List.
Simply right-click the medication or problem and select VisualDx from the pop-up menu or click the
information bubble icon ( ) in the yellow “sticky” and select VisualDx from the pop-up menu. For
medications and problems, VisualDx displays information about the selected item (Figure 27.12).
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Figure 27.12 Information from VisualDx

Batch Basket
The Batch Basket is a document “holding area” that allows your practice to print, publish, fax, view or
delete documents for the day when you have time. For example, a nurse can save all laboratory results to a
specific Batch Basket and send them to all to the Patient Portal at the end of the day.

○

MicroMD PM and MicroMD EMR share the Batch Basket.
Documents you save in either software appear in the
Batch Basket.

Figure 27.13 Batch Basket Window
To open the Batch Basket in MicroMD EMR (Figure 27.13), select File > Batch Basket from the main menu.
Table 27.1 explains the columns on this window.
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Table 27.1 Columns on the Batch Basket Window

Column

Description

Basket Name

The Basket Name represents the text entered if a user creates a new basket
when saving a document to the Batch Basket.

Page #

The Page # column displays the document’s page number in the associated
batch.

Batch User

This column displays the PM or EMR user who added the document to the Batch
Basket.

Patient

This column displays the patient (if applicable) to whom the document relates.

Document Name

When the user saves the document to the Batch Basket, they can enter a name
for the file. This column displays that text.

Batch Date

This column displays the date the user added the document to the Batch Basket.

Status

The Status column indicates the document’s current status.

Published

If the document was published to the patient’s account on the Patient Portal,
this column displays the date it was published.

Printing/Publishing the Documents in the Batch Basket
Throughout the day, you saved the documents you didn’t want to print or fax because it would tie up the
printer or fax line in your busy office. Now it’s time to print, fax, or publish those documents. The Batch
Basket makes it simple. When it is time to print, fax, or publish the documents in a Batch Basket, you can
simply choose the documents and print.

Procedure

Details

1. Select File > Batch Basket from the main
menu.

The Batch Basket window opens (Figure 27.13 on
page 27.14).

2. While on the Batch Basket window, place a
check mark next to each basket you want to
process.
3. Click the Publish drop-down button.
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Batch Basket History
If you want to see a list of documents printed or deleted from a Batch Basket, you can click the Batch
Basket History icon ( ) next to the Batch Basket Name drop-down. You can see the action taken and
who performed that action.

Figure 27.14 Batch Basket History

Patient Monitor
Ever needed to get to the patient’s problem list while in the Prescription Pad, trying to approve a request?
Maybe you’ve had an internal mail message open and needed to review the patient’s Family History before
responding. The Patient Monitor provides you with quick access to important patient information from
any patient-related window, even if you are in the middle of a task you cannot exit. This tool allows you to
keep your current task open while you look for other information in the chart.
For example, Dr. Davidson is in the process of reviewing Andy Homer’s recent prescriptions and he decides
he wants to look at some recent test results. Instead of closing the Prescriptions window, opening the Test
Results section of the Desktop and searching for Andy Homer’s results, then reopening the Prescriptions
window to continue his review, Dr. Davidson can simply click the question mark icon in the top right corner
of the Prescriptions window and click Test Results. He can view the results, close the window and continue
reviewing the prescriptions.

Figure 27.15 Patient Monitor
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There are several ways to access the Patient Monitor:

 Click the question mark icon ( ) in the top right corner of any window where you can associate
the patient (e.g., the standard Encounter Report on page 22.59). Be sure you have selected a
patient in the window or the monitor cannot open.

 Press the F3 function key on your keyboard while on any window where you can associate the
patient. Be sure you have selected a patient in the window or the monitor cannot open.

 Click the Desktop Tool called Patient Monitor.
 Once in the patient’s chart, click the Chart Tool called Patient Monitor or click the Patient
Monitor option in the Chart Navigator on the Demographics tab.

Patient Monitor Display
The top portion of the monitor displays patient demographic information, along with their insurances and
last/next appointment dates. The bottom portion of the window is your link to the wealth of information
found in the patient’s chart. The buttons in this section turn green (i.e., data exists for you to review) or red
(i.e., there are alerts to review or tasks for you to perform), just like the buttons in the Encounter Ribbon.
Depending on the type of information displayed by the button, the count displayed is either the count of
the total items (e.g., internal mail) or the count of any unaddressed items (e.g., test results) within that
section.

○

You can create an encounter from the Patient Monitor, as
well as open an encounter that was already created for
the patient today. Simply click the New Encounter (or
Open Encounter) button.

Table 27.2 Available Patient Monitor Categories and Their Counts and Color-Coding

Button

Opens

Count

Color

Alerts

Medical Information (Alerts)

How many exist

Green

Allergies

Medical Information (Allergies)

N/A

N/A

Allergy Testing

Medical Information (Allergy Testing)

N/A

N/A

Appointments

Find Appointments window

How many exist

Green

Asthma History

Medical Information (Asthma History)

N/A

N/A

Attachments

Medical Information (Attachments)

How many
attached for the
current user

Red

Clinical Profiles

Medical Information (Clinical Profiles)

N/A

N/A

Communicator

Workflow Communication window

N/A

Red (if there are
outstanding
items for the
current user in
any of the
categories)
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Table 27.2 Available Patient Monitor Categories and Their Counts and Color-Coding (continued)

Button

Opens

Count

Color

Confidential Info

Medical Information (Confidential Info)

N/A

N/A

Contacts

Patient Contacts window

N/A

N/A

Demographics

Edit Patient Information window

N/A

N/A

Diabetes

Medical Information (Diabetes)

N/A

N/A

Directives

Medical Information (Patient Directives)

N/A

Green

Encounters

Patient Activity window (automatically
filtered based on user preferences)

N/A

N/A

Env History

Medical Information (Environmental
History)

N/A

N/A

Eye Tests

Medical Information (Eye Examination)

N/A

N/A

Family History

Medical Information (Family History)

N/A

N/A

Family Planning

Medical Information (Family Planning)

N/A

N/A

Faxes Sent

Workflow Communication window
automatically set to Faxes Sent option

How many
outstanding

N/A

Fetal Ultrasound

Medical Information (Fetal Ultrasound)

N/A

N/A

Forms

Medical Information (Forms)

N/A

N/A

Genetic
Screening

Medical Information (Genetic History)

N/A

N/A

Geriatrics

Medical Information (Geriatrics)

N/A

N/A

Goal Monitoring

Medical Information (Goal monitoring)

Number of goals

Red

Gynecology
History

Medical Information (Gynecology History)

N/A

N/A

Habits

Medical Information (Habits)

N/A

N/A

Hearing

Medical Information (Hearing
Examination)

N/A

N/A

Hearing
Screening

Medical Information (Hearing Screening)

N/A

N/A

Hosp History

Medical Information (Hospitalization
History)

N/A

N/A

Immunizations

Medical Information (Immunizations)

How many are due
or missed

Red

Insurance Plans

Patient Insurance window

N/A

N/A

Labor & Delivery

Medical Information (Labor & Delivery)
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Table 27.2 Available Patient Monitor Categories and Their Counts and Color-Coding (continued)

Button

Opens

Count

Color

Letters

Medical Information (Letters)

N/A

N/A

Mail

Workflow Communication window
automatically set to Mail option

How many unread

Red

Medical History

Medical Information (Medical History)

N/A

N/A

Medical Info

Medical Information Review window

N/A

N/A

Medications

Medical Information (Medications)

N/A

Green

Menstruation
History

Medical Information (Menstruation
History)

Nursing Care

Medical Information (Nursing Care)

N/A

N/A

OB Care Record

Medical Information (OB Care Record)

N/A

N/A

OB Genetic
Screening

Medical Information (OB Genetic
Screening)

N/A

N/A

OB Initial
Physical Exam

Medical Information (OB Initial Exam)

N/A

N/A

OB Medical
History

Medical Information (OB Medical History)

N/A

N/A

Orders

Workflow Communication window
automatically set to Orders option

How many
outstanding for
current user to
perform

Red

Overview

Clinical Dashboard

N/A

N/A

Patient Activity

Patient Activity window

N/A

N/A

Patient Details
(PM)

Patient Detail window (populated from
the MicroMD PM)

N/A

N/A

Patient
Education

Medical Information (Patient Education)

N/A

N/A

Patient Memos

Workflow Communication window
automatically set to Patient Messages
option

How many exist

N/A

Ped
Development

Medical Information (Pediatric
Development)

N/A

N/A

Phone Messages

Workflow Communication window
automatically set to Phone Messages
option

How many
incomplete

Red

Pregnancy
History

Medical Information (Pregnancy History)

N/A

N/A
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Table 27.2 Available Patient Monitor Categories and Their Counts and Color-Coding (continued)

Button

Opens

Count

Color

Prenatal Visits

Medical Information (Prenatal Visits)

N/A

N/A

Prescriptions

Medical Information (Medications)

N/A

Green

Problem List

Medical Information (Problem List)

N/A

N/A

Recalls

Workflow Communication window
automatically set to Patient Recalls
option

Records Request

Workflow Communication window
automatically set to Records Request
option

How many exist

Red

Referrals In

Medical Information (Referrals In)

N/A

N/A

Referrals Out

Medical Information (Referral Orders)

N/A

N/A

Reminders

Reminder Manager

How many are due
(not including
future reminders)

Red

Risk Profile

Medical Information (Risk Profile)

N/A

N/A

Rx Requests

Workflow Communication window
automatically set to Rx Requests option

How many
outstanding for
current user to
approve for this
patient

Red

Rx Sent to
Pharmacy

Workflow Communication window
automatically set to Rx Sent to Pharmacy
option

How many exist

N/A

Screening and
Prev.

Medical Information (Screening &
Prevention)

How many are due
or missed

Red

Social History

Medical Information (Social History)

N/A

N/A

Surgical History

Medical Information (Surgical History)

N/A

N/A

Test Results

Test Results window

How many not
viewed by any
provider

Red

Transition of
Care

Workflow Communication window
automatically set to Transition of Care
option

N/A

N/A

Vision Screening

Medical Information (Vision Screening)

N/A

N/A

Vital Signs

Medical Information (Vital Signs)

N/A

Green
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Patient Monitor Templates
If you would like to customize the options that appear at the bottom of the Patient Monitor window (Figure
27.15 on page 27.16), you can do so using the Patient Monitor templates. Once you have created your
template, you can set this template as your default in your Chart Preferences (under Tools > User
Preferences).

Figure 27.16 Patient Monitor Templates
The left side of the template builder (Figure 27.16) lists the available information you can include in your
template, from the Alerts to Vital Signs. The right side is the list of items visible in this Patient Monitor.
Similar to the Clinical Dashboard templates, you drag a category from the left over to the appropriate
section on the right and drop it into place. You can reorder the categories to suit your needs. Use the up
and down arrow icons ( and ). If you want to remove an item, simply highlight it and click the Delete
icon ( ).

○

There is a limit of six items per column.

The fields at the bottom of the window provide a way for you to identify each section of categories. To
create a Patient Monitor template:

Procedure

Details

1. Select Tools > Patient Monitor Templates
from the main menu.

The Patient Monitor Template Manager window
opens.

2. Click the New button.

The Patient Monitor Builder window opens (Figure
27.16).
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Procedure (continued)

Details (continued)

3. Drag each category to the column where you
want it to appear and drop it into place.



The cursor changes to a blue folder
image when you click and drag the
category.

4. Repeat step 3 for each column.
5. In the field under each column, enter the text
you want to display to identify the column.
6. Click OK.
7. In the Template name field, enter a useful title
for your template and click OK.

Rules and the Rule Manager
MicroMD EMR allows you to create and implement rules for your practice. Rules help to ensure that specific
required or recommended practices are performed within the practice. These practices may be specific to
your office or your specialty. You can also create rules to help you adhere to requirements set by the state.
For example, you could implement a rule that displays a particular state form that you must provide to all
parents with small children.

Encountering a Rule
When you encounter rules while using MicroMD EMR, the system displays the Rule Activation dialog box
(Figure 27.17). The action you performed triggered the rule(s), and all rules that your action triggered
appear in the window.

Figure 27.17 Rule Activation Message
At the top of the window is the list of rules triggered by your actions and the message (if there is one)
associated with the rule. When you select the rule in the top portion, the details appear in the bottom
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portion of the window (Figure 27.18).

Figure 27.18 Actions for the Selected Rule
The Actions for selected rule section presents you with the action(s) required by the rule, along with an
action button:

 Click the Add button to add the indicated item to the patient’s encounter.
 Click the View button to view the associated document for View Education, View Information,
or View Data action items. The View Education and View Information action items open the
indicated education material. The View Data action item opens the indicated medical
information viewer.

 Click the Load button to load a CliniGuide to use the tool specified in the rule.



The system displays a green check mark next to the
action button when you have addressed that action.

When you have performed all the actions that you want to perform, close the dialog box. The controls at
the bottom of the Rule Activation dialog box change, depending on whether it appears during an
encounter or while you are in the Prescription Pad.
If you are not recording an encounter, only a Close button appears at the bottom of the window. If you are
recording an encounter or using the Prescription Pad, two buttons appear at the bottom of the Rule
Activation dialog box: Apply Anyway and Don’t Apply.

 Click Apply Anyway to close the Rule Activation dialog box and add the item to the patient’s
encounter record, against the recommendations of the rule.
For example, Dr. Webb has created an order in an encounter for a work hardening program for
Andy Homer, getting him ready to go back to work after his physical therapy completed. This
triggered a rule for Dr. Webb to review Andy’s medical history for any contraindications;
however, Dr. Webb is very familiar with Andy and has no concerns. She clicks Apply Anyway.

 Click Don’t Apply to close the Rule Activation dialog box without adding the item that originally
triggered the rule.
For example, Dr. Webb saved an encounter with Andy Homer that triggered a rule in relation to
his current age, gender, weight and BMI. The rule indicates that Dr. Webb should print the
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specified patient education materials on the dangers of obesity. Dr. Webb clicks Don’t Apply
because she has already provided Andy with the appropriate materials.



The system records interactions with the rules that pop
up for a patient in the CDS History section of the patient’s
chart (page 20.22).

Creating a New Rule
Any MicroMD EMR user can create and implement rules. The rules that you create can be applicable to
yourself, to all MicroMD EMR users in your practice, or to just those MicroMD EMR users in a specific
department. The Rule Manager (Figure 27.19) works just as the Template Managers do. You can access it
from the main menu under Tools > Rule Manager.

Figure 27.19 Rule Manager
The applicability of the rule depends on where you save it. If you save the rule in your Personal folder, the
rule applies only to your use of MicroMD EMR. If you save the rule in the Shared folder, the rule applies to all
MicroMD EMR users in the selected department. See page 2.8 for more details on Personal, Shared and
Standard folders.
Each rule must include a trigger, rule conditions and rule actions.

 Trigger
A trigger is an event that causes the system to invoke a rule. The system lets you select the
trigger from a list when you create the rule. This list includes, but is not limited to, triggers such
as When opening a chart, When creating an encounter, and When adding a medication. Many of
the triggers apply only when you record an encounter. MicroMD EMR comes with a standard set
of triggers that you cannot edit. Each rule that you create can only have a single trigger.

 Rule Conditions
Rule conditions work in conjunction with triggers and define exactly when the system activates
the rule and displays it for you. For example, you could define a rule condition that activates a
rule each time a provider prescribes the medication Amoxicillin. When a provider prescribes a
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medication, the system knows to wait for the medication Amoxicillin in order to display the rule.
When the physician prescribes Amoxicillin, then the system activates the rule.

 Rule Actions
Rule actions are the events that the person who created the rule wants you to perform, based
on the trigger and conditions. These actions can include View Patient Education Material, View
Data, View Information and Recommend Action. The rule actions that are available when you
create a rule depend on the trigger mechanism selected for the rule. There can be a list of
actions associated with any rule.
To create a new rule:

Procedure

Details

1. Select Tools > Rule Manager from the
main menu.

The Rule Manager window opens and lists all your
personal rules.

2. Click New.

The Rule Wizard window opens.

Choosing the Rule’s Triggering Event
3. From the Available Rule Triggers section,
highlight the event that you want to activate
this rule.



The system displays details of the
selected trigger in the yellow note
below the list of available triggers.

4. Click the Add button.

The system displays the trigger in the Selected Rule
Trigger section.

5. Click Next.

The system displays the Rule Conditions step.

Setting Rule Conditions
6. Create the appropriate data relationship(s)
from the Field Name, Condition, Value and
Logical drop-downs.

7. Click Next.

See page 27.27 for in-depth details about
establishing conditions.



Click the Clear Current Row button
to remove the conditions set in the
row that has your cursor’s focus.

The system displays the Rule Actions step.

Setting the Actions to Perform as a Result of the Rule’s Activation
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Procedure (continued)

Details (continued)

8. In the Display Message field, enter the details
about the rule.

This text appears in the Message section of the
Rule Activation dialog box.

○

This message text is an important
point of communication. It tells the
user precisely why the system
activated the rule. Be as informative
as you can about what you expect
from the user.

9. In the Actions section, click the Add button.

The Action Details dialog opens.

10. Select the appropriate type of action from the
Action drop-down.

The system changes the available choices based
on the action you want the user to perform. See
page 27.27 for more in-depth details about the
actions available.

11. Complete the rest of the Action Details dialog
box as appropriate.
12. Click OK.
13. Repeat step 9 through step 12 for each action
you want the user to perform related to this
rule.
14. Click Finish.

The Save Rule dialog box opens.

Saving the Rule
15. In the Template name field, enter a useful title
for this rule.

27.26
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Procedure (continued)

Details (continued)

16. Choose the folder in which you want to save
the rule.

You can choose either Personal (applicable only to
you) or Shared (applicable to multiple users). See
page 2.8 for more detailed information on
Personal, Shared and Standard folders.

○
17. Click OK.

Only a user with the function Add
templates to shared associated with
their user account can create a new
shared rule. For details on assigning
functions to users, see page 1.16.

The system adds the new rule to the selected
folder. The system activates the rule the next time
that both the trigger and the conditions are
satisfied.

Setting the Rule Conditions
At the heart of each rule you create is the set of conditions each piece of data must meet before the system
can trigger the rule. Just because the trigger on the rule is When opening a chart, you don’t want the rule to
pop up every time you open a chart. You want the rule to pop up when you open a chart ONLY IF a certain
set of conditions are met. These are your Rule Conditions.
MicroMD EMR allows you to create two types of rule conditions: simple and complex. For more details on
creating queries, refer to page 25.14. You create queries similar to those created for reports.

Setting the Rule Actions
Each rule that you create must include a set of rule actions. These actions are the tasks the user must
perform when they trigger a rule and their situation meets the rule conditions established. The rule actions
that are available when you create a rule depend on the trigger mechanism that you select for the rule. You
can create a list of multiple actions (if available).
There are several types of rule actions that could be available:

 View Patient Alert Note
 View Patient Education
 View Information
 View Data
 Recommend action
Displaying a Patient Alert Note
If you want the system to display the patient’s alert note (page 27.6) and override the message on the
rule when your action triggers this rule (if a note exists), you can select the View Patient Alert Note
action (Figure 27.20). If there is no patient alert note on the patient's chart, the system bypasses this
action on the rule.
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Figure 27.20 Action Details for Patient Alert Notes
When the rule activates in the system, MicroMD EMR displays the text from the Patient Alert Note
window in the Message area of the Rule Activation window (Figure 27.17 on page 27.22). You can also
click the View button to open the alert and edit it if needed.

Displaying Patient Education Material
You can create a rule that suggests materials from the Patient Education Library (page 27.8), based on
the rule conditions you set. The user who triggers the rule can click the View button provided to review
the material and print it for the patient.

Figure 27.21 Action Details for Patient Education Material
For example, you create a rule for patients under the age of 23 who have been diagnosed with
diabetes. You want the provider to print several pieces of information about juvenile diabetes for the
patient before they leave. You can add an action for each document.

Displaying Provider-Facing Materials
MicroMD EMR also allows you to create a rule in the system that can, depending on the triggers you
select, display access to specific clinical information meant more for the provider than for patient
education. When you select the View Information action, the system allows you to select information
from the Patient Education Library to attach to the action.
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Figure 27.22 Action Details for View Information
When you click the Lookup icon ( ) next to the Information for field, the system allows you to
choose between Assessments and Medications. Any documents associated with the selected
diagnosis or medication appear when the rule triggers and you click the View button.
In addition to the selected document, the system also provides the option when the rule triggers for
you to search for articles or reviews online.

Viewing Specific Medical Information Categories
If you want to be sure and review a section of the patient’s chart, you can create a rule that prompts
you to view that Medical Information category if the patient meets specific requirements. When you
select View Data from the Action drop-down, click the Lookup icon ( ) next to the Open field to
choose the category you want to display.

Figure 27.23 Action Details for Viewing Data
Once the rule triggers, you can click the View button to open the Medical Information Viewer window
for that category.

Recommending an Item
Depending on the trigger you choose, you can also recommend that the provider add a specific item to
the patient’s encounter record. The item can be an assessment, medication, procedure, laboratory
test, immunization, referral order, nursing order, measure, instructions, or assessment. The rule can
also recommend that you load a specific CliniGuide.
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Figure 27.24 Action Details for Recommending an Item
When you select the item, the appropriate Reference List Viewer window opens. However, if you select
the Apply CliniGuide Template option, the system prompts you to load the CliniGuide you want to
recommend to the user.

Electronic Signature
For those users with the Topaz Systems SignatureGem LCD 4x3 electronic signature device or the built-in
feature of most tablet computers (in conjunction with the Topaz tablet computer software), MicroMD EMR
allows you to sign administrative forms electronically, as well as capture and store the provider’s signature
to use in letters and forms.

○

Please contact your local MicroMD reseller for purchasing
information.

There are options in the Administrative Form, Form Encounter, Letter, Referral Letter and Prescription
templates. These options provide you with a way to capture a signature electronically using the Topaz
device or insert a stored signature into the final form or letter, just like you would a rubber stamp of the
physician’s signature.

Signature Capture
With the Administrative Form template (under Tools > Administrative Form Templates), there is a
control you can use related to the electronic signature: Signature Capture. The Signature Capture control
(Figure 27.25) allows you to create a form that the user or the patient will sign using your electronic
signature device at the time of using the form. For example, you have a HIPAA Disclosure Form that the
patient must sign, and you want them to sign it electronically with your device.
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Figure 27.25 Signature Capture Control in Template
To add the signature control to an Administrative Form, simply drag and drop the Signature Capture
control (Figure 27.25) to the appropriate place in your template and save your changes. When someone
uses the template, they double-click the control to launch the Topaz device or the table computer’s
signature feature. The system dates and time stamps the signature and displays it in the image on the
form.

○

When a patient has signed an Administrative Form, the
system locks the form, marks it as Signed and does not
allow it to be edited once saved.
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Capture and Store the Provider’s Signature
Many providers allow their trusted staff members to use their signature on standard forms to help increase
efficiency in their office. In the old paper world, this generally involved a rubber stamp of the physician’s
signature. With MicroMD EMR and the Topaz device, the physician can capture his or her signature in their
User Preferences (Figure 27.26), and staff members can use this signature in templates.
To capture your signature, click the Capture Signature button. This launches the installed device so you
can sign your name electronically. The system displays your signature in the image but does not
timestamp this image since a staff member can use this signature two months from now.

○

The system records each use of this captured signature in
the Audit Log reports.

To remove the captured image, simply click the Delete icon (

○

) next to the signature field.

If the signature was already used in a form or letter, the
system retains those instances in the patient’s chart to
maintain the integrity of your documentation.

Figure 27.26 Capture the User’s Signature
Once the physician captures his or her signature, the Provider Signature control/field in the Form
Encounter template, Administrative Form template, Letter template, Referral Letter template and the
Prescription Form template will pull in that image. The system records each use in the audit log, including
who used the signature and when.
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Use the Provider’s Stored Signature
When the provider has a captured signature, it is available to use in Form Encounters, Administrative
Forms, Letters, Referral Letters and Prescriptions. For the form templates, this is a Provider Signature
control that you can simply drag and drop onto the page being built. For the letter and prescription
templates, this is a Provider Signature merge field you can use in your template.

Figure 27.27 Example Provider Signature in Final Letter

Administrative Form and Form Encounter Templates
You have several options in the Administrative Form and Form Encounter templates: You can add the
Provider Signature control on its own, without a Lookup icon (Item 1 in Figure 27.28). Or you can
attach a Lookup icon ( ) to the control and allow users to choose the appropriate provider’s
signature at the time of using the form (Item 2 in Figure 27.28). You can also set defaults for the
Provider Signature control.

Figure 27.28 Form Template
When you add the control to the form, you can:

 Set the field to display the signature of the current user or the patient’s main provider. Once you
drag the Provider Signature control to the template, click the Lookup icon ( ) next to the
Default field (Figure 27.28). From the reference list that opens, you can select <Current User> or
<Patient’s Main Provider>.
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- Select <Current User> to instruct the control to display the signature of the user currently
logged into the system.

- Select <Patient’s Main Provider> to instruct the control to display the signature of the
provider listed in the Main Provider field of the Personal Details section of the patient’s
chart.

 Set the field to display the signature of a specific user (great for single-physician practices). Click
the Lookup icon ( ) next to the Default field (Figure 27.28) and choose the provider you want
to always display for that template.

 Attach a Lookup icon (

) to the control that allows the user to choose (Item 2 in Figure 27.28).

To allow users to choose the signature they want to use on either type of form, you associate a
Lookup Button control with the Provider Signature control on the template, just like you can
with the String Field and Text Box controls.



You can also set the default signature for the field, even if
you allow the user to choose a different one when they
use the form.

To associate a Lookup Button control with a Provider Signature control:

Procedure

Details

1. Drag and drop the Provider Signature
control on the Form Template.
2. Drag and drop the Lookup Button
control in place on the template.
3. Select the Lookup Button control.
4. Select the appropriate Provider
Signature control from the Attach to
Field drop-down.
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All Other Templates
For all other templates, you can simply drag the Provider Signature merge field into the appropriate
place in the template. This includes Letter templates, Referral Letter templates, and Prescription
templates. The provider the system pulls into the field when a user chooses the template varies
depending on the type tool (page 27.35).

Figure 27.29 Provider Signature Field in Template

How the System Chooses the Signature to Use
When you add the Provider Signature control or field to these templates, the system pulls in the
appropriate provider. This provider varies depending on the tool you use. For example, if you write a
letter using a template with the Provider Signature field, the system pulls in the user selected in the
Sent from field on the Write Letter window, while the Administrative Form uses the current user logged
into the system.

○

If the provider has not captured their signature in their
User Preferences, the field on the final document is blank.

 Administrative Form: The system uses the stored signature of the current user if there is no
Lookup icon ( ) next to the field on the form and if there is no default chosen (e.g., <Patient’s
Main Provider>). If there is a Lookup icon next to the field on the form, the system defaults to
the current user (or as selected in the template), but the user can choose the signature of
another provider if a signature is available.

 Form Encounter: The system uses the stored signature of the user in the Encounter for field of
the Encounter Header if there is no Lookup icon next to the field on the form and if there is no
default chosen (e.g., <Patient’s Main Provider>). If there is a Lookup icon next to the field on the
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form, the system defaults to the user in the Encounter for field, but the user can choose the
signature of another provider if a signature is available.

 Letter and Referral Letter: The system inserts the captured image of the user listed in the Sent
from field of the Write Letter window (Figure 26.2 on page 26.6).

 Prescription: The system pulls the user listed from the Provider field on the Prescription Pad.

Faxing In/Out with Interfax
Interfax is a web-based faxing company that offers secure and encrypted transmission of faxes, and
destroys documents immediately after transmission. Once set up, you can send and receive faxes using
MicroMD EMR.

○

For purchasing and registration information, please
contact Henry Schein Medical Systems.

Incoming Faxes
Once you have the Interfax account set up in the MicroMD EMR Manager, you need each user to add the
Faxes – Incoming section to their Desktop. Click the Modify icon ( ) to add the new section (page 3.2).

Figure 27.30 Faxes – Incoming Section of the Desktop
When you receive incoming faxes from Interfax, the system files these into the Faxes – Incoming section of
your Desktop, based on the fax line(s) associated with your user account. To view the fax, simply highlight
the appropriate row and click the Open button. This launches MicroMD Document Management to display
the fax and allows you to attach the document to a patient’s chart if necessary.
You can filter the list of faxes based on the date received (Date Range fields) and whether or not you have
filed the fax (the Status drop-down). You can also filter the list of faxes based on the incoming fax line to
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which you have access. The Fax Line drop-down displays only those fax numbers associated with your user
account in the MicroMD EMR Manager. The <ALL> option in this drop-down displays the faxes from all of
those associated phone numbers, or you can pick just one line.

Attaching a Fax to a Chart
When you open the fax and decide that you want to attach it to a patient’s chart, you can do so easily.
Complete the information on the right side of the window, just as you would when adding an attachment
from the Desktop. Click Attach to save it to the patient’s chart. Table 27.3 explains the fields in more detail.
For more in-depth details about the Attachments feature, please refer to page 20.1.

Figure 27.31 View Fax Window
Table 27.3 Attachment Fields on the View Fax Window

Field

Description

Patient

Choose the patient to whose chart you want to attach the fax. You can click the
Lookup icon ( ) or type the patient’s name.

File Name

Enter the text you want to use to name the fax. This file name appears in MicroMD
Document Management, as well as the list in the patient’s chart.

Service Date

If you would like to use the service date search in MicroMD Document
Management, enter the appropriate date in this field.
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Table 27.3 Attachment Fields on the View Fax Window (continued)

Field

Description

Type

The Type field allows you to choose the kind of attachment and where you want to
store it in the patient’s chart. You have the following options:

 Procedure Order/Result: These are procedure orders that you create in the
system. You can create a result for the order you select. By default, the system
saves documents in the Administrative Forms/Procedure folder of MicroMD
Document Management.

 Lab Order/Result: These are laboratory orders that you create in the system.
You can create a result for the order you select. By default, the system saves
documents in the Administrative Forms/Lab folder of MicroMD Document
Management.

 Referral Order (Out): These are referral orders that you create in the system. By
default, the system saves documents in the Administrative Forms/Referral
folder of MicroMD Document Management.

 Referral In: These are orders created in the Referral In section of the Desktop.
By default, the system saves documents in the Administrative Forms/Referral
folder of MicroMD Document Management.

 Immunization Order: These are immunization orders that you create in the
system. By default, the system saves documents in the Administrative Forms/
Immunization folder of MicroMD Document Management.

 Medication Order: These are medication orders that you create in the system.
By default, the system saves documents in the Administrative Forms/
Medication folder of MicroMD Document Management.

 Nursing Care Order: These are nursing care orders that you create in the
system. By default, the system saves documents in the Administrative Forms/
Nursing Care folder of MicroMD Document Management.

 Hospitalization History: These are recent hospitalization histories from the
Medical Information tab of the patient’s chart. By default, the system saves
documents in the History/Hospitalization folder of MicroMD Document
Management.

 Patient Directives: These are recent patient directives created in the Medical
Information tab of the patient’s chart. By default, the system saves documents
in the Administrative Forms/Patient Directives folder of MicroMD Document
Management.

 Surgical History: These are recent surgical histories from the Medical
Information tab of the patient’s chart. By default, the system saves documents
in the History/Surgical folder of MicroMD Document Management.
Details
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Once you make a selection in the Type field, the system displays the Details dropdown. In that drop-down, the system displays those orders or entries that were
created within the last 180 days.When you select the order or entry you want to
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Table 27.3 Attachment Fields on the View Fax Window (continued)

Field

Description

Status

When you choose an order from the Details drop-down, the system displays the
Status drop-down. This drop-down defaults to the order’s current status. When
you change this drop-down, the system changes the status of the order
appropriately.

Create Test Result This checkbox appears when you select Procedure Order/Result or Laboratory
Order/Result from the Type drop-down. When you place a check mark in this
checkbox, the system creates a row in the Test Results section of the provider’s
Desktop.
If you leave the box unchecked, the system simply adds the documents to the
order and to the Attachments section of the patient’s chart, without creating a
results entry.
Folders section

The folder structure displayed here is the folder structure of the selected patient’s
chart in MicroMD Document Management. Whenever you make a selection from
the Type drop-down, the system automatically chooses the appropriate MicroMD
Document Management folder for you. If you want to change the location for this
particular attachment, you can select the appropriate folder.

○

If you did not enter a patient, the folders displayed in
this section are the folders in your practice’s file
cabinet.

Attachment For

In the Attachment For drop-down, select the MicroMD EMR user the system should
notify of the attachment. The system populates this drop-down from your
Common List of users. If you do not see the user you want, click the Lookup icon
( ) to insert the appropriate user.

Comment

Add any additional information in the Comment field.

Forwarding a Fax
To forward a fax to another user, simply highlight the fax’s entry and click the Forward button in the Faxes
– Incoming section of your Desktop. In the Forward Attachment window, enter the appropriate user in the
To field and click OK. The fax appears in the Attachments section of that user’s Desktop.

Figure 27.32 Forward a Fax
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Sending Faxes
Once you activate faxing out with Interfax, the system enables the faxing option throughout the system.
Almost anywhere you can print an item, the system allows you to preview the item and then fax it. Simply
click the Fax button when you are ready to send the fax, complete the cover sheet information and click
OK.

○

To fax a document from the Attachments section of the
Desktop or the patient’s chart, simply right-click the
document and select Fax from the pop-up menu.

Figure 27.33 Faxing Out

○

In any Text Editor windows (e.g., Encounter Reports or
Print Chart), you can access the faxing option from the
File menu. Select File > Fax from the main menu to
launch the faxing module.

Send Fax Window
The Send Fax window opens whenever you click the Fax button in the system. The information you enter
in this window also carries through the Fax cover sheet you choose. Table 27.4 explains these fields in
more detail, including any default values and from where the system pulls them.

Figure 27.34 New Send Fax Window
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Table 27.4 Fields on the Send Fax Window

Field

Description

From

This field defaults to the current user and relates to the Fax: From merge field in the
Fax Cover Sheet Builder (Figure 27.35 on page 27.42). The system records this From
information in the Audit Log reports.

Clinic

This field defaults to the clinic listed in the Current Location field in the current
user’s Session Profile (under Tools > User Preferences).

Fax

This field defaults to the fax number listed on the Address tab (Work sub-tab) in the
current user’s account in the MicroMD EMR Manager (under the Users & Facilities
button). This field relates to the Fax: From (number) merge field in the Fax Cover
Sheet Builder.

Tel

This field is the telephone number listed on the Address tab (Work sub-tab) in the
current user’s account in the MicroMD EMR Manager (under the Users & Facilities
button).

Cover

From this drop-down, choose the cover sheet you want to use. You can now create
custom fax cover sheets.

Date/Time

The date and time that appear in these fields are the current date and time. This field
relates to the Fax: Date merge field in the Fax Cover Sheet Builder.

User

This field records the user sending the fax. You can find this information in the audit
log reports. This field relates to the Fax: User merge field in the Fax Cover Sheet
Builder.

Confidential

Place a check mark in this box to indicate if the fax contains private information not
to be shared with others. This field relates to the Fax: Confidential merge field in the
Fax Cover Sheet Builder.

Urgent

Place a check mark in this box to indicate if the fax contains important information
that should be viewed immediately. This field relates to the Fax: Urgent merge field
in the Fax Cover Sheet Builder.

Subject

The Subject field defaults from the description of the item for which you clicked the
Fax button. For example, the Description field of the Referral Order window. If there
is no Description (or similar) field, the Subject field is blank. This field relates to the
Fax: Subject merge field in the Fax Cover Sheet Builder.

To

The drop-down next to this field contains access to all contacts available in the EMR,
including the general Contact Manager. Once you choose a contact, the system
automatically populates the Fax no, Company, and Address fields if that information
exists in the contact’s entry. This field relates to the Fax: To merge field in the Fax
Cover Sheet Builder. The system records the To information in the Audit Log reports.

ATTN

Enter the person who should receive this fax at the receiving end of the transmission.
This field relates to the Fax: ATTN merge field in the Fax Cover Sheet Builder.

Fax no

Enter the receiving party’s fax number. This field relates to the Fax: To (number)
merge field in the Fax Cover Sheet Builder.

Company

Enter the name of the receiving party’s company. This field relates to the Fax:
Company merge field in the Fax Cover Sheet Builder.
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Table 27.4 Fields on the Send Fax Window (continued)

Field

Description

Address fields

Enter the address data of the receiving party. This field relates to the Fax: To
(Address 1), Fax: To (Address 2), Fax: To (City), Fax: To (State), Fax: To (ZIP) and Fax:
To (City, State, ZIP) merge fields in the Fax Cover Sheet Builder.

Reason for
Disclosure

Enter the reason for sending this patient’s information to an outside party. The
system records this information in the Audit Log reports. This field relates to the Fax:
Reason for Disclosure merge field in the Fax Cover Sheet Builder.

Comment

This field is the comment section of the fax and where you can communicate with
the party receiving the fax. This field relates to the Fax: Comment merge field in the
Fax Cover Sheet Builder.

Custom Fax Cover Sheets
You have the ability to create your own fax cover sheets. If you have a format you would prefer to use with
outgoing faxes, you can use that format. There is a Fax Cover Sheet Manager that you access through the
Administrative Panel on the Desktop.

○

Only users with the Administrator or Practice Manager
role associated with their account have access to the
Administrative Panel.

When you click the Fax Cover Sheet Manager icon ( ) in the Miscellaneous section, the system displays
a Template Manager window. Once you click the New button, the system displays the Fax Cover Sheet
Builder window.

Figure 27.35 Fax Cover Sheet Template
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The system provides you with access to the data from the Send Fax window (Figure 27.34 on page 27.40),
along with a variety of other information you might find useful in the cover sheet. Simply drag over the
fields you want to use and use the text editor to change the font face, font size, alignment, add your
company’s logo, and customize the cover sheet to suit the needs of your practice.
You can choose this cover sheet from the Cover drop-down on the Send Fax window.

Edit Interfax Header
By default, MicroMD EMR includes a standard header stamp on outgoing faxes. In the event that you want
to edit the page header, you can use the Page Header field on the Interfax setup to configure your
practice’s header stamp. Access Interfax setup in the MicroMD EMR Manager under Communications > Fax
> Interfax. Click the Edit button and navigate to the final step.



To send the MicroMD default header, simply make sure
the Page Header field is blank.

Figure 27.36 Page Header Field for Outgoing Fax

○

Interfax has a header limit of 90 characters, including
spaces and punctuation.

If you want to include the “from” fax number in the header stamp, you could enter the following text in the
Page Header field:
{datemm/dd/yyyy} {timehhmm} [FROM_NAME] [FROM_FAXNO] p{pagenumber}/{totalpages}

Due to character and space restrictions, you need to remove some data that is not as important for you. In
our example, we removed the company name so the user’s name who sent the fax was included, but you
could remove any piece of data to make room.
To change the outgoing header, you have several options on what to enter in the Page Header field:

 Type a combination of codes:
- MicroMD codes (in square brackets). You have three to choose from:
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• [FROM_NAME]: When you type [FROM_NAME] in the Page Header field, the header
on the fax includes the first name and last name of the user sending the fax, regardless
of the user selected in the From field of the Send Fax window. The user’s name is
found in the MicroMD EMR Manager on the Personal tab of their user account.

• [FROM_COMPANY]: Typing [FROM_COMPANY] in the Page Header field includes the
name of the location selected in the Clinic field on the Send Fax window.

• [FROM_FAXNO]: When you type [FROM_FAXNO] in the Page Header field, the
header on the fax includes the fax number entered in top portion of the Send Fax
window (in the Fax field).

- Type actual text. Text without brackets of any kind go out on every fax exactly as you type it.
In our example, the “p” and the slash ( / ) are actual text: p{pagenumber}/{totalpages}

- Interfax-specific codes. You can find more information about these in your Interfax account
under Preferences > Outgoing > Header Properties.

 Type only a Y in the field to use the custom header you define in your practice’s Interfax account
online. You can define the header in your Interfax account under Preferences > Outgoing >
Header Properties.

Transcribing for a Physician
MicroMD EMR enables you—under specific conditions—to transcribe for a physician. This means that you
can enter information into MicroMD EMR as if you are the other person. In a typical situation, a receptionist
or a transcriptionist transcribes for a physician. Only a user with the Transcriptionist role assigned to their
user account can access transcription in the system. You must also indicate the MicroMD EMR users for
whom the transcriptionist user documents patient visits. Please see page 1.22 for details on creating a
transcriptionist user.
When you transcribe for someone else, you assume all the privileges of the person for whom you are
transcribing. For example, Betty transcribes the details of an encounter for Dr. Kumar. In order to do this,
Betty’s user account must assume all the rights that Dr. Kumar has—enabling her to edit the encounter
information. If Betty was not transcribing for Dr. Kumar, she would not be able to edit—or even view—the
medical information of any of Dr. Kumar’s patients.

○

A transcriptionist cannot sign an encounter on behalf of a
physician. Only the physician who is responsible for the
encounter can sign it.

Internal Transcriptions
Once you have the Transcriptionist role assigned to your user account, you can access the Transcription
section of the Desktop (Figure 27.37). This is where you work through your list of transcriptions physicians
have sent to you to complete. Physicians typically create a Text Encounter and add Dictation Notes
(page 23.35) to the encounter. Once complete, they click the Send to Transcriptionist task on the
Encounter Ribbon and that encounter appears on your Desktop (Figure 27.37).
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Figure 27.37 Transcription on the Desktop
You can filter the list of transcriptions with any of the options in the Filter Criteria section of this window,
including date range. Once you find the encounter you want to transcribe, simply highlight the entry and
click the Edit button. This opens the Text Encounter the physician created. Listen to the dictations the
physician recorded and document the encounter accordingly. Please see page 23.23 for details on creating
text encounters and working with dictation.
If the physician decides to record their visit with the patient outside of MicroMD EMR, you can still use the
system to transcribe the encounter. Simply click the Add button to create an encounter based on what you
hear in the outside sound file, whether it be a micro cassette recorder or a file on the computer.
For example, Dr. Webb prefers to use the computer and a microphone to create individual *.wav files. She
then sends a mail message to Betty, her transcriptionist in the office, that the files are ready. Betty clicks
the Add button to start an encounter, opens the *.wav file from the network and documents the
encounter.

Sending an Encounter to a Transcriptionist
If you record an encounter where you record dictations and you need to send the encounter to the
transcriptionist, click the Send to Transcriptionist button in the Encounter Ribbon. This opens the Assign
to Transcriptionist window. Table 27.5 explains these fields in more detail.
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Figure 27.38 Send to Transcriptionist
Table 27.5 Fields on the Assign to Transcriptionist Window

Field

Description

Priority

From this drop-down, select the appropriate priority of this encounter in relation
to your other transcription requests with the selected transcriptionist. Generally,
you can leave the default.

Transcription type

Choose the appropriate type of transcriptionist to whom you want to send this
encounter.

 Internal: An internal transcriptionist is a MicroMD EMR user assigned to you as
your transcriptionist (page 1.22). The transcription request appears on that
user’s Desktop.

 External: This option is no longer supported.
Transcriptionist

If you choose Internal from the Transcription type options, the system enables
this field. The drop-down list displays your Common List of transcriptionists.
Select the appropriate user. If the list does not display the transcriptionist you
want, click the Lookup icon ( ) next to the Transcriptionist field to select the
appropriate MicroMD EMR user.

Report Name

This is a read-only field and displays the name and ID assigned to the
transcription by the system. This allows the system to link the encounter to the
transcription request.

Description

Enter a brief, useful description of the encounter for the transcriptionist.

Patient

This is a read-only field and displays the patient associated with the current
encounter.

Dictated by

This is a read-only field and displays the MicroMD EMR user who created the
encounter for which this is a transcription request.

Date requested

This is a read-only field and displays the date the transcription request was
created.

Status

This drop-down displays the current status of the transcription request.
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MicroMD PM Patient Details
For those with MicroMD PM + EMR, you can view the patient’s demographic information from within the
EMR in a view-only window. This window also allows you to view the details of any sub-accounts listed in
the PM. Simply choose the appropriate sub-account from the PM Patient drop-down.

Figure 27.39 MicroMD PM Patient Details Window
To access this window, click the Patient Details (PM) option in either your Desktop Tools or the Chart
Tools. The view-only window also includes the patient’s appointment history in MicroMD PM, as well as
MicroMD CHC profile information (if applicable) and billing history.



For details on the information of this window, please refer
to the main MicroMD PM User’s Reference Manual.
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MicroMD Document Manager
Sorting and sifting through overstuffed file cabinets, plus hours spent searching for lost files or missing
pages is not only inefficient but extremely frustrating. The Document Manager helps practices become
more efficient and virtually paperless by providing a centralized location to organize all office and patient
documentation. You can use this module to track and store any electronic documents and/or images of
paper documents. It also allows you to collect, categorize, copy, link, and move documents around with
ease and without the worry of losing any pages or files.



Imaging features are intended for documentation and
patient education purposes and should not be used for
diagnosis or treatment.

The MicroMD Document Manager, also called the Document Management System (DMS), runs
concurrently with other MicroMD processes, enabling users to continue working in MicroMD while
documents are loading. A progress bar and a message “Loading Documents” displays notifying users that
documents are continuing to load.

In This Chapter
In this chapter, we cover:

 Overall structure of MicroMD Document Manager (page 28.2)
 Editing the File Cabinet (page 28.3)
 Moving all documents in a folder (page 28.4)
 Showing or hiding system folders (page 28.5)
 Restricting folders (page 28.6)
 Adding folders to the patient account layout (page 28.7)
 Establishing templates for new documents (page 28.8)
 Managing deleted items (page 28.9)
 Working with folders and files (page 28.10)
 Using the System Unfiled folder (page 28.16)
 Adding documents to the system (page 28.17)
 Adding page notes and document comments (page 28.22)
 Annotating documents (page 28.23)
 Viewing the change history (page 28.24)
 Searching for a document (page 28.25)
 Changing user preferences for MicroMD DMS (page 28.26)
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Overview
In the Document Manager, File Cabinets are separate from the Account Charts, although you can access
Account Charts from within the File Cabinet area and vice versa. To access your practice’s File Cabinet,
click the Document Manager link in your Desktop Tools.

Figure 28.1 Document Manager
This displays the Document Manager application with the practice’s file cabinet structure displayed on the
left (Figure 28.1). The system comes with a set of patient account folders created for you. You can add to
these folders if you want, and they apply to all patients. (These folders are visible when you click Document
Manager in the Chart Tools pane of a patient’s chart.) The Document Manager displays this chart
organization on the left with the account name and ID at the top level (Figure 28.7 on page 28.7).
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Edit the File Cabinet
Although the system comes installed with a File Cabinet structure already created, you can edit this folder
structure if you like. A File Cabinet can house a variety of files related to the business of running a
practice—from remodeling contracts to employee attendance records to lunch menus. These are
documents not related to a specific patient.

Figure 28.2 File Cabinet Example
The Security Name field in the EMR defaults to (ALL) unless used with MicroMD PM. This field indicates
which practice can view the contents of the selected File Cabinet. For more information about using the
Document Manager with MicroMD PM, please refer to the MicroMD PM User’s Reference Manual supplied
with the PM system.
To add folders to the File Cabinet:

Procedure

Details

1. Click on the File Cabinet(s) Layout bar in
the left pane.
2. In the middle pane, highlight the folder to
which you want to add a subfolder.

This includes the top-level folder. For example, you
could highlight the MICROSYS MEDICAL folder to
establish the main levels of the file cabinet. After you
create the main folders, you could highlight any of
those folders to organize the file cabinet even more.
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The system changes the color of the
current active folder to green so you can
tell where the new folder will appear.
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Procedure (continued)

Details (continued)

3. Right-click anywhere in the right pane and
select Create Folder.

You can also click the Create button in to the top
toolbar. The system adds a new folder, ready for you
to name.

4. Type the name of the folder and press
Enter.

You can also simply click outside of the box when you
finish typing.

5. Repeat step 2 through step 4 for each
folder you want to add the cabinet.

This is the structure of your File Cabinet. Please refer
to page 28.17 for more details about using Document
Manager and adding documents to your cabinet.

Move All Documents in a Folder
There is a utility in MicroMD Document Manager setup that allows you to move all documents within a
folder to a different folder. This utility also appears if you try to delete a folder from the File Cabinet Layout
or Account Layout that still contains documents.

Figure 28.3 Move Documents Menu
Simply right-click a folder that contains documents and choose Move Documents. The system displays a
window that allows you to choose the folder to which you want move all of the documents. Select the
appropriate folder and click Move.
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Figure 28.4 Move Documents Window

Show/Hide System Folders
For those practices that would like to minimize the folders visible in DMS, you can choose to hide these
system folders from view. When a user sees a list of available folders for attachments or when opening a
patient’s chart in DMS, they only see the system folders you want them to see.

Figure 28.5 Show/Hide a Folder
To hide a system folder, log in to the Document Manager setup options. In the far right pane of either the
File Cabinet layout or the Account Layout, right-click a folder and select the appropriate option. If the
folder is currently visible to a user, the available option is Hide System Folder. If the folder is currently not
visible to the user, the available option is Show System Folder.
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Restricting Folders
Another security feature in the Document Manager is the ability to restrict individual folders by password.
This allows you to create a folder structure for the File Cabinet, as well as Account Layouts, where users
need a password to view the contents of the folder.

Figure 28.6 Restrict a Folder
Log in to the Document Manager setup. Right-click the folder you want to protect and select Password
Protect from the pop-up menu. Enter your password and click OK. The protected folder’s icon changes to
a key icon to show that there is a password for the folder. Users see this new folder icon as well.

28.6



Record this password somewhere safe. Remember to
share the password with those staff members that
need to access the folder.



If you need to reset the password on a folder, simply
right-click the protected folder and select Un-protect
from the pop-up menu.
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Adding Folders to the Patient Account Layout
MicroMD EMR automatically sorts documents you add from within the EMR into certain folders in the
system; however, you can add folders and edit those user-defined folders to suit the needs of your
practice.

Figure 28.7 Account Chart Example
To add folders to the Patient Account Chart:

Procedure

Details

1. Click on the Account Chart(s) Layout bar in
the left pane.
2. Highlight the Patient folder.
3. Highlight the folder in the middle pane to
which you want to add a subfolder.

This includes the top-level folder. For example, you
could highlight the Patient folder to edit the main
levels of that chart. After you create the main levels,
you could highlight any of those folders to organize
the chart even more.


4. Right-click anywhere in the right pane and
select Create Folder.

There are certain folders you cannot
edit. These are system folders that
the system needs for use with various
areas of the program (e.g., patient
photo and letters).

The system adds a new folder, ready for you to name.
You can also click the Create button to create a new
folder.

5. Type the name of the folder and press
Enter.

You can also simply click outside of the box when you
are finished typing.

6. Repeat step 3 through step 5 for each
folder you want to add the list of patient
folders.

Please refer to page 28.17 for more details about using
the Document Manager and adding documents to the
chart.
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Establish Templates for New Documents
Within the Document Manager, you have the ability to use templates for those documents you create
frequently. The system comes with some basic templates already built in for you: a blank Microsoft® Word
document, a blank Microsoft® Excel document, a blank text file. These are system files that you cannot edit.
However, you can add your own standardized documentation or stock images to use for annotations.
To access this setup area, click the main DMS button. From there, you click the Setup icon (
bottom of the menu and click the Templates tab (Figure 28.8).

) at the

The system prompts you with a password to access the
setup options for MicroMD Document Management. By
default, this is your database password.

○

Figure 28.8 Templates in the Document Manager



You must have the appropriate application in which
the template was created installed in order to open
and use the template (e.g., Microsoft® Word installed to
open a Microsoft® Word template).

To add a template from an existing file:

Procedure

Details

1. Right-click anywhere in the white area of the
Templates tab.
2. Select Add From File from the pop-up
menu.

The system displays the Open dialog.


28.8

If you select Overwrite from File,
the system replaces the file you
currently have selected with the file
you add.
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Procedure (continued)

Details (continued)

3. Find the file you want to add and click Open. The Template Properties dialog opens.

4. Edit the Document Name field if necessary.

5. Click Accept.



This field defaults to the name of the
file you chose.

The system adds the file to the existing list of
templates. See page 28.19 for details on adding a
document based on a template.

Manage Deleted Items
The File Management tab contains the deleted items area in the Document Manager is similar to the
Microsoft® Windows® recycling bin. It is a repository for all items deleted from either an account or from a
file cabinet. You can restore items in this area until you manually delete them. You can restore the deleted
document to any folder within the account chart from which it was deleted or to any folder within the file
cabinet from which it was deleted.

Figure 28.9 File Management
To restore an item to its original location, simply right-click the item and select Restore from the pop-up
menu. Choose the folder and click Restore.
To permanently delete an item, right-click the item and select Delete from the pop-up menu. Be sure to
confirm your action. This removes the file completely from the database.
If you are unsure of the contents of the document, you can view the document before you restore it. Simply
double-click the file or right-click and select View from the pop-up menu.
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Work with Folders and Files
In the right side of the window, the system displays the contents of the folder you have selected in the left
side of the window, whether the content is additional folders or individual files. If you have your window
displayed in the Detail view, the system displays an indicator next to the folder names. When you see (0/0)
next to a folder, the first number indicates how many subfolders are in the folder. The second number
indicates how many files are in the folder. For example, if you see (0/2) next to the Patient Education folder
name, there are zero (0) subfolders and two (2) files (e.g., Teen_Sex.pdf and Drug_Abuse.pdf).



Click the up arrows ( ) on the far right of the account
information band to collapse this section. MicroMD
Document Manager remembers your selection the next
time you open the document manager.

Color-Coded Folders
The color of the folders in the Document Manager changes depending on the contents of the folder:

 Yellow (

): Yellow means the folder contains documents.

 Green (

): Green indicates the current folder you have displayed in the right side of the

window.

 Gray (

): Folders displayed in gray in the left side of the window are empty folders.

 Red (

): The red folder is the system’s Unfiled folder. This folder is a system-generated folder
that you cannot remove or rename. (See more on page 28.16.)

Figure 28.10 Folder Colors
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Hover Text
You’re in a hurry and you need to see an image, but you don’t remember which file is the one you want to
open. Run your mouse over a file, and the Document Manager displays a thumbnail image of the file,
including other details such as the date and time the file was created, what type of file it is and who added
the file.

Figure 28.11 Hover Properties

Navigating Pages in a Document
When you open a document in the Document Manager, the system displays the pages of that document
along the bottom of the window. To access a page, simply click the page you want to view. This page
navigation area also provides the ability to rearrange the pages in the document if needed. Simply drag
and drop the page where you want it to appear.

Docking Windows
When working with the Document Manager, the technology used provides you some added flexibility in
how you view the document window. By default, the system displays documents and notes as tabbed
pages (Figure 28.12). If you prefer to see the notes and the document in the same view, you can drag and
drop the tabs in different configurations.

Figure 28.12 Changing Your Document View
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To change the configuration of your document view:

Procedure

Details

1. Open a document.
2. Click and hold a tab.
3. Drag the tab toward the middle of your screen. The docking station appears.

4. Hover over the icon whose shaded area
represents where you want the tab to appear
on the screen.

Your screen changes color in the appropriate area
to illustrate where your tab will appear for the
selected icon.

5. Drop the tab on that icon.

The selected tab relocates to its new position.

Document Tasks
Once you have documents and images in your File Cabinet and in Account Charts, there are a number of
actions you can perform with those items. Whenever you highlight a file in the Document Manager, the
system displays the Document Tasks navigation band (Figure 28.13). Table 28.1 explains these tasks in
more detail



You can also access these same tasks by right-clicking on
a file.

Figure 28.13 Document Tasks Band
Table 28.1 Document Tasks

Task

Description

View

Highlight a file and click this task to open the document for editing.
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Table 28.1 Document Tasks (continued)

Task

Description

Print

Highlight a file and click this task to print the contents of the file, even if the pages
are from different applications. You can print page ranges in pdf documents (DMS
pages). The current computer from which you try to print the document must have
the appropriate application to support the printing of the pages within the
document. If any of the pages use an unsupported application, the page(s) will not
print.

Shortcut

Highlight a file and click this task to create a link to the document that you can place
in another folder. Once you paste the shortcut, you can double-click the shortcut,
and the system opens the original document. This allows practices to “file” the same
document in two or more places as necessary, while only maintaining a single copy.

Properties

Highlight a file and click this task to display the attributes of the document. These
are the attributes set when the document was added to the system, either through
scanning, a template, or an external file—or when someone has edited them
through the Properties task.

Copy

Highlight a file and click this task to create a duplicate version of the document. This
action creates a new separate file that staff members can edit, independent of the
original.



If you only want to maintain a single copy of the
document but need to file it in multiple places, use
the Shortcut task instead.

Rename

Highlight a file and click this task to change the current name of the document.

Move

Highlight a file and click this task to transfer the document from its current location
to another folder in the File Cabinet or a patient’s chart.

Comment

Highlight a file and click this task to insert a document comment. This comment
applies to the entire file, not just a page. See page 28.22 for more details on adding
page notes and document comments.

Paste

This task is available only after you have copied a document or created a shortcut.
Once you have done one of these tasks, you can navigate to the document’s new
location and click the Paste task to add the document to the folder.

Delete

Highlight a file and click this task to remove the document from the File Cabinet or
patient’s chart.

Folder Tasks
Once you have folders in your File Cabinet and in Account Charts, there are a number of actions you can
perform with those items. Whenever you highlight a file in the Document Manager, the system displays the
Folder Tasks navigation band (Figure 28.14). Table 28.2 explains these tasks in more detail.
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Figure 28.14 Folder Tasks Band
Table 28.2 Folder Tasks

Task
Display

Description
Click the down arrow next to the computer screen icon (
options for the right pane of the window.

) to show a list of display

Home

Click this task to change the display to the upper most folder level.

Up

Click this task to change the display up one level.

Open

Highlight a folder in the right pane and click this task to display the contents of that folder.

View Options
On the ribbon bar in MicroMD DMS, the View section allows you to access different views from the current
window. For example, if you are currently in the Folder view and you want to search for a file without
closing the Folder view, you can click the Search button. The system opens the window separately from
your current window.

Figure 28.15 New View Options in MicroMD DMS
If you click the button related to a window you already have open, the system brings it to the foreground
and makes it the active window for you. For example, if you have the Folder view open and you want to
search for a file, click the Search button. On the search window, if you want to return to the folder view,
click the Folder button on the search view.
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Shortcut Keys
For those people who use the Document Manager heavily, there are a host of keyboard shortcuts that
allow you to perform various tasks with the application. Table 28.3 explains these in detail.
Table 28.3 Shortcut Keys in the Document Manager

Key Combination

Description

Alt + Shift + L

This key combination takes you to the last page in the open document.

Alt + Shift + F

This key combination takes you to the first page in the open document.

Alt + Shift + P

Takes you to the previous page in the open document.

Alt + Shift + N

Takes you to the next page in the open document.

Alt + Shift + S

This key combination saves the open document.

Alt + Shift + C

This key combination opens the Add Comment window for the currently active
page in the document.

Alt + Shift + O

This key combination opens the Add Note window for the currently active page
in the document.

Alt + Shift + T

Press this key combination while in the folder list to open the Template List
window. This allows you to add a document based on the templates in the
system.

Alt + Shift + I

Press this key combination while in the folder list to open the Scanning window.
This allows you to scan documents into the system.
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About the System Unfiled Folder
The System Unfiled folder is a central console that allows a user to scan multiple documents for multiple
patients quickly and easily. Users can also use this console to scan masses of documents and then file
them after the fact. You access the System Unfiled folder from the main DMS button. Select Open > Open
System Unfiled.

Figure 28.16 System Unfiled Folder



The System Unfiled folder is also a useful tool if you save
a document to a patient’s chart incorrectly and want to
move it from one patient’s chart to another.

For example, you received a stack of letters in the mail that you want to scan into the Document Manager.
You can use the System Unfiled folder to scan them all in after you open the letters. Then you can file them
into the appropriate patient folders with a few simple clicks.

Adding Documents
When you add documents (page 28.17) using the System Unfiled folder, the system adds these files to the
end of the display at the bottom of the window. Once you have the documents scanned, you can choose
the Account option at the top of the window and search for the account to which you want to add the
document currently displayed.
Once you have that account’s folder structure displayed in the right side of the window, you can highlight
the appropriate folder and click either the Add as Doc button or the Add as Page button. The Add as Doc
button moves the displayed document to the selected folder as an individual file within the folder. If you
click the Add as Page button, the system adds the displayed document as the last page in the document
with which you were just working.

Filtering Documents
By default, the Document Manager displays only those documents that you have scanned into the system.
This makes it easier for you to work with a single batch of documents. If you need to see all documents in
the System Unfiled folder for all users, simply click the Unfilter button (Figure 28.16). The system displays
all files in the folder and changes the button to Filter Docs. To view only your documents, click the Filter
Docs button.
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Add Documents to the System
While there are various areas in MicroMD EMR to add documents to the document manager, you can also
add documents to the Document Manager in a variety of ways from within the document manager itself.
You can:

 Scan documents or images using a TWAIN-complaint scanning device
 Import electronic files from your computer
 Create a new document based on a built-in template
Add a File from a TWAIN-Compliant Device
If you have a TWAIN-compliant scanner, camera or other scanning-type device, the system allows you to
add these scans to a File Cabinet or Account Chart or to the System Unfiled folder.

○

The device must be connected to the workstation or
network. You must also be sure any software provided by
the manufacturer is installed properly.

Figure 28.17 Add File from TWAIN Device
To scan a document or image into the Document Manager:

Procedure

Details

1. Open the practice’s file cabinet or an account
chart.

See page 28.10 for more on opening the file
cabinet or the patient’s chart. For more details
about using the System Unfiled folder, please see
page 28.16.

2. Highlight the folder to which you want to save
the scan.
3. Click the main DMS button.
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Procedure (continued)

Details (continued)

4. From the options, select Add Document >
Add From TWAIN Device.

This opens the MicroMD Scanning window (Figure
28.17).



You can also use the shortcut on the
main window (
) at the very top to
open the MicroMD Scanning
window.

5. Enter the file name for the scan in the
Document Name field.

By default, this name is Document [today’s date].

6. If the service date related to the document is
different than today’s date, change the Service
Date field accordingly.

You can use the Encounter field to help organize
documents within the patient’s chart. Simply type
text in the field or select from previously entered
categories. These are patient-specific.
The Chart Note field is not currently used in the
EMR.

7. If you have multiple TWAIN devices
connected, click the Select button (
) to
choose the one you want to use for this
session.

8. Check or uncheck the Multi-Page Scan and
Auto Close checkboxes as necessary.

This list displays all connected TWAIN devices. The
system defaults to the last device you used on this
workstation.
If you need to access the manufacturer’s setup
options for the device, you can click the Setup icon
( ) that is below the Select button in the
navigation band.
With the Multi-Page Scan box checked, the system
allows you to scan an entire stack of papers (or
images) into a single file. If you uncheck the box,
you can scan an entire stack of papers (or images),
but the system separates each scan into its own
individual file.
When you place a check mark in the Auto Close
checkbox, the system automatically closes this
scanning window when the scan is complete.
The system defaults to the choices you made
during the last session for both of these options.

9. Click the Scan button (

28.18

) when ready.

The system displays the manufacturer’s scanning
window for the device you have selected.
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Procedure (continued)

Details (continued)

10. Follow the instructions for your device.

Once the Document Manager has scanned the
document(s) and/or image(s), it displays the scan
in the MicroMD Scanning window.
At this point, you can close the window or add
another scan to the current document file. Click
the Append button (
) to perform step 4step
10again and add to the end of the current
document.

11. Close the window when finished.

Create a File from a Template
On page 28.8 you learned about the built-in templates that come with the Document Manager. You also
learned how to add templates for documents you create regularly. This helps you standardize your
electronic documentation. When you want to add a document based on one of these templates, the
system allows you to do so easily.

Figure 28.18 Choosing Your Template

Procedure

Details

1. Open the practice’s file cabinet or an
account chart.
2. Highlight the folder to which you want to
save the scan.
3. Click the main DMS button.
4. From the options, select Add Document >
Add From Template.

MicroMD EMR User’s Reference Manual Version 16.0

This opens the Template List window (Figure 28.18).



You can also use the shortcut at the
very top of the main window.
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Procedure (continued)

Details (continued)

5. Double-click the template you want to use.

The system opens the appropriate application within
the Document Manager window.

6. Edit the file as necessary and click the Save
icon ( ) at the top of the window.



If prompted to run, open or save the
file, click Run or Open.

○

Most of the editing application’s
features are available; however, you
cannot access them all.

Once you click the Save icon ( ), the system
displays the Document Properties window.
7. Enter the file name for the document in the
Document Name field.
8. If the service date related to the document
is different than today’s date, change the
Service Date field accordingly.

You can use the Encounter field to help organize
documents within the patient’s chart. Simply type
text in the field or select from previously entered
categories. These are patient-specific.
The Chart Note field is not currently used in the EMR.

9. Click Accept.

This saves your document into the folder you
highlighted in step 2. If you do not have a folder
selected, the system places the file top level of the
file cabinet or account chart.

Add an Existing External File to the File Cabinet or Account Chart
There are times when you need to add an external file to a patient’s chart or you want to file a document
away in your practice’s File Cabinet. For example, maybe you received an e-mail from the patient to
update their address or insurance information. Normally, you would print that e-mail and throw it into the
patient’s chart. You can still do that. You just do it electronically. You can add and view most image
formats, text files, the most popular Microsoft® Office documents, PDFs, audio files and video files.

Procedure

Details

1. Open the practice’s file cabinet or an account
chart.
2. Highlight the folder to which you want to save
the scan.
3. Click the main DMS button.
4. From the options, select Add Document >
Add From File.

28.20

This displays an Open dialog box that allows you to
navigate to the file you want to add.
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Procedure (continued)

Details (continued)

5. Navigate through your system to the file you
want to add to the cabinet or account chart
and click Open.

The system displays the Document Properties
window.

6. In the Document Name field, edit the file name
if necessary.

The system defaults this field to the file’s existing
name.

7. If the service date related to the document is
different than today’s date, change the Service
Date field accordingly.

You can use the Encounter field to help organize
documents within the patient’s chart. Simply type
text in the field or select from previously entered
categories. These are patient-specific.

8. Click Accept to save the information.

Add Pages to an Existing Document
You can add pages to existing documents in the Document Manager. For example, you receive an
addendum to a remodeling contract you have scanned into your practice’s File Cabinet. You can open that
document and add the addendum. When you need to refer to that document, you don’t have to look in
two separate files. You can just open the one file.

Figure 28.19 Appending a Document
To add a page to an existing document:

Procedure

Details

1. Open the document.
2. Click the main DMS button.
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Procedure (continued)

Details (continued)

3. From the options, select Add Page > Add
From TWAIN Device or Add From Template
or Add From File.

The appropriate window opens. The only
exception is that you click Append when scanning
instead of Scan.
The system adds the page to the end of the
document you currently have open.

Add Page Notes and Document Comments
With the Document Manager, you can enter detailed comments about the documents in your system. You
can also enter detailed notes about pages within those documents. You can use this nearly any way you
choose. For example, if you call a referring physician about a letter sent to you, you could record that you
had this conversation in the Document Comments tab of the document’s file. When you reference this
letter six months from now, you can refresh your memory about that conversation.

Figure 28.20 Adding Notes to a Document
To add a document note, click the Add Comments icon ( ) at the very top of the window. Enter your text
and click Save. The system adds a Document Comments tab to the window (Figure 28.20) and enters your
new comment at the bottom of the list of comments.
If you need to make notes only about an individual page within the document, click the Add Notes icon
( ) at the very top of the window. Enter your text and click Save. The system adds a Page Notes tab to
the window (Figure 28.20) and enters your new note at the bottom of the list of notes.
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Annotate Documents
When you add images to the system, you have the ability to “draw” on these images with the tools
provided by the Document Manager. You can also zoom in and crop images with the Document Manager.
The system retains the original so that you can revert to the original at any time. See Table 28.4 for details
on the tools available.

Figure 28.21 Image Toolbar



The system also allows you to undo the edits you make
step by step, at any time—even days later. Just click the
Undo button.

Table 28.4 Tools Available

Tools

Description

Image

The tools in the Image section of the toolbar allow you to revert your image back to
its original version, without any cropping, rotation or annotations. You can also
undo or redo your changes step by step.

Zoom

Click each of the icons to zoom in or out on the current page. The Smart icon resets
your view so you can see the entire document on the page. You can crop your
image so that any time you open the document, you only see that section. Click any
tool to activate it. For the Smart, In and Out icons, you can click the image once to
use the tool.
With zoom In icon, you can also click and drag the mouse over an area to zoom in
on that part of the image. You also click and drag the mouse over an area to crop
the image.

Rotate / Flip

You can click any of these icons to change the orientation of the image on the
screen. You can rotate the image 90 degrees clockwise, 180 degrees clockwise or
270 degrees clockwise.
The system also allows you to flip the image horizontally, vertically or diagonally.

Annotate and
Font

The tools in the Annotate section of the toolbar allow you to draw shapes or type
text on an image. You can choose the shape, line width and color of the shape. If
you want to add text, you can choose the font and size of the text from the Font
section of the toolbar. The system enables the Font section when you select the text
tool.
Simply click and drag the mouse to create the shape, size of the text box or size of
the highlight. For a text box, type the text and click the green check mark icon to
commit your text.
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Change History
The Document Manager tracks the actions performed against a document stored within the document
management system and who performed the action. This includes when a user created the document, if
someone copied the document, when a user edited the document, added annotations to an image, added
a note or a comment to the document, and more.

Document History
You can access this Document History when you right-click a file in the Document Manager and select View
History from the pop-up menu. The Document History window lists when the action occurred, what the
action was and who performed it. The Document History window lists those actions performed against the
file as a whole, as well as the actions performed within the file.

Figure 28.22 Document History in the Document Manager



You can also access this history from within a document.
Simply click the main DMS button and select Document
History from the menu.

Page History
Within the Document Manager, you can add several pages to a document from separate files. In one
document in the Document Manager, you could have a referral letter as a Microsoft® Word document, an
image of the patient’s chest in JPG format and a medical report in TXT format. With the history feature, the
system provides you with a Page History that details the changes made to the individual page you
currently have displayed in the document.
To access the page history, display the appropriate page. Click the main DMS button and select Page
History from the menu. The Page History window lists all of the changes made to that part of the
document.
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Search for a Document
If you know there is a document in the Document Manager, but you do not know where it is, you have the
ability to search for the document based on certain criteria, including the text within a note or comment on
the document. You can access the search feature simply by opening the Document Manager and clicking
the Search button in the navigation bar.

Figure 28.23 Searching for a Document
If you click the Search button from within a File Cabinet, the system allows you to search the documents
within that cabinet. If you click the Search button from within an Account Chart, the system allows you to
search only the folders within that Account Chart.
To search for a document in the File Cabinet or Account Chart:

Procedure

Details

1. Click the Search button.

The Search window opens.

2. From the Look in drop-down, select the folder
you want to search.

To search the entire cabinet or chart, leave the
drop-down set to the top level.

3. Enter the text you want to search in the
Document field.
4. Choose where you want the system to search
for the text.

You can choose to search the document’s name or
to search through any notes entered for the
document.
For example, you know that you added a note
about your conversation with Dr. Webb about an
image. You can choose to search only the notes
within a document for the word “Webb”.

5. Click the Search button.

The Encounter and Service Date fields are
currently not in use.
The system displays the list of documents that
contain the text either in the document or in notes.
Highlight the entry in the list to view the document
on the right. You can edit as you would normally.
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MicroMD DMS User Preferences
Each user has the ability to customize several aspects of their experience using the system, from what they
see when they first log in to the system to what data they prefer to use when searching for patients.
To customize your user experience for MicroMD DMS, select Tools > User Preferences from the main
menu of the main EMR application. Click the DMS category. Table 28.5 explains the options in more detail.

Figure 28.24 MicroMD DMS User Preferences
Table 28.5 Fields in the DMS Section of User Preferences

Field

Description

View Options
Default Cabinet View

This user preference allows you to set which view you see anytime you open
MicroMD Document Management from your Desktop, which opens your
practice’s File Cabinet. You can choose to open the File Cabinet in the Folder
View (Figure 28.1 on page 28.2) or you can choose to open it directly to the
Search View (Figure 28.23 on page 28.25).

Default Chart View

This user preference allows you to set which view you see anytime you open
MicroMD Document Management from within a patient’s chart. You can
choose to open the chart in the Folder View (Figure 28.10 on page 28.10); or
you can choose to open it directly to the Search View (Figure 28.23 on page
28.25); or you can choose to open DMS with a Preview View.

Show Note Pane

Place a check mark next to this option to display a third pane in MicroMD
DMS. The notes pane can display either the file’s Page Note or the Document
Note. Select your preference from the Default Note drop-down that appears.
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Table 28.5 Fields in the DMS Section of User Preferences (continued)

Field

Description

Add service date to
preview view

Within the Preview view of the Document Manager, you can choose to
display the Service Date next to the file name in the folder tree structure.
Simply place a check mark in the new Add service date to preview view
checkbox when your Default Chart View is set to Preview View.

Sort Order Options (DMS) and Sort Order Options (EMR Attachments)
Primary Sort, Secondary
Sort, and Tertiary Sort

The Sort Order (DMS) and Sort Order (EMR Attachments) options allow each
user to specify the default sort order for the columns in the Search and
Folder views of the MicroMD Document Manager and for the columns in the
attachment lists throughout the patient’s chart. For example, one user could
prefer to see list of file names displayed in order from A to Z. Then within
each matching file name, they want to see the list ordered by service date
with the most recent at the top.
By default, MicroMD Document Manager sorts the lists in the Search and
Folder views first by the selection you identified in the Primary Sort default.
Then by the selection you identified in the Secondary Sort default (if one
exists). And finally, by the selection you identified in the Tertiary Sort default
(if one exists).



If you click on a column while in the Search or Folder
view, the default sorts are no longer in effect until
you exit the view and come back in.

Encounter Report Naming
Naming convention

The Encounter Report Naming options allow each user to change how the
system names the Encounter Report when printing and saving into the
Document Manager, which also affects the sorting of the files when you look
at the lists. There is generally no reason to change the default settings that
come with MicroMD EMR; however, you can simply select the information
you prefer to use from the drop-downs.
When you change the default naming convention, the system begins using
that naming convention from that point forward.



If you ever want to change back to default values
that came with MicroMD EMR, select Encounter ID
from the first drop-down and Report ID from the
second.
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Incentive Programs
In MicroMD EMR, the heart of gathering your data for the various incentive programs is your personal use of
the software when caring for your patients. Data-gathering for the incentive programs is deeply integrated
in the EMR and carefully updated every year when the Centers for Medicare and Medicaid (CMS) release the
official rulings.

In This Chapter
In this chapter we cover:

 Available resources with information about MicroMD and the incentive programs (page 29.1)
 Quality Measures in an encounter (page 29.1)
 Reporting filters and where to set up different IDs for your reporting submissions (page 29.3)
 Generating your Objective Measures report (page 29.7)
 Generating your Clinical Quality Measures report (page 29.9)
 Tracking your Improvement Activities (page 29.12)

Available Resources
We have created two guides that explain in detail about the measures in each incentive program report
and what you need to do within the software to meet that report’s measures:

 MicroMD EMR Objective Measures Guide
 MicroMD EMR Clinical Quality Measures Guide
You can find the guides on the MicroMD Help Center by visiting: https://hsms.zendesk.com/hc/en-us/
categories/115002444867-MicroMD-Documentation-Library.

Quality Measures in an Encounter
MicroMD EMR provides you with integrated access to performance data within every encounter you create.
You can either access the quality measures data from the Encounter Ribbon or from the Measures sub-tab
of the Plan tab of the encounter.

Quality Measures Button in the Encounter Ribbon
On the Administration tab of the Encounter Ribbon, the system displays a Quality Measures button. This
button is dynamic. The system reviews the quality measures you chose in your User Preferences and
compares the requirements to the documentation you recorded in the patient's chart. Click the Refresh
button if needed to update the data with your performance.

 If the patient meets the requirements to be included in the Denominator for the Quality
measure, and you have met your requirements to have the patient included in the Numerator,
the button is green.

 If you have not met the requirements of a measure, the button is red. You can click the Quality
Measures button to review which measures you have not met.
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Quality Measures in an Encounter

In the window that opens when you click the button, MicroMD EMR places a green check mark next to the
measures you have met and a red “X” next to any measures you have not met for the patient to be included
in the Numerator.

Figure 29.1 Quality Measures in the Encounter

○

The user preferences DO NOT control information
gathered for your reports. The options only control what
displays for you in an encounter.



Click the Patient Monitor icon ( ) on the Patient
Quality Measures window to open the Patient Monitor
(page 27.16). You can fulfill many of the Quality
Measures—such as monitoring a patient’s smoking
status—while you still have the encounter open.

Measures Sub-Tab
To fulfill some clinical quality measures, you need to complete certain actions and add them while
recording the patient’s encounter. While on the Plan tab of the encounter, click the Measures sub-tab to
view the actions and codes specific to clinical quality measures. This is useful for those measures that are
heavily dependent on specific coding.

Figure 29.2 Measures Sub-Tab
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Retrieving Your Program Report Data
The Objective Measure and Clinical Quality Measure calculations are for those practices planning to
participate in government incentive programs. MicroMD EMR includes reporting tools to help you to
calculate measures and prepare the data for submission.
When it comes time to prepare your data for submission, the MicroMD EMR incentive program reporting
module helps you monitor your practice’s progress, as well as prepare the data. You can access these
reports from the Administrative Panel on the Desktop (under the Administration button. You have two
options:

 Objective Measure Calculations: This is where you can run reports for objective measures.
 Clinical Quality Measures: This is where you can run reports for clinical quality measures.
 Improvement Activities Tracking: This is where you can track your completion and add
documentation of completed activities.



Only those users with the Practice Manager or
Administrator role associated with their user account
can access the Administrative Panel.

Figure 29.3 Administrative Panel
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Reporting Filter Options
When you want to generate your report, you have a variety of filters on both reports. Table 29.1 explains
the filters in more detail.
Table 29.1 Filters Available for the Incentive Program Reports

Field

Details

Date Range

The dates you select in the Date Range fields tell MicroMD EMR the dates
of your reporting period. If you want to see your data for a specific 90-day
period, select that range here. If you want to see your data for the whole
year, leave the default values.

Provider

If you want to limit the data displayed to those activities performed by a
specific eligible professional, select that person from the Provider list.

Department Tax No

If you want to limit the data displayed to those activities performed by all
users within a specific department, select that department’s tax ID from
this filter. The system checks the Tax No field on the Department Details
window. In the MicroMD EMR Manager, click the Practice Information
button, click the Departments tab, select the clinic, highlight the
department, and click the Edit button.
This option is available on both reports.

Provider Taxpayer ID

This option is only available on the Clinical Quality Measures Report.
The Provider Taxpayer ID field (i.e., TIN) allows you to retrieve data for a
provider based on their TIN. The system checks the Tax Number field on
the eligible professional’s user account. In the MicroMD EMR Manager,
click the Users & Facilities button, highlight the user, and click the Edit
button on the Personal tab.
The TIN of the CPC+ practice site and comes from the Department setup
information.
When MIPS Individual is selected for CMS Program Name, the system
defaults to TIN instead of NPI.

NPI

If you want to find measure data for a specific National Provider Identifier
(NPI), you can select that NPI from this field. The data displayed in the
report will relate specifically to the user with that NPI. The system checks
the NPI Number field on the eligible professional’s user account. In the
MicroMD EMR Manager, click the Users & Facilities button, highlight the
user, and click the Edit button on the Professional tab.
Only the providers at the CPC+ practice site that are participating in CPC+
should be included.
When MIPS Group or CPC+ is selected for CMS Program Name, the system
defaults to NPI instead of TIN.

Provider Type

29.4

To find measure data for any providers that fall within a specific specialty,
you can select that specialty from this field. The system checks the
Specialty Type field on the eligible professional’s user account. In the
MicroMD EMR Manager, click the Users & Facilities button, highlight the
user, and click the Edit button on the Professional tab.
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Table 29.1 Filters Available for the Incentive Program Reports (continued)

Field

Details

Practice Clinic

If you want to see measure data for visits at a specific practice location,
you can select that location from this field.
For CPC+, the provider location is the CPC+ practice site address and
comes from the Department setup information.

○
Patient Ins Source of Pay

Remember: If you have MicroMD PM, a “clinic” in MicroMD
EMR is the “location” in the PM.

If you want to see measure data related only to those patients whose
encounter (where applicable) was billed to an insurance plan with a
specific selection in the Source of Payment field, you can select that
source of payment here.
You can find the plan’s source of payment on the Edit Insurance Plan
window (under Tools > Contact Managers > Insurance Manager).


Patient Age
Date of Birth

You can find the insurance used for the patient’s visit in
the Encounter Header.

If you want to narrow the measure data to patients within a specific age
range, you can enter a specific date range for those dates of birth.

Patient Gender

If you want to see measure data only for those patients of a specific
gender, you can select the gender from this filter. You can find the patient’s
gender displayed in the Sex field in Personal Details section of the
patient’s Demographics tab.

Patient Race

If you want to see measure data only for those patients of a specific race,
you can select the race from this filter. You can find the patient’s race
displayed in the Race field in Personal Details section of the patient’s
Demographics tab.

Patient Ethnicity

If you want to see measure data only for those patients of a specific
ethnicity, you can select the ethnicity from this filter. You can find the
patient’s gender displayed in the Ethnicity field in Personal Details section
of the patient’s Demographics tab.

Patient Problem List

If you want to see measure data only for those patients with a specific
diagnosis recorded in their chart, you can select that diagnosis from this
filter. You can find the Problem List section under the Medical button on
the Medical Information tab.

MicroMD EMR User’s Reference Manual Version 16.0

29.5

Chapter 29. Incentive Programs

Retrieving Your Program Report Data

CPC+PracID Field in Department Details
For practices that sign up for the CPC+ program, enter the CPC+PracID on the Department Details window
under Practice Information > Departments in the EMR Manager.

Figure 29.4 CPC+PracID Field

Virtual Group Reporting
Virtual Group reporting is the same as group reporting; however, those participating in a virtual group need
to include their group ID and group name in the QRDA file they generate. You can add these credentials in
the MIPS Virtual Grp ID and MIPS Virtual Grp Nm fields, respectively. Find the fields on the Department
Details window under Practice Information > Departments in the EMR Manager.

Figure 29.5 Virtual Group Reporting Fields

Validation Checks During Export of the QRDA III File
The system performs basic validation checks during the file export and will stop the export if it fails the
validation criteria. An error message will display indicating the data that failed the validation check.
For MIPS Individual reporting, the system will verify:

 One and not multiple providers is selected
 The correct TIN and NPI for the selected provider
For MIPS Group reporting, the system will verify:

 One department TIN is selected
For CPC Plus, the system will verify:

 One department TIN is selected
 The CPC+PracID field in Department Details is not null

29.6
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For MIPS Virtual Group, the system will verify:

 One department TIN is selected
 The MIPS Virtual Group ID and MIPS Virtual Group Name fields in Department Details for that
department (i.e., practice) are not null.

Generating the Objective Measures Report
The Objective Measure Calculations report retrieves your performance data for the Medicare or Medicaid
objective programs. Both Medicare and Medicaid have their own objective measures. While the sets of
objectives and measures mostly align with each other, there are differences between the measures in
Medicare and in Medicaid. Be sure to have the appropriate objective and measure number.

Figure 29.6 Objective Measure Calculations
In addition, the Medicare program (the Promoting Interoperability category of the MIPS track of the QPP)
has two separate sets of objectives and measures: PI and PI transition. For more details on the program,
please refer to the MicroMD EMR incentive program documentation.



You can double-click each measure to view a list of
patients included in the measure, as well as how they
were included (e.g., the patient was counted in the
Denominator, but not in the Numerator).
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To generate your objective measures report:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button and choose
Administrative Panel from the options
available.
3. Click the Objective Measure Calculations
button.

The report window opens (Figure 29.6).



The title of the window changes
based on the program and reporting
period you select.

4. From the Incentive Program/QPP Programs
drop-down, select either Medicare or
Medicaid, depending on the program for
which you want to gather data.
5. From the Reporting Period drop-down, select
the year for which you want to gather data.
6. Place a check mark next to each objective you
want to include in the report or file.

7. Make the appropriate choices in the filters
above the measure list.

8. Click the Retrieve button.

PI reflects the objectives within the Promoting
Interoperability category of the Quality Payment
Program (QPP).



Click the Select drop-down button
to select or deselect all measures
quickly.



When you choose filter criteria, the
patient data retrieved in the report
must meet ALL criteria to appear in
the report.

MicroMD EMR reviews the data in your system and
compares it to the requirements for each measure.
Please be patient. This process could take several
minutes.
When complete, the system displays the measure
numbers in the columns of the window.


9. Click the Print button to print your data.

29.8

Double-click a row to display a list of
patients included in the measure.

Once you have your printout, you can visit the CMS
attestation web site and enter your data.
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Generating the Clinical Quality Measures Report
The Clinical Quality Measures Report displays your performance data for Quality category in the Meritbased Incentive Payment System (MIPS) track of the Quality Payment Program (QPP).

Figure 29.7 Clinical Quality Measures Report
For in-depth details on how MicroMD calculates the data for each measure, please refer to the MicroMD
EMR incentive program documentation on the MicroMD Help Center.



You can double-click each measure to view a list of
patients included in the measure, as well as how they
were included (e.g., the patient was counted in the
Denominator, but not in the Numerator).

To generate your clinical quality measures report or file for submission to CMS:

Procedure

Details

1. Verify that you have the Desktop displayed.
2. In the Desktop Navigator section, click the
Administration button and choose
Administrative Panel from the options
available.
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Procedure (continued)

Details (continued)

3. Click the Clinical Quality Measure
Calculations button.

The report window opens (Figure 29.6).



The title of the window changes based
on the reporting year you select.

4. From the Reporting Period drop-down,
select the year for which you want to gather
data.
5. At the CMS Program Name field, select the
program name from the drop-down list.

This field identifies the QRDA III file that will be
exported.

 MIPS Individual reporting must contain exactly
one performer, which contains one TIN and one
NPI. Uses Practice setup information for data.

 MIPS Group reporting must contain exactly one
performer, which contains one TIN. No NPI is
allowed. Uses Department setup information for
group data.

 MIPS Virtual Group must contain exactly one
performer, which contains one TIN. No NPI is
allowed. Uses Department setup information for
virtual group data.

 CPC+ Reporting must contain exactly one
performer, which contains one TIN and one NPI.
Only CPC+ practice site providers are listed as
performers.
6. Place a check mark next to each quality
measure you want to include in the report
or file.

7. Make the appropriate choices in the filters
above the measure list.



See Table 29.1 on page 29.4 for details on each of the
filters available.
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Click the Select drop-down button
to select or deselect all measures
quickly.

When you choose filter criteria, the
patient data retrieved in the report
must meet ALL criteria to appear in
the report.
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Procedure (continued)

Details (continued)

8. Click the Retrieve button.

MicroMD EMR reviews the data in your system and
compares it to the requirements from the Centers for
Medicare and Medicaid for each measure.
When complete, the system displays the data in the
columns of the window.

○
9. Click the Export drop-down button and
select the type of file you want to generate.
OR
Click the Print drop-down button and
select the type of document you want to
print.

Please be patient. This process could
take some time depending on the
amount of data you have selected to
retrieve.

On the Export drop-down button, you have several
options:

 PDF: Select this option to save the report to a
PDF file.

 QRDA: Select this option to saves an XML file in
the Quality Reporting Document Architecture
(QRDA) format. The QRDA standard supports two
categories of quality reports in MicroMD:

- Category 1: This is the Single Patient Report.
Each report contains clinical quality data for
one patient within the measure (e.g., 24
patients in the denominator for measure 1 = 24
individual XML files for measure 1). This option
prompts you with a list of patients and
defaults to all. You can choose to generate a
single patient’s XML file if necessary.

- Category 3: This is the Aggregate Quality
Report. Each report contains calculated
summary data for one or more Clinical Quality
measures for specific population of patients
within a particular health care setup over a
period of time.
If you printed your report, once you have your
printout, you can visit the CMS attestation web site
and enter your data.
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Tracking Your Improvement Activities
The Improvement Activities (IA) category for MIPS rewards clinicians for focusing on care coordination,
beneficiary engagement, and patient safety. The majority of this category reports on activities the
clinicians perform in their daily workflows and documentation that they record, outside of an electronic
health record.
With the Improvement Activities Tracking feature in MicroMD EMR, you can track completion and add
documentation of completed activities for meeting the requirements in the Improvement Activities
category of MIPS track (Figure 29.8).

Figure 29.8 Improvement Activities Tracking
To access this tracking area, click the Improvement Activities Tracking button on the Administrative
Panel under the Administration button of your Desktop (Figure 29.3 on page 29.3).
Clinicians and groups may choose up to four Improvement Activities during the reporting period
(minimum of 90 days) where the total score is a minimum of 40. Activities weighted as “High” are worth 20
points, and activities weighted as “Medium” are worth 10 points. You are welcome to choose how you
reach 40 points, whether you choose two “High” activities, four “Medium” activities, or a combination of
“High” and “Medium”. As long as your total score is at least 40, you will meet the requirements to receive
the full 15% of your final MIPS score represented by the Improvement Activities category.

Adding a Provider’s Activities to the List
You can create a tracking entry for each eligible clinician. Once each clinician knows the activities to which
they want to attest, you can build the clinician’s tracking entry in the EMR. You can add the activities and
then attach documentation to the entry for each activity.
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Figure 29.9 Individual Improvement Activities Tracking
To add an entry to the tracking for an individual eligible clinician:

Procedure

Details

1. Click the Administration button on the
Desktop and choose Administrative Panel
from the available options.
2. Click the Improvement Activities
Tracking button.

The Improvement Activities window opens (Figure
29.8 on page 29.12).

3. Click the Add button on the Improvement
Activities window and select Individual IA
Tracking from the drop-down menu.

The Individual Improvement Activities window
opens (Figure 29.9).

4. Click the Lookup icon ( ) next to the
Clinician Included field and insert the clinician
for this entry.
5. Place a check mark next to each of the
activities you want to track for this clinician.



Use the Search For, Subcategory,
and Weighting fields to narrow the
list of activities.

See page 29.15 for details on adding
documentation to an activity.
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Tracking Your Improvement Activities

Details (continued)

6. Click OK.

○

You must click OK to save your entry
before you can add attachments to
the activity.

Adding a Group’s Activities to the List
You identify each “group” in MicroMD EMR based on the tax identification number you enter at the
department level (page 1.8). In the MicroMD EMR Manager, you assign a workplace to each user in the
system (page 1.15). This workplace consists of a clinic and a department. When you enter a tax
identification number for the department, the “group” includes all users who have a workplace associated
with their user account that contains that department.

Figure 29.10 Group Improvement Activities Tracking
To add a group’s activities to the list:

Procedure

Details

1. Click the Administration button on the
Desktop and choose Administrative Panel
from the available options.
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Procedure (continued)

Details (continued)

2. Click the Improvement Activities
Tracking button.

The Improvement Activities window opens (Figure
29.8 on page 29.12).

3. Click the Add button on the Improvement
Activities window and select Group IA
Tracking from the drop-down menu.

The Group Improvement Activities window opens
(Figure 29.10).

4. Enter useful identifying text in the Group
Description field.

This text appears in the Group/Individual Name
column on the Improvement Activities window.

5. From the Group Tax No, select the tax
identification number for which you want to
track activities.
6. Place a check mark next to each of the
activities you want to track for this group of
clinicians.



Use the Search For, Subcategory,
and Weighting fields to narrow the
list of activities.

See page 29.15 for details on adding
documentation to an activity.
7. Click OK.

○

You must click OK to save your entry
before you can add attachments to
the activity.

Managing Documentation on an Activity
You can easily manage documentation to group activity tracking and individual activity tracking. MicroMD
EMR stores the documentation in the Document Manager.

 The Add Attachment button (Figure 29.8 on page 29.12) allows you to add a web address, add
an existing file, or scan a paper document into the tracking entry (Figure 29.11). For each entry,
you can choose how you want to attach the document and provide a description of the
document that appears in the list of documentation (Figure 29.12).

Figure 29.11 Adding an Attachment

 The Edit Attachment button (Figure 29.8 on page 29.12) allows you to manage all
documentation you have associated with the Improvement Activity (Figure 29.12). Simply click
the Lookup icon ( ) to add another document and the Open icon ( ) to display the
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document in the Document Manager. If you want to remove a document from the Improvement
Activity, simply highlight the document and click the Delete icon ( ).

Figure 29.12 Editing Attachments
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